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Welcome To Sierra Wave 

Welcome to the Cadwell Sierra WaveTM  Help System.  To use the help system, 
expand the book chapters to the left (by clicking on the plus signs), then click on 
the topics you wish to learn more about. 

 

Sierra Wave with 2 Channel amplifier on the "Point Of Care" lightweight cart. 

 

REV. 11, 2010 

DJn 
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Introduction & Setup 

General Description 

The Cadwell Sierra WaveTM  is a complete 2 or 4 channel electromyography and 
evoked potential acquisition system.  The Wave is designed from the ground up 
to take full advantage of the WindowsTM operating system. 

The Wave can be configured in a portable or desktop version.  The portable 
version comes with a laptop computer and soft-sided carrying case for greater 
mobility. 

The desktop version comes with a tower or mini-tower PC and an LCD monitor. 

Both a lightweight and hospital-grade cart are available. 

The Sierra Wave basic system includes a 2 Channel amplifier with EMG, NCV, F 
Wave, H Reflex, RNS, Blink Reflex, Somatosensory Evoked Potentials, and 
Report Generation using Microsoft Word. 

Optional programs include Single Fiber EMG, Stimulated Single Fiber EMG, 
Macro EMG, Auditory Evoked Potential, Visual Evoked Potential, P300 Cognitive 
Evoked Potential, Quantitative EMG (Multi-MUP and Interference Pattern), Motor 
Unit Number Estimation, and RR Interval. 

 

Laptop model with 2 Channel Amplifier and Electrical Stimulator 
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System Connections 

 

LAPTOP 

1. Peel the liner of the Velcro patches on the top of the Sierra instrument and 
carefully align the laptop above and press down to attach the patches to 
the laptop bottom. 

2. Plug one end of the network cable into the Ethernet network port on the 
laptop and the other end into the connector labeled 10 BASE T on the 
Sierra rear panel. 

3. Connect one end of the Y-shaped power cord into the receptacle on the 
rear of the Sierra base unit, connect the other end of the cord into the AC 
adapter for the laptop.  Connect the AC adapter to the connector on the 
rear panel of the laptop labeled DC IN. 

4. Connect printer cable (if applicable) to laptop‟s printer port (parallel or 
USB). 

5. Connect mouse (if applicable) to laptop‟s mouse port. 

6. Attach the grounding wire from the base unit to the laptop's grounding wire 
(alligator clip) or the external video connector (VGA connector shell). 

7. Plug all power cords into hospital grade wall outlets. (Do not use a power 
strip or surge protector) 

8. If you are using a cart, follow the instructions included with the cart to 
ground the cart with the instrument. 
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9. Connect the Amplifier to the Sierra base unit using the amplifier cable 
supplied. 

10. Plug all accessory items (footswitch, stimulator etc…) into their respective 
inputs on the rear panel of the Sierra base. 

DESKTOP (Console) 

1. Place Monitor on Monitor shelf.  Place Wave base unit on shelf below. 

2. Plug one end of the network cable into the Ethernet network port on the 
computer and the other end into the connector labeled 10 BASE T on the 
Sierra rear panel. 

3. Connect the main power cord into the receptacle on the rear of the Sierra 
base unit. 

4. Connect printer cable (if applicable) to computer's printer port (parallel or 
USB). 

5. Connect the keyboard and mouse to computer's designated ports. 

6. Plug all power cords into hospital grade wall outlets. (Do not use a power 
strip or surge protector) 

7. If you are using a cart, follow the instructions included with the cart to 
ground the cart with the instrument. 

8. Connect the Amplifier to the Sierra base unit using the amplifier cable 
supplied. 

9. Plug all accessory items (footswitch, stimulator etc…) into their respective 
inputs on the rear panel of the Sierra base. 
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Network Card Configuration 

Configuring the Network Card (port) for the Sierra Wave Base 

1. If necessary, install a network card in the computer.  Follow the 
manufacturer‟s installation instructions. 

2. Login as a User that has administrative access rights. 

3. Click Start, then Control Panel, then Network and Internet 
Connections. 

4. Click on Network Connections.  The Network Connections window will 
be displayed.  A separate icon will be displayed for each network card that 
is installed in the PC.  By default, the name given to each network card is 
“Local Area Connection”.  You can rename the icons to something more 
descriptive by right-clicking on the icon and then selecting Rename.  For 
example, you might want to change the name to Sierra, or maybe to 
EMG_EEG as shown in the picture below. 

 

5. To configure the network properties; Right click over the appropriate icon 
and then select Properties.  The properties window will be displayed as 
shown in the next picture. 



Introduction & Setup 

7 

 

6. First, remove the check marks next to Client for Microsoft Networks, File 
and Printer Sharing for Microsoft Networks, and QoS Packet Scheduler. 
 Be sure to leave the check mark next to Internet Protocol (TCP/IP). 

7. Optional:  Place a check mark next to “Show icon in notification area when 
connected” if you want Windows to tell you when the connection to the 
Cadwell system has been made.  When the connection is made you will 
see a message displayed in the lower right hand corner of the desktop. 

8.  Select the Internet Protocol (TCP/IP) and then click on the Properties 
button. 

9. Select “Use the following IP address”.  Enter 192.168.113.66 for the IP 
Address.  Enter 255.255.255.0 for the subnet mask. 
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10.  Click the Advanced button, then click the WINS tab.  Remove the check 
mark next to “Enable LM Hosts lookup” and then select “Disable 
NetBIOS over TCP/IP” as shown in the following picture. 
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11.  Click OK, click OK again, then click Close. 
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Back Panel Connections 

 

 

 

AMPLIFIER  - Plug in 2 or 4 channel Amplifier. 

AUXILLIARY - Plug in LED Goggles, Trigger Out cable, 3" LED Checks or Flash. 

FOOTSWITCH - Plug in Footswitch 

10 BASE T - Network "Patch" cable attached to computer's network port 
(communication between the Wave base unit and the PC occurs over this cable). 

EXT SPEAKER  - Connection for external speaker (Please read external 
speaker specifications). 

BAEP/ VEP Monitor - Plug in Auditory Headphones, Inserts, Bone Transducer 
or VEP Monitor. 

ESTIM - Plug in Electrical Stimulator. 

TEMP - Plug in Temperature Probe. 

 - Attach grounding wire(s). 

100-240 VAC - 2Amp fuse located on bottom of base. 
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Custom Keyboard 

 

Standard Keyboard 

 

 

International Keyboard 

 

Function keys (F1, F2,  F3, F4) - The operations assigned to these function 
keys change depending on the test protocol that is active.  The description for the 
current function is located in the lower left of the screen. 

Study keys (S1, S2, S3, Select ) - Programmed to select your most common 
study lists.  The Select button will bring up the entire Study List/Test Menu. 

Knobs (1, 2, 3, 4) - The operations assigned to these knobs change depending 
on the test protocol that is active.  The description for the current functions is 
located in the lower right of the screen. 

On (Power) Indicator - Bright green when the base unit has power. 

Volume - Adjusts the speaker volume. 

Print - Programmable report generation key. 
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Report  - Programmable report generation key. 

Next  - Advances to the Next test protocol in the Study Window. 

View   - Toggles the Trace window to a maximized view, pressing a second 
time returns the window to its original size. 

Patient  - Opens the Patient Information Window. 

Imped   - Opens the Impedance Window. 

OK   - Closes various Pop-Up Windows. (Impedance, Patient Information 
etc...) 

Store   - Stores the active trace(s). 

Clear   - Clears the active or selected stored trace. 

Single   - Delivers a single stimulus. 

Run/Stop   - Delivers repetitive stimulations.  Press again to Stop 
stimulation. 
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Electrical Stimulator 

 

Reverse Polarity button (+/-): 

Press this button to select the Cathode (i.e., the negative stimulus probe).  A 
green LED indicates which probe is the Cathode.  For routine nerve 
conduction studies the Cathode (-) should be oriented closest to the recording 
electrodes. 

* For F Wave and H Reflex test protocols:  The Cathode (-) should be 
positioned away from the recording electrodes (i.e., Cathode proximal, Anode 
distal). 
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Stim button: 

NCV protocol: 

Press once and release to deliver a single electrical stimulus.  Press and Hold 
for two seconds, then release to initiate repetitive stimulation. 

The Press and Hold feature can be disabled in the System Setup 
window. 

SEP protocol: 

Press once and release to deliver repetitive electrical stimulus. 

Intensity / Distance Wheel: 

Turn toward the stimulus probes to increase the intensity, turn towards the 
cable to lower stimulus intensity.  In the NCV test protocol the wheel can be 
used to enter distance measurements. 

Store button: 

Press to store the active (white) trace. 

Programmable buttons 1 & 2: 

These two buttons are programmable per Test protocol.  In the NCV test 
protocol button 1 is used to reverse stimulator polarity and button 2 is used to 
enter distances. 

Release button: 

The stimulus probes can be angled to 3 positions besides the normal straight 
ahead position.  Press and hold the release button while moving the probe 
tips up or down.  Release the button to lock the probes into their new position. 

Stimulus Probes: 

The probe spacing can be narrowed for testing smaller patients.  The probes 
can also be removed to allow bar electrodes to be connected to the 
stimulator. 
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Auditory Stimulators 

Auditory Stimulators 

 

Acoustically shielded headphones 

The headphones feature 10-W 
speakers, adjustable headband, and 
color-coded earphones for easy 
right/left identification. 

 

Lightweight headphones 

Recommended for pediatric use, these 
headphones feature 10-W speakers 
and adjustable headband. 

 

Insert earphones 

The insert earphones feature 10-W 
compatible speakers with 1-ms acoustic 
delay. They are useful for intraoperative 
applications, ECochG testing, and 
BAEP testing in infants. 
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Auditory bone transducer 

The auditory bone transducer is useful 
for assessing peripheral hearing loss 
and/or head trauma. 

 

The auditory stimulator (headphones of both the cup and insert type) output a 
100µS square wave (pulse) which is heard as a click.  The output level is user 
adjustable from -10 to 95 dB nHL. Contralateral masking is also available and is 
user is adjustable from 0 to 80 dB below stimulus level.  Extended exposure to 
high sound pressure levels can result in permanent hearing loss.  While the 
effect of high sound pressure levels differ greatly between individuals it is 
possible that exposure to levels of 75dB nHL for several hours can cause 
permanent hearing loss. As the sound pressure levels go up the acceptable 
exposure time goes down. Where possible avoid stimulating at high levels for 
extended periods of time. 

Avoid prolonged use of high sound pressure levels which may cause 
permanent hearing impairment. 
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Visual Stimulators 

Visual Stimulators 

 

Monochrome VEP monitor 

The monitor presents reversing black-and-
white checkerboard stimuli for full-, half-, and 
quarter-field testing. Fixation point (small or 
large) and check sizes are controlled by 
software. 

 

LCD Television VEP monitor 

The monitor presents reversing black-and-
white checkerboard stimuli for full-, half-, and 
quarter-field testing. Fixation point (small or 
large) and check sizes are controlled by 
software. 

*Requires BNC-to-RCA Adapter (PN# 
277072-000) and software version 10.0.128 
or higher. 

 

 

3-in (8-cm) LED stimulator 

The LED stimulator presents reversing black-
and-red checkerboard patterns in 0.25-in (7-
mm) check sizes. It can also function as a 
flash stimulator. 
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LED goggles 

The goggles present LED flash stimuli to the 
left, right, or both eyes and are useful for 
intraoperative applications. 

 

Single-intensity flash stimulator 

Repetition rate and start and stop controlled 
by software. 

 

Photic (Flash) Stimulation: 

The photic stimulator using flash tube technology outputs a pulse of white light 
with a pulse width of approximately 10uS.  The flash can be manually triggered 
or set to flash repeatedly at a rate between 1 and 25 Hz.  The flash energy is 1.5 
million candle or less.  UV energy is blocked by a protective filter incorporated 
into the lens.  While there are no industry or other standards established for EEG 
flash stimulators these parameters are all within the range used by the major 
EEG manufactures.  They have been proven to be safe when used at distances 
of 18 inches or more on a patient with eyes closed. If used on an anesthetized 
patient a means should be provided to ensure that the eye lids remain closed. 

The photic stimulator using LED technology outputs a pulse of white light with a 
pulse width of several milliseconds.  The flash can be manually triggered or set to 
flash repeatedly at a rate between 1 and 60 Hz.  The LED produces no UV 
energy.  The flash energy is much less that output by a flash tube stimulator and 
the pulse width is adjusted to give the same perceived brightness. While there 
are no industry or other standards established for EEG flash stimulators these 
parameters are all within the range used by the major EEG manufactures.  They 
have been proven to be safe when used at distances of 18 inches or more on a 
patient with eyes closed. If used on an anesthetized patient a means should be 
provided to ensure that the eye lids remain closed. 

The photic stimulator goggles use LED technology and output a pulse of red light 
(650nm nominal wavelength) with a pulse width of 10 milliseconds.  The flash 
can be manually triggered or set to flash repeatedly at a rate up to 10 Hz.  The 
LED produces no UV energy.  The flash energy is in accordance with EN 60825-



Introduction & Setup 

19 

1 which covers the safety of laser and LED products. While there are no industry 
or other standards established for EEG flash stimulators these parameters are all 
within the range used by the major EEG manufactures.  The goggles have been 
proven to be safe when used on a patient with eyes closed.  If used on an 
anesthetized patient a means should be provided to ensure that the eye lids 
remain closed. 

Avoid prolonged use of high light output which may cause permanent 
visual impairment. 
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Getting Started - The Basics 

Turning Equipment On and Off 

To turn equipment On. 

1. Connect the amplifier, stimulators, and other accessories (if not already 
connected). 

2. Turn equipment on in the following order: 

 Sierra Wave base unit 

 Monitor (for desktop configuration only) 

 Printer 

 Computer 

 If you are using the isolation transformer and cart power switches, you 
will need to turn on the cart power switch and then the computer. 

 

To turn the equipment Off. 

 Do not turn the Sierra Wave instrument base on or off while a patient is 
connected. 

Turn off equipment in the following order: 

1. Close all programs that are running on the computer. 

2. On the Windows taskbar, click Start, Shutdown, Turn Off the Computer. 

3. Turn off the Sierra Wave base unit, Monitor (for desktop configuration 
only), and Printer. 

 

 If you are using the isolation transformer and cart power switches, turn 
off only the cart power switch after you have shutdown the computer.  The 
monitor, printer, Wave base unit, and isolation transformer power switches 
can remain on.  The next time you start the system, turn on the cart power 
switch and then the computer. 

 You do not need to disconnect the amplifier, stimulators, or 
accessories.  You can leave them connected. 
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Starting the Sierra Wave Program 

To Start the Sierra Wave program 

Start the Sierra Wave software on your computer in one of the following ways: 

 Double-click the Sierra Wave icon on the Windows desktop. 

 Click the Windows Start button, select All Programs, Cadwell, and then 
Sierra Wave. 

 

 If you receive a Communication Error message. 

Close the Sierra Wave program and make sure the Sierra Wave base unit is 
turned On, and that the network cable is attached securely between the 
computer and the Sierra Wave base unit.  Then, restart the Sierra Wave 
program. 

 If you are working on a Reader station (no acquisition hardware attached) 
the communication error can be disabled.  Click here for instructions on how to 
do this. 

 

Starting a New Exam and entering Patient 
Information 

To start a New Exam and enter Patient Information use one of the following methods. 

 Press F1 - New Exam. 

 Select Enter Patient Info from the File Menu. 

 Press the Patient key on the Sierra Wave base unit. 

 Select a Study or an individual Test Protocol from the Study/Test menu 

All of these methods will display the following Patient Information Window. 
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Patient Information window 

A blinking cursor will automatically be displayed in the Last Name field.  You can 
use the tab key, mouse, or Knob #1 on the Sierra Wave base unit to move from 
field to field.   

At a minimum, you should enter a Last Name and First Name, this is 
what the Sierra Wave program uses to create the patient's data file. 
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The Test Date and Test Time will automatically be entered for you, and can be 
modified if needed. 

Height can be entered in the following units: 

 Feet and Inches 

 

 Centimeters (cm) - required when using the prediction equations in NCV, 
F Wave, and H Reflex. 

 

 Text (txt) - for backwards compatibility with older patient data or when 
using different measurement units. 

 

Weight can be entered in the following units: 

 Pounds (lbs.) 

 

 Kilograms (kg) 

 

 Text (txt) - for backwards compatibility with older patient data or when 
using different measurement units. 

 

To use the Custom Information fields, you will need to click the mouse in the 
field prior to entering information. 

The Report Header can be selected from the drop-down list or by clicking on the 
Browse button.  The report header can also be selected from within the System 
Setup window. 

 



Getting Started - The Basics 

25 

The following buttons are shown at the bottom of the window: 

F1- Load Patient Info:  Allows previously entered patient information to 
be loaded from a saved patient information file (*.cpi) or from a patient 
data file (*.sd). 

F2- Close & Save:  Allows the entered patient information to be saved in 
a file, it can later be retrieved using the Load button. 

F3 - Start Exam:  Saves the entered patient information and then displays 
the Study Menu.  You can then select the Study or individual Test protocol 
that you would like to use. 

F4 - Cancel:  Closes the patient information window and discards all 
information. 

 

 The patient information can be edited at any time after starting an exam. 
 Simply press the Patient key on the Sierra Wave base unit, or select Patient 
Information from the Edit menu. 

 You can also start an exam without entering any patient information.  Simply 
select F3 - Start Exam and go directly into the Study or Test Protocol and begin 
testing.  If you do not enter any patient information during the exam, the program 
will prompt you for it when you close the patient's exam. 

Related Topics: 

Editing Patient Information during an Exam 

Custom Information Fields 

 

Selecting a Study or Test Protocol 

There are various ways to select a Study or individual Test protocol. 

From the Patient Information window: 

Click the F3 - Start Exam button.  The patient information will be saved and the 
Study/Test menu will be automatically displayed.  Use the mouse, or Knob #1 
to select a Study or an individual Test protocol. 
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 If a Study is selected, all the tests included in the Study will be displayed in 
the Study window and the first test protocol listed in the Study will 
automatically be initialized and will be ready for data acquisition. 

 If an individual Test is selected, the test protocol will be loaded.  If the test 
uses a muscle or nerve list, this list will be displayed so you can choose the 
muscles or nerves you wish to examine.  Once selected, these nerves or 
muscles will be displayed in the Study window. 

Outside the Patient Information window: 

Use the Study/Test menu or the Study keys on the Sierra Wave base unit. 

 Click on the Study/Test menu with the mouse and then select the Study 
or Test protocol of interest. 

 Press the Select key on the Sierra Wave base unit.  The Study/Test menu 
will be displayed, use the mouse or Knob #1 to select the Study or 
individual Test protocol of interest. 

 Press the S1, S2, or S3 keys on the Sierra Wave base unit.  The Study or 
Test Protocol assigned to the key will be loaded. 

 

Related Topics: 

Study Key Assignments 

Study Menu 

Study Menu Setup Window 

 

 

Description of Screen Layout 

The Sierra Wave screen is composed of three main windows; the Trace window, 
Study window, and Measurements / Cursor Table window.  The Amplifier / 
Stimulator controls can be displayed in either a window or toolbar format.  An 
optional Live Monitor window is available in the NCV, F Wave, H-Reflex, Blink 
Reflex, and RNS test protocols. 

The bottom of the screen shows the current function key and knob 
assignments for the Sierra Wave base unit. 
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Sierra Wave Screen showing the Trace, Study, and Cursor Table windows, the Amplifier / 
Stimulator Controls toolbar, and Live Monitor window. 

 

The color scheme used throughout the help topics is Factory Default 1. 
 For more information on changing the Sierra Wave's color scheme go to the 
Color Editor topic. 

 

Trace Window 

The Trace window displays the electromyographic and evoked responses 
acquired from the patient. 

Live or Averaged traces are displayed in "white" color.  Stored traces are 
displayed in "purple" color.  Traces that have been selected for manipulation 
are shown in "yellow" color. 

Pressing the View key on the Sierra Wave base unit will maximize the Trace 
window to fill the entire screen.  To return the Trace window to its original size & 
position, press the View key a second time. 
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The major divisions of this window are displayed in a white grid or dot pattern. 
 The Display Gain (vertical scale in microvolts per division) and Sweep Speed 
(horizontal scale in milliseconds per division) are shown in the lower left and right 
of this window respectively. 

 

NCV Trace window 

 

Trace Window Context Menu 

In true Windows fashion, the Trace window supports a Context menu. 

The Context menu, also known as the right click menu,  is accessed by right 
clicking the mouse anywhere over the trace window.  The functions that are 
available in the context menu will vary depending on the test protocol that is 
currently loaded. 
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Context menu for NCV Trace window. 

 

Study Window 

The Study window has several functions: 

 Lists the test protocols that have been pre-selected and grouped into 
the selected Study List (e.g., lists the tests for the Right Carpal Tunnel 
Study). 

 Automatically adds to the list other test protocols, not originally part of 
the Study list, as they are selected from the Study/Test menu or nerve 
and muscle lists. 

 Provides an easy way to change from one test protocol to another or go 
back and review a previous test. 

 Shows which test protocols have been completed by placing a 
checkmark on the test protocol's icon. 
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Use Knob #1 (Study Item), on the Sierra Wave base unit, to move the highlight 
up and down through the Study window.  If you stop the highlight on a test 
protocol for more than 1.5 seconds, that protocol will be loaded. 

Alternatively, click on a test protocol with the left mouse button to load it. 

 

Study window. 

 

Study Window Context Menu 

The Study window has a Context menu, also known as the right click menu. 
 It is accessed by right clicking the mouse over a blank area within the Study 
window, or by right clicking over a test protocol name.  The functions that are 
available in the context menu will vary depending on what you right clicked 
over. 

When right clicking over a blank area, not over a test protocol name: 
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When right clicking on a test protocol name: 

     

   Over an NCV test.                                            Over an EMG test. 

 

For more detailed information on using the Study Window, see the topic Study 
Window Overview. 

 

Controls Window or Controls Toolbar 

The Amplifier & Stimulator controls can be configured in either a window or 
toolbar format.  This preference can be saved on a per test protocol basis.  In 
software version 5.5 or higher, the default format is the Controls Toolbar enabled. 

To turn the Controls Toolbar On or Off, select the option called "Test Control 
Bar" from the View menu. 

Controls Window 

The Controls window displays the Amplifier, Averager, and Stimulator 
settings for the test protocol.  It also contains a Side control and buttons 
representing the same Acquisition keys found on the Wave's base unit (i.e., 
Run/Stop, Single, Store, and Clear).  The current settings for the Footswitch 
and Programmable buttons on the electrical stimulator can also be found 
here. 

Blue colored and underlined items can be changed or edited by clicking on 
them with the left mouse button.  Drop down lists can also be changed by 

clicking on the drop down arrow . 
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There is no Context menu for the Controls window. 

 

Controls Window for NCV test protocol. 

Controls Toolbar 

The Controls toolbar displays the Amplifier, Averager, Side, and Stimulator 
settings for the test protocol in a toolbar format across the top of the screen. 
 The current settings for the Footswitch and Programmable buttons on the 
electrical stimulator can also be found here. 

Blue colored and underlined items can be changed or edited by clicking on 
them with the left mouse button.  Drop down lists can also be changed by 

clicking on the drop down arrow . 

 

Controls Toolbar for NCV test protocol. 

Right click over the toolbar to turn Off/On various sections of the toolbar 
controls and to change the Font Size. 
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 Using the Toolbar format allows more room for the remaining windows. 

 

Measurements / Cursor Table Window 

The Measurements / Cursor Table window has several functions. 

 It displays the values for trace features that have been identified after 
placement of the latency and amplitude markers or auto-cursors.  The 
type of table shown in this window will vary depending on the test 
protocol that is currently selected. 

 It displays the muscle scoring table in the EMG protocol. 

 It displays the IP Analysis plots in the Interference Pattern Analysis 
mode. 

 It displays the MUA Table in the Single Motor Unit Analysis (SMUA) 
mode. 

 

NCV Tables window. 
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Measurements / Cursor Table Window Context Menu 

In the EMG, NCV, and RNS test protocols the Measurements / Cursor Table 
window supports the use of the Context menu. 

 

EMG Muscle Score Table Context menu. 

 

Live Monitor Window 

A Live Monitor window is available in the NCV, F Wave, H-Reflex, Blink Reflex, 
RNS, and MUNE test protocols. 

When this window is enabled it displays the “Live” activity coming from the 
recording electrodes.  When electrical stimulation occurs, the window will briefly 
display a stimulus-triggered waveform, and then will go back to display “Live” 
activity after one second. 

This window can be positioned, sized, and saved as part of the default settings 
for the test protocol. 

To Enable the Live Monitor window: 

1. Start the Sierra Wave program. 

2. Select a test protocol, NCV for example. 

3. From the Edit menu, select Current Test. 

4. Click on the General Settings tab. 

5. Check the box labeled, “Show Live Monitor”. 

6. Click OK. 

7. Adjust the size and positions of the windows on the screen. 
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8. From the Edit menu, select Save Test Parameters to update the 
default settings for the test.  From now on the test protocol will display 
the Live Monitor Window. 

  The Gain and Sweep Speed of the Live Monitor window are the same as 
the main Trace window. 

 

Function Keys F1 - F4 

The bottom left of the screen shows the program functions currently assigned to 
the F1-F4 function keys on the Sierra Wave base unit.  These functions will vary 
depending on the test protocol that is currently selected. 

These functions can also change with the status of the test protocol.  For 
example, when you Stop the EMG trace, by pressing the Run/Stop button, the 
functions of the F1 & F2 keys change.  When you return to Run mode, by 
pressing the Run/Stop button again, the functions of these keys go back to their 
original settings. 

In all test protocols, the F4 function key is reserved for TabData.  Pressing this 
key will display the TabData window which includes a list of all the tests 
performed on the patient as well as various summary tables. 

Some function keys toggle back and forth between two functions.  The currently 
selected function is displayed in bold text. 

 

F1-F4 Function Keys for NCV test. 

 

PC Toolbar (Function Keys F5 - F12) 

Additional program functions can be accessed using the F5-F12 function keys on 
the PC's keyboard.  A PC function key toolbar, that shows the current 
assignments for these additional function keys, can be enabled from the View 
menu.  Simply select View, then click on PC Function Key Menu. 

The PC function key toolbar is displayed below the F1-F4 function keys on the 
screen. 

 

PC Function Key Toolbar for the NCV test. 
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In all test protocols the F5 function key is assigned to Cursors, and the F6 
function key is assigned to Position.  The remaining F7-F12 keys will vary 
depending on the test protocol that is currently selected. 

If you press F5-Cursors or F6-Position to enter these modes, simply press the 
function key a second time, or press the OK key on the base unit to exit these 
modes when you are finished using them. 

 The PC function toolbar does not have to be visible to use the program 
functions assigned to it. 

 

Knobs 1 - 4 

The bottom right of the screen shows the program functions currently assigned to 
the four Knobs on the Sierra Wave base unit.  These functions will vary 
depending on the test protocol that is currently selected and the status of that 
test (i.e., running or stopped). 

The functions of the knobs also change if you enter the Cursor or Position 
mode by pressing the F5 or F6 function keys. 

Many knobs have dual functions.  Pressing the knob will toggle back and forth 
between the two functions.  Once the appropriate function is selected, turn the 
knob to perform that function 

Initially in all test protocols, Knob #1 is reserved for selecting tests from the Study 
window, Knob #4 is reserved for changing Gain and Sweep Speed settings. 

Knobs that change parameters such as Gain, Sweep Speed, Intensity, or knobs 
that move Cursors will display the associated value on the knob graphic. 

 

Knob functions for NCV test. 

All functions that can be done with the knobs can also be done using the 
mouse. 

 

Pressing the ALT key on the PC keyboard or the Select key on the Wave 
base unit will toggle Knob #1 to Select and Knob #2 to Move Left/Right.  This 
allows the program menus (File, Edit, View, Study/Test) at the top of the screen 
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to be accessed using these knobs.  Press the ESC key on the PC keyboard or 
F4-Close Menu on the Wave base unit to exit from this mode. 

 

Knob changes as result of pressing ALT key. 

 

 

 

Using the Study Window 

The Study window has several functions: 

 Lists the test protocols that have been pre-selected and grouped into 
the selected Study List (e.g., lists the tests for the Right Carpal Tunnel 
Study). 

 Automatically adds to the list other test protocols, not originally part of 
the Study list, as they are selected from the Study/Test menu or nerve 
and muscle lists. 

 Provides an easy way to change from one test protocol to another or go 
back and review a previous test. 

 Shows which test protocols have been completed by placing a 
checkmark on the test protocol's icon. 

 

To Select a Test within the Study window: 

 Use Knob #1 (Study Item), on the Sierra Wave base unit, to move the 
highlight up and down through the Study window.  If you stop the highlight 
on a test protocol for more than 1.5 seconds, that protocol will be loaded. 

 Alternatively, click on a test protocol with the left mouse button to load it. 
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Study window. 

 

Study Window Context Menu 

The Study window has a Context menu, also known as the right click menu. 
 It is accessed by right clicking the mouse over a blank area within the Study 
window, or by right clicking over a test protocol name.  The functions that are 
available in the context menu will vary depending on what you right clicked 
over. 
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When right clicking over a blank area, not over a test protocol name: 

 

When right clicking on a test protocol name: 

     

               Over an NCV test.                                              Over an EMG test. 
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Test Types within the Study Window: 

Each test protocol is indicated by a color coded icon.  The Table below 
summarizes the available tests and their associated icon. 

Test Icons: 

Test Type: Icon: Description: 

EMG  Pink color with blue needle hub. 

NCV  Yellow color with CMAP trace. 

F Wave  Green color with F Wave trace. 

H Reflex  Orange color with H Reflex trace. 

RNS  Violet color with RNS decrementing 
trace. 

Blink  Blue colored eye. 

SFEMG  Pink color with red needle hub. 

SSFEMG (Stim-

SFEMG) 
 Pink color with violet needle hub. 

Real Time SFEMG  Pink color with red needle hub. 

Macro EMG  Pink color with red needle hub. 

SEP  Blue with bar electrode. 

VEP  Blue with checkerboard pattern. 

AEP  Blue with headphones. 

P300  Blue with target. 

RR Interval  Red Heart 

MUNE (MPS and 
Incremental) 

 Blue color with CMAP trace. 

EMG Guidance  Pink color with blue needle hub. 

 

For more detailed information on using the Study Window, see the topic Study 
Window Overview. 
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NCV - Basic Operation 

Select the NCV  Test:   

 If a Study has already been selected, simply click on a nerve name (i.e., 
Right Median Motor) within the Study window or turn Knob #1 (Study 
Item / Site) to highlight the nerve name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual NCV test protocol from the Study/Test menu, a nerve 
list will be displayed allowing you to pick the nerve or nerves that you will 
be testing on the patient. 

 

Once the nerve has been selected.  Follow these steps for performing 
routine NCV data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the nerve being tested. 

Typical Settings 

 Gain 
(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep 
Speed 

(ms/Div) 

Motor 
Nerves 

2k to 5k 10k 10 5.0 

Sensory 
Nerves 

10 to 20 2k 10 2.0 

 

2.  Verify Side Setting 

Make sure the appropriate side, Right or Left, is selected. 

3.  Verify Stimulation Sites and Segments 

The selected nerve's recording site name, stimulation site names, and defined 
segments are shown within the NCV Tables window. 

 

Nerve name and recording site name. 
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The Site table displays the stimulation site names, one per row.  This table 
will display the onset or peak latency, amplitude measurements, duration and 
area measurements, and normal values.  By default, the first stimulation site's 
row is highlighted as soon as the nerve is selected.  The name of this site 
also appears on the active (white) trace's label. 

 

Site table with Erbs stimulation site selected. 

The Segment table displays the segments over which velocity calculations 
are to be made.  Each row in this table represents one segment.  This table 
has a column for entering distances and for displaying the calculated and 
normal velocity. 

 

Segment table. 

4.  Electrode Placement 

Attach the electrodes to the patient.  

5.  Check Stimulator Polarity 

For Nerve Conductions Studies, the Cathode (-) should be oriented closest 
to the recording electrodes. 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  

Clicking on the Polarity field in the NCV Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) 
mode has the right-side probe as the Cathode (if holding the stimulator with 
the Stim button facing you and the probes up); the reversed state will make 
the left-side probe the Cathode.  The image of the stimulator on the screen 
updates to indicate the selected polarity as well. 
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In the Normal mode, the electrical stimulator image on the screen will show 
the Right-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will 
show the Left-side probe as the cathode (-).  The polarity field on the screen 
will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

6.  Stimulate the first Site 

Increase the stimulus intensity level by turning the wheel on the electrical 
stimulator handle.  The intensity  level (in milliamps) is displayed on the 
screen in a small pop-up window and also in the Stimulator section.  Once 
you have reached an appropriate starting intensity apply the stimulator to the 
patient and deliver the stimulus by pressing the Stim button on the electrical 
stimulator handle.  The stimulator light, located next to the intensity level on 
the Screen, will flash Green and the patient's response will be displayed. 

 The Single key on the Sierra Wave base unit can also be used to deliver 
a single stimulus.  Intensity can also be adjusted using Knob #3 (Intensity / 
Pulse Width) on the base unit. 
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Continue to increase the intensity level and stimulate until a supra-maximal 
response is acquired.  If the response is large and "clips" at the top or bottom, 
 decrease the amplifier sensitivity by adjusting the Gain setting.  For example, 
change gain from 2k to 5k and re-stimulate.  Gain can be adjusted easily by 
using Knob #4 (Gain /Sweep) on the Sierra Wave base unit. 

8.  If necessary, Adjust Auto Cursors 

Auto Cursors are placed on the response as soon as it is displayed.  The 
cursors are Onset (O), Peak (P), Trough (T) and Recovery (R).  The 
configuration of the Site and Segment tables determines which of the four 
cursors are placed on the trace. The positions of these cursors can be 
adjusted by performing one of the following actions; 

 By using Knob #2 (Sel Cursor / Move Cursor) on the Sierra Wave 
base unit. 

 By clicking on them with the left mouse button and dragging them to 
their new position. 

For the correct placement of the auto-cursors the response must meet or 
exceed certain amplitude and slope criteria.  When these criteria are not met 
the cursors will be placed on the response in the following pattern. 

 

Pattern of auto-cursor placement when amplitude criteria is not met. 

The Peak (P) cursor will be positioned at the third division with the Onset (O) 
cursor placed one-quarter division in front and the Trough (T) and Recovery 
(R) cursors placed one-quarter and one-half division respectively following it. 
 If you believe that there is a response present you can move the cursors to 
their appropriate positions, or if there really is no response present, you can 
mark the response as "NR" in the Site table. 

9.  Store the Response 

To store the response and advance to the next stimulation site, perform one 
of the following actions; 

 Press the Store button on the Electrical Stimulator handle. 

 Press the Store key on the Sierra Wave base unit. 



Sierra Wave Help Manual 

46 

 Press the Footswitch pedal (assuming the pedal has been 
programmed with the Store function.) 

 Click the Store button in the NCV Controls window. 

When the response is stored the color of the trace changes from white to 
purple and the next row in the Site table is automatically highlighted. 

If the nerve has only one stimulation site, it is not necessary to store the 
response.  The Sierra Wave will automatically keep the trace when you 
change nerves or test protocols. 

10.  Stimulate and Store Additional Sites 

Continue to stimulate and store additional sites on the nerve. 

11.  Enter Distance to calculate Velocity 

Measure the distances for each segment and enter the values (in 
centimeters) into the segment table.  There are two ways to enter the 
distance. 

 Press the Distance key on the Sierra Wave base unit or click on 
the appropriate distance field with the mouse.  The first distance 
field will become activated and a small pop-up window is displayed 
showing the segment name and a place for the distance 
measurement, type the distance value and then press the Enter 
key.  You can also press the Distance key a second time instead of 
pressing the Enter key. 

 

Distance pop-up window. 

 Press Programmable button #1 on the Electrical Stimulator 
handle.  A small pop-up window is displayed showing the segment 
name, distance value, and velocity.  Now, turn the wheel on the 
stimulator handle to increase or decrease the distance value in 
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0.5 cm increments.  When the correct distance value is reached, 
press Programmable button #1 a second time or press the Enter 
key. 

 

Distance pop-up window. 

12.  Compare Left vs. Right side Data & Traces (optional) 

This feature allows for easy comparison of the latency, amplitude, and 
velocity differences between the left and right sides of a nerve.  It also allows 
for a visual comparison of the traces obtained for each side. 

Press the F10 - L/R Cmp function key to view the traces acquired for each 
side and a table of difference values. 

Normal values can be entered for the side-to-side difference measurements 
with abnormal values flagged by the program. 

Press the F10 - L/R Cmp function key a second time to return to the standard 
NCV display. 

13.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 
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To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

14.  Next Nerve or Test 

To advance to the Next Nerve: 

 Use Knob #1 (Study Item / Site) to highlight another NCV nerve in the 
Study window. 

 Click on another NCV nerve in the Study window using the mouse. 

 Press the F3 (Nerve List) function key on the Sierra Wave base unit 
and select another nerve from the nerve list. 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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EMG - Basic Operation 

Select the EMG  Test:   

 If a Study has already been selected, simply click on an EMG muscle 
name (i.e., Right Deltoid) within the Study window or turn Knob #1 (Study 
Item / Site) to highlight the muscle name.  Notice that as soon as any 
muscle is selected within the EMG test protocol, all the muscles are 
automatically added to the muscle score table. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual EMG test protocol from the Study/Test menu, a 
muscle list will be displayed allowing you to pick the muscle or muscles 
that you will be testing on the patient.  Notice that as soon as any muscle 
is selected, it is displayed within the Study window and is automatically 
added to the muscle score table. 

 The Automatic Muscle Scoring feature can be disabled in the EMG 
Test Setup window.  When this feature is disabled the muscles in the Study 
window are not automatically added to the muscle score table.   You will need 
to use the F2 (Muscle Sel/Score) knob or the Left mouse button to 
manually add the appropriate muscles to the scoring table. 

 

Once the muscle has been selected.  Follow these steps for performing 
routine EMG data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate. 

Typical Settings for EMG 

Gain = 100 or 200 uV/Div 

Hicut = 10k Hz 

Locut = 10 - 30 Hz 

Sweep Speed = 10.0 ms/Div 

2.  Verify the Side 

Make sure the appropriate side, Right or Left, is selected. 

3.  Insert the Needle Electrode 
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4.  Adjust Volume 

Increase or decrease the Sierra Wave's internal speaker by using the Volume 
Knob on the left hand side of the base unit. 

5.  Select Live or Capture Acquisition Mode 

Use the F1 (Live / Capture) function key to toggle between these two 
acquisition modes. 

Live Mode:  In Live mode free-running EMG is displayed in the Trace window 
and a compressed view of the EMG Live Buffer is displayed below this.  A 
moving blue marker shows the current position within the buffer.  At any time 
data acquisition can be stopped and the data in the Live Buffer can be 
reviewed or played back (see step #7 below).  The EMG protocol always 
defaults to the Live data acquisition mode. 

 

EMG - Live mode 

Live Mode with Raster Display:  An optional Raster Display can be enabled 
by pressing the F11 (Raster) function key.  When this feature is enabled the 
Trace window is split into two equal sections; the left half showing the live 
EMG data and the compressed buffer, the right half showing consecutively 



Getting Started - The Basics 

51 

rastered EMG traces.  Click here for more information on the Raster Display 
option. 

 

Live EMG mode with Raster Display enabled. 

Capture Mode:  In Capture mode a voltage level trigger and delay marker 
are displayed within the Trace window.  The level of the voltage trigger can be 
adjusted using Knob #3 (Trigger Lvl).  When EMG activity exceeds the 
trigger level (in either the negative or positive direction) the sweep is captured 
momentarily and is repositioned with the crossing point at the delay marker. 
 This allows for easier visualization of motor unit potentials.  At any time data 
acquisition can be stopped and up to 50 captured sweeps can be reviewed 
(see step #7 below). 
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EMG - Capture mode 

Capture Mode with Capture Window:  An optional Capture Window can be 
enabled by pressing the F11 (Cap Wnd) function key.  When this feature is 
enabled the trace window is split into two sections; the top section shows the 
live EMG trace and the trigger level and delay indicator, the bottom section 
shows a rastered display of the most recently captured traces.  Click here for 
more information on the Capture Window option. 
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Capture Mode with Capture Window enabled. 

 

6.  Adjust Gain & Sweep 

During EMG data acquisition you can easily adjust the Gain and Sweep 
Speed by using Knob #4 (Gain / Sweep) on the Sierra Wave base unit. 
 Simply turn the knob to adjust the gain, to change the sweep speed, press 
the knob first to toggle it to the sweep mode, then turn to change the sweep 
speed. 

You can also use the mouse to change these settings in the EMG Controls 
window or Controls Toolbar. 

7.  Stop Data Acquisition and Review (optional) 

To stop data acquisition perform one of the following actions; 

 Press the Run/Stop key on the Sierra Wave base unit. 
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 Press the Stim button on the Electrical Stimulator handle. 

 Press the Footswitch pedal. 

 Click on the Stop button in the EMG Controls window. 

Stopped Live EMG: 

Review the Live Buffer - move backwards and forwards in the Live 
EMG buffer by turning Knob #1 (Review / Play-Stop), press the knob to 
replay the buffer.  You can also review by dragging the blue marker back 
and forth within the compressed buffer area using the mouse. 

 

EMG - Stopped Live mode 

Store a Snapshot - press the F1 (Store Snap Shot) function key or the 
Store key on the Sierra Wave base unit to store the currently displayed 
sweep.  The stored sweep will be displayed in purple. 

Store the entire Live Buffer - press the F2 (Store Live Buffer) function 
key.  The trace will be displayed in blue indicating that the entire buffer 
has been stored. 
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Manual MUP Tool - right click the mouse over the motor unit potential 
(MUP) of interest, then select MUP Tool from the pop-up menu.  The 
motor unit potential is shown centered within a MUP window and 
quantitative measurements are shown in the table below.  Click OK to 
save the MUP and include it in the final report, click Cancel to discard 
the MUP. 

Stopped Capture EMG: 

Review Captured Sweeps -  use Knob #4 (Trace Sel /Delete) to 
review through the captured traces, press the knob to delete the 
selected trace (selected trace is displayed in yellow color).  Press the F2 
(Raster / Overlay) function key to superimpose all the captured traces. 

 

EMG - Stopped Capture mode 

Store Captured Sweeps - press the Store key on the Sierra Wave 
base unit or click on the Store button within the EMG Controls window. 
 The stored traces will be displayed in purple. 

 Prior to storing any EMG traces, Use Knob #2 (Muscle Sel) to 
highlight the correct muscle name in the Study window.  This will ensure 
that the EMG data will be stored with the correct muscle name. 
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 As EMG is stored, you will see a new node appear in the Study 
window below the muscle name.  This indicates what has been stored for 
this muscle.  The example below shows a Snapshot stored for the Right 
Abd Poll Brev muscle, a Capture run stored for the Right ABD Dig Min 
muscle, and a Live Buffer stored for the Right ExtDigCom muscle. 

 

Example of stored EMG nodes in the Study window. 

 

8.  Return to Data Acquisition Mode 

If you stopped either Live or Captured data acquisition, perform one of the 
following actions to resume data acquisition; 

 Press the Run/Stop key on the Sierra Wave base unit. 

 Press the Stim button on Electrical Stimulator handle. 

 Click the Run button in the EMG Controls window. 

9.  Modify Muscle Scoring 

With the Automatic Muscle Scoring feature enabled, as soon as a muscle is 
selected in the Study window, or added to the Study window using the F3 
(Muscle List) function key, it is automatically added to the Muscle Scoring 
Table and is scored as normal. 

To change the muscle scoring for a muscle: 

 Turn Knob #3 (Score Table / Modify) until the highlight is over the 
scoring field that you want to change, press the knob to pop up a list of 
choices, turn the knob to highlight one of the choices and press again 
to select it. 

 Using the left mouse button, click on the scoring field that you want to 
change.  From the pop up list of choices click again to make a 
selection. 
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Muscle Scoring Table 

 Depending on your preferences in System Setup, abnormal values 
can be flagged with a red background color, as bold text, as bold text with 
an asterisk, or as bold text & background color red. 

10.  Select Next Muscle 

Turn Knob #2 (Muscle Sel / Delete Score) to highlight the next muscle in the 
Study window.  If the muscle you want to examine is not displayed within the 
Study window, press F3 (Muscle List) and select the muscle from the list. 

Move the Needle Electrode to the new muscle and repeat the above steps as 
necessary. 

 It is a good idea to turn Off the preamplifier or turn down the Volume 
when moving the needle electrode to a new location. 

11.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected tests traces 
and cursor information will be displayed on the right hand side of the window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 
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To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

12.  Next Test 

 Use Knob #1 (Study Item) to highlight another Test Protocol in the 
Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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F/H Basic Operation 

Select the F Wave  or H Reflex  Test: 

 If a Study has already been selected, simply click on an F Wave or H 
Reflex nerve name (i.e., Right Median) within the Study window or turn 
Knob #1 (Study Item / Site) to highlight the nerve name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual F Wave or H Reflex test protocol from the Study/Test 
menu, a nerve list will be displayed allowing you to pick the nerve or 
nerves that you will be testing on the patient. 

 

Once the nerve has been selected.  Follow these steps for performing 
routine F Wave or H Reflex (Markers mode) data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the test being performed. 

Typical Settings 

 Gain 
(uV/Div) 

Split 
Gain 

(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep 
Speed 

(ms/Div) 

F Wave 5k 500 10k 20 5.0 or 10.0 

H Reflex 2 - 5k 500 10k 20 10.0 

 

2.  Electrode Placement 

Attach the electrodes to the patient.  

3.  Verify Side Setting 

Make sure the appropriate side, Right or Left, is selected. 

4.  Check Stimulator Polarity 

For F Wave and H-Reflex Studies, the Cathode (-) should be oriented away 
from the recording electrodes (i.e., Cathode proximal, Anode distal). 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  
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Clicking on the Polarity field in the F/H Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) 
mode has the right-side probe as the Cathode (if holding the stimulator with 
the Stim button facing you and the probes up); the reversed state will make 
the left-side probe the Cathode.  The image of the stimulator on the screen 
updates to indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show 
the Right-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will 
show the Left-side probe as the Cathode (-).  The polarity field on the screen 
will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

5.  Stimulate the Nerve 

Increase the stimulus intensity level by turning the wheel on the electrical 
stimulator handle.  The intensity  level (in milliamps) is displayed on the 
screen in a small pop-up window and also in the Stimulator section.  Once 
you have reached an appropriate starting intensity apply the stimulator to the 
patient and deliver the stimulus by pressing the Stim button on the electrical 
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stimulator handle.  The stimulator light, located next to the intensity level on 
the Screen, will flash Green and the patient's response will be displayed. 

 The Single key on the Sierra Wave base unit, or the Single button in 
the F/H Controls window, can also be used to deliver a single stimulus. 

 Repetitive stimulation can be delivered by pressing the Run/Stop 
button on the Sierra Wave base unit or by clicking on the Run button in the 
F/H Controls window. 

In general, F Waves are performed with supramaximal stimulus intensity, 
while H Reflex maximum amplitude occurs with sub-maximal stimulation 
intensity. 

If the M Wave or F/H response amplitude is large and "clips" at the top or 
bottom,  decrease the amplifier sensitivity by adjusting the Gain setting.  For 
example, change the gain from 2k to 5k and re-stimulate.  Gain can be 
adjusted easily by using Knob #4 (Gain M / Gain F or H) on the Sierra Wave 
base unit. 

6.  Store the Response 

If the F1 (Manual / AutoStore) function key is set to the Manual mode you 
will need to store the response by performing one of the following actions; 

 Press the Store button on the electrical stimulator handle. 

 Press the Footswitch pedal. 

 Press the Store button on the Sierra Wave base unit. 

 Click on the Store button in the F/H Controls window. 

If the F1 (Manual / AutoStore) function key is set to the AutoStore mode, 
the trace will automatically be stored immediately after it is acquired. 

Stored traces will be displayed in "purple" color on the screen. 

7.  Continue to Stimulate and Store until 10 or 20 responses have been 
acquired. 

8.  Adjust Latency Marker 

To adjust the latency marker, perform one of the following: 

 Turn Knob #2 (F/H Lat / M Wave Lat) on the Sierra Wave base unit to 
move the F/H latency marker to the minimal F Wave latency or H 
Reflex onset latency.  Changing the F2 (Raster / Overlay) function key 
to Overlay mode can be helpful when positioning the latency marker. 
 The latency value is displayed in the F/H Table window. 
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 Press the F8 (Auto F-Lat / Auto H-Lat) function key.  The program will 
automatically move the latency marker to the earliest onset latency.  In 
addition, a pop-up window will show the latency value and the wheel 
on the stimulator handle can be used to adjust the position of the 
marker.  Once the marker has been positioned, press the F8 function 
key a second time to exit this mode. 

 

Example F Wave Trace window. 

9.  Compare Left vs. Right side Traces (optional) 

Press the F10 - L/R Cmp function key to view the traces acquired for each 
side. 

The traces for each side are displayed in separate windows, stacked vertically 
on the screen.  The top window contains the traces for the current side. 

Press the F10 - L/R Cmp function key a second time to return to the standard 
F/H display. 

10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., F 
Wave Markers, Motor Summary table, Anti Sensory table, Muscle Scoring 
table). 
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To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Nerve or Test 

To advance to the Next Nerve: 

 Use Knob #1 (Study Item / Site) to highlight another F/H nerve in the 
Study window. 

 Click on another F/H nerve in the Study window using the mouse. 

 Press the F3 (Nerve List) function key on the Sierra Wave base unit 
and select another nerve from the nerve list. 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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RNS - Basic Operation 

Select the RNS  Test: 

 If a Study has already been selected, simply click on the RNS muscle 
name within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the RNS test protocol from the Study/Test menu, a muscle list will 
be displayed allowing you to pick the muscle or muscles that you will be 
testing on the patient. 

 

Once the muscle has been selected.  Follow these steps for performing 
RNS data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the test being performed.  RNS typically uses the 
same settings as a motor NCV. 

2.  Verify Side Setting 

Make sure the appropriate side, Right or Left, is selected. 

3.  Electrode Placement 

Attach the electrodes to the patient. 

Active 1 Input:  Belly of the muscle. 

Reference 1 Input:  Tendon of the muscle. 

Ground Electrode:  On stimulated limb or forehead. 

4.  Check Stimulator Polarity 

For RNS Studies, the Cathode (-) should be oriented closest to the 
recording electrodes. 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  

Clicking on the Polarity field in the RNS Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) 
mode has the right-side probe as the Cathode (if holding the stimulator with 
the Stim button facing you and the probes up); the reversed state will make 



Getting Started - The Basics 

65 

the left-side probe the Cathode.  The image of the stimulator on the screen 
updates to indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show 
the Right-side probe as the cathode (-).  The polarity field on the screen will 
indicate Nml. 

  

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will show 
the Left-side probe as the cathode (-).  The polarity field on the screen will 
indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

5.  Check the RNS Table 

The RNS test protocol supports a preprogrammed stimulus train table.  This 
table controls the number of stimuli presented in each train, the repetition rate 
for the stimuli, the amount of time to pause before proceeding to the next 
stimulus train, and it also provides a convenient way to label each stimulus 
train. 

The program allows for either manual or automatic delivery of the stimulus 
train table. 
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RNS Table. 

If your stimulus train table is undefined, select Current Test from the Edit 
menu.  Fill in the Sequencer Setup table in the lower left corner of the setup 
window, then click OK. 

6.  Check the General and Stimulator Settings 

General Settings 

Mode:  Choices are Train or Single. 

 Train - When the Stim button on the handheld stimulator or the 
Run/Stop button is pressed, a train of stimuli, corresponding to the 
highlighted row in the RNS Table, will be delivered. 

 Single - When the Stim button on the hand held stimulator or the 
Single button is pressed, a single stimulus will be delivered.  This 
mode is useful for determining supramaximal stimulation prior to 
delivering a train of stimuli. 

Train #:  The total number of stimuli that will be delivered to the patient 
when the program is set to the Train mode.  The typical setting is four to 
eight.  The maximum setting is 150.  This value is updated from the RNS 
Table. 

Spread:  This is the distance (in horizontal divisions) that will separate the 
individual traces within the train.  If this value is set to zero, the traces will 
be superimposed upon one another. 

Response 1:  Select the first response in the train that will be analyzed for 
amplitude and area measurements.  Typically this is always set to number 
1. 

Response 2:  Select the second response in the train that will be 
analyzed for amplitude and area measurements.  In addition, the 
percentage difference between this response and the trace selected for 
Response 1 will be computed.  This is typically set to number 4 or 5. 
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Auto Seq:  Allows for either manual or automatic sequencing through the 
RNS Table.  When set to On, the program will automatically deliver the 
trains specified in the RNS table (automatically pausing for the specified 
time after each train).  When set to Off, the user must manually start each 
train after the appropriate pause time, by pressing the Run/Stop key for 
each train. 

Stimulator Settings 

Pulse Width:  Set the electrical stimulus pulse width, also known as pulse 
duration, in microseconds (usec). 

Rep Rate:  Set the repetitive stimulus rate, in pulses per second (Hz). 
 This is typically set to 3 Hz.  This setting only applies when delivering 
repetitive (i.e., Train) stimulation, it does not apply during manual Single 
stimulus delivery. 

7.  Check Recording Setup 

Press the F1 (Train/Single) function key to select Single mode.  Increase 
the stimulus intensity level by turning the wheel on the electrical stimulator 
handle.  The intensity  level (in milliamps) is displayed on the screen in a 
small pop-up window and also in the Stimulator controls section.  Once 
you have reached an appropriate starting intensity apply the stimulator to 
the patient and deliver the stimulus by pressing the Stim button on the 
electrical stimulator handle.  The stimulator light, located next to the 
intensity level on the Screen, will flash Green and the patient's response 
will be displayed. 

 The Single key on the Sierra Wave base unit or the Single button 
within the on-screen RNS Controls window can also be used to deliver a 
single stimulus.  Intensity can also be adjusted using Knob #3 (Intensity / 
Pulse Width) on the base unit. 

Continue to increase the intensity level and stimulate until a supra-
maximal response is acquired.  If the response is large and "clips" at the 
top or bottom,  decrease the amplifier sensitivity by adjusting the Gain 
setting.  For example, change gain from 2k to 5k and re-stimulate.  Gain 
can be adjusted easily by using Knob #4 (Gain /Sweep) on the Sierra 
Wave base unit. 

8.  Deliver Stimulus Trains 

Press the F1 (Train/Single) function key to select Train mode.  Follow the 
instructions below for either Manual or Automatic Stimulus Train delivery. 



Sierra Wave Help Manual 

68 

Manual Stimulus Train Delivery: 

Press the Stim button on the electrical stimulator handle.  A train of 
stimuli will be delivered to the patient and a trace will be displayed for 
each stimulus within the train.  The traces are stacked in a horizontal 
fashion (see Spread setting above). 

After the Train is completed the program will automatically store the train 
and it will be displayed in a "purple" color. 

 The Run/Stop key on the Sierra Wave base unit or the Run 
button within the on-screen RNS Controls window can also be used to 
deliver a train of stimuli.  

 20 milliseconds is acquired after each stimulus.  This allows for a 
maximum repetition rate of 50 Hz during train stimulation. 

After a train is automatically stored, a timer is started.  The timer is 
displayed just below the side field in the RNS Controls window or at the 
top of the screen in the Controls Toolbar. 

Use the timer to measure the time elapsed while the patient exercises the 
muscle or the time elapsed between successive stimulus trains.  Typically, 
the patient will exercise the muscle for 30 seconds after the first train is 
delivered then another train will be delivered immediately after completion 
of exercise.  Additional trains are then typically delivered at 1 minute 
intervals after this. 

Press the Run/Stop key again to deliver the second stimulus train. 
 Proceed in this fashion until all stimulus trains have been acquired. 

 The timer automatically resets to zero after each train is stored. 
 You can also manually reset the timer to zero by pressing the F2 
(Reset Timer) function key on the Sierra Wave base unit. 



Getting Started - The Basics 

69 

 

Example RNS Traces 

Automatic Stimulus Train Delivery: 

Change the Auto Seq. control from Off to On.  The first row in the RNS 
Table will be automatically selected. 

Press the Stim button on the electrical stimulator handle.  A train of 
stimuli will be delivered to the patient and a trace will be displayed for 
each stimulus within the train.  The traces are stacked in a horizontal 
fashion (see Spread setting above). 

After the Train is completed the program will automatically store the train 
and it will be displayed in a "purple" color.  At this point the timer is started. 
 The timer is displayed just below the side field in the RNS Controls 
window or at the top of the screen in the Controls Toolbar. 



Sierra Wave Help Manual 

70 

Once the timer reaches the preprogrammed pause time for the stimulus 
train, the program will automatically deliver the next stimulus train in the 
RNS Table. 

Stimulation will continue in this manner until the last stimulus train is 
delivered. 

 You can stop the automatic sequencer at any time by changing the 
Auto Seq. control from On to Off. 

9.  Adjust Cursors (optional) 

Onset (O) and Peak (P) cursors are automatically placed on the selected 
responses (see Response 1 and Response 2 settings above) as each train is 
acquired.   The amplitude (onset to peak) and area (negative peak) of each 
response is calculated and displayed in the RNS table window. 

The positions of these cursors can be adjusted by performing one of the 
following actions; 

 By pressing the F5 (Cursor mode) function key and then using Knob 
#1 (Sel Cursor / Move Cursor) on the Sierra Wave base unit. 

 By clicking on them with the left mouse button and dragging them to 
their new position. 

The difference for both amplitude and area, between the two marked 
responses, is also automatically calculated and is displayed as a percentage 
(%).  The equation used for this calculation is as follows; 

D = (VR2 - VR1) / VR1 X 100% 

Where D = decrement or increment 

V = value (amplitude or area) 

R1 = response 1 

R2 = response 2 

A decrement is displayed as a negative number, typically more than a -10% 
decrement is considered abnormal.  An increment is displayed as a positive 
number. 

Peak-to-Trough amplitude measurements can also be selected in the 
RNS protocol's test setup window.  In this case, Peak (P) and Trough (T) 
cursors will be automatically placed on the responses.  

 Use the Comment field in the RNS table to enter a notation for the train. 
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RNS Cursor Table 

 

RNS Histogram Window 

10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 
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To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Muscle or Test 

To advance to the Next Muscle: 

 Use Knob #1 (Study Item / Site) to highlight another RNS muscle in 
the Study window. 

 Click on another RNS muscle in the Study window using the mouse. 

 Press the F3 (Muscle List) function key on the Sierra Wave base 
unit and select another muscle from the muscle list. 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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Blink - Basic Operation 

Select the Blink  Test: 

 If a Study has already been selected, simply click on the Blink test 
protocol within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the Blink test protocol from the Study/Test menu. 

 

Once the test has been selected.  Follow these steps for performing Blink 
data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the test being performed. 

Typical Blink Settings 

Gain = 200 uV/Div 

Hicut = 5k Hz 

Locut = 10 Hz 

Sweep Speed = 10.0 ms/Div 

2.  Electrode Placement 

 Attach the electrodes to the patient.  Click here to view an example Blink 
setup. 

 Connect the electrode leads from the patient‟s left side to the Channel 1 
inputs on the amplifier, and connect the electrode leads from the right side 
to the Channel 2 inputs. Electrodes must be connected to the amplifier in 
this configuration to ensure proper display of test data. 

Active 1 Input:  Belly of the Left orbicularis oculi muscle below the eye. 

Reference 1  Input:  Left side of nose. 

Active 2 Input:  Belly of the Right orbicularis oculi muscle below the eye. 

Reference 2  Input:  Right side of nose. 

Ground Electrode:  Forehead or cheek. 
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3.  Select Side of Stimulation 

Select the side, Left or Right, that will be stimulated first.   

Trials collected during left-side stimulation are displayed in the top half of the 
screen with the response recorded on the ipsilateral side (e.g., Ch1 : L) 
positioned above the response recorded on the contralateral side (Ch2 : L). 

Responses collected during right side stimulation display in the bottom half of 
the screen. Eliminating the need to change electrodes at the amplifier, the 
Sierra automatically inverts the order in which trials collected during right side 
stimulation are displayed so that the ipsilateral response (Ch2 : R) appears 
above the contralateral response (Ch1 : R). 

4.  Check Stimulator Polarity 

For Blink Reflex Studies, the Cathode (-) should be oriented closest to the 
recording electrodes. 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  

Clicking on the Polarity field in the Blink Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) 
mode has the right-side probe as the Cathode (if holding the stimulator with 
the Stim button facing you and the probes up); the reversed state will make 
the left-side probe the Cathode.  The image of the stimulator on the screen 
updates to indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show 
the Right-side probe as the cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 
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In the Reversed mode, the electrical stimulator image on the screen will show 
the Left-side probe as the cathode (-).  The polarity field on the screen will 
indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

5.  Stimulate 

Increase the stimulus intensity level by turning the wheel on the electrical 
stimulator handle.  The intensity  level (in milliamps) is displayed on the 
screen in a small pop-up window and also in the Stimulator section.  Once 
you have reached an appropriate starting intensity apply the stimulator to the 
patient's supra-orbital nerve and deliver the stimulus by pressing the Stim 
button on the electrical stimulator handle.  The stimulator light, located next 
to the intensity level on the Screen, will flash Green and the patient's 
response will be displayed. 

 The Single key on the Sierra Wave base unit can also be used to deliver 
a single stimulus.  Intensity can also be adjusted using Knob #3 (Intensity / 
Pulse Width) on the base unit. 

6.  Store the Response 

To store the response, perform one of the following actions; 

 Press the Store button on the electrical stimulator handle. 

 Press the Store key on the Sierra Wave base unit. 

 Press the Footswitch pedal. 

 Click the Store button in the Blink Controls window. 

When the response is stored the color of the trace changes from white to 
purple  

7.  Repeat Stimulation & Store additional responses 

Generally, two trials are acquired per side. 
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8.  Move Latency Markers (R1, R2i, R2c) 

Three latency markers are utilized in the Blink test protocol.  R1 is positioned 
at the onset of the ipsilateral R1 response.  R2i is positioned at the onset of 
the ipsilateral R2 response.  R2c is positioned at the onset of the contralateral 
R2 response. 

Each of the three markers has a different line pattern. 

To move the latency markers: 

 Use Knob #2 (R1) to move the R1 marker, use Knob #3 (R2i /R2c) to 
move the R2i and R2c markers. 

 Use the mouse to click and drag the appropriate marker to the desired 
location. 

9.  Change the Side and Repeat steps 4 - 8. 

Selecting a different side automatically stores the currently active (white) 
traces. 
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Blink Example. 

 The program will automatically calculate the R2i-R2c difference for each 
side.  It will also calculate the Left minus Right differences for R1, R2i, R2c, 
and R2i-R2c. 

 

Blink Cursor Table 
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10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Test 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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SEP - Basic Operation 

Select the SEP  Test: 

 If a Study has already been selected, simply click on the SEP test 
protocol within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the SEP test protocol from the Study/Test menu. 

 

Once the SEP test has been selected.  Follow these steps for performing 
data acquisition: 

1.  Apply electrodes to the patient and connect to amplifier 

Determine the number of channels that will be recorded and the electrodes 
that will be required for each channel.  Apply the recording electrodes and 
ground electrode to the patient and connect to the Sierra Wave amplifier. 

2.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the selected SEP test. 

Typical Settings 

 Gain 
(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep Speed 
(ms/Div) 

Upper Limb SEP 1 to 5 3k to 500 10 5.0 

Lower Limb SEP 1 to 5 3k to 500 10 10.0 

 

A Common Reference (CREF) input is available on the 4 Channel Amplifier. 
 The status of the CREF input, Off or On for each channel, will depend on the 
montage chosen for the test.  If the amplifier channel should use its 
corresponding individual reference input (i.e., reference 1, 2, 3, or 4) the 
CREF setting should be set to OFF.  If the channel should not use its 
individual reference input, but should use the CREF input in its place, then the 
CREF setting should be set to ON. 

The Notch filter is typically not used during SEP recordings and should 
remain OFF. 
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Median SEP default Amplifier Settings. 

3.  Check Impedances 

Press the Imped key on the Sierra Wave base unit.  The impedance window 
displays a picture of the front of the amplifier. 

 

Impedance window.  Channels 1, 2 and 3 have the CREF input enabled, channel 4 is turned Off. 

The Active (black) and Reference (red) inputs are displayed for each 
channel as well as the CREF input (4 Channel Amplifier only).  The Ground 
input is not included in impedance measurements. 

If a Channel is turned Off, no impedance values will be calculated for either 
the active or reference inputs and the word "Off" is displayed over the inputs 
of that channel. 
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When the CREF input is enabled (i.e., ON) for a channel, that channel's 
reference input will not show an impedance value and will have the word "Off" 
over the reference input.  An impedance value for the CREF input will be 
displayed. 

Impedances less than 5k Ohms (kilo-ohms) are displayed in green.  Values 
between 5.1 and 20 are displayed in yellow.  Values greater than 20 are 
displayed in red. 

To close the impedance window, press the Imped key again or click the OK 
button. 

 When performing evoked potential studies all impedances should be 
less than 5k Ohms. 

4.  Select Side of Stimulation 

Make sure the appropriate side, Right or Left, is selected.   

5.  Check Stimulator Settings and Polarity 

Apply the stimulating electrodes (bar electrode or individual electrodes) to the 
patient.  Connect the stimulating electrodes to the end of the hand-held 
electrical stimulator (remove the probe tips from the end of the stimulator). 
 The proximal stimulating electrode should be connected to the Cathode (-) 
and the distal stimulating electrode should be connected to the Anode (+). 

Intensity - start at zero milliamps and after data acquisition is started 
increase slowly until a visible muscle twitch is seen. 

Pulse Width - typically set to 100 or 200 microseconds. 

Rep Rate - typically between 2 to 5 Hz and not directly divisible into 60 (e.g., 
2.11, 2.66, 4.77). 

Polarity - set to Normal (Nml) mode.  The green LED indicates the Cathode 
(-). 
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Controls Window.                          Controls Toolbar. 

SEP Stimulator Controls 

6.  Verify Averager Settings 

Shutoff - This is the number of responses that will be averaged together to 
produce the final results.  When the shutoff count is reached stimulation will 
automatically be stopped. 

Reject On / Off - When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the percentage 
(%) of stimuli/sweeps that have been rejected from the total delivered will be 
displayed on the screen. 

Level - This is the reject sensitivity level, it is shown as a percentage of full 
amplifier scale.  Choices are 30 to 100 % in increments of 5.  100% equals 
full scale, smaller numbers will make the reject more sensitive. 

 

Example SEP Averager settings. 

 Reject is based on the Live un-averaged data and the Amp Gain 
setting.  Every channel has 5 divisions above and below its initial baseline. 
 So, if the Amp Gain is set to 10 uV/Div this means that the Live trace has an 
amplitude window of 100 microvolts (10 vertical divisions times 10 uV/Div) 
with 50 uV above the baseline and 50 uV below the baseline.  If the reject 
level is set to 100% (i.e., full scale), then the amplitude of the live data must 
be below +/- 50 uV to be included in the running average.  Should it exceed 
+/- 50 uV the trace will be rejected from the running average.  If the reject 
level is set to 50% (i.e., half of full scale), then the amplitude of the Live data 
can't exceed +/- 25 uV (2.5 divisions above or below the baseline) or it will be 
rejected from the running average.  The lower the reject level setting the more 
sensitive the program will be in rejecting large artifacts. 
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 You can check the Amp Gain setting by pressing the F1 (Avg / Live) 
function key to switch to the Live mode.  Press the function key again to 
return to the Avg mode and view the Display Gain setting. 

7.  Acquire Responses 

A.  Start Data Acquisition. 

Press the Run/Stop key to start stimulus delivery and data acquisition. 
 Slowly turn up the stimulus intensity level until a visible muscle twitch 
is observed.  The average count (AvgCnt) should start to increment and 
the traces will begin to take shape. 

Adjust the vertical size of the all traces by turning Knob #4 (Gain).  To 
adjust the gain of an individual trace, change the corresponding gain 
setting in the amplifier section of the EP Controls window. 

Press the F3 (Smooth) function key during acquisition to remove high 
frequency noise from the active (white) traces. 

B.  Store the first trial. 

When the Shutoff count is reached, stimulation will stop automatically. 
 Press the Store key to store the active (white) traces.  A copy of the 
active traces will appear on the screen and are displayed in a purple color. 

 The Store key can be pressed before the Shutoff count is reached. 
 This will cause the currently active traces to be stored, the average count 
will be reset to zero, and stimulation will continue automatically on a new 
set of traces. 

C.  Clear the Average Count. 

Press the Clear key to reset the average count (AvgCnt) back to zero. 
 The active (white) traces will be reset to flat lines. 

D.  Acquire a second Trial 

Press the Run/Stop key to start stimulus delivery and data acquisition 
again.  Generally, two trials should always be acquired when performing 
evoked potentials to show replication of the traces. 

E.  Store second trial and Clear. 

After the Shutoff count is reached for the second trial, press the Store key 
to store the active (white) traces.  Press the Clear key to reset the 
average count to zero. 
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F.  Change Side of Stimulation. 

To acquire traces for the opposite side, change the Side setting in the EP 
Controls window.  If you are using the Split Screen feature the active 
(white) traces will automatically move to the opposite side of the Trace 
window. 

G.  Repeat steps A - E and collect data for the opposite side. 

 

Example 3 Channel Median SEP, Left and Right. 

8.  Trace Positioning (optional) 

If the position of the traces needs to be adjusted, follow one of these 
procedures. 

 Using the Mouse - simply click on the Trial you want to move with 
the left mouse button and drag the trial to its new location.  If you 
want to move an individual Trace, not the entire Trial, first right-click 
the mouse over the Trace window and remove the check mark in 
front of "Trial Selection Mode". 

 Using the Knobs - press the F6 (Position) function key on the 
PC's keyboard.  The program's knob and function keys will change 
to reflect the position mode controls.  Use Knob #1 (Sel Trial / 
Move) to select and move trials.  To move individual traces, first 
press the F4 (Trial / Trace) function key to change the selection 
mode. 
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When positioning is completed, press the F6 (Position) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Position mode. 

 Using the Trace Position Settings - right-click the mouse over the 
Trace window and select Trace Position Settings from the pop-up 
menu.  Change the settings for Start Position, Trial Offset, and 
Channel Offset and click OK. 

9.  Place Auto Cursors 

To place Cursors on the important trace features, follow one of these 
procedures. 

 Using the Mouse - simply left-click on a trial to select it, the trial 
will be displayed in yellow.  Now, right-click the mouse and select 
Auto Place Cursors from the pop-up menu.  Cursors will be 
placed on the selected trial and the values (latency, amplitude, etc.) 
derived from the cursors will be displayed in the EP Cursor Table 
window. 

 Using the Mouse and F9 (Auto Cursors) function key - simply 
left-click on a trial to select it, the trial will be displayed in yellow. 
 Now, press the F9 key.  Cursors will be placed on the selected trial 
and the values (latency, amplitude, etc.) derived from the cursors 
will be displayed in the EP Cursor Table window. 

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trial) to select 
a trial, when selected the trial will be displayed in yellow.  Once the 
appropriate trial is selected, press the F2 (AutoPlace Cursors) 
function key and cursors will be placed on the selected trial.  The 
values (latency, amplitude, etc.) derived from the cursors will be 
displayed in the EP Cursor Table window. 

After cursors have been placed, press the F5 (Cursor) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Cursor mode. 

 For information on configuring the Auto Cursors, see the SEP Test 
Protocol setup topic. 
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To Adjust the positions of the Cursors, follow one of these procedures. 

 Using the Mouse - simply click on the Cursor you want to move 
with the left mouse button and drag the cursor along the trace to its 
new location.  

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trial) to select 
the trial with the cursors you need to adjust, when selected the trial 
will be displayed in yellow.  Once the appropriate trial is selected, 
use Knob #1 (Sel Cursor / Move) to select and move the desired 
cursor. 

After cursor positions have been adjusted, press the F5 (Cursor) 
function key again or press the OK key on the Sierra Wave base unit 
to exit from Cursor mode. 

 

Example Median SEP Cursor Table. 

 The program will calculate the left minus right difference values for each 
defined measurement after cursors have been placed on one left and one 
right side trial. 

 Depending on your preferences in System Setup, abnormal values can 
be flagged with a red background color, as bold text, as bold text with an 
asterisk, or as bold text & background color red. 

10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 
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To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Test 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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AEP - Basic Operation 

Select the AEP  Test: 

 If a Study has already been selected, simply click on the AEP test 
protocol within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the AEP test protocol from the Study/Test menu. 

 

Once the AEP test has been selected.  Follow these steps for performing 
data acquisition: 

1.  Apply electrodes to the patient and connect to amplifier 

Determine the number of channels that will be recorded and the electrodes 
that will be required for each channel.  Apply the recording electrodes and 
ground electrode to the patient and connect to the Sierra Wave amplifier. 

2.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the selected AEP test. 

Typical AEP Settings 

Gain = 0.2 to 0.5 uV/Div 

Hicut = 3k Hz 

Locut = 100 Hz 

Sweep Speed = 1.0 ms/Div 

A Common Reference (CREF) input is available on the 4 Channel Amplifier. 
 The status of the CREF input, Off or On for each channel, will depend on the 
montage chosen for the test.  If the amplifier channel should use its 
corresponding individual reference input (i.e., reference 1, 2, 3, or 4) the 
CREF setting should be set to OFF.  If the channel should not use its 
individual reference input, but should use the CREF input in its place, then the 
CREF setting should be set to ON. 

The Notch filter is typically not used during AEP recordings and should 
remain OFF. 
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2Ch. AEP Default Settings. 

3.  Check Impedances 

Press the Imped key on the Sierra Wave base unit.  The impedance window 
displays a picture of the front of the amplifier. 

 

Impedance window.  Channels 3 & 4 are turned Off.  CREF is turned OFF. 

The Active (black) and Reference (red) inputs are displayed for each 
channel as well as the CREF input (4 Channel Amplifier only).  The Ground 
input is not included in impedance measurements. 

If a Channel is turned Off, no impedance values will be calculated for either 
the active or reference inputs and the word "Off" is displayed over the inputs 
of that channel. 
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When the CREF input is enabled (i.e., ON) for a channel, that channel's 
reference input will not show an impedance value and will have the word "Off" 
over the reference input.  An impedance value for the CREF input will be 
displayed. 

Impedances less than 5k Ohms (kilo-ohms) are displayed in green.  Values 
between 5.1 and 20 are displayed in yellow.  Values greater than 20 are 
displayed in red. 

To close the impedance window, press the Imped key again or click the OK 
button. 

 When performing evoked potential studies all impedances should be 
less than 5k Ohms. 

4.  Select Side of Stimulation 

Make sure the appropriate side, Right or Left, is selected.   

5.  Check Stimulator Settings 

Apply the stimulator (headphones or inserts) to the patient, the red 
headphone/insert should be placed on the patient's right side, the blue 
headphone/insert should be placed on the left.  Connect the stimulator  to the 
back of the Sierra Wave base unit. 

 

AEP Stimulator Settings - Controls Window 

 

AEP Stimulator Settings - Controls Toolbar 

Mode:  Click here to select the auditory stimulus type, choose either Click, 
Tone, Pip202, or Pip212. 

 Click - this is a 100 microsecond click stimulus. 

 Tone - by default this is a 10-30-10 tone burst stimulus.  It has a 10 
millisecond rise time, a 30 millisecond plateau, and a 10 millisecond 
fall time.  This stimulus is typically used for long latency auditory 
evoked potentials. 
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 Pip 202 or Pip 212 - these are also tone stimuli but their rise, plateau, 
and fall times are measured in cycles rather than milliseconds.  The 2-
0-2 Pip has a 2 cycle rise, 0 cycle plateau, and 2 cycle fall.  The 2-1-2 
Pip has a 2 cycle rise, 1 cycle plateau, and a 2 cycle fall. 

 Frequency - when Tone, Pip202, or Pip212 are selected a Frequency 
setting will be displayed.  Click here to select the frequency of the 
tone/pip.  The choices are 250, 500, 750, 1000, 2000, 3000, 4000, 
6000, and 8000 Hz. 

 R/P/F - when Tone, Pip202, or Pip212 are selected the rise, plateau, 
and fall values are shown here.  Click here to change these values. 

 

Change the rise, plateau, and fall values for a Tone or Pip. 

 Envelope - when Tone, Pip202, or Pip212 are selected a stimulus 
envelope can be selected here.  Choices are None, Linear, Blackman, 
Hanning, and Gaussian. 

Type:  Click here to select the type of stimulus delivery hardware, choose 
either Phones or Inserts. 

 When Inserts are selected the program will automatically subtract 
1.0 milliseconds from all latency calculations to compensate for the delay 
produced by the plastic tubing.  This delay value can be modified by 
clicking on the Acoustic Delay value.  This value does not shift the 
displayed trace. 

Polarity:  Click here to set the stimulus polarity, the choices vary depending 
on the stimulus type. 

 For Click - choose either Rarefaction, Condensation, or Alternating 
polarity. 

 For Tone or Pip -  choose either Negative, Positive, or Alternating 
polarity. 



Sierra Wave Help Manual 

92 

Intensity L-R:  Click here to set the starting stimulus intensity value.  The first 
column is for the left side, the second column is for the right side. 

 To avoid excessive auditory stimulation, ensure that the stimulus 
intensity never exceeds 75 dB above the hearing threshold. 

Threshold L-R:  Indicates the behavioral threshold value.  The first column is 
for the left side, the second column is for the right side.  During data 
acquisition the Threshold values are added to the Intensity values to produce 
the stimulus at the headphones/inserts.  See step #6 for instructions on 
determining thresholds. 

Intensity Units:  Choose either nHL (normalized hearing level) or SPL 
(sound pressure level).  When SPL is selected the Threshold settings are 
disabled. 

dB Incr:  Click here to change the intensity value scale.  The default 
setting is 1 dB increments, choices are 1, 2, 5 and 10. 

Mask:  Click here to set the "white" noise masking as either On or Off and to 
set the level for the non-stimulated ear.  The amount selected is the number 
of dB's below the Intensity value.  This is known as differential masking and 
allows the intensity of the masking noise to decrease automatically as the 
intensity of the stimulus is decreased. 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz). 

6.  Determine Behavioral Threshold Levels (optional) 

There are two specially designated knobs for setting the behavioral threshold 
levels.  Knob #2 (L Thresh/Off) and Knob #3 (R Thresh/Off).  To determine 
the threshold levels follow these steps. 

I. Turn Knob #2.  Stimuli will be automatically delivered to the left ear 
and the threshold value for the left ear will turn "yellow". 

II. Continue to turn Knob #2 until the patient can definitely hear the 
stimulus. 

III. Slowly turn Knob #2 in the reverse direction to decrease the 
threshold level.  Keep decreasing the level until the patient signals 
that they can no longer hear, or can just barely hear, the stimulus. 

IV. Press Knob #2 to stop stimulus delivery and set the threshold 
value for the left ear. 

V. Repeat the above steps for the right ear using Knob #3. 
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 The threshold value is automatically added to the intensity value to 
obtain the output level for the stimulator.  For example, if the left intensity was 
set to 70 dB and the left threshold was determined to be 12 dB, the actual 
output intensity from the stimulator would be 82 (70 + 12). 

7.  Verify Averager Settings 

Shutoff - This is the number of responses that will be averaged together to 
produce the final results.  When the shutoff count is reached stimulation will 
automatically be stopped. 

Reject On / Off - When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the percentage 
(%) of stimuli/sweeps that have been rejected from the total delivered will be 
displayed on the screen. 

Level - This is the reject sensitivity level, it is shown as a percentage of full 
amplifier scale.  Choices are 30 to 100 % in increments of 5.  100% equals 
full scale, smaller numbers will make the reject more sensitive. 

 

AEP Default Averager Settings. 

 Reject is based on the Live un-averaged data and the Amp Gain 
setting.  Every channel has 5 divisions above and below its initial baseline. 
 So, if the Amp Gain is set to 10 uV/Div this means that the Live trace has an 
amplitude window of 100 microvolts (10 vertical divisions times 10 uV/Div) 
with 50 uV above the baseline and 50 uV below the baseline.  If the reject 
level is set to 100% (i.e., full scale), then the amplitude of the live data must 
be below +/- 50 uV to be included in the running average.  Should it exceed 
+/- 50 uV the trace will be rejected from the running average.  If the reject 
level is set to 50% (i.e., half of full scale), then the amplitude of the Live data 
can't exceed +/- 25 uV (2.5 divisions above or below the baseline) or it will be 
rejected from the running average.  The lower the reject level setting the more 
sensitive the program will be in rejecting large artifacts. 

 You can check the Amp Gain setting by pressing the F1 (Avg / Live) 
function key to switch to the Live mode.  Press the function key again to 
return to the Avg mode and view the Display Gain setting. 
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8.  Acquire Responses 

A.  Start Data Acquisition. 

Press the Run/Stop key to start stimulus delivery and data acquisition. 
 The average count (AvgCnt) should start to increment and the traces will 
begin to take shape. 

Adjust the vertical size of the all traces by turning Knob #4 (Gain).  To 
adjust the gain of an individual trace, change the corresponding gain 
setting in the amplifier section of the EP Controls window. 

Press the F3 (Smooth) function key during acquisition to remove high 
frequency noise from the active (white) traces. 

B.  Store the first trial. 

When the Shutoff count is reached, stimulation will stop automatically. 
 Press the Store key to store the active (white) traces.  A copy of the 
active traces will appear on the screen and are displayed in a purple color. 

 The Store key can be pressed before the Shutoff count is reached. 
 This will cause the currently active traces to be stored, the average count 
will be reset to zero, and stimulation will continue automatically on a new 
set of traces. 

C.  Clear the Average Count. 

Press the Clear key to reset the average count (AvgCnt) back to zero. 
 The active (white) traces will be reset to flat lines. 

D.  Acquire a second Trial 

Press the Run/Stop key to start stimulus delivery and data acquisition 
again.  Generally, two trials should always be acquired when performing 
evoked potentials to show replication of the traces. 

E.  Store second trial and Clear. 

After the Shutoff count is reached for the second trial, press the Store key 
to store the active (white) traces.  Press the Clear key to reset the 
average count to zero. 

F.  Change Side of Stimulation. 

To acquire traces for the opposite side, change the Side setting in the EP 
Controls window.  If you are using the Split Screen feature the active 
(white) traces will automatically move to the opposite side of the Trace 
window. 

G.  Repeat steps A - E and collect data for the opposite side. 
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Example 2 Channel AEP, Left and Right. 

9.  Trace Positioning (optional) 

If the position of the traces needs to be adjusted, follow one of these 
procedures. 

 Using the Mouse - simply click on the Trace you want to move 
with the left mouse button and drag the trace to its new location. 

 Using the Knobs - press the F6 (Position) function key on the 
PC's keyboard.  The program's knob and function keys will change 
to reflect the position mode controls.  Use Knob #1 (Sel Trace / 
Move) to select and move traces. 

When positioning is completed, press the F6 (Position) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Position mode. 

 Using the Trace Position Settings - right-click the mouse over the 
Trace window and select Trace Position Settings from the pop-up 
menu.  Change the settings for Start Position, Trial Offset, and 
Channel Offset and click OK. 

10.  Place Auto Cursors 

To place Cursors on the important trace features, follow one of these 3 
procedures. 
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 Using the Mouse - simply left-click on a trace to select it, the 
trace will be displayed in yellow.  Now, right-click the mouse and 
select Auto Place Cursors from the pop-up menu.  Cursors will be 
placed on the selected trace and the values (latency, amplitude, 
etc.) derived from the cursors will be displayed in the EP Cursor 
Table window. 

 Using the Mouse and F9 (Auto Cursors) function key - simply 
left-click on a trace to select it, the trace will be displayed in 
yellow.  Now, press the F9 key.  Cursors will be placed on the 
selected trace and the values (latency, amplitude, etc.) derived 
from the cursors will be displayed in the EP Cursor Table window. 

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select a trace, when selected the trace will be displayed in yellow. 
 Once the appropriate trace is selected, press the F2 (AutoPlace 
Cursors) function key and cursors will be placed on the selected 
trace.  The values (latency, amplitude, etc.) derived from the 
cursors will be displayed in the EP Cursor Table window. 

After cursors have been placed, press the F5 (Cursor) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Cursor mode. 

 For information on configuring the Auto Cursors, see the AEP Test 
Setup topic. 

To Adjust the positions of the Cursors, follow one of these procedures. 

 Using the Mouse - simply click on the Cursor you want to move 
with the left mouse button and drag the cursor along the trace to its 
new location.  

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select the trace with the cursors you need to adjust, when selected 
the trace will be displayed in yellow.  Once the appropriate trace is 
selected, use Knob #1 (Sel Cursor / Move) to select and move the 
desired cursor. 

After cursor positions have been adjusted, press the F5 (Cursor) 
function key again or press the OK key on the Sierra Wave base unit 
to exit from Cursor mode. 
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AEP cursor table example. 

 The program will calculate the left minus right difference values for each 
defined measurement after cursors have been placed on one left and one 
right side trace. 

 Depending on your preferences in System Setup, abnormal values can 
be flagged with a red background color, as bold text, as bold text with an 
asterisk, or as bold text & background color red. 

11.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 
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12.  Next Test 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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VEP - Basic Operation 

Select the VEP  Test: 

 If a Study has already been selected, simply click on the VEP test 
protocol within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the VEP test protocol from the Study/Test menu. 

 

Once the VEP test has been selected.  Follow these steps for performing 
data acquisition: 

1.  Apply electrodes to the patient and connect to amplifier 

Determine the number of channels that will be recorded and the electrodes 
that will be required for each channel.  Apply the recording electrodes and 
ground electrode to the patient and connect to the Sierra Wave amplifier. 

2.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the selected VEP test. 

Typical VEP Settings 

Gain = 5 uV/Div 

Hicut = 200 Hz 

Locut = 1 Hz 

Sweep Speed = 25 ms/Div 

A Common Reference (CREF) input is available on the 4 Channel Amplifier. 
 The status of the CREF input, Off or On for each channel, will depend on the 
montage chosen for the test.  If the amplifier channel should use its 
corresponding individual reference input (i.e., reference 1, 2, 3, or 4) the 
CREF setting should be set to OFF.  If the channel should not use its 
individual reference input, but should use the CREF input in its place, then the 
CREF setting should be set to ON. 

The Notch filter is typically not used during VEP recordings and should 
remain OFF. 
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Default VEP Amplifier Settings. 

3.  Check Impedances 

Press the Imped key on the Sierra Wave base unit.  The impedance window 
displays a picture of the front of the amplifier. 

 

Impedance window.  Channels 2, 3, & 4 are turned Off.  CREF is turned Off for Channel 1. 

The Active (black) and Reference (red) inputs are displayed for each 
channel as well as the CREF input (4 Channel Amplifier only).  The Ground 
input is not included in impedance measurements. 
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If a Channel is turned Off, no impedance values will be calculated for either 
the active or reference inputs and the word "Off" is displayed over the inputs 
of that channel. 

When the CREF input is enabled (i.e., ON) for a channel, that channel's 
reference input will not show an impedance value and will have the word "Off" 
over the reference input.  An impedance value for the CREF input will be 
displayed. 

Impedances less than 5k Ohms (kilo-ohms) are displayed in green.  Values 
between 5.1 and 20 are displayed in yellow.  Values greater than 20 are 
displayed in red. 

To close the impedance window, press the Imped key again or click the OK 
button. 

 When performing evoked potential studies all impedances should be 
less than 5k Ohms. 

4.  Select Side of Stimulation 

Make sure the appropriate side, Right or Left, is selected.   

5.  Check Stimulator Settings 

Connect the VEP stimulator to the appropriate connector on the back of the 
Sierra Wave base unit.  Position the stimulator at the required distance from 
the patient.  Cover the non-stimulated eye. 

 

VEP Default Stimulator Settings - Controls Window 

 

VEP Stimulator Settings - Controls Toolbar 

Mode:  Click here to select the type of visual stimulus.  Choices are Checks, 
Goggles, LED, and Flash. 
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 Checks - selects a reversing black & white checkerboard pattern. 
 When checks are selected as the stimulus type the following 
additional parameters are available. 

o Target - select either On or Off.  When turned On a small target 
is positioned in the center of the black & white monitor, the 
patient should focus on this target during data acquisition. 

o Checks - click here to select the number of checks displayed 
across a horizontal row.  The choices are 1, 2, 4, 8, 16, 32, 64, 
and 128 (default is 32 checks with monitor positioned about 1 
meter from patient). 

o Field - click in this area to select the field of stimulation.  The 
choices are Full Field, Upper Half,  Right Half, Lower Half, Left 
Half, Left Upper Quarter, Right Upper Quarter, Right Lower 
Quarter, and Left Lower Quarter (default is Full Field). 

 Goggles - selects the LEG Goggles. 

 LED - selects the 3 inch hand held LED checkerboard stimulator. 

 Flash - selects the strobe flash stimulator. 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz). 

If you are using a LCD Television Monitor, rather than a CRT Monitor, 
please refer to the document "291218-933 - Setup Instructions for LCD 
Checkerboard Monitor.pdf".  LCD monitors have different screen drawing 
characteristics than CRT monitors, and as such a compensatory delay (or 
offset) has to be determined and entered into the Sierra Wave program 
before an LCD monitor can be used.  Without this delay value entered into the 
program the latency of the visual evoked potentials will be greatly prolonged. 

6.  Verify Averager Settings 

Shutoff - This is the number of responses that will be averaged together to 
produce the final results.  When the shutoff count is reached stimulation will 
automatically be stopped. 

Reject On / Off - When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the percentage 
(%) of stimuli/sweeps that have been rejected from the total delivered will be 
displayed on the screen. 

Level - This is the reject sensitivity level, it is shown as a percentage of full 
amplifier scale.  Choices are 30 to 100 % in increments of 5.  100% equals 
full scale, smaller numbers will make the reject more sensitive. 



Getting Started - The Basics 

103 

 

VEP Default Averager Settings. 

 Reject is based on the Live un-averaged data and the Amp Gain 
setting.  Every channel has 5 divisions above and below its initial baseline. 
 So, if the Amp Gain is set to 10 uV/Div this means that the Live trace has an 
amplitude window of 100 microvolts (10 vertical divisions times 10 uV/Div) 
with 50 uV above the baseline and 50 uV below the baseline.  If the reject 
level is set to 100% (i.e., full scale), then the amplitude of the live data must 
be below +/- 50 uV to be included in the running average.  Should it exceed 
+/- 50 uV the trace will be rejected from the running average.  If the reject 
level is set to 50% (i.e., half of full scale), then the amplitude of the Live data 
can't exceed +/- 25 uV (2.5 divisions above or below the baseline) or it will be 
rejected from the running average.  The lower the reject level setting the more 
sensitive the program will be in rejecting large artifacts. 

 You can check the Amp Gain setting by pressing the F1 (Avg / Live) 
function key to switch to the Live mode.  Press the function key again to 
return to the Avg mode and view the Display Gain setting. 

7.  Acquire Responses 

A.  Start Data Acquisition. 

Press the Run/Stop key to start stimulus delivery and data acquisition. 
 The average count (AvgCnt) should start to increment and the traces will 
begin to take shape. 

Adjust the vertical size of the all traces by turning Knob #4 (Gain).  To 
adjust the gain of an individual trace, change the corresponding gain 
setting in the amplifier section of the EP Controls window. 

Press the F3 (Smooth) function key during acquisition to remove high 
frequency noise from the active (white) traces. 

B.  Store the first trial. 

When the Shutoff count is reached, stimulation will stop automatically. 
 Press the Store key to store the active (white) traces.  A copy of the 
active traces will appear on the screen and are displayed in a purple color. 

 The Store key can be pressed before the Shutoff count is reached. 
 This will cause the currently active traces to be stored, the average count 
will be reset to zero, and stimulation will continue automatically on a new 
set of traces. 
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C.  Clear the Average Count. 

Press the Clear key to reset the average count (AvgCnt) back to zero. 
 The active (white) traces will be reset to flat lines. 

D.  Acquire a second Trial 

Press the Run/Stop key to start stimulus delivery and data acquisition 
again.  Generally, two trials should always be acquired when performing 
evoked potentials to show replication of the traces. 

E.  Store second trial and Clear. 

After the Shutoff count is reached for the second trial, press the Store key 
to store the active (white) traces.  Press the Clear key to reset the 
average count to zero. 

F.  Change Side of Stimulation. 

To acquire traces for the opposite side, change the Side setting in the EP 
Controls window.  If you are using the Split Screen feature the active 
(white) traces will automatically move to the opposite side of the Trace 
window. 

G.  Repeat steps A - E and collect data for the opposite side. 

 

Example VEP, single channel recording, Left & Right. 
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8.  Trace Positioning (optional) 

If the position of the traces needs to be adjusted, follow one of these 
procedures. 

 Using the Mouse - simply click on the Trace you want to move 
with the left mouse button and drag the trace to its new location. 

 Using the Knobs - press the F6 (Position) function key on the 
PC's keyboard.  The program's knob and function keys will change 
to reflect the position mode controls.  Use Knob #1 (Sel Trace / 
Move) to select and move traces. 

When positioning is completed, press the F6 (Position) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Position mode. 

 Using the Trace Position Settings - right-click the mouse over the 
Trace window and select Trace Position Settings from the pop-up 
menu.  Change the settings for Start Position, Trial Offset, and 
Channel Offset and click OK. 

9.  Place Auto Cursors 

To place Cursors on the important trace features, follow one of these 
procedures. 

 Using the Mouse - simply left-click on a trace to select it, the 
trace will be displayed in yellow.  Now, right-click the mouse and 
select Auto Place Cursors from the pop-up menu.  Cursors will be 
placed on the selected trace and the values (latency, amplitude, 
etc.) derived from the cursors will be displayed in the EP Cursor 
Table window. 

 Using the Mouse and F9 (Auto Cursors) function key - simply 
left-click on a trace to select it, the trace will be displayed in 
yellow.  Now, press the F9 key.  Cursors will be placed on the 
selected trace and the values (latency, amplitude, etc.) derived 
from the cursors will be displayed in the EP Cursor Table window. 

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select a trace, when selected the trace will be displayed in yellow. 
 Once the appropriate trace is selected, press the F2 (AutoPlace 
Cursors) function key and cursors will be placed on the selected 
trace.  The values (latency, amplitude, etc.) derived from the 
cursors will be displayed in the EP Cursor Table window. 
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After cursors have been placed, press the F5 (Cursor) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Cursor mode. 

 For information on configuring the Auto Cursors, see the VEP Test 
Setup topic. 

To Adjust the positions of the Cursors, follow one of these procedures. 

 Using the Mouse - simply click on the Cursor you want to move 
with the left mouse button and drag the cursor along the trace to its 
new location.  

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select the trace with the cursors you need to adjust, when selected 
the trace will be displayed in yellow.  Once the appropriate trace is 
selected, use Knob #1 (Sel Cursor / Move) to select and move the 
desired cursor. 

After cursor positions have been adjusted, press the F5 (Cursor) 
function key again or press the OK key on the Sierra Wave base unit 
to exit from Cursor mode. 

 

VEP cursor table example. 

 The program will calculate the left minus right difference values for each 
defined measurement after cursors have been placed on one left and one 
right side trace. 

 Depending on your preferences in System Setup, abnormal values can 
be flagged with a red background color, as bold text, as bold text with an 
asterisk, or as bold text & background color red. 
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10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Test 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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P300 - Basic Operation 

Select the P300  Test: 

 If a Study has already been selected, simply click on the P300 test 
protocol within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the P300 test protocol from the Study/Test menu. 

 

Once the P300 test has been selected.  Follow these steps for performing 
data acquisition: 

1.  Apply electrodes to the patient and connect to amplifier 

Determine the number of channels that will be recorded and the electrodes 
that will be required for each channel.  Apply the recording electrodes and 
ground electrode to the patient and connect to the Sierra Wave amplifier. 

2.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the selected P300 test. 

Typical P300 Settings 

Gain = 2.0 uV/Div 

Hicut = 30-100 Hz 

Locut = 1 Hz 

Sweep Speed = 75 - 100 ms/Div 

A Common Reference (CREF) input is available on the 4 Channel Amplifier. 
 The status of the CREF input, Off or On for each channel, will depend on the 
montage chosen for the test.  If the amplifier channel should use its 
corresponding individual reference input (i.e., reference 1, 2, 3, or 4) the 
CREF setting should be set to OFF.  If the channel should not use its 
individual reference input, but should use the CREF input in its place, then the 
CREF setting should be set to ON. 

The Notch filter is typically not used during P300 recordings and should 
remain OFF. 
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3 Ch. P300 Settings. 

3.  Check Impedances 

Press the Imped key on the Sierra Wave base unit.  The impedance window 
displays a picture of the front of the amplifier. 

 

Impedance window.  Channel 4 is turned Off.  CREF is turned ON for Channels 1 & 2 & 3. 

The Active (black) and Reference (red) inputs are displayed for each 
channel as well as the CREF input (4 Channel Amplifier only).  The Ground 
input is not included in impedance measurements. 

If a Channel is turned Off, no impedance values will be calculated for either 
the active or reference inputs and the word "Off" is displayed over the inputs 
of that channel. 

When the CREF input is enabled (i.e., ON) for a channel, that channel's 
reference input will not show an impedance value and will have the word "Off" 
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over the reference input.  An impedance value for the CREF input will be 
displayed. 

Impedances less than 5k Ohms (kilo-ohms) are displayed in green.  Values 
between 5.1 and 20 are displayed in yellow.  Values greater than 20 are 
displayed in red. 

To close the impedance window, press the Imped key again or click the OK 
button. 

 When performing evoked potential studies all impedances should be 
less than 5k Ohms. 

4.  Check Stimulator Settings 

Clinical recordings of the P300 are generally performed using a binaural 
auditory tone stimulus, commonly referred to as the auditory odd-ball 
paradigm.  Typically, two easily discriminable tones of different pitches are 
presented in random order.  One of the two tones occurs more often than the 
other and is designated the Common tone.  The other tone is designated the 
Rare tone.  This outline will assume that an auditory stimulus will be used for 
both the Common and Rare stimuli. 

Apply the stimulator (headphones or inserts) to the patient, the red 
headphone/insert should be placed on the patient's right side, the blue 
headphone/insert should be placed on the left.  Connect the stimulator  to the 
back of the Sierra Wave base unit. 

 

P300 Stimulator Controls Toolbar 

Common Stim:  These settings are used to configure the Common 
stimulus. 

 Type - can be set to Audio, Visual, Electrical, or '.Wav' file.  Audio 
is the default setting. 

 Mode - can be set to Click, Pip 202, Pip 212, or Tone.  Tone is the 
default setting and it is a 10-30-10 tone burst.  It has a 10 
millisecond rise time, a 30 millisecond plateau, and a 10 millisecond 
fall time.  

 Int - sets the intensity of the common stimulus in nHL values.  65 
dB is the default setting. 
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 Frequency - click here to select the frequency of the tone.  The 
default setting is 1000 Hz. 

 Side - can be set to Right, Left, or Bilateral.  The default setting is 
Bilateral. 

 Env. - when Tone, Pip202, or Pip212 are selected a stimulus 
envelope can be selected here.  Choices are None, Linear, 
Blackman, Hanning, and Gaussian. 

 R/P/F - when Tone, Pip202, or Pip212 are selected the rise, 
plateau, and fall values are shown here.  Click here to change 
these values. 

 

Change the rise, plateau, and fall values for a Tone or Pip. 

Rare Stim:  These settings are used to configure the Rare stimulus. 

 Type - can be set to Audio, Visual, Electrical, or '.Wav' file.  Audio 
is the default setting. 

 Mode - can be set to Click, Pip 202, Pip 212, or Tone.  Tone is the 
default setting and it is a 10-30-10 tone burst.  It has a 10 
millisecond rise time, a 30 millisecond plateau, and a 10 millisecond 
fall time.  

 Int - sets the intensity of the common stimulus in nHL values.  65 
dB is the default setting. 

 Frequency - click here to select the frequency of the tone.  The 
default setting is 3000 Hz. 

 Side - can be set to Right, Left, or Bilateral.  The default setting is 
Bilateral. 
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 Env. - when Tone, Pip202, or Pip212 are selected a stimulus 
envelope can be selected here.  Choices are None, Linear, 
Blackman, Hanning, and Gaussian. 

 R/P/F - when Tone, Pip202, or Pip212 are selected the rise, 
plateau, and fall values are shown here.  Click here to change 
these values. 

RepRate:  Click here to set the repetitive stimulus rate, in pulses per 
second (Hz).  The default setting is 0.97. 

Rare %:  Click here to set the percentage of Rare stimuli that will be 
delivered.  The default setting is 20 %. 

 To avoid excessive auditory stimulation, ensure that the stimulus 
intensity never exceeds 75 dB above the hearing threshold. 

5.  Verify Averager Settings 

AvgCnt - The second number displayed here is the total number of stimuli 
(Common + Rare) that will be delivered.  When this number is reached 
stimulation will automatically be stopped.  The default is 200 (160 Common, 
40 Rare). 

Reject On / Off - When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the number of 
stimuli/sweeps that have been rejected for both the Common and Rare stimuli 
will be displayed on the screen. 

Level - This is the reject sensitivity level, it is shown as a percentage of full 
amplifier scale.  Choices are 30 to 100 % in increments of 5.  100% equals 
full scale, smaller numbers will make the reject more sensitive. 

 

P300 Default Averager Settings. 

 Reject is based on the Live un-averaged data and the Amp Gain 
setting.  Every channel has 5 divisions above and below its initial baseline. 
 So, if the Amp Gain is set to 10 uV/Div this means that the Live trace has an 
amplitude window of 100 microvolts (10 vertical divisions times 10 uV/Div) 
with 50 uV above the baseline and 50 uV below the baseline.  If the reject 
level is set to 100% (i.e., full scale), then the amplitude of the live data must 
be below +/- 50 uV to be included in the running average.  Should it exceed 
+/- 50 uV the trace will be rejected from the running average.  If the reject 
level is set to 50% (i.e., half of full scale), then the amplitude of the Live data 
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can't exceed +/- 25 uV (2.5 divisions above or below the baseline) or it will be 
rejected from the running average.  The lower the reject level setting the more 
sensitive the program will be in rejecting large artifacts. 

 You can check the Amp Gain setting by pressing the F1 (Avg / Live) 
function key to switch to the Live mode.  Press the function key again to 
return to the Avg mode and view the Display Gain setting. 

6.  Acquire Responses 

A.  Start Data Acquisition. 

It is important that the patient attend to the stimuli.  This is facilitated by 
having the patient keep a mental record of the number of Rare tones (i.e., 
higher pitched tones) that are presented during the test.  Drowsiness 
should be avoided, as well as distracting noises. 

Press the Run/Stop key to start stimulus delivery and data acquisition. 
 The average count (AvgCnt) should start to increment and the traces will 
begin to take shape. 

The P300 program has dual averager banks.  The Common stimuli are 
averaged in the first averager bank and the corresponding traces are 
displayed in the left half of the trace window.  The Rare stimuli are 
averaged in the second averager bank and the corresponding traces are 
displayed in the right half of the trace window. 

Adjust the vertical size of the all traces by turning Knob #4 (Gain).  To 
adjust the gain of an individual trace, change the corresponding gain 
setting in the amplifier section of the EP Controls window or Toolbar. 

Press the F3 (Smooth) function key during acquisition to remove high 
frequency noise from the active (white) traces. 

B.  Store the first trial. 

When the Shutoff count is reached, stimulation will stop automatically. 
 Press the Store key to store the active (white) traces.  A copy of the 
active traces will appear on the screen and are displayed in a purple color. 

 The Store key can be pressed before the Shutoff count is reached. 
 This will cause the currently active traces to be stored, the average count 
will be reset to zero, and stimulation will continue automatically on a new 
set of traces. 

Ask the patient how many Rare stimuli they counted.  Compare this with 
the number shown in the AvgCnt column. 
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C.  Clear the Average Count. 

Press the Clear key to reset the average count (AvgCnt) back to zero. 
 The active (white) traces will be reset to flat lines. 

D.  Acquire a second Trial 

Press the Run/Stop key to start stimulus delivery and data acquisition 
again.  Generally, two trials should always be acquired when performing 
evoked potentials to show replication of the traces.  Again, ask the patient 
to count the Rare stimuli. 

E.  Store second trial and Clear. 

After the Shutoff count is reached for the second trial, press the Store key 
to store the active (white) traces.  Press the Clear key to reset the 
average count to zero. 

F.  Perform a Grand Average (Optional) 

Press the F7 (Grand Avg) function key.  Performing a Grand Average can 
enhance the principle peaks.  A 'blue' trace, representing the grand 
average of all traces acquired from that channel, will be shown for each 
channel in the montage. 
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Example 3 Channel P300.  Cursors have been placed on the Grand Average trace for the 
Cz-A1A2 channel. 

7.  Trace Positioning (optional) 

If the position of the traces needs to be adjusted, follow one of these 
procedures. 

 Using the Mouse - simply click on the Trace you want to move 
with the left mouse button and drag the trace to its new location. 

 Using the Knobs - press the F6 (Position) function key on the 
PC's keyboard.  The program's knob and function keys will change 
to reflect the position mode controls.  Use Knob #1 (Sel Trace / 
Move) to select and move traces. 

When positioning is completed, press the F6 (Position) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Position mode. 

 Using the Trace Position Settings - right-click the mouse over the 
Trace window and select Trace Position Settings from the pop-up 
menu.  Change the settings for Start Position, Trial Offset, and 
Channel Offset and click OK. 
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8.  Place Auto Cursors 

To place Cursors on the important trace features, follow one of these 
procedures. 

 Using the Mouse - simply left-click on a trace to select it, the 
trace will be displayed in yellow.  Now, right-click the mouse and 
select Auto Place Cursors from the pop-up menu.  Cursors will be 
placed on the selected trace and the values (latency, amplitude, 
etc.) derived from the cursors will be displayed in the EP Cursor 
Table window. 

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select a trace, when selected the trace will be displayed in yellow. 
 Once the appropriate trace is selected, press the F2 (AutoPlace 
Cursors) function key and cursors will be placed on the selected 
trace.  The values (latency, amplitude, etc.) derived from the 
cursors will be displayed in the EP Cursor Table window. 

After cursors have been placed, press the F5 (Cursor) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Cursor mode. 

 For information on configuring the Auto Cursors, see the P300 Test 
Setup topic. 

To Adjust the positions of the Cursors, follow one of these procedures. 

 Using the Mouse - simply click on the Cursor you want to move 
with the left mouse button and drag the cursor along the trace to its 
new location.  

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select the trace with the cursors you need to adjust, when selected 
the trace will be displayed in yellow.  Once the appropriate trace is 
selected, use Knob #1 (Sel Cursor / Move) to select and move the 
desired cursor. 

After cursor positions have been adjusted, press the F5 (Cursor) 
function key again or press the OK key on the Sierra Wave base unit 
to exit from Cursor mode. 
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P300 cursor table example. 

 Depending on your preferences in System Setup, abnormal values can 
be flagged with a red background color, as bold text, as bold text with an 
asterisk, or as bold text & background color red. 

9.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

10.  Next Test 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 
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 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

 

The TabData Window 

The TabData window provides an overview of all tests completed on the patient 
as well as summary tables for test protocols such as NCV, F/H, and EMG.  An 
optional Sentence Generator is available to create sentences describing the 
EMG and NCV results. 

To open the TabData window press the F4 (TabData) function key from within 
any test protocol or select TabData from the View menu. 

Completed test protocols are listed down the left-hand side of the window. 
  To select a test protocol or summary table perform one of the following 
actions. 

 Turn Knob #1 (Select / Open) to move the blue highlight to the 
desired test protocol or table. 

 Click the left mouse button on the test protocol or table. 

The highlighted entry's results are displayed on the right-hand side of the 
TabData window. 
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TabData window with All NCV summary tables selected. 

 

Actions that can be performed in the TabData window: 

Adjusting Auto Cursor Positions 

Begin by highlighting an individual test protocol, such as Right Median Motor. 
 The test's traces and cursor table will be displayed on the right-hand side of 
the window. 

Click on a cursor using the left mouse button and drag it along the trace to its 
new location.  The information in the cursor table will be updated to reflect the 
new position. 

Trace Context (pop-up) Menu 

Whenever traces are displayed in the right-hand side of the TabData window 
you can right-click the mouse over the trace area to display the same context 
menu that is available during data acquisition. 
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Use this context menu to delete traces, smooth traces, etc. 

Change Muscle Scoring 

If an EMG Muscle Scoring Table is selected you can change the muscle 
scoring selections for a muscle simply by clicking with the left mouse button 
within the table. 

Sorting Muscle Scoring Table 

If an EMG Muscle Scoring Table is selected you can click the mouse at the 
top of any of the table's columns to sort the table according to that column's 
information.  To reverse the sorting, right-click the mouse over the muscle 
scoring table and select "Original Sort Order" from the pop-up menu. 

NCV Column Setup 

When a NCV Summary table or individual nerve test protocol is selected the 
Change Columns button is available. 

Clicking on Change Columns allows you to specify how the NCV results will 
be shown in your reports.  This does not change how the results are 
displayed during data acquisition. 

Click on the Nerve Type you want to change.  To include information in 
reports, click at the bottom of the displayed column, or within the column, and 
then select Insert from the pop-up menu.  Select the value you want to 
include in the report from the displayed list of choices.  To remove information 
in reports, click on the value displayed in the column, then select Delete from 
the pop-up menu. 

 

NCV - Change Columns window. 
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Sorting within the NCV, F Wave, and H Reflex Summary Tables 

When a NCV Summary table or individual nerve test protocol is selected the 
Sort Options button is available. 

Clicking on this button allows you to specify how the NCV, F Wave, and H 
Reflex  results will be sorted  within the summary tables. 

 

NCV/F/H Sorting Options 

 Alphbetical by Nerve Name (Left then Right) - when this option is selected the 
nerves are sorted alphabetically by nerve name, Left side first and then Right side. 

 Alphbetical by Nerve Name (Right then Left) - when this option is selected the 
nerves are sorted alphabetically by nerve name, Right side first and then Left side. 

 By Side (Right then Left) - when this option is selected the nerves are sorted with 
Right side before Left side (all right-sided nerves and then all left-sided nerves). 

 By Side (Left then Right) - when this option is selected the nerves are sorted with 
Left side before Right side (all left-sided nerves and then all right-sided nerves). 

 

Swap Sides 

When an individual NCV, F Wave, or H Reflex test protocol is selected the 
Swap Side button can be used to swap the side parameter of the selected 
test. 

 If the side you are swapping to doesn't already exist within the Study 
window, then that nerve will automatically be added. 

 If the side you are swapping to already has stored traces, then a second 
run will be automatically added to that existing nerve. 
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Override an Abnormal Value 

When an individual test protocol is selected you can right click over an 
abnormal value and then select Set As Normal from the pop-up menu.  The 
abnormal value flag will be removed from that value.  To reset the abnormal 
value flag, right click over the value a second time and click on Set As Normal 
to remove the check mark. 

 

Assign an Abnormal Severity Meaning 

If you have the optional integrated sentence generator enabled, you can right 
click over an abnormal value to display a list of possible meanings.  An 
asterisk indicates the sentence generator's currently assigned default 
meaning for the value.  You can override the default meaning by selecting 
one of the additional meanings from the list. 

 

Playback an EMG Buffer 

When a stored EMG Buffer is selected, the compressed buffer trace will be 
shown in the right hand portion of the TabData window.  Use the playback 
controls to replay the buffer without having to open the EMG test protocol. 

View the Custom Fields from the Patient Information window 

Clicking on the Patient Info / Report node will display the custom fields from 
the patient information window as well as the findings sentences (if enabled). 
 If a QuickReport Item has been assigned to a custom field, it can be 
processed in this view.  For more information on using custom fields, click 
here. 
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Print a Report 

Two buttons, representing the Print and Report keys on the Sierra Wave 
base unit, are displayed at the bottom of the TabData window.  The name of 
the report template that is currently assigned to these buttons is displayed as 
the button's label. 

To initiate a report. 

 Click on one of these two buttons with the mouse. 

 Press the F2 or F3 function keys. 

 Press the Print or Report keys on the Sierra Wave base unit. 

Change Report Options 

The Report Options button allows you to remove or add elements to 
generated reports without effecting the data acquisition screen or the 
TabData Summary view. 

 Flag Abnormals in Reports - when this box is checked abnormal 
values will be indicated in reports, usually as red colored boxes or 
bolded numbers. 

 Show Comments (NCV, F, H) - when this box is checked 
comments entered during NCV, F Wave, or H Reflex data 
acquisition will be displayed in the data tables of generated reports. 

 Show Norm Columns (NCV, F, H) - when this box is checked the 
normal value columns for NCV, F Wave, and H Reflex tests will be 
included in the data tables of generated reports. 

 Show Column Header Shading - when this box is checked the 
column headings at the top of each table are shaded gray. 

 Show Outside Table Lines - when this box is checked a line is 
drawn between each nerve and a box is drawn around the entire 
table.  If this box is unchecked, only the column heading row will 
remain underlined. 

 Show All Vertical Table Lines - when this box is checked a 
vertical line is drawn between each table column. 

 Show All Horizontal Table Lines - when this box is checked a 
horizontal line is drawn between each table row. 

 Convert Red Background to Grey (Best for Fax) - when this box 
is checked the abnormal values, that are usually shown as red 
colored boxes in reports, will be changed to grey colored boxes. 
 This is more suitable for reports that are being faxed to the 
referring physician. 
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Open a Test Protocol 

To open a test protocol and display the acquisition screen (this would be 
necessary to re-stimulate or collect additional traces). 

 Highlight the test protocol by turning Knob #1 (Select / Open) and 
then press to open. 

 Highlight the test protocol and then click the Open Test button. 

 Double click on the test protocol with the mouse. 

Close the TabData window 

To close the TabData window and return to the previous test protocol screen. 

 Click on the F4 (Close) button. 

 Press the F4 (Close) function key on the Sierra Wave base unit. 

 Click on the TabData window's red X  . 

 

Integrated Sentence Generator for Findings: 

The TabData window features an optional Sentence Generator which can 
build findings sentences to describe NCV, F Wave, H-Reflex, EMG, and EP 
data. 

To Enable the Sentence Generator: 

 Start the Sierra Wave program. 

 Select System Setup from the Edit menu. 

 Place a check mark in the box labeled "Show Sentence Generator in 
TabData". 

 Click OK. 

When an NCV, F Wave, or H-Reflex table node is highlighted in the TabData 
window, the findings sentences for those test protocols will be displayed 
below the summary tables. 

 

NCV, F, H findings sentences. 
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When the EMG Scoring Table is highlighted in the TabData window, the 
findings sentences for the muscle scoring will be displayed below the scoring 
table. 

 

EMG findings sentences. 

When an EP node is highlighted in the TabData window, the findings 
sentences for that evoked potential protocol will be displayed below the 
summary tables. 

 

AEP findings sentences. 

 

Editing the Findings Sentences: 

Below each sentence is a Reset, Edit, and Save button.  Click the Edit 
button if you want to make changes or additions to the generated sentences. 
 The background of the sentence area will change to white color, signifying 
that you are in the Edit mode.  The formatting controls above the sentence 
area will also be activated. 

 

Edit mode. 

Click within the sentence area and make your changes/additions. 
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Edit mode with changes. 

To save your changes, click the Save button.  The background will turn 
green, this signifies that editing has been performed and those 
changes/additions have been saved. 

 

Changes to the sentences have been saved. 

To cancel your changes or additions, click the Reset button.  The sentence 
is returned to its default state and the background color changes back to the 
non-edit mode color. 

 

Sentence has been reset to default state. 
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Generating A Report 

The Sierra Wave uses a separate program for report generation, this program is 
called QuickReport. 

To initiate a report you must select a template from within the Sierra Wave 
program.  Once a template is selected the QuickReport program will start 
automatically. 

 QuickReport is a Microsoft WordTM based application and includes such 
Word features as spell check, grammar check, table formatting, and graphics 
support. 

 QuickReport can be run stand-alone to edit and create the report templates 
used by the program. 

 

To Select a Report Template 

From within the TabData window: 

 Click on one of the two report buttons shown within the TabData 
window.  The buttons are labeled with the name of the template 
currently assigned to them. 

 Press either the Print or Report key on the Sierra Wave base unit. 

From within a Test Protocol screen: 

 Press either the Print or Report key on the Sierra Wave base unit. 

 Use the program's File Menu to select one of the following. 

Launch QuickReport & Select Template - this will start the 
QuickReport program and allow you to select any report template 
available on the system. 

Print "Template Name" for Print key - the template name currently 
assigned to the Print key on the Sierra Wave base unit is displayed 
here.  Clicking this entry will select this template and start QuickReport. 

Print "Template Name" for Report key - the template name currently 
assigned to the Report key on the Sierra Wave base unit is displayed 
here.  Clicking this entry will select this template and start QuickReport. 
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Description of the Factory Default Report Templates 

Current Test - use this template to print the results for the individual Test 
Protocol that is currently displayed on the screen.  For example, use this to 
print the results for a single NCV nerve test or a single Evoked Potential test. 
 It also includes the Chief Complaints, Medications, Physical Exam / History, 
and Impression custom fields from the Patient Information window. 

Full Report (manual Findings) - this template includes all the test protocols 
within the TabData window (tables & traces).  It also includes the Chief 
Complaints, Medications, Physical Exam / History, Impression, and 
Recommendation custom fields from the Patient Information window as well 
as an interactive Findings item for manual creation of findings sentences. 

Full Report with DataLAB - this template includes all the test protocols 
within the TabData window (tables & traces).   It also includes the Chief 
Complaints, Medications, Physical Exam / History, Impression, and 
Recommendation custom fields from the Patient Information window.  A 
Findings section automatically imports the text from the Sentence Generator 
feature of the TabData window.  The results of the DataLAB feature are also 
included in this report. 

Full Report with Sentence Gen - this template includes all the test protocols 
within the TabData window (tables & traces).   It also includes the Chief 
Complaints, Medications, Physical Exam / History, Impression, and 
Recommendation custom fields from the Patient Information window.  A 
Findings section automatically imports the text from the Sentence Generator 
feature of the TabData window. 

Full Report with SG and AV - this template includes all the test protocols 
within the TabData window (tables & traces).   It also includes the Chief 
Complaints, Medications, Physical Exam / History, Impression, and 
Recommendation custom fields from the Patient Information window.  A 
Findings section automatically imports the text from the Sentence Generator 
feature of the TabData window.  The AnatomyVIEW graphic is also included 
in this report. 

Injection Report - this template to print the injection log table from the EMG 
Guidance protocol.  It also includes an injection diagnosis and procedure 
code table. 

MMUA Report -  this template includes the summary tables and MUP 
waveforms from Multi-Motor Unit Analysis.  It also includes the Chief 
Complaints, Medications, Physical Exam / History, Impression, and 
Recommendation custom fields from the Patient Information window. 

TabData w/ Traces - this template includes all the test protocols within the 
TabData window (tables & traces).  It also includes the Chief Complaints, 
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Medications, Physical Exam / History, Impression, and Recommendation 
custom fields from the Patient Information window. 

TabData w/o Traces - this template includes all the test protocols within the 
TabData window (tables only).  It also includes the Chief Complaints, 
Medications, Physical Exam / History, Impression, and Recommendation 
custom fields from the Patient Information window. 

 

Overview of QuickReport  

QuickReport has three main views. 

Select Report - the program will go to this view if you select "Launch 
QuickReport & Select Template" from the Sierra Wave's file menu.  This 
view allows you to choose any template on the system.  This view is 
initially displayed if you start QuickReport outside of the Sierra Wave 
program.  To select a template, either double click on it or single click on it 
and then click the Next button. 

Fill In Report - the program will go to this view if you select a report 
template that requires user input.  For example, the "Full Report (manual 
Findings)" template will go directly to this view so that the user can make 
manual selections for the Findings section of the report. 

Document - this view shows the generated report in Word format.  The 
program will automatically go to this view if you select a report template 
that does not require any user input, the "Current Test", "TabData w/ 
Traces", and "TabData w/o Traces" templates are examples.  The 
program will also switch to this view when all selections are complete on 
the Fill In Report view. 
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QuickReport - Select Report view. 

 

To Print the Report 

From the Document view, 

 click on the Printer icon at the top of the screen.  The report 
will be sent to your default printer. 

 select Print from the File menu. 

To Save the Report 

From the Document view,  

 click the Finish button, you will be prompted to save the report. 

 click on the Diskette icon . 

 select Save from the File menu. 

The report is saved to the user's Data directory with the filename of 
"lastname, firstname, date, time~template name.doc". 
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To Close QuickReport 

From the Document view, 

 select Exit from the File menu. 

 click the Finish button at the bottom left of the screen. 

 click the Red X in the top right-hand corner. 

If the report has not been saved the program will ask you if you would 
like to save the report before exiting. 

 

 To get a simple printout of the current test screen, select Print Screen from 
the Sierra Wave File menu. 

 For more detailed information on QuickReport and report templates, see the 
Help Topics from within the QuickReport program. 

 

Closing the Patient Exam 

To close the patient's exam, click on the File menu and select Close Exam. 

 The program will automatically display the Patient Information window if 
you did not enter a Last Name for the patient prior to starting the exam. 
 Enter the Last Name in the Patient Information window and click F3-OK 
to close the exam. 

 

 You can also click on the red X in the upper right hand corner.  This 
will close the patient's exam first, then the Sierra Wave program will be exited. 
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Closing the Sierra Wave Program 

To close the Sierra Wave program. 

 Click on the File menu and select Exit. 

OR, 

 Click on the red X in the upper right hand corner of the screen. 

 

The program will automatically display the Patient Information window if 
you did not enter a Last Name for the patient prior to starting the exam. 
 Enter the Last Name in the Patient Information window and click F3-OK to 
close the exam.  The Sierra Wave program will then close immediately after 
this. 
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System Setup Options 

System Setup Window 

This window is used to setup program Directories, Study & Report Key 
Assignments, Screen Colors, Preferences and Custom Patient Info. 

 Click on Edit. 

 Select System Setup. 

The System Setup window will be displayed. 
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There are 13 sections in the System Setup window. 

Directories 

 Data Directory - specifies where user's Patient Data will be stored. 

 Setup Directory - specifies where user's Parameter Settings will be 
stored. 

 Archive Directory - sets the default location for archiving patient data 
and stored reports. 

Study Key Assignments 

 Program Study Keys on Wave base unit. 

Notch Frequency 

 Set the frequency of the notch filter. 

Report Key Assignments 

 Program Report Keys on Wave base unit. 

Color Editor 

 Program colors for screen elements. 

Reports 

 Remove or add elements to the generated report. 

Stimulator Handle 

 Enable or disable repetitive stimulation mode. 

Normals 

 Check this box to remove the 'equal to' requirement when comparing 
the patient's values to normals. 

Preferences 

 Graticule Style – Dashes or Dots on Trace window. 

 Flag Abnormal Values - None, Bold, Bold with Asterisk, 
Background Color Red, Bold & Background Color Red. 

 Edit Physician Lists - Used to add or remove names from the 
Physician, Referring Physician, and Technician fields. 

 Edit NCV/F/H Comments - Used to edit the list of comments 
available in the NCV, F Wave, and H-Reflex test protocols. 
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 Report Header - Used to select  and edit the header to be used in 
reports. 

 Sentence Generator - Enables the automatic generation of findings 
sentences in the TabData window for EMG, NCV, F Wave, H-
Reflex, and EP test protocols. 

VEP Stimulator Setup 

 Specify the VEP monitor delay value and select the flash duration for 
VEP Goggles. 

Sentence Generator Font 

 Specify the default font size and font style that will be used to display 
the findings sentences within the TabData window. 

Default Height / Weight Units 

 Select the default units for Height (ft., cm, txt) and Weight (lbs., kg, 
txt) in the Patient Information window. 

Custom Patient Info 

 Setup the Custom Fields in the Patient Information Window. 

 

After making changes to any of these settings, Click OK and the changes will be 
saved. 

Directory Paths 

When the Wave Program is first installed it creates a Data folder and a Setup 
folder.  Factory default test parameters and study lists are placed the Setup 
folder. 

Once you start the Wave Program it will create a unique Data folder and Setup 
folder using your Windows user name.  This allows each user, that logs into the 
computer, to have their own data and setup locations.    The Windows user name 
is added to the end of the folder name separated with a period.  For example; 
Data.Sharonb and Setup.Sharonb. 
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Data Directory: 

The Data folder is where patient data files and stored reports are stored.  

Setup Directory: 

The Setup folder is where the user's test parameters, study lists and preserve 
files are stored. 

Archive Directory: 

This is normally set to your CD-R/CD-RW drive letter.  It can be set to a local 
folder, a network folder or other write-able media. 

Browse buttons: 

Click the appropriate Browse button to select a different directory path. 

 If desired, you can set every user‟s Data and Setup folder paths to the 
same locations.  This would ensure that everyone uses the same parameter 
settings and saves patient data to a central location. 

Study Key Assignments 

The Study Key Assignment allows you assign your most common studies/tests to 
the S1, S2 and S3 Study Keys on Wave base unit.  Click on the Select button 
and then select the study/test to change the Study Key Assignment. 

 

Notch Frequency 

This section allows the user to choose the frequency of the notch filter.  The 
choices are 50 or 60 Hz. 

 

Simply click on the frequency that is appropriate for your location. 
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Report Key Assignments 

The Report Key Assignment allows you to assign specific report templates to 
Print & Report Keys on Wave base unit.  Click on the Select button; click (+) 
next to report category; highlight the report template and click OK to change the 
Report Key Assignment.  You can also assign “Use Menu” to bring up the 
complete report template list when the appropriate key is pushed. 

 

Edit Colors 

Click the Edit Colors button to display the Color Editor window. 

 

Color Editor window. 
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To Change the color of an Item: 

Click on the box corresponding to the item you want to change, then select a 
new color from the color palette.  Color changes will take effect when the next 
new study is started. 

 

 

 

To Load a Factory Default Color Scheme: 

Click on the folder icon and select Default 1 or Default 2 from the list.  The 
Sierra Wave ships from the factory with Default 1 selected as the color 
scheme. 

 

To Save the current color scheme as a Custom Scheme: 

After making changes to the appropriate items in the color editor; click the 
diskette icon and then select either Custom 1 or Custom 2 from the list. 
 Your selections will be saved to that scheme. 

You cannot save changes to the Default color schemes. 
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To Load a Custom Color Scheme: 

Click on the folder icon and select either Custom 1 or Custom 2.  Click the 
OK button to apply the selected color scheme. 

Report Options 

This section allows you to remove some elements from generated reports without 
removing them from the data acquisition screen or the TabData Summary view. 

Click on the Report Options button to display the following window: 

 

 Flag Abnormals in Reports - when this box is checked abnormal values 
will be indicated in reports, usually as red colored boxes or bolded 
numbers. 

 Show Comments (NCV, F, H) - when this box is checked comments 
entered during NCV, F Wave, or H Reflex data acquisition will be 
displayed in the data tables of generated reports. 

 Show Norm Columns (NCV, F, H) - when this box is checked the normal 
value columns for NCV, F Wave, and H Reflex tests will be included in the 
data tables of generated reports. 

 Show Column Header Shading - when this box is checked the column 
headings at the top of each table are shaded gray. 
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 Show Outside Table Lines - when this box is checked a line is drawn 
between each nerve and a box is drawn around the entire table.  If this 
box is unchecked, only the column heading row will remain underlined. 

 Show All Vertical Table Lines - when this box is checked a vertical line 
is drawn between each table column. 

 Show All Horizontal Table Lines - when this box is checked a horizontal 
line is drawn between each table row. 

 Convert Red Background to Grey (Best for Fax)  - when this box is 
checked the abnormal values, that are usually shown as red colored 
boxes in reports, will be changed to grey colored boxes.  This is more 
suitable for reports that are being faxed to the referring physician. 

 The Report Options button can also be accessed in the TabData 
Summary view. 

Stimulator Handle 

This section allows you to change the function of the Stim button on the electrical 
stimulator. 

Checking this box will enable the repetitive stimulation function when the Stim 
button is held down for 2 seconds. 

 

 

Normals 

Check this box to remove the 'equal to' requirement when comparing the 
patient's values to normals. 

 

When this option is checked cursor values that are equal to the normal value 
will be flagged as abnormal.  For example, if the normal onset value is entered 
as (<4.2), a recorded value from the patient of 4.2 will be flagged as abnormal. 
  The program considers a value equal to the norm as abnormal. 
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Value of 4.2 is normal.                          Value of 4.2 is abnormal. 

 

Preferences 

This section allows user to customize trace window graticule style, to flag 
abnormal values, to create and choose different report headers, and to enable 
the automatic sentence generator. 

 

Graticule Style: 

Use the drop down arrow to select Dashes or Dots for trace window. 

Edit Physician Lists: 

Clicking on this button opens the Edit Physician List window.  This window 
can be used to Add or Delete entries from the Physician, Referring Physician, 
and Technician lists.  The order of the names can be changed using the Move 
Up and Move Down buttons.  Use the Set as Default button to indicate which 
name should automatically appear when a new patient exam is started. 
 These lists are available when entering the Patient Information. 
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Edit Physician Lists 

Edit NCV/F/H Comments: 

Clicking on this button opens the Edit NCV and F/H Comments window. 
 This window can be used to Add or Delete entries from the comment lists 
used in the NCV, F Wave, and H-Reflex test protocols.  The order of the 
comments can be changed using the Move Up and Move Down buttons.  
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Edit NCV and F/H Comments 

 

Flag Abnormal Values: 

Use the drop down arrow to select None, Bold, Bold with Asterisk, 
Background Color Red, or Bold Text and Background Color Red. 
 Abnormal values will be flagged in the test window, TabData, and the Report. 

Report Header: 

Multiple report headers can be saved for different locations, doctors, etc... 

Click the Edit button to open the currently selected Report Header using 
Microsoft Word and make changes to it. 

Click the Browse button to locate a different report header or click the drop-
down arrow to select from a list of the most recently used report headers. 



Sierra Wave Help Manual 

144 

Sentence Generator: 

Placing a check mark in this box enables the automatic generation of findings 
sentences in the TabData window for EMG, NCV, F Wave, H-Reflex, and EP 
protocols. 

VEP Stimulator Setup 

Clicking on the VEP Stimulator Setup button opens the following window. 

 

 

VEP Monitor Delay (ms):  

This setting has been added to support the use of selected LCD monitors for use 
as checkerboard pattern stimulators.  LCD monitors have different screen 
drawing characteristics than CRT monitors, and as such a compensatory delay 
(or offset) has to be determined and input before an LCD monitor can be used. 
 Without this delay value entered into the program the latency of the visual 
evoked potentials will be greatly prolonged. 

LCD checkerboard monitors purchased from Cadwell have been calibrated and 
the delay has been carefully determined.  Use the delay value indicated on the 
back of the LCD monitor.  For the ViewSonic N1630W this value is 52 
milliseconds. 

If you do not purchase an LCD monitor from Cadwell the appropriate 
delay value will not be known and the latency of your visual evoked 
potentials could be adversely affected. 

The Composite Video (yellow) connector is used on the LCD 
checkerboard monitors.  This requires that a RCA-to-BNC adapter be 
used with the standard CRT monitor cable.  
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The delay value should be set to zero milliseconds for all old-style CRT 
monitors. 

 

VEP Monitor Type: 

This is a text field that allows a descriptive label to be entered for the VEP 
monitor. 

 

VEP Goggles Flash Duration: 

This setting allows the duration of the goggle LED flash to be set at 5 or 10 
milliseconds.  If you are using normative data from other competitor systems it is 
suggested that you use a setting of 5 milliseconds. 

 

 

Sentence Generator Font 

Select the default font size and font style that will be used to display the findings 
sentences within the TabData window. 

 

Choices are: 

 12 pt Times New Roman 

 10 pt Times New Roman 

 12pt Arial 

 10 pt Arial 
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Height & Weight Units 

This section allows the user to choose the units that will be displayed for the 
patient's Height and Weight. 

 

Height units: 

 Feet and Inches (ft.) 

 Centimeters (cm) 

 Text (txt) - for backwards compatibility with older patient data or when 
using different measurement units. 

Weight units: 

 Pounds (lbs.) 

 Kilograms (kg) 

 Text (txt) - for backwards compatibility with older patient data or when 
using different measurement units. 

Custom Patient Information Fields 

This section allows you to create custom information fields in the Patient 
Information Window.   This information will be transferred to your report (you 
will need to enter items in the report template to include this information).  Up to 
20 fields can be created and there are 5 types (length) to choose from. 
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Name: 

Enter the name of the Custom Field.  To change an existing field name, click 
on it with the mouse.  To enter a new field, click on the blank blue line at the 
bottom of the list. 

Type: 

Click here to specify the length of each Custom Field.  Choices are Short (15 
characters max), Medium (40 characters max), Long (110 characters max), 
Paragraph (unlimited characters), and Report Item.  A selection of Short, 
Medium, Long, or Paragraph for a custom field will setup a simple text box in 
the patient information window. 

If Report Item is selected an additional column will be displayed.  This 
additional column, titled Report Item, allows you to assign a QuickReport Item 
to this custom field.  Simply click within the Report Item column and the 
Select Item window will be displayed.  This window displays all the available 
Narrative, Paragraph, and Select items that are stored within QuickReport's 
database.  Only one report item can be assigned to each custom field. 

 

Select Item window. 
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Using a Report Item with a Custom Field 

When a report item has been assigned to a custom field, the label of that 
report item and a small document icon will be displayed above and to the left 
of the custom field in the patient information window.  The user still has the 
option of simply typing into the custom field, or they can click on the report 
item's name and process that item.  This gives the user the ability to 'pre-
process' the report item before starting the report generator. 

 

Patient Information window. 
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Clicking on the Complaints item , in the above example, will pop-
up the typical QuickReport window for that item which is shown below. 

 

Chief Complaints report item. 

You can complete the report item in the normal fashion and when the OK 
button is clicked the output of the report item (i.e., the data in the blue preview 
box) is inserted into the custom field in the patient information window. 
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Patient Information window with the Patient Complaints, Medications, and Patient 
History/Exam custom fields completed. 

 



 

151 

Network Setup Options 

Network Setup Window 

This window is used to setup automatic copy of the patient's exam to a specified 
network location and to enable automatic synchronization of test settings when 
the Sierra Wave program is launched. 

 Click on Edit. 

 Select Network Setup. 

The Network Setup window will be displayed. 

 

There are two sections in the Network Setup window. 

Copy Patient Exam to Network Share 

 Options related to copying the patient's exam and/or report document to a 
network location. 

Synchronize Settings from Network Share 

 Specify location of the Preserve file that will be loaded when the Sierra 
Wave program is launched. 
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Copy Patient Exam 

The configuration options in this section allow for the automated copy of the 
patient‟s data file and/or report document to a specified location on the local area 
network at the conclusion of testing. 

 

 

 Copy Patient Exam (datafile + report) to Network Share – enables the 
automatic copy feature.  When the patient exam is concluded (e.g., File - 
Close Exam) the patient‟s datafile and report document will be copied to 
the location specified under Network Path. 

 Copy Patient Report Document Only – if enabled, only the report 
document will be copied to the specified location. 

 Prompt before copying – enables a message to the user that the 
program is ready to copy the patient‟s exam/report to the specified 
location.  Clicking OK will confirm that the exam/report should be 
copied. 

 Network Path – specifies the location on the network where the 
patient‟s exam/report will be copied.  The user should have "read/write" 
permissions for this location. 

 Delete the patient exam from local data folder after the copy – 
enabling this option will delete the patient‟s file from the users local 



Network Setup Options 

153 

data folder once it has successfully been copied to the specified 
location. 

 Prompt before deleting patient from local data folder – if the 
previous Delete option is enabled, this option will enable a message to 
the user that the program is ready to delete the patient from the local 
hard drive.  Clicking OK will confirm that the exam/report should be 
deleted. 

 If your Sierra Wave is configured for multiple user accounts, each user can 
specify a unique network path. 

 When the Copy to Network feature is enabled the Review/Resume Exam 
windows will contain two tabs; one tab for local files and another for files on 
the network. 
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Synchronize Settings 

The configuration options in this section allow for the automatic restore of 
settings from a specified preserve file when the Sierra Wave program is 
launched. 

 

 

 Synchronize Settings from Network Share – enables the automatic 
synchronization feature.  When the Sierra Wave program is launched the 
preserve file specified in the Network Path will automatically be loaded.  If 
the network path is not available, then the program will utilize the settings 
that were loaded the last time the network path was available. 

 Network Path – specifies the location on the network where the 
preserve file is located.  The user should have "read" permission for 
this location. 

 If your Sierra Wave is configured for multiple user accounts, this is a good 
way to ensure that all users are utilizing the same test settings and report 
templates. 
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Test Protocol Setup 

Test Menu Setup Window - Overview 

From the Edit menu, select Test Menu to display the Test Menu Setup window. 
 From this window you can program all the default parameter settings for every 
test protocol on the instrument. 

 

The Test Menu Setup window is generally divided into two sections, the Test 
List section on the left and the Settings section on the right. 

Test List Section: 

This area lists the currently available test protocols.  Color coded icons 
represent the various test types. 

Test Icons: 

Test Type: Icon: Description: 

EMG  Pink color with blue needle hub. 

NCV  Yellow color with CMAP trace. 

F Wave  Green color with F Wave trace. 
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H Reflex  Orange color with H Reflex trace. 

RNS  Violet color with RNS decrementing 
trace. 

Blink  Blue colored eye. 

SFEMG  Pink color with red needle hub. 

SSFEMG (Stim-

SFEMG) 
 Pink color with violet needle hub. 

Real Time SFEMG 
(SFEMG2) 

 Pink color with red needle hub. 

Macro EMG  Pink color with red needle hub. 

SEP  Blue with bar electrode. 

VEP  Blue with checkerboard pattern. 

AEP  Blue with headphones. 

P300  Blue with target. 

RR Interval  Red Heart. 

MUNE (MPS and 
Incremental) 

 Blue color with CMAP trace. 

EMG Guidance  Pink color with blue needle hub. 

 

To Select a Test Protocol: 

Left click on the test with the mouse.  The test protocol will be highlighted 
in blue and that test's parameter settings will be displayed. 

The Test List's Right-click menu. 

By right-clicking the mouse over a test you can display the right-click 
menu. 
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Test List's right-click menu. 

Cut, Copy, & Paste. 

Select Cut to remove the highlighted test protocol from the list.  Select 
Paste to place the recently cut or copied test protocol above the currently 
highlighted test protocol.  Select Copy to make a copy of the highlighted 
test protocol. 

When Copying & Pasting test protocols the program will automatically 
change the name of the pasted protocol by placing a "2" after its name. 
 Two test protocols cannot have the same name. 

Renaming a test. 

To rename a test protocol, right-click on the test and select Rename. 
 Now, type the new name for the protocol and press enter. 

Deleting a test. 

To remove a test from the test list, right-click on the test and select Delete. 

Inserting Test. 

To insert a test protocol into the test list, right click on one of the existing 
test protocols and select Insert.  A second menu will be displayed 
showing the type of tests you can insert.  Click on the type of test that you 
want and it will be inserted above the originally highlighted test protocol. 
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Insert Test menu. 

 

To Move a test in the list to change the order: 

Click on the test you wish to move with the left mouse button.  Keep the 
button pressed down while you move the mouse up or down through the 
list.  You will see a black bar moving with the mouse as you move it up or 
down in the list.  When you let go of the left mouse button the test will be 
moved to the location of the black bar. 
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Settings Section: 

Blue colored and underlined items can be changed or edited by clicking on them 
with the left mouse button.  Drop down lists can also be changed by clicking on 

the drop down arrow . 

 Clicking on a nerve name, site name, etc., will open a text box.  Simply 
type in the box to change the name, then press Enter. 

 

Clicking on the nerve name Median opens text box. 

 Clicking on an amplifier setting, like Amp Gain, will display a list of 
selections.  Simply click on the setting that you want. 
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Clicking on Gain value of 5k opens list of values. 

 Clicking on a drop down arrow, like Max Captured Traces in the EMG test 
protocol setup, will display a list of values.  Simply click on the value that 
you want. 

 

Clicking on  opens list of values. 

 

By right-clicking within a nerve or muscle list you can Insert a Group 
Heading, Insert a new nerve or muscle, Delete, Cut, Copy, or Paste. 
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Right click over Ulnar nerve 

The NCV test protocol has two tabbed sheets, Nerve & General.  The Nerve 
tab has settings specific to the nerve type (motor, anti-sensory, etc.) and 
individual nerves, while the General tab has settings that are 'global' to all 
nerves. 

 If the test protocol, muscle, or nerve name is changed, you will need to 
update all the Study Lists that use this test protocol, muscle, or nerve.  Study 
Lists are not automatically updated. 

 

Test Setup Window Buttons: 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
currently selected test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the test settings that were previously stored in a file using the Save Test 
feature. 
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Clicking the Restore button will allow you to open a Preserve file and restore 
from that file only the test settings for the currently highlighted test protocol. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any changes 
that have been made to the test protocol settings. 

EMG Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the EMG test protocol in the test list.  The EMG test protocol 
settings will be displayed on the right hand side of the screen. 

Use the settings on this screen to program the default parameters for Graticule 
size, Amplifier settings, Trace positioning, Custom Key settings, Muscle Scoring 
selections, and the Muscle List. 

 

EMG Test Protocol Setup 
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Hardware Settings 

General Settings 

Max Channels:  Sets the maximum number of 
channels that can be turned ON in the test.  Choices 
are 1, 2, 3, or 4. 

Max Captured Traces:  Sets the maximum number 
of traces that can be held in the captured trace buffer. 
 Only applies to Capture EMG mode.  Choices are 10, 
20, 30, or 50. 

EMG Buffer (secs):  Sets the maximum length of the 
Live EMG Buffer.  Choices are 30, 60, 120, 240, 360, 
and 600 seconds. 

Store MUA Capture Traces:  When this box is 
checked the program will automatically store the individual captured traces as 
well as the averaged MUP trace when the Store key is pressed.  This only 
applies to SMUA mode. 

 

Confirm Store Commands:  When this box is checked the program will display 
a confirmation window whenever an EMG Snapshot, Live Buffer, or Captured 
traces are stored.  This ensures that the data is stored with the correct muscle 
name and side. 

 

Auto Score Muscles:  When this box is checked the program will automatically 
add all muscles in the Study List to the score table as soon as the EMG protocol 
is loaded.  The muscles will be initially scored as "Normal".  If this box is not 
checked, you will need to manually score the muscles by using the F2 (Muscle 
Sel/Score) knob. 

Graticule Size:  These selections change the number of Vertical and Horizontal 
divisions that are displayed in the EMG Trace window.  The first number is for the 
number of vertical divisions and the second number is for the number of 
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horizontal divisions.  Live and Capture EMG modes can be programmed 
differently. 

 

Amplifier Settings 

Fibs:  Click on this setting to program 
the amplifier settings for the Fibs, Recrt, 
Capture/SMUA, and IPA data 
acquisition modes.  You can program a 
different Gain and Sweep Speed setting 
 for each mode. 

On:  Click here to program a channel as 
either On or Off. 

Gain:  Click here to select the default 
Gain setting in microvolts per division 
(uV/Div). 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected channel. 
 When common reference is On the individual reference input for the channel is 
disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

All:  Provides a quick method of changing the parameters for all the channels at 
one time. 

Sweep: Click here to select the default sweep speed setting in milliseconds per 
division (ms/Div). 

TrgDel:  Click here to select the trigger delay point for Captured EMG/SMUA 
mode.  The choices are 1 to 9 divisions in 0.1 increments. 

TrgWth:  Click here to specify the number of divisions between the dual trigger 
lines in Capture EMG/SMUA mode.  The choices are 0.5, 1, 1.5, 2.0, 2.5, and 3.0 
divisions. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 
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Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 

 

Trace Position Settings 

 Start Position: This is the default trace position for 
Channel 1 within the trace window.  It is the number 
of vertical divisions below the top of the trace window. 
 In this example, the trace will be positioned 5 
divisions below the top of the window. 

Trial Offset:  This setting determines where the first stored EMG snapshot is 
displayed within the trace window and also how much space will separate 
additional stored snapshots within the same trace window.  In this example the 
setting is 0.5 divisions, therefore the first stored snapshot will be displayed 0.5 
divisions below the Live trace.  If another snapshot is stored within the same 
trace window it will be displayed 0.5 divisions below the first stored snapshot and 
so on. 
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Channel Offset:  This setting only applies when more than one channel is turned 
ON.  It is the amount of space, in vertical divisions, that separates the Live 
channels. 

 These settings can be changed during data acquisition by right-clicking the 
mouse on the trace window and selecting Trace Position Settings from the pop-
up menu. 

 

Muscle Scoring Table 

This section is used to setup your muscle scoring column names (i.e., Fibs, Amp, 
Ins Act), the column type (List or Text), and if applicable the default values (i.e., 
choices) for the column. 

 

Name column:  These entries will be displayed as the column headings across 
the top of your muscle scoring table.  The first four entries Side, Muscle, Nerve, 
and Root are fixed and cannot be altered.  The remaining entries are 
programmable.  To change an existing name simply select it by clicking on it with 
the mouse, then type the new name and press Enter.  To enter a new name, 
click on the blank entry at the bottom of the list, then type the name for the entry 
and press Enter. 

It is a good idea to keep the Name entries as short as possible.  This will 
allow more column headings to be entered and displayed across the report table. 

Type column:  After entering the name for the scoring column you can specify 
the column type.  Simply click on the type setting and select Label, List, or Text. 

 Label - simply inserts the column name into the muscle scoring table. 
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 Text - allows free form typing to be entered for that scoring column. 

 List - allows you to program a list of value choices for that scoring column. 
 Once the List type is selected the Values section will be enabled and you 
can enter your choices.  Simply click on the Values area and type your 
choices, the choices must be separated by a comma. 

 

Value choices separated by commas. 

Norm column:  If the scoring entry is a List, you can preset the value that should 
be scored when the muscle is normal. 

Show for Paraspinals: These check boxes allow you to choose which scoring 
columns will be enabled for paraspinal muscles.   

 

Muscle List 

This section is used to setup your EMG muscle list.  The list can contain group 
headings (i.e., Hand, Forearm), muscle names, nerve names, and root levels. 
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To insert a New Muscle into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type 
in the muscle name, nerve name, and root level. 

Within the list - right click the mouse over an existing muscle name.  From 
the pop-up menu select Insert.  A new row will appear above the muscle you 
right clicked on.  Enter the muscle name, nerve name and root level. 

To insert a Group Heading into the list:  Right click the mouse over an existing 
muscle name.  From the pop-up menu select Insert Group.  A new row will 
appear above the muscle that you right clicked on.  Type the heading name in 
the muscle/group name field, leave the nerve and root fields blank.  Group 
Headings are automatically shown in bold text: 

To change the name of an existing muscle:  Click on the muscle name you 
want to change.  Type the new name and press Enter. 

To change the order of the muscles in the list:  Changing the order of the 
muscle list requires the use of the Cut & Paste features on the right-click pop-up 
menu.  Begin by right clicking on the muscle name or group heading that you 
want to move, select Cut from the pop-up menu.  Now, right click in the list where 
you want the muscle or group heading to go and select Paste from the pop-up 
menu (the muscle or group heading will be pasted above the row you right 
clicked upon).  Repeat this process for all the muscles and group headings you 
want to move. 

To delete a muscle from the list:  Right click on the muscle you want to delete, 
then select Delete from the pop-up menu. 

To designate a muscle as a Paraspinal:  Right click on the muscle and select 
Is Paraspinal.  Muscles with this designation will appear with an asterisk in front 
of their name.  Use the check boxes in the muscle scoring table setup to specify 
which of the scoring columns will be utilized for these muscle types. 
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AnatomyVIEW Muscle Map 

 

The AnatomyVIEW feature allows the EMG muscle scoring data to be displayed 
on a 3D color-coded anatomical model. 

The Sierra Wave is very flexible in that each user can create and name their own 
muscles and change the name of factory default muscles.  Therefore, the 
program must be able to match each users name for a muscle to the muscle ID 
that is recognized by the AnatomyVIEW window.  This is done using the Muscle 
Map Editor. 

Click on the AnatomyVIEW Muscle Map button to open the Muscle Map 
Editor window. 
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Muscle Map Editor window. 

Column Descriptions: 

 Sierra Muscle - this column shows the user's muscle list, as read 
from the EMG test protocol setup window. 

 Right Mapped IDs - this column shows the muscle ID's from the 
Viewer that have been assigned to this muscle for the Right side. 

 Left Mapped IDs - this column shows the muscle ID's from the 
Viewer that have been assigned to this muscle for the Left side.  

 Muscles Available in AnatomyVIEW - this column lists all the 
muscle IDs that the Viewer is able to display. 

 

To  Map a Viewer Muscle ID to a Muscle: 

1. Find the appropriate muscle ID in the Viewer List. 

2. Left click on the muscle ID and drag it over to the appropriate 
Right or Left Mapped ID cell. 

3. Release the mouse button to drop the muscle ID into the cell. 
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Click and Drag muscle available in Viewer and drop into appropriate user muscle. 

To Map Multiple Viewer Muscle IDs to a Muscle: 

You may want to map more than one Viewer muscle to a muscle in 
your muscle list.  For example, when you score the Biceps muscle, you 
may want both the Lateral Biceps and the Medial Biceps to be 
highlighted in the AnatomyVIEW window.  This can be done by 
mapping multiple viewer muscles to the muscle in your list. 

Simply click and drag multiple muscle IDs from the viewer list and drop 
them onto the muscle.  You can click on the drop-down arrow to view 
all the muscles that have been mapped to your muscle. 

 

The Viewer's Lateral & Medial Biceps have both been mapped to the user's Biceps 
muscle. 
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To Clear an Assignment: 

1. Highlight the appropriate cell by clicking on it with the mouse. 

2. Click on the Clear button. 

 

To Clear All Assignments: 

1. Click on the Clear All button. 

 

To Save the Assignments: 

1. Click on the OK button. 

 The muscle mapping data is saved to a file in the user's setup 
folder.  This file is named "MuscleMap.xml" and it is automatically 
included in the Preserve & Restore functions. 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
EMG test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the EMG test settings that were previously stored in a file using the Save 
Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
EMG settings from that file. 
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Clicking OK will close the Test Setup window and will save any changes that 
have been made to the EMG test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the EMG test protocol settings. 

NCV Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the NCV test protocol in the test list.  The NCV test protocol 
settings will be displayed on the right hand side of the screen. 

NCV settings are divided into two tabbed sheets, the Nerve Settings and the 
General Settings. 

 

NCV Test Setup window 
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Nerve Settings Tab 

Nerve Type List 

This section is used to specify the types of nerve conduction tests that will be 
performed.  For each nerve type that is defined, you can program the default 
amplifier, stimulator, averager, trace position, and table settings.  Common nerve 
types are Motor, Anti-Sensory, Ortho-Sensory, and Inching. 

Each nerve type has its own table in the TabData summary window and in 
printed reports. 

To edit the settings of a nerve type, click on the nerve type name.  The right side 
of the window will change to display the settings for that nerve type. 

 

Motor Nerve Type Settings 

Nerve Type Hardware Settings (with Motor Nerve Type selected) 

This section is used to program the default amplifier, stimulator, averager, 
and trace position settings for all the nerves of the type that is selected. 
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 Amplifier: 

On:  Click here to program a channel as either On or Off.  NCV 
supports two or four channel recording mode.  To enable four channel 
recording, go to the General Settings tab. 

Amp Gain:  Click here to select the default Amplifier Gain setting in 
microvolts per division (uV/Div). 

Disp Gain:  Click here to select the default Display Gain setting in 
microvolts per division (uV/Div). 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the 
selected channel.  When common reference is On the individual 
reference input for the channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. (Not 
recommended for motor nerves) 

Sweep: Click here to select the default sweep speed setting in 
milliseconds per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of 
either -1, 0, or +1 division.  A setting of -1 will show one division of 
activity before the stimulus. 

Max Sweep:  Click here to select the maximum sweep speed that can 
be used for the test in milliseconds per division (ms/Div). 
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Stimulator: 

Pulse Width:  Click here to set the electrical stimulus pulse width, also 
known as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per 
second (Hz).  This setting only applies when delivering repetitive 
stimulation.  It does not apply during manual single stimulus delivery. 

Averager: 

Off/On :  Click here to enable or disable the averager.  Occasionally 
sensory nerves require averaging of several responses.  This 
parameter is usually set to OFF and is turned ON as needed during the 
patient examination. 

When turned ON, you can then select the following; 

Shutoff Count (total number of responses to average). 

Reject Status (artifact rejection Off or On). 

Reject Level (35 to 100% of amplifier bandwidth). 

Trace Position: 

Start Position: This is the default trace position for Channel 1 within 
the trace window.  It is the number of vertical divisions below the top of 
the trace window.  In the above example, the first trace will be 
positioned 4 divisions below the top of the window. 

Trial Offset:  This setting determines how much space will separate 
each stored NCV trace.  In the above example the setting is 2.5 
divisions, therefore the second NCV trace will be displayed 2.5 
divisions below the first trace.  If a third NCV trace is acquired it will be 
displayed 2.5 divisions below the second NCV trace and so on. 

Channel Offset:  This setting only applies when more than one 
channel is turned ON.  It is the amount of space, in vertical divisions, 
that separates the two Live channels. 

Auto Adjust Traces: When checked, this parameter will automatically 
adjust the Start Position and Trial Offset to keep all acquired traces 
displayed within the Trace window. 

 Trace Position settings can be changed during data acquisition by 
right-clicking the mouse on the trace window and selecting Trace 
Position Settings from the pop-up menu. 
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Nerve Type Table Settings 

This section is used to program how the measurements for the selected 
Nerve Type will be displayed.   

Selections can be made for both the NCV Tables and the Left/Right 
Comparison Tables. 

You can program what is displayed during data acquisition (NCV) and what is 
displayed in the Report/TabData summary window independently.  For 
example, some users like to have normal values displayed during data 
acquisition but not in reports. 

 

Motor Type - Table Settings 

Amplitude Units:  Click here to select the amplitude measurement units, 
either millivolts (mV) or microvolts (uV).  Motor nerves are generally 
displayed in millivolts, sensory nerves in microvolts. 

Norm Amplitude Type:  Click here to select how the normal amplitude 
value is displayed, either Onset to Peak or Peak to Trough. 
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Delta Type:  Click here to select how the nerve conduction velocity 
calculations are determined. 

 Delta-O, velocity is calculated based on the difference between the 
onset latencies of the two responses, and when distal onset latency 
is used for the terminal conduction velocity. 

 Delta-P, velocity is calculated based on the difference between the 
peak latencies of the two responses, and when distal peak latency 
is used for the terminal conduction velocity. 

First Velocity:  Click here to select whether the first velocity segment 
should have it's velocity displayed or hidden.  Generally this setting is 
always set to Show, but in some instances users like to put in a distal 
segment for motor nerves, such as Wrist to APB.  This allows them to 
record the distal distance but hide the conduction velocity. 

L-R Amp Units:  Click here to specify whether the left minus right side 
amplitude differences are displayed as percentages (%) or absolute 
amplitude values (uV or mV). 

 

Site Table Columns: Select the site measurement columns that you would 
like to display on the data acquisition screen (NCV) and in the report 
(Report/TabData).  To include a measurement, click at the bottom of the 
displayed column list, or within the column list, and then select Insert from the 
pop-up menu.  Select the measurement you want to include from the 
displayed list of choices.  To remove a measurement, click on the 
measurement column in the column list, then select Delete from the pop-up 
menu. 
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Site Table measurement choices. 

 Site - this column displays the stimulus site names, (e.g., Wrist, 
Elbow, Axilla). 

 NR - this column is used to indicate a "no response". 

 Onset (ms) - this column reports the onset latency of the response 
in milliseconds. 

 Norm Onset (ms) - this column displays the normal value for the 
site if one has been entered for the nerve being tested. 

 Peak (ms) - this column displays the peak latency of the response 
in milliseconds. 

 Norm Peak (ms) - this column displays the normal value for the 
site if one has been entered for the nerve being tested. 
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 O-P or P-T Amp - this column displays the amplitude of the 
response as either onset to peak or peak to trough.  The type of 
measurement, mV or uV,  is determined by selecting the 
Amplitude Units. 

 Norm Amp - this column displays the normal amplitude for the site 
if one has been entered for the nerve being tested.  The label of O-
P or P-T is determined by the Amplitude Type setting. 

 Neg Dur (ms) - this column displays the negative duration of the 
response in milliseconds. 

 Full Dur (ms) - this column displays the full duration of the 
response in milliseconds. 

            

 Neg Area - this column displays the negative area of the response 
in either mV-ms or uV-ms depending on the setting of the 
Amplitude Units. 

 Full Area - this column displays the full area of the response in 
either mV-ms or uV-ms depending on the setting of the Amplitude 
Units. 
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 Amp% (1st) - this column shows a site‟s percent change in 
amplitude compared to the amplitude of site #1.  (Site #1 compared 
to itself is always 100%) 

 Amp% (Prev) - this column shows a site's percent change in 
amplitude compared to the amplitude of the previous site.  (e.g., 
Site 2 compared to Site 1, Site 3 compared to Site 2) 

 Neg Area% (1st) - this column shows a site's percent change in 
negative area compared to the negative area of site #1.  (Site#1 
compared to itself is always 100%). 

 Neg Area% (Prev) - this column shows a site's percent change in 
negative area compared to the negative area of the previous site. 
 (e.g., Site 2 compared to Site 1, Site 3 compared to Site 2) 

 Full Area% (1st) - this column shows a site's percent change in full 
area compared to the full area of site #1.  (Site#1 compared to itself 
is always 100%). 

 Full Area% (Prev) - this column shows a site's percent change in 
full area compared to the full area of the previous site.  (e.g., Site 2 
compared to Site 1, Site 3 compared to Site 2) 

 Contra Lat (ms) - this column shows the corresponding latency 
values (if Delta-O they are onset latencies, if Delta-P they are peak 
latencies) for the contralateral side. 

 L Lat (ms) - this column shows the corresponding latency values (if 
Delta-O they are onset latencies, if Delta-P they are peak latencies) 
for the left side of the nerve. 

 R Lat (ms) - this column shows the corresponding latency values (if 
Delta-O they are onset latencies, if Delta-P they are peak latencies) 
for the right side of the nerve. 

 L-R Lat (ms) - this column shows the Left minus Right side 
difference in the latency values. 

 Norm L-R Lat (ms) - this column displays the L-R normal latency 
difference value for the site if one has been entered for the nerve 
being tested. 

 Contra Amp (uV or mV) - this column displays the corresponding 
amplitude values (as either onset to peak or peak to trough) for the 
contralateral side.  The type of measurement, mV or uV,  is 
determined by selecting the Amplitude Units. 

 L Amp (uV or mV) - this column shows the correspond amplitude 
values (as either onset to peak or peak to trough) for the left side. 
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 The type of measurement, mV or uV,  is determined by selecting 
the Amplitude Units. 

 R Amp (uV or mV) - this column shows the correspond amplitude 
values (as either onset to peak or peak to trough) for the right side. 
 The type of measurement, mV or uV,  is determined by selecting 
the Amplitude Units. 

 L-R Amp (%, uV, or mV) - this column displays the Left minus 
Right side difference in amplitude values.  The values can be 
shown as a percentage or as an absolute value. 

 Norm L-R Amp - this column displays the L-R normal amplitude 
difference value for the site if one has been entered for the nerve 
being tested. 

 

Segment Table Columns:  Select the segment measurement columns that 
you would like to display on the data acquisition screen (NCV) and in the 
report (Report/TabData).  To include a measurement, click at the bottom of 
the displayed column list, or within the column list, and then select Insert from 
the pop-up menu.  Select the measurement you want to include from the 
displayed list of choices.  To remove a measurement, click on the 
measurement column in the column list, then select Delete from the pop-up 
menu. 

 

Segment Table measurement choices. 
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 Site 1 and Site 2 - this column shows the names of the stimulus 
sites that make up the segment. 

 Delta-O or Delta-P - this column shows the difference (in 
milliseconds) between the response latencies of the two sites 
composing the segment.  The type of measurement is determined 
by selecting the Delta Type (onset or peak). 

 Norm Delta (ms) - this column displays the segment's normal 
value for the Delta measurement if one has been entered for the 
nerve being tested. 

 Distance (cm) - this column provides a place to enter the distance 
(in centimeters) between the two stimulus sites, or in some cases 
the distance between the distal stimulation site and the recording 
site. 

 Vel (m/s) - this column displays the calculated conduction velocity 
in meters per second. 

 Norm Vel (m/s) - this column displays the normal velocity for the 
segment if one has been entered for the nerve being tested. 

 Contra Dist (cm) - the column displays the corresponding distance 
values for the contralateral side. 

 L Dist (cm) - this column displays the distance values for segments 
on the left side. 

 R Dist (cm) - this column displays the distance values for 
segments on the right side 

 Contra Vel (m/s) - this column displays the corresponding velocity 
values for the contralateral side. 

 L Vel (m/s) - this column displays the velocity values for segments 
on the left side. 

 R Vel (m/s) - this column displays the velocity values for segments 
on the right side. 

 L-R Vel (m/s) - this column displays the Left minus Right side 
difference in velocity values. 

 Norm L-R Vel (m/s) - this column displays the L-R normal velocity 
difference value for the segment if one has been entered for the 
nerve being tested. 

 DVel (m/s 1st) - this column shows a segment's change in velocity 
compared to the velocity of the 1st segment.  (e.g., Segment 2 
compared to Segment 1, Segment 3 compared to Segment 1). 
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 DVel (m/s prev) - this column shows a segment's change in 
velocity compared to the velocity of the previous segment.  (e.g., 
Segment 2 compared to Segment 1, Segment 3 compared to 
Segment 2). 

Default Selections for the NCV Tables: 

 

Default selections for the NCV Tables. 
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Default Selections for the Left/Right Comparison Tables: 

 

Default selections for the Left/Right Comparison Tables. 

Nerve List 

This section is used to setup your NCV nerve list.  The list can contain group 
headings (i.e., Upper Motor, Upper Sensory) and individual nerve names.  The 
Nerve Type column allows the nerve type settings programmed above to be 
assigned to the nerve. 
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Nerve List 

To Select a Nerve:  To select a nerve in the list, click on the nerve name with the 
left mouse button.  Once the nerve is selected its parameter settings, site table, 
and segment table will be displayed on the right hand side of the screen.  See 
the section below titled Nerve Table Settings for information on how to change 
these settings. 
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To Insert a new Nerve into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type 
in the nerve name, then click in the nerve type field and select the nerve type 
from the pop-up list. 

Within the list - right click the mouse over an existing nerve name.  From the 
pop-up menu select Insert.  A new row will appear above the nerve you right 
clicked on.  Enter the nerve name, then click in the nerve type field and select 
the nerve type from the pop-up list. 

To insert a Group Heading name into the list:  Right click the mouse over an 
existing nerve name.  From the pop-up menu select Insert Group.  A new row 
will appear above the nerve that you right clicked on.  Enter the heading name in 
the Nerve/Group name field.  Group Headings are automatically shown in bold 
text: 

To change the name of a Nerve:  Click on the nerve name you want to change. 
 Type the new name and press Enter. 

To change the order of the nerve list:  Changing the order of the nerve list 
requires the use of the Cut & Paste features on the right-click pop-up menu. 
 Begin by right clicking on the nerve or group heading that you want to move, 
select Cut from the pop-up menu.  Now, right click in the list where you want the 
nerve or group heading to go and select Paste from the pop-up menu (the nerve 
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or group heading will be pasted above the row you right clicked upon).  Repeat 
this process for all the nerves or group headings you want to move. 

To delete a nerve or group heading from the list:  Right click on the nerve or 
group heading you want to delete, then select Delete from the pop-up menu. 

 

Nerve Table Settings 

Once a nerve is selected in the nerve list, that nerve's parameter settings, 
recording and stimulus site names, and segment table will be displayed. 

Hardware Parameter Settings: 

The nerve's parameter settings will be initialized to the settings that were already 
programmed for the Nerve Type (i.e., motor settings, anti-sensory settings). 
 Normally these will be the desired default settings and will not need to be 
changed.  However, if necessary, the nerve's parameter settings can be 
programmed different than the nerve type settings.  This is done by checking the 
box labeled "Individualize Nerve Settings" at the top of the parameter settings 
area.  Once this box has been checked you can change the default amplifier, 
stimulator, averager, and trace position settings. 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed in 
the Normal or Reversed mode on a Side basis.  Clicking the drop down arrow 
for this parameter will list four choices, Neither, Left, Right, and Bilateral 
(both). 

 Neither - the stimulator polarity will be initialized in the Normal mode 
when either the Left or Right side is selected for the nerve being tested. 
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 In the Normal mode, the right-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode when 
the Left side is selected for the nerve being tested.  When the Right side 
is selected the stimulator polarity will initialize in the Normal mode.  In the 
Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed mode 
when the Right side is selected for the nerve being tested.  When the Left 
side is selected the stimulator polarity will initialize in the Normal mode.  In 
the Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Bilateral - the stimulator polarity will be initialized in the Reversed mode 
when both the Left and Right side is selected for the nerve being tested. 
 In the Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED.. 

 For NCV Studies, the Cathode (-) should be positioned closest to the 
recording electrodes. 

 In the Normal mode, the electrical stimulator image on the screen will 
show the Right-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Nml. 

.    

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

 In the Reversed mode, the electrical stimulator image on the screen will 
show the Left-side probe as the Cathode (-).  The polarity field on the screen 
will indicate Rev. 
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Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 

Site and Segment Table Settings: 

This section is used to program the recording site name, stimulus site names, 
normal values, and segments for velocity calculations.  The two tables in this 
section are commonly referred to as the Site and Segment tables. 

 

To enter the Recording Site name:  Click in the Rec Site box, type the 
recording site name and press Enter. 

To enter Stimulating Site names: 

 For a new nerve - the first row of the Site Table will be blank, simply click 
in the Site box then type the stimulus site name and press Enter.  A 
second row will automatically be displayed.  Continue entering site names 
until complete. 

 For an existing nerve - right click the mouse on an existing site name, a 
pop up menu will be displayed.  Select Insert from this menu and a new 
row will be inserted above the site name that you originally right clicked 
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on.  Now, click in the site name box and type the name for the stimulus 
site. 

 

Right click on an existing site to insert a new row. 

To build Segments for conduction velocities:  After the stimulus site names 
have been entered you can build conduction velocity segments in the segment 
table.  Click within the Site 1 box and select the site name from the pop-up menu. 
 Then, click within the Site 2 box, on the same row, and select the other site 
name from the pop-up menu.  For example, selecting Elbow for the first site and 
Wrist for the second site will allow a conduction velocity to be calculated for the 
Elbow to Wrist segment. 

 

Building a conduction velocity segment. 

 

To Enter Normal Values:  There are three methods for entering normal values; 
Simple Value Limit, Simple Value Limit by Age Group, or Prediction 
Equation. 

 Method #1 - Simple Value Limit:   

Click in the normal value field and type the desired value for the upper or 
lower limit, then press Enter.  You can use symbols such as > (greater 
than) or < (less than) if you like. 
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 Method #2 - Simple Value Limit by Age Group: 

Up to 8 Age Groups can be defined and normal values can be entered for 
each group.  The Sierra Wave program will compute the patient‟s age based 
on their date-of-birth and then use the appropriate age group norms. 

To define the Age Groups: 

1. Click on the Define Age Groups button. 

 

2. Select the number of Age Groups, the maximum is 8. 

3. Fill in the upper age limit for each group, select years or months, 
and click OK. 

4. Select a Nerve from the nerve list. 

5. Check the Use Age Groups box.  This will enable the age groups 
drop-down list. 
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6. Enter the normal values for this age group into the Site and Segment 
tables.  Repeat for each age group in the drop-down list. 

7. Select another nerve in the nerve list, repeat steps 5 and 6. 

If the patient's date-of-birth is not entered into the patient information 
window, the program will use the normal values entered for the All Ages 
group. 

 

 Method #3 - Prediction Equation: 

Normal values can be predicted using the patient‟s Age and Height. Click 
on the Prediction Equation button, a window will be displayed which 
allows you to input the factors for Age, Height, Constant, and Standard 
Deviation needed by the prediction equation; this is done on a per nerve 
basis.  The equation can be used to predict Onset latency, Peak latency, 
Amplitude, and Velocity.  If the equation is enabled, the normal value in the 
Site or Segment table is replaced with the letters “PV”, for predicted value. 
 This signifies that the normal value is not a simple value limit but will 
instead be calculated and displayed on the data acquisition screen once 
the patient‟s Date of Birth (i.e., Age) and Height have been input in the 
Patient Information window. 
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Prediction Equation setup window. 

The prediction equation used is: 

Predicted Value = Constant + (Age x Age Factor) + (Height x 
Height Factor) 

If the standard deviation is known then: 

Normal Value = Predicted Value +/- 'x' Standard Deviations 

Typically: 

Latency Norm = Predicted Value + 2 SD 

Amplitude Norm = Predicted Value – 2 SD 

Velocity Norm = Predicted Value – 2 SD 
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To use the prediction equation the patient's height must be entered in 
centimeters. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

If the patient‟s Date of Birth and/or Height have not been entered prior 
to loading the test protocol the normal value will be shown as <0.0 or >0.0 
with a yellow background.  Once the Date of Birth and/or Height have 
been entered the predicted normal values will be displayed. 

When the prediction equation is enabled you cannot input a simple 
value limit for the norm. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

 

To Enter a Distance:  Sometimes a fixed distance is always used for a nerve 
segment.  To program a distance simply click in the appropriate distance field 
and type the value.  The Sierra Wave always uses distances in Centimeters. 
 There is no need to type "cm" in the box. 

To Delete a Site or Segment:  Right click the mouse over the row you want to 
delete and select Delete from the pop-up menu. 

Cursor Offset:  This parameter determines the starting point (in milliseconds) for 

the auto-cursor algorithm.  Data prior to this setting is ignored by the algorithm. 

 

 

To use Temperature Corrected Velocity: 

1. Click on the Setup Temp Factors button. 

 

2. Enter the Reference Temperature (in °C), and the Correction Factor 
(meters/sec per °C) for the selected nerve. 
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3. Click OK. 

4. Check the box "Use Temp Correction". 

 

If the patient's measured temperature is below the reference temperature -- for 
every degree that is below the reference temperature the program will add the 
correction factor to the displayed velocity value.  This will be indicated by the 
letter "T" after the velocity value. 

Using the above reference temperature and correction factor: 

If the patient's temperature was measured at 30°C, the program would 
add 4.5 (1.5 x 3) to the velocity value. 

5. Repeat steps 1 to 4 for other nerves in the nerve list. 

6. Click OK to close the Test Menu window and save your changes to the 
Nerve's settings. 

 

General Settings Tab 

The parameter settings within this section are applied to all nerves within the 
nerve list. 

Custom Keys: 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 
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Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 

 

General Stimulator Settings: 

This section has settings that affect the electrical stimulator intensity. 

 

 Keep Intensity On/Off - when set to On, the stimulus intensity will not be 
reset to zero milliamps when changing from one nerve to the next.  The 
intensity will remain at what was used last.  When this parameter is set to 
Off, the stimulus intensity will always be reset to zero milliamps when 
changing from one nerve to the next. 

 Start Intensity - sets the initial starting stimulus intensity for the first nerve 
to be selected.  Possible selections are 0, 10, 20, 30, 40, 50, 60, 70, 80, 
90, and 100 milliamps. 

 Max Intensity - sets the maximum intensity level in milliamps.  Possible 
selections are 10, 20, 30, 40, 50, 60, 70, 80, 90, and 100 milliamps. 
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Trace Labels: 

By default, all NCV traces are automatically displayed with the Site name for a 
trace label (e.g., Wrist, Elbow).  These settings can be used to add other 
information to the trace label. 

 

There are five additional fields that can be added to the trace label.  Simply click 
in the first blank field and make a selection from the pop-up list.  The above 
example shows how to add the Gain setting to the trace label. 

 

Cursor Display: 

There are three options for how the cursors will appear on the traces.  The 
factory default selection is Show Labels. 

 

 Show Labels - shows the labels O (onset), P (peak), T (trough), and 
R (recovery). 
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 Labels and Values - shows the labels mentioned above as well as 
the latency value for the cursor and the amplitude value between two 
cursors in brackets. 

 

 Show Values - shows the latency value for the cursor and the 
amplitude values between two cursors in brackets. 

 

 

Lock Cursor Order: 

Check this box to 'lock' the cursor order.  This will prevent the user from 
being able to move the Onset cursor past the Peak cursor, the Peak past 
the Trough, and so on. 

 

Distance Value: 

 Copy Distance value when changing sides - enabling this feature 
causes the program to automatically copy all segment distances 
entered for one side of a nerve to the opposite side when it is 
selected for testing. 

 Use 0.1 cm Distance Increments - enabling this feature causes the 
wheel on the stimulator handle to increment the distance value in 0.1 
cm increments rather than 0.5 cm increments. 
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Multiple Channels: 

Enabling this feature allows channels 3 & 4 to be used in the NCV test 
protocol. 

 

Optional Windows: 

 Show Live Monitor - when this window is enabled it displays the “Live” 
activity coming from the recording electrodes.  When electrical stimulation 
occurs, the window will briefly display a stimulus-triggered waveform, and 
then will go back to display “Live” activity after one second. 

This window can be positioned, sized, and saved as part of the default 
settings for the test protocol. 

 

Trace History: 

 Disable Trace History on restimulation of a site - when this box 
is checked the Trace History window will be suppressed (hidden) 
during restimulation of a site. 

 Save Trace History data - when this box is checked the program 
will store all Trace History data in the patient's record. 

 

Velocity Precision: 

Enabling this feature will cause all velocity values to be displayed with one 
decimal place. 
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AnatomyView Nerve Map: 

 

The AnatomyVIEW feature allows the NCV nerve segment data to be displayed 
on a 3D color-coded anatomical model. 

The Sierra Wave is very flexible in that each user can create and name their own 
nerves, sites, and segments; and change the name of factory default nerves. 
 Therefore, the program must be able to match each users name for a nerve 
segment to the nerve segment ID that is recognized by the AnatomyVIEW 
window.  This is done using the Nerve Map Editor. 

Click on the AnatomyVIEW Nerve Map button to open the Nerve Map Editor 
window. 

 

Nerve Map Editor window. 

Column Descriptions: 

 Sierra Nerve List - this column shows the user's nerve list, as read 
from the NCV test protocol setup window.  Only those sites and 
segments with corresponding normal values (latency, amplitude, or 
velocity) are shown in the list. 
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 Right Mapped IDs - this column shows the nerve segment ID's 
from the Viewer that have been assigned to this site/segment for 
the Right side. 

 Left Mapped IDs - this column shows the nerve segment ID's from 
the Viewer that have been assigned to this site/segment for the Left 
side.  

 Nerve Segments Available in AnatomyVIEW - this column lists 
all the nerve segment IDs that the Viewer is able to display. 

 

To  Map a Viewer Nerve Segment ID to a Site/Segment: 

1. Find the appropriate nerve segment ID in the Viewer List. 

2. Left click on the nerve segment ID and drag it over to the 
appropriate Right or Left Mapped ID cell. 

3. Release the mouse button to drop the nerve segment ID into the 
cell. 

 

Click and Drag nerve segment available in Viewer and drop into appropriate user site/segment 

 

To Clear an Assignment: 

1. Highlight the appropriate cell by clicking on it with the mouse. 

2. Click on the Clear button. 

 

To Clear All Assignments: 

1. Click on the Clear All button. 
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To Save the Assignments: 

1. Click on the OK button. 

 The nerve mapping data is saved to a file in the user's setup 
folder.  This file is named "NerveMap.xml" and it is automatically 
included in the Preserve & Restore functions. 

 

Window Buttons: 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
NCV test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the NCV test settings that were previously stored in a file using the Save 
Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
NCV settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the NCV test protocol settings.  (All nerves are saved) 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the NCV test protocol settings. 
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F Wave Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the F Wave test protocol in the test list.  The F Wave test 
protocol settings will be displayed on the right hand side of the screen. 

 

F Wave Setup window. 

 

General Stimulator Settings 

This section has settings that affect the electrical stimulator intensity.  These 
settings apply to all the nerves listed in the Nerve List. 

 

 Keep Intensity On/Off - when set to On, the stimulus intensity will not be 
reset to zero milliamps when changing from one nerve to the next.  The 
intensity will remain at what was used last.  When this parameter is set to 
Off, the stimulus intensity will always be reset to zero milliamps when 
changing from one nerve to the next. 
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 Start Intensity - sets the initial starting stimulus intensity for the first nerve 
to be selected.  Possible selections are 0, 10, 20, 30, 40, 50, 60, 70, 80, 
90, and 100 milliamps. 

 Max Intensity - sets the maximum intensity level in milliamps.  Possible 
selections are 10, 20, 30, 40, 50, 60, 70, 80, 90, and 100 milliamps. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch.  These 
settings apply to all the nerves listed in the Nerve List. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 

 

Nerve List 

This section is used to specify the types of F Wave tests that will be performed. 
 For each nerve that is defined, you can program the default normal value, L-R 
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normal value, recording site, amplifier settings, stimulator settings, test options, 
and trace position settings. 

There are two types of F Wave test, Markers mode or Cursors mode. 

 Markers Mode - a single latency marker is used for the minimum F wave 
latency. 

 Cursors Mode - auto cursors are placed on each trace and the min, max, 
mean, F/M ratio, and velocity can be calculated. 

Each F Wave type has its own table in the TabData summary window and in 
printed reports. 

To Select a Nerve in the list:  Click on the nerve name with the left mouse 
button.  Once the nerve is selected its parameter settings, and test options will be 
displayed on the right hand side of the screen.  See the section below titled, 
Hardware Settings, for information on how to change these settings. 

 

To insert a new Nerve into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type 
in the Nerve name, then click in the Norm field and type a normal latency 
value, and finally, click in the Recording Site field and enter the muscle name. 

Within the list - right click the mouse over an existing nerve name.  From the 
pop-up menu select Insert.  A new row will appear above the nerve you right 
clicked on.  Enter the nerve name, then click in the Norm field and type a 
normal latency value, and finally, click in the Recording Site field and enter 
the muscle name. 

To insert a Group Heading name into the list:  Right click the mouse over an 
existing nerve name.  From the pop-up menu select Insert Group.  A new row 
will appear above the nerve that you right clicked on.  Enter the heading name in 
the Nerve/Group name field.  Group Headings are automatically shown in bold 
text: 
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To change the name of a Nerve:  Click on the nerve name you want to change. 
 Type the new name and press Enter. 

To change the order of the nerve list:  Changing the order of the nerve list 
requires the use of the Cut & Paste features on the right-click pop-up menu. 
 Begin by right clicking on the nerve or group heading that you want to move, 
select Cut from the pop-up menu.  Now, right click in the list where you want the 
nerve or group heading to go and select Paste from the pop-up menu (the nerve 
or group heading will be pasted above the row you right clicked upon).  Repeat 
this process for all the nerves or group headings you want to move. 

To delete a nerve or group heading from the list:  Right click on the nerve or 
group heading you want to delete, then select Delete from the pop-up menu. 

 

To enter a Normal Value for a nerve:  There are two methods for entering 
normal values; Simple Value Limit or Prediction Equation. 

 Simple Value Limit:   

Click in the normal value column of the nerve list and type the desired 
value.  For example, <33.0. 

 Prediction Equation: 

The normal F wave latency can be predicted using the patient‟s Age and 
Height.  To use the prediction equation, check the box labeled Enable 
Prediction Equation.  You can then input the factors for Age, Height, 
Constant, and Standard Deviation needed by the prediction equation; this is 
done on a per nerve basis.  If the equation is enabled, the normal value in 
the nerve list is ignored and the norm will instead be calculated and 
displayed on the data acquisition screen once the patient‟s Date of Birth 
(i.e., Age) and Height have been input in the Patient Information window. 

 

The prediction equation used is: 

Predicted Value = Constant + (Age x Age Factor) + (Height x 
Height Factor) 
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If the standard deviation is known then: 

Normal Value = Predicted Value + 'x' Standard Deviations 

Typically: 

F Wave Latency Norm = Predicted Value + 2 SD 

To use the prediction equation the patient's height must be entered in 
centimeters. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

If the patient‟s Date of Birth and/or Height have not been entered prior 
to loading the test protocol the normal value will be shown as <0.0 with a 
yellow background.  Once the Date of Birth and/or Height have been 
entered the predicted normal value will be displayed. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

 

Hardware Settings 

Once a nerve has been selected from the Nerve/Group list its parameter settings 
and test options will be displayed in the Hardware settings section. 

Amplifier: 

 

Only Channel 1 is supported in the F Wave test protocol. 

Amp Gain:  Click here to select the default M Wave Amplifier Gain setting in 
microvolts per division (uV/Div). 

Disp Gain:  Click here to select the default M Wave Display Gain setting in 
microvolts per division (uV/Div). 
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Split Gain:  Click here to select the default F Wave Display Gain setting in 
microvolts per division (uV/Div). 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected 
channel.  When common reference is On the individual reference input for the 
channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of either -1, 0, 
or +1 division.  A setting of -1 will show one division of activity before the 
stimulus. 

Split Pt:  Click here to set the default position of the gain split point in 
divisions. 

Max Sweep:  Click here to select the maximum sweep speed that can be 
used for the test in milliseconds per division (ms/Div). 

 

Stimulator: 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed 
in the Normal or Reversed mode on a Side basis.  Clicking the drop down 
arrow for this parameter will list four choices, Neither, Left, Right, and 
Bilateral (both). 

 Neither - the stimulator polarity will be initialized in the Normal 
mode when either the Left or Right side is selected for the nerve 
being tested.  In the Normal mode, the right-side probe will be the 
Cathode (-) and is indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode 
when the Left side is selected for the nerve being tested.  When 
the Right side is selected the stimulator polarity will initialize in the 
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Normal mode.  In the Reversed mode, the left-side probe will be 
the Cathode (-) and is indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed 
mode when the Right side is selected for the nerve being tested. 
 When the Left side is selected the stimulator polarity will initialize in 
the Normal mode.  In the Reversed mode, the left-side probe will 
be the Cathode (-) and is indicated by a green LED. 

 Bilateral - the stimulator polarity will be initialized in the Reversed 
mode when both the Left and Right side is selected for the nerve 
being tested.  In the Reversed mode, the left-side probe will be the 
Cathode (-) and is indicated by a green LED.. 

 For F Wave Studies, the Cathode (-) should be positioned away 
from the recording electrodes (i.e., Cathode proximal, Anode Distal). 

 In the Normal mode, the electrical stimulator image on the screen 
will show the Right-side probe as the Cathode (-).  The polarity field on 
the screen will indicate Nml. 

  

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

 In the Reversed mode, the electrical stimulator image on the screen 
will show the Left-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Rev. 
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Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 

Pulse Width:  Click here to set the electrical stimulus pulse width, also known 
as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 

 

Test Options: 

 

Measurement Mode:  Click here to select either Marker or Auto-Cursor 
mode.  In Marker mode a single latency marker is used to determine the 
minimal F latency.  In Auto-Cursor mode each trace receives auto cursors 
and the F min, F mean, F max, Dispersion (F min - F max), F/M ratio, and 
Velocity are calculated. 

Store Mode:  Click here to select either Manual or Auto-Store mode.  In 
Manual mode the user must press the Store key after each stimulation.  In 
Auto-Store mode the program will automatically store each trace after 
stimulation. 

Distance Column:  Click here to select either Show or Hide.  When Show is 
selected the test will provide a distance field and a velocity field for the 
calculation and display of F wave velocity.  When Hide is selected both the 
distance and velocity fields will be hidden. 
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Trial Count:  Click here to select either No Limit, 5, 10, 15, 20, 30, or 50. 
 When No Limit is selected the test will not limit the number of traces that can 
be acquired and stored.  When one of the listed values is selected the 
program will automatically stop acquiring and storing traces when that value 
is reached. 

Contra Lat. Field:  Click here to select Show or Hide.  When Show is 
selected the test will show the latency value for the contralateral side in the 
measurement table.  When Hide is selected this value is not shown in the 
table. 

 

Trace Position 

 

Start Position:  This is the default trace position for Channel 1 within the 
trace window.  It is the number of vertical divisions below the top of the trace 
window.  In this example, the first trace will be positioned 4 divisions below 
the top of the window. 

Trial Offset:  This setting determines how much space will separate each 
stored F Wave trace.  In this example the setting is 0.5 divisions, therefore the 
second F Wave trace will be displayed 0.5 divisions below the first trace.  If a 
third F Wave trace is acquired it will be displayed 0.5 divisions below the 
second F Wave trace and so on. 

Auto Adjust Traces:  When checked, this parameter will automatically adjust 
the Start Position and Trial Offset to keep all acquired traces displayed within 
the Trace window. 

 Trace Position settings can be changed during data acquisition by right-
clicking with the mouse on the trace window and selecting Trace Position 
Settings from the pop-up menu. 

 

Trace Labels 

By default, all F Wave traces are automatically displayed with the Trial 
Number for a trace label (e.g., Tr1, Tr2, Tr3).  These settings can be used to 
add other information to the trace label. 
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There are five additional fields that can be added to the trace label.  Simply 
click in the first blank field and make a selection from the pop-up list.  The 
above example shows how to add the Gain setting to the trace label. 

 

Distance Value 

This setting determines the increments that will be used when the wheel on 
the electrical stimulator is used to enter distance measurements.  When 
checked, the wheel will use 0.1 cm increments. 

 

 

Optional Windows 

 Show Live Monitor - when this window is enabled it displays the “Live” 
activity coming from the recording electrodes.  When electrical stimulation 
occurs, the window will briefly display a stimulus-triggered waveform, and 
then will go back to display “Live” activity after one second. 

This window can be positioned, sized, and saved as part of the default 
settings for the test protocol. 
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Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the F 
Wave test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the F Wave test settings that were previously stored in a file using the 
Save Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
F Wave settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the F Wave test protocol settings.  (All nerves are saved) 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the F Wave test protocol settings. 
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H Reflex Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the H Reflex test protocol in the test list.  The H Reflex test 
protocol settings will be displayed on the right hand side of the screen. 

 

H Reflex Setup window. 

General Stimulator Settings 

This section has settings that affect the electrical stimulator intensity.  These 
settings apply to all the nerves listed in the Nerve List. 

 

 Keep Intensity On/Off - when set to On, the stimulus intensity will not be 
reset to zero milliamps when changing from one nerve to the next.  The 
intensity will remain at what was used last.  When this parameter is set to 
Off, the stimulus intensity will always be reset to zero milliamps when 
changing from one nerve to the next. 
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 Start Intensity - sets the initial starting stimulus intensity for the first nerve 
to be selected.  Possible selections are 0, 10, 20, 30, 40, 50, 60, 70, 80, 
90, and 100 milliamps. 

 Max Intensity - sets the maximum intensity level in milliamps.  Possible 
selections are 10, 20, 30, 40, 50, 60, 70, 80, 90, and 100 milliamps. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch.  These 
settings apply to all the nerves listed in the Nerve List. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 
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Nerve List 

This section is used to specify the types of H Reflex tests that will be performed. 
 For each nerve that is defined, you can program the default normal value, L-R 
normal value, recording site, amplifier settings, stimulator settings, test options, 
and trace position settings. 

To Select a Nerve in the list:  Click on the nerve name with the left mouse 
button.  Once the nerve is selected its parameter settings, and test options will be 
displayed on the right hand side of the screen.  See the section below titled, 
Hardware Settings, for information on how to change these settings. 

 

To Insert a new Nerve into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type 
in the Nerve name, then click in the Norm field and type a normal latency 
value, and finally, click in the Recording Site field and enter the muscle name. 

Within the list - right click the mouse over an existing nerve name.  From the 
pop-up menu select Insert.  A new row will appear above the nerve you right 
clicked on.  Enter the nerve name, then click in the Norm field and type a 
normal latency value, and finally, click in the Recording Site field and enter 
the muscle name. 

To insert a Group Heading name into the list:  Right click the mouse over an 
existing nerve name.  From the pop-up menu select Insert Group.  A new row 
will appear above the nerve that you right clicked on.  Enter the heading name in 
the Nerve/Group name field.  Group Headings are automatically shown in bold 
text: 

To change the name of a Nerve:  Click on the nerve name you want to change. 
 Type the new name and press Enter. 

To change the order of the nerve list:  Changing the order of the nerve list 
requires the use of the Cut & Paste features on the right-click pop-up menu. 
 Begin by right clicking on the nerve or group heading that you want to move, 
select Cut from the pop-up menu.  Now, right click in the list where you want the 
nerve or group heading to go and select Paste from the pop-up menu (the nerve 
or group heading will be pasted above the row you right clicked upon).  Repeat 
this process for all the nerves or group headings you want to move. 
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To delete a nerve or group heading from the list:  Right click on the nerve or 
group heading you want to delete, then select Delete from the pop-up menu. 

 

To enter a Normal Value for a nerve:  There are two methods for entering 
normal values; Simple Value Limit or Prediction Equation. 

 Simple Value Limit:   

Click in the normal value column of the nerve list and type the desired 
value.  For example, <37.0. 

 Prediction Equation: 

The normal H Reflex latency can be predicted using the patient‟s Age and 
either Height, Leg Length or Arm Length.  To use the prediction equation, 
check the box labeled Enable Prediction Equation.  You can then input 
the factors for Age, Height or Leg/Arm Length, Constant, and Standard 
Deviation needed by the prediction equation; this is done on a per nerve 
basis.  If the equation is enabled, the normal value in the nerve list is 
ignored and the norm will instead be calculated and displayed on the data 
acquisition screen once the patient‟s Date of Birth (i.e., Age) and Height 
or Leg/Arm Length have been input. 

 

The prediction equation used is: 

Predicted Value = Constant + (Age x Age Factor) + (Height  x 
Height Factor) 

Leg or Arm Length and appropriate Factor can be substituted for 
Height. 

If the standard deviation is known then: 

Normal Value = Predicted Value + 'x' Standard Deviations 

Typically: 

H Reflex Latency Norm = Predicted Value + 2 SD 
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To use the prediction equation the patient's height or leg/arm length 
must be entered in centimeters. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

If the patient‟s Date of Birth and/or Height have not been entered prior 
to loading the test protocol the normal value will be shown as <0.0 with a 
yellow background.  Once the Date of Birth and/or Height have been 
entered the predicted normal value will be displayed. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

If Leg Length is selected for the Tibial H Reflex, the standard H Reflex 
Nomogram will be displayed on the acquisition screen and a Leg Length 
field will be shown in the measurement table.  After entering the patient's 
leg length in the table a line will be drawn in the nomogram to indicate the 
predicted normal latency, the blue dot marks the predicted value and the 
green dot marks the upper limit of normal based on the specified standard 
deviation. 
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H Reflex Nomogram 

 

Hardware Settings 

Once a nerve has been selected from the Nerve/Group list its parameter settings 
and test options will be displayed in the Hardware settings section. 
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Amplifier: 

 

Only Channel 1 is supported in the H Reflex test protocol. 

Amp Gain:  Click here to select the default M Wave Amplifier Gain setting in 
microvolts per division (uV/Div). 

Disp Gain:  Click here to select the default M Wave Display Gain setting in 
microvolts per division (uV/Div). 

Split Gain:  Click here to select the default H Reflex Gain setting in 
microvolts per division (uV/Div). 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected 
channel.  When common reference is On the individual reference input for the 
channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of either -1, 0, 
or +1 division.  A setting of -1 will show one division of activity before the 
stimulus. 

Split Pt:  Click here to set the default position of the gain split point in 
divisions. 

Max Sweep:  Click here to select the maximum sweep speed that can be 
used for the test in milliseconds per division (ms/Div). 
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Stimulator: 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed 
in the Normal or Reversed mode on a Side basis.  Clicking the drop down 
arrow for this parameter will list four choices, Neither, Left, Right, and 
Bilateral (both). 

 Neither - the stimulator polarity will be initialized in the Normal mode 
when either the Left or Right side is selected for the nerve being 
tested.  In the Normal mode, the right-side probe will be the Cathode 
(-) and is indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode 
when the Left side is selected for the nerve being tested.  When the 
Right side is selected the stimulator polarity will initialize in the Normal 
mode.  In the Reversed mode, the left-side probe will be the Cathode 
(-) and is indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed mode 
when the Right side is selected for the nerve being tested.  When the 
Left side is selected the stimulator polarity will initialize in the Normal 
mode.  In the Reversed mode, the left-side probe will be the Cathode 
(-) and is indicated by a green LED. 

 Bilateral - the stimulator polarity will be initialized in the Reversed 
mode when both the Left and Right side is selected for the nerve 
being tested.  In the Reversed mode, the left-side probe will be the 
Cathode (-) and is indicated by a green LED.. 

 For H Reflex Studies, the Cathode (-) should be positioned away 
from the recording electrodes (i.e., Cathode proximal, Anode Distal). 

 In the Normal mode, the electrical stimulator image on the screen 
will show the Right-side probe as the Cathode (-).  The polarity field on 
the screen will indicate Nml. 
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Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

 In the Reversed mode, the electrical stimulator image on the screen 
will show the Left-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 

Pulse Width:  Click here to set the electrical stimulus pulse width, also known 
as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 
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Test Options: 

 

Store Mode:  Click here to select either Manual or Auto-Store mode.  In 
Manual mode the user must press the Store key after each stimulation.  In 
Auto-Store mode the program will automatically store each trace after 
stimulation. 

Trial Count:  Click here to select either No Limit, 5, 10, 15, 20, 30, or 50. 
 When No Limit is selected the test will not limit the number of traces that can 
be acquired and stored.  When one of the listed values is selected the 
program will automatically stop acquiring and storing traces when that value 
is reached. 

Contra Lat. Field:  Click here to select Show or Hide.  When Show is 
selected the test will show the latency value for the contralateral side in the 
measurement table.  When Hide is selected this value is not shown in the 
table. 

 

Trace Position 

 

Start Position:  This is the default trace position for Channel 1 within the 
trace window.  It is the number of vertical divisions below the top of the trace 
window.  In this example, the first trace will be positioned 2 divisions below 
the top of the window. 

Trial Offset:  This setting determines how much space will separate each 
stored H Reflex trace.  In this example the setting is 1.5 divisions, therefore 
the second H Reflex trace will be displayed 1.5 divisions below the first trace. 
 If a third H Reflex trace is acquired it will be displayed 1.5 divisions below the 
second H Reflex trace and so on. 

Auto Adjust Traces:  When checked, this parameter will automatically adjust 
the Start Position and Trial Offset to keep all acquired traces displayed within 
the Trace window. 
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 Trace Position settings can be changed during data acquisition by right-
clicking with the mouse on the trace window and selecting Trace Position 
Settings from the pop-up menu. 

 

Trace Labels 

By default, all H Reflex traces are automatically displayed with the Trial 
Number for a trace label e.g., Tr1, Tr2, Tr3).  These settings can be used to 
add other information to the trace label. 

 

There are five additional fields that can be added to the trace label.  Simply 
click in the first blank field and make a selection from the pop-up list.  The 
above example shows how to add the Gain setting to the trace label. 

 

Distance Value 

This setting determines the increments that will be used when the wheel on 
the electrical stimulator is used to enter distance measurements.  When 
checked, the wheel will use 0.1 cm increments. 
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Optional Windows 

 Show Live Monitor - when this window is enabled it displays the “Live” 
activity coming from the recording electrodes.  When electrical stimulation 
occurs, the window will briefly display a stimulus-triggered waveform, and 
then will go back to display “Live” activity after one second. 

This window can be positioned, sized, and saved as part of the default 
settings for the test protocol. 

 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the H 
Reflex test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the H Reflex test settings that were previously stored in a file using the 
Save Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
H Reflex settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the H Reflex test protocol settings.  (All nerves are saved) 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the H Reflex test protocol settings. 
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RNS Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the RNS (Repetitive Nerve Stimulation) test protocol in the test 
list.  The RNS test protocol settings will be displayed on the right hand side of the 
screen. 

 

RNS Test Setup window. 

 

Hardware Settings 

Amplifier: 

 

On:  Click here to program a channel as either On or Off. 
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Gain:  Click here to select the default Gain setting in microvolts per division 
(uV/Div). 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected 
channel.  When common reference is On the individual reference input for the 
channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of either -1, 0, 
or +1 division.  A setting of -1 will show one division of activity before the 
stimulus. 

 

Stimulator: 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed 
in the Normal or Reversed mode on a Side basis.  Clicking the drop down 
arrow for this parameter will list four choices, Neither, Left, Right, and 
Bilateral (both). 

 Neither - the stimulator polarity will be initialized in the Normal mode 
when either the Left or Right side is selected for the nerve being tested. 
 In the Normal mode, the right-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode when 
the Left side is selected for the nerve being tested.  When the Right side 
is selected the stimulator polarity will initialize in the Normal mode.  In the 
Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed mode 
when the Right side is selected for the nerve being tested.  When the 
Left side is selected the stimulator polarity will initialize in the Normal 
mode.  In the Reversed mode, the left-side probe will be the Cathode (-) 
and is indicated by a green LED. 
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 Bilateral - the stimulator polarity will be initialized in the Reversed mode 
when both the Left and Right side is selected for the nerve being tested. 
 In the Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED.. 

 For RNS Studies, the Cathode (-) should be positioned closest to 
the recording electrodes. 

 In the Normal mode, the electrical stimulator image on the screen 
will show the Right-side probe as the Cathode (-).  The polarity field on 
the screen will indicate Nml. 

  

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

 In the Reversed mode, the electrical stimulator image on the screen 
will show the Left-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 
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Pulse Width:  Click here to set the electrical stimulus pulse width, also known 
as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 

 

Max Channels: 

 

To enable 2 Channel recording capability; change this value from 1 to 2. 
 For more information on 2 Channel recording mode, see the topic 2 Channel 
Recording. 

 

General Settings 

 

Mode:  Click to select the default stimulus mode for the test.  Choices are 
Train or Single. 

 Train - When the Stim button on the handheld stimulator or the 
Run/Stop button is pressed a train of stimuli will be delivered. 

 Single - When the Stim button on the hand held stimulator or the 
Single button is pressed a single stimulus will be delivered.  The 
Run/Stop button is disabled in this mode.  This mode is useful for 
determining supramaximal stimulation prior to delivering a train of 
stimuli. 

Train:  Click to select the number of stimuli to be delivered in a train.  The 
maximum number is 150. 

Spread: Click here to select the default spacing between individual traces 
within a train, this setting is in divisions.  To superimpose all the traces on top 
of each other, set this value to zero. 

Response 1:  Click here to select the first response in the train that will be 
analyzed for amplitude and area measurements. 

Response 2:  Click here to select the second response in the train that will be 
analyzed for amplitude and area measurements.  In addition, the percentage 
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difference between this response and the trace selected for Response 1 will 
be computed. 

 

Trace Position 

 

Start Position: This is the default trace position for Channel 1 within the trace 
window.  It is the number of vertical divisions below the top of the trace 
window.  In this example, the first train will be positioned 4 divisions below the 
top of the window. 

Trial Offset:  This setting determines how much space will separate each 
stored RNS train from other stored (purple) trains.  In this example the setting 
is 2.00 divisions, therefore the second stored RNS train will be displayed 2.00 
divisions below the first.  If a third RNS  train is acquired it will be displayed 
2.00 divisions below the second stored RNS train and so on. 

 Trace Position settings can be changed during data acquisition by right-
clicking the mouse on the trace window and selecting Trace Position 
Settings from the pop-up menu. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 
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Custom Key selection list. 

 

Trace Labels 

This section is used to configure how the train labels are displayed and allows 
you to choose the type of  information that is included in the train labels.  The 
train label can consist of up to five parameters.  The parameters can be 
separated by a colon ( ), a hyphen ( ), or a line return ( ). 

 

Display Mode:  Click here to specify how the train labels will be displayed during 
data acquisition.  The choices are; 

 All Trials - train labels are shown on all trains. 

 No Trials - train labels are not shown on any trains. 

 First Trial - only the first train acquired has a train label. 

 Active Trial - only the active train (white) has train labels. 

Trace Label Selections: (up to 5 can be selected) 
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 Trial - shows the trial number or the display mode of active traces (Avg or 
Live). 

 Channel - shows the amplifier channel number. 

 Side - shows the side being tested. 

 Gain - shows the display gain setting. 

 Sweep - shows the sweep speed setting. 

 Intensity - shows the stimulus intensity setting. 

 Rep Rate - shows the stimulus repetition rate. 

 Time - shows the time of day. 

 Custom Ch - allows you to include notations that only appear for a 
specific channel or side (i.e., C4'-Fz or A1-Cz montage designations). 

Left / Right Custom Labels: 

When Custom Ch is selected for one of the five parameters the Left/Right 
Channel area becomes activated.  This allows you to enter a text label of your 
choice for each channel on a left/right basis.  This is most commonly used to 
display the amplifier montage on the channel's trace label. 

Separators: 

The parameters can be separated by a colon ( ), a hyphen ( ), or a line 
return ( ).  Simply click the mouse on the separator and select the type that 
you want from the pop-up list.  The line return can be used to put parameters 
that follow it on a second line. 

 

Muscle List 

This section is used to setup your RNS muscle list.  The list can contain muscle 
names, nerve names, and root levels. 
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To insert a New Muscle into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type in 
the muscle name, nerve name, and root level. 

Within the list - right click the mouse over an existing muscle name.  From the 
pop-up menu select Insert.  A new row will appear above the muscle you right 
clicked on.  Enter the muscle name, nerve name, and root level. 

To insert a Group Heading into the list: 
Right click the mouse over an existing muscle name.  From the pop-up menu 
select Insert Group.  A new row will appear above the muscle that you right 
clicked on.  Enter the heading name in the muscle/group name field, leave the 
remaining fields blank.  Group Headings are automatically shown in bold text: 

To change the name of an existing muscle: 
Click on the muscle name you want to change.  Type the new name and press 
Enter. 

To change the order of the muscles in the list: 
Changing the order of the muscle list requires the use of the Cut & Paste 
features on the right-click pop-up menu.  Begin by right clicking on the muscle 
name or group heading that you want to move, select Cut from the pop-up menu. 
 Now, right click in the list where you want the muscle or group heading to go and 
select Paste from the pop-up menu (the muscle or group heading will be pasted 
above the row you right clicked upon).  Repeat this process for all the muscles 
and group headings you want to move. 

To delete a muscle from the list: 
Right click on the muscle you want to delete, then select Delete from the pop-up 
menu. 
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Sequence Setup 

This section is used to program the stimulus train sequence that will be delivered 
during the test procedure. 

 

 Label - this is a label that describes the stimulus train, it appears in the 
trace window as well as in the results table. 

 Rep Rate - sets the repetition rate (Hz) for the stimulus train. 

 Train Length - sets the number of stimuli that will be delivered in the 
stimulus train.  The maximum train length is 150 (1 channel mode) and 75 
(2 channel mode). 

 Pause Time - sets the amount of time the program will pause at the end 
of the stimulus train before automatically advancing to the next stimulus 
train. 

 

Trace Display 

The settings in this section apply to long stimulus trains. 

 

 Trace Count Threshold - sets a threshold for the Trace Selection List.  If 
the number of stimuli in a stimulus train exceeds the value set for the 
threshold, the traces indicated in the Trace Selection List will be displayed 
in the Trace window for that train. 

 Trace Selection List - numbers separated by a comma indicate which 
traces within the stimulus train will be displayed in the trace window. 
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Table Settings 

 Amplitude Type - determines how amplitude is measured.  Choices are 
Onset-to-Peak (O-P) or Peak-to-Trough (P-T). 

 

 

Optional Windows 

 Show Live Monitor - when this window is enabled it displays the “Live” 
activity coming from the recording electrodes.  When electrical stimulation 
occurs, the window will briefly display a stimulus-triggered waveform, and 
then will go back to display “Live” activity after one second. 

This window can be positioned, sized, and saved as part of the default 
settings for the test protocol. 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
RNS test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the RNS test settings that were previously stored in a file using the Save 
Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
RNS settings from that file. 
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Clicking OK will close the Test Setup window and will save any changes that 
have been made to the RNS test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the RNS test protocol settings. 

 

 

Blink Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the Blink test protocol in the test list.  The Blink test protocol 
settings will be displayed on the right hand side of the screen. 

 

Blink Test Setup window. 
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Hardware Settings 

Amplifier: 

 

On:  Click here to program a channel as either On or Off.  The Blink test 
protocol only supports 2 channels maximum. 

 Connect the electrode leads from the patient's left side (obicularis 
oculi) to the CH 1 inputs on the amplifier, and connect the leads from the 
patient's right side to the CH 2 inputs.  The electrodes must be 
connected to the amplifier in this configuration to ensure the correct 
display of the test data and marker information. 

Gain:  Click here to select the default Gain setting in microvolts per division 
(uV/Div). 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected 
channel.  When common reference is On the individual reference input for the 
channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of either -1, 0, 
or +1 division.  A setting of -1 will show one division of activity before the 
stimulus. 
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Stimulator: 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed 
in the Normal or Reversed mode on a Side basis.  Clicking the drop down 
arrow for this parameter will list four choices, Neither, Left, Right, and 
Bilateral (both). 

 Neither - the stimulator polarity will be initialized in the Normal mode 
when either the Left or Right side is selected for the nerve being tested. 
 In the Normal mode, the right-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode when 
the Left side is selected for the nerve being tested.  When the Right side 
is selected the stimulator polarity will initialize in the Normal mode.  In the 
Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed mode 
when the Right side is selected for the nerve being tested.  When the 
Left side is selected the stimulator polarity will initialize in the Normal 
mode.  In the Reversed mode, the left-side probe will be the Cathode (-) 
and is indicated by a green LED. 

 Bilateral - the stimulator polarity will be initialized in the Reversed mode 
when both the Left and Right side is selected for the nerve being tested. 
 In the Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED.. 

 For Blink Studies, the Cathode (-) should be positioned closest to 
the recording electrodes. 

 In the Normal mode, the electrical stimulator image on the screen 
will show the Right-side probe as the Cathode (-).  The polarity field on 
the screen will indicate Nml. 
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Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

 In the Reversed mode, the electrical stimulator image on the screen 
will show the Left-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 

 

Pulse Width:  Click here to set the electrical stimulus pulse width, also known 
as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 
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Display Settings: 

The Blink test protocol splits the trace window horizontally by side, left sided 
responses are displayed in the top half of the trace window, right sided traces are 
displayed in the bottom half of the trace window.  This parameter can't be 
changed. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 
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Trace Position 

 

Start Position: This is the default trace position for Channel 1 within the trace 
window.  It is the number of vertical divisions below the top of the trace 
window.  In this example, the first trace will be positioned 8 divisions below 
the top of the window. 

Trial Offset:  This setting determines how much space will separate each 
stored Blink trace from both the active (white) and other stored (purple) 
traces.  In this example the setting is 0.25 divisions, therefore the first stored 
Blink trace will be displayed 0.25 divisions below the active trace.  If a second 
Blink  trace is acquired and stored it will be displayed 0.25 divisions below the 
first stored Blink trace and so on.  If you want all the traces from each channel 
superimposed on each other set this value to 0. 

Channel Offset:  This setting only applies when more than one channel is 
turned ON.  It is the amount of space, in vertical divisions, that separates the 
Active (white) channels. 

 Trace Position settings can be changed during data acquisition by right-
clicking the mouse on the trace window and selecting Trace Position 
Settings from the pop-up menu. 

 

Trace Labels 

This section is used to configure how the trace labels are displayed and allows 
you to choose the type of  information that is included in the trace labels.  The 
trace label can consist of up to five parameters.  The parameters can be 
separated by a colon ( ), a hyphen ( ), or a line return ( ). 

 

Display Mode:  Click here to specify how the trace labels will be displayed 
during data acquisition.  The choices are; 
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 All Trials - trace labels are shown on all traces. 

 No Trials - trace labels are not shown on any traces. 

 First Trial - only the first trace/trial acquired on each side has a trace 
label. 

 Active Trial - only the active (white traces) have trace labels. 

Trace Label Selections: (up to 5 can be selected) 

 Trial - shows the trial number or the display mode of active traces (Avg or 
Live). 

 Channel - shows the amplifier channel number. 

 Side - shows the side being tested. 

 Gain - shows the display gain setting. 

 Sweep - shows the sweep speed setting. 

 Intensity - shows the stimulus intensity setting. 

 Rep Rate - shows the stimulus repetition rate. 

 Time - shows the time of day. 

 Custom Ch - allows you to include notations that only appear for a 
specific channel or side (i.e., C4'-Fz or A1-Cz montage designations). 

Left / Right Custom Labels: 

When Custom Ch is selected for one of the five parameters the Left/Right 
Channel area becomes activated.  This allows you to enter a text label of your 
choice for each channel on a left/right basis.  This is most commonly used to 
display the amplifier montage on the channel's trace label. 

Separators: 

The parameters can be separated by a colon ( ), a hyphen ( ), or a line 
return ( ).  Simply click the mouse on the separator and select the type that 
you want from the pop-up list.  The line return can be used to put parameters 
that follow it on a second line. 
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Optional Windows 

 Show Live Monitor - when this window is enabled it displays the “Live” 
activity coming from the recording electrodes.  When electrical stimulation 
occurs, the window will briefly display a stimulus-triggered waveform, and 
then will go back to display “Live” activity after one second. 

This window can be positioned, sized, and saved as part of the default 
settings for the test protocol. 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
Blink test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the Blink test settings that were previously stored in a file using the Save 
Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
Blink settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the Blink test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the Blink test protocol settings. 
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Single Fiber EMG Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the SFEMG test protocol in the test list.  The SFEMG test 
protocol settings will be displayed on the right hand side of the screen. 

Use the settings on this screen to program the default parameters for Graticule 
size, Amplifier settings, Trace positioning, Custom Key settings, and the Muscle 
List. 

 

SFEMG Setup window. 
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Hardware Settings 

Amplifier Settings 

 

On: Click here to program a channel as either On or Off. 

Gain:  Click here to select the default Gain setting in microvolts per division 
(uV/Div). 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected channel. 
 When common reference is On the individual reference input for the channel is 
disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Sweep: Click here to select the default sweep speed setting in milliseconds per 
division (ms/Div). 

TrgDel:  Click here to select the trigger delay point.  The choices are 1 to 9 
divisions in 0.1 increments. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 
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Custom Key selection list. 

 

General Settings 

 

Max Samples:  Sets the maximum number of traces that can be held in the 
captured trace buffer.  Choices are 10, 20, 30, 50, 70, 100, 150, and 200. 

Graticule Size:  These selections change the number of Vertical and Horizontal 
divisions that are displayed in the SFEMG Trace window.  The first number is for 
the number of vertical divisions and the second number is for the number of 
horizontal divisions. 

 Check this box to enable jitter measurement by 
interpolated peak latency rather than by the point on the rising slope that crosses 
through the analysis marker. 
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Muscle List 

This section is used to setup your SFEMG muscle list.  The list can contain group 
headings, muscle names, nerve names, root levels, and normal values for Jitter. 

 

To insert a New Muscle into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type in 
the muscle name, nerve name, root level, and MCD normal value. 

Within the list - right click the mouse over an existing muscle name.  From the 
pop-up menu select Insert.  A new row will appear above the muscle you right 
clicked on.  Enter the muscle name, nerve name, root level, and normal values. 

To insert a Group Heading into the list: 
Right click the mouse over an existing muscle name.  From the pop-up menu 
select Insert Group.  A new row will appear above the muscle that you right 
clicked on.  Enter the heading name in the muscle/group name field, leave the 
remaining fields blank.  Group Headings are automatically shown in bold text: 

To change the name of an existing muscle: 
Click on the muscle name you want to change.  Type the new name and press 
Enter. 

To change the order of the muscles in the list: 
Changing the order of the muscle list requires the use of the Cut & Paste 
features on the right-click pop-up menu.  Begin by right clicking on the muscle 
name or group heading that you want to move, select Cut from the pop-up menu. 
 Now, right click in the list where you want the muscle or group heading to go and 
select Paste from the pop-up menu (the muscle or group heading will be pasted 
above the row you right clicked upon).  Repeat this process for all the muscles 
and group headings you want to move. 
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To delete a muscle from the list: 
Right click on the muscle you want to delete, then select Delete from the pop-up 
menu. 

Normal Values: 

 Mean Jitter Norm - this is the muscle's overall normal value for mean 
MCD of 20 fiber pairs. 

 Ind. Jitter Norm - this is the normal value for individual single fiber pairs. 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
SFEMG test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the SFEMG test settings that were previously stored in a file using the 
Save Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
SFEMG settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the SFEMG test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the SFEMG test protocol settings. 
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Stimulated Single Fiber EMG Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the Stim SFEMG test protocol in the test list.  The Stim 
SFEMG test protocol settings will be displayed on the right hand side of the 
screen. 

Use the settings on this screen to program the default parameters for Graticule 
size, Amplifier settings, Stimulator settings, Trace positioning, Custom Key 
settings, and the Muscle List. 

 

Stim SFEMG (stimulated single fiber emg) Setup window. 

 

The only difference between Stim SFEMG and SFEMG setup is the addition of 
electrical stimulator settings.  Therefore this topic will only cover the electrical 
stimulator controls.  For information about the other settings, please go to the 
SFEMG setup topic. 
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Stimulator Settings 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed 
in the Normal or Reversed mode on a Side basis.  Clicking the drop down 
arrow for this parameter will list four choices, Neither, Left, Right, and 
Bilateral (both). 

 Neither - the stimulator polarity will be initialized in the Normal mode 
when either the Left or Right side is selected for the nerve being tested. 
 In the Normal mode, the right-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode when 
the Left side is selected for the nerve being tested.  When the Right side 
is selected the stimulator polarity will initialize in the Normal mode.  In the 
Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed mode 
when the Right side is selected for the nerve being tested.  When the 
Left side is selected the stimulator polarity will initialize in the Normal 
mode.  In the Reversed mode, the left-side probe will be the Cathode (-) 
and is indicated by a green LED. 

 Bilateral - the stimulator polarity will be initialized in the Reversed mode 
when both the Left and Right side is selected for the nerve being tested. 
 In the Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 In the Normal mode, the electrical stimulator image on the screen 
will show the Right-side probe as the Cathode (-).  The polarity field on 
the screen will indicate Nml. 
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Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

 In the Reversed mode, the electrical stimulator image on the screen 
will show the Left-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 

 

Pulse Width:  Click here to set the electrical stimulus pulse width, also known 
as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 

Stim Incr.:  Click here to set the default intensity increments for the electrical 
stimulator.  Values are in milliamps (mA). 
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Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
SSFEMG test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the SSFEMG test settings that were previously stored in a file using the 
Save Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
SSFEMG settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the SSFEMG test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the SSFEMG test protocol settings. 
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Real Time SFEMG Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the Real Time SFEMG test protocol in the test list.  The Real 
Time SFEMG test protocol settings will be displayed on the right hand side of the 
screen. 

Use the settings on this screen to program the default parameters for Graticule 
size, Amplifier settings, Stimulator Settings, Custom Key settings, Peak Analyzer 
settings, and the Muscle List. 

 

Real Time SFEMG Setup window. 

Hardware Settings 

Amplifier Settings 
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On: Click here to program a channel as either On or Off. 

Gain:  Click here to select the default Gain setting in microvolts per division 
(uV/Div). 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected channel. 
 When common reference is On the individual reference input for the channel is 
disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Sweep: Click here to select the default sweep speed setting in milliseconds per 
division (ms/Div). 

TrgDel:  Click here to select the trigger delay point.  The choices are 1 to 9 
divisions in 0.1 increments. 

 

Stimulator Settings 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed 
in the Normal or Reversed mode on a Side basis.  Clicking the drop down 
arrow for this parameter will list four choices, Neither, Left, Right, and 
Bilateral (both). 

 Neither - the stimulator polarity will be initialized in the Normal mode 
when either the Left or Right side is selected for the nerve being tested. 
 In the Normal mode, the right-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode when 
the Left side is selected for the nerve being tested.  When the Right side 
is selected the stimulator polarity will initialize in the Normal mode.  In the 
Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed mode 
when the Right side is selected for the nerve being tested.  When the 
Left side is selected the stimulator polarity will initialize in the Normal 
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mode.  In the Reversed mode, the left-side probe will be the Cathode (-) 
and is indicated by a green LED. 

 Bilateral - the stimulator polarity will be initialized in the Reversed mode 
when both the Left and Right side is selected for the nerve being tested. 
 In the Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 In the Normal mode, the electrical stimulator image on the screen 
will show the Right-side probe as the Cathode (-).  The polarity field on 
the screen will indicate Nml. 

  

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

 In the Reversed mode, the electrical stimulator image on the screen 
will show the Left-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 
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Pulse Width:  Click here to set the electrical stimulus pulse width, also known 
as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 

Stim Incr.:  Click here to set the default intensity increments for the electrical 
stimulator.  Values are in milliamps (mA). 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 
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General Settings 

 

Graticule Size:  These selections change the number of Vertical and Horizontal 
divisions that are displayed in the SFEMG Trace window.  The first number is for 
the number of vertical divisions and the second number is for the number of 
horizontal divisions. 

Return to Acquisition mode after pressing Store key:  Enabling  this check 
box causes the program to automatically return to acquisition mode as soon as 
the Store key is pressed in analysis mode. 

Clear buffer after trigger adjustment:  Enabling this check box causes the 
program to automatically clear the capture buffer, and peak detect window, when 
the trigger indicator position is changed. 

 

Peak Analyzer 

 

This section is used to adjust the automatic peak detection criteria. 

Minimum Peak Amplitude (Div) - choices are 0.25 or 0.5 divisions.  The default 
setting is 0.5. 

Maximum Peak Duration (uS) - choices are 250, 300, or 350.  The default 
setting is 250. 
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Minimum Peak Separation (uS) - choices are 150, 100, or 50.  The default 
setting is 150. 

Maximum Latency Deviation (StdDev) - choices are 4, 3, or 2.  The default 
setting is 4. 

Minimum Peak Frequency (% of Trials) - choices are 30, 20, 10, or 0.  The 
default setting is 30. 

The peak analyzer settings must be adjusted prior to data acquisition. 

For more information on the peak detection critera, click here. 

 

Muscle List 

This section is used to setup your Real Time SFEMG muscle list.  The list can 
contain group headings, muscle names, nerve names, root levels, and normal 
values for Jitter. 

 

To insert a New Muscle into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type in 
the muscle name, nerve name, root level, and MCD normal value. 

Within the list - right click the mouse over an existing muscle name.  From the 
pop-up menu select Insert.  A new row will appear above the muscle you right 
clicked on.  Enter the muscle name, nerve name, root level, and normal values. 

To insert a Group Heading into the list: 
Right click the mouse over an existing muscle name.  From the pop-up menu 
select Insert Group.  A new row will appear above the muscle that you right 
clicked on.  Enter the heading name in the muscle/group name field, leave the 
remaining fields blank.  Group Headings are automatically shown in bold text: 
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To change the name of an existing muscle: 
Click on the muscle name you want to change.  Type the new name and press 
Enter. 

To change the order of the muscles in the list: 
Changing the order of the muscle list requires the use of the Cut & Paste 
features on the right-click pop-up menu.  Begin by right clicking on the muscle 
name or group heading that you want to move, select Cut from the pop-up menu. 
 Now, right click in the list where you want the muscle or group heading to go and 
select Paste from the pop-up menu (the muscle or group heading will be pasted 
above the row you right clicked upon).  Repeat this process for all the muscles 
and group headings you want to move. 

To delete a muscle from the list: 
Right click on the muscle you want to delete, then select Delete from the pop-up 
menu. 

Normal Values: 

 Mean Jitter Norm - this is the muscle's overall normal value for mean 
MCD of 20 fiber pairs. 

 Ind. Jitter Norm - this is the normal value for individual single fiber pairs. 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
Real Time SFEMG test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the Real Time SFEMG test settings that were previously stored in a file 
using the Save Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
Real Time SFEMG settings from that file. 
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Clicking OK will close the Test Setup window and will save any changes that 
have been made to the Real Time SFEMG test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the Real Time SFEMG test protocol settings. 

 

Stim Real Time SFEMG Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the Stim Real Time SFEMG test protocol in the test list.  The 
Stim Real Time SFEMG test protocol settings will be displayed on the right hand 
side of the screen. 

Use the settings on this screen to program the default parameters for Graticule 
size, Amplifier settings, Stimulator settings, Custom Key settings, Peak Analyzer 
Settings, and the Muscle List. 

 

Stim Real Time SFEMG setup window. 
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The only difference between Stim Real Time SFEMG and Real Time SFEMG 
setup is that different normal values have bee programmed for the muscles. 
 Please go to the Real Time SFEMG setup topic for a description of the setup 
parameters. 

 

Macro EMG Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the Macro EMG test protocol in the test list.  The Macro EMG 
test protocol settings will be displayed on the right hand side of the screen. 

Use the settings on this screen to program the default parameters for Graticule 
size, Amplifier settings, Custom Key settings, and the Muscle List. 

 

Macro EMG Setup window. 
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Hardware Settings 

Amplifier Settings 

 

On: Click here to program a channel as either On or Off. 

Gain:  Click here to select the default Gain setting in microvolts per division 
(uV/Div). 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected channel. 
 When common reference is On the individual reference input for the channel is 
disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Sweep: Click here to select the default sweep speed setting for channel 1 
(SFEMG channel) in milliseconds per division (ms/Div). 

Sweep2: Click here to select the default sweep speed setting for channel 2 
(Macro channel) in milliseconds per division (ms/Div). 

TrgDel:  Click here to select the trigger delay point.  The choices are 1 to 9 
divisions in 0.1 increments. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 
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Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 

General Settings 

 

Graticule Size:  These selections change the number of Vertical and Horizontal 
divisions that are displayed in the SFEMG and Macro Trace windows.  The first 
number is for the number of vertical divisions and the second number is for the 
number of horizontal divisions. 

 

Muscle List 

This section is used to setup your Macro EMG muscle list.  The list can contain 
group headings, muscle names, nerve names, and root levels. 
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To insert a New Muscle into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type in 
the muscle name, nerve name, and root level. 

Within the list - right click the mouse over an existing muscle name.  From the 
pop-up menu select Insert.  A new row will appear above the muscle you right 
clicked on.  Enter the muscle name, nerve name, and root level. 

To insert a Group Heading into the list: 
Right click the mouse over an existing muscle name.  From the pop-up menu 
select Insert Group.  A new row will appear above the muscle that you right 
clicked on.  Enter the heading name in the muscle/group name field, leave the 
remaining fields blank.  Group Headings are automatically shown in bold text: 

To change the name of an existing muscle: 
Click on the muscle name you want to change.  Type the new name and press 
Enter. 

To change the order of the muscles in the list: 
Changing the order of the muscle list requires the use of the Cut & Paste 
features on the right-click pop-up menu.  Begin by right clicking on the muscle 
name or group heading that you want to move, select Cut from the pop-up menu. 
 Now, right click in the list where you want the muscle or group heading to go and 
select Paste from the pop-up menu (the muscle or group heading will be pasted 
above the row you right clicked upon).  Repeat this process for all the muscles 
and group headings you want to move. 

To delete a muscle from the list: 
Right click on the muscle you want to delete, then select Delete from the pop-up 
menu. 
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Table Control 

 

Area & Amplitude - this setting determines how the summarized data for a 
muscle is displayed.  The data for amplitude and area can either be displayed as 
the mean or median value. 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
Macro EMG test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the Macro EMG test settings that were previously stored in a file using the 
Save Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
Macro EMG settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the Macro EMG test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the Macro EMG test protocol settings. 
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MUNE (Incremental) Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the MUNE-Incr test protocol in the test list.  The MUNE-Inr 
(Motor Unit Number Estimation - Incremental) test protocol settings will be 
displayed on the right hand side of the screen. 

Use the settings on this screen to program the default parameters for Amplifier 
settings, Stimulator settings, Trace positioning, Custom Key settings, Table 
settings, and the Muscle List. 

 

MUNE-Incr Setup window 
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Hardware Settings 

Amplifier Settings 

 

On:  Click here to program a channel as either On or Off. 

Max Gain:  Click here to select the default gain setting in microvolts per 
division (uV/Div) for the maximum CMAP trace. 

Incr Gain:  Click here to select the default gain setting in microvolts per 
division (uV/Div) for the individual incremental SMUP (single motor unit 
potential) traces. 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected 
channel.  When common reference is On the individual reference input for the 
channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of either -1, 0, 
or +1 division.  A setting of -1 will show one division of activity before the 
stimulus. 
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Stimulator Settings 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed 
in the Normal or Reversed mode on a Side basis.  Clicking the drop down 
arrow for this parameter will list four choices, Neither, Left, Right, and 
Bilateral (both). 

 Neither - the stimulator polarity will be initialized in the Normal mode 
when either the Left or Right side is selected for the nerve being tested. 
 In the Normal mode, the right-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode when 
the Left side is selected for the nerve being tested.  When the Right side 
is selected the stimulator polarity will initialize in the Normal mode.  In the 
Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed mode 
when the Right side is selected for the nerve being tested.  When the 
Left side is selected the stimulator polarity will initialize in the Normal 
mode.  In the Reversed mode, the left-side probe will be the Cathode (-) 
and is indicated by a green LED. 

 Bilateral - the stimulator polarity will be initialized in the Reversed mode 
when both the Left and Right side is selected for the nerve being tested. 
 In the Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 In the Normal mode, the electrical stimulator image on the screen 
will show the Right-side probe as the Cathode (-).  The polarity field on 
the screen will indicate Nml. 
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Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

 In the Reversed mode, the electrical stimulator image on the screen 
will show the Left-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 

 

Pulse Width:  Click here to set the electrical stimulus pulse width, also known 
as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 

Stim Incr. :  Click here to set the value of the electrical stimulus increments, 
in milliamps (mA).  Choices are 0.026, 0.03, 0.04, 0.05, 0.08. 0.1, 0.2, 0.3, 
and 0.5. 
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Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 

 

Trace Position 

 

Start Position:  This is the default trace within the incremental SMUP trace 
window.  It specifies the number of vertical divisions below the top of the trace 
window.  In this example, the first incremental trace will be positioned 2 
divisions below the top of the window. 
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Trial Offset:  This setting determines how much space will separate each 
stored incremental trace.  In this example the setting is 1.0 divisions, 
therefore the second incremental trace will be displayed 1.0 divisions below 
the first trace.  The third incremental trace will be displayed 1.0 divisions 
below the second trace and so on. 

Auto Adjust Traces:  When checked, this parameter will automatically adjust 
the Start Position and Trial Offset to keep all acquired traces displayed within 
the incremental trace window. 

 Trace Position settings can be changed during data acquisition by right-
clicking with the mouse on the trace window and selecting Trace Position 
Settings from the pop-up menu. 

 

Muscle List 

This section is used to setup your MUNE-Incr muscle list.  The list can contain 
group headings, muscle names, nerve names, root levels, and normal values. 

 

To insert a New Muscle into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type 
in the muscle name, nerve name, root level, and MUNE normal value. 

Within the list - right click the mouse over an existing muscle name.  From 
the pop-up menu select Insert.  A new row will appear above the muscle you 
right clicked on.  Enter the muscle name, nerve name, root level, and normal 
values. 

To insert a Group Heading into the list: 
Right click the mouse over an existing muscle name.  From the pop-up menu 
select Insert Group.  A new row will appear above the muscle that you right 
clicked on.  Enter the heading name in the muscle/group name field, leave the 
remaining fields blank.  Group Headings are automatically shown in bold text: 

To change the name of an existing muscle: 
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Click on the muscle name you want to change.  Type the new name and 
press Enter. 

To change the order of the muscles in the list: 
Changing the order of the muscle list requires the use of the Cut & Paste 
features on the right-click pop-up menu.  Begin by right clicking on the muscle 
name or group heading that you want to move, select Cut from the pop-up 
menu.  Now, right click in the list where you want the muscle or group 
heading to go and select Paste from the pop-up menu (the muscle or group 
heading will be pasted above the row you right clicked upon).  Repeat this 
process for all the muscles and group headings you want to move. 

To delete a muscle from the list: 
Right click on the muscle you want to delete, then select Delete from the pop-
up menu. 

Normal Values: 

 MUNE Norm - enter the normal value for the muscle here. 

 

Table Settings 

 

Area Type:  the MUNE can be calculated using the area of the maximum 
CMAP divided by the area of the mean SMUP.  Choices for the area 
measurement are Neg Area or Full Area. 

Amplitude Type:  the MUNE can be calculated using the amplitude of the 
maximum CMAP divided by the amplitude of the mean SMUP.  Choices for 
the area measurement are O-P (Onset to Peak) or P-T (Peak to Trough). 

Show Area Column:  when enabled the area of the maximum CMAP, the 
area of the mean SMUP, and the MUNE value based on the area will be 
shown in the table. 

Show Amplitude Column:  when enabled the amplitude of the maximum 
CMAP, the amplitude of the mean SMUP, and the MUNE value based on the 
amplitude will be shown in the table. 
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Auto Alternation Threshold 

 

Sets the value of the Cross-Correlation threshold used by the Auto-
Alternation detection algorithm.  The cross-correlation is normalized to the 
largest amplitude incremental trace. 

Alternation refers to the problems that occur when two or more motor 
units are capable of being activated at the same stimulus intensity.  One or 
the other (or both) motor units may be recruited at any given time.  Alternation 
results in a larger number of perceived increments, which in turn results in a 
smaller mean SMUP value, and hence a larger or overestimated MUNE 
value.  The alternation detection function sorts the increment waveforms by 
increasing negative peak amplitude and then subtracts each incremental 
waveform from all subsequent ones; any identical solutions are considered to 
be examples of alternation. 

 

Cursors 

 

Cursor Display: 

There are three options for how the cursors will appear on the traces.  The 
factory default selection is Show Labels. 

 Show Labels - shows the labels O (onset), P (peak), T (trough), and 
R (recovery). 
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 Labels and Values - shows the labels mentioned above as well as 
the latency value for the cursor and the amplitude value between two 
cursors in brackets. 

 

 Show Values - shows the latency value for the cursor and the 
amplitude values between two cursors in brackets. 

 

 

Cursor Offset:  This parameter determines the starting point (in milliseconds) 
for the auto-cursor algorithm.  Data prior to this setting is ignored by the 
algorithm. 

 

Optional Windows 

 Show Live Monitor - when this window is enabled it displays the “Live” 
activity coming from the recording electrodes.  When electrical stimulation 
occurs, the window will briefly display a stimulus-triggered waveform, and 
then will go back to display “Live” activity after one second. 

This window can be positioned, sized, and saved as part of the default 
settings for the test protocol. 
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Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
MUNE-Incr test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the MUNE-Incr test settings that were previously stored in a file using the 
Save Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
MUNE-Incr settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the MUNE-Incr test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the MUNE-Incr test protocol settings. 
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MUNE (MPS) Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the MUNE-MPS test protocol in the test list.  The MUNE-MPS 
(Motor Unit Number Estimation - Multiple Point Stimulation) test protocol settings 
will be displayed on the right hand side of the screen. 

Use the settings on this screen to program the default parameters for Amplifier 
settings, Stimulator settings, Trace positioning, Custom Key settings, Table 
settings, and the Muscle List. 

 

MUNE-MPS Setup window. 
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Hardware Settings 

Amplifier Settings 

 

On:  Click here to program a channel as either On or Off. 

Max Gain:  Click here to select the default gain setting in microvolts per 
division (uV/Div) for the maximum CMAP trace. 

SMUP Gain:  Click here to select the default gain setting in microvolts per 
division (uV/Div) for the individual SMUP (single motor unit potential) traces. 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected 
channel.  When common reference is On the individual reference input for the 
channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of either -1, 0, 
or +1 division.  A setting of -1 will show one division of activity before the 
stimulus. 
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Stimulator Settings 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed 
in the Normal or Reversed mode on a Side basis.  Clicking the drop down 
arrow for this parameter will list four choices, Neither, Left, Right, and 
Bilateral (both). 

 Neither - the stimulator polarity will be initialized in the Normal mode 
when either the Left or Right side is selected for the nerve being tested. 
 In the Normal mode, the right-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode when 
the Left side is selected for the nerve being tested.  When the Right side 
is selected the stimulator polarity will initialize in the Normal mode.  In the 
Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed mode 
when the Right side is selected for the nerve being tested.  When the 
Left side is selected the stimulator polarity will initialize in the Normal 
mode.  In the Reversed mode, the left-side probe will be the Cathode (-) 
and is indicated by a green LED. 

 Bilateral - the stimulator polarity will be initialized in the Reversed mode 
when both the Left and Right side is selected for the nerve being tested. 
 In the Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 In the Normal mode, the electrical stimulator image on the screen 
will show the Right-side probe as the Cathode (-).  The polarity field on 
the screen will indicate Nml. 
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Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

 In the Reversed mode, the electrical stimulator image on the screen 
will show the Left-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 

 

Pulse Width:  Click here to set the electrical stimulus pulse width, also known 
as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 

Stim Incr. :  Click here to set the value of the electrical stimulus increments, 
in milliamps (mA).  Choices are 0.026, 0.03, 0.04, 0.05, 0.08. 0.1, 0.2, 0.3, 
and 0.5. 
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Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 

 

Trace Position 

 

Start Position:  This is the default trace within the individual SMUP trace 
window.  It specifies the number of vertical divisions below the top of the trace 
window.  In this example, the first SMUP trace will be positioned 1.5 divisions 
below the top of the window. 
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Trial Offset:  This setting determines how much space will separate each 
stored SMUP trace acquired from the same stimulus site.  In this example the 
setting is 0.5 divisions, therefore the second SMUP trace will be displayed 0.5 
divisions below the first trace.  The third SMUP trace will be displayed 0.5 
divisions below the second trace and so on. 

Site Offset:  This setting determines how much space will separate the 
stored SMUP traces from different stimulus sites.  In this example the setting 
is 1.5 divisions, therefore the second stimulus site's SMUP will be displayed 
1.5 divisions below the last stored trace for the first stimulus site.  

Auto Adjust Traces:  When checked, this parameter will automatically adjust 
the Start Position and Trial Offset to keep all acquired traces displayed within 
the SMUP trace window. 

 Trace Position settings can be changed during data acquisition by right-
clicking with the mouse on the trace window and selecting Trace Position 
Settings from the pop-up menu. 

 

Muscle List 

This section is used to setup your MUNE-MPS muscle list.  The list can contain 
group headings, muscle names, nerve names, root levels, and normal values. 

 

To insert a New Muscle into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type 
in the muscle name, nerve name, root level, and MUNE normal value. 

Within the list - right click the mouse over an existing muscle name.  From 
the pop-up menu select Insert.  A new row will appear above the muscle you 
right clicked on.  Enter the muscle name, nerve name, root level, and normal 
values. 

To insert a Group Heading into the list: 
Right click the mouse over an existing muscle name.  From the pop-up menu 
select Insert Group.  A new row will appear above the muscle that you right 
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clicked on.  Enter the heading name in the muscle/group name field, leave the 
remaining fields blank.  Group Headings are automatically shown in bold text: 

To change the name of an existing muscle: 
Click on the muscle name you want to change.  Type the new name and 
press Enter. 

To change the order of the muscles in the list: 
Changing the order of the muscle list requires the use of the Cut & Paste 
features on the right-click pop-up menu.  Begin by right clicking on the muscle 
name or group heading that you want to move, select Cut from the pop-up 
menu.  Now, right click in the list where you want the muscle or group 
heading to go and select Paste from the pop-up menu (the muscle or group 
heading will be pasted above the row you right clicked upon).  Repeat this 
process for all the muscles and group headings you want to move. 

To delete a muscle from the list: 
Right click on the muscle you want to delete, then select Delete from the pop-
up menu. 

Normal Values: 

 MUNE Norm - enter the normal value for the muscle here. 

 

Table Settings 

 

Area Type:  the MUNE can be calculated using the area of the maximum 
CMAP divided by the area of the average SMUP.  Choices for the area 
measurement are Neg Area or Full Area. 

Amplitude Type:  the MUNE can be calculated using the amplitude of the 
maximum CMAP divided by the amplitude of the average SMUP.  Choices for 
the area measurement are O-P (Onset to Peak) or P-T (Peak to Trough). 

Show Area Column:  when enabled the area of the maximum CMAP, the 
area of the average SMUP, and the MUNE value based on the area will be 
shown in the table. 

Show Amplitude Column:  when enabled the amplitude of the maximum 
CMAP, the amplitude of the average SMUP, and the MUNE value based on 
the amplitude will be shown in the table. 
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Cursors 

 

Cursor Display: 

There are three options for how the cursors will appear on the traces.  The 
factory default selection is Show Labels. 

 Show Labels - shows the labels O (onset), P (peak), T (trough), and 
R (recovery). 

 

 Labels and Values - shows the labels mentioned above as well as 
the latency value for the cursor and the amplitude value between two 
cursors in brackets. 

 

 Show Values - shows the latency value for the cursor and the 
amplitude values between two cursors in brackets. 
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Cursor Offset:  This parameter determines the starting point (in milliseconds) 
for the auto-cursor algorithm.  Data prior to this setting is ignored by the 
algorithm. 

 

Optional Windows 

 Show Live Monitor - when this window is enabled it displays the “Live” 
activity coming from the recording electrodes.  When electrical stimulation 
occurs, the window will briefly display a stimulus-triggered waveform, and 
then will go back to display “Live” activity after one second. 

This window can be positioned, sized, and saved as part of the default 
settings for the test protocol. 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
MUNE-MPS test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the MUNE-MPS test settings that were previously stored in a file using 
the Save Test feature. 
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Clicking the Restore button will allow you to open a Preserve file and restore the 
MUNE-MPS settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the MUNE-MPS test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the MUNE-MPS test protocol settings. 
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EMG Guidance Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the EMG Guidance test protocol in the test list.  The EMG 
Guidance test protocol settings will be displayed on the right hand side of the 
screen. 

Use the settings on this screen to program the default parameters for Graticule 
size, Amplifier settings, Trace positioning, Custom Key settings, Injection Log 
selections, and the Muscle List. 

 

EMG Guidance Setup window. 
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Hardware Settings 

General Settings 

 

EMG Buffer (secs):  Sets the maximum length of the Live EMG Buffer.  Choices 
are 30, 60, 120, 240, 360, and 600 seconds. 

Confirm Store Commands:  When this box is checked the program will display 
a confirmation window whenever an EMG Guidance Snapshot, or Live Buffer is 
stored.  This ensures that the data is stored with the correct muscle name and 
side. 

 

Auto Log Muscles:  When this box is checked the program will automatically 
add all muscles in the Study List to the Muscle Injection Table as soon as the 
EMG Guidance protocol is loaded.  If this box is not checked, you will need to 
manually add the muscles by using the F2 (Muscle Sel/Add to Log) knob. 

Graticule Size:  These selections change the number of Vertical and Horizontal 
divisions that are displayed in the EMG Guidance Trace window.  The first 
number is for the number of vertical divisions and the second number is for the 
number of horizontal divisions. 
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Amplifier Settings 

 

On:  Click here to turn channel one On or Off. 

Gain:  Click here to select the default Gain setting in microvolts per division 
(uV/Div). 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected channel. 
 When common reference is On the individual reference input for the channel is 
disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Sweep: Click here to select the default sweep speed setting in milliseconds per 
division (ms/Div). 

 

Stimulator Settings 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed 
in the Normal or Reversed mode on a Side basis.  Clicking the drop down 
arrow for this parameter will list four choices, Neither, Left, Right, and 
Bilateral (both). 

 Neither - the stimulator polarity will be initialized in the Normal mode 
when either the Left or Right side is selected for the nerve being tested. 
 In the Normal mode, the right-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode when 
the Left side is selected for the nerve being tested.  When the Right side 
is selected the stimulator polarity will initialize in the Normal mode.  In the 
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Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed mode 
when the Right side is selected for the nerve being tested.  When the 
Left side is selected the stimulator polarity will initialize in the Normal 
mode.  In the Reversed mode, the left-side probe will be the Cathode (-) 
and is indicated by a green LED. 

 Bilateral - the stimulator polarity will be initialized in the Reversed mode 
when both the Left and Right side is selected for the nerve being tested. 
 In the Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 In the Normal mode, the electrical stimulator image on the screen 
will show the Right-side probe as the Cathode (-).  The polarity field on 
the screen will indicate Nml. 

  

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 
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 In the Reversed mode, the electrical stimulator image on the screen 
will show the Left-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 

 

Pulse Width:  Click here to set the electrical stimulus pulse width, also known 
as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 

Stim Incr. :  Click here to set the value of the electrical stimulus increments, 
in milliamps (mA).  Choices are 0.026, 0.03, 0.04, 0.05, 0.08. 0.1, 0.2, 0.3, 
and 0.5. 

Max Intensity:  Click here to set the maximum stimulus intensity, in milliamps 
(mA).  Choices are 10, 20, 30, 40, 50, 60, 70, 80, 90, and 100. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 
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Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 

 

Trace Position Settings 

 

Start Position: This is the default trace position for Channel 1 within the trace 
window.  It is the number of vertical divisions below the top of the trace window. 
 In this example, the trace will be positioned 5 divisions below the top of the 
window. 

Trial Offset:  This setting determines where the first stored EMG Guidance 
snapshot is displayed within the trace window and also how much space will 
separate additional stored snapshots within the same trace window.  In this 
example the setting is 0.5 divisions, therefore the first stored snapshot will be 
displayed 0.5 divisions below the Live trace.  If another snapshot is stored within 
the same trace window it will be displayed 0.5 divisions below the first stored 
snapshot and so on. 

Channel Offset:  This setting only applies when more than one channel is turned 
ON.  It is the amount of space, in vertical divisions, that separates the Live 
channels. 



Test Protocol Setup 

293 

 These settings can be changed during data acquisition by right-clicking the 
mouse on the trace window and selecting Trace Position Settings from the pop-
up menu. 

 

Muscle Injection Table 

This section is used to setup your muscle injection table column names (i.e., 
BTX-Type, Lot #, # Sites Injected), the column type (List or Text), and if 
applicable the default values (i.e., choices) for the column. 

 

Name column:  These entries will be displayed as the column headings across 
the top of your muscle injection table.  The first four entries Side, Muscle, Nerve, 
and Root are fixed and cannot be altered.  The remaining entries are 
programmable.  To change an existing name simply select it by clicking on it with 
the mouse, then type the new name and press Enter.  To enter a new name, 
click on the blank entry at the bottom of the list, then type the name for the entry 
and press Enter. 

It is a good idea to keep the Name entries as short as possible.  This will 
allow more column headings to be entered and displayed across the report table. 

Type column:  After entering the name for the column you can specify the 
column type.  Simply click on the type setting and select Label, List, or Text. 

 Label - simply inserts the column name into the muscle injection table. 

 Text - allows free form typing to be entered for that column. 

 List - allows you to program a list of value choices for that column.  Once 
the List type is selected the Values section will be enabled and you can 
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enter your choices.  Simply click on the Values area and type your 
choices, the choices must be separated by a comma. 

Norm column:  If the entry is a List, you can preset the value that should be 
displayed when the muscle is initially entered into the table. 

 

Muscle List 

This section is used to setup your EMG Guidance muscle list.  The list can 
contain group headings (i.e., Hand, Forearm), muscle names, nerve names, and 
root levels. 

 

To insert a New Muscle into the list: 

At the end of the list - click on the blank entry at the bottom of the list.  Type 
in the muscle name, nerve name, and root level. 

Within the list - right click the mouse over an existing muscle name.  From 
the pop-up menu select Insert.  A new row will appear above the muscle you 
right clicked on.  Enter the muscle name, nerve name and root level. 

To insert a Group Heading into the list:  Right click the mouse over an existing 
muscle name.  From the pop-up menu select Insert Group.  A new row will 
appear above the muscle that you right clicked on.  Type the heading name in 
the muscle/group name field, leave the nerve and root fields blank.  Group 
Headings are automatically shown in bold text: 
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To change the name of an existing muscle:  Click on the muscle name you 
want to change.  Type the new name and press Enter. 

To change the order of the muscles in the list:  Changing the order of the 
muscle list requires the use of the Cut & Paste features on the right-click pop-up 
menu.  Begin by right clicking on the muscle name or group heading that you 
want to move, select Cut from the pop-up menu.  Now, right click in the list where 
you want the muscle or group heading to go and select Paste from the pop-up 
menu (the muscle or group heading will be pasted above the row you right 
clicked upon).  Repeat this process for all the muscles and group headings you 
want to move. 

To delete a muscle from the list:  Right click on the muscle you want to delete, 
then select Delete from the pop-up menu. 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
EMG Guidance test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the EMG Guidance test settings that were previously stored in a file using 
the Save Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
EMG Guidance settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the EMG Guidance test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the EMG Guidance test protocol settings. 
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SEP Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the SEP (Somatosensory Evoked Potential) test protocol in the 
test list (e.g., SEP Upper, Median SEP, or Tibial SEP).  The SEP test protocol 
settings will be displayed on the right hand side of the screen. 

 

SEP Upper Test Setup window. 

Hardware Settings 



Test Protocol Setup 

297 

Amplifier: 

 

On:  Click here to program a channel as either On or Off. 

Amp Gain:  Click here to select the default Amp Gain setting in microvolts 
per division (uV/Div).  This is also known as Live Gain and is the setting used 
when viewing the Live, un-averaged traces. 

Disp Gain:  Click here to select the default Display Gain setting in microvolts 
per division (uV/Div).  This is the setting that is used when viewing the 
averaged traces. 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected 
channel.  When common reference is On the individual reference input for the 
channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Invert:  Click and select ON to automatically invert all traces recorded from 
this channel. 

All:  Provides a quick method of changing the parameters for all the channels 
at one time. 

Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of either -1, 0, 
or +1 division.  A setting of -1 will show one division of activity before the 
stimulus. 
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Stimulator: 

 

Reverse Polarity:  The electrical stimulator polarity can be pre-programmed 
in the Normal or Reversed mode on a Side basis.  Clicking the drop down 
arrow for this parameter will list four choices, Neither, Left, Right, and 
Bilateral (both). 

 Neither - the stimulator polarity will be initialized in the Normal mode 
when either the Left or Right side is selected for the nerve being tested. 
 In the Normal mode, the right-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Left - the stimulator polarity will be initialized in the Reversed mode when 
the Left side is selected for the nerve being tested.  When the Right side 
is selected the stimulator polarity will initialize in the Normal mode.  In the 
Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED. 

 Right - the stimulator polarity will be initialized in the Reversed mode 
when the Right side is selected for the nerve being tested.  When the 
Left side is selected the stimulator polarity will initialize in the Normal 
mode.  In the Reversed mode, the left-side probe will be the Cathode (-) 
and is indicated by a green LED. 

 Bilateral - the stimulator polarity will be initialized in the Reversed mode 
when both the Left and Right side is selected for the nerve being tested. 
 In the Reversed mode, the left-side probe will be the Cathode (-) and is 
indicated by a green LED.. 

 For SEP Studies, the Cathode (-) should be positioned proximally 
with the Anode distally. 

 In the Normal mode, the electrical stimulator image on the screen 
will show the Right-side probe as the Cathode (-).  The polarity field on 
the screen will indicate Nml. 
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Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

 In the Reversed mode, the electrical stimulator image on the screen 
will show the Left-side probe as the Cathode (-).  The polarity field on the 
screen will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 To determine whether the probe is right or left, hold the stimulator 
with the Stim button facing you and the probes pointing up. 

 

Pulse Width:  Click here to set the electrical stimulus pulse width, also known 
as pulse duration, in microseconds (usec). 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 
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Averager: 

 

Averager:  Click here to set the default setting for the averager as either On 
or Off.  For evoked potentials, the averager is always On. 

Shutoff:  Click here to set the default setting for the shutoff count.  This is the 
number of responses that will be averaged together to produce the final 
results.  When the shutoff count is reached stimulation will automatically be 
stopped. 

Reject:  Click here to set the default setting for the artifact rejection feature as 
either On or Off.  When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the percentage of 
stimuli/sweeps that have been rejected from the total delivered will be 
displayed on the screen. 

Level:  Click here to set the default reject sensitivity level in percent full scale. 
 Choices are 30 to 100 % in increments of 5.   

 Reject is based on the Live un-averaged data and the Amp Gain setting. 
 Every channel has 5 divisions above and below its initial baseline.  So, if the 
Amp Gain is set to 10 uV/Div this means that the Live trace has an amplitude 
window of 100 microvolts (10 vertical divisions times 10 uv/Div) with 50 uV 
above the baseline and 50 uV below the baseline.  If the reject level is set to 
100% (i.e., full scale), then the amplitude of the live data must be below +/- 50 
uV to be included in the running average.  Should it exceed +/- 50 uV the 
trace will be rejected from the running average.  If the reject level is set to 
50% (i.e., half of full scale), then the amplitude of the Live data can't exceed 
+/- 25 uV (2.5 divisions above or below the baseline) or it will be rejected from 
the running average.  The lower the reject level setting the more sensitive the 
program will be in rejecting large artifacts. 

 

Display Settings: 

 

Side:  Click here to set the default setting for the side of stimulation.  The 
choices are Left, Right, and Bilateral.  For example, selecting Right will 
always set the initial side of stimulation to "Right" when the test protocol is 
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selected.  This setting can be changed on the acquisition screen if you want 
to begin stimulation on the opposite side. 

Split Screen:  Click here to set the default setting for how the trace window is 
displayed.  The choices are Full, Vertical and Horizontal. 

 Full - sets the trace area to full, all data from all sides are displayed in 
the same trace area. 

 Vertical - splits the trace area into two equal halves with a vertical 
divider.  Left sided traces are displayed on the left half of the trace 
window.  Right sided traces are displayed on the right half of the trace 
window. 

 Horizontal - splits the trace area into two equal halves with a 
horizontal divider.  Left sided traces are displayed in the top half of the 
trace window.  Right sided traces are displayed in the lower half of the 
trace window. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 
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Custom Key selection list. 

 

Trace Position 

 

Start Position: This is the default trace position for Channel 1 within the trace 
window.  It is the number of vertical divisions below the top of the trace 
window.  In this example, the first trace will be positioned 4 divisions below 
the top of the window. 

Trial Offset:  This setting determines how much space will separate each 
stored SEP trace from both the active (white) and other stored (purple) traces. 
 In this example the setting is 0.25 divisions, therefore the first stored SEP 
trace will be displayed 0.25 divisions below the active trace.  If a second SEP 
 trace is acquired and stored it will be displayed 0.25 divisions below the first 
stored SEP trace and so on.  If you want all the traces from each channel 
superimposed on each other set this value to 0. 

Channel Offset:  This setting only applies when more than one channel is 
turned ON.  It is the amount of space, in vertical divisions, that separates the 
Active (white) channels. 
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 Trace Position settings can be changed during data acquisition by right-
clicking the mouse on the trace window and selecting Trace Position 
Settings from the pop-up menu. 

 

Trace Labels 

This section is used to configure how the trace labels are displayed and allows 
you to choose the type of  information that is included in the trace labels.  The 
trace label can consist of up to five parameters.  The parameters can be 
separated by a colon ( ), a hyphen ( ), or a line return ( ). 

 

Display Mode:  Click here to specify how the trace labels will be displayed 
during data acquisition.  The choices are; 

 All Trials - trace labels are shown on all traces. 

 No Trials - trace labels are not shown on any traces. 

 First Trial - only the first trace/trial acquired on each side has a trace 
label. 

 Active Trial - only the active (white traces) have trace labels. 

Trace Label Selections: (up to 5 can be selected) 

 Trial - shows the trial number or the display mode of active traces (Avg or 
Live). 

 Channel - shows the amplifier channel number. 

 Side - shows the side being tested. 

 Gain - shows the display gain setting. 

 Sweep - shows the sweep speed setting. 

 Intensity - shows the stimulus intensity setting. 

 Rep Rate - shows the stimulus repetition rate. 

 Time - shows the time of day. 
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 Custom Ch - allows you to include notations that only appear for a 
specific channel or side (i.e., C4'-Fz or A1-Cz montage designations). 

Left / Right Custom Labels: 

When Custom Ch is selected for one of the five parameters the Left/Right 
Channel area becomes activated.  This allows you to enter a text label of your 
choice for each channel on a left/right basis.  This is most commonly used to 
display the amplifier montage on the channel's trace label. 

Separators: 

The parameters can be separated by a colon ( ), a hyphen ( ), or a line 
return ( ).  Simply click the mouse on the separator and select the type that 
you want from the pop-up list.  The line return can be used to put parameters 
that follow it on a second line. 

 

Show Live Monitor 

When this window is enabled it displays the “Live” activity coming from the 
recording electrodes.  When stimulation occurs, the window will briefly display a 
stimulus-triggered waveform, and then will go back to display “Live” activity after 
one second. 

 

This window can be positioned, sized, and saved as part of the default settings 
for the test protocol. 

 

Cursor Table 

This section is used to configure the cursors that will be used in the evoked 
potential test.  You can enter the name of the cursor, select its feature type 
(Peak, Trough, or Onset), set a latency search window for the cursor, and assign 
cursors to specific channels. 
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Trial Cursors: 

When this box is checked, the program will allow you to assign the cursors to 
specific channels.  This is most commonly done for SEP test protocols since 
the cursors are not all applied to the same channel.  If this boxed is 
unchecked, the channel column is hidden. 

Auto Cursors: 

Name - click here to enter a name for the cursor, up to ten characters can be 
used. 

Feature - click here to define the trace feature that the cursor will be 
searching for.   

 Choose Peak to locate the highest point within the specified latency 
window. 

 Choose Trough to locate the lowest point within the specified latency 
window. 

 Choose Onset to locate the initial change from baseline before a peak. 

Start / End - click here to enter the time, in milliseconds, that you want the 
program start and stop searching for the specified trace feature.  If the 
program does not find the feature within the start and end latency times it will 
place the cursor at the start latency position. 

Ch - click here to assign the cursor to a specific channel.  This column is only 
available if the Trial Cursors mode has been enabled. 
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Median SEP with cursors placed on one trial. 

 

Cursor Measurements 

This section is used to specify the measurements that will be displayed during 
data acquisition and in printed reports.  The Cursor Table section must be 
completed before any selections in this table can be made. 

 

Type: Click here to pick the type of measurement from a pop up list. 

 Latency - displays the time, in milliseconds, between stimulus delivery 
and the selected cursor in the Measure1 column. 
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 Amplitude - displays the amplitude, in microvolts, between the two 
selected cursors in the Measure1 and Measure2 columns.  In order to 
measure amplitude, the two selected cursors should be placed on the 
same trace. 

 Interlatency - displays the time difference, in milliseconds, between the 
two selected cursors in the Measure1 and Measure2 columns.  In order to 
measure interlatency, you must first define two latency types. 

 Interamplitude - displays either the amplitude Difference or Ratio (see 
Calc column below) between the two selected amplitude types in 
Measure1 and Measure2.  In order to measure interamplitude, you must 
first define two amplitude types. 

 None - select this option to remove the line from the cursor 
measurements. 

Measure 1 and Measure 2:  Click here to select the cursor name from a pop up 
list.  These names were defined previously in the Cursor Table section. 

Calc:  This column is only available for Interamplitude measurements. 

 Difference - the difference, in microvolts, between the two selected 
amplitude types is displayed. (Measure1 - Measure2) 

 Ratio - the result of dividing the first amplitude by the second amplitude is 
displayed. (Measure1 / Measure2) 

Norm:  Use this field to enter a normal value for the measurement.  You can use 
a less than (<) or a greater than (>) symbol.  The program will compare the 
measured value to the norm, if the measured value is outside normal limits it will 
be flagged as either bold or red colored text.  See the topic "System Setup 
Options - Preferences". 

L-R:  Use this field to enter a normal value for the left minus right difference for 
the measurement.  The program will calculate the left minus right values for each 
defined measurement if cursors have been placed on one left and one right side 
trial.  The program will compare the measured left minus right value to the norm, 
if the measured value is outside normal limits it will be flagged as either bold or 
red colored text.  See the topic "System Setup Options - Preferences". 
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Median SEP cursor table example. 

 

Age Group Norms 

Up to 8 Age Groups can be defined and normal values can be entered for 
each group.  The Sierra Wave program will compute the patient‟s age based 
on their date-of-birth and then use the appropriate age group norms. 

To define the Age Groups: 

1. Click on the Define Age Groups button. 
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2. Select the number of Age Groups, the maximum is 8. 

3. Fill in the upper age limit for each group, select years or months, 
and click OK. 

4. Check the Use Age Groups box.  This will enable the age groups 
drop-down list. 

 

6. Enter the normal values for this age group into the Cursor table. 
 Repeat for each age group in the drop-down list. 

If the patient's date-of-birth is not entered into the patient information 
window, the program will use the normal values entered for the All Ages 
group. 
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Cursor Labels 

There are three options for how the cursors will appear on the traces.  The 
factory default selection is Show Labels. 

 

 Show Labels - shows the label names as entered in the auto-cursor 
table. 

 

 Labels and Values - shows the label names mentioned above as 
well as the latency value for the cursor and the amplitude value 
between two cursors in brackets. 
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 Show Values - shows the latency value for the cursor and the 
amplitude values between two cursors in brackets. 

 

 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
SEP test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the SEP test settings that were previously stored in a file using the Save 
Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
SEP settings from that file. 
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Clicking OK will close the Test Setup window and will save any changes that 
have been made to the SEP test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the SEP test protocol settings. 

VEP Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the VEP (Visual Evoked Potential) test protocol in the test list. 
 The VEP test protocol settings will be displayed on the right hand side of the 
screen. 

 

VEP Test Setup window. 
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Hardware Settings 

Amplifier: 

 

On:  Click here to program a channel as either On or Off. 

Amp Gain:  Click here to select the default Amp Gain setting in microvolts 
per division (uV/Div).  This is also known as Live Gain and is the setting used 
when viewing the Live, un-averaged traces. 

Disp Gain:  Click here to select the default Display Gain setting in microvolts 
per division (uV/Div).  This is the setting that is used when viewing the 
averaged traces. 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected 
channel.  When common reference is On the individual reference input for the 
channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Invert:  Click and select ON to automatically invert all traces recorded from 
this channel. 

All:  Provides a quick method of changing the parameters for all the channels 
at one time. 

Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of either -1, 0, 
or +1 division.  A setting of -1 will show one division of activity before the 
stimulus. 
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Stimulator: 

 

Mode:  Click here to select the type of visual stimulus.  Choices are Checks, 
Goggles, LED, and Flash. 

 Checks - selects a reversing black & white checkerboard pattern. 
 When checks are selected as the stimulus type the following 
additional parameters are available. 

o Target - select either On or Off.  When turned On a small target 
is positioned in the center of the black & white monitor, the 
patient should focus on this target during data acquisition. 

o Checks - click here to select the number of checks displayed 
across a horizontal row.  The choices are 1, 2, 4, 8, 16, 32, 64, 
and 128. 

o Field - click in this area to select the field of stimulation.  The 
choices are Full Field, Upper Half,  Right Half, Lower Half, Left 
Half, Left Upper Quarter, Right Upper Quarter, Right Lower 
Quarter, and Left Lower Quarter. 

 Goggles - selects the LED Goggles. 

 LED - selects the 3 inch hand held LED checkerboard stimulator. 

 Flash - selects the strobe flash stimulator. 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 

 

Averager: 
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Averager:  Click here to set the default setting for the averager as either On 
or Off.  For evoked potentials, the averager is always On. 

Shutoff:  Click here to set the default setting for the shutoff count.  This is the 
number of responses that will be averaged together to produce the final 
results.  When the shutoff count is reached stimulation will automatically be 
stopped. 

Reject:  Click here to set the default setting for the artifact rejection feature as 
either On or Off.  When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the percentage of 
stimuli/sweeps that have been rejected from the total delivered will be 
displayed on the screen. 

Level:  Click here to set the default reject sensitivity level in percent full scale. 
 Choices are 30 to 100 % in increments of 5.   

 Reject is based on the Live un-averaged data and the Amp Gain setting. 
 Every channel has 5 divisions above and below its initial baseline.  So, if the 
Amp Gain is set to 10 uV/Div this means that the Live trace has an amplitude 
window of 100 microvolts (10 vertical divisions times 10 uv/Div) with 50 uV 
above the baseline and 50 uV below the baseline.  If the reject level is set to 
100% (i.e., full scale), then the amplitude of the live data must be below +/- 50 
uV to be included in the running average.  Should it exceed +/- 50 uV the 
trace will be rejected from the running average.  If the reject level is set to 
50% (i.e., half of full scale), then the amplitude of the Live data can't exceed 
+/- 25 uV (2.5 divisions above or below the baseline) or it will be rejected from 
the running average.  The lower the reject level setting the more sensitive the 
program will be in rejecting large artifacts. 

 

Display Settings: 

 

Side:  Click here to set the default setting for the side of stimulation.  The 
choices are Left, Right, and Bilateral.  For example, selecting Right will 
always set the initial side of stimulation to "Right" when the test protocol is 
selected.  This setting can be changed on the acquisition screen if you want 
to begin stimulation on the opposite side. 

Split Screen:  Click here to set the default setting for how the trace window is 
displayed.  The choices are Full, Vertical and Horizontal. 



Sierra Wave Help Manual 

316 

 Full - sets the trace area to full, all data from all sides are displayed in 
the same trace area. 

 Vertical - splits the trace area into two equal halves with a vertical 
divider.  Left sided traces are displayed on the left half of the trace 
window.  Right sided traces are displayed on the right half of the trace 
window. 

 Horizontal - splits the trace area into two equal halves with a 
horizontal divider.  Left sided traces are displayed in the top half of the 
trace window.  Right sided traces are displayed in the lower half of the 
trace window. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 
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Trace Position 

 

Start Position: This is the default trace position for Channel 1 within the trace 
window.  It is the number of vertical divisions below the top of the trace 
window.  In this example, the first trace will be positioned 15 divisions below 
the top of the window. 

Trial Offset:  This setting determines how much space will separate each 
stored VEP trace from both the active (white) and other stored (purple) traces. 
 In this example the setting is 0.25 divisions, therefore the first stored VEP 
trace will be displayed 0.25 divisions below the active trace.  If a second VEP 
 trace is acquired and stored it will be displayed 0.25 divisions below the first 
stored VEP trace and so on.  If you want all the traces from each channel 
superimposed on each other set this value to 0. 

Channel Offset:  This setting only applies when more than one channel is 
turned ON.  It is the amount of space, in vertical divisions, that separates the 
Active (white) channels. 

 Trace Position settings can be changed during data acquisition by right-
clicking the mouse on the trace window and selecting Trace Position 
Settings from the pop-up menu. 

 

Trace Labels 

This section is used to configure how the trace labels are displayed and allows 
you to choose the type of  information that is included in the trace labels.  The 
trace label can consist of up to five parameters.  The parameters can be 
separated by a colon ( ), a hyphen ( ), or a line return ( ). 

 

Display Mode:  Click here to specify how the trace labels will be displayed 
during data acquisition.  The choices are; 
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 All Trials - trace labels are shown on all traces. 

 No Trials - trace labels are not shown on any traces. 

 First Trial - only the first trace/trial acquired on each side has a trace 
label. 

 Active Trial - only the active (white traces) have trace labels. 

Trace Label Selections: (up to 5 can be selected) 

 Trial - shows the trial number or the display mode of active traces (Avg or 
Live). 

 Channel - shows the amplifier channel number. 

 Side - shows the side being tested. 

 Gain - shows the display gain setting. 

 Sweep - shows the sweep speed setting. 

 Intensity - shows the stimulus intensity setting. 

 Rep Rate - shows the stimulus repetition rate. 

 Time - shows the time of day. 

 Custom Ch - allows you to include notations that only appear for a 
specific channel or side (i.e., C4'-Fz or Oz-Cz montage designations). 

Left / Right Custom Labels: 

When Custom Ch is selected for one of the five parameters the Left/Right 
Channel area becomes activated.  This allows you to enter a text label of your 
choice for each channel on a left/right basis.  This is most commonly used to 
display the amplifier montage on the channel's trace label. 

Separators: 

The parameters can be separated by a colon ( ), a hyphen ( ), or a line 
return ( ).  Simply click the mouse on the separator and select the type that 
you want from the pop-up list.  The line return can be used to put parameters 
that follow it on a second line. 

 

Show Live Monitor 

When this window is enabled it displays the “Live” activity coming from the 
recording electrodes.  When stimulation occurs, the window will briefly display a 
stimulus-triggered waveform, and then will go back to display “Live” activity after 
one second. 
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This window can be positioned, sized, and saved as part of the default settings 
for the test protocol. 

 

Cursor Table 

This section is used to configure the cursors that will be used in the evoked 
potential test.  You can enter the name of the cursor, select its feature type 
(Peak, Trough, or Onset), set a latency search window for the cursor, and assign 
cursors to specific channels. 

 

Trial Cursors: 

When this box is checked, the program will allow you to assign the cursors to 
specific channels.  This is most commonly done for SEP test protocols since 
the cursors are not all applied to the same channel.  If this boxed is 
unchecked, the channel column is hidden. 

Auto Cursors: 

Name - click here to enter a name for the cursor, up to ten characters can be 
used. 

Feature - click here to define the trace feature that the cursor will be 
searching for.   

 Choose Peak to locate the highest point within the specified latency 
window. 

 Choose Trough to locate the lowest point within the specified latency 
window. 

 Choose Onset to locate the initial change from baseline before a peak. 

Start / End - click here to enter the time, in milliseconds, that you want the 
program start and stop searching for the specified trace feature.  If the 
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program does not find the feature within the start and end latency times it will 
place the cursor at the start latency position. 

Ch - click here to assign the cursor to a specific channel.  This column is only 
available if the Trial Cursors mode has been enabled. 

 

VEP example (right eye) with cursors placed on one trial. 

 

Cursor Measurements 

This section is used to specify the measurements that will be displayed during 
data acquisition and in printed reports.  The Cursor Table section must be 
completed before any selections in this table can be made. 

 

Type: Click here to pick the type of measurement from a pop up list. 

 Latency - displays the time, in milliseconds, between stimulus delivery 
and the selected cursor in the Measure1 column. 

 Amplitude - displays the amplitude, in microvolts, between the two 
selected cursors in the Measure1 and Measure2 columns.  In order to 
measure amplitude, the two selected cursors should be placed on the 
same trace. 

 Interlatency - displays the time difference, in milliseconds, between the 
two selected cursors in the Measure1 and Measure2 columns.  In order to 
measure interlatency, you must first define two latency types. 
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 Interamplitude - displays either the amplitude Difference or Ratio (see 
Calc column below) between the two selected amplitude types in 
Measure1 and Measure2.  In order to measure interamplitude, you must 
first define two amplitude types. 

 None - select this option to remove the line from the cursor 
measurements. 

Measure 1 and Measure 2:  Click here to select the cursor name from a pop up 
list.  These names were defined previously in the Cursor Table section. 

Calc:  This column is only available for Interamplitude measurements. 

 Difference - the difference, in microvolts, between the two selected 
amplitude types is displayed. (Measure1 - Measure2) 

 Ratio - the result of dividing the first amplitude by the second amplitude is 
displayed. (Measure1 / Measure2) 

Norm:  Use this field to enter a normal value for the measurement.  You can use 
a less than (<) or a greater than (>) symbol.  The program will compare the 
measured value to the norm, if the measured value is outside normal limits it will 
be flagged as either bold or red colored text.  See the topic "System Setup 
Options - Preferences". 

L-R:  Use this field to enter a normal value for the left minus right difference for 
the measurement.  The program will calculate the left minus right values for each 
defined measurement if cursors have been placed on one left and one right side 
trial.  The program will compare the measured left minus right value to the norm, 
if the measured value is outside normal limits it will be flagged as either bold or 
red colored text.  See the topic "System Setup Options - Preferences". 

 

 

VEP cursor table example. 

 

Age Group Norms 

Up to 8 Age Groups can be defined and normal values can be entered for 
each group.  The Sierra Wave program will compute the patient‟s age based 
on their date-of-birth and then use the appropriate age group norms. 
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To define the Age Groups: 

1. Click on the Define Age Groups button. 

 

2. Select the number of Age Groups, the maximum is 8. 

3. Fill in the upper age limit for each group, select years or months, 
and click OK. 

4. Check the Use Age Groups box.  This will enable the age groups 
drop-down list. 

 

6. Enter the normal values for this age group into the Cursor table. 
 Repeat for each age group in the drop-down list. 
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If the patient's date-of-birth is not entered into the patient information 
window, the program will use the normal values entered for the All Ages 
group. 

 

Cursor Labels 

There are three options for how the cursors will appear on the traces.  The 
factory default selection is Show Labels. 

 

 Show Labels - shows the label names as entered in the auto-cursor 
table. 

 

 Labels and Values - shows the label names mentioned above as 
well as the latency value for the cursor and the amplitude value 
between two cursors in brackets. 

 

 Show Values - shows the latency value for the cursor and the 
amplitude values between two cursors in brackets. 
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Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
VEP test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the VEP test settings that were previously stored in a file using the Save 
Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
VEP settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the VEP test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the VEP test protocol settings. 
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AEP Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the AEP (Auditory Evoked Potential) test protocol in the test 
list.  The AEP test protocol settings will be displayed on the right hand side of the 
screen. 

 

AEP Test Setup window. 

Hardware Settings 

Amplifier: 
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On:  Click here to program a channel as either On or Off. 

Amp Gain:  Click here to select the default Amp Gain setting in microvolts 
per division (uV/Div).  This is also known as Live Gain and is the setting used 
when viewing the Live, un-averaged traces. 

Disp Gain:  Click here to select the default Display Gain setting in microvolts 
per division (uV/Div).  This is the setting that is used when viewing the 
averaged traces. 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected 
channel.  When common reference is On the individual reference input for the 
channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Invert:  Click and select ON to automatically invert all traces recorded from 
this channel. 

All:  Provides a quick method of changing the parameters for all the channels 
at one time. 

Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of either -1, 0, 
or +1 division.  A setting of -1 will show one division of activity before the 
stimulus. 

 

Stimulator: 
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Mode:  Click here to select the auditory stimulus type, choose either Click, 
Tone, Pip202, or Pip212. 

 Click - this is a 100 microsecond click stimulus. 

 Tone - this is a 10-30-10 tone burst stimulus.  It has a 10 millisecond 
rise time, a 30 millisecond plateau, and a 10 millisecond fall time.  This 
stimulus is typically used for long latency auditory evoked potentials. 

 Pip 202 or Pip 212 - these are also tone stimuli but their rise, plateau, 
and fall times are measured in cycles rather than milliseconds.  The 2-
0-2 Pip has a 2 cycle rise, 0 cycle plateau, and 2 cycle fall.  The 2-1-2 
Pip has a 2 cycle rise, 1 cycle plateau, and a 2 cycle fall. 

 Frequency - when Tone, PiP202, or PiP212 are selected a Frequency 
setting will be displayed.  Click here to select the frequency of the 
tone/pip.  The choices are 250, 500, 750, 1000, 2000, 3000, 4000, 
6000, and 8000 Hz. 

 R/P/F - when Tone, Pip202, or Pip212 are selected the rise, plateau, 
and fall values are shown here.  Click here to change these values. 

 

Change the rise, plateau, and fall values for a Tone or Pip. 

 Envelope - when Tone, Pip202, or Pip212 are selected a 
stimulus envelope can be selected here.  Choices are None, 
Linear, Blackman, Hanning, and Gaussian. 

Type:  Click here to select the type of stimulus delivery hardware, choose 
either Phones or Inserts. 

 When Inserts are selected the program will automatically subtract 
1.0 milliseconds from all latency calculations to compensate for the delay 
produced by the plastic tubing.  This delay value can be modified by 
clicking on the Acoustic Delay value.  This value does not shift the 
displayed trace. 
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Polarity:  Click here to set the stimulus polarity, the choices vary depending 
on the stimulus type. 

 For Click - choose either Rarefaction, Condensation, or Alternating 
polarity. 

 For Tone or Pip -  choose either Negative, Positive, or Alternating 
polarity. 

Intensity L-R:  Click here to set the starting stimulus intensity value.  The first 
column is for the left side, the second column is for the right side. 

Threshold L-R:  Click here to set the starting behavioral threshold value. 
 The first column is for the left side, the second column is for the right side. 
 During data acquisition the Threshold values are added to the Intensity 
values to produce the stimulus at the headphones/inserts. 

Intensity Units:  Choose either nHL (normalized hearing level) or SPL 
(sound pressure level).  When SPL is selected the Threshold settings are 
disabled. 

dB Incr:  Click here to change the intensity value scale.  The default 
setting is 1 dB increments, choices are 1, 2, 5 and 10. 

Mask:  Click here to set the "white" noise masking as either On or Off and to 
set the level for the non-stimulated ear.  The amount selected is the number 
of dB's below the Intensity value.  This is known as differential masking and 
allows the intensity of the masking noise to decrease automatically as the 
intensity of the stimulus is decreased. 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  This setting only applies when delivering repetitive stimulation.  It does 
not apply during manual single stimulus delivery. 

 

Averager: 

 

Averager:  Click here to set the default setting for the averager as either On 
or Off.  For evoked potentials, the averager is always On. 

Shutoff:  Click here to set the default setting for the shutoff count.  This is the 
number of responses that will be averaged together to produce the final 
results.  When the shutoff count is reached stimulation will automatically be 
stopped. 
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Reject:  Click here to set the default setting for the artifact rejection feature as 
either On or Off.  When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the percentage of 
stimuli/sweeps that have been rejected from the total delivered will be 
displayed on the screen. 

Level:  Click here to set the default reject sensitivity level in percent full scale. 
 Choices are 30 to 100 % in increments of 5.   

 Reject is based on the Live un-averaged data and the Amp Gain setting. 
 Every channel has 5 divisions above and below its initial baseline.  So, if the 
Amp Gain is set to 10 uV/Div this means that the Live trace has an amplitude 
window of 100 microvolts (10 vertical divisions times 10 uv/Div) with 50 uV 
above the baseline and 50 uV below the baseline.  If the reject level is set to 
100% (i.e., full scale), then the amplitude of the live data must be below +/- 50 
uV to be included in the running average.  Should it exceed +/- 50 uV the 
trace will be rejected from the running average.  If the reject level is set to 
50% (i.e., half of full scale), then the amplitude of the Live data can't exceed 
+/- 25 uV (2.5 divisions above or below the baseline) or it will be rejected from 
the running average.  The lower the reject level setting the more sensitive the 
program will be in rejecting large artifacts. 

 

Display Settings: 

 

Side:  Click here to set the default setting for the side of stimulation.  The 
choices are Left, Right, and Bilateral.  For example, selecting Right will 
always set the initial side of stimulation to "Right" when the test protocol is 
selected.  This setting can be changed on the acquisition screen if you want 
to begin stimulation on the opposite side. 

Split Screen:  Click here to set the default setting for how the trace window is 
displayed.  The choices are Full, Vertical and Horizontal. 

 Full - sets the trace area to full, all data from all sides are displayed in 
the same trace area. 

 Vertical - splits the trace area into two equal halves with a vertical 
divider.  Left sided traces are displayed on the left half of the trace 
window.  Right sided traces are displayed on the right half of the trace 
window. 
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 Horizontal - splits the trace area into two equal halves with a 
horizontal divider.  Left sided traces are displayed in the top half of the 
trace window.  Right sided traces are displayed in the lower half of the 
trace window. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 

 

Trace Position 
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Start Position: This is the default trace position for Channel 1 within the trace 
window.  It is the number of vertical divisions below the top of the trace 
window.  In this example, the first trace will be positioned 4 divisions below 
the top of the window. 

Trial Offset:  This setting determines how much space will separate each 
stored AEP trace from both the active (white) and other stored (purple) traces. 
 In this example the setting is 0.25 divisions, therefore the first stored AEP 
trace will be displayed 0.25 divisions below the active trace.  If a second AEP 
 trace is acquired and stored it will be displayed 0.25 divisions below the first 
stored AEP trace and so on.  If you want all the traces from each channel 
superimposed on each other set this value to 0. 

Channel Offset:  This setting only applies when more than one channel is 
turned ON.  It is the amount of space, in vertical divisions, that separates the 
Active (white) channels. 

 Trace Position settings can be changed during data acquisition by right-
clicking the mouse on the trace window and selecting Trace Position 
Settings from the pop-up menu. 

 

Trace Labels 

This section is used to configure how the trace labels are displayed and allows 
you to choose the type of  information that is included in the trace labels.  The 
trace label can consist of up to five parameters.  The parameters can be 
separated by a colon ( ), a hyphen ( ), or a line return ( ). 

 

Display Mode:  Click here to specify how the trace labels will be displayed 
during data acquisition.  The choices are; 

 All Trials - trace labels are shown on all traces. 

 No Trials - trace labels are not shown on any traces. 

 First Trial - only the first trace/trial acquired on each side has a trace 
label. 
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 Active Trial - only the active (white traces) have trace labels. 

Trace Label Selections: (up to 5 can be selected) 

 Trial - shows the trial number or the display mode of active traces (Avg or 
Live). 

 Channel - shows the amplifier channel number. 

 Side - shows the side being tested. 

 Gain - shows the display gain setting. 

 Sweep - shows the sweep speed setting. 

 Intensity - shows the stimulus intensity setting. 

 Rep Rate - shows the stimulus repetition rate. 

 Time - shows the time of day. 

 Custom Ch - allows you to include notations that only appear for a 
specific channel or side (i.e., C4'-Fz or A1-Cz montage designations). 

Left / Right Custom Labels: 

When Custom Ch is selected for one of the five parameters the Left/Right 
Channel area becomes activated.  This allows you to enter a text label of your 
choice for each channel on a left/right basis.  This is most commonly used to 
display the amplifier montage on the channel's trace label. 

Separators: 

The parameters can be separated by a colon ( ), a hyphen ( ), or a line 
return ( ).  Simply click the mouse on the separator and select the type that 
you want from the pop-up list.  The line return can be used to put parameters 
that follow it on a second line. 

 

Show Live Monitor 

When this window is enabled it displays the “Live” activity coming from the 
recording electrodes.  When stimulation occurs, the window will briefly display a 
stimulus-triggered waveform, and then will go back to display “Live” activity after 
one second. 

 

This window can be positioned, sized, and saved as part of the default settings 
for the test protocol. 
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Cursor Table 

This section is used to configure the cursors that will be used in the evoked 
potential test.  You can enter the name of the cursor, select its feature type 
(Peak, Trough, or Onset), set a latency search window for the cursor, and assign 
cursors to specific channels. 

 

Trial Cursors: 

When this box is checked, the program will allow you to assign the cursors to 
specific channels.  This is most commonly done for SEP test protocols since 
the cursors are not all applied to the same channel.  If this boxed is 
unchecked, the channel column is hidden. 

Auto Cursors: 

Name - click here to enter a name for the cursor, up to ten characters can be 
used. 

Feature - click here to define the trace feature that the cursor will be 
searching for.   

 Choose Peak to locate the highest point within the specified latency 
window. 

 Choose Trough to locate the lowest point within the specified latency 
window. 

 Choose Onset to locate the initial change from baseline before a peak. 

Start / End - click here to enter the time, in milliseconds, that you want the 
program start and stop searching for the specified trace feature.  If the 
program does not find the feature within the start and end latency times it will 
place the cursor at the start latency position. 
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Ch - click here to assign the cursor to a specific channel.  This column is only 
available if the Trial Cursors mode has been enabled. 

 

AEP (left stimulation) with cursors placed on one trial. 

 

Cursor Measurements 

This section is used to specify the measurements that will be displayed during 
data acquisition and in printed reports.  The Cursor Table section must be 
completed before any selections in this table can be made. 

 

Type: Click here to pick the type of measurement from a pop up list. 

 Latency - displays the time, in milliseconds, between stimulus delivery 
and the selected cursor in the Measure1 column. 

 Amplitude - displays the amplitude, in microvolts, between the two 
selected cursors in the Measure1 and Measure2 columns.  In order to 
measure amplitude, the two selected cursors should be placed on the 
same trace. 
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 Interlatency - displays the time difference, in milliseconds, between the 
two selected cursors in the Measure1 and Measure2 columns.  In order to 
measure interlatency, you must first define two latency types. 

 Interamplitude - displays either the amplitude Difference or Ratio (see 
Calc column below) between the two selected amplitude types in 
Measure1 and Measure2.  In order to measure interamplitude, you must 
first define two amplitude types. 

 None - select this option to remove the line from the cursor 
measurements. 

Measure 1 and Measure 2:  Click here to select the cursor name from a pop up 
list.  These names were defined previously in the Cursor Table section. 

Calc:  This column is only available for Interamplitude measurements. 

 Difference - the difference, in microvolts, between the two selected 
amplitude types is displayed. (Measure1 - Measure2) 

 Ratio - the result of dividing the first amplitude by the second amplitude is 
displayed. (Measure1 / Measure2) 

Norm:  Use this field to enter a normal value for the measurement.  You can use 
a less than (<) or a greater than (>) symbol.  The program will compare the 
measured value to the norm, if the measured value is outside normal limits it will 
be flagged as either bold or red colored text.  See the topic "System Setup 
Options - Preferences". 

L-R:  Use this field to enter a normal value for the left minus right difference for 
the measurement.  The program will calculate the left minus right values for each 
defined measurement if cursors have been placed on one left and one right side 
trial.  The program will compare the measured left minus right value to the norm, 
if the measured value is outside normal limits it will be flagged as either bold or 
red colored text.  See the topic "System Setup Options - Preferences". 

 

 

AEP cursor table example. 
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Age Group Norms 

Up to 8 Age Groups can be defined and normal values can be entered for 
each group.  The Sierra Wave program will compute the patient‟s age based 
on their date-of-birth and then use the appropriate age group norms. 

To define the Age Groups: 

1. Click on the Define Age Groups button. 

 

2. Select the number of Age Groups, the maximum is 8. 

3. Fill in the upper age limit for each group, select years or months, 
and click OK. 

4. Check the Use Age Groups box.  This will enable the age groups 
drop-down list. 
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6. Enter the normal values for this age group into the Cursor table. 
 Repeat for each age group in the drop-down list. 

If the patient's date-of-birth is not entered into the patient information 
window, the program will use the normal values entered for the All Ages 
group. 

 

Cursor Labels 

There are three options for how the cursors will appear on the traces.  The 
factory default selection is Show Labels. 

 

 Show Labels - shows the label names as entered in the auto-cursor 
table. 

 

 Labels and Values - shows the label names mentioned above as 
well as the latency value (one decimal place precision) for the cursor 
and the amplitude value between two cursors in brackets. 
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 Show Values - shows the latency value (one decimal place 
precision) for the cursor and the amplitude values between two 
cursors in brackets. 

 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
AEP test protocol to be saved to a file. 

 

Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the AEP test settings that were previously stored in a file using the Save 
Test feature. 
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Clicking the Restore button will allow you to open a Preserve file and restore the 
AEP settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the AEP test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the AEP test protocol settings. 

P300 Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the P300 test protocol in the test list.  The P300 test protocol 
settings will be displayed on the right hand side of the screen. 

 

P300 Test Setup. 
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Hardware Settings 

Amplifier: 

 

On:  Click here to program a channel as either On or Off. 

Amp Gain:  Click here to select the default Amp Gain setting in microvolts 
per division (uV/Div).  This is also known as Live Gain and is the setting used 
when viewing the Live, un-averaged traces. 

Disp Gain:  Click here to select the default Display Gain setting in microvolts 
per division (uV/Div).  This is the setting that is used when viewing the 
averaged traces. 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 

CRef:  Click here to enable the common reference input for the selected 
channel.  When common reference is On the individual reference input for the 
channel is disabled. 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

All:  Provides a quick method of changing the parameters for all the channels 
at one time. 

Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

Delay:  Click here to select a pre or post stimulus sweep delay of either -1, 0, 
or +1 division.  A setting of -1 will show one division of activity before the 
stimulus. 
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Stimulator: 

 

Clinical recordings of the P300 are generally performed using a binaural 
auditory tone stimulus, commonly referred to as the auditory odd-ball 
paradigm.  Typically, two easily discriminable tones of different pitches are 
presented in random order.  One of the two tones occurs more often than the 
other and is designated the Common tone.  The other tone is designated the 
Rare tone.  This outline will assume that an auditory stimulus will be used for 
both the Common and Rare stimuli. 

Common Stim:  These settings are used to configure the Common stimulus. 

 Type - can be set to Audio, Visual, Electrical, or .Wav file.  Audio is 
the default setting. 

 Mode - can be set to Click, Pip 202, Pip 212, or Tone.  Tone is the 
default setting and it is a 10-30-10 tone burst.  It has a 10 millisecond 
rise time, a 30 millisecond plateau, and a 10 millisecond fall time.  

 Int - sets the intensity of the common stimulus in nHL values.  65 dB is 
the default setting. 

 Frequency - click here to select the frequency of the tone.  The default 
setting is 1000 Hz. 

 Side - can be set to Right, Left, or Bilateral.  The default setting is 
Bilateral. 

 R/P/F - when Tone, Pip202, or Pip212 are selected the rise, plateau, 
and fall values are shown here.  Click here to change these values. 
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Change the rise, plateau, and fall values for a Tone or Pip. 

 Env. - when Tone, Pip202, or Pip212 are selected a stimulus envelope 
can be selected here.  Choices are None, Linear, Blackman, Hanning, 
and Gaussian. 

 

Rare Stim:  These settings are used to configure the Rare stimulus. 

 Type - can be set to Audio, Visual, Electrical, or .Wav file.  Audio is 
the default setting. 

 Mode - can be set to Click, Pip 202, Pip 212, or Tone.  Tone is the 
default setting and it is a 10-30-10 tone burst.  It has a 10 millisecond 
rise time, a 30 millisecond plateau, and a 10 millisecond fall time.  

 Int - sets the intensity of the common stimulus in nHL values.  65 dB is 
the default setting. 

 Frequency - click here to select the frequency of the tone.  The default 
setting is 3000 Hz. 

 Side - can be set to Right, Left, or Bilateral.  The default setting is 
Bilateral. 

 R/P/F - same settings as for the Common stimulus. 

 Env. - same settings as for the Common stimulus. 

RepRate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz).  The default setting is 0.97. 

Rare %:  Click here to set the percentage of Rare stimuli that will be 
delivered.  The default setting is 20 %. 
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 Note that not all stimulus combinations are valid.  The common stimulus 
may be set to any of the available stimulus types.  The “Rare” stimulus, 
however; cannot be set to a stimulus type which conflicts with the choice of 
common stimulus.  If the common stimulus is changed after setting the rare 
stimulus and a conflict occurs, the rare stimulus will be changed so that the 
conflict is resolved.  See stimulator limitations below. 

Stimulator Limitations 

Due to hardware limitations, not all combinations of stimulus modalities 
are supported.  The video checkerboard pattern and audio tones are 
generated by the same hardware device and share the same output 
connected on the back panel.  Setting both stimuli for video checks or 
setting one stimulus for audio and one stimulus for video checks is not 
permitted.  Note, however; that two audio stimuli are supported.  It is also 
permissible to combine an audio stimulus with a visual stimulus mode 
other than video checks. 

 

Averager: 

 

Averager:  Click here to set the default setting for the averager as either On 
or Off.  For evoked potentials, the averager is always On. 

Shutoff:  Click here to set the default setting for the shutoff count, this is the 
total number of stimuli (Common + Rare) that will be delivered.  When this 
number is reached stimulation will automatically be stopped.  The default is 
200 (160 Common, 40 Rare). 

Reject:  Click here to set the default setting for the artifact rejection feature as 
either On or Off.  When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the number of 
stimuli/sweeps that have been rejected for both the Common and Rare stimuli 
will be displayed on the screen. 

Level:  Click here to set the default reject sensitivity level in percent full scale. 
 Choices are 30 to 100 % in increments of 5.   

 Reject is based on the Live un-averaged data and the Amp Gain setting. 
 Every channel has 5 divisions above and below its initial baseline.  So, if the 
Amp Gain is set to 10 uV/Div this means that the Live trace has an amplitude 
window of 100 microvolts (10 vertical divisions times 10 uv/Div) with 50 uV 
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above the baseline and 50 uV below the baseline.  If the reject level is set to 
100% (i.e., full scale), then the amplitude of the live data must be below +/- 50 
uV to be included in the running average.  Should it exceed +/- 50 uV the 
trace will be rejected from the running average.  If the reject level is set to 
50% (i.e., half of full scale), then the amplitude of the Live data can't exceed 
+/- 25 uV (2.5 divisions above or below the baseline) or it will be rejected from 
the running average.  The lower the reject level setting the more sensitive the 
program will be in rejecting large artifacts. 

 

Display Settings: 

 

Split Screen:  Click here to set the default setting for how the trace window is 
displayed.  The choices Vertical or Horizontal. 

 Vertical - splits the trace area into two equal halves with a vertical 
divider.  Traces for Common stimuli are displayed on the left half of the 
trace window.  Traces for Rare stimuli are displayed on the right half of 
the trace window. 

 Horizontal - splits the trace area into two equal halves with a 
horizontal divider.  Traces for Common stimuli are displayed in the top 
half of the trace window.  Traces for Rare stimuli are displayed in the 
lower half of the trace window. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 
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Custom Key selection list. 

Trace Position 

 

Start Position: This is the default trace position for Channel 1 within the trace 
window.  It is the number of vertical divisions below the top of the trace 
window.  In this example, the first trace will be positioned 8 divisions below 
the top of the window. 

Trial Offset:  This setting determines how much space will separate each 
stored P300 trace from both the active (white) and other stored (purple) 
traces.  In this example the setting is 0.50 divisions, therefore the first stored 
P300 trace will be displayed 0.50 divisions below the active trace.  If a second 
P300  trace is acquired and stored it will be displayed 0.50 divisions below the 
first stored P300 trace and so on.  If you want all the traces from each 
channel superimposed on each other set this value to 0. 

Channel Offset:  This setting only applies when more than one channel is 
turned ON.  It is the amount of space, in vertical divisions, that separates the 
Active (white) channels. 

 Trace Position settings can be changed during data acquisition by right-
clicking the mouse on the trace window and selecting Trace Position 
Settings from the pop-up menu. 
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Trace Labels 

This section is used to configure how the trace labels are displayed and allows 
you to choose the type of  information that is included in the trace labels.  The 
trace label can consist of up to five parameters.  The parameters can be 
separated by a colon ( ), a hyphen ( ), or a line return ( ). 

 

Display Mode:  Click here to specify how the trace labels will be displayed 
during data acquisition.  The choices are; 

 All Trials - trace labels are shown on all traces. 

 No Trials - trace labels are not shown on any traces. 

 First Trial - only the first trace/trial acquired on each side has a trace 
label. 

 Active Trial - only the active (white traces) have trace labels. 

Trace Label Selections: (up to 5 can be selected) 

 Trial - shows the trial number or the display mode of active traces (Avg or 
Live). 

 Channel - shows the amplifier channel number. 

 Side - shows the side being tested. 

 Gain - shows the display gain setting. 

 Sweep - shows the sweep speed setting. 

 Intensity - shows the stimulus intensity setting. 

 Rep Rate - shows the stimulus repetition rate. 

 Time - shows the time of day. 
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 Custom Ch - allows you to include notations that only appear for a 
specific channel or side (i.e., Fz-A1A2 or CZ-A1A2 montage 
designations). 

Left / Right Custom Labels: 

When Custom Ch is selected for one of the five parameters the Left/Right 
Channel area becomes activated.  This allows you to enter a text label of your 
choice for each channel on a left/right basis.  This is most commonly used to 
display the amplifier montage on the channel's trace label. 

Separators: 

The parameters can be separated by a colon ( ), a hyphen ( ), or a line 
return ( ).  Simply click the mouse on the separator and select the type that 
you want from the pop-up list.  The line return can be used to put parameters 
that follow it on a second line. 

 

Cursor Table 

This section is used to configure the cursors that will be used in the evoked 
potential test.  You can enter the name of the cursor, select its feature type 
(Peak, Trough, or Onset), set a latency search window for the cursor, and assign 
cursors to specific channels. 

 

Trial Cursors: 

When this box is checked, the program will allow you to assign the cursors to 
specific channels.  This is most commonly done for SEP test protocols since 
the cursors are not all applied to the same channel.  If this boxed is 
unchecked, the channel column is hidden. 
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Auto Cursors: 

Name - click here to enter a name for the cursor, up to ten characters can be 
used. 

Feature - click here to define the trace feature that the cursor will be 
searching for.   

 Choose Peak to locate the highest point within the specified latency 
window. 

 Choose Trough to locate the lowest point within the specified latency 
window. 

 Choose Onset to locate the initial change from baseline before a peak. 

Start / End - click here to enter the time, in milliseconds, that you want the 
program start and stop searching for the specified trace feature.  If the 
program does not find the feature within the start and end latency times it will 
place the cursor at the start latency position. 

Ch - click here to assign the cursor to a specific channel.  This column is only 
available if the Trial Cursors mode has been enabled. 

 

P300 with cursors placed on the grand average of two trials. 

 

Cursor Measurements 

This section is used to specify the measurements that will be displayed during 
data acquisition and in printed reports.  The Cursor Table section must be 
completed before any selections in this table can be made. 
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Type: Click here to pick the type of measurement from a pop up list. 

 Latency - displays the time, in milliseconds, between stimulus delivery 
and the selected cursor in the Measure1 column. 

 Amplitude - displays the amplitude, in microvolts, between the two 
selected cursors in the Measure1 and Measure2 columns.  In order to 
measure amplitude, the two selected cursors should be placed on the 
same trace. 

 Interlatency - displays the time difference, in milliseconds, between the 
two selected cursors in the Measure1 and Measure2 columns.  In order to 
measure interlatency, you must first define two latency types. 

 Interamplitude - displays either the amplitude Difference or Ratio (see 
Calc column below) between the two selected amplitude types in 
Measure1 and Measure2.  In order to measure interamplitude, you must 
first define two amplitude types. 

 None - select this option to remove the line from the cursor 
measurements. 

Measure 1 and Measure 2:  Click here to select the cursor name from a pop up 
list.  These names were defined previously in the Cursor Table section. 

Calc:  This column is only available for Interamplitude measurements. 

 Difference - the difference, in microvolts, between the two selected 
amplitude types is displayed. (Measure1 - Measure2) 

 Ratio - the result of dividing the first amplitude by the second amplitude is 
displayed. (Measure1 / Measure2) 

Norm:  Use this field to enter a normal value for the measurement.  You can use 
a less than (<) or a greater than (>) symbol.  The program will compare the 
measured value to the norm, if the measured value is outside normal limits it will 
be flagged as either bold or red colored text.  See the topic "System Setup 
Options - Preferences". 

L-R:  these fields are not used for P300. 
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P300 Cursor Table. 

 

Cursor Labels 

There are three options for how the cursors will appear on the traces.  The 
factory default selection is Show Labels. 

 

 Show Labels - shows the label names as entered in the auto-cursor 
table. 

 

 Labels and Values - shows the label names mentioned above as 
well as the latency value (one decimal place precision) for the cursor 
and the amplitude value between two cursors in brackets. 
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 Show Values - shows the latency value (one decimal place 
precision) for the cursor and the amplitude values between two 
cursors in brackets. 

 

 

Window Buttons 

  

Clicking the Print Screen button will send an image of the screen to your default 
printer. 

 

Clicking the Save Test button will open the Save Test window.  This allows the 
P300 test protocol to be saved to a file. 
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Clicking the Load Test button will open the Load Test window.  Use this feature 
to load the P300 test settings that were previously stored in a file using the Save 
Test feature. 

 

Clicking the Restore button will allow you to open a Preserve file and restore the 
P300 settings from that file. 

 

Clicking OK will close the Test Setup window and will save any changes that 
have been made to the P300 test protocol settings. 

 

Clicking Cancel will close the Test Setup window and will not save any 
changes that have been made to the P300 test protocol settings. 
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RR Interval Setup 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the RR Interval test protocol in the test list.  The RR Interval 
test protocol settings will be displayed on the right hand side of the screen. 

 

RR Interval Test Setup window. 

Amplifier Settings 

 

Gain:  Click here to select the default Gain setting in microvolts per division 
(uV/Div). 

Notch:  Click here to enable the 50 or 60 Hertz notch filter. 

Hicut:  Click here to select the default Hicut filter setting in Hertz (Hz). 

Locut:  Click here to select the default Locut filter setting in Hertz (Hz) 
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Sweep: Click here to select the default sweep speed setting in milliseconds 
per division (ms/Div). 

 RR Interval is a single channel protocol. 

 

Custom Keys 

The Custom Key settings are used to program the functions of the two 
programmable buttons on the electrical stimulator and the footswitch. 

 

Click on the setting you want to change and a pop-up list of available choices will 
be displayed.  Simply select the function that you want from the list. 

 

Custom Key selection list. 

 

RR Interval Run Table 

This section is used to program the data collection runs that will be used during 
the test procedure. 
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Run #:  up to five different data collection runs can be programmed. 

Label:  this is a label that describes the run, it appears in the RR Results 
Table and the RR Datapoints Graph. 

Duration (min):  specifies how long (in minutes) the run will collect RR 
data. 

Events:  use to pre-program events that can be entered during data 
collection .  Individual events are separated by commas. 

 

RR Interval 

This check box will convert the collected RR Interval data (milliseconds) to Heart 
Rate data (beats per minute).  The Heart Rate (bpm) will be displayed in the RR 
Tables and RR Datapoint Graphs. 

 

 

RR Interval Datapoints Graph (Y-axis) 

This section is used to set the default limits for the RR Datapoint Graph Y-axis. 
 These values can be changed at any time during or after data collection from 
within the RR Datapoints Graph. 

 

 These values are automatically converted to Heart Rate (bpm) if the 
preceding RR Interval check box is enabled. 
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Saving Test Setups 

This feature allows the user to save a selected test protocol's settings to a file. 
 This file can be given to other Sierra Wave users so that they can load the saved 
test protocol onto their own system. 

 

Clicking the Save Test button will open the Save Test window. 

 

Save Test window. 

 

To Save a Test Protocol to a file: 

1. From within the Test Menu Editor window, highlight the test protocol that 
you want to save. 

2. Click on the Save Test button.  The Save As window will be displayed. 

3. If necessary, change the Save In path to the location where you want to 
save the file. 
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4. If necessary, change the File Name.  The name will default to the name of 
the test protocol that is highlighted in the Test Menu Editor. 

5. Click the Save button. 

 

To Load a Test Protocol from a file: 

See the topic Loading Test Setups. 

Loading Test Setups 

This feature allows the user to load a test protocol's settings from a file that was 
created using the Save Test feature. 

 

Clicking the Load Test button will open the Load Test window. 

 

Load Test window. 
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To Load a Test Protocol from a file: 

1. From within the Test Menu Editor window click on the Load Test button. 

2. The Open window will be displayed. 

3. If necessary, change the Look In path to the location of the test setting 
file. 

4. Select the test setting file. 

5. Click the Open button. 

 

Tests that are loaded from a file are added to the bottom of the 
existing Test Menu list.  They do not overwrite existing test protocols.  If the 
name of the test being loaded matches a test protocol already in the Test 
Menu, it will be added to the bottom of the list with the number "2" after its 
name. 

Restoring a Test Setup from a Preserve File 

This feature allows you to load an individual  test protocol's settings from a 
preserve file.  For information about creating a preserve file, see the topic 
Preserve Settings. 

 

Clicking the Restore button will allow you to open a Preserve file and load the 
currently selected test protocol's settings from that file. 
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Restore selected test protocol. 

 

To restore the selected test protocol's settings from a preserve file: 

1. In the Test Menu Editor, highlight a test in the Test List. 

2. Click on the Restore button. 

3. The Open window will be displayed. 

4. If necessary, change the Look In path to the location of the preserve file. 

5. Select the preserve file. 

6. Click the Open button. 

If no matching test protocol name is found within the preserve file the 
program will notify the user and will then terminate the restore process. 

Changing Test Setup during an Exam 

While performing an exam, if you make changes to the test protocol's parameters 
(i.e., Gain, Screen Layout, etc.) and want to save these changes as the new 
default settings for the test protocol, follow these steps. 
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 Click on the Edit menu 

 Select Save Test Parameters 

Changing the Test Layout 

Four main windows compose the Sierra Wave screen, they are the Trace, 
Study, Amplifier & Stimulator Controls, and Measurements / Cursor Table 
windows. 

The Size and Position of these windows can be changed and saved on a per 
test protocol basis. 

 The Amplifier & Stimulator controls can be configured in either a window or 
toolbar format.  This preference can be saved on a per test protocol basis.  In 
software version 5.5 or higher, the default format is the Controls Toolbar enabled. 
 To turn the Controls Toolbar On or Off, select the option called "Test Control 
Bar" from the View menu. 

 

To change the Size of a Window: 

Move the mouse cursor until it is over the edge or corner of the window you 
want to resize.  The cursor should turn into a double-headed arrow.  Click 
the left mouse button and hold it down while you move the mouse, as the 
mouse moves the size of the window will change.  Release the left mouse 
button when you have reached the size that you like. 

 

Study window with double-headed arrow in lower right corner. 
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To change the Position of a Window: 

Move the mouse cursor over the Title Bar of the window you want to move.  Click 
the left mouse button and hold it down while you move the mouse.  The window 
will move with the mouse.  When you reach the new position for the window 
release the left mouse button. 

Repeat this for all the windows that you want to move. 

 

Mouse cursor over the Study window's Title Bar. 

 

To Save the Test Protocol's  Layout: 

After changing the Size and Position of the windows. 

 Click on the Edit menu 

 Select Save Test Parameters 

 The EMG test protocol has separate layouts for Live mode, Capture mode, 
and IPA mode.  This also includes the Trace window's grid selection.  When 
saving the layout of the EMG test protocol, first select Save Test Parameters 
while in Live acquisition mode, then switch to Capture mode and select Save 
Test Parameters a second time to save the Capture layout, and finally switch to 
IPA mode and select Save Test Parameters a third time to save the IPA layout. 

 Capture mode layout also includes SMUA. 
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Study Menu Setup 

Study Menu Setup Window 

From the Edit menu, select Study Menu to display the Study Menu Setup 
window.  From this window you can create new study lists or modify existing 
study lists. 

A Study List is simply a predefined list of test protocols.  It is typically organized 
with the individual tests ordered in the sequence they are usually performed on 
the patient. 

The Sierra Wave comes with several default studies that are ready to use or can 
be modified to suit your testing needs. 

The left side of this window, labeled Study Menu, shows the existing Study Lists 
that are on the instrument.  The right side of the window, labeled Test Menu, 
shows the available Test Procotols. 

To expand a Study List and see what test protocols it contains, click on the plus 
sign (+) in front of the study name.  To contract a Study List, click on the minus 
sign (-). 

Those test protocols which have an associated muscle or nerve list also have 
plus signs (+) in front of their names.  Click on these plus signs to view the 
muscle or nerve list for that test protocol. 
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Study Menu Setup window with Right Carpal Tunnel Study expanded. 

Creating a New Study 

To Create a New Study List 

1. Right click the mouse in the Study Menu side of the window. 

2. Select Insert Study from the pop-up menu. 
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Right click in Study Menu area to get pop-up menu. 

3. Type the name for the new study and press Enter. 

4. Using the left mouse, click and drag the desired Test Protocol from the 
Test Menu side of the window over to the Study Menu side of the 
window.  Drop the Test Protocol onto the name of the new study.  The 
Test Protocol will then appear underneath the name of the study. 

 

Result of dragging over Tibial SEP test and dropping it on My New Study. 

5. Click and drag over another Test Protocol.  A black line (see picture 
below) will appear which indicates where the second test will be placed 
when the mouse button is released. 
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Black line indicates where second test (Peroneal SEP) will be inserted. 

6. Continue to select and drag over test protocols until the Study is 
complete. 

 

Working with Test Protocols that have a muscle or nerve list: 

To view the associated nerve or muscle list for a test protocol, expand the 
protocol by clicking on the plus sign (+) in front of its name. 
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NCV test protocol expanded to show Upper Motor nerve list. 

 

Using the Side parameter: 

 

When you select a nerve or muscle from the Test Menu the Side field at the 
bottom of the window becomes activated.  This allows you to select the side 
parameter for the particular nerve or muscle. 

For example, if you want to add the Right Median Motor nerve to a study, first 
click on the Median Motor test to select it, then make sure the Side field is set 
to Right.  Now go ahead and drag the test over to the Study List. 

The Side field can be used with NCV, EMG, EMG Guidance, F Wave, H 
Reflex, RNS, SFEMG, SSFEMG, Real Time SFEMG, and MUNE test 
protocols since all these tests have either a nerve or muscle list. 

 

Using the  button: 

If you make a mistake and drag over a test with the wrong side selected, simply 
highlight the test in the Study Menu and then click the Swap Side button.  The 
side of that test will be reversed. 
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Window Buttons 

 

Click the OK button to close the Study Menu Editor window and save all your 
changes. 

 

Click the Cancel button to close the Study Menu Editor window without saving 
any changes that were made. 

Changing an Existing Study 

To change or modify and existing Study List 

Click the (+) sign in front of the Study to be changed.  This will expand the Study 
and show the Test Protocols contained within it. 

 

To Delete a Test from the Study: 

Right click on the Test Protocol you want to remove from the Study, select 
Delete from the pop-up menu. 
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To Add a Test to the Study: 

Click and drag (using the left mouse button) a Test Protocol from the Test Menu 
side of the window over to the Study Menu side of the window.  A black bar will 
appear which indicates where the new Test Protocol will be placed when the 
mouse is released. 

 

The black bar shows where the Radial Anti Sensory test 
protocol will be placed when the left mouse button is released. 

To Swap Sides of a Test: 

Select the Test Protocol in the Study that needs to be changed.  Now, click the 
Swap Sides button at the bottom of the window.  The Side parameter for the 
Test Protocol will be reversed, from Left to Right or Right to Left. 

 

 

To Change the Order of the Tests in the Study: 

Select the Test Protocol in the Study that you want to move.  Click and drag 
(using the left mouse button) the Test Protocol up or down within the Study.  A 
black bar will appear to indicate where the Test Protocol will be placed when the 
mouse is released. 

 

To Rename a Study: 

Right click over the name of the Study.  From the pop-up menu select Rename. 
 Type the new name for the Study and press Enter. 
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Right click on a Study and select Rename. 

Window Buttons 

 

Click the OK button to close the Study Menu Editor window and save all your 
changes. 

 

Click the Cancel button to close the Study Menu Editor window without saving 
any changes that were made. 

Assigning DataLAB Formulas to a Study 

To Assign a DataLAB Formula to a Study: 

1.  From the Edit menu, select Study Menu to display the Study Menu 
Setup window. 

2.  Right click over the name of the Study and select DataLAB Setup from 
the pop-up menu.  The DataLAB Setup window will be displayed. 
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3.  Place a check mark next to the formulas you want to appear in the 
DataLAB window when using this Study. 
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DatLAB Setup window. 

4.  Click OK. 

To Display the contents of a Formula: 

1.  Click on the formula to highlight it. 

2.  Click on the Display Formula button. 

3.  The actual formula specified in the FormulaList.xml file will be displayed. 

 

Display Formula window. 
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Setting the default AnatomyVIEW for a Study 

To Assign the default AnatomyVIEW for a Study: 

1.  From the Edit menu, select Study Menu to display the Study Menu 
Setup window. 

2.  Right click over the name of the Study and select AnatomyVIEW Setup 
from the pop-up menu.  The AnatomyVIEW Setup window will be 
displayed. 

 

 

3.  Select the default view and then click the OK button. 
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Menus 

File Menu 

Wave Program Menus 

 

 

Pressing the ALT key on the PC keyboard or the Select key on the Wave 
base unit configures the base unit knobs to allow selection from the program 
menus.  Knob 1 moves up/down through the selected menu, Knob 2 moves 
across the menus, and the F4 function key closes the menus and returns the 
knobs to their original state. 

 

Menu controls. 
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File Menu: 

 

 New Exam – Opens the Patient Information window, after entering Last 
Name and First Name testing can begin. 

 Resume Exam – Opens the Resume Exam window. Use this feature to 
open an existing patient file and add more test data to it. 

 Review Exam – Opens the Review Exam window.  Use this feature to 
review a completed patient test. 

 Close Exam - Closes the current Patient's Exam and saves all data to 
their file.  This function is only listed in the menu after starting an exam. 

 Review Report - Opens the Review Report window.  Use this feature to 
review stored report documents. 

 Enter Patient Info – Opens the Patient Information window.  Use this 
feature to pre-enter and save patient information for use at a later time. 
 This feature is only listed in the menu prior to starting an exam. 

 Launch QuickReport & Select Template - Starts the QuickReport 
program and allows selection of a report template.  This feature is only 
listed in the menu after starting an exam. 

 Print Current Test Report - Starts the QuickReport program and uses 
the report template assigned to the Print key on the base unit.  In this 
example, the report template is called "Current Test".  This feature is only 
listed in the menu after starting an exam. 
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 Print TabData w/Traces Report - Starts the QuickReport program and 
uses the report template assigned to the Report key on the base unit.  In 
this example, the report template is called "TabData w/Traces".  This 
feature is only listed in the menu after starting an exam. 

 Print Screen - Sends an image of the current screen to the default printer. 
 This feature is only listed in the menu after starting an exam. 

 Preserve – Copies all test parameters, study lists and report templates to 
a user defined location and filename. 

 Restore 

o Restore All – Restores all test parameters, study lists and report 
templates from a preserve file. 

o Restore Selected – Opens the Sierra Restore Utility and allows 
selected test protocols, study lists or report templates to be 
restored from a preserve file. 

 Archiving – Opens the Archive Window.  Which provides a convenient 
way to copy patient data files and stored reports to selected archive 
media. 

 List of last 4 studies opened. 

 Exit – Closes the Sierra Wave program. 

 

Edit Menu 

Edit Menu: 

 

 Study Menu – Opens the Study Menu Setup window.  Use this feature to 
modify and/or create customized Study Lists. 

 Test Menu – Opens the Test Menu Setup window.  Use this feature to 
change default test protocol, parameter settings as well as Nerve and 
Muscle Lists. 

 System Setup – Opens the System Setup window.  Use this feature to 
select Directories, Assign Study and Report Keys, set Archive 



Menus 

377 

Destinations, Modify Report Header and create Custom Patient 
Information fields. 

 Network Setup - Opens the Network Setup window.  Use this feature to 
enable Automatic Copy of the patient's exam to a network location and to 
enabled Automatic Synchronization of test settings from a preserve file at 
program launch. 

 Patient Information – Opens the Patient Information window.  Use this 
feature to modify or add to patient info after starting exam. 

 Save Test Parameters - Use this function to save any changes that were 
made to the test protocol settings and make them the new default settings 
for the test.  This feature is only listed in the menu after starting an exam. 

 Current Test - Use this function to open the Test Menu Editor window for 
the current test protocol.  This feature is only listed in the menu after 
starting an exam. 

 

View Menu 

View Menu: 

 

 Status Bar – Not used by the Wave program at this time. 

 PC Function Key Menu – Enables the F5-F12 Function Key toolbar.  This 
is shown at the bottom of the screen and displays additional functions that 
can be utilized in the test protocol.  For example, F5 is used to select 
Cursor Mode with allows positioning of cursors using the knobs on the 
base unit. 

 

PC Function Key toolbar. 



Sierra Wave Help Manual 

378 

Even when the PC Function Key toolbar is disabled (unchecked) you 
can still use F5 and F6 to select the Cursor and Position functions 
respectively. 

 Test Control Bar - This setting determines how the Amplifier & Stimulator 
controls are displayed.  If this option is enabled, the controls are displayed 
in a toolbar rather than a window format. 

 

Controls Toolbar for the NCV test protocol. 

 AnatomyVIEW Window - Opens the AnatomyVIEW window.  This 
window displays the EMG muscle scoring data on a 3D color-coded 
anatomical model.  Selecting this is the same as clicking on the 
AnatomyVIEW toolbar button. 

 

 DataLAB Window - Opens the DataLAB widnow.  This window is used to 
display the results of custom formulas, such as the Robinson Index. 

 TabData - Opens the TabData Summary window.  This window is a 
convenient way to review all the tests that have been performed on the 
patient.  It also displays summary tables for NCV nerve types.  This 
function is only listed in the menu after starting an exam. 

 Calibration Signal - Enables the built-in calibration signal.  For more 
information see the topic Calibration Signal in the Utilities chapter. 

 Cursor Mode F5 - Selecting this is the same as pressing the F5 function 
key. 

 Position Mode F6 - Selecting this is the same as pressing the F6 function 
key. 

 Trace History - Opens the Trace History window.  This window shows the 
last 30 traces acquired for each stimulus site in the NCV test protocol. 
 This window can also be opened by clicking on the Trace History Icon in 
the toolbar. 

 

Trace History Icon. 
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Study/Test Menu 

Study / Test Menu: 

 

 The upper section lists the Studies available.  Studies are comprised of 
individual Test Protocols generally arranged in the order they will be 
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performed on the patient.  For example Right Carpal Tunnel Study 
includes the following tests. 

o Right Median Motor 

o Right Ulnar Motor 

o Right Median Anti Sensory 

o Right Ulnar Anti Sensory 

o Etc… 

o The lower section lists the individual Test Protocols available. 

Analysis Menu 

Analysis Menu: 

 

This menu is only available when the EMG test protocol is selected. 

 Multi-Motor Unit Analysis - when selected, this will enable the multi-
motor unit analysis mode which is utilized on live or stored EMG buffers. 

 Analysis Off - turns off the Interference Pattern Analysis and Single Motor 
Unit Analysis modes.  To turn off Multi-Motor Unit Analysis, click on the 
Multi-Motor Unit Analysis entry a second time. 

 Interference Pattern Analysis - when selected, this will enable the 
interference pattern analysis mode and display the three available IP 
"cloud plots". 

 Single Motor Unit Analysis - when selected, this will enable the single 
motor unit analysis mode and display the MUA table. 

 Store SMUA Capture Traces - when selected, this will cause the 
program to automatically store the individual captured traces as well as 
the averaged MUP trace when the Store key is pressed. 

 Play Stored Buffer in Capture Mode - when selected, this feature allows 
previously stored Live EMG Buffers to be played back in EMG Capture 
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mode.  This feature is disabled if the currently selected muscle in the 
Study window does not have any associated stored EMG Buffers. 

Help Menu 

Help Menu: 

 

 Help Topics – This opens the Sierra Wave Help File. 

 NCV Setups - A shortcut to the NCV Setup Guides in the Reference 
Chapter. 

 F/H Setups - A shortcut to the F/H Setup Guides in the Reference 
Chapter. 

 EP Setups - A shortcut to the Evoked Potential Setup Guides in the 
Reference Chapter. 

 Muscle Index - A shortcut to the list of Muscles in the Reference Chapter. 

 About Sierra – This contains information regarding the current software 
version and the current versions of other components installed in the 
Sierra Wave Base Unit. 





 

383 

Protocols 

EMG 

EMG Basics 

This topic is a repeat of the basic EMG steps found in the Getting Started 
chapter. 

Select the EMG  Test:   

 If a Study has already been selected, simply click on an EMG muscle 
name (i.e., Right Deltoid) within the Study window or turn Knob #1 (Study 
Item / Site) to highlight the muscle name.  Notice that as soon as any 
muscle is selected within the EMG test protocol, all the muscles are 
automatically added to the muscle score table. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual EMG test protocol from the Study/Test menu, a 
muscle list will be displayed allowing you to pick the muscle or muscles 
that you will be testing on the patient.  Notice that as soon as any muscle 
is selected, it is displayed within the Study window and is automatically 
added to the muscle score table. 

 The Automatic Muscle Scoring feature can be disabled in the EMG 
Test Setup window.  When this feature is disabled the muscles in the Study 
window are not automatically added to the muscle score table.   You will need 
to use the F2 (Muscle Sel/Score) knob or the Left mouse button to 
manually add the appropriate muscles to the scoring table. 

Once the muscle has been selected.  Follow these steps for performing 
routine EMG data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate. 

Typical Settings for EMG 

Gain = 100 or 200 uV/Div 

Hicut = 10k Hz 

Locut = 10 - 30 Hz 

Sweep Speed = 10.0 ms/Div 
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2.  Verify the Side 

Make sure the appropriate side, Right or Left, is selected. 

3.  Insert the Needle Electrode 

4.  Adjust Volume 

Increase or decrease the Sierra Wave's internal speaker by using the Volume 
Knob on the left hand side of the base unit. 

5.  Select Live or Capture Acquisition Mode 

Use the F1 (Live / Capture) function key to toggle between these two 
acquisition modes. 

Live Mode:  In Live mode free-running EMG is displayed in the Trace window 
and a compressed view of the EMG Live Buffer is displayed below this.  A 
moving blue marker shows the current position within the buffer.  At any time 
data acquisition can be stopped and the data in the Live Buffer can be 
reviewed or played back (see step #7 below).  The EMG protocol always 
defaults to the Live data acquisition mode. 

 

EMG - Live mode 
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Live Mode with Raster Display:  An optional Raster Display can be enabled 
by pressing the F11 (Raster) function key.  When this feature is enabled the 
Trace window is split into two equal sections; the left half showing the live 
EMG data and the compressed buffer, the right half showing consecutively 
rastered EMG traces.  Click here for more information on the Raster Display 
option. 

 

Live EMG mode with Raster Display enabled. 

Capture Mode:  In Capture mode a voltage level trigger and delay marker 
are displayed within the Trace window.  The level of the voltage trigger can be 
adjusted using Knob #3 (Trigger Lvl).  When EMG activity exceeds the 
trigger level (in either the negative or positive direction) the sweep is captured 
momentarily and is repositioned with the crossing point at the delay marker. 
 This allows for easier visualization of motor unit potentials.  At any time data 
acquisition can be stopped and up to 50 captured sweeps can be reviewed 
(see step #7 below). 
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EMG - Capture mode 

Capture Mode with Capture Window:  An optional Capture Window can be 
enabled by pressing the F11 (Cap Wnd) function key.  When this feature is 
enabled the trace window is split into two sections; the top section shows the 
live EMG trace and the trigger level and delay indicator, the bottom section 
shows a rastered display of the most recently captured traces.  Click here for 
more information on the Capture Window option. 
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Capture Mode with Capture Window enabled. 

6.  Adjust Gain & Sweep 

During EMG data acquisition you can easily adjust the Gain and Sweep 
Speed by using Knob #4 (Gain / Sweep) on the Sierra Wave base unit. 
 Simply turn the knob to adjust the gain, to change the sweep speed, press 
the knob first to toggle it to the sweep mode, then turn to change the sweep 
speed. 

You can also use the mouse to change these settings in the EMG Controls 
window or Controls Toolbar. 

7.  Stop Data Acquisition and Review (optional) 

To stop data acquisition perform one of the following actions; 

 Press the Run/Stop key on the Sierra Wave base unit. 

 Press the Stim button on the Electrical Stimulator handle. 
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 Press the Footswitch pedal. 

 Click on the Stop button in the EMG Controls window. 

Stopped Live EMG: 

Review the Live Buffer - move backwards and forwards in the Live 
EMG buffer by turning Knob #1 (Review / Play-Stop), press the knob to 
replay the buffer.  You can also review by dragging the blue marker back 
and forth within the compressed buffer area using the mouse. 

 

EMG - Stopped Live mode 

Store a Snapshot - press the F1 (Store Snap Shot) function key or the 
Store key on the Sierra Wave base unit to store the currently displayed 
sweep.  The stored sweep will be displayed in purple. 

Store the entire Live Buffer - press the F2 (Store Live Buffer) function 
key.  The trace will be displayed in blue indicating that the entire buffer 
has been stored. 

Manual MUP Tool - right click the mouse over the motor unit potential 
(MUP) of interest, then select MUP Tool from the pop-up menu.  The 
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motor unit potential is shown centered within a MUP window and 
quantitative measurements are shown in the table below.  Click OK to 
save the MUP and include it in the final report, click Cancel to discard 
the MUP. 

Stopped Capture EMG: 

Review Captured Sweeps -  use Knob #4 (Trace Sel /Delete) to 
review through the captured traces, press the knob to delete the 
selected trace (selected trace is displayed in yellow color).  Press the F2 
(Raster / Overlay) function key to superimpose all the captured traces. 

 

EMG - Stopped Capture mode 

Store Captured Sweeps - press the Store key on the Sierra Wave 
base unit or click on the Store button within the EMG Controls window. 
 The stored traces will be displayed in purple. 

 Prior to storing any EMG traces, Use Knob #2 (Muscle Sel) to 
highlight the correct muscle name in the Study window.  This will ensure 
that the EMG data will be stored with the correct muscle name. 
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 As EMG is stored, you will see a new node appear in the Study 
window below the muscle name.  This indicates what has been stored for 
this muscle.  The example below shows a Snapshot stored for the Right 
Abd Poll Brev muscle, a Capture run stored for the Right ABD Dig Min 
muscle, and a Live Buffer stored for the Right ExtDigCom muscle. 

 

Example of stored EMG nodes in the Study window. 

 

8.  Return to Data Acquisition Mode 

If you stopped either Live or Captured data acquisition, perform one of the 
following actions to resume data acquisition; 

 Press the Run/Stop key on the Sierra Wave base unit. 

 Press the Stim button on Electrical Stimulator handle. 

 Click the Run button in the EMG Controls window. 

9.  Modify Muscle Scoring 

With the Automatic Muscle Scoring feature enabled, as soon as a muscle is 
selected in the Study window, or added to the Study window using the F3 
(Muscle List) function key, it is automatically added to the Muscle Scoring 
Table and is scored as normal. 

To change the muscle scoring for a muscle: 

 Turn Knob #3 (Score Table / Modify) until the highlight is over the 
scoring field that you want to change, press the knob to pop up a list of 
choices, turn the knob to highlight one of the choices and press again 
to select it. 

 Using the left mouse button, click on the scoring field that you want to 
change.  From the pop up list of choices click again to make a 
selection. 
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Muscle Scoring Table 

 Depending on your preferences in System Setup, abnormal values 
can be flagged with a red background color, as bold text, as bold text with 
an asterisk, or as bold text & background color red. 

10.  Select Next Muscle 

Turn Knob #2 (Muscle Sel / Delete Score) to highlight the next muscle in the 
Study window.  If the muscle you want to examine is not displayed within the 
Study window, press F3 (Muscle List) and select the muscle from the list. 

Move the Needle Electrode to the new muscle and repeat the above steps as 
necessary. 

 It is a good idea to turn Off the preamplifier or turn down the Volume 
when moving the needle electrode to a new location. 

11.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected tests traces 
and cursor information will be displayed on the right hand side of the window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 
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To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

12.  Next Test 

 Use Knob #1 (Study Item) to highlight another Test Protocol in the 
Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

 

 

Knob & Fkey Controls (EMG) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in Live vs. Capture acquisition 
mode and on whether the EMG is running or stopped.  The functions will also 
change when either the Cursor or Position modes are enabled. 

 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 
 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 

 

Live EMG Acquisition Mode: 

Live EMG 

(Knobs) 

 

Study Item - turn this knob to highlight and load a different Test 
Protocol in the Study window. 

Muscle Sel / Delete Score - turn this knob to highlight a different 
muscle name within the EMG test protocol in the Study window.  If the 
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muscle has been scored you can press the knob to remove it from the 
Muscle Scoring Table. 

ScoreTable / Modify - turn this knob to move the highlight within the 
Muscle Scoring Table window.  Press this knob to change the scoring 
choice for a muscle, for example to change Fibs from Nml to +3. 

Gain / Sweep - this knob defaults to the Gain mode and can be used 
to increase or decrease the gain (uV/Div) of the EMG trace.  Press the 
knob to switch to Sweep mode and turn to adjust the sweep speed 
(ms/Div) of the EMG trace. 

The Gain and Sweep will automatically reset to default values 
when a new muscle is selected in the Study window. 

(F Keys) 

 

Live / Capture - press this function key to switch back and forth 
between Live or Capture acquisition modes. 

Fibs / Recrt - press this function key to switch back and forth between 
Fibs and Recrt parameter settings.  You can program different Gain 
and Sweep Speed parameters for these two modes and use this 
function key to easily toggle between the two. 

This function key will automatically reset to the Fibs mode 
when a new muscle is selected in the Study window. 

Muscle List - opens the EMG Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData summary window. 

 

Live EMG - Data Acquisition Stopped 

(Knobs) 

 

Review / Play-Stop - turn this knob to move backward and forward 
within the EMG buffer.  Press the knob to start & stop playback of the 
EMG buffer. 
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Muscle Sel / Delete Score - turn this knob to highlight a different 
muscle name within the EMG test protocol in the Study window.  If the 
muscle has been scored you can press the knob to remove it from the 
Muscle Scoring Table. 

Score Table Modify - turn this knob to move the highlight within the 
Muscle Scoring Table window.  Press this knob to change the scoring 
choice for a muscle, for example to change Fibs from Nml to +3. 

Gain / Sweep - turn the knob to change the gain of the EMG trace. 
 Press the knob, then turn to change the sweep speed of the EMG 
trace. 

(F Keys) 

 

Store Snap Shot - press this function key to store the currently 
displayed EMG trace. 

Store Live Buffer - press this function key to store the entire EMG 
buffer. 

Muscle List - opens the EMG Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData Summary window. 

 

Cursor mode (F5) 

(Knobs) 

 

Lat 1 / Lat 2 - turn this knob to move latency marker number one. 
 Press this knob, then turn to move latency marker number two.  The 
latency values are displayed at the top left of the Trace window. 

Amp 1 / Amp 2 - turn this knob to move amplitude marker number 
one.  Press this knob, then turn to move amplitude marker number two. 
 The amplitude value is displayed at the top left of the Trace window. 

Sel. Trial - turn this knob to select a stored snapshot trace.  When 
selected, the trace will be displayed in yellow. 
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Gain - turn this knob to change the gain of the selected snapshot 
trace. 

(F Keys) 

 

Raster / Overlay - press this function key to toggle between displaying 
stored snapshot traces in raster or overlay (i.e., superimposed) modes. 

AmpMrk On / Off - press this function key to toggle the amplitude 
markers On or Off within the Trace window. 

LatMrk On / Off - press this function key to toggle the latency markers 
On or Off within the Trace window. 

 

Position mode (F6) 

(Knobs) 

 

Sel. Trial / Move - turn this knob to select a stored EMG snapshot 
trace.  When selected, the trace will be displayed in yellow.  Press the 
knob, then turn to move the selected trace up or down within the Trace 
window. 

Move Active - turn this knob to move the active (white colored) trace 
up or down within the Trace window. 

Sel. Trial / Delete - turn this knob to select a stored EMG snapshot 
trace.  When selected, the trace will be displayed in yellow.  Press the 
knob to delete the selected trace. 

Gain - turn this knob to change the Gain of the selected trace. 

(F Keys) 

 

Raster / Overlay - press this function key to toggle between displaying 
stored snapshot traces in raster or overlay (i.e., superimposed) modes. 
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Capture EMG Acquisition Mode: 

Capture EMG - During Data Acquisition 

(Knobs) 

 

Study Item - turn this knob to highlight and load a different Test 
Protocol in the Study window. 

Muscle Sel / Delete Score - turn this knob to highlight a different 
muscle name within the EMG test protocol in the Study window.  If the 
muscle has been scored you can press the knob to remove it from the 
Muscle Scoring Table. 

Trigger Lvl / Dual Trig - turn this knob to move the trigger level 
indicator up or down within the Trace window.  Press this knob to 
activate the Dual Trigger mode.  In Dual Trigger mode the trace will be 
captured if it falls between the two trigger level indicators (useful for 
capturing small amplitude motor units in the presence of large 
amplitude motor units) 

Gain / Sweep - turn the knob to change the gain of the EMG trace. 
 Press the knob, then turn to change the sweep speed of the EMG 
trace. 

(F Keys) 

 

Live / Capture - press this function key to switch back and forth 
between Live or Capture acquisition modes. 

Fibs / Recrt - press this function key to switch back and forth between 
Fibs and Recrt parameter settings.  You can program different Gain 
and Sweep Speed parameters for these two modes and use this 
function key to easily toggle between the two. 

Muscle List - opens the EMG Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData summary window. 
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Capture EMG - Data Acquisition Stopped 

(Knobs) 

 

Study Item - turn this knob to highlight and load a different Test 
Protocol in the Study window. 

Muscle Sel / Delete Score - turn this knob to highlight a different 
muscle name within the EMG test protocol in the Study window.  If the 
muscle has been scored you can press the knob to remove it from the 
Muscle Scoring Table. 

Start Trace / Trace Cnt - this knob effects how the traces in the EMG 
capture buffer are displayed.  Turn the knob to change the starting 
trace number.  Press the knob, then turn to change the trace count 
number. 

Trace Sel / Delete - turn this knob to select an EMG Capture trace. 
 When selected, the trace will be displayed in yellow.  Press the knob 
to delete the selected trace from the capture buffer. 

(F Keys) 

 

Raster / Overlay - press this function key to toggle between displaying 
captured EMG traces in raster or overlay (i.e., superimposed) modes. 

Muscle List - opens the EMG Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData summary window. 

 

Cursor Mode (F5) 

(Knobs) 

 

Lat 1 / Lat 2 - turn this knob to move latency marker number one. 
 Press this knob, then turn to move latency marker number two.  The 
latency values are displayed at the top left of the Trace window. 
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Amp 1 / Amp 2 - turn this knob to move amplitude marker number 
one.  Press this knob, then turn to move amplitude marker number two. 
 The amplitude value is displayed at the top left of the Trace window. 

Sel. Trial - turn this knob to select a captured EMG trace.  When 
selected, the trace will be displayed in yellow. 

Gain - turn this knob to change the gain of the selected trace. 

(F Keys) 

 

Raster / Overlay - press this function key to toggle between displaying 
captured EMG traces in raster or overlay (i.e., superimposed) modes. 

AmpMrk On / Off - press this function key to toggle the amplitude 
markers On or Off within the Trace window. 

LatMrk On / Off - press this function key to toggle the latency markers 
On or Off within the Trace window. 

Position Mode (F6) 

- this feature is disabled in EMG Capture. 

 

 

 

EMG Test Setup 

EMG test setup options are discussed in detail in the Test Protocol Setup 
chapter of the Help system. 

Live vs. Capture Mode 

The EMG test protocol has two basic data acquisition modes, Live and Capture. 
 Live mode is also known as "Free Running EMG" mode and Capture mode is 
also known as "Trigger" mode. 

Use the F1 (Live / Capture) function key to toggle between these two acquisition 
modes. 
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Live Mode 

Live Mode:  In Live mode "free-running" EMG is displayed in the Trace 
window and a compressed view of the EMG Live Buffer is displayed below 
this.  A moving blue marker shows the current position within the buffer.  At 
any time data acquisition can be stopped and the data in the Live Buffer can 
be reviewed or played back.  The EMG test protocol always defaults to the 
Live data acquisition mode when it is first loaded. 

 

EMG - Live mode 

Live Mode with Raster Display:  While in EMG Live mode, click or press the 
F11-Raster function key, or right click within the EMG trace window and 
select Raster Live Display from the pop-up menu. 
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When this feature is enabled the Trace window is split into two equal 
sections; the left half showing the live EMG data and the compressed buffer, 
the right half showing consecutively rastered EMG traces. 
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Live EMG mode with Raster Display enabled. 

Raster Display Options. 

Right clicking within the raster trace area will display a pop-up menu of 
raster display options. 
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 Amplitude Markers – enables amplitude markers within the raster 
display area. 

 Time Markers – enables time markers within the raster display 
area. 

 Raster Off – turns off the raster display feature. 

 Number of Rastered Traces – changes the number of traces 
displayed in the raster area.  Select 3, 5, or 10 from the drop down 
list or type in any number between 2 and 100. 
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 Auto Position Traces – if traces have been moved up/down within 
the raster area, this option will return the traces to their original 
positions. 

 Trial Highlighting - enables the alternating white/gray coloring of 
the rastered traces. 

 MUP Tool - this feature is only available when EMG acquisition has 
been stopped.  For more information on the MUP Tool, click here. 

 Track Live Gain - when enabled the rastered traces will always be 
displayed at the same gain setting as the Live EMG trace. 

 Trace Live Sweep - when enabled the rastered traces will always 
be displayed at the same sweep speed setting as the Live EMG 
trace. 

 Sweep - changes the sweep speed of the rastered traces.  Select a 
sweep speed value from the list.  The black dot indicates the 
current setting. 

 Gain - changes the gain of the rastered traces.  Select a gain value 
from the list.  The black dot indicates the current setting. 

 Copy Window - copies the contents of the EMG trace window to 
the clipboard. 

 

Enabling the Raster Display as your default setting for EMG. 

The status of the Raster display feature, and the number of rastered 
traces, can be saved as part of the default settings for the EMG test 
protocol.  With the feature enabled, simply select Save Test Parameters 
from the Edit menu. 

 

Capture Mode 

Capture Mode:  In Capture mode a voltage level trigger and delay marker 
are displayed within the Trace window.  The level of the voltage trigger can be 
adjusted using Knob #3 (Trigger Lvl).  When EMG activity exceeds the 
trigger level (in either the negative or positive direction) the sweep is captured 
momentarily and is repositioned with the crossing point at the delay marker. 
 This allows for easier visualization of motor unit potentials.  At any time data 
acquisition can be stopped and up to 50 captured sweeps can be reviewed. 
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EMG - Capture mode 

Capture Mode with Capture Window:  While in EMG Capture mode, click or 
press the F11-Cap Wnd function key, or right click within the EMG trace 
window and select Capture Window from the pop-up menu. 
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When this feature is enabled the trace window is split into two sections; the 
top section shows the live EMG trace and the trigger level and delay indicator, 
the bottom section shows a rastered display of the most recently captured 
traces. 
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Capture Mode with Capture Window enabled. 

Capture Window Options. 

Right clicking within the capture window trace area will display a pop-up 
menu of display options. 
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 Hide Capture Window – turns off the capture window. 

 Number of Captured Traces - changes the number of traces 
displayed in the captured window trace area.  Select 3, 5, or 10 
from the drop down list or type in any number between 2 and 
100. 

 Amplitude Markers – enables amplitude markers in the 
captured window area. 

 Time Markers – enables time markers in the captured window 
area. 

 Raster / Overlay – sets the position of the captured window 
traces as either rastered or overlayed (i.e., superimposed). 

 Auto Position Traces - if captured window traces have been 
moved up/down using the mouse, this option will return the 
traces to their original positions. 

 Trial Highlighting - enables the alternating white/gray coloring 
of the captured traces. 

 Sweep Speed – the sweep speed of the Live and Capture 
Window areas can be set independently. 
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o Link Sweep to EMG Trace Window – automatically sets 
the captured window trace area to the same sweep 
speed as the Live trace. 

o 1, 2, 5, 10 ms/Div – sets the captured window trace 
sweep speed to the selected value.  Dual sweep values 
are displayed in the Controls Toolbar or Amplifier 
Controls window when the captured window sweep 
speed is set differently than the Live trace sweep speed. 

 Copy Window - copies the contents of the EMG Trace window 
to the clipboard. 

Enabling the Capture Window Display as your default setting for 
EMG. 

The status of the Capture Window display feature and the number of 
traces displayed within the window can be saved as part of the default 
settings for the EMG test protocol.  With the feature enabled, simply select 
Save Test Parameters from the Edit menu. 

 

Live Buffer Review & Playback 

Before you can review the Live EMG Buffer you need to stop data acquisition. 
 To stop Live EMG data acquisition perform one of the following, 

 Press the Run/Stop key on the Sierra Wave base unit. 

 Press the Stim button on the Electrical Stimulator handle. 

Data acquisition will be stopped and the last complete sweep of EMG data will be 
displayed. 

 

To Move Backwards & Forwards within the buffer: 

Turn Knob #1 (Review / Play-Stop) counter-clockwise to move backward in the 
buffer, turn the knob clockwise to move forward.  You can also turn the Intensity 
Wheel on the electrical stimulator handle to move within the buffer.  Another 
method is to use the mouse to click and drag the blue marker back and forth 
within the compressed buffer area. 



Protocols 

409 

 

EMG - Stopped Live mode 

To Start EMG Playback: 

Press Knob #1 (Review / Play-Stop) and the EMG buffer will begin to playback. 
 Playback begins at the current location of the buffer position indicator (blue line). 
 As the EMG is played back the buffer position indicator will move from left to 
right across the compressed  buffer area.  The EMG's audio signal is played back 
through the PC's speakers, not through the speaker in the Sierra Wave base unit, 
therefore, if the audio is not loud enough, adjust the volume controls on your 
PC's speakers. 
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Review & Playback can also be accomplished by clicking on the EMG Buffer 
Playback Controls. 

 

Buffer Playback Controls. 

Go back one page. 

Go forward one page. 

Go back one division. 

Go forward one division. 

Start EMG playback. 

Stop EMG playback. 

 

To Set the Length of the EMG Buffer: 

The length of the Live EMG Buffer can be preset to be 30, 60, 120, 240, 360, or 
600 seconds. 

 Select Edit Current Test from the Edit menu. 

 Change the setting labeled EMG Buffer (secs), then click the OK 
button. 

To save these changes as the new default settings for the EMG Test protocol. 

 Select Save Test Parameters from the Edit menu. 

Storing a Live Snapshot 

1. Stop Live EMG data acquisition by performing one of the following, 

 Press the Run/Stop key on the Sierra Wave base unit. 

 Press the Stim button on the Electrical Stimulator handle. 

Data acquisition will be stopped and the last complete sweep of EMG 
data will be displayed. 

2. Move backward or forward within the EMG buffer until the trace that you want 
to store is displayed. 
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3. Verify that the correct muscle name is highlighted in the Study window.  If 
necessary, use Knob #2 (Muscle Sel / Delete Score) to highlight a different 
muscle name. 

4. Store the snapshot by performing one of the following actions, 

 Press the F1 (Store Snap Shot) function key on the Sierra Wave 
base unit. 

 Press the Store key on the Sierra Wave base unit. 

 Press the Store button on the Electrical Stimulator handle. 

 Click the Store button in the EMG Controls window on the screen. 

5. The stored EMG snapshot will be displayed in purple color and an entry will 
appear underneath the currently selected muscle name in the Study window. 

 

Study window showing stored EMG snapshot for the Right ExtDigCom muscle. 

6. Return to Live EMG data acquisition mode by performing one of the 
following, 

 Press the Run/Stop key on the Sierra Wave base unit. 

 Press the Stim button on the Electrical Stimulator handle. 

 Click on the Run button in the EMG Controls window on the 
screen. 

 

   If the Confirm Store Commands option is enabled for the EMG test 
protocol, the program will display a confirmation window whenever a Live 
Snapshot, Live Buffer, or Captured traces are stored.  This ensures that 
the data is stored with the correct muscle name and side and provides a 
place for a comment to be entered as well. 
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Storing a Live Buffer 

1. Stop Live EMG data acquisition by performing one of the following, 

 Press the Run/Stop key on the Sierra Wave base unit. 

 Press the Stim button on the Electrical Stimulator handle. 

Data acquisition will be stopped and the last complete sweep of EMG 
data will be displayed. 

2. Verify that the correct muscle name is highlighted in the Study window.  If 
necessary, use Knob #2 (Muscle Sel / Delete Score) to highlight a different 
muscle name. 

3. Store the Live EMG Buffer by pressing the F2 (Store Live Buffer) function 
key on the Sierra Wave base unit. 

4. The EMG trace color will change from white to light blue to indicate that the 
buffer has been stored and an entry will appear underneath the currently 
selected muscle name in the Study window. 

 

Study window showing stored buffer for Right Biceps muscle. 

5. Return to Live EMG data acquisition mode by performing one of the 
following, 

 Press the Run/Stop key on the Sierra Wave base unit. 
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 Press the Stim button on the Electrical Stimulator handle. 

 Click on the Run button in the EMG Controls window on the 
screen. 

 

   If the Confirm Store Commands option is enabled for the EMG test 
protocol, the program will display a confirmation window whenever a Live 
Snapshot, Live Buffer, or Captured traces are stored.  This ensures that 
the data is stored with the correct muscle name and side and provides a 
place for a comment to be entered as well. 

 

MUP Tool 

The MUP Tool gives the user the ability to quickly select and document motor 
unit potentials without having to use special software techniques like SMUA or 
MMUA. 

Using the MUP Tool: 

1. Stop the Live EMG.  The MUP Tool is only available when the EMG is 
stopped. 

2. Right-click the mouse over the motor unit potential (MUP) of interest, 
then select MUP Tool from the pop-up menu. 
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3. The motor unit potential is shown centered within a MUP window and is 
displayed at a sweep speed of 4 ms/Div.  Cursors are automatically 
placed on the potential and the resulting measurements are shown in a 
table at the bottom of the window.  The positions of the cursors can be 
adjusted using the mouse. 
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MUP window. 

4. Clicking the OK button closes the MUP window and creates a new node 
in the Study window called MUP Table with a sub-node called MUP #1. 
 The program also automatically stores the Live EMG Buffer.  Clicking the 
Cancel button closes the MUP window and discards the MUP without 
adding it to the Study window. 

This process can be repeated any number of times.  The program will 
automatically increment the MUP # as each additional MUP is stored. 
 MUPs can be saved for each muscle shown in the Study window and are 
stored separately for each buffer. 
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MUP Table created in Study window for the Left Abd Poll Brev with three MUPs stored 
from the buffer. 

 

Study window behavior: 

 Clicking on the MUP Table node in the Study window displays a MUP 
Table window in place of the Muscle Score Table window.  This table 
includes the measurements for all MUPs selected using the MUP Tool. 

 

 

 Clicking on an individual MUP # node in the Study window displays 
the individual MUP window once again.  This is also true if a row is 
selected within the MUP Table window.  At this point clicking OK simply 
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closes the MUP window , clicking Cancel also closes the window and 
would 'undo' any changes made to the cursor positions. 

 

 

TabData window behavior: 

 Clicking on the MUP Table node displays the summary MUP Table. 
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 Clicking on an individual MUP # node displays the waveform for the 
MUP and its results table. 
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Reports: 

MUP traces and the tabulated measurements are included in reports. 
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Buffer Playback in Capture Mode 

This feature allows a previously stored Live EMG Buffer to be played back in 
Capture Mode.  All of the typical functions of Capture Mode are available during 
playback (i.e., adjusting Trigger & Delay, stop and review of capture buffer). 

To playback a stored EMG Buffer in Capture Mode, follow these steps: 

1.  Select a muscle in the Study window that has one or more stored EMG 
Buffers. 

  

 

2.  Enable the playback feature by selecting Play Stored Buffer in Capture 
Mode from the Analysis menu. 

  

 

3.  The Capture Playback window is displayed and the first stored buffer is 
automatically selected.  This window lists all the stored buffers for the 
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selected muscle.  It contains the compressed buffer trace, a position marker, 
and a Play/Stop button. 

 

  

 

4.  Pressing the Play button causes the selected buffer to be played within 
the EMG Capture trace window. 



Sierra Wave Help Manual 

422 

 

 

Stored EMG Buffer being played back in Capture Mode 

 

5.  During playback in Capture Mode the following controls are available. 

a. Knob 4 (Gain/Sweep) can be utilized. 

b. Knob 3 (Trigger Lvl/Dual Trig) can be utilized. 

c. Clear key can be used to reset the Capture Count. 

d. Trg Dly control can be utilizied. 

 

6.  Clicking the Stop button will show all the traces in the Capture buffer.  To 
save these traces, press the Store key on the Sierra Wave base unit. 

 

7.  To select a different EMG buffer, simply click on it in the list. 

 

8.  Click the Done button to close the Capture Playback window. 
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Reviewing Captured Traces 

1. Stop Capture EMG data acquisition by performing one of the following, 

 Press the Run/Stop key on the Sierra Wave base unit. 

 Press the Stim button on the Electrical Stimulator handle. 

Data acquisition will be stopped and the contents of the captured trace 
buffer will be displayed.  Up to 50 traces can be held in the capture 
buffer. 

2. Use Knob #3 (Start Trace / Trace Cnt) to set the Trace Cnt number, 
typically this defaults to the total number of traces in the capture buffer. 
 Changing this to 5, for example, would display only five traces at a time in 
the trace window rather than all the traces at once. 

3. If necessary, use Knob #3 (Start Trace / Trace Cnt) to set the Start Trace 
number, typically this defaults to 1 and can't be changed until the Trace Cnt 
has been changed first.  A setting of 1 means that the first trace in the 
capture buffer is displayed at the top of the Trace window. 

Here's an example of how to use the Trace Cnt and Start Trace settings to 
view subsets of the capture buffer: 

Assume there are 50 total traces in the capture buffer.  The Trace Cnt will 
default to 50 and the Start Trace number will default to 1.  Therefore all 50 
traces (1 to 50) are displayed in the Trace window.  Now, change the 
Trace Cnt to 20 and leave the Start Trace number at 1.  You will see 
traces 1-20 displayed in the Trace window.  You can now change the Start 
Trace number to 21, now you can view traces 21-40.  Change the Start 
Trace number again and it goes to 41, now you can view traces 41-50. 

4. If necessary, use Knob #4 (Trace Sel / Delete) to select and delete any 
unwanted traces from the capture buffer.  A selected trace is displayed in 
yellow color on the screen.  As traces are deleted the total Trace Cnt will 
decrease. 

5. For instructions on how to store the captured traces, go to the next topic in 
the Help system. 

Storing Captured Traces 

1. Stop Capture EMG data acquisition by performing one of the following, 

 Press the Run/Stop key on the Sierra Wave base unit. 

 Press the Stim button on the Electrical Stimulator handle. 
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Data acquisition will be stopped and the contents of the captured trace 
buffer will be displayed. 

2. If necessary, use Knob #4 (Trace Sel / Delete) to select and delete any 
unwanted traces from the capture buffer. 

3. Verify that the correct muscle name is highlighted in the Study window.  If 
necessary, use Knob #2 (Muscle Sel / Delete Score) to highlight a different 
muscle name. 

4. Store the captured traces by performing one of the following, 

 Press the Store key on the Sierra Wave base unit. 

 Press the Store button on the Electrical Stimulator handle. 

 Click the Store button in the EMG Controls window on the screen. 

5. The captured trace color will change from white to purple indicating the 
traces have been stored.  You will also see an entry appear underneath the 
currently selected muscle name in the Study window. 

 

Study window showing a stored set of captured traces for the Right Abd Poll Brev muscle. 

6. Return to Capture EMG data acquisition mode by performing one of the 
following, 

 Press the Run/Stop key on the Sierra Wave base unit. 

 Press the Stim button on the Electrical Stimulator handle. 

 Click on the Run button in the EMG Controls window on the 
screen. 

 

Deleting a Snapshot, Buffer, or Capture 

1. Right click the mouse over the stored Snapshot, Live Buffer, or 
Capture run in the Study window. 

2. From the pop-up menu select Delete. 
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Right click and select Delete. 

3. A confirmation message will be displayed, select OK. 

 

 

Deleting a Manual MUP 

1. Right click the mouse over the stored MUP # in the Study window. 

2. From the pop-up menu select Delete. 
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Right click and select Delete. 

3. A confirmation message will be displayed, select OK. 

 

 

 

Moving a Stored Buffer or Snapshot 

To move a Stored EMG Buffer or Snapshot to a different muscle in the Study 
window, simply left click on the stored Snapshot or Buffer and drag it to the 
appropriate muscle name in the Study window.  When you release the left mouse 
button the snapshot or buffer will be moved to that muscle. 



Protocols 

427 

 

 

Muscle Scoring 

EMG Muscle Scoring 

With the Automatic Muscle Scoring feature enabled, as soon as any EMG 
muscle is selected within the Study window, or is added to the Study window 
using the F3 (Muscle List) function key, it is automatically scored as "normal" 
and is added to the Muscle Score Table. 

 The Automatic Muscle Scoring feature can be disabled in the EMG 
Test Setup window.  When this feature is disabled the muscles in the Study 
window are not automatically added to the muscle score table.   You will need 
to use the F2 (Muscle Sel/Score) knob to manually add the appropriate 
muscles to the scoring table. 

 

Modifying Muscle Scoring 

To change the muscle scoring for a muscle, 

 Turn Knob #3 (Score Table / Modify) until the highlight is over the 
scoring field that you want to change, press the knob to pop up a list 
of choices, turn the knob to highlight one of the choices and press 
again to select it. 

 Using the left mouse button, click on the scoring field that you want to 
change.  From the pop up list of choices click again to make a 
selection. 
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Muscle Scoring Table 

 Depending on your preferences in System Setup, abnormal 
selections can be flagged with a red background color, as bold text, or as 
bold text & background color red. 

 Muscles with the Is Paraspinal flag enabled will not use all the 
columns in the muscle scoring table. 

 

 

Scoring Multiple Muscle Abnormalities 

To score the same abnormality on multiple muscles, simply hold down the 
Control key while left clicking on each row in the Muscle Scoring Table. 
 Once the appropriate muscles (i.e., rows) have been selected you can then 
change the scoring choices on any one of the selected rows and your 
selections will be applied to all the selected rows.  To deselect the rows, click 
in a blank area outside the table. 
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Muscle Scoring Table with three muscles selected and scored with 3+ Psw. 

 

Deleting a Row from the Muscle Score Table 

To delete a row from the Muscle Score Table, perform one of the following. 

 Turn Knob #2 (Muscle Sel / Delete Score) until the muscle you want 
to remove from the Muscle Score Table is highlighted in the Study 
window, then press the knob and the corresponding row in the table 
will be deleted. 

 Right click the mouse over the row you want to delete, then select 
Delete Row from the pop-up menu. 

 When a muscle is deleted from the Muscle Score Table the 
checkmark next to the muscle name in the Study window is also removed. 

 

Deleting all Rows from the Muscle Score Table 

To delete all rows from the Muscle Score Table, perform one of the following. 

 Turn Knob #2 (Muscle Sel / Delete Score) until the muscle name you 
want to remove from the Muscle Score Table is highlighted in the 
Study window, then press the knob to delete the row.  Repeat this 
process until all the rows are deleted. 

 Right click the mouse over any row in the Muscle Score Table, then 
select Delete All Rows from the pop-up menu.  A confirmation 
message will be displayed, select OK. 

 When a muscle is deleted from the Muscle Score Table the 
checkmark next to the muscle name in the Study window is also removed. 
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Re-Scoring a Muscle that has been deleted from the Muscle Score 
Table 

To re-score one muscle, perform one of the following. 

 Turn Knob #2 (Muscle Sel / Score) to highlight the muscle name in 
the Study window.  Press the knob to score the muscle with its 
normal defaults. 

 Right click the mouse over the muscle name in the Study window. 
 From the pop-up menu select Score Muscle Normal. 

To re-score all muscles. 

 Right click the mouse over any muscle name in the Study window. 
 From the pop-up menu select Score All Muscles Normal. 

 

Sorting the Muscle Score Table 

Initially, the muscles are added to the score table in the same order that they 
are listed in the Study window. 

Single click on the column heading (e.g. Fibs) to sort the table by the 
entries in that column.  Sorting priority is first by number (0-9), then 
alphabetically (a-z). 

 

Restoring Original Sort Order 

Right click the mouse on any row in the Muscle Score Table and select 
Original Sort Order from the pop-up menu. 

 

Manually changing the Sort Order 

Left click & hold over muscle name, pointer turns into a „hand‟.  Drag to the 
location where you want to move this row and release the mouse button. 
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AnatomyVIEW - EMG 

The AnatomyVIEW feature allows the EMG muscle scoring data to be displayed 
on a 3D color-coded anatomical model.  The AnatomyVIEW window can be 
included in reports. 

To open the AnatomyVIEW window, perform one of the following: 

 Click on the AnatomyVIEW button in the EMG test controls toolbar. 

 

 Select AnatomyVIEW from the View menu. 
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AnatomyVIEW window. 

 

For additional AnatomyVIEW topics, Click here. 

 

 

Table Font Size 

In all test protocols the font size of the Table window can be increased or 
decreased.  Simply right click on the table and select Font Size from the pop-up 
menu.  The choices are Small (default), Medium, Large, and Extra Large. 
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Changing the font size of the Muscle Scoring Table. 

 

 

Changing the font size of the NCV Tables. 

 

To save your selection as part of the test protocol's default settings, select Save 
Test Parameters from the Edit menu. 

 The selected font size is also applied to that table in the TabData window. 
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Swap Sides 

To swap the side parameter on a muscle, perform one of the following. 

 Right click the mouse over the muscle name in the Study window. 
 From the pop-up menu select Swap Sides, Left/Right. 

 Right click the mouse over the corresponding row in the Muscle Score 
Table.  From the pop-up menu select Swap Sides, Left /Right. 

 If the muscle was listed only once  in the Study window, then it will be 
swapped to the opposite side. 

 If the muscle was listed in the Study window twice, as a right sided 
muscle and as a left sided muscle, then both the entries will have their side 
parameter swapped.  You can never have more than one Right or Left sided 
muscle in the Study window. 

 If the muscle being swapped contains stored data (i.e., a snapshot, 
buffer, or capture runs), the data is also moved to the opposite side. 

Change Sides 

Changing the Side parameter for a muscle is different than Swapping Sides. 
 When you change sides, the highlight moves from the currently selected muscle 
in the Study window (e.g. Right Abd Poll Brev) to the same muscle but with the 
opposite side (e.g., Left Abd Poll Brev). 

If the muscle corresponding to the selected side is not listed in the Study window, 
it is automatically added to the window. 

 

To change the side parameter: 

In the EMG Controls Window, click the down arrow for the Side parameter 
control.  Select the appropriate side from the drop-down list. 
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Or, in the EMG Controls Toolbar, click the down arrow for the Side 
parameter control.  Select the appropriate side from the drop-down list. 

 

 

Notch Filter 

A 50 or 60 Hz Notch Filter can be enabled for each channel.  The default 
frequency of the filter is set within the System Setup preferences. 

 

To enable the Notch Filter 

In the EMG Controls window, click on the Notch setting for the appropriate 
channel.  The setting will toggle from Off to 50 or 60 Hz. 
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                      Notch Off                                                    Notch ON (60 Hz) 

In the Controls Toolbar, click on the Notch setting for the appropriate channel. 
 The setting will toggle from Off to 50 or 60 Hz. 

 

 

To set the default Notch Filter Frequency 

1. From the File menu, select System Setup. 

2. Select either 50 Hz or 60 Hz in the Notch Frequency section. 

 

3. Click OK. 

Muscle List (F3) 

The F3 (Muscle List) function key is a convenient way to add muscles to the 
Study window after a Study List has been selected or after the EMG Test 
Protocol has been loaded. 

 



Protocols 

437 

To Add a Muscle to the Study Window 

1. From within the EMG Test Protocol, press the F3 (Muscle List) function 
key.  The Select Muscle window will be displayed. 

 

F3 - Select Muscle window. 

2. To add a single muscle, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 
the muscle.  Verify the Side parameter, use Knob #2 (Side) to 
change this if necessary.  Press the OK key on the Sierra Wave 
base unit. 

 Using the Mouse - verify the Side parameter and then double 
click on the muscle name. 

3. To add multiple muscles, perform one of the following. 
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 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 
the muscle.  Repeat this process until all of the muscles you want 
to add are highlighted.  Verify the Side parameter, use Knob #2 
(Side) to change this if necessary.  Press the OK key on the Sierra 
Wave base unit. 

 Using the Mouse - single click the mouse over the appropriate 
muscle names.  Once all of the muscles have been selected, verify 
the Side parameter and then click OK. 

 

 Setting the Side parameter to Left & Right will add the muscle to the Study 
window twice, once for the Left and once for the Right. 

 Adding muscles to the Study window in this manner is only temporary.  To 
add muscles to a Study List permanently, review the help topic "Changing an 
Existing Study". 

Time & Amplitude Markers 

To quickly measure the duration or amplitude of a motor unit potential use the 
Time & Amplitude Markers. 

 

Using the Time Markers 

 Right click over the EMG Trace window and select Time Markers from 
the pop-up menu.  Two vertical time markers will be displayed. 

 Move the markers by clicking on them with the mouse and dragging 
them across the window. 

 The latency, in milliseconds (from the left edge of the Trace window), is 
displayed for each Time Marker in the upper left hand corner of the Trace 
window.  The difference between the two time markers is also indicated. 

 To remove the Time Markers from the window, right click over the EMG 
Trace window and de-select Time Markers from the pop-up menu. 
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EMG Trace window with Time Markers. 

Using the Amplitude Markers 

 Right click over the EMG Trace window and select Amplitude Markers 
from the pop-up menu.  Two horizontal amplitude markers will be 
displayed. 

 Move the markers by clicking on them with the mouse and dragging 
them up or down in the window. 

 The amplitude, in microvolts, between the two amplitude markers is 
shown in the upper left hand corner. 

 To remove the Amplitude Markers from the window, right click over the 
EMG Trace window and de-select Amplitude Markers from the pop-up 
menu. 
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EMG Trace window with Amplitude Markers. 

 

Using Cursor mode to manipulate the Time & Amplitude Markers 

If you prefer using the Sierra Wave base unit's dedicated knob and function 
keys when working with the Time & Amplitude markers simply press the F5 
function key on the PC's keyboard to enter Cursor mode.  The functions of 
the base unit's knobs and function keys will change to those illustrated below. 
 When your finished using Cursor mode, press the F5 function key a second 
time, or the OK key to exit from Cursor mode. 

Cursor mode (F5) 

(Knobs) 
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Lat 1 / Lat 2 - turn this knob to move latency marker number one. 
 Press this knob, then turn to move latency marker number two.  The 
latency values are displayed at the top left of the Trace window. 

Amp 1 / Amp 2 - turn this knob to move amplitude marker number 
one.  Press this knob, then turn to move amplitude marker number two. 
 The amplitude value is displayed at the top left of the Trace window. 

Sel. Trial - turn this knob to select a stored snapshot trace.  When 
selected, the trace will be displayed in yellow color. 

Gain - turn this knob to change the gain of the selected snapshot 
trace. 

(F Keys) 

 

Raster / Overlay - press this function key to toggle between displaying 
stored snapshot traces in raster or overlay (i.e., superimposed) modes. 

AmpMrk On / Off - press this function key to toggle the amplitude 
markers On or Off within the Trace window. 

LatMrk On / Off - press this function key to toggle the latency markers 
On or Off within the Trace window. 

Graticule Size 

The EMG Trace window is divided into a grid pattern using vertical and horizontal 
divisions or graticules.  The grid pattern can be changed by altering the number 
of these divisions. 

 

To Change the EMG Trace window Graticule Size during an exam: 

 Right click on the EMG Trace window. 

 From the pop-up menu, highlight Graticule Size, a second level pop-up 
menu will be displayed. 

 Choose one of the listed selections.  The first number is for the number of 
vertical divisions, the second number is for the number of horizontal 
divisions. 
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Graticule size selections for EMG Trace window. 

 

 Live and Capture EMG modes can have different graticule sizes.  Factory 
default Graticule size for Live EMG mode is 10 x 10.  For Capture EMG mode it 
is 10 x 10. 

 For information on changing the default Graticule size, see the topic "EMG 
Setup". 

Fast Refresh Rate 

This feature changes the drawing of the EMG trace so that it appears more like 
an oscilloscope display.  Simply right-click over the EMG Trace window and 
select Fast Refresh from the pop-up menu.  This setting adds a 2 division „gap‟ 
and updates the trace at 60 Hz.  When this setting is disabled the trace is drawn 
with no gap and refreshes at 15 Hz. 
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Enable Fast Refresh Rate for EMG trace. 

 

Saving Changes to EMG Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the EMG Test protocol. 

 Select Save Test Parameters from the Edit menu. 
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EMG Interference Pattern Analysis (IP) 

Performing IP Analysis 

The electromyographic (EMG) interference pattern (IP) recorded by an 
intramuscular needle electrode contains the motor unit action potentials (MUAPs) 
of all active motor units that are within the recording area of the electrode.  The 
IP is typically assessed by its appearance on the EMG machine's display and its 
sound on a loudspeaker.  Several methods have been developed to quantify the 
IP, the "cloud plot" technique has gained popularity in recent years. 

Follow these steps for performing IP Analysis: 

1.  Select the EMG  Test:   

 If a Study has already been selected, simply click on an EMG muscle 
name (i.e., Right Deltoid) within the Study window or turn Knob #1 (Study 
Item) to highlight the muscle name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual EMG test protocol from the Study/Test menu, a 
muscle list will be displayed allowing you to pick the muscle or muscles 
that you will be testing on the patient. 

2.  Activate IP Analysis mode. 

Enable IP Analysis by performing one of the following. 

 Press the F7 function key on the PC's keyboard. 

 Click on the IPA button on the Wave's PC Function Key menu.  To 
enable the function key menu click on the View menu, then select 
PC Function Menu. 

 Select Interference Pattern Analysis from the Analysis menu. 

The display will change to show the IP Analysis window in the location 
normally occupied by the Muscle Score Table window.   The IP Analysis 
window contains three plots, Amplitude vs. Turns/sec, Envelope vs. 
Activity, and NSS vs. Activity.  For more information on these plots, go to 
the Cloud Plot Descriptions topic. 

 If you were in Capture mode the program will automatically switch to Live 
mode when IP Analysis is selected. 

3.  Position the needle electrode within the muscle. 

Adjust the Gain setting so that motor unit potentials do not clip at moderate 
and full effort.  The Sweep Speed setting is typically 10-20 ms/Div. 
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4.  Begin Analysis. 

Press the F1 (Pause / Analyze) function key to activate the Analyze mode. 
 Record EMG activity during moderate to full effort.  As the EMG data is 
analyzed data points will begin to be placed on the cloud plots, each data 
point represents a 500 millisecond epoch of EMG activity.  Typically 20-30 
data points should be collected for the muscle being examined (20 data 
points = 10 seconds), and these should be acquired from 6-10 different sites 
within the muscle. 

The Clear key on the Sierra Wave base unit can be used to reset (i.e., clear) 
the cloud plots at any time. 

Blue data points lie within the defined normal (light green) area and red data 
points lie outside the normal area.  The total number of data points plotted on 
the cloud is shown below each plot as well as the number and percentage of 
abnormal data points. 

 

IP Analysis window. 

Press the F1 (Pause / Analyze) function key to activate the Pause mode 
while the needle is being repositioned within the muscle.  Once the needle 
has been positioned, return to the Analyze mode. 

5.  Stop Analysis. 

After the appropriate number of data points has been collected, press the 
Run/Stop key on the Sierra Wave base unit to stop the EMG acquisition (this 
also places IP Analysis in Pause mode). 

6.  Store the IP Analysis 

To store the IP Analysis Cloud plots, press the Store key on the Sierra Wave 
base unit. 
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Once the IP Analysis Cloud plots have been stored an IP node will be 
displayed in the Study window for the muscle being examined. 

The Live EMG Buffer can also be stored along with the IP Analysis plots by 
optionally pressing the F2 (Store Live Buffer) function key. 

 

Study window with stored IP Analysis and Live Buffer for Right Ant Tibialis muscle. 

7.  To record another IP Analysis run. 

Press the Run/Stop key on the Sierra Wave base unit to start EMG 
acquisition and automatically clear the IP plots.   Repeat steps 3 - 6. 

8.  To Exit from IP Analysis mode. 

To return to basic EMG, perform one of the following. 

 Press the F7 function key on the PC's keyboard. 

 Click on the IPA button on the Wave's PC Function Key menu.  To 
enable the function key menu click on the View menu, then select 
PC Function Menu. 

 Select Analysis Off from the Analysis menu. 

 

Knob & Fkey Controls (IP Analysis) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether EMG data acquisition is running or stopped. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 
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Data Acquisition mode: 

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Muscle Sel  - turn this knob to highlight a different muscle name within the 
EMG test protocol in the Study window. 

Gain / Sweep - this knob defaults to the Gain mode and can be used to 
increase or decrease the gain (uV/Div) of the Trace window.  Press the 
knob to switch to Sweep mode and turn to adjust the sweep speed 
(ms/Div) of the Trace window. 

The Gain and Sweep will automatically reset to default values 
when a new muscle is selected in the Study window. 

F Keys 

 

Pause / Analyze - defaults to the Pause mode, in this mode Live EMG is 
displayed but no IP Analysis occurs.  Press the key to activate Analyze 
mode, in this mode every 500 msec of EMG data is analyzed and plotted 
on the cloud plots. 

Fibs / Recrt - press this function key to switch back and forth between 
Fibs and Recrt parameter settings.  You can program different Gain and 
Sweep Speed parameters for these two modes and use this function key 
to easily toggle between the two. 

This function key will automatically reset to the Fibs mode when a 
new muscle is selected in the Study window. 

Muscle List - opens the EMG Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData Summary window. 
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Data Acquisiton Stopped: 

Knobs 

 

Review / Play-Stop - turn this knob to move backward and forward within 
the EMG buffer.  Press the knob to start & stop playback of the EMG 
buffer. 

Muscle Sel  - turn this knob to highlight a different muscle name within the 
EMG test protocol in the Study window. 

Gain / Sweep - turn the knob to change the gain of the EMG trace.  Press 
the knob, then turn to change the sweep speed of the EMG trace. 

F Keys 

 

Store Snap Shot - press this function key to store the currently displayed 
EMG trace. 

Store Live Buffer - press this function key to store the entire EMG buffer. 

Muscle List - opens the EMG Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData summary window. 

 

Cloud Plot Descriptions 

IP Analysis uses three distinct plots, they are; Amplitude vs. Turns/sec, 
Envelope vs. Activity, and NSS vs. Activity. 

Blue data points lie within the defined normal (light green) area and red data 
points lie outside the normal area.  The total number of data points plotted on 
the cloud is shown below each plot as well as the number and percentage of 
abnormal data points. 

All normative data is taken from the published literature.  If a plot does not have 
normative data for a muscle then no normal (light green) area is shown on that 
plot. 
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Plot #1:  Mean Amp/Turn vs. Turns/sec. 

 

The mean amplitude per turn is plotted on the Y-axis, the number of Turns per 
second is plotted on the X-axis. 

Definitions: 

Turn - a turn ocurs at a local minimum or maximum of the EMG signal (i.e., 
peak or trough), where the signal changes its direction and the signal 
amplitude changes by at least 100 microvolts (uV) compared to the preceding 
and subsequent turns. 

Segment - portion of the EMG signal between two consecutive turns. 

Mean Amplitude per Turn - the mean amplitude of all the segments in the 
analyzed epoch. 

 

Example EMG signal with five turns (T1-T5) 
defining four segments (S1-S4).  The amplitudes 
(A1-A4) and durations (D1-D4) are shown. 
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Normative Data: 

Normative data for the Amp vs. Turns plot are based on Needle type 
(concentric only), Age (less than 60 or greater than 60), Muscle, and 
Gender. 

The Sierra Wave comes with Concentric needle normative data for the 
following muscles. 

 Biceps Brachii 

 Extensor Digitorum Communis 

 Vastus Medialis (Quadriceps) 

 Anterior Tibialis 

 1st Dorsal Interosseous (not age dependent) 

 There is no normative data included for the Monopolar needle type. 

Interpretation: 

Neuropathy - Mean Amplitude is increased, Turns/sec is normal or 
decreased. 

Myopathy - Mean Amplitude is decreased, Turns/sec increased. 

Generally, less than 10% of all data points should lie outside the normal 
boundaries (i.e., 2 out of 20 points).  Points that cluster above the normal 
space are suggestive of a neuropathic process while points that cluster below 
the normal space are suggestive of a myopathic process.  Sometimes the 
data points will all lie within the normal space but will tend to cluster either 
above or below the mean line, this can also be indicative of a disease 
process. 
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Plot #2:  Envelope vs. Activity 

 

Envelope is plotted on the Y-axis, the Activity is plotted on the X-axis. 

Definitions: 

Activity - as the force of muscle contraction increases, the IP becomes 
increasing "full", i.e., it contains more and more MUAP activity with less time 
between individual MUAPs.  The activity parameter quantifies the "fullness" of 
the IP.  Activity is calculated by summating the durations of all the segments 
within the 500 msec epoch that lie below the duration and amplitude limits. 
 This sum is multiplied by 2 to give a value that corresponds to a 1-second 
epoch.  Therefore, activity represents the time (in milliseconds) within a 1-
second period during which MUAPs are present in the signal. 

In order for a segment to be included in the activity measurement it must 
meet the following criteria: 

 Amplitude between 2-10 mV and duration less than 5 msec. 

 Amplitude between 0.5-2 mV and duration less than 3 msec. 

 Amplitude less than 0.5 mV and duration less than 1.5 msec. 

Envelope - quantifies the largest spikes of the IP.  The envelope is defined as 
the amplitude that is exceeded by only 1% of the segments within the epoch. 

Normative Data: 

Normative data for the Envelope vs. Activity plot are based on Needle type 
(concentric only) and Gender.  As such, all muscles are shown with the same 
normal space and change only with respect to the patient's gender.  There is 
no normative data for the monopolar needle type. 

Interpretation: 

Neuropathy - Activity is normal or reduced, Envelope is increased. 
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Myopathy - Activity is decreased, Envelope is decreased. 

Generally, less than 10% of all data points should lie outside the normal 
boundaries (i.e., 2 out of 20 points).  Points that cluster above the normal 
space are suggestive of a neuropathic process while points that cluster below 
the normal space are suggestive of a myopathic process.  Sometimes the 
data points will all lie within the normal space but will tend to cluster either 
above or below the mean line, this can also be indicative of a disease 
process. 

 

Plot #3:  Number of Short Segments (NSS) vs. Activity: 

 

The number of short segments (NSS) is plotted on the Y-axis, the Activity is 
plotted on the X-axis. 

Definitions: 

Activity - same as above for the Envelope vs. Activity plot. 

Number of Short Segments (NSS) - this parameter assess the "complexity" 
of the IP by measuring the low-amplitude, short duration, high-frequency 
components of the IP. 

In order for a segment to be included in the NSS measurement it must meet 
the following criteria: 

 Amplitude between 0.5-2 mV and duration less than 3 msec. 

 Amplitude less than 0.5 mV and duration less than 1.5 msec. 

Normative Data: 

Normative data for the NSS vs. Activity plot are based on Needle type 
(concentric only) and Gender.  As such, all muscles are shown with the same 
normal space and change only with respect to the patient's gender.  There is 
no normative data for the monopolar needle type. 
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Interpretation: 

Neuropathy - Activity is normal or reduced, NSS is reduced. 

Myopathy - Activity is decreased, NSS is increased. 

Generally, less than 10% of all data points should lie outside the normal 
boundaries (i.e., 2 out of 20 points).  Points that cluster above the normal 
space are suggestive of a myopathic process while points that cluster below 
the normal space are suggestive of a neuropathic process (this is the reverse 
of the Envelope vs. Activity plot).  Sometimes the data points will all lie within 
the normal space but will tend to cluster either above or below the mean line, 
this can also be indicative of a disease process. 

 

Storing IP Analysis Results 

To store the IP Analysis Cloud plots, press the Store key on the Sierra Wave 
base unit. 

Once the IP Analysis Cloud plots have been stored an IP node will be displayed 
in the Study window for the muscle being examined. 

The Live EMG Buffer can also be stored along with the IP Analysis plots by 
pressing the F2 (Store Live Buffer) function key. 

 

Study window with stored IP Analysis and Live Buffer for Right Ant Tibialis muscle. 

Deleting an IP Analysis Run 

To Delete a stored IP Analysis run, follow these steps. 

 Right click the mouse over the Run # you want to delete in the Study 
window. 

 From the pop-up menu, select Delete. 

 A confirmation message will be displayed, click OK. 

 The Run is deleted. 
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Analyzing a stored EMG Buffer 

To Analyze a stored EMG Buffer: 

 Select the EMG Buffer by clicking on it in the Study window. 

 Enable Interference Pattern Analysis. 

 Press the F7 function key on the PC's keyboard. 

 Click on the IPA button on the Wave's PC Function Key menu.  To 
enable the function key menu click on the View menu, then select 
PC Function Menu. 

 Select Interference Pattern Analysis from the Analysis menu. 

 Right click over the IPA cloud plots, from the pop-up menu select Analyze 
Buffer. 

 

 The EMG data in the buffer will be analyzed and the cloud plots will be 
updated. 

 Press the Store key to save the analysis results. 

IP Analysis Options 

Right-clicking the mouse over the IP Analysis window will display a pop-up menu 
with several options. 

 

 

Cloud Plots - when selected this option will display the graphical cloud plots 
within the window.  This is the default. 
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Table View - when selected this option will display a table showing the values 
associated with each data point that has been collected.  The values listed are 
Turns/Sec, Amp/Turn, NSS, Envelope, and Activity. 

Clear Plots - during data acquisition this option will reset and clear all data points 
from all the cloud plots.  The Clear key on the Sierra Wave base unit also 
performs this function. 

Analyze Buffer - selecting this option will analyze the currently selected stored 
EMG buffer in the Study window and update the cloud plots accordingly. 

ASCII Dump - selecting this option will output the Table of data point values to a 
text file. 

Needle Type - allows selection of either Concentric or Monopolar needle types. 
 Normal data is provided only for the Concentric needle type. 

IP Analysis Normative Data 

The Sierra Wave's IP Analysis normative data has been taken directly from the 
published literature. 

The normal cloud can be drawn using two methods.  Method #1 uses a 
regression curve and standard deviation.  Method #2  uses pre-defined points to 
outline the normal polygon. 

All of the default normal clouds on the Sierra Wave use Method #1, as described 
in the literature. 

An editable text file called "IPAnalysisNorms.txt" contains the parameters used to 
draw the normal clouds.  By editing this file the user can modify the existing 
normative data or even add additional normative data for new muscles. 

The IPAnalysisNorms.txt file is located in the C:\Cadwell\Sierra Wave folder. 

When opened, the file looks like the following. 
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[Global] 

The first part of the file defines some global attributes which are applied to 
each cloud.  These attributes are ignored if the same attribute is specified for 
an individual cloud.  There can be multiple global sections. 

XScale=log (can be log or linear, if log, then x values of the regression curve 
are transformed from logarythmic to linear scale.  If linear, no transform is 
done) 

YOffset=100 (this value is added to the y values AFTER they have been 
transformed to linear scale) 

Needle = Concentric (can be either Concentric or Monopolar) 
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[Default] 

If there is not a cloud specified for a muscle then use this header to define a 
default for a particular plot type.  This is used for the Envelope vs. Activity and 
NSS vs. Activity plots. 

//*******************Biceps********************** 

This is a comment line. It begins with a double forward slash.   It is not used 
by the program. 

[Biceps] 

Defines the muscle name. 

Plot = Amp vs. Turns 

Specifies the plot the cloud is for.  Should contain the words Amp, Turns, 
Envelope, NSS, or Activity. 

Gender = Male 

Specifies if the plot is for Male or Female. 

Age = <60 

Specifies an age range.  Format is comparison operator followed by an age 
value.  Separate multiple age ranges by ';' or ','. 

Examples: 

Age = <60 

Age = >15, <60 

Slope = 0.507 

Clouds are defined by Slope, YIntercept, and Standard. Deviation.  This 
attribute defines the Slope of the regression curve. 

Intercept = 1.340 

Defines the Y-Intercept of the regression curve. 

SD = 0.162 

Defines the Standard Deviation that is added/subtracted from the regression 
curve to specify the top/bottom curves of the cloud. 

XMax = 850 

Defines an upper limit to x values of the cloud AFTER they have been 
transformed to linear scale.  Default is full scale of the plot. 



Sierra Wave Help Manual 

458 

YMax = 1525 

Defines an upper limit to y values of the cloud AFTER they have been 
transformed to linear scale.  Default is zero. 

StdDevCount = 3 

Specifies how many Standard Deviations (SD) to add and subtract from the 
regression curve to form the upper and lower curves of the cloud.  Default is 
2. 

 

Method #2 - Defined Points of the Polygon 

If Method #2 is used to draw the normal cloud the following syntax would be used 
in place of using Slope, Intercept, SD, XMax, YMax, StdDevCount as described 
above. 

Pt(0,200) 

Specifies a single point in the polygon that defines the cloud.  Syntax is: 
Pt(<x>, <y>).  The following defines a cloud. 

pt(0,200) 

pt(125,250) 

pt(625,375) 

pt(832.5,375) 

pt(832.5,1500) 

pt(625,1375) 

pt(375,1082) 

pt(187.5,750) 

pt(82.5,583) 
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IP Analysis References 

1. On the Shape of the Normal Turns – Amplitude Cloud 

Sanjeev D. Nandedkar, PhD, Donald B. Sanders, MD, and Erik V. Stalberg, MD 

Muscle & Nerve, 14:8-13, January 1991 

2. Analysis of the Electromyographic Interference Pattern 

Donald B. Sanders, Erik V. Stalberg, and Sanjeev D. Nandedkar 

Journal of Clinical Neurophysiology, 13(5):385-400, 1996. 

3. Automatic Analysis of the EMG Interference Pattern 

E. Stalberg, J. Chu, V. Bril, S. Nandedkar, S. Stahlberg, and M. Ericsson 

Technical Section – Electroencephalography and Clinical Neurophysiology 

56: 672-681, 1983. 

4. Automatic Analysis of the Electromyographic Interference Pattern.  Part 
1: Development of Quantitative Features. 

Sanjeev D. Nandedkar, PhD, Donald B. Sanders, MD, and Erik V. Stalberg, MD. 

Muscle & Nerve 9:431-439, June 1986. 

5. Automatic Analysis of the Electromyographic Interference Pattern.  Part 
2: Findings in Control Subjects and in some Neuromuscular Diseases. 

Sanjeev D. Nandedkar, PhD, Donald B. Sanders, MD, and Erik V. Stalberg, MD. 

Muscle & Nerve 9:491-500, July-August 1986. 

6. A New Approach to Quantitative Electromyography 

Nandedkar, S.D.: Wells, E.O.; Robertson, C.D. 

Technical Applications Bulletin Sheet 

Teca Corporation, March 1994 

7. The Utility of Interference Pattern Analysis 

Anders Fuglsang-Frederiksen, MD, DMSc 

Muscle & Nerve 23:18-36, January 2000 

8. Sensitivity and Specificity of Needle Electromyography:  A prospective 
study comparing automated interference pattern analysis with single 
motor unit analysis. 

Arto C. Nirkko, Kai M. Rosler, Christian W. Hess 

Electroencephalography and Clinical Neurophysiology 
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97 (1995) 1-10 

9. Methods in Clinical Neurophysiology:  Turns – Amplitude Analysis of the 
EMG Interference Pattern 

Anders Fuglsang-Frederiksen 

Dantec Corporation, December 1993 

10. Quantitative EMG in Inflammatory Myopathy 

Paul E. Barkhaus, MD, Sanjeev D. Nandedkar, PhD., and Donald B. Sanders, MD. 

Muscle & Nerve 13:247-253, March 1990 

11. Quantitative Analysis: Objective and Interactive Assessment in 
Electromyography. 

Sanjeev D. Nandedkar and Paul E. Barkhaus 

Clinical Evaluation and Diagnostic Tests for Neuromuscular Disorders, Chapter 12 

Edited by Tulio E. Bertorini 

Butterworth Heinemann Publisher, 2002 
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EMG Multi-Motor Unit Analysis 

Performing Multi-Motor Unit Analysis 

Multi-Motor Unit Analysis (MMUA) is an optional Quantitative EMG program 
that uses signal decomposition and template matching to extract, identify, and 
sort motor unit action potentials (MUAPs) from an epoch of EMG.  The main goal 
of MMUA is to quantify MUP parameters, not do complete signal decomposition 
and detect every occurrence of a given MUP in the firing pattern.  The method is 
called Multi-Motor Unit Analysis because many different MUPs usually can be 
obtained from each recording site. 

The Sierra Wave‟s MMUA program can be used in two ways.  It can be setup to 
immediately analyze a buffer of EMG activity as soon as it is acquired, or it can 
be used to analyze stored EMG buffers after the patient has left the office. 

Follow these steps for performing Multi-Motor Unit Analysis: 

1.  Select the EMG  Test:   

 If a Study has already been selected, simply click on an EMG muscle 
name (i.e., Right Deltoid) within the Study window or turn Knob #1 (Study 
Item) to highlight the muscle name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual EMG test protocol from the Study/Test menu, a 
muscle list will be displayed allowing you to pick the muscle or muscles 
that you will be testing on the patient. 

2.  Activate the MMUA program. 

Enable MMUA  by performing one of the following. 

 Press the F9 function key on the PC's keyboard. 

 Click on the MMUA button on the Wave's PC Function Key menu. 
 To enable the function key menu click on the View menu, then 
select PC Function Menu. 

 Select Multi-Motor Unit Analysis from the Analysis menu. 

3.  Position the needle electrode within the muscle. 

The needle electrode (typically concentric) is inserted randomly in the muscle 
but positioned at a site where the EMG signal is crisp.  No further adjustment 
of the electrode position is done.  A slight to moderate contraction (5-30% of 
maximum force) is used.  At this level of contraction the EMG signal may 
contain discharges of one to four different motor unit action potentials 
(MUAPs).  Adjust the Gain setting so that motor unit potentials do not clip at 
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moderate effort.  The Sweep Speed setting is typically 10-20 ms/Div.  Up to 
30 seconds of EMG can be analyzed but 5 to 10 second epochs are 
suggested. 

4.  Acquire 10-30 seconds of EMG activity and then press the Run/Stop key. 

The MMUA window will be displayed.  The EMG Buffer has been analyzed 
and the results are shown on the Analyze tab.  

 To analyze a previously acquired and stored EMG Buffer, simply click on 
the buffer you wish to analyze in the Study window. 

 

MMUA Analyze view.  3 MUPs have been identified in this EMG buffer. 

Analysis Overview: 

The computer begins by identifying the spikes within the EMG signal.  The 
first spike becomes a template against which all the other spikes are 
compared.  So, if the next spike in the signal is considered the same as the 
template spike (based on template matching algorithms) it is sorted into that 
template‟s bin.  If the spike does not match the template spike, it becomes the 
template for a second bin. This is repeated until all the spikes in the epoch 
are evaluated and sorted into bins. 

When a bin contains several matches (>10), it is considered to represent 
discharges from a single MUAP.  The spikes in the bin are averaged and the 
resulting averaged trace is displayed.  Measurements are made on the 
averaged trace and allow the MUPs properties to be quantified.  Typical 
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measurements include; Amplitude, Duration, #Phases (<= 4 is normal), 
Turns, Firing Frequency, and Thickness. 

This process is repeated until 20-30 different MUPs have been acquired for 
the muscle under investigation.  The mean and standard deviation is 
computed for all the MUPs and for just the Non-Polyphasic MUPs (i.e., the 
Simple MUPs).  The total percentage of polyphasic MUPs found within the 
muscle is indicated as well. 

5.  The Analyze Tab 

The EMG Buffer is shown across the bottom of the window.  By default the 
program automatically analyzes the last 10 seconds of the buffer. You can 
move the start & end analysis markers (shown in blue) and analyze other 
portions of the buffer by clicking on the Analyze button.  Up to 30 seconds 
can be analyzed at one time. 

 Results are displayed in bins. All the individual MUAP traces are 
shown in light grey, the resulting averaged trace is shown in purple 
(non-polyphasic) or orange (polyphasic). 

 The amplitude (peak to peak), duration (ms), firing rate (Hz), and 
number of phases (ph) are summarized in the top right of each bin. 

 The firing pattern of the MUP is indicated by „tick marks‟ below the bin. 
 The marks indicate where the MUP was found within the epoch of 
EMG.  Firing rate accuracy is better with increasing number of 
detections. 

 You can overlay or raster the individual traces in a bin by using the 
right-click menu.  The default is overlay. 

 Bins with more than 10 traces are automatically selected (shown by 
check mark in upper left of bin) 

 Bins with less than 10 traces are shown as "insufficient" and are not 
selected. 

 MUPs with 5 or more phases are considered “Polyphasic” and the 
averaged trace is displayed in orange. 

 Gaps in the firing pattern indicate portions of the signal where the 
MUAP discharge could not be extracted or resolved due to 
superimposition with other discharging MUAPs.  Gaps may also occur 
if the MUAP stops firing. 

 Sometimes the same MUAP may be sorted into multiple bins.  This 
typically occurs when the MUAP waveform changes during the 
recording (e.g., electrode movement, MUAP instability) or when the 
MUAP is complex.  The user can manually combine the bins in this 
situation. 
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To Combine Bins: 

1. Hold down the Control key and single left click the mouse 
on the bins to be combined.  Selected bins will have a blue 
box drawn around them. 

2. Right click over any one of the selected bins and choose 
Combine Bins from the pop-up menu. 

 Duration can be edited by moving the Onset and End cursors on the 
averaged trace. 

6.  Click the Add Results button to add the selected MUPs to the Results Table; 
the Results Table is then displayed automatically. 

 

MMUA Results view.  18 MUPs have been acquired for this muscle. 

7.  The Results Tab 

The Results Tab shows the averaged trace for each MUP and a cumulative 
table of MUP measurements. Purple traces indicate non-polyphasic MUPs, 
orange traces indicate polyphasic MUPs (>4 phases).  The total number of 
MUPS and the percentage of polyphasic MUPs for the muscle are shown at 
top of the table.  The bottom rows of the table show the mean & standard 
deviation calculations for All MUPs and for MUPs with only four or less 
phases. 

 Description of Table Entries 

Run # - the first number designates the EMG Buffer that was analyzed, 
the second number specifies the MUP bin number. 
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# Samples - the number of individual motor unit potentials that were 
sorted into this bin and contributed to the averaged trace. 

Amplitude (peak to peak, uV) - the amplitude of the MUP trace, 
measured in microvolts. 

Duration (ms) - the duration of the MUP trace, measured in 
milliseconds between the onset and end cursors. 

Phases - the number of baseline crossings plus one, between the 
onset and end cursors. 

Turns - the number of times the potential changed direction, by at 
least 50 uV, measured between the onset and end cursors. 

Frequency (Hz) - the firing rate of the motor unit potential, measured 
in cycles per second, or hertz.  Firing rate accuracy is better with 
increasing number of samples. 

Thickness - the Area / Amplitude ratio, typically decreased in 
myopathy. 

Size Index - calculated as 2 x Log10 (Thickness). 

 Bins can be combined using the same method that is described above 
for the Analyze tab. 

 Bins can be deleted by selecting the bin and then clicking the Delete 
Selected Bins button.  A selected bin has a blue box drawn around it. 

 Double clicking on a bin will open that bin in a larger window, called the 
Zoom window.  The Zoom window allows for easier viewing or 
adjustment of cursors.  You can right-click on the zoom window and 
choose to overlay or raster the individual traces within that bin. 
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MMUA Results Tab and Zoom Window for bin 3-1. 

8.  Click the Done button.  The MMUA window is minimized. 

An MMUA node is now shown in the Study window for the tested muscle. 
 Clicking on this node will re-display the Results Table. 

 

Study window showing MMUA node for the Right Abd Poll Brev muscle. 

 MMUA is still enabled.  If you record new EMG the analysis will 
automatically pop-up when the EMG is stopped.  Analysis will also 
automatically occur if you click on a different stored buffer in the Study 
window. 
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9.  Record additional EMG or select another stored EMG Buffer from the 
Study window.  Repeat until 20-30 MUPs are obtained for the muscle under 
investigation. 

10.  Turn Off Multi-Motor Unit Analysis. 

To turn MMUA off, perform one of the following. 

 Press the F9 function key on the PC's keyboard. 

 Click on the MMUA button on the Wave's PC Function Key menu. 
 To enable the function key menu click on the View menu, then 
select PC Function Menu. 

 De-select Multi-Motor Unit Analysis in the Analysis menu. 

 

MMUA Setup Options 

To access the MMUA Setup options, click the Setup button while viewing the 
Analyze Tab. 

 

MMUA Setup 

Needle Type – documents the needle type in the results table. 

Auto Analyze – when checked, the program automatically analyzes the 
last 10 seconds of the EMG buffer. 

Auto Add Results – when checked, the program will automatically add all 
sufficient MUPs to the results table. 

 

Extractor Settings button: 

Clicking the Extractor Settings button opens the MUAP Extract Setup window. 
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MMUA Extraction Settings 

Match Criteria: 

The Cadwell and RMSE (Root Mean Square Error) extractor routines are 
part of the template matching algorithm used to calculate how closely a 
candidate MUAP compares to and matches a template MUAP. The 
smaller the error between the candidate and the template, the closer the 
match. 

The Cadwell method compares the candidate and template by computing 
a sum of differences, point by point, between the two and then divides this 
sum by the integrated area under the template MUAP. This method takes 
into account the individual point differences and the overall size and shape 
of the MUAPs.  This is the factory default setting. 

The RMSE method calculates how much the candidate deviates from the 
template by computing the sum of the squared differences, point by point, 
between the two and then taking the square root of the sum. This is 
closely related to statistical standard deviation. 

The slider bars can be used to increase (tighten) or decrease (loosen) the 
amount of acceptable error between the template and the candidate. 

Printing MMUA Results 

MMUA results can be included in reports by either of the methods described 
below. 
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Method #1:  Automatic using a designated QuickReport template. 

Launch QuickReport and select a template that contains the report items 
needed in order to include the MMUA results.  The factory default template 
"MMUA Report" is one example. 

 The two report items needed in the template are the Sierra item "MMUA 
Tables" and the Sierra item "MMUA Waves". 

 

Method #2:  Manual copy & paste into a report. 

To Copy & Paste the trace bins: 

From the MMUA Results Tab 

 Right click over any one of the MUP traces. 

 From the pop-up menu, select Copy All Bins. 

 Start QuickReport or Word. 

 Right click within the report document and select Paste. 

To Copy & Paste the results table: 

From the MMUA Results Tab 

 Right click over any row in the Results Table. 

 From the pop-up menu, select Copy. 

 Start QuickReport, Word, or Excel. 

 Right click and select Paste. 

Deleting MMUA Results 

To delete the MMUA results for a muscle: 

 Right click over the MMUA node in the Study window. 

 From the pop-up menu, select Delete. 

 Click OK to the warning message that is displayed. 
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MMUA References 

Quantitative Analysis: Objective and Interactive Assessment in Electromyography. 

Sanjeev D. Nandedkar and Paul E. Barkhaus 

Clinical Evaluation and Diagnostic Tests for Neuromuscular Disorders, Chapter 12 

Edited by Tulio E. Bertorini 

Butterworth Heinemann Publisher, 2002 

 

Quantitative Motor Unit Potential Analysis 

Erik Stalberg, Sanjeev Nandedkar, Donald B. Sanders, Bjorn Falck 

Journal of Clinical Neurophysiology 

13(5): 401-422 Lippincott Raven Publishers, Philadelphia, 1996 

 

Reference Values of Motor Unit Action Potentials Obtained with Multi-MUAP Analysis 

Christian Bischoff, MD, Erik Stalberg, MD, Bjorn Falck, MD, and Karin Edebol EEG-Olofsson. 

Muscle & Nerve, 17:842-851 

August 1994 

 

Multi-MUP EMG Analysis in Clinical Routine 

B. Falck, E. Stalberg, S. Stalberg, M Astrom 

Neur. Neurochir. Pol. 1996, T. 30 (XLVI), SUPL 3. 

 

Multi-MUP EMG Analysis – a two year experience in daily clinical work 

E. Stalberg, B. Falck, M. Sonoo, S. Stalberg, M. Anstrom. 

Electroencephalography and Clinical Neurophysiology 

97(1995) 145-154 

 

Multi-Motor Unit Action Potential Analysis (MMA) 

Sanjeev D. Nandedkar, PhD, Paul E. Barkhaus, MD, and Alison Charles, BA 

Muscle & Nerve  18:1155-1166 

October 1995 
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Quantitative Analysis of Individual Motor Unit Potentials:  A Proposition for Standardized 
Terminology and Criteria Measurement 

Erik Stalberg, Steen Andreassen, Bjorn Falck, Heikki Lang, Annelise Rosenfalck, and Werner 
Trojaborg 

Journal of Clinical Neurophysiology 

3(4):313-348, Raven Press, New York, 1986 

 

Automatic Decompositon Electromyography (ADEMG) - Methodologic and Technical 
Considerations 

Kevin C. McGill and Leslie J. Dorfman 

Computer-Aided Electromyography and Expert Systems 

Chapter 7 

1989, Elesvier Science Publishers 

 

A New Approach to Quantitative Electromyography 

Nandedkar, S.D.: Wells, E.O.; Robertson, C.D. 

Technical Applications Bulletin Sheet 

Teca Corporation, March 1994 
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EMG Single Motor Unit Analysis (SMUA) 

Performing Single Motor Unit Analysis 

Single Motor Unit Analysis (SMUA) is an extension of the EMG Capture mode 
and allows captured motor units to be averaged and quantified.  The program 
automatically places cursors on the averaged motor unit response and calculates 
the following measurments; Rise Time, Amplitude, Duration, Area, Phases, 
and Turns.  Multiple runs can be performed on a muscle with the mean and 
standard deviation automatically computed for all the measurements. 

 

Follow these steps for performing SMUA Analysis: 

1.  Select the EMG  Test:   

 If a Study has already been selected, simply click on an EMG muscle 
name (i.e., Right Deltoid) within the Study window or turn Knob #1 (Study 
Item) to highlight the muscle name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual EMG test protocol from the Study/Test menu, a 
muscle list will be displayed allowing you to pick the muscle or muscles 
that you will be testing on the patient. 

2.  Activate SMUA Analysis mode. 

Enable SMUA Analysis by performing one of the following. 

 Press the F8 function key on the PC's keyboard. 

 Click on the SMUA button on the Wave's PC Function Key menu. 
 To enable the function key menu click on the View menu, then 
select PC Function Menu. 

 Select Single Motor Unit Analysis from the EMG Analysis menu. 

The display will change to show the SMUA Table window in the location 
normally occupied by the Muscle Score Table window. 

 If you were in Live EMG mode the program will automatically switch to 
Capture mode when SMUA Analysis is selected. 

3.  Position the needle electrode within the muscle. 

4.  Set the capture buffer Count value. 

The Count value is the total number of traces that can be collected in the 
SMUA trace buffer.  When a motor unit potential crosses the Trigger Line the 
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trace is added to the trace buffer and the Capture number is incremented by 
one.  The Count can be set to 10, 20, 30, or 50.  This setting is located in the 
EMG Controls window and can be easily changed using the mouse. 

 

5.  Adjust the Gain and Sweep Speed. 

Adjust the Gain setting so that motor unit potentials do not clip at the top or 
bottom.  Adjust the Sweep Speed setting so that an individual motor unit 
potential can be displayed, typically 2 - 5 ms/Div. 

During EMG data acquisition you can easily adjust the Gain and Sweep 
Speed by using Knob #4 (Gain / Sweep) on the Sierra Wave base unit. 
 Simply turn the knob to adjust the gain, to change the sweep speed, press 
the knob first to toggle it to the sweep mode, then turn to change the sweep 
speed. 

You can also use the mouse to change these settings in the EMG Controls 
window or Controls Toolbar. 

6.  Adjust the Trigger Level 

In SMUA mode a voltage level trigger and delay marker are displayed within 
the Trace window.  The level of the voltage trigger can be adjusted using 
Knob #3 (Trigger Lvl).  When EMG activity exceeds the trigger level (in 
either the negative or positive direction) the capture count is incremented and 
the sweep is captured momentarily and is repositioned with the crossing point 
at the delay marker.  This allows for easier visualization of motor unit 
potentials. 

Pressing Knob #3 will activate the Dual Trigger feature.  In this mode there 
will be two trigger level markers displayed within the trace window.  Only 
motor unit potentials that exceed the lower trigger level but do not exceed the 
top trigger level will be captured.  This allows small amplitude motor units to 
be captured in the presence of larger amplitude motor units. 

7.  Capture Motor Unit Potentials 

Acquire motor unit potentials until the buffer Count is reached.  The Clear key 
can be used to reset the buffer count to zero at any time. 
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SMUA Capture mode with Trigger Level marker and Delay at third division. 
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SMUA Capture mode with Capture Window enabled.  For more information on the Capture 
Window, click here. 

8.  Stop Data Acquisition 

Press the Run/Stop key on the Sierra Wave base unit to stop data 
acquisition.  This will change the display to the Data Analysis mode.  The 
captured traces will be displayed in a rastered format with the resulting 
average trace displayed at the top in blue color.  Cursors are automatically 
placed on the averaged trace. 

The cursors are Onset (O), Spike Onset (SpO), Peak (P), Peak End (PE), 
and End (E). 
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SMUA, data acquisition stopped, average of rastered traces shown at top. 

9.  Review the Captured Traces and Adjust Cursors. 

Knob #4 (Trace Sel /Delete) can be used to delete artifacts from the capture 
buffer.  Simply turn the knob to select the trace, when selected the trace will 
be displayed in yellow color, press the knob to delete the selected trace.  The 
averaged trace is automatically updated as soon as any captured trace is 
deleted. 

If necessary, use the mouse to adjust the SMUA cursor positions.  Simply 
click on a cursor and drag it along the averaged trace to a new position. 

The SMUA Table will display the measurements for the averaged motor unit. 
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SMUA Table window. 

 Run - displays the run number. 

 Rise (ms) - displays the rise time of the motor unit potential, this is 
the time (in milliseconds) between the spike onset (SpO) and the 
peak (P) cursors. 

 Amp (uV) - displays the amplitude of the motor unit potential (in 
microvolts), this can be measured from the spike onset (SpO) to the 
peak (P) or from the peak (P) to the peak end (PE) whichever is 
larger. 

 Dur (ms) - displays the duration of the motor unit potential, this is 
the time (in milliseconds) between the onset (O) and the end (E) 
cursors. 

 Area (mVms) - displays the full rectified area of the motor unit 
potential (in millivolt milliseconds) betwen the onset (O) and end (E) 
cursors. 

 Phases - displays the number of phases in the motor unit potential. 
 This is calculated as the number of baseline crossings plus one. 

 Turns - displays the number of turns in the motor unit potential.  A 
turn is any change in direction of the signal that exceeds 50 uV 
between the onset (O) and end (E) cursors. 

 Thickness - the Area / Amplitude ratio, typically decreased in 
myopathy. 

 Size Index - calculated as 2 x Log10 (Thickness). 

 Traces Stored - a "Yes" indicates that the captured traces for the 
run have been stored. 

 Avg. Trace Stored - a "Yes" indicates that the averaged motor unit 
trace and the measurements associated with it have been stored. 
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The Mean and Standard Deviation values are automatically calculated 
and updated as new runs are added to the SMUA Table. 

10.  Store the SMUA results. 

Press the Store key on the Sierra Wave base unit to keep the run (i.e., keep 
the averaged trace and measurements), by default all the captured traces for 
the run are stored as well.  In the SMUA Table the "Traces Stored" and "Avg. 
Trace Stored" fields for the current run will change from No to Yes. 

 As each SMUA run is stored, you will see a new "node" appear in the 
Study window below the muscle name.  The example below shows four runs 
stored for the Right Deltoid muscle.   

 

 If  you decide not to keep the run, do not press the Store key, simply 
return to the Acquisition mode by pressing the Run/Stop key and the run will 
be discarded. 

11.  Return to Data Acquisition mode and acquire additional motor unit 
potentials. 

Press the Run/Stop key to return to Acquistion mode and repeat steps 6 - 
10 to acquire additional SMUA runs for the muscle.  Up to 20 runs can be 
acquired per muscle. 

12.  To Exit from SMUA mode. 

To return to Live EMG, perform one of the following. 

 Press the F8 function key on the PC's keyboard. 
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 Click on the SMUA button on the Wave's PC Function Key menu. 
 To enable the function key menu click on the View menu, then 
select PC Function Menu. 

 Select Analysis Off from the EMG Analysis menu. 

Knob & Fkey Controls (SMUA) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether SMUA data acquisition is running or stopped. 
 The functions also change when Cursor mode is enabled. 

 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 

 

Data Acquisition mode: 

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Muscle Sel  - turn this knob to highlight a different muscle name within the 
EMG test protocol in the Study window. 

Trigger Lvl / Dual Trig - defaults in Trigger Lvl mode, turn this knob to 
move the trigger level indicator up or down within the Trace window. 
 Press this knob to activate the Dual Trigger mode.  In Dual Trigger mode 
the trace will be captured if it falls between the two trigger level indicators 
(useful for capturing small amplitude motor units in the presence of large 
amplitude motor units) 

Gain / Sweep - this knob defaults to the Gain mode and can be used to 
increase or decrease the gain (uV/Div) of the Trace window.  Press the 
knob to switch to Sweep mode and turn to adjust the sweep speed 
(ms/Div) of the Trace window. 

The Gain and Sweep will automatically reset to default values 
when a new muscle is selected in the Study window. 
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F Keys 

 

Live / Capture - press this function key to switch back and forth between 
Live or Capture acquisition modes.  For SMUA, capture mode should be 
selected. 

Fibs / Recrt - press this function key to switch back and forth between 
Fibs and Recrt parameter settings.  You can program different Gain and 
Sweep Speed parameters for these two modes and use this function key 
to easily toggle between the two. 

This function key will automatically reset to the Fibs mode when a 
new muscle is selected in the Study window. 

Muscle List - opens the EMG Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData Summary window. 

 

Data Acquisition Stopped: 

Knobs 

 

Run Select - turn this knob to highlight and review stored runs in the MUA 
Table.  When the run is highlighted the traces for that run will be displayed 
in the trace window. 

Muscle Sel  - turn this knob to highlight a different muscle name within the 
EMG test protocol in the Study window. 

Start Trace / Trace Cnt - this knob effects how the traces in the SMUA 
capture buffer are displayed.  Turn the knob to change the starting display 
trace number.  Press the knob, then turn to change the trace count 
number. 

Here's an example of how to use the Trace Cnt and Start Trace 
settings to view subsets of the capture buffer: 

Assume there are 50 total traces in the capture buffer.  The Trace Cnt 
will default to 50 and the Start Trace number will default to 1. 
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 Therefore all 50 traces (1 to 50) are displayed in the Trace window. 
 Now, change the Trace Cnt to 20 and leave the Start Trace number at 
1.  You will see traces 1-20 displayed in the Trace window.  You can 
now change the Start Trace number to 21, now you can view traces 
21-40.  Change the Start Trace number again and it goes to 41, now 
you can view traces 41-50. 

Trace Sel / Delete - defaults to the Trace Sel mode, turn this knob to 
select a captured trace.  When selected, the trace will be displayed in 
yellow.  Press the knob to Delete the selected trace from the capture 
buffer. 

F Keys 

 

Raster / Overlay - press this function key to toggle between displaying 
captured EMG traces in raster or overlay (i.e., superimposed) modes. 

Muscle List - opens the EMG Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData summary window. 

 

Cursor Mode: (data acquisition stopped) 

Knobs 

 

Select Cur / Move Cur - this knob defaults to the Select Cursor mode 
and can be used to move the focus (yellow triangle) to any cursor on the 
averaged SMUA trace.  Press this knob to switch to Move Cursor mode 
which will allow you to move the selected (green triangle) cursor. 

Gain - turn this knob to change the gain of all the traces in the trace 
window.  The current gain setting for the window is displayed on the knob 
icon. 

F Keys 
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AutoPlace Cursors - press this function key to re-apply the auto-cursor 
algorithm to the averaged SMUA trace. 

 

SMUA Cursors 

Cursors are automatically placed on the averaged SMUA trace.  The cursors are 
Onset (O), Spike Onset (SpO), Peak (P), Peak End (PE), and End (E). 

 

 

SMUA averaged trace. 

 

To adjust the positions of the Cursors, follow one of these procedures. 

 Using the Knobs - press the F5 (Cursor) function key on the PC's 
keyboard.  The program's knob and function keys will change to reflect 
the cursor mode controls.  Use Knob #1 (Sel Cursor / Move) to select 
and move the desired cursor. 

After cursor positions have been adjusted, press the F5 (Cursor) 
function key again or press the OK key on the Sierra Wave base unit 
to exit from Cursor mode. 

 Using the Mouse - simply click on the Cursor you want to move with 
the left mouse button and drag the cursor along the trace to its new 
location.  

Measurements in the MUA Table are updated automatically when the cursor 
positions are changed. 
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Storing SMUA Results 

Press the Store key on the Sierra Wave base unit to keep the SMUA run (i.e., 
keep the averaged trace and measurements), by default all the captured traces 
for the run are stored as well.  In the SMUA Table the "Traces Stored" and "Avg. 
Trace Stored" fields for the current run will change from No to Yes. 

 As each SMUA run is stored, you will see a new "node" appear in the 
Study window below the muscle name.  The example below shows four runs 
stored for the Right Deltoid muscle.   

 

 

Deleting a Run 

To Delete a stored SMUA run, follow these steps. 

 Right click the mouse over the Run # you want to delete in the Study 
window. 

 From the pop-up menu, select Delete. 

 A confirmation message will be displayed, click OK. 

 The Run is deleted and the mean and standard deviation values in the 
MUA Table are automatically re-calculated. 
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EMG Guidance 

EMG Guidance Basics 

Select the EMG Guidance  Test:   

 If a Study has already been selected, simply click on an EMG Guidance 
muscle name (i.e., Right Deltoid) within the Study window or turn Knob #1 
(Study Item) to highlight the muscle name.  Notice that as soon as any 
muscle is selected within the EMG Guidance test protocol, all the muscles 
are automatically added to the muscle injection table. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual EMG Guidance test protocol from the Study/Test 
menu, a muscle list will be displayed allowing you to pick the muscle or 
muscles that you will be testing on the patient.  Notice that as soon as any 
muscle is selected, it is displayed within the Study window and is 
automatically added to the muscle injection table. 

 The Automatic Log Muscle feature can be disabled in the EMG 
Guidance Test Setup window.  When this feature is disabled the muscles in 
the Study window are not automatically added to the muscle injection table. 
  You will need to use the F2 (Muscle Sel/Add to Log) knob or the Left 
mouse button to manually add the appropriate muscles to the injection table. 

 

Once the muscle has been selected.  Follow these steps for performing 
routine EMG Guidance data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate. 

Typical Settings for EMG Guidance 

Gain = 100 or 200 uV/Div 

Hicut = 10k Hz 

Locut = 10 - 30 Hz 

Sweep Speed = 10 ms/Div 

2.  Verify the Side 

Make sure the appropriate side, Right or Left, is selected. 

3.  Insert the Needle Electrode 
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4.  Adjust Volume 

Increase or decrease the Sierra Wave's internal speaker by using the Volume 
Knob on the left hand side of the base unit. 

5.  View Live EMG 

Free-running EMG is displayed in the Trace window and a compressed view 
of the EMG Live Buffer is displayed below this.  A moving blue marker shows 
the current position within the buffer.  At any time data acquisition can be 
stopped and the data in the Live Buffer can be reviewed or played back (see 
step #7 below). 

 

EMG - Live mode 

6.  Adjust Gain & Sweep 

During EMG Guidance data acquisition you can easily adjust the Gain and 
Sweep Speed by using Knob #4 (Gain / Sweep) on the Sierra Wave base 
unit.  Simply turn the knob to adjust the gain, to change the sweep speed, 
press the knob first to toggle it to the sweep mode, then turn to change the 
sweep speed. 

You can also use the mouse to change these settings in the Controls 
Toolbar. 

7.  Stop Data Acquisition and Review (optional) 

To stop data acquisition press the Run/Stop key on the Sierra Wave base 
unit. 
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Stopped Live EMG: 

Review the Live Buffer - move backwards and forwards in the Live 
EMG buffer by turning Knob #1 (Review / Play-Stop), press the knob to 
replay the buffer.  You can also review by dragging the blue marker back 
and forth within the compressed buffer area using the mouse. 

 

EMG - Stopped Live mode 

Store a Snapshot - press the F1 (Store Snap Shot) function key or the 
Store key on the Sierra Wave base unit to store the currently displayed 
sweep.  The stored sweep will be displayed in purple. 

Store the entire Live Buffer - press the F2 (Store Live Buffer) function 
key.  The trace will be displayed in blue indicating that the entire buffer 
has been stored. 

 Prior to storing any EMG traces, Use Knob #2 (Muscle Sel) to 
highlight the correct muscle name in the Study window.  This will ensure 
that the EMG data will be stored with the correct muscle name. 

 As EMG is stored, you will see a new node appear in the Study 
window below the muscle name.  This indicates what has been stored for 
this muscle.  The example below shows a Snapshot stored for the Right 
Abd Poll Brev muscle, and a Live Buffer stored for the Right ExtDigCom 
muscle. 
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Example of stored EMG Guidance nodes in the Study window. 

 

8.  Return to Data Acquisition Mode 

If you stopped data acquisition, press the Run/Stop key on the Sierra Wave 
base unit to resume data acquisition. 

9.  Stimulate through the Needle Electrode (optional) 

In some cases the muscle can be better localized by stimulating through the 
injectable needle while simultaneously recording surface EMG over the 
intended muscle. 

 Connect the injectable needle electrode to the cathode (-) of the 
electrical stimulator. 

 Connect a surface electrode to the anode (+) of the electrical 
stimulator. 

 Place surface electrodes over the intended muscle and connect to 
Act 1 and Ref 1 on the amplifier. 

 Press the Stim button on the electrical stimulator to deliver a single 
stimulus, or press the F1 (Stim OFF / Stim ON) function key to initiate 
repetitive stimulation, through the injectable needle. 

 Adjust the stimulus intensity using the wheel on the electrical stimulator 
or Knob #3 (Intensity / Pulse Width). 

 The surface recorded EMG will be displayed in both the Live EMG 
window and the Triggered EMG window.  The Triggered EMG 
window is only activated when the electrical stimulation is enabled. 
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Triggered EMG window. 

The Triggered EMG window has a 1 division sweep delay. 

10.  Inject the Muscle. 

Please refer to the appropriate guide for the amount of Botox or Myobloc 
to inject. 

11.  Modify Muscle Injection Table 

With the Automatic Log Muscle feature enabled, as soon as a muscle is 
selected in the Study window, or added to the Study window using the F3 
(Muscle List) function key, it is automatically added to the Muscle Injection 
Table. 

To change the muscle injection data for a muscle: 

 Turn Knob #3 (Score Table / Modify) until the highlight is over the 
field that you want to change, press the knob to pop up a list of 
choices, turn the knob to highlight one of the choices and press again 
to select it. 

 Using the left mouse button, click on the field that you want to 
change.  From the pop up list of choices click again to make a 
selection. 

 

Muscle Injection Table 
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12.  Select Next Muscle 

Turn Knob #2 (Muscle Sel / Del from Log) to highlight the next muscle in 
the Study window.  If the muscle you want to examine is not displayed within 
the Study window, press F3 (Muscle List) and select the muscle from the list. 

Move the Needle Electrode to the new muscle and repeat the above steps as 
necessary. 

 It is a good idea to turn Off the preamplifier or turn down the Volume 
when moving the needle electrode to a new location. 

13.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Injection table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected tests traces 
and cursor information will be displayed on the right hand side of the window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

14.  Next Test 

 Use Knob #1 (Study Item) to highlight another Test Protocol in the 
Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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EMG Guidance Test Setup 

EMG Guidance test setup options are discussed in detail in the Test Protocol 
Setup chapter of the Help system. 

Click here to go to this topic. 

Amplifier / Stimulator Switch Box 

EMG guidance can be utilized to help the clinician accurately localize the muscle 
or nerve injection site and to monitor activity after the delivery of the medicinal 
product.  Guidance can be in the form of live EMG activity & audio from the 
injection needle or by electrical stimulation through the injection needle. 

For live EMG guidance the hypodermic needle is connected to the EMG 
amplifier‟s (-) input with a reference electrode placed on the surface and 
connected to the amplifier‟s (+) input. 

For Electrical Stimulation guidance the hypodermic needle is connected to the 
cathode (-) of the electrical stimulator with the reference electrode connected to 
the anode (+). 

The Cadwell Amp/Stim Switch Box eliminates the need to manually move the 
injection needle and reference electrode from the amplifier to the electrical 
stimulator.  A 2-position switch allows the injection needle & reference electrode 
to be routed to either the amplifier or stimulator inputs. 

 

Top view of Amp/Stim Switch Box, switch in the Record position. 
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Ordering Information: 

The Amp/Stim Switch Box Kit (Part number 9732022) contains the following 
items: 

QTY DESCRIPTION PART NUMBER 

1 Amp/Stim Switch Box 190266-200 

2 Interconnect Cable, 24 inch, 
Red & Black Twisted, 1.5 mm 
safety DIN each end. 

302785-000 

1 Amp/Stim Switch Box 
Instructions 

190266-620 

 

Diagram of Connections: 

 

Connect the injection needle to the ACT (black) input on the switch box.  Connect 
the recording reference electrode to the REF (red) input on the switch box. 
 Connect the patient ground electrode to the amplifier‟s ground input. 

Remove the probes from the end of the stimulator; this is done by pulling them 
straight out.  Connect the first interconnect cable from the black and red STIM 
inputs on the switch box to the cathode (-) and anode (+) of the electrical 
stimulator respectively.  The Cathode is indicated by the green LED. 
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Connect the second interconnect cable from the black and red TO AMP inputs on 
the switch box to the amplifier‟s channel 1 Active and Reference inputs 
respectively. 

Position the Amp/Stim Switch Box, Electrical Stimulator, and Amplifier in a 
convenient location. 

Start with the Switch Box in the RECORD position. 

 

Operation of the Amp/Stim Switch Box: 

For live EMG – set the switch to the RECORD position. 

For electrical stimulation – set the switch to the STIM position, and then enable 
electrical stimulation and adjust the stimulation current.  Note: In the Stim 
position the recording inputs are shorted. 

    This device does not provide patient isolation. 

   This device is not intended for patient contact. 

Storing a Live Snapshot 

1. Stop EMG Guidance data acquisition by pressing the Run/Stop key on the 
Sierra Wave base unit. 

Data acquisition will be stopped and the last complete sweep of EMG 
Guidance data will be displayed. 

2. Move backward or forward within the EMG Guidance buffer until the trace 
that you want to store is displayed. 

3. Verify that the correct muscle name is highlighted in the Study window.  If 
necessary, use Knob #2 (Muscle Sel / Del from Log) to highlight a different 
muscle name. 

4. Store the snapshot by performing one of the following actions, 

 Press the F1 (Store Snap Shot) function key on the Sierra Wave 
base unit. 

 Press the Store key on the Sierra Wave base unit. 

 Press the Store button on the Electrical Stimulator handle. 

5. The stored EMG Guidance snapshot will be displayed in purple color and an 
entry will appear underneath the currently selected muscle name in the Study 
window. 
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Study window showing stored EMG snapshot for the Right Abd Poll Brev muscle. 

6. Return to EMG Guidance data acquisition mode by pressing the Run/Stop 
key on the Sierra Wave base unit. 

   If the Confirm Store Commands option is enabled for the EMG Guidance 
test protocol, the program will display a confirmation window whenever a 
Live Snapshot or Live Buffer are stored.  This ensures that the data is 
stored with the correct muscle name and side and provides a place for a 
comment to be entered as well. 

 

 

Storing a Live Buffer 

1. Stop EMG Guidance data acquisition by pressing the Run/Stop key on the 
Sierra Wave base unit. 

Data acquisition will be stopped and the last complete sweep of EMG 
Guidance data will be displayed. 

2. Verify that the correct muscle name is highlighted in the Study window.  If 
necessary, use Knob #2 (Muscle Sel / Del from Log) to highlight a different 
muscle name. 
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3. Store the EMG Guidance Buffer by pressing the F2 (Store Live Buffer) 
function key on the Sierra Wave base unit. 

4. The EMG Guidance  trace color will change from white to light blue to 
indicate that the buffer has been stored and an entry will appear underneath 
the currently selected muscle name in the Study window. 

 

Study window showing stored buffer for Right ExtDigCom muscle. 

5. Return to EMG Guidance data acquisition mode by pressing the Run/Stop 
key on the Sierra Wave base unit. 

   If the Confirm Store Commands option is enabled for the EMG Guidance 
test protocol, the program will display a confirmation window whenever a 
Live Snapshot or Live Buffer are stored.  This ensures that the data is 
stored with the correct muscle name and side and provides a place for a 
comment to be entered as well. 

 

 

Deleting a Snapshot or Buffer 

1. Right click the mouse over the stored Snapshot, Live Buffer, or 
Capture run in the Study window. 
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2. From the pop-up menu select Delete. 

 

Right click and select Delete. 

3. A confirmation message will be displayed, select OK. 

 

 

 

Muscle Injection Table 

EMG Guidance Muscle Injection Table 

With the Automatic Log Muscle feature enabled, as soon as any EMG 
Guidance muscle is selected within the Study window, or is added to the 
Study window using the F3 (Muscle List) function key, it is automatically 
added to the Muscle Injection Table. 

 The Automatic Log Muscle feature can be disabled in the EMG 
Guidance Test Setup window.  When this feature is disabled the muscles in 
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the Study window are not automatically added to the muscle injection table. 
  You will need to use the F2 (Muscle Sel/Add to Log) knob to manually add 
the appropriate muscles to the injection table. 

 

Modifying Injection Data 

To change the Injection Data for a muscle, 

 Turn Knob #3 (Score Table / Modify) until the highlight is over the 
scoring field that you want to change, press the knob to pop up a list 
of choices, turn the knob to highlight one of the choices and press 
again to select it. 

 Using the left mouse button, click on the scoring field that you want to 
change.  From the pop up list of choices click again to make a 
selection. 

 

Muscle Injection Table 

Deleting a Row from the Muscle Injection Table 

To delete a row from the Muscle Injection Table, perform one of the following. 

 Turn Knob #2 (Muscle Sel / Del from Log) until the muscle you want 
to remove from the Muscle Injection Table is highlighted in the Study 
window, then press the knob and the corresponding row in the table 
will be deleted. 

 Right click the mouse over the row you want to delete, then select 
Delete Row from the pop-up menu. 

 When a muscle is deleted from the Muscle Injection Table the 
checkmark next to the muscle name in the Study window is also removed. 
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Deleting all Rows from the Muscle Injection Table 

To delete all rows from the Muscle Injection Table, perform one of the 
following. 

 Turn Knob #2 (Muscle Sel / Delete from Log) until the muscle name 
you want to remove from the Muscle Injection Table is highlighted in 
the Study window, then press the knob to delete the row.  Repeat this 
process until all the rows are deleted. 

 Right click the mouse over any row in the Muscle Injection Table, then 
select Delete All Rows from the pop-up menu.  A confirmation 
message will be displayed, select OK. 

 When a muscle is deleted from the Muscle Injection Table the 
checkmark next to the muscle name in the Study window is also removed. 

 

Adding a Muscle that has been deleted from the Muscle Injection 
Table 

To add one muscle, perform one of the following. 

 Turn Knob #2 (Muscle Sel / Add to Log) to highlight the muscle 
name in the Study window.  Press the knob to add the muscle to the 
injection table. 

 Right click the mouse over the muscle name in the Study window. 
 From the pop-up menu select Score Muscle Normal. 

To re-add all muscles. 

 Right click the mouse over any muscle name in the Study window. 
 From the pop-up menu select Score All Muscles Normal. 

 

Sorting the Muscle Injection Table 

Initially, the muscles are added to the injection table in the same order that 
they are listed in the Study window. 

Single click on the column heading (e.g. # Sites Injected) to sort the table 
by the entries in that column.  Sorting priority is first by number (0-9), then 
alphabetically (a-z). 
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Restoring Original Sort Order 

Right click the mouse on any row in the Muscle Injection Table and select 
Original Sort Order from the pop-up menu. 

 

Table Font Size 

In all test protocols the font size of the Table window can be increased or 
decreased.  Simply right click on the table and select Font Size from the pop-up 
menu.  The choices are Small (default), Medium, Large, and Extra Large. 

 

Changing the font size of the Muscle Injection Table. 

 

Swap Sides 

To swap the side parameter on a muscle, perform one of the following. 

 Right click the mouse over the muscle name in the Study window. 
 From the pop-up menu select Swap Sides, Left/Right. 

 Right click the mouse over the corresponding row in the Muscle 
Injection Table.  From the pop-up menu select Swap Sides, Left /Right. 

 If the muscle was listed only once  in the Study window, then it will be 
swapped to the opposite side. 

 If the muscle was listed in the Study window twice, as a right sided 
muscle and as a left sided muscle, then both the entries will have their side 
parameter swapped.  You can never have more than one Right or Left sided 
muscle in the Study window. 
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 If the muscle being swapped contains stored data (i.e., a snapshot or 
buffer), the data is also moved to the opposite side. 

 

Change Sides 

Changing the Side parameter for a muscle is different than Swapping Sides. 
 When you change sides, the highlight moves from the currently selected muscle 
in the Study window (e.g. Right Abd Poll Brev) to the same muscle but with the 
opposite side (e.g., Left Abd Poll Brev). 

If the muscle corresponding to the selected side is not listed in the Study window, 
it is automatically added to the window. 

 

To change the side parameter: 

In the EMG Guidance Controls Toolbar, click the down arrow for the Side 
parameter control.  Select the appropriate side from the drop-down list. 

 

 

Graticule Size 

The EMG Guidance Trace window is divided into a grid pattern using vertical and 
horizontal divisions or graticules.  The grid pattern can be changed by altering 
the number of these divisions. 

 

To Change the EMG Guidance Trace window Graticule Size during 
an exam: 

 Right click on the EMG Guidance Trace window. 

 From the pop-up menu, highlight Graticule Size, a second level pop-up 
menu will be displayed. 
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 Choose one of the listed selections.  The first number is for the number of 
vertical divisions, the second number is for the number of horizontal 
divisions. 

 

Graticule size selections for EMG Guidance Trace window. 

 

Fast Refresh Rate 

This feature changes the drawing of the EMG Guidance trace so that it appears 
more like an oscilloscope display.  Simply right-click over the EMG Guidance 
Trace window and select Fast Refresh from the pop-up menu.  This setting adds 
a 2 division „gap‟ and updates the trace at 60 Hz.  When this setting is disabled 
the trace is drawn with no gap and refreshes at 15 Hz. 
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Enable Fast Refresh Rate for EMG Guidance trace. 

 

Saving Changes to EMG Guidance Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the EMG Guidance Test 
protocol. 

 Select Save Test Parameters from the Edit menu. 
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NCV 

NCV Basics 

This topic is a repeat of the basic NCV steps found in the Getting Started 
chapter. 

Select the NCV  Test:   

 If a Study has already been selected, simply click on a nerve name (i.e., 
Right Median Motor) within the Study window or turn Knob #1 (Study 
Item / Site) to highlight the nerve name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual NCV test protocol from the Study/Test menu, a 
nerve list will be displayed allowing you to pick the nerve or nerves that 
you will be testing on the patient. 

 

Once the nerve has been selected.  Follow these steps for performing 
routine NCV data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the nerve being tested. 

Typical Settings 

 Gain 
(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep 
Speed 

(ms/Div) 

Motor 
Nerves 

2k to 5k 10k 10 5.0 

Sensory 
Nerves 

10 to 20 2k 10 2.0 

 

2.  Verify Side Setting 

Make sure the appropriate side, Right or Left, is selected. 

3.  Verify Stimulation Sites and Segments 

The selected nerve's recording site name, stimulation site names, and defined 
segments are shown within the NCV Tables window. 
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Nerve name and recording site name. 

The Site table displays the stimulation site names, one per row.  This table 
will display the onset or peak latency, amplitude measurements, duration and 
area measurements, and normal values.  By default, the first stimulation site's 
row is highlighted as soon as the nerve is selected.  The name of this site 
also appears on the active (white) trace's label. 

 

Site table with third stimulation site selected. 

The Segment table displays the segments over which velocity calculations 
are to be made.  Each row in this table represents one segment.  This table 
has a column for entering distances and for displaying the calculated and 
normal velocity. 

 

Segment table. 

4.  Electrode Placement 

Attach the electrodes to the patient.   

5.  Check Stimulator Polarity 

For Nerve Conductions Studies, the Cathode (-) should be oriented closest 
to the recording electrodes. 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  

Clicking on the Polarity field in the NCV Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) 
mode has the right-side probe as the Cathode (if holding the stimulator with 
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the Stim button facing you and the probes up); the reversed state will make 
the left-side probe the Cathode.  The image of the stimulator on the screen 
updates to indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show 
the Right-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will 
show the Left-side probe as the Cathode (-).  The polarity field on the screen 
will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

6.  Stimulate the first Site 

Increase the stimulus intensity level by turning the wheel on the electrical 
stimulator handle.  The intensity  level (in milliamps) is displayed on the 
screen in a small pop-up window and also in the Stimulator section.  Once 
you have reached an appropriate starting intensity apply the stimulator to the 
patient and deliver the stimulus by pressing the Stim button on the electrical 
stimulator handle.  The stimulator light, located next to the intensity level on 
the Screen, will flash Green and the patient's response will be displayed. 
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 The Single key on the Sierra Wave base unit can also be used to deliver 
a single stimulus.  Intensity can also be adjusted using Knob #3 (Intensity / 
Pulse Width) on the base unit. 

Continue to increase the intensity level and stimulate until a supra-maximal 
response is acquired.  If the response is large and "clips" at the top or bottom, 
 decrease the amplifier sensitivity by adjusting the Gain setting.  For example, 
change gain from 2k to 5k and re-stimulate.  Gain can be adjusted easily by 
using Knob #4 (Gain /Sweep) on the Sierra Wave base unit. 

8.  If necessary, Adjust Auto Cursors 

Auto Cursors are placed on the response as soon as it is displayed.  The 
cursors are Onset (O), Peak (P), Trough (T) and Recovery (R).  The 
configuration of the Site and Segment tables determines which of the four 
cursors are placed on the trace.  The positions of these cursors can be 
adjusted by performing one of the following actions; 

 By using Knob #2 (Sel Cursor / Move Cursor) on the Sierra Wave 
base unit. 

 By clicking on them with the left mouse button and dragging them to 
their new position. 

For the correct placement of the auto-cursors the response must meet or 
exceed certain amplitude and slope criteria.  When these criteria are not met 
the cursors will be placed on the response in the following pattern. 

 

Pattern of auto-cursor placement when amplitude criteria is not met. 

The Peak (P) cursor will be positioned at the third division with the Onset (O) 
cursor placed one-quarter division in front and the Trough (T) and Recovery 
(R) cursors placed one-quarter and one-half division respectively following it. 
 If you believe that there is a response present you can move the cursors to 
their appropriate positions, or if there really is no response present, you can 
mark the response as "NR" in the Site table. 

9.  Store the Response 

To store the response and advance to the next stimulation site, perform one 
of the following actions; 
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 Press the Store button on the Electrical Stimulator handle. 

 Press the Store key on the Sierra Wave base unit. 

 Press the Footswitch pedal (assuming the pedal is programmed for 
the Store function). 

 Click the Store button in the NCV Controls window. 

When the response is stored the color of the trace changes from white to 
purple and the next row in the Site table is automatically highlighted. 

If the nerve has only one stimulation site, it is not necessary to store the 
response.  The Sierra Wave will automatically keep the trace when you 
change nerves or test protocols. 

10.  Stimulate and Store Additional Sites 

Continue to stimulate and store additional sites on the nerve. 

11.  Enter Distance to calculate Velocity 

Measure the distances for each segment and enter the values (in 
centimeters) into the segment table.  There are two ways to enter the 
distance. 

 Press the Distance key on the Sierra Wave base unit or click on 
the appropriate distance field with the mouse.  The first distance 
field will become activated and a small pop-up window is displayed 
showing the segment name and a place for the distance 
measurement, type the distance value and then press the Enter 
key.  You can also press the Distance key a second time instead of 
pressing the Enter key. 

 

Distance pop-up window. 



Protocols 

507 

 Press Programmable button #1 on the Electrical Stimulator 
handle.  A small pop-up window is displayed showing the segment 
name, distance value, and velocity.  Now, turn the wheel on the 
stimulator handle to increase or decrease the distance value in 
0.5 cm increments.  When the correct distance value is reached, 
press Programmable button #1 a second time or press the Enter 
key. 

 

Distance pop-up window. 

12.  Compare Left vs. Right side Data & Traces (optional) 

This feature allows for easy comparison of the latency, amplitude, and 
velocity differences between the left and right sides of a nerve.  It also allows 
for a visual comparison of the traces obtained for each side. 

Press the F10 - L/R Cmp function key to view the traces acquired for each 
side and a table of difference values. 

Normal values can be entered for the side-to-side difference measurements 
with abnormal values flagged by the program. 

Press the F10 - L/R Cmp function key a second time to return to the standard 
NCV display. 

13.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 
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Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

14.  Next Nerve or Test 

To advance to the Next Nerve: 

 Use Knob #1 (Study Item / Site) to highlight another NCV nerve in the 
Study window. 

 Click on another NCV nerve in the Study window using the mouse. 

 Press the F3 (Nerve List) function key on the Sierra Wave base unit 
and select another nerve from the nerve list. 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

Knob & Fkey Controls (NCV) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in normal Acquisition mode or has 
been switched to either Cursor or Position mode. 

 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 
 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 
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Acquisition mode  

Knobs 

 

Study Item / Site - in Study Item mode, turn this knob to highlight and 
load a different Test Protocol in the Study window.  In Site mode, turn this 
knob to select a site (by highlighting a row) within the NCV Site table. 

Sel Cursor / Move Cursor - this knob defaults to the Move Cursor mode 
and can be used to move either the Onset or Peak cursor on the active 
(white) trace.  Press this knob to switch to Sel Cursor mode which will 
allow you to move the focus (yellow triangle) to any cursor on any trace 
within the Trace window. 

Intensity / Pulse Width - this knob defaults to the Pulse Width mode and 
can be used to increase or decrease the electrical stimulus pulse width, 
the current value (in microseconds) is displayed on the knob icon.  Press 
this knob to switch to the Intensity mode and  turn to increase or 
decrease the stimulus intensity, the current intensity value (in milliamps) is 
displayed on the knob icon. 

Gain / Sweep - this knob defaults to the Gain mode and can be used to 
increase or decrease the gain (uV/Div) of the Trace window.  Press the 
knob to switch to Sweep mode and turn to adjust the sweep speed 
(ms/Div) of the Trace window. 

F Keys 

 

Distance - pressing this key will activate (highlight) the first distance cell in 
the NCV Segment Table.  Repeated pressing will activate other distance 
cells in the table.  Once a distance cell is activated you can type in the 
distance value for that segment. 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this key 
switches to Overlay mode which will superimpose all traces on top of one 
another. 

Nerve List - opens the Nerve List window which allows you to select and 
add nerves to your Study window. 
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TabData - opens the TabData Summary window. 

PC Function Keys (F5-F12) 

 

F5-Cursor - enables Cursor mode (see below). 

F6-Position - enables Position mode (see below). 

F7-Swap Sides - press to swap the side parameter for the nerve. 

F8-Sort Traces - press to sort the traces by increasing latency. 

F9-Avg On - press to enable the signal averager. 

F10-L/R Cmp - press to display the opposite side's traces and the Left vs. 
Right comparison tables for the nerve. 

F11-Upd. Traces - press to update the Site table based on the current 
position of the traces. 

F12-Clear All - press to delete all traces for the nerve. 

 

Cursor mode (F5) 

Knobs 

 

Select Cur / Move Cur - this knob defaults to the Select Cursor mode 
and can be used to move the focus (yellow triangle) to any cursor on any 
trace within the Trace window.  Press this knob to switch to Move Cursor 
mode which will allow you to move the selected (green triangle) cursor. 

Select Cur / On-Off - this knob defaults to the Select Cursor mode and 
can be used to move the focus (yellow triangle) to any cursor on any trace 
within the Trace window.  Press the knob to hide the selected cursor (turn 
the cursor Off) or bring it back to view (turn the cursor On). 

Sel. Trial - turn this knob to select an NCV trace.  When selected, the 
trace will be displayed in yellow. 

Gain - turn this knob to change the gain of the selected NCV trace.  The 
current gain setting for the trace is displayed on the knob icon. 
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F Keys 

 

AutoPlace Cursors - press this function key to re-apply the auto-cursor 
algorithm to the selected (yellow) trace. 

Clear Cursors - press this function key to clear all cursors from the 
selected (yellow) trace. 

All On / All Off - defaults to All On mode.  Press to hide all cursors on all 
traces. 

 

Position mode (F6) 

Knobs 

 

Sel. Trial / Move - defaults to Select Trial mode, turn this knob to select a 
stored NCV trace.  When selected, the trace will be displayed in yellow 
color.  Press the knob to switch to Move mode, then turn to move the 
selected trace up or down within the Trace window. 

Move Active - turn this knob to move the active (white colored) trace up 
or down within the Trace window. 

Sel. Trial / Delete - turn this knob to select a stored NCV trace.  When 
selected, the trace will be displayed in yellow color.  Press the knob to 
permanently delete the selected trace. 

Gain - turn this knob to change the Gain of the selected NCV trace.  The 
current gain setting for the trace is displayed on the knob icon. 

F Keys 

 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position settings.  Pressing this key 
switches to Overlay mode which will superimpose all traces on top of one 
another. 
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Smooth All - each time this key is pressed the traces will be passed 
through a digital smoothing algorithm.  Smoothing can be reversed by 
right-clicking the mouse on the Trace window and selecting Unsmooth All 
from the pop-up menu. 

 

NCV Test Setup 

NCV test setup options are discussed in detail in the Test Protocol Setup 
chapter of the Help system. 

Click here to go to this topic. 

Normal Values (NCV) 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the NCV test protocol in the test list.  The NCV test protocol 
settings will be displayed on the right hand side of the screen. 

In the Nerve List, select the nerve you want to make changes to. 

There are three methods for entering normal values; Simple Value Limit, 
Simple Value Limit by Age Group, or Prediction Equation. 

Method #1  Simple Value Limit:   

Click in the normal value field and type the desired value, then press Enter. 
 You can use symbols such as > (greater than) or < (less than) if you like. 

 

Method #2  Simple Value Limit by Age Group: 

Up to 8 Age Groups can be defined and normal values can be entered for 
each group.  The Sierra Wave program will compute the patient‟s age based 
on their date-of-birth and then use the appropriate age group norms. 

To define the Age Groups: 

1. Click on the Define Age Groups button. 
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2. Select the number of Age Groups, the maximum is 8. 

3. Fill in the upper age limit for each group, select years or months, 
and click OK. 

4. Select a Nerve from the nerve list. 

5. Check the Use Age Groups box.  This will enable the age groups 
drop-down list. 

  

6. Enter the normal values for this age group into the Site and Segment 
tables.  Repeat for each age group in the drop-down list. 

7. Select another nerve in the nerve list, repeat steps 5 and 6. 

If the patient's date-of-birth is not entered into the patient information 
window, the program will use the normal values entered for the All Ages 
group. 
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Method #3  Prediction Equation: 

Normal values can be predicted using the patient‟s Age and Height. Click 
on the Prediction Equation button, a window will be displayed which 
allows you to input the factors for Age, Height, Constant, and Standard 
Deviation needed by the prediction equation; this is done on a per nerve 
basis.  The equation can be used to predict Onset latency, Peak latency, 
Amplitude, and Velocity.  If the equation is enabled, the normal value in the 
Site or Segment table is replaced with the letters “PV”, for predicted value. 
 This signifies that the normal value is not a simple value limit but will 
instead be calculated and displayed on the data acquisition screen once 
the patient‟s Date of Birth (i.e., Age) and Height have been input in the 
Patient Information window. 

 

Prediction Equation setup window. 



Protocols 

515 

The prediction equation used is: 

Predicted Value = Constant + (Age x Age Factor) + (Height x 
Height Factor) 

If the standard deviation is known then: 

Normal Value = Predicted Value +/- 'x' Standard Deviations 

Typically: 

Latency Norm = Predicted Value + 2 SD 

Amplitude Norm = Predicted Value – 2 SD 

Velocity Norm = Predicted Value – 2 SD 

To use the prediction equation the patient's height must be entered in 
centimeters. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

If the patient‟s Date of Birth and/or Height have not been entered prior 
to loading the test protocol the normal value will be shown as <0.0 or >0.0 
with a yellow background.  Once the Date of Birth and/or Height have 
been entered the predicted normal values will be displayed. 

When the prediction equation is enabled you cannot input a simple 
value limit for the norm. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

Using Prediction Equations (NCV) 

Normal values can be predicted using the patient‟s Age and Height.  This topic 
will outline the steps needed to enable prediction equations for the Median Motor 
Onset latency and Conduction Velocity across the Elbow-to-Wrist segment. 
 Follow these same steps to program equations for other nerves in the nerve list. 

Setup Steps: 

1.  From the Edit menu, select Test Setup. 

2.  Select the NCV test. 
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3.  Select a nerve in the Nerve List (i.e., Median Motor).  You will see a button 
labeled “Setup Prediction Factors” below the Site Table. 

 

Site & Segment Tables for Median Motor Nerve. 

4.  Click on the Setup Prediction Factors button.  The window shown below 
will be displayed. 
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Prediction Setup window. 

5. To setup the equation for Onset Latency at the Wrist. 

a. Select Onset Lat. at the top of the window. 

b. Enable the equation by changing the Off setting to On for the Wrist site. 

c. Enter the appropriate values for Constant, Age Factor, Height Factor, and 
one Standard Deviation. 

d. Set the upper limit of normal by selecting the number of standard 
deviations from the Onset Lat. drop-down list. 

e. Repeat steps a. to d. to setup Peak Latency and/or Amplitude. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 
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6. To setup the equation for Elbow-to-Wrist Velocity. 

a. Enable the equation by changing the Off setting to On for the Elbow-Wrist 
segment. 

b. Enter the appropriate values for Constant, Age Factor, Height Factor, and 
one Standard Deviation. 

c. Set the lower limit of normal by selecting the number of standard deviations 
from the drop-down list. 

d. Repeat steps a. to c. for other velocity segments. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

 

Completed setup for wrist latency and elbow-wrist velocity. 
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7.  Click Done. 

8.  Note the text “PV” in the Norm Onset and Norm Velocity fields.  This 
indicates that the predicted value equation has been enabled for these values 
and that the normal values for these measurements will be automatically 
calculated by the program once the data acquisition screen has been loaded 
and the patient‟s Date Of Birth (i.e., Age) and Height have been entered. 

 

Site and Segment Table for Median Motor Nerve. 

9.  Program other nerves by repeating steps 1-8. 

10. Click OK to close the Test Setup window and save your changes. 

 

Data Acquisition Mode: 

If the patient‟s Date Of Birth and/or Height have not been entered prior to 
loading the test protocol the normal value will be shown as <0.0 or >0.0 with 
a yellow background.  Once the Date of Birth and/or Height have been 
entered the predicted normal values will be displayed. 
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When the prediction equation is enabled you cannot edit the norm value 
field. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

NCV Cursors 

In the NCV Test Protocol, if the response is of sufficient amplitude, cursors are 
automatically placed on the trace.  Up to four cursors are placed on each trace, 
they are Onset (O), Peak (P), Trough (T), and Recovery (R).  The configuration 
of the Site and Segment tables determines which of the four cursors will be 
needed on the trace. 
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NCV trace with cursors positioned. 

 

If the amplitude criteria is not met the cursors will be placed on the response 
in the following pattern. 

 

Pattern of auto-cursor placement when amplitude criteria is not met. 

The Peak (P) cursor will be positioned at the third division with the Onset (O) 
cursor placed one-quarter division in front and the Trough (T) and Recovery 
(R) cursors placed one-quarter and one-half division respectively following it. 
 If you believe that there is a response present you can move the cursors to 
their appropriate positions, or if there really is no response present, you can 
mark the response as "NR" in the Site table. 

 

Adjusting Cursor Positions 

The positions of the cursors on a trace can be easily adjusted by following one of 
the methods below. 

 Using Knob #2 (Sel Cursor / Move Cursor) - this knob defaults to the 
Move Cursor mode and can be used to move either the Onset or Peak 
cursor on the active (white) trace.  Press this knob to switch to Sel 
Cursor mode which will allow you to move the focus (yellow triangle) to 
any cursor on any trace within the Trace window. 

 Using the F5-Cursor mode - press the F5 key on the PC's keyboard 
to change the base unit's knob and functions keys to cursor mode.  See 
the Knob & Fkey Controls topic for further information. 

 Using the mouse - simply left click on the appropriate cursors blue 
triangle and drag the cursor along the trace to its new location.  While 
the cursor is being moved the blue triangle is replaced with a yellow 
triangle. 
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Sorting Traces 

Typically the NCV Site Table lists the stimulation sites from distal to proximal and 
stimulation is performed in the same manner.  However you can acquire traces in 
a different order than what is listed in the NCV Site Table and then sort the traces 
later by increasing latency.  For motor nerves the onset latency is used, for 
sensory nerves either the onset or peak latency is used depending on how that 
nerve type is configured. 

To Sort the NCV Traces perform one of the following. 

 Press the F8 function key on the PC's keyboard. In the NCV test 
protocol the F8 key is always assigned the Sort Traces function. 

 Right click the mouse over the Trace window and select Sort Traces 
from the pop-up menu. 

 

Example of Median Motor performed out of order, from proximal to distal. 
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Example of the previous Median Motor after 
using the Sort Traces function.  Traces now 

match the order of the site names listed in the 
NCV Site Table. 

Swap Sides 

To swap the side parameter on a nerve, perform one of the following. 

 Right click the mouse over the nerve name in the Study window.  From 
the pop-up menu select Swap Sides. 

 Press the F7 function key on the PC's keyboard.  In the NCV test 
protocol the F7 key is always assigned the Swap Sides function. 

 If the side you are swapping to doesn't already exist within the Study 
window, then that nerve will automatically be added. 

 If the side you are swapping to already has stored traces, then a second 
run will automatically be added to that existing nerve.  If necessary, you can 
then swap the side on the first run. 
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Change Sides 

Changing the Side parameter for a nerve is different than Swapping Sides. 
 When you change sides, the highlight in the Study window simply moves to that 
nerve in the Study window.  No traces are transferred. 

If the nerve corresponding to the selected side is not listed in the Study window, 
it is automatically added to the window. 

 

To change the side parameter: 

In the NCV Controls window, click the down arrow for the Side parameter 
control.  Select the appropriate side from the drop-down list. 

 

In the Controls Toolbar, click the down arrow for the Side parameter 
control.  Select the appropriate side from the drop-down list. 
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Move To 

This feature allows the NCV traces to be moved to a different nerve of the same 
„nerve type‟.  For example, motor nerve traces can be moved to any other motor 
nerve in your nerve list. 

To Move the traces to another nerve: 

 Right click the mouse over the nerve in the Study window. 

 Select Move To from the pop-up menu. 

 Select a nerve from the displayed list. 

 

 

No Response 

If no response can be obtained for a stimulation site you can indicate this using 
the NR column in the NCV Site Table. 
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Simply click within the NR column just to the right of the site's name.  The text 
"NR" will be displayed for that site and any cursor values for the site will be 
cleared. 

 

NCV Site Table with NR indicated for the Wrist site. 

If you mistakenly click in the wrong NR box, click on the "NR" text and it will be 
removed and the cursor values will be restored. 

 

Override an Abnormal Value 

You can override the abnormal value flag when you believe that a value is 
actually within acceptable limits.  This function can be performed from the main 
acquisition screen for the nerve, or from within the TabData window if the 
individual nerve‟s node is highlighted in the left hand column. 

Simply right-click the mouse over the abnormal value, then select Set as 
Normal from the pop-up menu.  The abnormal flag (red color or bold text) will be 
removed. 

 

Median motor cursor table. 

If you make a mistake, right click over the value again, and then remove the 
check mark next to Set as Normal.  The abnormal flag will return. 

This feature is also available in EP cursor tables. 
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Tibial SEP cursor table. 

 

Using Abnormal Severity Meanings 

This feature gives a user the ability to specify an abnormal value‟s degree of 
abnormality (e.g., mildly increased, moderately increased, or severely increased) 
for a latency value rather than simply having the findings sentence indicate that a 
latency is only „increased‟. 

You can define the wording used for up to 3 severity ranges in the NCV 
Sentence Setup window and this feature can be automated by using a range of 
values for the normal value of a nerve. 

Abnormal Severity Setup 

In the NCV Sentence Setup window there are three columns for specifying 
the degree of abnormality.  The columns are titled Severity Meaning 1, 
Severity Meaning 2, and Severity Meaning 3. 

These columns allow you to specify the additional wording that can be used in 
the findings sentence when a value is found to be abnormal.  You can fill-in 
some, all, or none of rows in these columns. 

 To open the NCV Sentence Setup window, go to the TabData window 
and select the top level NCV node in the left hand column.  Click on the 
Sentence Setup button shown in the lower right hand corner. 
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NCV Sentence Setup window. 

 

How to use the Abnormal Severity Meanings 

In either the NCV Acquisition screen or from within the TabData window (if 
the individual nerve‟s node is highlighted in the left hand column) right click 
over the abnormal value to display a list of possible meanings.  The following 
example shows the result of right clicking over an abnormal Onset Latency. 
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An asterisk (*) indicates the sentence generator‟s currently assigned default 
meaning.  You can override the default meaning by selecting one of the 
additional abnormal meanings from the list.  You can also override the 
program and set the meaning  for the value to Normal. 

When an abnormal meaning other than the default is selected, a check mark 
appears next to that meaning.  To remove a selection, simply click on that 
meaning again and the check mark will be deleted. 

 

Meaning changed to "moderately". 

Right clicking over an abnormal Amplitude or Velocity value will list 
appropriate selections for those values. 
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Right click over Amplitude value. 

 

 

Right click over Velocity value. 

 

In the following example, the default meaning for both the distal peak latency 
and conduction velocity of the Right Median Anti-Sensory nerve were 
changed to “moderately”. 

 

 

Automating this feature using Normal Value Ranges 

The selection for the sentence‟s abnormal meaning can be automated by 
specifying a range of values in the norm field of a nerve.  Up to three ranges 
can be specified that correspond to Severity Meaning 1, Severity Meaning 2, 
and Severity Meaning 3.   

After the initial normal value is specified (e.g. <4.2) commas can be used to 
setup the additional abnormal ranges for the sentence generator. 

The following example shows how this can be done for the Onset, Amplitude, 
and Velocity measurements of the Median Motor nerve. 
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 Using <4.2,5,6 for the Onset normal value sets up the following 
ranges. 

<4.2 sets the normal limit.  (Anything greater than this value is 
flagged as abnormal). 

4.3 – 5.0 represents the #1 severity range (i.e., mildly increased). 

5.1 – 6.0 represents the #2 severity range (i.e., moderately 
increased). 

6.1 and above represents the #3 severity range (i.e., severely 
increased). 

 To determine what the three Latency ranges will be, use 
the following formula. 

Severity Range #1 = 1st value (plus 0.1) to 2nd 
value. 

Severity Range #2 = 2nd value (plus 0.1) to 3rd 
value. 

Severity Range #3 = 3rd value (plus 0.1) and above. 

 

 Using >5,4,2.5 for the distal Amplitude normal value sets up the 
following ranges. 
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>5 sets the normal limit.  (Anything less than this value is flagged 
as abnormal). 

4.9 – 4.0 represents the #1 severity range (i.e., mildly decreased). 

3.9 – 2.5 represents the #2 severity range (i.e., moderately 
decreased). 

2.4 or less represents the #3 severity range (i.e., severely 
decreased). 

 To determine what the three Amplitude ranges will be, 
use the following formula. 

Severity Range #1 = 1st value (minus 0.1) to 2nd 
value. 

Severity Range #2 = 2nd value (minus 0.1) to 3rd 
value. 

Severity Range #3 = 3rd value (minus 0.1) or less. 

 

 Using >50,45,40 for the distal Velocity normal value sets up the 
following ranges. 

>50 sets the normal limit.  (Anything less than this value is flagged 
as abnormal.) 

49 – 45 represents the #1 severity range (i.e., mildly decreased). 

44 – 40 represents the #2 severity range (i.e., moderately 
decreased). 

39 or less represents the #3 severity range (i.e., severely 
decreased). 

 To determine what the three Velocity ranges will be, use 
the following formula. 

Severity Range #1 = 1st value (minus 1) to 2nd 
value. 

Severity Range #2 = 2nd value (minus 1) to 3rd 
value. 

Severity Range #3 = 3rd value (minus 1) or less. 
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 If only two values are used for a norm, such as <4.2,6.5 for 
latency. 

<4.2 sets the normal limit. 

4.3 – 6.5 represents the #1 severity range (i.e., mildly prolonged). 

6.6 and above represents the #2 severity range (i.e., moderately 
prolonged). 

Severity #3 is not used. 

 

 If only one value is used for a norm, such as <4.0 for latency. 

For a latency value of 4.1 or higher the findings sentence will use 
the default meaning, “prolonged onset latency”. 

 

 Normal value ranges are hidden in the acquisition view unless the 
norm field is selected with the mouse for editing purposes.  The ranges 
are also hidden in the TabData window and in final reports. 
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Trace History 

The Trace History feature stores up to 30 traces for each stimulation site that is 
tested on a nerve.  This allows you to easily review previously acquired traces 
and replace your current trace with a better one from the history. 

To access the Trace History window: 

 Click on the Trace History icon in the toolbar. 

 

 The Trace History window will be displayed. 
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Trace History window showing all 8 
stimulations that were performed at 
the Wrist for the Left Median anti-

dromic sensory nerve.  The latency 
and amplitude values are displayed 

in the trace label. 

Prior to clicking on the Trace History icon you should store the 
trace for the current stimulation site. 
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To select a Site: 

 The window defaults to the last stimulated site.  Select a different site from 
the drop-down list at the bottom of the window. 

 

 

To replace the current trace: 

You can replace the current trace for a site with any of the traces shown in 
the history. 

 Left-click on a trace in the history to highlight it. 

 Click on the Replace with Highlighted Trace button. 

 The current trace is replaced with the selected trace and the Trace History 
window is automatically closed. 

 

To average traces in the history: 

 To average all traces - right-click within the window and click on Select 
All Traces.  Then, right-click again and select Average Traces.  The 
newly averaged trace is placed at the bottom of the trace stack. 

 To average only selected traces - select the desired traces by left-
clicking on each trace while holding down the Control key.  Once you have 
selected all the traces to be averaged, right-click and select Average 
Traces.  The newly averaged trace is placed at the bottom of the trace 
stack. 
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After selecting traces, right-click and select Average Traces. 

 You can now replace the current trace for a site with the newly averaged 
trace.  See steps above on replacing the current trace. 

 

To re-stimulate a site: 

The Trace History window replaces the old method of re-stimulating a site.  Now, 
as soon as you re-stimulate a site, the trace history window will be displayed so 
you can see all previously collected traces for that site and any new stimulations 
that are performed. 

 Click on the row in the site table corresponding to the site you want to 
re-stimulate. 

 Stimulate the site. 

 The Trace History window will be automatically displayed.  It will show 
all previous traces that have been collected for this site and automatically 
adds new traces as the site is re-stimulated. 

 Perform one of the following actions: 

o Press the Store button on the electrical stimulator or the Store key 
on the base unit.  The most recent trace will replace the previously 
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stored trace for that site.  Close the Trace History window by 
clicking on the Close button. 

o Select a trace in the history, and then click on the Replace with 
Highlighted Trace button. 

o Keep the original trace by clicking the Close button. 

 

To position & size the Trace History window: 

The program will automatically remember any changes that are made to the 
positioning and size of the trace history window. 

 

Trace History Setup Options: 

There are two configuration options for the Trace History window.  These options 
are found on the General Settings tab of the NCV Test Menu editor. 

 

 Disable Trace History on restimulation of a site - when this box is 
checked the Trace History window will be suppressed (hidden) during re-
stimulation of a site. 

 Save Trace History data - when this box is checked the program will 
store all Trace History data in the patient's record.  If this box is unchecked 
the trace histories will be cleared when the patient's exam is closed (File - 
Close Exam). 

 

Re-Stimulate a Site 

The Sierra Wave provides an easy way to re-stimulate a site and compare the 
new traces to the previously stored trace.  You have the choice of keeping the 
original trace or you can replace it with any trace from the Trace History window. 

Steps for Re-stimulating a Site: 

1.  In the Site Table, click on the Site (i.e., the row) that you want to repeat. 
 The row is highlighted and the active (white) trace goes to that position 
within the Trace window. 
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Wrist site has been selected for re-stimulation. 

 

2.  Stimulate the site.  As soon as re-stimulation is delivered, the Trace 
History window is displayed.  This window displays up to 30 traces for 
each stimulation site.  This allows you to easily review previously acquired 
traces and replace your current trace with a better one from the history. 
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The Trace History window shows all previous traces acquired for this site (top two traces) as 
well as any re-stimulations (last trace in this example). 

Note that the latency and amplitude of the response are included in 
the trace label. 

 

3.  Continue to re-stimulate as needed.  After each stimulation the 
corresponding trace is added to the trace history. 
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Four new traces (#3 - 6) have been add to the history for the Wrist stimulation site. 

 

4.  Perform one of the following actions: 

a. Keep the most recent trace by pressing the Store button on the 
electrical stimulator or the Store key on the base unit.  The most 
recent trace will replace the previously stored trace for that site. 
 Close the Trace History window by clicking on the Close button. 

b. Select a trace from the history by left-clicking on a trace with the 
mouse (trace becomes highlighted), and then click on the Replace 
with Highlighted Trace button.  The current trace is replaced with 
the selected trace and the Trace History window is automatically 
closed. 
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c. Keep the original trace for the site by clicking the Close button. 

 

Distance 

There are two ways to enter the distances into the NCV Segment table 

 Press the Distance key on the Sierra Wave base unit or click on the 
appropriate distance field with the mouse.  The first distance field will 
become activated and a small pop-up window is displayed showing the 
segment name and a place for the distance measurement, type the 
distance value and then press the Enter key.  You can also press the 
Distance key a second time instead of pressing the Enter key. 
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Distance pop-up window. 

 Press Programmable button #1 on the Electrical Stimulator handle.  A 
small pop-up window is displayed showing the segment name, distance 
value, and velocity.  Now, turn the wheel on the stimulator handle to 
increase or decrease the distance value in 0.5 cm increments.  When 
the correct distance value is reached, press Programmable button #1 a 
second time or press the Enter key. 

 

Distance pop-up window. 

Repeat this process to enter distances for additional segments. 

 In order for the velocity calculation to be done correctly you must enter 
distance values in centimeters. 
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Live Monitor Window 

A live monitor window is available in the NCV, F Wave, H-Reflex, Blink Reflex, 
and RNS test protocols. 

When this window is enabled it displays the “Live” activity coming from the 
recording electrodes.  When electrical stimulation occurs, the window will briefly 
display a stimulus-triggered waveform, and then will return to displaying  “Live” 
activity after one second. 

This window can be positioned, sized, and saved as part of the default settings 
for the test protocol. 

 

To Enable the Live Monitor window: 

1. Start the Sierra Wave program. 

2. Select a test protocol. 

3. From the Edit menu, select Current Test. 

4. Click on the General Settings tab. 

5. Check the box labeled, “Show Live Monitor”. 

6. Click OK. 

7. Adjust the size and positions of the windows on the screen. 

8. From the Edit menu, select Save Test Parameters to update the 
default settings for the test.  From now on the test protocol will display 
the Live Monitor Window. 

  The Gain and Sweep Speed of the Live Monitor window are the same as 
the main Trace window. 

Nerve List (F3) 

The F3 (Nerve List) function key is a convenient way to add nerves to the Study 
window after a Study List has been selected or after the NCV Test Protocol has 
been loaded. 
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To Add a Nerve to the Study Window 

1. From within the NCV Test Protocol, press the F3 (Nerve List) function 
key.  The Select Nerve window will be displayed. 

 

F3 - Select Nerve window. 

2. To add a single nerve, perform one of the following. 

 Using the Knobs - turn Knob #1 (Nerve Sel / Toggle) until the 
appropriate nerve name is selected, this is indicated by a dotted 
line drawn around the nerve name.  Press the knob to highlight 
the nerve.  Verify the Side parameter, use Knob #2 (Side) to 
change this if necessary.  Press the OK key on the Sierra Wave 
base unit. 
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 Using the Mouse - verify the Side parameter and then double 
click on the nerve name. 

3. To add multiple nerves, perform one of the following. 

 Using the Knobs - turn Knob #1 (Nerve Sel / Toggle) until the 
appropriate nerve name is selected, this is indicated by a dotted 
line drawn around the nerve name.  Press the knob to highlight 
the nerve.  Repeat this process until all of the nerves you want to 
add are highlighted.  Verify the Side parameter, use Knob #2 
(Side) to change this if necessary.  Press the OK key on the Sierra 
Wave base unit. 

 Using the Mouse - single click the mouse over the appropriate 
nerve names.  Once all of the nerves have been selected, verify 
the Side parameter and then click OK. 

 

 Setting the Side parameter to Left & Right will add the nerve to the Study 
window twice, once for the Left side and once for the Right side. 

 Adding nerves to the Study window in this manner is only temporary.  To 
add nerves to a Study List permanently, review the help topic "Changing an 
Existing Study". 

 

AnatomyVIEW - NCV 

The AnatomyVIEW feature allows the NCV nerve segment data to be displayed 
on a 3D color-coded anatomical model.  The AnatomyVIEW window can be 
included in reports. 

To open the AnatomyVIEW window, perform one of the following: 

 Click on the AnatomyVIEW button in the NCV test controls toolbar. 

 

 Select AnatomyVIEW from the View menu. 
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AnatomyVIEW window. 
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Site & Segment Tables 

During NCV data acquisition you may need to make modifications to the NCV 
Site or Segment tables. 

Site Table Changes: 

Changing a site's name - To change the name of an existing site, simply 
click the mouse directly on the underlined site name.  The box holding the site 
name will be changed into an edit mode, simply type the new name and then 
press Enter. 

 

Axilla site name in Edit mode. 

Adding a new site name to the last row - simply click the mouse in the site 
name box of the last row in the table.  Type the name and then press Enter. 
 The program always displays an empty row at the bottom of the site table to 
allow easy entry of additional sites. 

Inserting a new site in between existing sites - right click the mouse over 
an existing row in the site table and select Insert from the pop-up menu.  A 
new blank row will be inserted above the row that you right clicked on.  Now 
click in the site name box, type the name for the new site and then press 
Enter. 

Storing a Trace in an un-named site - if a trace is stored to an un-named 
site, the program will automatically insert a name for that site corresponding 
to the row's number within the site table. 
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Segment Table Changes: 

Changing the sites within a segment - A nerve segment is composed of 
two sites.  To change the sites that are being used to build a segment simply 
click the mouse over the Site 1 or Site 2 box you want to change, a pop-up list 
of the available site names and the recording site name will be displayed. 
 Click on the desired name. 

 

Clicking on the Elbow site produces a selection list. 

Adding a new segment to the last row - simply click the mouse in the Site 1 
box of the last row in the table.  Select a name, now click within the Site 2 box 
for this row and select another name.  The program always displays an empty 
row at the bottom of the segment table to allow easy entry of additional 
segments. 

Inserting a new segment in between existing segments - right click the 
mouse over an existing row in the segment table and select Insert from the 
pop-up menu.  A new blank row will be inserted above the row that you right 
clicked on.  Now click in the Site 1 box, select the name for the first site, now 
click in the Site 2 box and select the name for Site 2. 
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Saving changes to the Site & Segment Tables: 

To save any changes that were made to the Site or Segment table as the new 
defaults for the nerve, 

 Select Save Test Parameters from the Edit menu. 

 

Changing the Columns that are displayed: 

The columns that are displayed within the site and segment tables are 
specified in the NCV protocol's test setup parameters. 

For information on NCV Test Setup, click here. 

Table Font Size 

In all test protocols the font size of the Table window can be increased or 
decreased.  Simply right click on the table and select Font Size from the pop-up 
menu.  The choices are Small (default), Medium, Large, and Extra Large. 

 

Changing the font size of the Muscle Scoring Table. 
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Changing the font size of the NCV Tables. 

 

To save your selection as part of the test protocol's default settings, select Save 
Test Parameters from the Edit menu. 

 The selected font size is also applied to that table in the TabData window. 

Compare Left vs. Right (NCV) 

This feature allows for easy comparison of the latency, amplitude, and velocity 
differences between the left and right sides of a nerve.  It also allows for a visual 
comparison of the traces obtained for each side. 

To compare Left vs. Right sides perform one of the following. 

 Press the F10 - L/R Cmp function key. 

 Click on the Left/Right Comparison Tables tab in the NCV Tables 
window. 

The Left/Right Comparison Tables will be displayed and the trace window will 
show the contralateral side's traces (in blue) overlayed on the current side's 
traces. 
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NCV test protocol showing the Left/Right Comparison Tables and the contralateral side's traces 
in blue. 

 

Normal values can be entered for the side-to-side difference measurements 
with abnormal values flagged by the program. 

Press the F10 - L/R Cmp function key a second time or click on the NCV 
Tables tab to return to the standard NCV display. 

 The contralateral traces can be toggled On/Off at any time by right-
clicking over the trace window and selecting Show Contralateral Traces 

Comment (NCV) 

An optional comment can be entered on a per nerve basis.  Simply click in the 
Comment field and enter the comment you would like to attach to the nerve. 

The comment will appear in the TabData window and in reports. 

The comment field will remember the last 20 comments that have been entered 
and these can be re-selected from a list using the drop-down arrow. 
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NCV Tables with a comment entered into the comment field. 

 

 

TabData table showing the comment on the same line as the nerve's name. 

Repeat a Nerve 

If you decide to repeat a nerve you have a choice of clearing the previously 
acquired data for the nerve or of keeping the previously acquired data. 

To Clear the Previous Data & Repeat: 

1. Right click the mouse in the Trace window over the previously acquired 
traces for the nerve.  From the pop-up menu select Delete All Stored 
Trials. 

2. A confirmation message will be displayed.  Click OK and all previous data 
for the nerve is cleared. 

3. Acquire new data for the nerve in the normal fashion. 
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To Keep the Previous Data & Repeat: 

1. Right click the mouse over the nerve's name in the Study window. 
 From the pop-up menu select Start New Run. 

2. A second run node will be displayed under the nerve's name. 

3. Acquire new data for the nerve in the normal fashion. 

4. To view the first run done on the nerve select Run #1 from the Study 
window.  To view the second run done on the nerve select Run #2. 

 

Two separate runs have been acquired for the Right Median Anti Sensory nerve. 

5. If you want to delete one of the runs for the nerve, simply right click 
over the run you want to delete and select Delete from the pop-up menu. 
 A confirmation message will be displayed, click OK to delete the run. 

 

Averaging 

Signal averaging can be used on difficult to obtain nerves and helps to produce a 
more stable baseline by improving the signal to noise ratio. 

 

To Turn On the Signal Averager 

1. In the NCV Controls toolbar, change the Averager setting from Off to On 
by clicking on it, or press the F9 - Avg On function key. 
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F9 - Avg On function key, bold text indicates the signal averager is On. 

2. Stimulate the nerve by pressing the Stim button on the electrical 
stimulator handle or by pressing the Single key on the Sierra Wave base 
unit.  With each subsequent stimulation the averaged response will be 
updated and displayed in the Trace window. 

3. Once a satisfactory response has been obtained, press the Store button 
on the electrical stimulator handle or the Store key on the Sierra Wave 
base unit. 

The averager will automatically return to the Off state when advancing to 
the next stimulus site. 

You can also stimulate repetitively by pressing the Run/Stop button on 
the Sierra Wave keyboard.  In this mode the program will stimulate the nerve 
until it reaches the predefined Shutoff Count. 

 

Collision Study 

Train Stimulation and Collision Study Option 

Train stimulation can be performed using the standard Sierra Wave electrical 
stimulator, performing Collision Studies requires the use of the ES2 dual output 
stimulus splitter box. 

 

To perform Train Stimulation using the standard electrical stimulator: 

1. Select the NCV test protocol. 

2. In the stimulator section of the parameter toolbar - change the stimulus 
mode from Single to Dual mode.  The Dual Electrical Stim Controls 
window will be displayed. 
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Train of 4 pulses configured for stimulator #1. 

3. Set the Stim Count for stimulator #1. 

4. Set the ISI value for stimulator #1 (if the Stim Count is more than 1). 

5. Set the Pulse Width and Intensity for stimulator #1. 

6. Position the stimulator. 

7. Stimulate by pressing the Stim button on the handheld electrical 
stimulator or by pressing the Single key on the Sierra Wave base unit. 

 

To perform Collision Studies using the ES2 stimulus splitter box: 

1. Connect the ES2 stimulus splitter box. 

2. Select the NCV test protocol. 

3. In the stimulator section of the parameter toolbar - change the stimulus 
mode from Single to Dual.  The Dual Electrical Stim Controls window will 
be displayed. 
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One pulse from each stimulus output separated by 4 msec. 

4. Set the Stim Count for stimulator #1 and for stimulator #2. 

5. Set the ISI value for stimulator #1 and for stimulator #2 (if Stim Count is 
more than 1). 

6. Set the Pulse Width and Intensity for stimulator #1. 

7. Set the Pulse Width and Intensity for stimulator #2. 

8. Apply stimulus leads to the patient and connect the leads to the #1 and #2 
outputs on the ES2. 

9. Stimulate by pressing the Single key on the Sierra Wave base unit. 

 

Specifications for Train and Collision Study stimulation: 

Single Train Mode (Stim #1 output only) 

Stim Count: 1 to10 

ISI (inter-stimulus interval): 1.0 to 20 milliseconds 

Pulse Width: 50 to 1000 microseconds 

Intensity: 0 to 100 milliamps 
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Collision (Dual Train) Mode:  (Requires ES2 Stimulus Splitter Box) 

Stim Count: 1 to 10 for each stimulator 

ISI (inter-stimulus interval): 1.0 to 20 milliseconds each stimulator 

ITI (inter-train interval): 1.0 to 65 milliseconds 

Pulse Width: 50 to 500 microseconds each stimulator 

 

Please contact the Cadwell Customer Service Department if you are 
interested in purchasing the ES2 stimulus splitter box. 
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ES2 dual output stimulus splitter box. 

 

Recording Temperature 

Using the Surface Temperature Probe: 

The patient's temperature can be measured and recorded using the optional skin 
surface temperature probe. 

Connect the temperature probe to the connector labeled "Temp" on the back of 
the Sierra Wave base unit. 

The temperature is displayed in the Controls window or Controls Toolbar as 
follows; 

 

To turn the temperature reading Off, simply click on the underlined 
temperature value.  You don't need to disconnect the temperature probe. 

 

 

Without a Surface Temperature Probe: 

Simply click on the Temp Off control at the top of the screen, enter the 
temperature value in the pop-up window and click OK.  The entered value will 
remain on the screen until you click on the value and clear it, which sets the 
control back to the Off state. 
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Temperature Corrected Velocity 

Individual nerves can be configured to apply a temperature correction factor to 
the patient's measured velocity.  This is done in the NCV Test Setup window. 

To use Temperature Corrected Velocity: 

1. From the Edit menu, select Test Menu. 

2. Click on the NCV test protocol in the Test List. 

3. Select a Nerve in the Nerve List. 

4. Click on the Setup Temp Factors button. 

 

5. Enter the Reference Temperature (in °C), and the Correction Factor 
(meters/sec per °C) for the selected nerve. 

 

6. Click OK. 

7. Check the box "Use Temp Correction". 

 

If the patient's measured temperature is below the reference temperature -- for 
every degree that is below the reference temperature the program will add the 
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correction factor to the displayed velocity value.  This will be indicated by the 
letter "T" after the velocity value. 

Using the above reference temperature and correction factor: 

If the patient's temperature was measured at 30°C, the program would 
add 4.5 (1.5 x 3) to the velocity value. 

8. Repeat steps 3 to 7 for other nerves in the nerve list. 

9. Click OK to close the Test Menu window and save your changes to the 
Nerve's settings. 

 

Clear All Traces 

There may be times when you want to clear all the traces that have been 
acquired for a nerve. 

To Clear All Traces for a Nerve: 

Perform one of the following. 

 Right click the mouse in the Trace window over the previously acquired 
traces for the nerve.  From the pop-up menu select Delete All Stored 
Trials. 

 Press the F12-Clear All function key. 

A confirmation message will be displayed.  Click OK and all previous data for 
the nerve is cleared. 

 

Delete a Selected Trace 

There may be times when you want to delete only an individual trace for a nerve 
while keeping the rest of the traces. 

To Delete a selected NCV trace, perform one of the following. 

 Using the Mouse - select the trace you want to delete by clicking on it 
with the left mouse button.  When selected, the trace color will change 
from purple to yellow.  Now you can either press the Clear key on the 
Sierra Wave base unit or you can right click the mouse and select Delete 
Selected Traces from the pop-up menu.  A confirmation message will be 
displayed, click OK and the selected trace will be deleted. 

 Using the Knobs - enter the Position mode by pressing the F6 function 
key.  Now turn Knob #3 (Sel Trace / Delete) until the trace you want to 
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delete is selected, a selected trace is displayed in yellow.  Press the knob 
to delete the selected trace.  Exit Position mode by pressing the F6 
function key a second time or by pressing the OK key on the Sierra Wave 
base unit. 

Delete a Nerve 

To delete a nerve from the Study window, 

 Right click the mouse over the nerve name in the Study window.  From 
the pop-up menu select Delete. 

Trace Positioning 

There are several methods of changing the vertical positions of the NCV traces 
within the Trace window. 

Using the Mouse: 

Left click on the trace you want to move and drag the trace to it's new 
location.  Press the F11-Upd. Traces function key to update the Site 
table based on the new trace positions. 

Using the Knobs: 

1. Enter the Position mode by pressing the F6 function key on the 
PC's keyboard. 

2. Turn Knob #1 (Sel Trace / Move) until the trace you want to move 
is selected.  A selected trace is displayed in yellow rather than 
purple. 

3. Press the knob to activate the Move mode, now turn the knob to 
move the selected trace up or down. 

4. Press the knob a second time to return to the Sel Trace mode. 

Using the Trace Position Settings: 

1. Right click over the NCV Trace window. 

2. From the pop-up menu, select Trace Position Settings.  The 
Trace Position Settings window will be displayed. 
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Trace Position Settings window. 

3. Change the listed parameters, then click OK. 

Start Position: This is the default trace position for the first trace in 
the window.  It is the number of vertical divisions below the top of 
the trace window.  In this example, the first trace will be positioned 
4 divisions below the top of the window. 

Trial Offset:  This setting determines how much space will 
separate each stored NCV trace.  In this example the setting is 2.5 
divisions, therefore the second NCV trace will be displayed 2.5 
divisions below the first trace.  If a third NCV trace is acquired it will 
be displayed 2.5 divisions below the second NCV trace and so on. 

Channel Offset:  This setting only applies when more than one 
channel is turned ON.  It is the amount of space, in vertical 
divisions, that separates the two Live channels. 

Auto Adjust Traces:  When checked, this parameter will 
automatically adjust the Start Position and Trial Offset to keep all 
acquired traces displayed within the Trace window. 

Stimulator Polarity 

Press the Reverse Polarity (+/-) button on the electrical stimulator handle to 
select the Cathode (i.e., the negative stimulus probe).  A green LED indicates the 
probe that is the Cathode.  For routine nerve conduction, RNS, and Blink 
Studies the Cathode (-) should be oriented closest to the recording 
electrodes. 

Clicking on the Polarity field in the Controls window or Controls Toolbar can 
also reverse the stimulator polarity.  The default (i.e., Normal) mode has the 
right-side probe as the Cathode (if holding the stimulator with the Stim button 
facing you and the probes up); the reversed state will make the left-side probe 
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the Cathode.  The image of the stimulator on the screen updates to indicate the 
selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show the 
Right-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will show 
the Left-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 

Change Gain of a Selected Trace 

To change the gain of a selected NCV trace, perform the following. 

1. Select the Trace you want to change. 

 Using the Mouse - simply left click the mouse over the trace, when 
selected the trace will be displayed in yellow rather than purple. 
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 Using the Knobs - enter Position mode by pressing the F6 function 
key on the PC's keyboard.  Turn Knob #1 (Sel Trace / Move) until the 
desired trace is selected. 

2. Now, turn Knob #4 (Gain), the selected trace will be changed and it's 
current gain value will be displayed on the knob's icon. 

 

 To change the gain of all the NCV traces at one time, simply turn Knob #4 
(Gain / Sweep). 

Smooth Traces 

High frequency noise can be removed from the NCV traces by applying a digital 
smoothing filter. 

To Smooth All Traces: 

 Using the Mouse - right click over the NCV Trace window and select 
Smooth All from the pop-up menu. 

 Using the Knobs - enter Position mode by pressing the F6 function key 
on the PC's keyboard.  Now press the F2 (Smooth All) function key. 

 

To Smooth a Selected Trace: 

 Using the Mouse - select the trace you want to smooth by left clicking 
the mouse over it.  When selected, the trace will be displayed in yellow. 
 Now, right click the mouse and select Smooth from the pop-up menu. 

 Using the Knobs - there is no method for performing this function using 
the knobs. 

 

To Remove Smoothing: 

Right click the mouse over the NCV Trace window.  Select Unsmooth All 
from the pop-up menu. 

Time & Amplitude Marker 

To quickly measure the latency or amplitude of a nerve response, use the Time & 
Amplitude Markers. 
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Using the Time Markers 

 Right click over the NCV Trace window and select Time Markers from 
the pop-up menu.  Two vertical time markers will be displayed. 

 Move the markers by clicking on them with the mouse and dragging 
them across the window. 

 The latency, in milliseconds (from the left edge of the Trace window), is 
displayed for each Time Marker in the upper left hand corner of the Trace 
window.  The difference between the two time markers is also indicated. 

 To remove the Time Markers from the window, right click over the NCV 
Trace window and de-select Time Markers from the pop-up menu. 

 

NCV Trace window with Time Markers. 

 

Using the Amplitude Markers 

 Right click over the NCV Trace window and select Amplitude Markers 
from the pop-up menu.  Two horizontal amplitude markers will be 
displayed. 

 Move the markers by clicking on them with the mouse and dragging 
them up or down in the window. 

 The amplitude, in microvolts, between the two amplitude markers is 
shown in the upper left hand corner. 
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 To remove the Amplitude Markers from the window, right click over the 
NCV Trace window and de-select Amplitude Markers from the pop-up 
menu. 

 

NCV Trace window with Amplitude Markers. 

 

 Time & Amplitude Marker values are not displayed in the NCV Site 
Table. 

Saving Changes to NCV Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the Nerve. 

 Select Save Test Parameters from the Edit menu. 
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F Wave (Markers) 

F Wave (Markers) Basics 

This topic is a repeat of the basic F Wave steps found in the Getting Started 
chapter. 

Select the F Wave  Test: 

 If a Study has already been selected, simply click on an F Wave nerve 
name (i.e., Right Median) within the Study window or turn Knob #1 (Study 
Item / Site) to highlight the nerve name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual F Wave protocol from the Study/Test menu, a nerve 
list will be displayed allowing you to pick the nerve or nerves that you will 
be testing on the patient. 

 

Once the nerve has been selected.  Follow these steps for performing a 
routine F Wave (Markers mode) data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the test being performed. 

Typical Settings 

 Gain 
(uV/Div) 

Split 
Gain 

(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep 
Speed 

(ms/Div) 

F Wave 5k 500 10k 20 5.0 or 10.0 

 

2.  Electrode Placement 

Attach the electrodes to the patient.  

3.  Verify Side Setting 

Make sure the appropriate side, Right or Left, is selected. 

4.  Check Stimulator Polarity 

For F Wave Studies, the Cathode (-) should be oriented away from the 
recording electrodes (i.e., Cathode proximal, Anode distal). 
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The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  

Clicking on the Polarity field in the F Wave Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) 
mode has the right-side probe as the Cathode (if holding the stimulator with 
the Stim button facing you and the probes up); the reversed state will make 
the left-side probe the Cathode.  The image of the stimulator on the screen 
updates to indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show 
the Right-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will 
show the Left-side probe as the Cathode (-).  The polarity field on the screen 
will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 
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5.  Stimulate the Nerve 

Increase the stimulus intensity level by turning the wheel on the electrical 
stimulator handle.  The intensity  level (in milliamps) is displayed on the 
screen in a small pop-up window and also in the Stimulator section.  Once 
you have reached an appropriate starting intensity apply the stimulator to the 
patient and deliver the stimulus by pressing the Stim button on the electrical 
stimulator handle.  The stimulator light, located next to the intensity level on 
the Screen, will flash Green and the patient's response will be displayed. 

 The Single key on the Sierra Wave base unit, or the Single button in 
the F Wave Controls window, can also be used to deliver a single stimulus. 

 Repetitive stimulation can be delivered by pressing the Run/Stop 
button on the Sierra Wave base unit or by clicking on the Run button in the 
F Wave Controls window. 

In general, F Waves are performed with supramaximal stimulus intensity. 

If the M Wave or F Wave response amplitude is large and "clips" at the top or 
bottom,  decrease the amplifier sensitivity by adjusting the Gain setting.  For 
example, change the gain from 2k to 5k and re-stimulate.  Gain can be 
adjusted easily by using Knob #4 (Gain M / Gain F) on the Sierra Wave base 
unit. 

6.  Store the Response 

If the F1 (Manual / AutoStore) function key is set to the Manual mode you 
will need to store the response by performing one of the following actions; 

 Press the Store button on the electrical stimulator handle. 

 Press the Footswitch pedal. 

 Press the Store button on the Sierra Wave base unit. 

 Click on the Store button in the F/H Controls window. 

If the F1 (Manual / AutoStore) function key is set to the AutoStore mode, 
the trace will automatically be stored immediately after it is acquired. 

Stored traces will be displayed in "purple" color on the screen. 

7.  Continue to Stimulate and Store until 10 or 20 responses have been 
acquired. 

8.  Adjust Latency Marker 

To adjust the latency marker, perform one of the following: 
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 Turn Knob #2 (F Wave Lat / M Wave Lat) on the Sierra Wave base 
unit to move the F latency marker to the minimal F Wave latency. 
 Changing the F2 (Raster / Overlay) function key to Overlay mode 
can be helpful when positioning the latency marker.  The latency value 
is displayed in the F Wave Table window. 

 Press the F8 (Auto F-Lat) function key.  The program will 
automatically move the latency marker to the earliest onset latency.  In 
addition, a pop-up window will show the latency value and the wheel 
on the stimulator handle can be used to adjust the position of the 
marker.  Once the marker has been positioned, press the F8 function 
key a second time to exit this mode. 

 

Example F Wave Trace window. 

9.  Compare Left vs. Right side Traces (optional) 

Press the F10 - L/R Cmp function key to view the traces acquired for each 
side. 

The traces for each side are displayed in separate windows, stacked vertically 
on the screen.  The top window contains the traces for the current side. 

Press the F10 - L/R Cmp function key a second time to return to the standard 
F Wave display. 

10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 
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The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for summary Tables (i.e., F 
Wave Markers, Motor Summary table, Anti Sensory table, Muscle Scoring 
table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Nerve or Test 

To advance to the Next Nerve: 

 Use Knob #1 (Study Item / Site) to highlight another F Wave nerve in 
the Study window. 

 Click on another F Wave nerve in the Study window using the mouse. 

 Press the F3 (Nerve List) function key on the Sierra Wave base unit 
and select another nerve from the nerve list. 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

 

Knob & Fkey Controls (F Wave Markers) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in normal Acquisition mode or has 
been switched to either Cursor or Position mode. 
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 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 
 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 

 

Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

FWave Lat / MWave Lat - this knob defaults to the FWave Lat mode and 
can be used to move the F Wave latency marker across the trace window 
to the minimal F Wave latency.  Press the knob to activate the MWave Lat 
mode and turn to move a second latency marker to the onset of the M 
Wave. 

Intensity / Pulse Width - this knob defaults to the Intensity mode and 
can be used to increase or decrease the stimulus intensity, the current 
intensity value (in milliamps) is displayed on the knob icon.  Press the 
knob to activate the Pulse Width  mode and then turn to adjust the pulse 
duration of the stimulus (in microseconds). 

Gain F / Gain M - this knob defaults to the Gain F mode and can be used 
to change the gain of the F Wave side of the split point.  Press the knob to 
activate the Gain M mode and then turn to change the gain of the M Wave 
side of the split point. 

F Keys 

 

Manual / Autostore - In Manual mode the Store key must be pressed 
after each stimulation.  In Auto-Store mode the program will automatically 
store each trace after stimulation.  The initial status of this key can be 
programmed in the Test Menu Editor. 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this key 
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switches to Overlay mode which will superimpose all traces on top of one 
another. 

Nerve List - opens the F Wave Nerve List window which allows you to 
select and add nerves to your Study window. 

TabData - opens the TabData Summary window. 

PC Function Keys (F5-F12) 

 

F5-Cursor - enables Cursor mode (see below). 

F6-Position - enables Position mode (see below). 

F7-Swap Sides - press to swap the side parameter for the nerve. 

F8 - Auto F-Lat - press to have the program automatically move the F-
Latency marker to the minimum onset latency. 

F10-L/R Cmp - press to display the opposite side's traces. 

F12-Clear All - press to delete all traces for the nerve. 

 

Cursor mode (F5) 

Knobs 

 

F Lat / M Lat - this knob defaults to the F Lat mode and can be used to 
move the latency marker on the F Wave side of the Trace window.  Press 
the knob to activate the M Lat mode and turn to move the latency marker 
on the M Wave side of the Trace window. 

Amp 1 / Amp 2 - this knob defaults to the Amp 1 mode and can be used 
to move amplitude marker #1 within the F Wave side of the Trace window. 
 Press the knob to activate the Amp 2 mode and turn to move amplitude 
marker #2 within the F Wave side of the Trace window.  Prior to moving 
these markers you will need to press the F3 function key to toggle the 
amplitude markers from Off to On. 

Split Pt - turn this knob to move the gain split point indicator within the 
Trace window. 

Gain F / Gain M - this knob defaults to the Gain F mode and can be used 
to change the gain of the F Wave side of the split point.  Press the knob to 
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activate the Gain M mode and then turn to change the gain of the M Wave 
side of the split point. 

F Keys 

 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this key 
switches to Overlay mode which will superimpose all traces on top of one 
another. 

AmpMrk On / Off - defaults to AmpMrk Off mode.  Press this key to turn 
the amplitude markers On. 

Lat Mrk On / Off - defaults to LatMrk On mode.  Press this key to turn the 
latency markers Off. 

 

Position mode (F6) 

Knobs 

 

Sel Trace / Move - defaults to the Sel Trace mode, turn this knob to 
select a stored F Wave trace.  When selected, the trace will be displayed 
in yellow color.  Press the knob to activate the Move mode and then turn 
to move the selected trace up or down within the Trace window. 

Sel Trace / Delete - defaults to the Sel Trace mode, turn this knob to 
select a stored F Wave trace.  When selected, the trace will be displayed 
in yellow color.  Press the knob to Delete the selected trace. 

Split Pt - turn this knob to move the gain split point indicator within the 
Trace window. 

Gain F / Gain M - this knob defaults to the Gain F mode and can be used 
to change the gain of the F Wave side of the split point.  Press the knob to 
activate the Gain M mode and then turn to change the gain of the M Wave 
side of the split point. 
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F Keys 

 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this key 
switches to Overlay mode which will superimpose all traces on top of one 
another. 

Smooth All - each time this key is pressed the traces will be passed 
through a digital smoothing algorithm.  Smoothing can be reversed by 
right-clicking the mouse on the Trace window and selecting Unsmooth All 
from the pop-up menu. 

F Wave Test Setup 

F Wave test setup options are discussed in detail in the Test Protocol Setup 
chapter of the Help system. 

Click here to go to this topic. 

Normal Values (F Wave) 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the F Wave test protocol in the test list.  The F Wave test 
protocol settings will be displayed on the right hand side of the screen. 

In the Nerve List, select the nerve you want to make changes to. 

There are two methods for entering normal values; Simple Value Limit or 
Prediction Equation. 

 Simple Value Limit:   

Click in the normal value column of the nerve list and type the desired 
value.  For example, <33.0. 

 Prediction Equation: 

The normal F wave latency can be predicted using the patient‟s Age and 
Height.  To use the prediction equation, check the box labeled Enable 
Prediction Equation.  You can then input the factors for Age, Height, 
Constant, and Standard Deviation needed by the prediction equation; this is 
done on a per nerve basis.  If the equation is enabled, the normal value in 
the nerve list is ignored and the norm will instead be calculated and 
displayed on the data acquisition screen once the patient‟s Date of Birth 
(i.e., Age) and Height have been input in the Patient Information window. 



Protocols 

577 

 

The prediction equation used is: 

Predicted Value = Constant + (Age x Age Factor) + (Height x 
Height Factor) 

If the standard deviation is known then: 

Normal Value = Predicted Value + 'x' Standard Deviations 

Typically: 

F Wave Latency Norm = Predicted Value + 2 SD 

To use the prediction equation the patient's height must be entered in 
centimeters. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

If the patient‟s Date of Birth and/or Height have not been entered prior 
to loading the test protocol the normal value will be shown as <0.0 with a 
yellow background.  Once the Date of Birth and/or Height have been 
entered the predicted normal value will be displayed. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

Using Prediction Equation (F Wave markers) 

Normal values can be predicted using the patient‟s Age and Height.  This topic 
will outline the steps needed to enable the prediction equation for the Median 
(markers) F Wave test.  Follow these same steps to program equations for other 
nerves in the nerve list. 
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Setup Steps: 

1. From the Edit menu, select Test Setup. 

2. Select the F Wave test. 

3. Select a nerve in the Nerve List (i.e., Median markers).  You will see a 
section in the setup parameters called Prediction Equation. 

4. To enable the prediction equation, check the box next to Enable 
Prediction Equation. 

5. Enter the appropriate values for Constant, Age Factor, Height Factor, and 
one Standard Deviation. 

 

 

To use the prediction equation the patient's height must be entered in 
centimeters. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

6. Repeat steps 1-5 for other nerves. 

7. Click OK to close the Test Setup window. 

 

Data Acquisition Mode: 

If the patient‟s Date of Birth and/or Height have not been entered prior to 
loading the test protocol the normal value will be shown as <0.0 with a 
yellow background.  Once the Date of Birth and/or Height have been 
entered the predicted normal value will be displayed. 
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Stimulator Polarity 

For F Wave Studies, the Cathode (-) should be oriented away from the 
recording electrodes (i.e., Cathode proximal, Anode distal). 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing the 
Reverse Polarity (+/-) button on the electrical stimulator handle.  A green LED 
indicates the probe that is the Cathode.  

Clicking on the Polarity field in the F Wave Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) mode 
has the right-side probe as the Cathode (if holding the stimulator with the Stim 
button facing you and the probes up); the reversed state will make the left-side 
probe the Cathode.  The image of the stimulator on the screen updates to 
indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show the 
Right-side probe as the Cathode (-).  The polarity field on the screen will indicate 
Nml. 

  

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will show 
the Left-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Rev. 
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Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

Swap Sides 

To swap the side parameter on a nerve, perform one of the following. 

 Right click the mouse over the nerve name in the Study window.  From 
the pop-up menu select Swap Sides. 

 Press the F7 function key on the PC's keyboard.  In the F Wave test 
protocol the F7 key is always assigned the Swap Sides function. 

 If the side you are swapping to doesn't already exist within the Study 
window, then that nerve will automatically be added. 

 If the side you are swapping to already has stored traces, then a second 
run will be automatically added to that existing nerve. 

Change Sides 

Changing the Side parameter for a nerve is different than Swapping Sides. 
 When you change sides, the highlight in the Study window simply moves to that 
nerve in the Study window.  No traces are transferred. 

If the nerve corresponding to the selected side is not listed in the Study window, 
it is automatically added to the window. 

 

To change the side parameter: 

In the F Wave Controls window, click the down arrow for the Side 
parameter control.  Select the appropriate side from the drop-down list. 
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In the Controls Toolbar, click the down arrow for the Side parameter 
control.  Select the appropriate side from the drop-down list. 

 

 

Move To 

This feature allows the F Wave traces to be moved to a different nerve.  For 
example, median nerve traces can be moved to any other nerve in your F Wave 
nerve list. 

To Move the traces to another nerve: 

 Right click the mouse over the nerve in the Study window. 

 Select Move To from the pop-up menu. 

 Select a nerve from the displayed list. 



Sierra Wave Help Manual 

582 

 

 

The position of the latency marker is not moved with the traces, you will 
have to reset its position after the move. 

 

No Response 

If no response can be obtained you can indicate this using the NR column in the 
F Wave Table. 

Simply click within the NR column just to the left of the F Wave Latency.  The 
text "NR" will be displayed and any latency values for the site will be cleared. 

 

F Wave Table with no response indicated. 
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If you mistakenly mark the test as no response, click on the "NR" text and it will 
be removed and the latency marker values will be restored. 

Compare Left vs. Right (F Wave) 

This feature allows for a visual comparison of the traces obtained for each side. 

To compare Left vs. Right sides. 

 Press the F10 - L/R Cmp function key. 

The trace window will show the current side's traces in the top window and 
the contralateral side's traces (in blue) in the bottom window. 

 

F Wave test protocol, left side traces in top window, right side traces in bottom window. 

Press the F10 - L/R Cmp function key a second time to return to the standard 
F Wave display. 

 The F Wave Table always shows the Contra F Latency, L-R F Latency, 
and L-R Latency Norm (if entered for the nerve). 

 The contralateral traces can be toggled On/Off at any time by right-
clicking over the trace window and selecting Show Contralateral Traces 
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Comment (F Wave) 

An optional comment can be entered on a per nerve basis.  Simply click in the 
Comment field and enter the comment you would like to attach to the nerve. 

The comment will appear in the TabData window and in reports. 

The comment field will remember the last 20 comments that have been entered 
and these can be re-selected from a list using the drop-down arrow. 

 

F Wave Table with a comment entered into the comment field. 

 

TabData table showing the comment on the same line as the nerve's name. 

Table Font Size 

In all test protocols the font size of the Table window can be increased or 
decreased.  Simply right click on the table and select Font Size from the pop-up 
menu.  The choices are Small (default), Medium, Large, and Extra Large. 
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Changing the font size of the Muscle Scoring Table. 

 

 

Changing the font size of the NCV Tables. 

 

To save your selection as part of the test protocol's default settings, select Save 
Test Parameters from the Edit menu. 

 The selected font size is also applied to that table in the TabData window. 
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Live Monitor Window 

A live monitor window is available in the NCV, F Wave, H-Reflex, Blink Reflex, 
and RNS test protocols. 

When this window is enabled it displays the “Live” activity coming from the 
recording electrodes.  When electrical stimulation occurs, the window will briefly 
display a stimulus-triggered waveform, and then will return to displaying  “Live” 
activity after one second. 

This window can be positioned, sized, and saved as part of the default settings 
for the test protocol. 

 

To Enable the Live Monitor window: 

1. Start the Sierra Wave program. 

2. Select a test protocol. 

3. From the Edit menu, select Current Test. 

4. Click on the General Settings tab. 

5. Check the box labeled, “Show Live Monitor”. 

6. Click OK. 

7. Adjust the size and positions of the windows on the screen. 

8. From the Edit menu, select Save Test Parameters to update the 
default settings for the test.  From now on the test protocol will display 
the Live Monitor Window. 

  The Gain and Sweep Speed of the Live Monitor window are the same as 
the main Trace window. 

Nerve List (F3) 

The F3 (Nerve List) function key is a convenient way to add nerves to the Study 
window after a Study List has been selected or after the F Wave Test Protocol 
has been loaded. 
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To Add a Nerve to the Study Window 

1. From within the F Wave Test Protocol, press the F3 (Nerve List) function 
key.  The Select Nerve window will be displayed. 

 

F Wave Select Nerve window. 

2. To add a single nerve, perform one of the following. 

 Using the Knobs - turn Knob #1 (Nerve Sel / Toggle) until the 
appropriate nerve name is selected, this is indicated by a dotted 
line drawn around the nerve name.  Press the knob to highlight 
the nerve.  Verify the Side parameter, use Knob #2 (Side) to 
change this if necessary.  Press the OK key on the Sierra Wave 
base unit. 
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 Using the Mouse - verify the Side parameter and then double 
click on the nerve name. 

3. To add multiple nerves, perform one of the following. 

 Using the Knobs - turn Knob #1 (Nerve Sel / Toggle) until the 
appropriate nerve name is selected, this is indicated by a dotted 
line drawn around the nerve name.  Press the knob to highlight 
the nerve.  Repeat this process until all of the nerves you want to 
add are highlighted.  Verify the Side parameter, use Knob #2 
(Side) to change this if necessary.  Press the OK key on the Sierra 
Wave base unit. 

 Using the Mouse - single click the mouse over the appropriate 
nerve names.  Once all of the nerves have been selected, verify 
the Side parameter and then click OK. 

 

 Setting the Side parameter to Left & Right will add the nerve to the Study 
window twice, once for the Left side and once for the Right side. 

 Adding nerves to the Study window in this manner is only temporary.  To 
add nerves to a Study List permanently, review the help topic "Changing an 
Existing Study". 

 

 

Split Gain Position 

The F Wave Trace window is divided in two by a vertical Split Gain marker.  The 
left side of the window is assigned an M Wave gain setting, the right side of the 
window is assigned an F Wave gain setting. 

By moving the Split Point indicator you can give more or less space to either side 
of the Trace window. 
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To Move the Split Point Indicator 

Click on the split point indicator line with the mouse and drag the indicator line 
left or right within the Trace window. 

 The default position of the Split Pt indicator can be programmed in the F 
Wave Test Menu Editor. 

 

Manual / Auto Store 

If the F1 (Manual / AutoStore) function key is set to the Manual mode you will 
need to store the response by performing one of the following actions; 

 Press the Store button on the electrical stimulator handle. 

 Press the Footswitch pedal. 

 Press the Store button on the Sierra Wave base unit. 

 Click on the Store button in the F/H Controls window. 

If the F1 (Manual / AutoStore) function key is set to the AutoStore mode, the 
trace will automatically be stored immediately after it is acquired. 

Stored traces will be displayed in "purple" color on the screen. 
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 The default state of the F1 function key can be programmed in the Test 
Menu Editor. 

Latency Markers 

The F Wave (Markers) test protocol uses two latency markers to mark the 
Minimal F Wave Latency and the M Wave Latency. 

To move the latency markers, perform one of the following. 

 Using the Mouse - click on the marker you want to move using the left 
mouse button and drag the marker across the Trace window. 

 Using the Knobs - use Knob #2 (FWave Lat / MWave Lat).  This knob 
defaults to the FWave Lat mode, turn the knob to move the F Wave 
latency marker across the trace window to the minimal F Wave latency. 
 Press the knob to activate the MWave Lat mode and turn to move a 
second latency marker to the onset of the M Wave. 

Auto F Wave Latency 

 Press the F8 (Auto F-Lat) function key.  The program will automatically 
move the Minimal F Wave latency marker to the earliest onset latency.  In 
addition, a pop-up window will show the latency value and the wheel on 
the stimulator handle can be used to adjust the position of the marker. 
 Once the marker has been positioned, press the F8 function key a 
second time to exit this mode. 

Amplitude Markers 

In the F Wave (Markers) test protocol the amplitude markers can be used to 
measure the amplitude of one M Wave and one F Wave trace. 

To measure both M & F Wave amplitude, perform the following. 

 Using the Mouse - right click the mouse over the Trace window and 
select Amplitude Markers from the pop-up menu.  Two horizontal 
markers will be displayed on each side of the split point.  Click and drag 
the markers to the appropriate positions.  The amplitude (in microvolts) 
between the two markers is displayed in the F Wave Table. 

To measure only  F Wave amplitude, perform the following. 

 Using the Knobs - press the F5 function key to enter Cursor mode. 
 Press the F3 function key to turn the F Wave Amplitude markers On. 
 Now use Knob #2 (Amp 1 / Amp 2) to move the two markers.  The 
amplitude (in microvolts) between the two markers is displayed in the F 
Wave Table and on the Knob #2 icon. 
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Change to Auto Cursor Mode 

After performing an F Wave study in the (Markers) mode you can easily switch to 
(Auto Cursor) mode for more detailed analysis. 

To change from Markers to Auto Cursor mode: 

Click on the Measurement Mode parameter in the Controls Toolbar at the 
top of the screen.  The parameter will switch from Marker to Auto Cursor. 

 

 

Distance & Velocity 

F Wave Velocity can be calculated by entering a Distance value into the F Wave 
Table. 

 

The following calculation is used for F Wave Velocity: 

Velocity (in meters per second)  = ((Distance) x 10) x 2 / (FLat - MLat) - 1 

where, 

D = distance from stimulating cathode (-) to C7 or T12, in centimeters. 

FLat = F Wave latency. 

MLat = M Wave latency. 

 

To Enter a Distance value: 

Simply click in the Distance field of the F Wave Table, type the value and 
press Enter. 

 

 The Distance field can be programmed as Show or Hide in the F Wave Test 
Menu Editor. 
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Deleting Traces 

To Delete a selected F Wave trace, perform one of the following. 

 Using the Mouse - select the trace you want to delete by clicking on it 
with the left mouse button.  When selected, the trace color will change 
from purple to yellow.  Now you can either press the Clear key on the 
Sierra Wave base unit or you can right click the mouse and select Delete 
Selected Traces from the pop-up menu.  A confirmation message will be 
displayed, click OK and the selected trace will be deleted. 

 Using the Knobs - enter the Position mode by pressing the F6 function 
key.  Now turn Knob #2 (Sel Trial / Delete) until the trace you want to 
delete is selected, a selected trace is displayed in yellow.  Press the knob 
to delete the selected trace.  Exit Position mode by pressing the F6 
function key a second time or by pressing the OK key on the Sierra Wave 
base unit. 

Saving Changes to F Wave Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the F Wave nerve. 

 Select Save Test Parameters from the Edit menu. 
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F Wave (Cursors) 

F Wave (Cursors) - Basic Steps 

Select the F Wave  Test: 

 If a Study has already been selected, simply click on an F Wave nerve 
name (i.e., Right Median) within the Study window or turn Knob #1 (Study 
Item / Site) to highlight the nerve name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual F Wave protocol from the Study/Test menu, a nerve 
list will be displayed allowing you to pick the nerve or nerves that you will 
be testing on the patient. 

 

Once the nerve has been selected.  Follow these steps for performing a 
routine F Wave (Cursors mode) data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the test being performed. 

Typical Settings 

 Gain 
(uV/Div) 

Split 
Gain 

(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep 
Speed 

(ms/Div) 

F Wave 5k 500 10k 20 5.0 or 10.0 

 

2.  Electrode Placement 

Attach the electrodes to the patient.   

3.  Verify Side Setting 

Make sure the appropriate side, Right or Left, is selected. 

4.  Check Stimulator Polarity 

For F Wave Studies, the Cathode (-) should be oriented away from the 
recording electrodes (i.e., Cathode proximal, Anode distal). 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  



Sierra Wave Help Manual 

594 

Clicking on the Polarity field in the F Wave Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) 
mode has the right-side probe as the Cathode (if holding the stimulator with 
the Stim button facing you and the probes up); the reversed state will make 
the left-side probe the Cathode.  The image of the stimulator on the screen 
updates to indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show 
the Right-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will 
show the Left-side probe as the Cathode (-).  The polarity field on the screen 
will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

5.  Stimulate the Nerve 

Increase the stimulus intensity level by turning the wheel on the electrical 
stimulator handle.  The intensity  level (in milliamps) is displayed on the 
screen in a small pop-up window and also in the Stimulator section.  Once 
you have reached an appropriate starting intensity apply the stimulator to the 
patient and deliver the stimulus by pressing the Stim button on the electrical 
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stimulator handle.  The stimulator light, located next to the intensity level on 
the Screen, will flash Green and the patient's response will be displayed. 

 The Single key on the Sierra Wave base unit, or the Single button in 
the F Wave Controls window, can also be used to deliver a single stimulus. 

 Repetitive stimulation can be delivered by pressing the Run/Stop 
button on the Sierra Wave base unit or by clicking on the Run button in the 
F Wave Controls window. 

In general, F Waves are performed with supramaximal stimulus intensity. 

If the M Wave or F Wave response amplitude is large and "clips" at the top or 
bottom,  decrease the amplifier sensitivity by adjusting the Gain setting.  For 
example, change the gain from 2k to 5k and re-stimulate.  Gain can be 
adjusted easily by using Knob #4 (Gain M / Gain F) on the Sierra Wave base 
unit. 

6.  Store the Response 

If the F1 (Manual / AutoStore) function key is set to the Manual mode you 
will need to store the response by performing one of the following actions; 

 Press the Store button on the electrical stimulator handle. 

 Press the Footswitch pedal. 

 Press the Store button on the Sierra Wave base unit. 

 Click on the Store button in the F/H Controls window. 

If the F1 (Manual / AutoStore) function key is set to the AutoStore mode, 
the trace will automatically be stored immediately after it is acquired. 

Stored traces will be displayed in "purple" color on the screen. 

7.  Continue to Stimulate and Store until 10 or 20 responses have been 
acquired. 

8.  If necessary, Adjust Auto Cursors 

Auto Cursors are placed on the response as soon as it is displayed.  Three 
cursors are place on the M Wave, they are Onset (O), Peak (P), and Trough 
(T).  The F Wave also receives three cursors, the are F Onset (Of), F Peak 
(Pf), and F Trough (Tf). 

The F Wave Table window shows the M Wave latency (M-Lat) and M Wave 
amplitude (M-Amp) as well as the F Wave latency (F-Lat) and F Wave 
amplitude (F-Amp) for each stored trial. 
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The minimum F Wave latency (Min-F), maximum F Wave latency (Max-F), 
Dispersion (Max-F minus Min-F), Mean F latency (Mean-F), F wave norm (F-
norm), F wave vs. M wave ratio (F/M ratio), Distance, and F Wave velocity 
(F-Velocity) are all displayed in a summary table below the trial table. 

The positions of the cursors on a trace can be easily adjusted by following 
one of the methods below. 

 Using the mouse - simply left click on the appropriate cursors blue 
triangle and drag the cursor along the trace to its new location.  While 
the cursor is being moved the blue triangle is replaced with a yellow 
triangle. 

 Using Knob #2 (Of / Pf) - this knob defaults to the Of mode and can be 
used to move the F Wave Onset cursor on the active (white) trace. 
 Press this knob to switch to Pf mode which will allow you to move the 
F Wave Peak cursor on the active (white) trace. 

 Using the F5-Cursor mode - press the F5 key on the PC's keyboard 
to change the base unit's knob and functions keys to cursor mode.  See 
the Knobs & F Key Controls topic for further information. 



Protocols 

597 

 

F Wave (Cursors) example. 
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F Wave (Cursors) Table. 

9.  Compare Left vs. Right side Traces (optional) 

Press the F10 - L/R Cmp function key to view the traces acquired for each 
side. 

The traces for each side are displayed in separate windows, stacked vertically 
on the screen.  The top window contains the traces for the current side. 

Press the F10 - L/R Cmp function key a second time to return to the standard 
F Wave (Curs) display. 

10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., F 
Wave Cursors, Motor Summary table, Anti Sensory table, Muscle Scoring 
table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 
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To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Nerve or Test 

To advance to the Next Nerve: 

 Use Knob #1 (Study Item / Site) to highlight another F Wave nerve in 
the Study window. 

 Click on another F Wave nerve in the Study window using the mouse. 

 Press the F3 (Nerve List) function key on the Sierra Wave base unit 
and select another nerve from the nerve list. 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

Knob & Fkey Controls (F Wave Cursors) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in normal Acquisition mode or has 
been switched to either Cursor or Position mode. 

 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 
 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 
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Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Of / Pf - this knob defaults to the Of mode and can be used to move the F 
Wave Onset cursor on the active (white) trace.  Press this knob to switch 
to Pf mode which will allow you to move the F Wave Peak cursor on the 
active (white) trace. 

Intensity / Pulse Width- this knob defaults to the Intensity mode and can 
be used to increase or decrease the stimulus intensity, the current 
intensity value (in milliamps) is displayed on the knob icon.  Press the 
knob to activate the Pulse Width  mode and then turn to adjust the pulse 
duration of the stimulus (in microseconds). 

Gain F / Gain M - this knob defaults to the Gain F mode and can be used 
to change the gain of the F Wave side of the split point.  Press the knob to 
activate the Gain M mode and then turn to change the gain of the M Wave 
side of the split point. 

F Keys 

 

Manual / Autostore - In Manual mode the Store key must be pressed 
after each stimulation.  In Auto-Store mode the program will automatically 
store each trace after stimulation.  The initial status of this key can be 
programmed in the Test Menu Editor. 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this key 
switches to Overlay mode which will superimpose all traces on top of one 
another. 

Nerve List - opens the F Wave Nerve List window which allows you to 
select and add nerves to your Study window. 

TabData - opens the TabData Summary window. 

PC Function Keys (F5-F12) 
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F5-Cursor - enables Cursor mode (see below). 

F6-Position - enables Position mode (see below). 

F7-Swap Sides - press to swap the side parameter for the nerve. 

F8-Auto F-Lat - not available in Cursors mode. 

F10-L/R Cmp - press to display the opposite side's traces. 

F12-Clear All - press to delete all traces for the nerve. 

 

Cursor mode (F5) 

Knobs 

 

Select Cur / Move Cur - this knob defaults to the Select Cur mode and 
can be used to move the focus (yellow triangle) to any cursor on any trace 
within the Trace window.  Press this knob to switch to Move Cur mode 
which will allow you to move the selected (green triangle) cursor. 

Select Cur / On-Off - this knob defaults to the Select Cur mode and can 
be used to move the focus (yellow triangle) to any cursor on any trace 
within the Trace window.  Press the knob to hide the selected cursor (turn 
the cursor Off) or bring it back to view (turn the cursor On). 

Sel. Trace - turn this knob to select an F Wave trace.  When selected, the 
trace will be displayed in yellow. 

Gain F / Gain M - this knob defaults to the Gain F mode and can be used 
to change the gain of the F Wave side of the split point.  Press the knob to 
activate the Gain M mode and then turn to change the gain of the M Wave 
side of the split point. 

F Keys 

 

AutoPlace Cursors - press this function key to re-apply the auto-cursor 
algorithm to the selected (yellow) trace. 

Clear Cursors - press this function key to clear all cursors from the 
selected (yellow) trace. 
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All On / All Off - defaults to All On mode.  Press to hide all cursors (turn 
Off) on all traces. 

 

Position mode (F6) 

Knobs 

 

Sel Trace / Move - defaults to the Sel Trace mode, turn this knob to 
select a stored F Wave trace.  When selected, the trace will be displayed 
in yellow color.  Press the knob to activate the Move mode and then turn 
to move the selected trace up or down within the Trace window. 

Sel Trace / Delete - defaults to the Sel Trace mode, turn this knob to 
select a stored F Wave trace.  When selected, the trace will be displayed 
in yellow color.  Press the knob to Delete the selected trace. 

Split Pt - turn this knob to move the gain split point indicator within the 
Trace window. 

Gain F / Gain M - this knob defaults to the Gain F mode and can be used 
to change the gain of the F Wave side of the split point.  Press the knob to 
activate the Gain M mode and then turn to change the gain of the M Wave 
side of the split point. 

F Keys 

 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this key 
switches to Overlay mode which will superimpose all traces on top of one 
another. 

Smooth All - each time this key is pressed the traces will be passed 
through a digital smoothing algorithm.  Smoothing can be reversed by 
right-clicking the mouse on the Trace window and selecting Unsmooth All 
from the pop-up menu. 

F Wave Cursors - Test Setup 

F Wave test setup options are discussed in detail in the Test Protocol Setup 
chapter of the Help system. 
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Click here to go to this topic. 

Normal Values (F Wave) 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the F Wave test protocol in the test list.  The F Wave test 
protocol settings will be displayed on the right hand side of the screen. 

In the Nerve List, select the nerve you want to make changes to. 

There are two methods for entering normal values; Simple Value Limit or 
Prediction Equation. 

 Simple Value Limit:   

Click in the normal value column of the nerve list and type the desired 
value.  For example, <33.0. 

 Prediction Equation: 

The normal F wave latency can be predicted using the patient‟s Age and 
Height.  To use the prediction equation, check the box labeled Enable 
Prediction Equation.  You can then input the factors for Age, Height, 
Constant, and Standard Deviation needed by the prediction equation; this is 
done on a per nerve basis.  If the equation is enabled, the normal value in 
the nerve list is ignored and the norm will instead be calculated and 
displayed on the data acquisition screen once the patient‟s Date of Birth 
(i.e., Age) and Height have been input in the Patient Information window. 

 

The prediction equation used is: 

Predicted Value = Constant + (Age x Age Factor) + (Height x 
Height Factor) 

If the standard deviation is known then: 

Normal Value = Predicted Value + 'x' Standard Deviations 

Typically: 

F Wave Latency Norm = Predicted Value + 2 SD 
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To use the prediction equation the patient's height must be entered in 
centimeters. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

If the patient‟s Date of Birth and/or Height have not been entered prior 
to loading the test protocol the normal value will be shown as <0.0 with a 
yellow background.  Once the Date of Birth and/or Height have been 
entered the predicted normal value will be displayed. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

Using Prediction Equation (F Wave cursors) 

Normal values can be predicted using the patient‟s Age and Height.  This topic 
will outline the steps needed to enable the prediction equation for the Median 
(cursors) F Wave test.  Follow these same steps to program equations for other 
nerves in the nerve list. 

Setup Steps: 

1. From the Edit menu, select Test Setup. 

2. Select the F Wave test. 

3. Select a nerve in the Nerve List (i.e., Median markers).  You will see a 
section in the setup parameters called Prediction Equation. 

4. To enable the prediction equation, check the box next to Enable 
Prediction Equation. 

5. Enter the appropriate values for Constant, Age Factor, Height Factor, and 
one Standard Deviation. 
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To use the prediction equation the patient's height must be entered in 
centimeters. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

6. Repeat steps 1-5 for other nerves. 

7. Click OK to close the Test Setup window. 

 

Data Acquisition Mode: 

If the patient‟s Date of Birth and/or Height have not been entered prior to 
loading the test protocol the normal value will be shown as <0.0 with a 
yellow background.  Once the Date of Birth and/or Height have been 
entered the predicted normal value will be displayed. 



Sierra Wave Help Manual 

606 

 

Stimulator Polarity 

For F Wave Studies, the Cathode (-) should be oriented away from the 
recording electrodes (i.e., Cathode proximal, Anode distal). 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing the 
Reverse Polarity (+/-) button on the electrical stimulator handle.  A green LED 
indicates the probe that is the Cathode.  

Clicking on the Polarity field in the F Wave Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) mode 
has the right-side probe as the Cathode (if holding the stimulator with the Stim 
button facing you and the probes up); the reversed state will make the left-side 
probe the Cathode.  The image of the stimulator on the screen updates to 
indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show the 
Right-side probe as the Cathode (-).  The polarity field on the screen will indicate 
Nml. 

  

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 
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In the Reversed mode, the electrical stimulator image on the screen will show 
the Left-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

Swap Sides 

To swap the side parameter on a nerve, perform one of the following. 

 Right click the mouse over the nerve name in the Study window.  From 
the pop-up menu select Swap Sides. 

 Press the F7 function key on the PC's keyboard.  In the F Wave test 
protocol the F7 key is always assigned the Swap Sides function. 

 If the side you are swapping to doesn't already exist within the Study 
window, then that nerve will automatically be added. 

 If the side you are swapping to already has stored traces, then a second 
run will be automatically added to that existing nerve. 

Change Sides 

Changing the Side parameter for a nerve is different than Swapping Sides. 
 When you change sides, the highlight in the Study window simply moves to that 
nerve in the Study window.  No traces are transferred. 

If the nerve corresponding to the selected side is not listed in the Study window, 
it is automatically added to the window. 
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To change the side parameter: 

In the F Wave Controls window, click the down arrow for the Side 
parameter control.  Select the appropriate side from the drop-down list. 

 

In the Controls Toolbar, click the down arrow for the Side parameter 
control.  Select the appropriate side from the drop-down list. 

 

 

Move To 

This feature allows the F Wave traces to be moved to a different nerve.  For 
example, median nerve traces can be moved to any other nerve in your F Wave 
nerve list. 

To Move the traces to another nerve: 

 Right click the mouse over the nerve in the Study window. 

 Select Move To from the pop-up menu. 

 Select a nerve from the displayed list. 
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No Response (F Wave Cursors) 

If no response can be obtained for a stimulation you can indicate this using the 
NR column in the F Wave Table. 

Simply click within the NR column just to the right of the trial number.  The text 
"NR" will be displayed for that trial and any cursor values for the trial will be 
cleared.  Rows that have been marked as No Response are not included in the 
Min, Max, Mean calculations. 
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No Response indicated for Trial #3. 

If you mistakenly click in the wrong box, click on the "NR" text and it will be 
removed and the cursor values will be restored. 

Compare Left vs. Right (F Wave Cursors) 

This feature allows for a visual comparison of the traces obtained for each side. 

To compare Left vs. Right sides. 

 Press the F10 - L/R Cmp function key. 

The trace window will show the current side's traces in the top window and 
the contralateral side's traces (in blue) in the bottom window. 
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F Wave (Cursor) test protocol, left side traces in top window, right side traces in bottom window. 

Press the F10 - L/R Cmp function key a second time to return to the standard 
F Wave (Curs) display. 

 The F Wave Table always shows the Contra Mean F Latency, L-R 
Mean Latency, and L-R Mean Latency Norm (if entered for the nerve). 

 The contralateral traces can be toggled On/Off at any time by right-
clicking over the trace window and selecting Show Contralateral Traces 

Comment (F Wave) 

An optional comment can be entered on a per nerve basis.  Simply click in the 
Comment field and enter the comment you would like to attach to the nerve. 

The comment will appear in the TabData window and in reports. 

The comment field will remember the last 20 comments that have been entered 
and these can be re-selected from a list using the drop-down arrow. 
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F Wave Table with a comment entered into the comment field. 

 

TabData table showing the comment on the same line as the nerve's name. 

Table Font Size 

In all test protocols the font size of the Table window can be increased or 
decreased.  Simply right click on the table and select Font Size from the pop-up 
menu.  The choices are Small (default), Medium, Large, and Extra Large. 

 

Changing the font size of the Muscle Scoring Table. 
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Changing the font size of the NCV Tables. 

 

To save your selection as part of the test protocol's default settings, select Save 
Test Parameters from the Edit menu. 

 The selected font size is also applied to that table in the TabData window. 

Live Monitor Window 

A live monitor window is available in the NCV, F Wave, H-Reflex, Blink Reflex, 
and RNS test protocols. 

When this window is enabled it displays the “Live” activity coming from the 
recording electrodes.  When electrical stimulation occurs, the window will briefly 
display a stimulus-triggered waveform, and then will return to displaying  “Live” 
activity after one second. 

This window can be positioned, sized, and saved as part of the default settings 
for the test protocol. 



Sierra Wave Help Manual 

614 

 

To Enable the Live Monitor window: 

1. Start the Sierra Wave program. 

2. Select a test protocol. 

3. From the Edit menu, select Current Test. 

4. Click on the General Settings tab. 

5. Check the box labeled, “Show Live Monitor”. 

6. Click OK. 

7. Adjust the size and positions of the windows on the screen. 

8. From the Edit menu, select Save Test Parameters to update the 
default settings for the test.  From now on the test protocol will display 
the Live Monitor Window. 

  The Gain and Sweep Speed of the Live Monitor window are the same as 
the main Trace window. 

Nerve List (F3) 

The F3 (Nerve List) function key is a convenient way to add nerves to the Study 
window after a Study List has been selected or after the F Wave Test Protocol 
has been loaded. 

 

To Add a Nerve to the Study Window 

1. From within the F Wave Test Protocol, press the F3 (Nerve List) function 
key.  The Select Nerve window will be displayed. 
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F Wave Select Nerve window. 

2. To add a single nerve, perform one of the following. 

 Using the Knobs - turn Knob #1 (Nerve Sel / Toggle) until the 
appropriate nerve name is selected, this is indicated by a dotted 
line drawn around the nerve name.  Press the knob to highlight 
the nerve.  Verify the Side parameter, use Knob #2 (Side) to 
change this if necessary.  Press the OK key on the Sierra Wave 
base unit. 

 Using the Mouse - verify the Side parameter and then double 
click on the nerve name. 

3. To add multiple nerves, perform one of the following. 

 Using the Knobs - turn Knob #1 (Nerve Sel / Toggle) until the 
appropriate nerve name is selected, this is indicated by a dotted 
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line drawn around the nerve name.  Press the knob to highlight 
the nerve.  Repeat this process until all of the nerves you want to 
add are highlighted.  Verify the Side parameter, use Knob #2 
(Side) to change this if necessary.  Press the OK key on the Sierra 
Wave base unit. 

 Using the Mouse - single click the mouse over the appropriate 
nerve names.  Once all of the nerves have been selected, verify 
the Side parameter and then click OK. 

 

 Setting the Side parameter to Left & Right will add the nerve to the Study 
window twice, once for the Left side and once for the Right side. 

 Adding nerves to the Study window in this manner is only temporary.  To 
add nerves to a Study List permanently, review the help topic "Changing an 
Existing Study". 

 

 

Split Gain Position 

The F Wave Trace window is divided in two by a vertical Split Gain marker.  The 
left side of the window is assigned an M Wave gain setting, the right side of the 
window is assigned an F Wave gain setting. 

By moving the Split Point indicator you can give more or less space to either side 
of the Trace window. 
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To Move the Split Point Indicator 

Click on the split point indicator line with the mouse and drag the indicator line 
left or right within the Trace window. 

 The default position of the Split Pt indicator can be programmed in the F 
Wave Test Menu Editor. 

 

Manual / Auto Store 

If the F1 (Manual / AutoStore) function key is set to the Manual mode you will 
need to store the response by performing one of the following actions; 

 Press the Store button on the electrical stimulator handle. 

 Press the Footswitch pedal. 

 Press the Store button on the Sierra Wave base unit. 

 Click on the Store button in the F/H Controls window. 

If the F1 (Manual / AutoStore) function key is set to the AutoStore mode, the 
trace will automatically be stored immediately after it is acquired. 

Stored traces will be displayed in "purple" color on the screen. 
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 The default state of the F1 function key can be programmed in the Test 
Menu Editor. 

Auto Cursors (F Wave) 

In the F Wave (Cursors) Test Protocol, if the response is of sufficient amplitude, 
cursors are automatically placed on both the M Wave and F Wave trace. 

Three cursors are placed on the M Wave trace, they are Onset (O), Peak (P), 
and Trough (T). 

The F Wave trace also gets the same cursors but with slightly different labels, 
they are Onset F (Of), Peak F (Pf), and Trough F (Tf). 

 

F Wave (Cursors) example trace. 

 

Adjusting Cursor Positions 

The positions of the cursors on a trace can be easily adjusted by following one of 
the methods below. 

 Using the mouse - simply left click on the appropriate cursors blue 
triangle and drag the cursor along the trace to its new location.  While 
the cursor is being moved the blue triangle is replaced with a yellow 
triangle. 

 Using Knob #2 (Of / Pf) - this knob defaults to the Of mode and can be 
used to move the F Wave Onset cursor on the active (white) trace. 
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 Press this knob to switch to Pf mode which will allow you to move the 
F Wave Peak cursor on the active (white) trace. 

 Using the F5-Cursor mode - press the F5 key on the PC's keyboard 
to change the base unit's knob and functions keys to cursor mode.  See 
the Knobs & F Key Controls topic for further information. 

 

How can I place cursors on a trace that was stored without them? 

If you store a trace without cursors and later determine that there is a response 
present, you can easily add cursors to the trace. 

Here is one simple method to accomplish this. 

1.  Left click on the trace to select it, the trace will change from purple 
color to yellow. 

2.  Now, right click the mouse on the trace and select Auto Place 
Cursors from the pop-up menu. 

3.  Adjust the cursor positions as needed. 

 

Change to Markers Mode 

After performing an F Wave study in the (Auto Cursor) mode you can easily 
switch to (Marker) mode for a simpler display. 

To change from Auto Cursor to Marker mode: 

Click on the Measurement Mode parameter in the Controls Toolbar at the 
top of the screen.  The parameter will switch from Auto Cursor to Marker.  

 

 

Distance & Velocity 

F Wave Velocity can be calculated by entering a Distance value into the F Wave 
Table. 
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The following calculation is used for F Wave Velocity: 

Velocity (in meters per second)  = ((Distance) x 10) x 2 / (FLat - MLat) - 1 

where, 

D = distance from stimulating cathode (-) to C7 or T12, in centimeters. 

FLat = F Wave latency. 

MLat = M Wave latency. 

 

To Enter a Distance value: 

Simply click in the Distance field of the F Wave Table, type the value and 
press Enter. 

 

 The Distance field can be programmed as Show or Hide in the F Wave Test 
Menu Editor. 

Deleting Traces 

To Delete a selected F Wave trace, perform one of the following. 

 Using the Mouse - select the trace you want to delete by clicking on it 
with the left mouse button.  When selected, the trace color will change 
from purple to yellow.  Now you can either press the Clear key on the 
Sierra Wave base unit or you can right click the mouse and select Delete 
Selected Traces from the pop-up menu.  A confirmation message will be 
displayed, click OK and the selected trace will be deleted. 

 Using the Knobs - enter the Position mode by pressing the F6 function 
key.  Now turn Knob #2 (Sel Trial / Delete) until the trace you want to 
delete is selected, a selected trace is displayed in yellow.  Press the knob 
to delete the selected trace.  Exit Position mode by pressing the F6 
function key a second time or by pressing the OK key on the Sierra Wave 
base unit. 

Saving Changes to F Wave Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the F Wave nerve. 

 Select Save Test Parameters from the Edit menu. 
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H Reflex 

H Reflex Basic Steps 

This topic is a repeat of the basic H Reflex steps found in the Getting Started 
chapter. 

Select the H Reflex  Test: 

 If a Study has already been selected, simply click on an H Reflex nerve 
name (i.e., Right Tibial) within the Study window or turn Knob #1 (Study 
Item / Site) to highlight the nerve name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual H Reflex test protocol from the Study/Test menu, a 
nerve list will be displayed allowing you to pick the nerve or nerves that 
you will be testing on the patient. 

 

Once the nerve has been selected.  Follow these steps for performing 
routine H Reflex data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the test being performed. 

Typical Settings 

 Gain 
(uV/Div) 

Split 
Gain 

(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep 
Speed 

(ms/Div) 

H Reflex 2 - 5k 500 10k 20 10.0 

 

2.  Electrode Placement 

Attach the electrodes to the patient.   

3.  Verify Side Setting 

Make sure the appropriate side, Right or Left, is selected. 

4.  Check Stimulator Polarity 

For H-Reflex Studies, the Cathode (-) should be oriented away from the 
recording electrodes (i.e., Cathode proximal, Anode distal). 
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The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  

Clicking on the Polarity field in the H Reflex Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) 
mode has the right-side probe as the Cathode (if holding the stimulator with 
the Stim button facing you and the probes up); the reversed state will make 
the left-side probe the Cathode.  The image of the stimulator on the screen 
updates to indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show 
the Right-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will 
show the Left-side probe as the Cathode (-).  The polarity field on the screen 
will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 
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5.  Stimulate the Nerve 

Increase the stimulus intensity level by turning the wheel on the electrical 
stimulator handle.  The intensity  level (in milliamps) is displayed on the 
screen in a small pop-up window and also in the Stimulator section.  Once 
you have reached an appropriate starting intensity apply the stimulator to the 
patient and deliver the stimulus by pressing the Stim button on the electrical 
stimulator handle.  The stimulator light, located next to the intensity level on 
the Screen, will flash Green and the patient's response will be displayed. 

 The Single key on the Sierra Wave base unit, or the Single button in 
the H Reflex Controls window, can also be used to deliver a single stimulus. 

 Repetitive stimulation can be delivered by pressing the Run/Stop 
button on the Sierra Wave base unit or by clicking on the Run button in the 
H Reflex Controls window. 

In general, H Reflex maximum amplitude occurs with sub-maximal stimulation 
intensity. 

If the M Wave or H Reflex response amplitude is large and "clips" at the top 
or bottom,  decrease the amplifier sensitivity by adjusting the Gain setting. 
 For example, change the gain from 2k to 5k and re-stimulate.  Gain can be 
adjusted easily by using Knob #4 (Gain M / Gain H) on the Sierra Wave base 
unit. 

6.  Store the Response 

If the F1 (Manual / AutoStore) function key is set to the Manual mode you 
will need to store the response by performing one of the following actions; 

 Press the Store button on the electrical stimulator handle. 

 Press the Footswitch pedal. 

 Press the Store button on the Sierra Wave base unit. 

 Click on the Store button in the H Reflex Controls window. 

If the F1 (Manual / AutoStore) function key is set to the AutoStore mode, 
the trace will automatically be stored immediately after it is acquired. 

Stored traces will be displayed in "purple" color on the screen. 

7.  Continue to Stimulate and Store until 10 or 20 responses have been 
acquired. 

8.  Adjust Latency Marker 

To adjust the latency marker, perform one of the following: 
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 Turn Knob #2 (H Lat / M Wave Lat) on the Sierra Wave base unit to 
move the H Reflex latency marker to the H Reflex onset latency. 
 Changing the F2 (Raster / Overlay) function key to Overlay mode 
can be helpful when positioning the latency marker.  The latency value 
is displayed in the H Reflex Table window. 

 Press the F8 (Auto H-Lat) function key.  The program will 
automatically move the latency marker to the earliest onset latency.  In 
addition, a pop-up window will show the latency value and the wheel 
on the stimulator handle can be used to adjust the position of the 
marker.  Once the marker has been positioned, press the F8 function 
key a second time to exit this mode. 

 

Example H Reflex Trace window. 

9.  Compare Left vs. Right side Traces (optional) 

Press the F10 - L/R Cmp function key to view the traces acquired for each 
side. 

The traces for each side are displayed in separate windows, stacked vertically 
on the screen.  The top window contains the traces for the current side. 
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Press the F10 - L/R Cmp function key a second time to return to the standard 
H Reflex display. 

10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., H 
Reflex, F Wave Markers, Motor Summary table, Anti Sensory table, Muscle 
Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Nerve or Test 

To advance to the Next Nerve: 

 Use Knob #1 (Study Item / Site) to highlight another H Reflex nerve in 
the Study window. 

 Click on another H Reflex nerve in the Study window using the 
mouse. 

 Press the F3 (Nerve List) function key on the Sierra Wave base unit 
and select another nerve from the nerve list. 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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Knob & Fkey Controls (H Reflex) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in normal Acquisition mode or has 
been switched to either Cursor or Position mode. 

 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 
 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 

 

Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

H Lat / MWave Lat - this knob defaults to the H Lat mode and can be 
used to move the H Reflex latency marker across the trace window to the 
onset of the H Reflex.  Press the knob to activate the MWave Lat mode 
and turn to move a second latency marker to the onset of the M Wave. 

Intensity / Split Pt - this knob defaults to the Intensity mode and can be 
used to increase or decrease the stimulus intensity, the current intensity 
value (in milliamps) is displayed on the knob icon.  Press the knob to 
activate the Pulse Width  mode and then turn to adjust the pulse duration 
of the stimulus (in microseconds). 

Gain H / Gain M - this knob defaults to the Gain H mode and can be used 
to change the gain of the H Reflex side of the split point.  Press the knob 
to activate the Gain M mode and then turn to change the gain of the M 
Wave side of the split point. 

F Keys 

 

Manual / Autostore - In Manual mode the Store key must be pressed 
after each stimulation.  In Auto-Store mode the program will automatically 
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store each trace after stimulation.  The initial status of this key can be 
programmed in the Test Menu Editor. 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this key 
switches to Overlay mode which will superimpose all traces on top of one 
another. 

Nerve List - opens the H Reflex Nerve List window which allows you to 
select and add nerves to your Study window. 

TabData - opens the TabData Summary window. 

PC Function Keys (F5-F12) 

 

F5-Cursor - enables Cursor mode (see below). 

F6-Position - enables Position mode (see below). 

F7-Swap Sides - press to swap the side parameter for the nerve. 

F8-Auto H-Lat - press to have the program automatically move the H-
Latency marker to the minimum onset. 

F10-L/R Cmp - press to display the opposite side's traces. 

F12-Clear All - press to delete all traces for the nerve. 

 

Cursor mode (F5) 

Knobs 

 

H Lat / M Lat - this knob defaults to the H Lat mode and can be used to 
move the latency marker on the H Reflex side of the Trace window.  Press 
the knob to activate the M Lat mode and turn to move the latency marker 
on the M Wave side of the Trace window. 

Amp 1 / Amp 2 - this knob defaults to the Amp 1 mode and can be used 
to move amplitude marker #1 within the H Reflex side of the Trace 
window.  Press the knob to activate the Amp 2 mode and turn to move 
amplitude marker #2 within the H Reflex side of the Trace window.  Prior 
to moving these markers you will need to press the F3 function key to 
toggle the amplitude markers from Off to On. 
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Split Pt - turn this knob to move the gain split point indicator within the 
Trace window. 

Gain H / Gain M - this knob defaults to the Gain H mode and can be used 
to change the gain of the H Reflex side of the split point.  Press the knob 
to activate the Gain M mode and then turn to change the gain of the M 
Wave side of the split point. 

F Keys 

 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this key 
switches to Overlay mode which will superimpose all traces on top of one 
another. 

AmpMrk On / Off - defaults to AmpMrk Off mode.  Press this key to turn 
the amplitude markers On. 

Lat Mrk On / Off - defaults to LatMrk On mode.  Press this key to turn the 
latency markers Off. 

 

Position mode (F6) 

Knobs 

 

Sel Trace / Move - defaults to the Sel Trace mode, turn this knob to 
select a stored H Reflex trace.  When selected, the trace will be displayed 
in yellow color.  Press the knob to activate the Move mode and then turn 
to move the selected trace up or down within the Trace window. 

Sel Trace / Delete - defaults to the Sel Trace mode, turn this knob to 
select a stored H Reflex trace.  When selected, the trace will be displayed 
in yellow color.  Press the knob to Delete the selected trace. 

Split Pt - turn this knob to move the gain split point indicator within the 
Trace window. 

Gain H / Gain M - this knob defaults to the Gain H mode and can be used 
to change the gain of the H Reflex side of the split point.  Press the knob 
to activate the Gain M mode and then turn to change the gain of the M 
Wave side of the split point. 
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F Keys 

 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this key 
switches to Overlay mode which will superimpose all traces on top of one 
another. 

Smooth All - each time this key is pressed the traces will be passed 
through a digital smoothing algorithm.  Smoothing can be reversed by 
right-clicking the mouse on the Trace window and selecting Unsmooth All 
from the pop-up menu. 

H Reflex Test Setup 

H Reflex test setup options are discussed in detail in the Test Protocol Setup 
chapter of the Help system. 

Click here, to go to this topic. 

Normal Values (H Reflex) 

From the Edit menu select Test Menu.  When the Test Menu Setup window is 
displayed click on the H Reflex test protocol in the test list.  The H Reflex test 
protocol settings will be displayed on the right hand side of the screen. 

In the Nerve List, select the nerve you want to make changes to. 

There are two methods for entering normal values; Simple Value Limit or 
Prediction Equation. 

 Simple Value Limit:   

Click in the normal value column of the nerve list and type the desired 
value.  For example, <37.0. 

 Prediction Equation: 

The normal H Reflex latency can be predicted using the patient‟s Age and 
either Height, Leg Length or Arm Length.  To use the prediction equation, 
check the box labeled Enable Prediction Equation.  You can then input 
the factors for Age, Height or Leg/Arm Length, Constant, and Standard 
Deviation needed by the prediction equation; this is done on a per nerve 
basis.  If the equation is enabled, the normal value in the nerve list is 
ignored and the norm will instead be calculated and displayed on the data 
acquisition screen once the patient‟s Date of Birth (i.e., Age) and Height 
or Leg/Arm Length have been input. 
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The prediction equation used is: 

Predicted Value = Constant + (Age x Age Factor) + (Height  x 
Height Factor) 

Leg or Arm Length and appropriate Factor can be substituted for 
Height. 

If the standard deviation is known then: 

Normal Value = Predicted Value + 'x' Standard Deviations 

Typically: 

H Reflex Latency Norm = Predicted Value + 2 SD 

To use the prediction equation the patient's height or leg/arm length 
must be entered in centimeters. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

If the patient‟s Date of Birth and/or Height have not been entered prior 
to loading the test protocol the normal value will be shown as <0.0 with a 
yellow background.  Once the Date of Birth and/or Height have been 
entered the predicted normal value will be displayed. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

If Leg Length is selected for the Tibial H Reflex, the standard H Reflex 
Nomogram will be displayed on the acquisition screen and a Leg Length 
field will be shown in the measurement table.  After entering the patient's 
leg length in the table a line will be drawn in the nomogram to indicate the 
predicted normal latency, the blue dot marks the predicted value and the 
green dot marks the upper limit of normal based on the specified standard 
deviation. 
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H Reflex Nomogram 

 

Using Prediction Equation (H Reflex) 

Normal values can be predicted using the patient‟s Age and Height or Leg/Arm 
Length.  This topic will outline the steps needed to enable the prediction 
equation for the Tibial (markers) H Reflex test.  Follow these same steps to 
program equations for other nerves in the nerve list. 

Setup Steps: 

1. From the Edit menu, select Test Setup. 
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2. Select the H Reflex test in the Test List. 

3. Select a nerve in the Nerve List (i.e., Tibial markers).  You will see a new 
section in the setup parameters called Prediction Equation. 

4. To enable the prediction equation, check the box next to Enable 
Prediction Equation. 

5. Enter the appropriate values for Constant, Age Factor, Height or Leg/Arm 
Length Factor, and one Standard Deviation. 

 

 

 

To use the prediction equation the patient's height or leg/arm length 
must be entered in centimeters. 

Sometimes the Age or Height factor is not used, in this case leave the 
factor set to zero. 

There is a document on the Sierra Wave software installation CD 
containing a compilation of many published factors for predicting normal 
values. 

6. Repeat steps 1-5 for other nerves. 

7. Click OK to close the Test Setup window. 

 

Data Acquisition Mode: 

If Leg Length is selected for the Tibial H Reflex, the standard H Reflex 
Nomogram will be displayed on the acquisition screen and a Leg Length field 
will be shown in the measurement table.  After entering the patient's leg 
length in the table a line will be drawn in the nomogram to indicate the 
predicted normal latency, the blue dot marks the predicted value and the 
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green dot marks the upper limit of normal based on the specified standard 
deviation. 

 

H Reflex Nomogram 

If the patient‟s Date Of Birth and/or Height have not been entered prior to 
loading the test protocol the normal value will be shown as <0.0 with a 
yellow background.  Once the Date of Birth and/or Height/Leg Length have 
been entered the predicted normal value will be displayed. 
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Stimulator Polarity 

For H Reflex Studies, the Cathode (-) should be oriented away from the 
recording electrodes (i.e., Cathode proximal, Anode distal). 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing the 
Reverse Polarity (+/-) button on the electrical stimulator handle.  A green LED 
indicates the probe that is the Cathode.  

Clicking on the Polarity field in the H Reflex Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) mode 
has the right-side probe as the Cathode (if holding the stimulator with the Stim 
button facing you and the probes up); the reversed state will make the left-side 
probe the Cathode.  The image of the stimulator on the screen updates to 
indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show the 
Right-side probe as the Cathode (-).  The polarity field on the screen will indicate 
Nml. 
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Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will show 
the Left-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

Swap Sides 

To swap the side parameter on a nerve, perform one of the following. 

 Right click the mouse over the nerve name in the Study window.  From 
the pop-up menu select Swap Sides. 

 Press the F7 function key on the PC's keyboard.  In the H Reflex test 
protocol the F7 key is always assigned the Swap Sides function. 

 If the side you are swapping to doesn't already exist within the Study 
window, then that nerve will automatically be added. 

 If the side you are swapping to already has stored traces, then a second 
run will be automatically added to that existing nerve. 
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Change Sides 

Changing the Side parameter for a nerve is different than Swapping Sides. 
 When you change sides, the highlight in the Study window simply moves to that 
nerve in the Study window.  No traces are transferred. 

If the nerve corresponding to the selected side is not listed in the Study window, 
it is automatically added to the window. 

 

To change the side parameter: 

In the H Reflex Controls window, click the down arrow for the Side 
parameter control.  Select the appropriate side from the drop-down list. 

 

In the Controls Toolbar, click the down arrow for the Side parameter 
control.  Select the appropriate side from the drop-down list. 
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Move To 

This feature allows the H Reflex traces to be moved to a different nerve.  For 
example, tibial nerve traces can be moved to any other nerve in your H Reflex 
nerve list. 

To Move the traces to another nerve: 

 Right click the mouse over the nerve in the Study window. 

 Select Move To from the pop-up menu. 

 Select a nerve from the displayed list. 

 

 

The position of the latency marker is not moved with the traces, you will 
have to reset its position after the move. 
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No Response 

If no response can be obtained you can indicate this using the NR column in the 
H Reflex Table. 

Simply click within the NR column just to the left of the H Reflex Latency.  The 
text "NR" will be displayed and any latency values for the site will be cleared. 

 

H Reflex Table with no response indicated. 

If you mistakenly mark the test as no response, click on the "NR" text and it will 
be removed and the latency marker values will be restored. 

Compare Left vs. Right (H Reflex) 

This feature allows for a visual comparison of the traces obtained for each side. 

To compare Left vs. Right sides. 

 Press the F10 - L/R Cmp function key. 

The trace window will show the current side's traces in the top window and 
the contralateral side's traces (in blue) in the bottom window. 

Press the F10 - L/R Cmp function key a second time to return to the standard 
H Reflex display. 

 The H Reflex Table always shows the Contra H Latency, L-R H 
Latency, and L-R Latency Norm (if entered for the nerve). 

 The contralateral traces can be toggled On/Off at any time by right-
clicking over the trace window and selecting Show Contralateral Traces 

Comment (H Reflex) 

An optional comment can be entered on a per nerve basis.  Simply click in the 
Comment field and enter the comment you would like to attach to the nerve. 

The comment will appear in the TabData window and in reports. 
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The comment field will remember the last 20 comments that have been entered 
and these can be re-selected from a list using the drop-down arrow. 

 

H-Reflex Table with a comment entered into the comment field. 

 

TabData table showing the comment on the same line as the nerve's name. 

Table Font Size 

In all test protocols the font size of the Table window can be increased or 
decreased.  Simply right click on the table and select Font Size from the pop-up 
menu.  The choices are Small (default), Medium, Large, and Extra Large. 

 

Changing the font size of the Muscle Scoring Table. 
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Changing the font size of the NCV Tables. 

 

To save your selection as part of the test protocol's default settings, select Save 
Test Parameters from the Edit menu. 

 The selected font size is also applied to that table in the TabData window. 

Live Monitor Window 

A live monitor window is available in the NCV, F Wave, H-Reflex, Blink Reflex, 
and RNS test protocols. 

When this window is enabled it displays the “Live” activity coming from the 
recording electrodes.  When electrical stimulation occurs, the window will briefly 
display a stimulus-triggered waveform, and then will return to displaying  “Live” 
activity after one second. 

This window can be positioned, sized, and saved as part of the default settings 
for the test protocol. 
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To Enable the Live Monitor window: 

1. Start the Sierra Wave program. 

2. Select a test protocol. 

3. From the Edit menu, select Current Test. 

4. Click on the General Settings tab. 

5. Check the box labeled, “Show Live Monitor”. 

6. Click OK. 

7. Adjust the size and positions of the windows on the screen. 

8. From the Edit menu, select Save Test Parameters to update the 
default settings for the test.  From now on the test protocol will display 
the Live Monitor Window. 

  The Gain and Sweep Speed of the Live Monitor window are the same as 
the main Trace window. 

Nerve List (F3) 

The F3 (Nerve List) function key is a convenient way to add nerves to the Study 
window after a Study List has been selected or after the H Reflex Test Protocol 
has been loaded. 

 

To Add a Nerve to the Study Window 

1. From within the H Reflex Test Protocol, press the F3 (Nerve List) function 
key.  The Select Nerve window will be displayed. 
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H Reflex Select Nerve window. 

2. To add a single nerve, perform one of the following. 

 Using the Knobs - turn Knob #1 (Nerve Sel / Toggle) until the 
appropriate nerve name is selected, this is indicated by a dotted 
line drawn around the nerve name.  Press the knob to highlight 
the nerve.  Verify the Side parameter, use Knob #2 (Side) to 
change this if necessary.  Press the OK key on the Sierra Wave 
base unit. 

 Using the Mouse - verify the Side parameter and then double 
click on the nerve name. 

3. To add multiple nerves, perform one of the following. 

 Using the Knobs - turn Knob #1 (Nerve Sel / Toggle) until the 
appropriate nerve name is selected, this is indicated by a dotted 
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line drawn around the nerve name.  Press the knob to highlight 
the nerve.  Repeat this process until all of the nerves you want to 
add are highlighted.  Verify the Side parameter, use Knob #2 
(Side) to change this if necessary.  Press the OK key on the Sierra 
Wave base unit. 

 Using the Mouse - single click the mouse over the appropriate 
nerve names.  Once all of the nerves have been selected, verify 
the Side parameter and then click OK. 

 

 Setting the Side parameter to Left & Right will add the nerve to the Study 
window twice, once for the Left side and once for the Right side. 

 Adding nerves to the Study window in this manner is only temporary.  To 
add nerves to a Study List permanently, review the help topic "Changing an 
Existing Study". 

 

 

Split Gain Position 

The H Reflex Trace window is divided in two by a vertical Split Gain marker.  The 
left side of the window is assigned an M Wave gain setting, the right side of the 
window is assigned an H Reflex gain setting. 

By moving the Split Point indicator you can give more or less space to either side 
of the Trace window. 
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To Move the Split Point Indicator 

Click on the split point indicator line with the mouse and drag the indicator line 
left or right within the Trace window. 

 The default position of the Split Pt indicator can be programmed in the H 
Reflex Test Menu Editor. 

 

Manual / Auto Store 

If the F1 (Manual / AutoStore) function key is set to the Manual mode you will 
need to store the response by performing one of the following actions; 

 Press the Store button on the electrical stimulator handle. 

 Press the Footswitch pedal. 

 Press the Store button on the Sierra Wave base unit. 



Protocols 

645 

 Click on the Store button in the F/H Controls window. 

If the F1 (Manual / AutoStore) function key is set to the AutoStore mode, the 
trace will automatically be stored immediately after it is acquired. 

Stored traces will be displayed in "purple" color on the screen. 

 The default state of the F1 function key can be programmed in the Test 
Menu Editor. 

Latency Markers 

The H Reflex test protocol uses two latency markers to mark the H Reflex Onset 
Latency and the M Wave Onset Latency. 

To move the latency markers, perform one of the following. 

 Using the Mouse - click on the marker you want to move using the left 
mouse button and drag the marker across the Trace window. 

 Using the Knobs - use Knob #2 (H Lat / MWave Lat).  This knob 
defaults to the H Lat mode, turn the knob to move the H Reflex latency 
marker across the trace window to the onset of the H Reflex.  Press the 
knob to activate the MWave Lat mode and turn to move a second latency 
marker to the onset of the M Wave. 

Auto H-Reflex Latency 

 Press the F8 (Auto H-Lat) function key.  The program will automatically 
move the Minimal H-Reflex latency marker to the earliest onset latency.  In 
addition, a pop-up window will show the latency value and the wheel on 
the stimulator handle can be used to adjust the position of the marker. 
 Once the marker has been positioned, press the F8 function key a 
second time to exit this mode. 

Amplitude Markers 

In the H Reflex test protocol the amplitude markers can be used to measure the 
amplitude of one M Wave and one H Reflex trace. 

To measure both M Wave & H Reflex amplitude, perform the following. 

 Using the Mouse - right click the mouse over the Trace window and 
select Amplitude Markers from the pop-up menu.  Two horizontal 
markers will be displayed on each side of the split point.  Click and drag 
the markers to the appropriate positions.  The amplitude (in microvolts) 
between the two markers is displayed in the H Reflex Table. 
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To measure only  H Reflex amplitude, perform the following. 

 Using the Knobs - press the F5 function key to enter Cursor mode. 
 Press the F3 function key to turn the H Reflex Amplitude markers On. 
 Now use Knob #2 (Amp 1 / Amp 2) to move the two markers.  The 
amplitude (in microvolts) between the two markers is displayed in the H 
Reflex Table and on the Knob #2 icon. 

Deleting Traces 

To Delete a selected H Reflex trace, perform one of the following. 

 Using the Mouse - select the trace you want to delete by clicking on it 
with the left mouse button.  When selected, the trace color will change 
from purple to yellow.  Now you can either press the Clear key on the 
Sierra Wave base unit or you can right click the mouse and select Delete 
Selected Traces from the pop-up menu.  A confirmation message will be 
displayed, click OK and the selected trace will be deleted. 

 Using the Knobs - enter the Position mode by pressing the F6 function 
key.  Now turn Knob #2 (Sel Trial / Delete) until the trace you want to 
delete is selected, a selected trace is displayed in yellow.  Press the knob 
to delete the selected trace.  Exit Position mode by pressing the F6 
function key a second time or by pressing the OK key on the Sierra Wave 
base unit. 

Saving Changes to H Reflex Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the H Reflex nerve. 

 Select Save Test Parameters from the Edit menu. 
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RNS (Myasthenia) 

RNS Basic Steps 

This topic is a repeat of the basic RNS (Repetitive Nerve Stimulation) steps 
found in the Getting Started chapter. 

Select the RNS  Test: 

 If a Study has already been selected, simply click on the RNS muscle 
name within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the RNS test protocol from the Study/Test menu, a muscle list will 
be displayed allowing you to pick the muscle or muscles that you will be 
testing on the patient. 

 

Once the muscle has been selected.  Follow these steps for performing 
RNS data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the test being performed.  RNS typically uses the 
same settings as a motor NCV. 

2.  Verify Side Setting 

Make sure the appropriate side, Right or Left, is selected. 

3.  Electrode Placement 

Attach the electrodes to the patient. 

Active 1 Input:  Belly of the muscle. 

Reference 1  Input:  Tendon of the muscle. 

Ground Electrode:  On stimulated limb or forehead. 

4.  Check Stimulator Polarity 

For RNS Studies, the Cathode (-) should be oriented closest to the 
recording electrodes. 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  
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Clicking on the Polarity field in the RNS Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) 
mode has the right-side probe as the Cathode (if holding the stimulator with 
the Stim button facing you and the probes up); the reversed state will make 
the left-side probe the Cathode.  The image of the stimulator on the screen 
updates to indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show 
the Right-side probe as the cathode (-).  The polarity field on the screen will 
indicate Nml. 

  

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will show 
the Left-side probe as the cathode (-).  The polarity field on the screen will 
indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

5.  Check the RNS Table 

The RNS test protocol supports a preprogrammed stimulus train table.  This 
table controls the number of stimuli presented in each train, the repetition rate 
for the stimuli, the amount of time to pause before proceeding to the next 
stimulus train, and it also provides a convenient way to label each stimulus 
train. 
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The program allows for either manual or automatic delivery of the stimulus 
train table. 

 

RNS Table. 

If your stimulus train table is undefined, select Current Test from the Edit 
menu.  Fill in the Sequencer Setup table in the lower left corner of the setup 
window, then click OK. 

6.  Check the General and Stimulator Settings 

General Settings 

Mode:  Choices are Train or Single. 

 Train - When the Stim button on the handheld stimulator or the 
Run/Stop button is pressed, a train of stimuli, corresponding to the 
highlighted row in the RNS Table, will be delivered. 

 Single - When the Stim button on the hand held stimulator or the 
Single button is pressed, a single stimulus will be delivered.  This 
mode is useful for determining supramaximal stimulation prior to 
delivering a train of stimuli. 

Train #:  The total number of stimuli that will be delivered to the patient 
when the program is set to the Train mode.  The typical setting is four to 
eight.  The maximum setting is 150.  This value is updated from the RNS 
Table. 

Spread:  This is the distance (in horizontal divisions) that will separate the 
individual traces within the train.  If this value is set to zero, the traces will 
be superimposed upon one another. 

Response 1:  Select the first response in the train that will be analyzed for 
amplitude and area measurements.  Typically this is always set to number 
1. 

Response 2:  Select the second response in the train that will be 
analyzed for amplitude and area measurements.  In addition, the 
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percentage difference between this response and the trace selected for 
Response 1 will be computed.  This is typically set to number 4 or 5. 

Auto Seq:  Allows for either manual or automatic sequencing through the 
RNS Table.  When set to On, the program will automatically deliver the 
trains specified in the RNS table (automatically pausing for the specified 
time after each train).  When set to Off, the user must manually start each 
train after the appropriate pause time, by pressing the Run/Stop key for 
each train. 

Stimulator Settings 

Pulse Width:  Set the electrical stimulus pulse width, also known as pulse 
duration, in microseconds (usec). 

Rep Rate:  Set the repetitive stimulus rate, in pulses per second (Hz). 
 This is typically set to 3 Hz.  This setting only applies when delivering 
repetitive (i.e., Train) stimulation, it does not apply during manual Single 
stimulus delivery. 

7.  Check Recording Setup 

Press the F1 (Train/Single) function key to select Single mode.  Increase 
the stimulus intensity level by turning the wheel on the electrical stimulator 
handle.  The intensity  level (in milliamps) is displayed on the screen in a 
small pop-up window and also in the Stimulator controls section.  Once 
you have reached an appropriate starting intensity apply the stimulator to 
the patient and deliver the stimulus by pressing the Stim button on the 
electrical stimulator handle.  The stimulator light, located next to the 
intensity level on the Screen, will flash Green and the patient's response 
will be displayed. 

 The Single key on the Sierra Wave base unit or the Single button 
within the on-screen RNS Controls window can also be used to deliver a 
single stimulus.  Intensity can also be adjusted using Knob #3 (Intensity / 
Pulse Width) on the base unit. 

Continue to increase the intensity level and stimulate until a supra-
maximal response is acquired.  If the response is large and "clips" at the 
top or bottom,  decrease the amplifier sensitivity by adjusting the Gain 
setting.  For example, change gain from 2k to 5k and re-stimulate.  Gain 
can be adjusted easily by using Knob #4 (Gain /Sweep) on the Sierra 
Wave base unit. 

8.  Deliver Stimulus Trains 

Press the F1 (Train/Single) function key to select Train mode.  Follow the 
instructions below for either Manual or Automatic Stimulus Train delivery. 
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Manual Stimulus Train Delivery: 

Press the Stim button on the electrical stimulator handle.  A train of 
stimuli will be delivered to the patient and a trace will be displayed for 
each stimulus within the train.  The traces are stacked in a horizontal 
fashion (see Spread setting above). 

After the Train is completed the program will automatically store the train 
and it will be displayed in a "purple" color. 

 The Run/Stop key on the Sierra Wave base unit or the Run 
button within the on-screen RNS Controls window can also be used to 
deliver a train of stimuli.  

 20 milliseconds is acquired after each stimulus.  This allows for a 
maximum repetition rate of 50 Hz during train stimulation. 

After a train is automatically stored, a timer is started.  The timer is 
displayed just below the side field in the RNS Controls window or at the 
top of the screen in the Controls Toolbar. 

Use the timer to measure the time elapsed while the patient exercises the 
muscle or the time elapsed between successive stimulus trains.  Typically, 
the patient will exercise the muscle for 30 seconds after the first train is 
delivered then another train will be delivered immediately after completion 
of exercise.  Additional trains are then typically delivered at 1 minute 
intervals after this. 

Press the Run/Stop key again to deliver the second stimulus train. 
 Proceed in this fashion until all stimulus trains have been acquired. 

 The timer automatically resets to zero after each train is stored. 
 You can also manually reset the timer to zero by pressing the F2 
(Reset Timer) function key on the Sierra Wave base unit. 
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Example RNS Traces 

Automatic Stimulus Train Delivery: 

Change the Auto Seq. control from Off to On.  The first row in the RNS 
Table will be automatically highlighted. 

Press the Stim button on the electrical stimulator handle.  A train of 
stimuli will be delivered to the patient and a trace will be displayed for 
each stimulus within the train.  The traces are stacked in a horizontal 
fashion (see Spread setting above). 

After the Train is completed the program will automatically store the train 
and it will be displayed in a "purple" color.  At this point the timer is started. 
 The timer is displayed just below the side field in the RNS Controls 
window or at the top of the screen in the Controls Toolbar. 
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Once the timer reaches the preprogrammed pause time for the stimulus 
train, the program will automatically deliver the next stimulus train in the 
RNS Table. 

Stimulation will continue in this manner until the last stimulus train is 
delivered. 

 You can stop the automatic sequencer at any time by changing the 
Auto Seq. control from On to Off. 

9.  Adjust Cursors (optional) 

Onset (O) and Peak (P) cursors are automatically placed on the selected 
responses (see Response 1 and Response 2 settings above) as each train is 
acquired.   The amplitude (onset to peak) and area (negative peak) of each 
response is calculated and displayed in the RNS table window. 

The positions of these cursors can be adjusted by performing one of the 
following actions; 

 By pressing the F5 (Cursor mode) function key and then using  Knob 
#1 (Sel Cursor / Move Cursor) on the Sierra Wave base unit. 

 By clicking on them with the left mouse button and dragging them to 
their new position. 

The difference for both amplitude and area, between the two marked 
responses, is also automatically calculated and is displayed as a percentage 
(%).  The equation used for this calculation is as follows; 

D = (VR2 - VR1) / VR1 X 100% 

Where D = decrement or increment 

V = value (amplitude or area) 

R1 = response 1 

R2 = response 2 

A decrement is displayed as a negative number, typically more than a -10% 
decrement is considered abnormal.  An increment is displayed as a positive 
number. 

Peak-to-Trough amplitude measurements can also be selected in the 
RNS protocol's test setup window.  In this case, Peak (P) and Trough (T) 
cursors will be automatically placed on the responses.  

 Use the Comment field in the RNS table to enter a notation for the train. 
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RNS Cursor Table 

 

RNS Histogram Window 

10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 
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To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Muscle or Test 

To advance to the Next Muscle: 

 Use Knob #1 (Study Item / Site) to highlight another RNS muscle in 
the Study window. 

 Click on another RNS muscle in the Study window using the mouse. 

 Press the F3 (Muscle List) function key on the Sierra Wave base 
unit and select another muscle from the muscle list. 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

Knob & Fkey Controls (RNS) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in normal Acquisition mode or has 
been switched to either Cursor or Position mode. 

 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 
 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 
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Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Intensity / Pulse Width - this knob defaults to the Intensity mode and 
can be used to increase or decrease the stimulus intensity, the current 
intensity value (in milliamps) is displayed on the knob icon.  Press this 
knob to switch to the Pulse Width mode and  turn to change the value of 
the electrical stimulus pulse width, the current pulse width value (in 
microseconds) will be displayed on the knob icon. 

Gain / Sweep - this knob defaults to the Gain mode and can be used to 
increase or decrease the gain (uV/Div) of the Trace window.  Press the 
knob to switch to Sweep mode and turn to adjust the sweep speed 
(ms/Div) of the Trace window. 

F Keys 

 

Train / Single - in Train mode, when the Stim button on the handheld 
stimulator or the Run/Stop button is pressed a train of stimuli will be 
delivered.  In Single mode, when the Stim button on the hand held 
stimulator or the Single button is pressed a single stimulus will be 
delivered.  This mode is useful for determining supramaximal stimulation 
prior to delivering a train of stimuli. 

Reset Timer - manually resets the timer to zero. 

Muscle List - opens the RNS Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData Summary window. 

PC Function Keys (F5-F12) 

 

F5-Cursor - enables Cursor mode (see below). 

F6-Position - enables Position mode (see below). 
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F7-Auto Seq. - toggles the Auto Sequencer On and Off. 

 

Cursor mode (F5) 

Knobs 

 

Select Cur / Move Cur - this knob defaults to the Select Cursor mode 
and can be used to move the focus (yellow triangle) to any cursor on any 
trace within the Trace window.  Press this knob to switch to Move Cursor 
mode which will allow you to move the selected (green triangle) cursor. 

Select Cur / On-Off - this knob defaults to the Select Cursor mode and 
can be used to move the focus (yellow triangle) to any cursor on any trace 
within the Trace window.  Press the knob to hide the selected cursor (turn 
the cursor Off) or bring it back to view (turn the cursor On). 

Sel. Trial - turn this knob to select an RNS train.  When selected, the train 
will be displayed in yellow. 

Gain - turn this knob to change the gain of the selected RNS train.  The 
current gain setting for the train is displayed on the knob icon. 

F Keys 

 

AutoPlace Cursors - press this function key to re-apply the auto-cursor 
algorithm to the selected (yellow) train. 

Clear Cursors - press this function key to clear all cursors from the 
selected (yellow) train. 

All On / All Off - defaults to All On mode.  Press to hide all cursors on all 
trains. 

 

Position mode (F6) 

Knobs 
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Sel. Trial / Move - defaults to Select Trial mode, turn this knob to select a 
stored RNS train.  When selected, the train will be displayed in yellow 
color.  Press the knob to switch to Move mode, then turn to move the 
selected train up or down within the Trace window. 

Move Active - turn this knob to move the active (white colored) train up or 
down within the Trace window. 

Sel. Trial / Delete - turn this knob to select a stored RNS train.  When 
selected, the train will be displayed in yellow color.  Press the knob to 
permanently delete the selected train. 

Gain - turn this knob to change the Gain of the selected RNS train.  The 
current gain setting for the train is displayed on the knob icon. 

F Keys 

- there are no functions assigned to the F Keys is position mode. 

RNS Test Setup 

RNS test setup options are discussed in detail in the Test Protocol Setup 
chapter of the Help system. 

Single / Train Mode 

Mode:  Select the default stimulus mode for the test.  Choices are Train or 
Single. 

 Train - When the Stim button on the handheld stimulator or the Run/Stop 
button is pressed a train of stimuli will be delivered. 

 Single - When the Stim button on the hand held stimulator or the Single 
button is pressed a single stimulus will be delivered.  This mode is useful 
for determining supramaximal stimulation prior to delivering a train of 
stimuli. 

Using the Automatic Sequencer 

After checking the recording setup, press the F1 (Train/Single) function key to 
select Train mode.  Follow the instructions below for Automatic Stimulus Train 
delivery. 

Automatic Stimulus Train Delivery: 

Change the Auto Seq. control from Off to On.  The first row in the RNS 
Table will be automatically highlighted. 
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Press the Stim button on the electrical stimulator handle.  A train of 
stimuli will be delivered to the patient and a trace will be displayed for 
each stimulus within the train.  The traces are stacked in a horizontal 
fashion (see Spread setting above). 

After the Train is completed the program will automatically store the train 
and it will be displayed in a "purple" color.  At this point the timer is started. 
 The timer is displayed just below the side field in the RNS Controls 
window or at the top of the screen in the Controls Toolbar. 

Once the timer reaches the preprogrammed pause time for the stimulus 
train, the program will automatically deliver the next stimulus train in the 
RNS Table. 

Stimulation will continue in this manner until the last stimulus train is 
delivered. 

 You can stop the automatic sequencer at any time by changing the 
Auto Seq. control from On to Off. 

2 Channel Recording in RNS 

The RNS test protocol is capable of simultaneous recording from 2 channels. 

To Enable 2 Channel Mode: 

In the RNS Test Setup window, change the Max Channel parameter from 1 
to 2.  Then, change the status of channel 2 in the Amplifier Settings from Off 
to On and set the appropriate gain and filter values for the channel. 

 

 

Labeling the Channels: 

You can label each channel with the name of the muscle it will be recording 
from.  To do this, add a compound muscle name to the muscle list, this is 
actually two muscles names on the same line separated with a comma. 
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Channel 1 will use the name to the left of the comma, while channel 2 will use 
the name to the right of the comma. 

 

Data Acquisition: 

In 2 Channel recording mode the Sierra Wave program will automatically split 
the trace window.  Responses from channel 1 will be displayed in the left half 
of the window, while responses to channel 2 will be displayed in the right half 
of the window. 
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2 channel RNS Trace window. 

The program will also create a complete table for each channel in the RNS 
Table window.  The RNS Histogram will be split in half with channel 1 
represented in the top half of the window and channel two in the bottom half. 
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2 channel RNS Table & Histogram. 

 

Stimulator Polarity 
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Press the Reverse Polarity (+/-) button on the electrical stimulator handle to 
select the Cathode (i.e., the negative stimulus probe).  A green LED indicates the 
probe that is the Cathode.  For routine nerve conduction, RNS, and Blink 
Studies the Cathode (-) should be oriented closest to the recording 
electrodes. 

Clicking on the Polarity field in the Controls window or Controls Toolbar can 
also reverse the stimulator polarity.  The default (i.e., Normal) mode has the 
right-side probe as the Cathode (if holding the stimulator with the Stim button 
facing you and the probes up); the reversed state will make the left-side probe 
the Cathode.  The image of the stimulator on the screen updates to indicate the 
selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show the 
Right-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will show 
the Left-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 
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Cursors (RNS) 

In the RNS Test Protocol, if the response is of sufficient amplitude, cursors are 
automatically placed on the trace.  Depending on how your test protocol is 
configured - two or three cursors are placed on Response 1 and 2.  If the test is 
configured for O-P amplitude measurements then an Onset (O), and Peak (P) 
cursor are displayed.  If the test is configured for P-T amplitude measurements 
then an Onset (O), Peak (P), and Trough (T) cursor are displayed. 

 

RNS single trace and two trains with cursors positioned. 

 

Adjusting Cursor Positions 

The positions of the cursors on a trace with a train can be easily adjusted by 
following one of the methods below. 
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 Using the mouse - simply left click on the appropriate cursors blue 
triangle and drag the cursor along the trace to its new location.  While 
the cursor is being moved the blue triangle is replaced with a yellow 
triangle. 

 Using the F5-Cursor mode - press the F5 key on the PC's keyboard 
to change the base unit's knob and functions keys to cursor mode.  See 
the Knob & Fkey Controls topic for further information. 

 

Change Gain of a Train 

To change the gain of a selected RNS train, perform the following. 

1. Select the Train you want to change. 

 Using the Mouse - simply left click the mouse over any of the traces 
within the train, when selected the train will be displayed in yellow 
rather than purple. 

 Using the Knobs - enter Position mode by pressing the F6 function 
key on the PC's keyboard.  Turn Knob #1 (Sel Trial / Move) until the 
desired train is selected. 

2. Now, turn Knob #4 (Gain), the selected train will be changed and it's 
current gain value will be displayed on the knob's icon. 

 

 To change the gain of all the RNS trains at one time, simply turn Knob #4 
(Gain / Sweep). 

RNS Timer 

After an RNS train is automatically stored, a timer is started.  The Timer is 
displayed just below the side field in the RNS Controls window and to the left of 
the stimulus controls in the Controls Toolbar. 
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Use the timer to measure the time elapsed while the patient exercises the muscle 
or the time elapsed between successive stimulus trains. 

The timer automatically resets to zero after each train is stored.  You can also 
manually reset the timer to zero by pressing the F2 (Reset Timer) function key 
on the Sierra Wave base unit. 

Train Comments 

A comment can be entered for each train in the RNS Table window. 

Simply select the comment field by left clicking the mouse within the comment 
box, then type your comment and press the Enter key when you have finished. 

 

Table Font Size 

In all test protocols the font size of the Table window can be increased or 
decreased.  Simply right click on the table and select Font Size from the pop-up 
menu.  The choices are Small (default), Medium, Large, and Extra Large. 

 

Changing the font size of the Muscle Scoring Table. 
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Changing the font size of the NCV Tables. 

 

To save your selection as part of the test protocol's default settings, select Save 
Test Parameters from the Edit menu. 

 The selected font size is also applied to that table in the TabData window. 

Histogram window 

The Histogram window can display the Amplitude, Area, or both for each 
response in every train.  Right-click over this window to select the histogram you 
would like to view. 
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Amplitude 

This histogram displays the amplitude (mV) for each response in every train. 
 Different colors are used to represent the different trains. 

 

 

Area 

This histogram displays the area (mV/ms) for each response in every train. 
 Different colors are used to represent the different trains. 

 

 

Amplitude and Area 

This histogram displays both the amplitude (mV) and area (mV/ms) for each 
response in every train.  Different colors are used to represent the different 
trains. 
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First Response 

Select this in combination with Amplitude or Area to show the percentage change 
between the first response in train #1 and the first response in all other trains. 

 

 

Muscle List (F3) 

The F3 (Muscle List) function key is a convenient way to add muscles to the 
Study window after a Study List has been selected or after the RNS Test 
Protocol has been loaded. 

 

To Add a Muscle to the Study Window 

1. From within the RNS Test Protocol, press the F3 (Muscle List) function 
key.  The Select Muscle window will be displayed. 
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F3 - Select Muscle window. 

2. To add a single muscle, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 
the muscle.  Verify the Side parameter, use Knob #2 (Side) to 
change this if necessary.  Press the OK key on the Sierra Wave 
base unit. 

 Using the Mouse - verify the Side parameter and then double 
click on the muscle name. 

3. To add multiple muscles, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 
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the muscle.  Repeat this process until all of the muscles you want 
to add are highlighted.  Verify the Side parameter, use Knob #2 
(Side) to change this if necessary.  Press the OK key on the Sierra 
Wave base unit. 

 Using the Mouse - single click the mouse over the appropriate 
muscle names.  Once all of the muscles have been selected, verify 
the Side parameter and then click OK. 

 

 Setting the Side parameter to Left & Right will add the muscle to the Study 
window twice, once for the Left and once for the Right. 

 Adding muscles to the Study window in this manner is only temporary.  To 
add muscles to a Study List permanently, review the help topic "Changing an 
Existing Study". 

Move To 

This feature allows the RNS trains to be moved to a different muscle.  For 
example, the ADM traces can be moved to any other muscle in your RNS nerve 
list. 

To Move the traces to another muscle: 

 Right click the mouse over the muscle in the Study window. 

 Select Move To from the pop-up menu. 

 Select a muscle from the displayed list. 
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Review a single Train 

To view the responses for only a single Train, simply click on the corresponding 
Trial # in the Study window. 
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Deleting a Train 

To Delete a selected RNS train, perform one of the following. 

 Using the Mouse - select the train you want to delete by clicking on it 
with the left mouse button.  When selected, the entire train color will 
change from purple to yellow.  Now you can either press the Clear key 
on the Sierra Wave base unit or you can right click the mouse and select 
Delete Selected Train from the pop-up menu.  A confirmation message 
will be displayed, click OK and the selected train will be deleted. 

 Using the Knobs - enter the Position mode by pressing the F6 function 
key.  Now turn Knob #3 (Sel Trial / Delete) until the train you want to 
delete is selected, a selected train is displayed in yellow.  Press the knob 
to delete the selected train.  Exit Position mode by pressing the F6 
function key a second time or by pressing the OK key on the Sierra Wave 
base unit. 

 Using the RNS Table - right click the mouse over the row in the RNS 
Table that corresponds to the train you want to delete.  From the pop-up 
menu, select Delete Row. 

 

RNS Table - right click over row and select delete. 

 

Start New Run 

If you decide to repeat a muscle you have a choice of clearing the previously 
acquired data for the muscle or of keeping the previously acquired data. 

To Clear the Previous Data & Repeat: 

1. Right click the mouse in the RNS Trace window over the previously 
acquired trains.  From the pop-up menu select Delete All Stored Trains. 
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2. A confirmation message will be displayed.  Click OK and all previous data 
for the muscle is cleared. 

3. Acquire new data for the muscle in the normal fashion. 

 

To Keep the Previous Data & Repeat: 

1. Right click the mouse over the muscle's name in the Study window. 
 From the pop-up menu select Start New Run. 

2. A second run node will be displayed under the muscle's name. 

3. Acquire new data for the muscle in the normal fashion. 

4. To view the first run done on the muscle select Run #1 from the Study 
window.  To view the second run done on the muscle select Run #2. 

 

Two separate runs have been acquired for the Right Abd Poll Brev muscle. 

5. If you want to delete one of the runs for the muscle, simply right click 
over the run you want to delete and select Delete from the pop-up menu. 
 A confirmation message will be displayed, click OK to delete the run. 
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Saving Changes to RNS Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the RNS test protocol. 

 Select Save Test Parameters from the Edit menu. 



Sierra Wave Help Manual 

676 

Blink 

Blink Basics 

This topic is a repeat of the basic Blink Reflex steps found in the Getting Started 
chapter. 

Select the Blink  Test: 

 If a Study has already been selected, simply click on the Blink test 
protocol within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the Blink test protocol from the Study/Test menu. 

 

Once the test has been selected.  Follow these steps for performing Blink 
data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the test being performed. 

Typical Blink Settings 

Gain = 200 uV/Div 

Hicut = 5k Hz 

Locut = 10 Hz 

Sweep Speed = 10.0 ms/Div 

2.  Electrode Placement 

 Attach the electrodes to the patient.   

 Connect the electrode leads from the patient‟s left side to the Channel 1 
inputs on the amplifier, and connect the electrode leads from the right side 
to the Channel 2 inputs. Electrodes must be connected to the amplifier in 
this configuration to ensure proper display of test data. 

Active 1 Input:  Belly of the Left orbicularis oculi muscle below the eye. 

Reference 1  Input:  Left side of nose. 

Active 2 Input:  Belly of the Right orbicularis oculi muscle below the eye. 
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Reference 2  Input:  Right side of nose. 

Ground Electrode:  Forehead or cheek. 

3.  Select Side of Stimulation 

Select the side, Left or Right, that will be stimulated first.   

Trials collected during left-side stimulation are displayed in the top half of the 
screen with the response recorded on the ipsilateral side (e.g., Ch1 : L) 
positioned above the response recorded on the contralateral side (Ch2 : L). 

Responses collected during right side stimulation display in the bottom half of 
the screen. Eliminating the need to change electrodes at the amplifier, the 
Sierra automatically inverts the order in which trials collected during right side 
stimulation are displayed so that the ipsilateral response (Ch2 : R) appears 
above the contralateral response (Ch1 : R). 

4.  Check Stimulator Polarity 

For Blink Reflex Studies, the Cathode (-) should be oriented closest to the 
recording electrodes. 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  

Clicking on the Polarity field in the Blink Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., normal) 
mode has the right-side probe as the Cathode (if holding the stimulator with 
the Stim button facing you and the probes up); the reversed state will make 
the left-side probe the Cathode.  The image of the stimulator on the screen 
updates to indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show 
the Right-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 
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In the Reversed mode, the electrical stimulator image on the screen will 
show the Left-side probe as the Cathode (-).  The polarity field on the screen 
will indicate Rev. 

   

Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

5.  Stimulate 

Increase the stimulus intensity level by turning the wheel on the electrical 
stimulator handle.  The intensity  level (in milliamps) is displayed on the 
screen in a small pop-up window and also in the Stimulator section.  Once 
you have reached an appropriate starting intensity apply the stimulator to the 
patient's supra-orbital nerve and deliver the stimulus by pressing the Stim 
button on the electrical stimulator handle.  The stimulator light, located next 
to the intensity level on the Screen, will flash Green and the patient's 
response will be displayed. 

 The Single key on the Sierra Wave base unit can also be used to deliver 
a single stimulus.  Intensity can also be adjusted using Knob #3 (Intensity / 
Pulse Width) on the base unit. 

6.  Store the Response 

To store the response, perform one of the following actions; 

 Press the Store button on the electrical stimulator handle. 

 Press the Store key on the Sierra Wave base unit. 

 Press the Footswitch pedal. 

 Click the Store button in the Blink Controls window. 

When the response is stored the color of the trace changes from white to 
purple  

7.  Repeat Stimulation & Store additional responses 

Generally, two trials are acquired per side. 
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8.  Move Latency Markers (R1, R2i, R2c) 

Three latency markers are utilized in the Blink test protocol.  R1 is positioned 
at the onset of the ipsilateral R1 response.  R2i is positioned at the onset of 
the ipsilateral R2 response.  R2c is positioned at the onset of the contralateral 
R2 response. 

Each of the three markers has a different line pattern. 

To move the latency markers: 

 Use Knob #2 (R1) to move the R1 marker, use Knob #3 (R2i /R2c) to 
move the R2i and R2c markers. 

 Use the mouse to click and drag the appropriate marker to the desired 
location. 

9.  Change the Side and Repeat steps 4 - 8. 

Selecting a different side automatically stores the currently active (white) 
traces. 
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Blink Example. 

 The program will automatically calculate the R2i-R2c difference for each 
side.  It will also calculate the Left minus Right differences for R1, R2i, R2c, 
and R2i-R2c. 

 

Blink Cursor Table 
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10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Test 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

Knob & Fkey Controls (Blink) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in normal Acquisition mode or has 
been switched to Position mode. 

 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 
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Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

R1 / Intensity - turn this knob to move the R1 latency marker.  Press this 
knob and turn to increase or decrease the electrical stimulus intensity. 

R2i / R2c - this knob defaults to the R2i mode, turn the knob to position 
the R2i (R2 ipsilateral) latency marker.  Press the knob to activate the R2c 
mode and then turn to position the R2c (R2 contralateral) latency marker. 

Gain / Sweep - this knob defaults to the Gain mode and can be used to 
increase or decrease the gain (uV/Div) of the Trace window.  Press the 
knob to switch to Sweep mode and turn to adjust the sweep speed 
(ms/Div) of the Trace window. 

F Keys 

 

Left / Right - press to select the side of stimulation. 

Trials collected during left-side stimulation are displayed in the top 
half of the screen with the response recorded on the ipsilateral side 
(Ch1 : L) positioned above the response recorded on the contralateral 
side (Ch2 : L). 

Responses collected during right side stimulation display in the 
bottom half of the screen. Eliminating the need to change electrodes at 
the amplifier, the Sierra automatically inverts the order in which trials 
collected during right side stimulation are displayed so that the 
ipsilateral response (Ch2 : R) appears above the contralateral 
response (Ch1 : R). 

TabData - opens the TabData Summary window. 
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Position mode 

Knobs 

 

Sel. Trial / Move - defaults to Select Trial mode, turn this knob to select a 
stored Blink trial.  When selected, the trial will be displayed in yellow color. 
 Press the knob to switch to Move mode, then turn to move the selected 
trial up or down within the Trace window. 

Move Active - turn this knob to move the active (white colored) trial up or 
down within the Trace window. 

Sel. Trial / Delete - turn this knob to select a stored Blink trial.  When 
selected, the trial will be displayed in yellow.  Press the knob to 
permanently delete the selected trial. 

Gain - turn this knob to change the Gain of the selected Blink trial.  The 
current gain setting for the trial is displayed on the knob icon. 

F Keys 

 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
from each channel are separated according to the Trace Position Settings. 
 Pressing this key switches to Overlay mode which will superimpose all 
traces from each channel on top of one another. 

Trace / Trial - defaults to Trial mode, in Trial mode the select knobs 
(Knobs #1 and #3) will function to select a complete trial.  Press to activate 
Trace mode, in Trace mode the select knobs will function to select 
individual traces rather than complete trials. 

Cursor mode 

- this mode is not available in the Blink Reflex test protocol. 
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Blink Test Setup 

Blink Reflex test setup options are discussed in detail in the Test Protocol 
Setup chapter of the Help system. 

Click here, to go to this topic. 

Markers 

The Blink Reflex test protocol uses three latency markers, they are R1, R2i, and 
R2c.  Each marker has its own distinct pattern. 

 

R1 - this marker is shown as a straight line. 

R2i - this marker is shown as a dotted line. 

R2c - this marker is shown as a dashed line. 

 

To position the latency markers use the corresponding knob on the Sierra Wave 
base unit or click on the marker using the mouse and drag it to its new location. 

Raster / Overlay 

Positioning the acquired traces in Overlay mode can be helpful when trying to 
identify the precise takeoff point of a response. 

To enable Overlay mode: 

 Enter Position mode by pressing the F6 function key. 
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 Press the F1 (Raster / Overlay) function key to toggle it to Overlay mode. 

 

To Overlay traces by adjusting the Trace Position Settings: 

 Right click the mouse over the Trace window. 

 From the pop-up menu, select Trace Position Settings. 

 Change the Trial Offset value to 0.0 and press the Enter key. 

 Click OK. 

Stimulator Polarity 

Press the Reverse Polarity (+/-) button on the electrical stimulator handle to 
select the Cathode (i.e., the negative stimulus probe).  A green LED indicates the 
probe that is the Cathode.  For routine nerve conduction, RNS, and Blink 
Studies the Cathode (-) should be oriented closest to the recording 
electrodes. 

Clicking on the Polarity field in the Blink Controls window or Controls 
Toolbar can also reverse the stimulator polarity.  The default (i.e., Normal) mode 
has the right-side probe as the Cathode (if holding the stimulator with the Stim 
button facing you and the probes up); the reversed state will make the left-side 
probe the Cathode.  The image of the stimulator on the screen updates to 
indicate the selected polarity as well. 

In the Normal mode, the electrical stimulator image on the screen will show the 
Right-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Nml. 

   

Controls Window.                          Controls Toolbar. 

Normal mode (right probe is Cathode). 

In the Reversed mode, the electrical stimulator image on the screen will show 
the Left-side probe as the Cathode (-).  The polarity field on the screen will 
indicate Rev. 
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Controls Window.                          Controls Toolbar. 

Reversed mode (left probe is Cathode). 

 

Table Font Size 

In all test protocols the font size of the Table window can be increased or 
decreased.  Simply right click on the table and select Font Size from the pop-up 
menu.  The choices are Small (default), Medium, Large, and Extra Large. 

 

Changing the font size of the Muscle Scoring Table. 

 



Protocols 

687 

 

Changing the font size of the NCV Tables. 

 

To save your selection as part of the test protocol's default settings, select Save 
Test Parameters from the Edit menu. 

 The selected font size is also applied to that table in the TabData window. 

Trace Positioning & Delete 

Trace Positioning 

There are several methods of changing the vertical positions of the Blink Reflex 
traces within the Trace window. 

Using the Mouse: 

Left click on the trial you want to move and drag the trial to it's new 
location. 

 To select and move an individual trace, rather than the entire trial, 
first right click the mouse and disable the "Trial Selection Mode" setting 
in the pop-up menu by clicking on it to remove the checkmark. 
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Using the Knobs: 

1. Enter the Position mode by pressing the F6 function key on the 
PC's keyboard. 

2. Turn Knob #1 (Sel Trial / Move) until the trial you want to move is 
selected.  A selected trial is displayed in yellow rather than purple. 

3. Press the knob to activate the Move mode, now turn the knob to 
move the selected trial up or down. 

4. Press the knob a second time to return to the Sel Trial mode. 

 To select and move an individual trace, rather than the entire trial, 
first press the F4 (Trace / Trial) function key to toggle the function to 
Trace mode. 

Using the Trace Position Settings: 

1. Right click over the Blink Reflex Trace window. 

2. From the pop-up menu, select Trace Position Settings.  The 
Trace Position Settings window will be displayed. 

 

Trace Position Settings window. 

3. Change the listed parameters, then click OK. 

Start Position: This is the default trace position for the first trace in 
the window.  It is the number of vertical divisions below the top of 
the trace window.  In this example, the first trace will be positioned 
4 divisions below the top of the window. 

Trial Offset:  This setting determines how much space will 
separate each stored Blink Reflex trace acquired from each 
channel.  In this example the setting is 2.5 divisions, therefore the 
second Blink Reflex trace will be displayed 2.5 divisions below the 
first trace.  If a third Blink Reflex trace is acquired it will be 
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displayed 2.5 divisions below the second Blink Reflex trace and so 
on. 

Channel Offset:  This setting only applies when more than one 
channel is turned ON.  It is the amount of space, in vertical 
divisions, that separates the two Live channels. 

 

Trace Deletion 

To delete Blink Reflex traces use one of the following methods. 

 Using the Mouse - select the trial you want to delete by clicking on it 
with the left mouse button.  When selected, the trial color will change 
from purple to yellow.  Now you can either press the Clear key on the 
Sierra Wave base unit or you can right click the mouse and select Delete 
Selected Traces from the pop-up menu.  A confirmation message will be 
displayed, click OK and the selected trial will be deleted. 

 To select an individual trace, rather than the entire trial, first right click 
the mouse and disable the "Trial Selection Mode" setting in the pop-up 
menu by clicking on it to remove the checkmark. 

 Using the Knobs - enter the Position mode by pressing the F6 function 
key.  Now turn Knob #3 (Sel Trial / Delete) until the trial you want to 
delete is selected, a selected trial is displayed in yellow.  Press the knob 
to delete the selected trial.  Exit Position mode by pressing the F6 
function key a second time or by pressing the OK key on the Sierra Wave 
base unit. 

 To select and delete an individual trace, rather than the entire trial, first 
press the F4 (Trace / Trial) function key to toggle the function to Trace 
mode. 

Saving Changes to Blink Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the Blink Reflex test 
protocol. 

 Select Save Test Parameters from the Edit menu. 
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Single Fiber EMG 

Performing SFEMG 

Select the SFEMG  Test:   

 If a Study has already been selected, simply click on a SFEMG muscle 
name (i.e., Right Biceps) within the Study window or turn Knob #1 (Study 
Item) to highlight the muscle name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual SFEMG test protocol from the Study/Test menu, a 
muscle list will be displayed allowing you to pick the muscle or muscles 
that you will be testing on the patient.  Notice that when a muscle is 
selected, it is displayed within the Study window. 

 

Once the muscle has been selected.  Follow these steps for performing 
routine SFEMG data acquisition and analysis: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate.  Only Channel 1 can be used in the SFEMG test 
protocol. 

Typical Settings for SFEMG 

Gain = 100 uV/Div 

Hicut = 10k Hz 

Locut = 500 Hz 

Sweep Speed = 0.5 ms/Div 

2.  Verify the Side 

Make sure the appropriate side, Right or Left, is selected. 
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3.  Set the capture buffer Count value. 

The Count value is the total number of traces that can be collected in the 
SFEMG trace buffer.  When a SFEMG signal crosses the Trigger Line the 
trace is added to the trace buffer and the Capture number is incremented by 
one.  The Count can be set to 10, 20, 30, 50, 70, 100, 150, or 200.  This 
setting is located in the SFEMG Controls window and can be easily changed 
using the mouse. 

 

4.  Insert the SFEMG Needle Electrode. 

5.  Adjust the Gain and Sweep Speed as necessary. 

During SFEMG data acquisition you can easily adjust the Gain and Sweep 
Speed by using Knob #4 (Gain / Sweep) on the Sierra Wave base unit. 
 Simply turn the knob to adjust the gain, to change the sweep speed, press 
the knob first to toggle it to the sweep mode, then turn to change the sweep 
speed. 

You can also use the mouse to change these settings in the SFEMG 
Controls window. 

6.  Adjust the Volume 

Increase or decrease the Sierra Wave's internal speaker by using the Volume 
knob on the left hand side of the base unit. 

7.  Adjust Trigger Level & Delay 

Knob #3 (Trig Lev /Trig Del) defaults to the Trig Lev mode, turn this knob to 
move the position of the trigger level (horizontal portion of purple crosshair) 
up or down within the trace window.  Each time a SFEMG potential crosses 
the trigger level the sweep is added to the capture buffer.  Press the knob to 
activate Trig Del mode then turn to move the delay point (vertical portion of 
purple crosshair) left or right in one division increments.  Changing the delay 
point allows you to see more or less data after the triggering potential. 

 The mouse can also be used to move the Trigger Level/Delay indicator. 

8.  Acquire SFEMG Potentials 

Once the appropriate SFEMG signal is located and the Trigger and Delay 
positions have been adjusted appropriately, press the Clear key on the Sierra 
Wave base unit to reset the Capture buffer to zero.  Now, acquire SFEMG 
potentials until the buffer Count is reached or until you are satisfied that 
enough SFEMG data has been captured for analysis. 
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Acquisition mode, the first potential is the triggering potential. 

9.  Stop Data Acquisition 

Press the Run/Stop key on the Sierra Wave base unit to stop data 
acquisition.  This will change the display to the Analysis mode. 

The Analysis mode has two trace areas, the Captured Trace area and the 
Filtered Trace area.  Typically a Sequential IPI Plot and Results Table are 
also displayed. 

Captured Trace area - shows all the traces in the current capture buffer. 
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Filtered Trace area - shows only those traces that fall within the 
Sequential IPI Plots include area (yellow band).  Blocking traces (red) are 
also shown in this area when the Jitter is abnormal.  Jitter measurements 
are based on the traces in this area. 

 

SFEMG Analysis Mode. 

10.  Verify the Position of the Analysis Marker 

Check the position of analysis marker (shown in light-blue) in the Captured 
Trace area, the rising edge of the potentials to be analyzed should cross 
through the analysis marker.  If a single fiber potential does not transition 
through the marker it will be considered as a block.  The width of the analysis 
marker should be adjusted to encompass all the potentials that you want to 
analyze.  Use the mouse or Knob #2 (Threshold / Min Lat) to make 
adjustments to the analysis marker position and width.  The Filtered Trace 
area and the Sequential IPI Plot are automatically updated when the analysis 
marker is repositioned. 
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Analysis Marker correctly positioned in the Capture Trace area. 

Colors Used in the Capture Trace Area 

Trace Color Description 

White These traces are within the Sequential IPI Plot 
include area (shown as yellow band on the 
plot) and are added to the Filtered Trace area 
where they are used for calculating the jitter. 

Red These traces did not cross through the 
analysis marker and are therefore considered 
blocks.  They are added to the Filtered Trace 
area if the Jitter measurement is abnormal.  If 
the Jitter is normal, these traces are most likely 
the result of artifacts or mis-triggers. 

Dark Blue These traces lie outside the Sequential IPI Plot 
include area and are not added to the Filtered 
Trace area. 

Light Blue These traces have been manually rejected 
from the data set and are removed from the 
Filtered Trace area. 

Yellow Indicates the trace has been selected (using 
the mouse or Knob #4), it can be manually 
rejected or deleted from the data set. 

 

11.  Make adjustments to the Sequential IPI Plot (Optional) 
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This is the default plot that is displayed in the Analysis Mode.  The 
Sequential IPI Plot displays the distribution of the Inter-Potential Intervals by 
plotting the difference between each individual IPI (Inter-Potential Interval) 
and the mean IPI for the whole data set.  The mean IPI is indicated as zero 
on the vertical axis.  The horizontal axis represents each sweep in the data 
set, up to a maximum of 200. 

Blocks are shown as red plus signs at the top of the plot and as red traces in 
the Captured and Filtered Trace areas.  A +/- 3 standard deviation yellow 
band is drawn about the mean value and defines an acceptance limit of IPI for 
computing jitter.  Potentials outside the yellow band are shown as dark blue 
color in the Captured Trace area and are not included in the Filtered Trace 
area.  A circle is drawn around the currently selected trace (i.e., corresponds 
to the yellow trace). 

The upper & lower boundaries of the yellow band can be adjusted by clicking 
on the boundary with the mouse and then dragging it up or down.  The 
Captured and Filtered trace areas and jitter measurements are updated 
automatically when the boundary is changed.  This is a powerful and quick 
way to analyze multiple potentials in the data set and to exclude traces that 
represent technical problems. 

 

Sequential IPI Plot 

12. View other Data Plots (Optional) 

The plot window can display up to three data plots at one time.  To view other 
plots, simply right-click over this window and select the plots you would like 
to view from the pop-up menu. 
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Sequential IPI Plot with right-click menu. 

The available plots are: 

Sequential IPI:  See step #11 above. 

IPI Histogram:  Displays the distribution of the IPI's in a bar graph format. 
 The height of each bar indicates the counts (N) for each value of IPI.  This 
graph should demonstrate a Gaussian distribution; any deviation would 
suggest that spurious data may have been acquired. 
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IPI Histogram 

 

Sequential IDI Plot:  Displays the distribution of the Inter-Discharge 
Intervals (IDI) for the data set. 

 

Sequential IDI Plot 

 

IDI vs IPI Plot:  Displays the distribution of the IPI versus the IDI, this plot 
is used to view the jitter dependence on the preceding interval. 
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IDV vs. IPI Plot 

 

Jitter Histogram:  This histogram provides a quick summary of the data 
collected for the muscle.  The vertical axis marks the count, while the 
horizontal axis indicates jitter (in microseconds, us).  The height of colored 
bar graphs indicates the number of runs containing that amount of jitter. 
Normal jitter is indicated by green bars, abnormal jitter as red bars, and 
abnormal jitter with blocking as red cross-hatched bars.  A dashed line 
marks the jitter norm for individual potential pairs in the muscle.  This is 
the default plot for the Acquisition Mode. 
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Jitter Histogram 

13.  Manually Reject Traces (Optional) 

Traces can be manually excluded from the analysis by selecting them with 
the mouse (left-click).  Once selected the trace is displayed in yellow color. 
 Now, right-click and select Reject Selected Traces from the pop-up menu, 
this removes the trace from the analysis.  Rejected traces are displayed in 
light blue color.  You can re-accept a rejected trace by selecting it, then right-
click to remove the check mark next to Reject Selected Traces. 
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Example showing three manually rejected traces in the Captured Trace area that have been 
automatically removed from the Filtered Trace area. 

14.  Store the Run 

Press the Store key on the Sierra Wave base unit to keep the run, by default 
all the traces for the run are stored as well.  In the Results Table the "Stored" 
field will change from No to Yes. 

 As each SFEMG run is stored, you will see a new "node" appear in the 
Study window below the muscle name.  The example below shows six runs 
stored for the Right Ext Dig Com muscle.   
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 If  you decide not to keep the run, do not press the Store key, simply 
return to the Acquisition mode by pressing the Run/Stop key and the run will 
be discarded. 

The Results Table records the analysis results for each run and calculates 
the mean and standard deviation values. 

 

SFEMG Results Table 

Run – indicates the run #.  If a run is analyzed more than once, it is 
indicated by .2, .3, and so on.  This would occur if more than one potential 
was analyzed in the run using the New Pair function key. 

Samples – indicates the total number of traces shown in the Filtered 
Trace area for that run. 
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Blocks – indicates the number of blocks shown in the Filtered Trace area 
for that run. 

IPI – displays the mean Inter-Potential Interval for the traces shown in the 
Filtered Trace area. 

Jitter – displays the lowest value of either the MCD or MSCD in 
microseconds (usec).  The user can right-click on this value and select 
Swap Jitter Value, this will display the larger of the two values in this field. 

Jitter Norm – the value on the first row of the table is the jitter norm for 
individual potential pairs.  The value in the mean row of the table is the 
overall MCD jitter norm for the muscle. 

MCD – the jitter as calculated by using the Mean Consecutive Difference 
for the run. 

MSCD – the jitter as calculated by using the Mean Sorted Consecutive 
Difference for the run. 

Freq. – displays the mean firing frequency of the triggering potential in 
hertz (Hz). 

Stored – indicates if the run has been stored to disk. 

Block Ratio – indicates the percentage of runs with blocking potentials. 

Fiber Density - displays the fiber density value from the Fiber Density 
window. 

15.  Analyze a Second Potential Pair (Optional) 

Sometimes the captured data can contain three or more time-locked action 
potentials.  In this case, you can analyze the additional combinations by 
pressing the F1 (New Pair) function key.  A new row will be added to the 
measurements table.  Repeat steps 10 to 14 to analyze the second potential 
pair. 

16.  Acquire additional SFEMG Runs. 

Press the Run/Stop key to return to Acquistion mode and repeat steps 7 
through 15 to acquire additional SFEMG runs.  Typically 20 runs should be 
collected for the muscle. 

17.  Select Next Muscle (optional) 

From Acquisition mode, turn Knob #1 (Study Item) to highlight the next 
muscle in the Study window.  If the muscle you want to examine is not 
displayed within the Study window, press F3 (Muscle List) and select the 
next SFEMG muscle from the list. 
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Move the SFEMG Needle Electrode to the new muscle and repeat the above 
steps as necessary. 

 It is a good idea to turn Off the preamplifier or turn down the Volume 
when moving the needle electrode to a new location. 

18.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

19.  Next Test 

 Use Knob #1 (Study Item) to highlight another Test Protocol in the 
Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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Knob & Fkey Controls (SFEMG) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in Acquisition mode or  Analyze 
mode. 

 Analyze mode is entered by pressing the Run/Stop key. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 

 

Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Trig Lev / Trig Delay - this knob defaults to the Trig Lev mode, turn the 
knob to change the vertical position of the trigger level indicator.  Press 
the knob to activate the Trig Delay mode, then turn to change the trigger 
delay position from 1 to 9 divisions in 0.1 division increments. 

Gain / Sweep - turn the knob to change the gain of the SFEMG trace. 
 Press the knob, then turn to change the sweep speed of the SFEMG 
trace. 

F Keys 

 

Muscle List - opens the SFEMG Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData Summary window. 
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Analyze  mode 

Knobs 

 

Run Select - turn this knob to highlight and review stored runs in the 
Results table.  When the run is highlighted the traces for that run will be 
displayed in the trace window. 

Threshold / Min Lat - this knob defaults to the Threshold mode, turn the 
knob to move the Analysis Marker up or down within the Trace window. 
 Press the knob to activate the Min Lat mode, then turn to move the 
Analysis Marker left or right within the Trace window. 

Disp Trace / Trace Cnt - this knob effects how the traces in the SFEMG 
capture buffer are displayed.  Turn the knob to change the starting display 
trace number.  Press the knob, then turn to change the trace count 
number. 

Here's an example of how to use the Trace Cnt and Disp Trace 
settings to view subsets of the capture buffer: 

Assume there are 50 total traces in the SFEMG capture buffer.  The 
Trace Cnt will default to 50 and the Disp Trace number will default to 1. 
 Therefore all 50 traces (1 to 50) are displayed in the Trace window. 
 Now, change the Trace Cnt to 20 and leave the Disp Trace number at 
1.  You will see traces 1-20 displayed in the Trace window.  You can 
now change the Disp Trace number to 21, now you can view traces 
21-40.  Change the Disp Trace number again and it goes to 41, now 
you can view traces 41-50. 

Trace Sel / Delete - defaults to the Trace Sel mode, turn this knob to 
select a SFEMG trace.  When selected, the trace will be displayed in 
yellow color.  Press the knob to Delete the selected trace from the capture 
buffer. 

F Keys 

 

New Pair - press to add an additional row to the results table and to 
analyze a second potential pair in the data. 
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Overlay / Raster - defaults Overlay mode, in this mode the traces are 
superimposed on top of one another.  Press to activate Raster mode, in 
this mode the traces are evenly rastered down the trace window. 

Muscle List - opens the SFEMG Muscle List window which allows you to 
select and add muscles to your Study window. 

TabData - opens the TabData summary window. 

SFEMG Test Setup 

SFEMG test setup options are discussed in detail in the Test Protocol Setup 
chapter of the Help system. 

Click here, to go to this topic. 

Muscle List (F3) 

The F3 (Muscle List) function key is a convenient way to add muscles to the 
Study window after a Study List has been selected or after the SFEMG Test 
Protocol has been loaded. 

 

To Add a Muscle to the Study Window 

1. From within the SFEMG Test Protocol, press the F3 (Muscle List) 
function key.  The Select Muscle window will be displayed. 
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F3 - Select Muscle window. 

2. To add a single muscle, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 
the muscle.  Verify the Side parameter, use Knob #2 (Side) to 
change this if necessary.  Press the OK key on the Sierra Wave 
base unit. 

 Using the Mouse - verify the Side parameter and then double 
click on the muscle name. 

3. To add multiple muscles, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 



Sierra Wave Help Manual 

708 

the muscle.  Repeat this process until all of the muscles you want 
to add are highlighted.  Verify the Side parameter, use Knob #2 
(Side) to change this if necessary.  Press the OK key on the Sierra 
Wave base unit. 

 Using the Mouse - single click the mouse over the appropriate 
muscle names.  Once all of the muscles have been selected, verify 
the Side parameter and then click OK. 

 

 Setting the Side parameter to Left & Right will add the muscle to the Study 
window twice, once for the Left and once for the Right. 

 Adding muscles to the Study window in this manner is only temporary.  To 
add muscles to a Study List permanently, review the help topic "Changing an 
Existing Study". 

SFEMG Trace Area 

The contents of the Trace Area will varying depending on whether the program is 
in the Acquisition or Analysis modes. 

Acquisition Mode 

Displays the volitional SFEMG activity.  Adjust the Gain and Sweep Speed by 
using Knob #4 (Gain / Sweep) on the Sierra Wave base unit.  Simply turn the 
knob to adjust the gain, to change the sweep speed, press the knob first to 
toggle it to the sweep mode, then turn to change the sweep speed. 

Adjust the Trigger Level and Delay by using Knob #3 (Trig Lev /Trig Del). 
 Turn this knob to move the position of the trigger level (horizontal portion of 
purple crosshair) up or down within the trace window.  Each time a SFEMG 
potential crosses the trigger level the sweep is added to the capture buffer. 
 Press the knob to activate Trig Del mode then turn to move the delay point 
(vertical portion of purple crosshair) left or right in one division increments. 
 Changing the delay point allows you to see more or less data after the 
triggering potential. 

 The mouse can also be used to move the Trigger Level/Delay indicator. 

Right-clicking on the trace area displays a menu of functions that can be 
used. 
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Trace Area in SFEMG Acquisition mode. 
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Right-click menu. 

Graticule Size:  The SFEMG Trace window is divided into a grid pattern 
using vertical and horizontal divisions or graticules.  The grid pattern can 
be changed by altering the number of these divisions.  The first number is 
for the number of vertical divisions, the second number is for the number 
of horizontal divisions. 

Capture Window:  When this feature is enabled the trace window is split 
into two sections; the top section shows the live SFEMG trace and the 
trigger level indicator line, the bottom section shows a rastered display of 
the most recently captured traces. 

Capture Window Options. 

When the Capture Window is enabled, right clicking within the capture 
window trace area will display a pop-up menu of display options. 

 

 

 Hide Capture Window – turns off the capture window. 

 Number of Captured Traces - changes the number of traces 
displayed in the captured window trace area.  Select 3, 5, or 10 
from the drop down list or type in any number between 2 and 
100. 

 Amplitude Markers – enables amplitude markers in the 
captured window area. 
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 Time Markers – enables time markers in the captured window 
area. 

 Raster / Overlay – sets the position of the captured window 
traces as either rastered or overlayed (i.e., superimposed). 

 Auto Position Traces - if captured window traces have been 
moved up/down using the mouse, this option will return the 
traces to their original positions. 

 Trial Highlighting - enables the alternating white/gray coloring 
of the rastered traces. 

 Sweep Speed – the sweep speed of the Live and Capture 
Window areas can be set independently. 

o Link Sweep to SFEMG Trace Window – automatically 
sets the captured window trace area to the same sweep 
speed as the Live trace. 

o 1, 2, 5, 10 ms/Div – sets the captured window trace 
sweep speed to the selected value.  Dual sweep values 
are displayed in the Controls Toolbar or Amplifier 
Controls window when the captured window sweep 
speed is set differently than the Live trace sweep speed. 

 Copy Window - copies the contents of the SFEMG trace 
window to the clipboard. 

Enabling the Capture Window Display as your default setting for 
SFEMG. 

The status of the Capture Window display feature and the number of 
traces displayed within the window can be saved as part of the default 
settings for the SFEMG test protocol.  With the feature enabled, simply 
select Save Test Parameters from the Edit menu. 

 

Analysis Mode 

The Analysis mode has two trace areas, the Captured Trace area on the top, 
and the Filtered Trace area on the bottom.  Right-clicking on the trace area 
displays a menu of functions that can be used. 

Captured Trace area - shows all the traces in the current capture buffer and 
an adjustable Analysis Marker. 
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Colors Used in the Capture Trace Area 

Trace Color Description 

White These traces are within the Sequential IPI Plot 
include area (shown as yellow band on the plot) and 
are added to the Filtered Trace area where they are 
used for calculating the jitter. 

Red These traces did not cross through the analysis 
marker and are therefore considered blocks.  They 
are added to the Filtered Trace area if the Jitter 
measurement is abnormal.  If the Jitter is normal, 
these traces are most likely the result of artifacts or 
mis-triggers. 

Dark Blue These traces lie outside the Sequential IPI Plot 
include area and are not added to the Filtered Trace 
area. 

Light Blue These traces have been manually rejected from the 
data set and are removed from the Filtered Trace 
area. 

Yellow Indicates the trace has been selected (using the 
mouse or Knob #4), it can be manually rejected or 
deleted from the data set. 

 

Filtered Trace area - shows only those traces that fall within the Sequential 
IPI Plots include area (yellow band).  Blocking traces (red) are also shown in 
this area when the Jitter is abnormal.  Jitter measurements are based on the 
traces in this area. 
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Trace Area in SFEMG Analysis mode. 

 

 

Right-click menu. 
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Delete Selected Traces:  Deletes the yellow (i.e, selected) traces from 
the capture buffer. 

Store:  Stores the run to disk.  This is the same function as pressing the 
Store key on the base unit. 

Reject Selected Traces:  Marks the selected trace as "manually rejected" 
which colors it light-blue and removes it from the Filtered Trace area but 
does not delete it from the capture buffer. 

Graticule Size:  The SFEMG Trace window is divided into a grid pattern 
using vertical and horizontal divisions or graticules.  The grid pattern can 
be changed by altering the number of these divisions.  The first number is 
for the number of vertical divisions, the second number is for the number 
of horizontal divisions. 

Save Traces to ASCII:  Allows all the traces in the Capture Trace area to 
be output to a comma separated values file (*csv).  For more information 
on using the ASCII Output Utility click here. 

Copy Window - copies the contents of the SFEMG trace window to the 
clipboard. 

SFEMG Plot Descriptions 

The plot window can display up to three data plots at one time.  To view other 
plots, simply right-click over this window and select the plots you would like to 
view from the pop-up menu. 

 

Sequential IPI Plot with right-click menu. 
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Sequential IPI Plot 

This is the default plot that is displayed in the Analysis Mode.  The 
Sequential IPI Plot displays the distribution of the Inter-Potential Intervals by 
plotting the difference between each individual IPI (Inter-Potential Interval) 
and the mean IPI for the whole data set.  The mean IPI is indicated as zero 
on the vertical axis.  The horizontal axis represents each sweep in the data 
set, up to a maximum of 200. 

Blocks are shown as red plus signs at the top of the plot and as red traces in 
the Captured and Filtered Trace areas.  A +/- 3 standard deviation yellow 
band is drawn about the mean value and defines an acceptance limit of IPI for 
computing jitter.  Potentials outside the yellow band are shown as dark blue 
color in the Captured Trace area and are not included in the Filtered Trace 
area.  A circle is drawn around the currently selected trace (i.e., corresponds 
to the yellow trace). 

The upper & lower boundaries of the yellow band can be adjusted by clicking 
on the boundary with the mouse and then dragging it up or down.  The 
Captured and Filtered trace areas and jitter measurements are updated 
automatically when the boundary is changed.  This is a powerful and quick 
way to analyze multiple potentials in the data set and to exclude traces that 
represent technical problems. 

 

Sequential IPI Plot 

 

IPI Histogram:  Displays the distribution of the IPI's in a bar graph format.  The 
height of each bar indicates the counts (N) for each value of IPI.  This graph 
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should demonstrate a Gaussian distribution; any deviation would suggest that 
spurious data may have been acquired. 

 

IPI Histogram 

 

Sequential IDI Plot:  Displays the distribution of the Inter-Discharge Intervals 
(IDI) for the data set. 

 

Sequential IDI Plot 
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IDI vs IPI Plot:  Displays the distribution of the IPI versus the IDI, this plot is used 
to view the jitter dependence on the preceding interval. 

 

IDV vs. IPI Plot 

 

Jitter Histogram:  This histogram provides a quick summary of the data 
collected for the muscle.  The vertical axis marks the count, while the horizontal 
axis indicates jitter (in microseconds, us).  The height of colored bar graphs 
indicates the number of runs containing that amount of jitter. Normal jitter is 
indicated by green bars, abnormal jitter as red bars, and abnormal jitter with 
blocking as red cross-hatched bars.  A dashed line marks the jitter norm for 
individual potential pairs in the muscle.  This is the default plot for the Acquisition 
Mode. 
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Jitter Histogram 

Table Options 

Clicking on a row in the Results Table highlights that row and allows that run's 
trace data to be reviewed.  Right-clicking within the table will display a menu of 
options. 

 

SFEMG Results Table 
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Right-click menu. 

Font Size:  The font size of the table can be increased or decreased.  The 
choices are Small (default), Medium, Large, and Extra Large. 

Copy Table:  Copies the contents of the SFEMG table to the Windows 
clipboard. 

Delete Run:  This will delete the highlighted row from the table and all the 
data for that run. 

Swap Jitter Value:  Selecting this option will cause the larger value between 
MCD and MSCD to be displayed in the Jitter field.  By default, the lower value 
of the two is displayed in the Jitter field. 

Column Definitions: 

Run – indicates the run #.  If a run is analyzed more than once, it is 
indicated by .2, .3, and so on.  This would occur if more than one potential 
was analyzed in the run using the New Pair function key. 

Samples – indicates the total number of traces shown in the Filtered 
Trace area for that run. 

Blocks – indicates the number of blocks shown in the Filtered Trace area 
for that run. 

IPI – displays the mean Inter-Potential Interval for the traces shown in the 
Filtered Trace area. 

Jitter – displays the lowest value of either the MCD or MSCD in 
microseconds (usec).   

Jitter Norm – the value on the first row of the table is the jitter norm for 
individual potential pairs.  The value in the mean row of the table is the 
overall MCD jitter norm for the muscle. 

MCD – the jitter as calculated by using the Mean Consecutive Difference 
for the run. 

MSCD – the jitter as calculated by using the Mean Sorted Consecutive 
Difference for the run. 

Freq. – displays the mean firing frequency of the triggering potential in 
hertz (Hz). 
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Stored – indicates if the run has been stored to disk. 

Block Ratio – indicates the percentage of runs with blocking potentials. 

Fiber Density - displays the fiber density value from the Fiber Density 
window. 

 

Fiber Density 

The top portion of the Fiber Density window is used to record the results of fiber 
density studies.  Count the number of time-locked potentials in the trace and then 
record that value by clicking on the corresponding button in the Fiber Density 
window.  The program computes the fiber density by taking the total count and 
dividing it by the number of entries (units).  The fiber density value is recorded in 
the results table and is included in reports. 

 

Fiber Density window. 
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In the above example: 

Fiber Density = (13 x 1) + (6 x 2) + (1 x 3) / (13 + 6 + 1) 

= 13 +12 + 3 / 20 

= 28 / 20 

= 1.40 

 

Deleting a Run 

To Delete a stored SFEMG run, perform one of the following procedures. 

Using the Study Window: 

 Right click the mouse over the Run # you want to delete in the Study 
window. 

 From the pop-up menu, select Delete. 

 A confirmation message will be displayed, click OK. 

 The Run is deleted and the mean and standard deviation values in the 
Results table are automatically re-calculated. 

 

Using the Results Table: 

 Right click over the row in the table corresponding to the run you want 
to delete. 

 From the pop-up menu, select Delete Run. 
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Re-analyzing a Run 

To review and re-analyze a Run, follow these steps. 

 Select the Run # you want to re-analyze by performing one of the 
following. 

o Turn Knob #1 (Select Run) until the desired run # is highlighted. 

o Left click the mouse over the desired run # in the Study window. 

o Left click the mouse over the desired run # within the Results 
table. 

 Adjust the Analysis Marker as needed. 

 Adjust the include area (i.e., yellow band) of the Sequential IPI Plot as 
needed. 

Saving Changes to SFEMG Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the SFEMG test protocol. 

 Select Save Test Parameters from the Edit menu. 
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Stimulated Single Fiber EMG 

Performing Stimulated SFEMG 

Select the SSFEMG  Test:   

 If a Study has already been selected, simply click on a SSFEMG muscle 
name (i.e., Right Biceps) within the Study window or turn Knob #1 (Study 
Item) to highlight the muscle name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual SSFEMG test protocol from the Study/Test menu, a 
muscle list will be displayed allowing you to pick the muscle or muscles 
that you will be testing on the patient.  Notice that when a muscle is 
selected, it is displayed within the Study window. 

 

Once the muscle has been selected.  Follow these steps for performing 
routine SSFEMG data acquisition and analysis: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate.  Only Channel 1 can be used in the SSFEMG test 
protocol. 

Typical Settings for SSFEMG 

Gain = 100 uV/Div 

Hicut = 10k Hz 

Locut = 500 Hz 

Sweep Speed = 0.5 ms/Div 

2.  Verify the Side 

Make sure the appropriate side, Right or Left, is selected. 

3.  Set the capture buffer Count value. 

The Count value is the total number of traces that can be collected in the 
SSFEMG trace buffer.  Each time the electrical stimulator fires the resulting 
time-locked trace is added to the trace buffer and the Capture number is 
incremented by one.  The Count can be set to 10, 20, 30, 50, 70, 100, 150, or 
200.  This setting is located in the SSFEMG Controls window and can be 
easily changed using the mouse. 
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4.  Start Data Acquisition 

Press the F2 (Stim off / Stim on) function key to initiate data acquisition. 
 Leave the stimulus intensity set to ZERO mA until the recording and 
stimulating needles are inserted and positioned. 

5.  Insert the recording SSFEMG Needle Electrode. 

6.  Position the Stimulating Electrode. 

The stimulating electrode should be connected to the Cathode (-), indicated 
by the green LED on the electrical stimulator.  A surface electrode should be 
connected to the Anode (+). 

7.  Begin stimulus delivery. 

Verify that the F2 (Stim off / Stim on) function key is set to the Stim On 
mode and increase the stimulation intensity.  Adjust other stimulation settings 
as necessary. 

Intensity - adjust the stimulation intensity by turning the wheel on the 
hand held electrical stimulator or by clicking on the Intensity field in the 
SSFEMG Controls window and selecting a value from the pop-up list. 

Pulse Width - adjust the pulse width (in microseconds) by clicking on the 
Pulse Width field and selecting a value from the pop-up list. 

Rep Rate - adjust the stimulation frequency by clicking on the Rep Rate 
field and selecting a value from the pop-up list. 

Polarity - Typically set to the Normal mode, the Cathode (-) is indicated 
by the green LED. 

8.  Adjust the Gain and Sweep Speed as necessary. 

During SSFEMG data acquisition you can easily adjust the Gain and Sweep 
Speed by using Knob #4 (Gain / Sweep) on the Sierra Wave base unit. 
 Simply turn the knob to adjust the gain, to change the sweep speed, press 
the knob first to toggle it to the sweep mode, then turn to change the sweep 
speed. 

You can also use the mouse to change these settings in the SSFEMG 
Controls window. 

9.  Adjust the Volume (optional) 

Increase or decrease the Sierra Wave's internal speaker by using the Volume 
knob on the left hand side of the base unit. 
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10.  Acquire SSFEMG Potentials 

Once the appropriate SSFEMG signal is located, press the Clear key on the 
Sierra Wave base unit to reset the Capture buffer to zero.  Now, acquire 
SSFEMG potentials until the buffer Count is reached or until you are satisfied 
that enough SSFEMG data has been captured for analysis. 

 

Acquisition mode. 

11.  Stop Data Acquisition 

Press the Run/Stop key on the Sierra Wave base unit to stop data 
acquisition.  This will change the display to the Analysis mode.  Electrical 
stimulus delivery is stopped while in the Analysis mode. 
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The Analysis mode has two trace areas, the Captured Trace area and the 
Filtered Trace area.  Typically a Sequential IPI Plot and Results Table are 
also displayed. 

Captured Trace area - shows all the traces in the current capture buffer. 

Filtered Trace area - shows only those traces that fall within the 
Sequential IPI Plots include area (yellow band).  Blocking traces (red) are 
also shown in this area when the Jitter is abnormal.  Jitter measurements 
are based on the traces in this area. 

 

Stimulated SFEMG Analyze Mode 

12.  Verify the Position of the Analysis Marker 

Check the position of analysis marker (shown in light-blue) in the Captured 
Trace area, the rising edge of the potentials to be analyzed should cross 
through the analysis marker.  If a single fiber potential does not transition 
through the marker it will be considered as a block.  The width of the analysis 
marker should be adjusted to encompass all the potentials that you want to 
analyze.  Use the mouse or Knob #2 (Threshold / Min Lat) to make 
adjustments to the analysis marker position and width.  The Filtered Trace 
area and the Sequential IPI Plot are automatically updated when the analysis 
marker is repositioned. 
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Analysis Marker correctly positioned in the Capture Trace area. 

Colors Used in the Capture Trace Area 

Trace Color Description 

White These traces are within the Sequential IPI Plot 
include area (shown as yellow band on the 
plot) and are added to the Filtered Trace area 
where they are used for calculating the jitter. 

Red These traces did not cross through the 
analysis marker and are therefore considered 
blocks.  They are added to the Filtered Trace 
area if the Jitter measurement is abnormal.  If 
the Jitter is normal, these traces are most likely 
the result of artifacts or mis-triggers. 

Dark Blue These traces lie outside the Sequential IPI Plot 
include area and are not added to the Filtered 
Trace area. 

Light Blue These traces have been manually rejected 
from the data set and are removed from the 
Filtered Trace area. 

Yellow Indicates the trace has been selected (using 
the mouse or Knob #4), it can be manually 
rejected or deleted from the data set. 
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13.  Make adjustments to the Sequential IPI Plot (Optional) 

This is the default plot that is displayed in the Analysis Mode.  The 
Sequential IPI Plot displays the distribution of the Inter-Potential Intervals by 
plotting the difference between each individual IPI (Inter-Potential Interval) 
and the mean IPI for the whole data set.  The mean IPI is indicated as zero 
on the vertical axis.  The horizontal axis represents each sweep in the data 
set, up to a maximum of 200. 

Blocks are shown as red plus signs at the top of the plot and as red traces in 
the Captured and Filtered Trace areas.  A +/- 3 standard deviation yellow 
band is drawn about the mean value and defines an acceptance limit of IPI for 
computing jitter.  Potentials outside the yellow band are shown as dark blue 
color in the Captured Trace area and are not included in the Filtered Trace 
area.  A circle is drawn around the currently selected trace (i.e., corresponds 
to the yellow trace). 

The upper & lower boundaries of the yellow band can be adjusted by clicking 
on the boundary with the mouse and then dragging it up or down.  The 
Captured and Filtered trace areas and jitter measurements are updated 
automatically when the boundary is changed.  This is a powerful and quick 
way to analyze multiple potentials in the data set and to exclude traces that 
represent technical problems. 

 

Sequential IPI Plot 
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14. View other Data Plots (Optional) 

The plot window can display up to three data plots at one time.  To view other 
plots, simply right-click over this window and select the plots you would like 
to view from the pop-up menu. 

 

Sequential IPI Plot with right click menu. 

The available plots are: 

Sequential IPI:  See step #13 above. 

IPI Histogram:  Displays the distribution of the IPI's in a bar graph format. 
 The height of each bar indicates the counts (N) for each value of IPI.  This 
graph should demonstrate a Gaussian distribution; any deviation would 
suggest that spurious data may have been acquired. 



Sierra Wave Help Manual 

730 

 

IPI Histogram 

 

Jitter Histogram:  This histogram provides a quick summary of the data 
collected for the muscle.  The vertical axis marks the count, while the 
horizontal axis indicates jitter (in microseconds, us).  The height of colored 
bar graphs indicates the number of runs containing that amount of jitter. 
Normal jitter is indicated by green bars, abnormal jitter as red bars, and 
abnormal jitter with blocking as red cross-hatched bars.  A dashed line 
marks the jitter norm for individual potential pairs in the muscle.  This is 
the default plot for the Acquisition Mode. 
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Jitter Histogram 

15.  Manually Reject Traces (Optional) 

Traces can be manually excluded from the analysis by selecting them with 
the mouse (left-click).  Once selected the trace is displayed in yellow color. 
 Now, right-click and select Reject Selected Traces from the pop-up menu, 
this removes the trace from the analysis.  Rejected traces are displayed in 
light blue color.  You can re-accept a rejected trace by selecting it, then right-
click to remove the check mark next to Reject Selected Traces. 
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Example showing two manually rejected traces in the Captured Trace area that have been 
automatically removed from the Filtered Trace area. 

16.  Store the Run 

Press the Store key on the Sierra Wave base unit to keep the run, by default 
all the traces for the run are stored as well.  In the Results Table the "Stored" 
field will change from No to Yes. 

 As each SSFEMG run is stored, you will see a new "node" appear in the 
Study window below the muscle name.  The example below shows five runs 
stored for the Right Biceps muscle. 
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Study Window 

 If  you decide not to keep the run, do not press the Store key, simply 
return to the Acquisition mode by pressing the Run/Stop key and the run will 
be discarded. 

The Results Table records the analysis results for each run and calculates 
the mean and standard deviation values. 

 

Results Table 

Run – indicates the run #.  If a run is analyzed more than once, it is 
indicated by .2, .3, and so on.  This would occur if more than one potential 
was analyzed in the run using the New Pair function key. 

Samples – indicates the total number of traces shown in the Filtered 
Trace area for that run. 

Blocks – indicates the number of blocks shown in the Filtered Trace area 
for that run. 
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MCD – the Jitter (in microseconds) as calculated by using the Mean 
Consecutive Difference for the run. 

MCD Norm – the value on the first row of the table is the jitter norm for 
individual potential pairs.  The value in the mean row of the table is the 
overall MCD jitter norm for the muscle. 

Latency - the mean latency (in milliseconds) from the sweep onset to the 
single fiber potential. 

Stored – indicates if the run has been stored to disk. 

Block Ratio – indicates the percentage of runs with blocking potentials. 

Fiber Density - displays the fiber density value from the Fiber Density 
window. 

17.  Collect Additional  SSFEMG Runs 

Press the Run/Stop key to return to Acquistion mode and repeat steps 7 - 
16 to acquire additional SSFEMG runs. 

18.  Select Next Muscle (optional) 

From Acquisition mode, turn Knob #1 (Study Item) to highlight the next 
muscle in the Study window.  If the muscle you want to examine is not 
displayed within the Study window, press F3 (Muscle List) and select the 
next SSFEMG muscle from the list. 

Move the recording SSFEMG Needle Electrode and Stimulating Electrode to 
the new muscle and repeat the above steps as necessary. 

 It is a good idea to turn Off the preamplifier or turn down the Volume 
when moving the needle electrode to a new location. 

19.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 
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To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

20.  Next Test 

 Use Knob #1 (Study Item) to highlight another Test Protocol in the 
Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

 

Knob & Fkey Controls (SSFEMG) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in Acquisition mode or  Analyze 
mode. 

 Analyze mode is entered by pressing the Run/Stop key. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 

 

Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Intensity / Pulse Width - this knob defaults to the Intensity mode and 
can be used to increase or decrease the stimulus intensity, the current 
intensity value (in milliamps) is displayed on the knob icon.  Press this 
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knob to switch to the Pulse Width mode and then turn to increase or 
decrease the electrical stimulus pulse width, the current value (in 
microseconds) is displayed on the knob icon.    

Gain / Sweep - turn the knob to change the gain of the SSFEMG trace. 
 Press the knob, then turn to change the sweep speed of the SSFEMG 
trace. 

F Keys 

 

Stim off / Stim on - defaults to Stim off mode, press to activate Stim on 
mode and initiate data acquisition with stimulus delivery. 

Muscle List - opens the SSFEMG Muscle List window which allows you 
to select and add muscles to your Study window. 

TabData - opens the TabData Summary window. 

 

Analyze  mode 

Knobs 

 

Run Select - turn this knob to highlight and review stored runs in the 
Results table.  When the run is highlighted the traces for that run will be 
displayed in the trace window. 

Threshold / Min Lat - this knob defaults to the Threshold mode, turn the 
knob to move the Analysis Marker up or down within the Trace window. 
 Press the knob to activate the Min Lat mode, then turn to move the 
Analysis Marker left or right within the Trace window. 

Disp Trace / Trace Cnt - this knob effects how the traces in the SSFEMG 
capture buffer are displayed.  Turn the knob to change the starting display 
trace number.  Press the knob, then turn to change the trace count 
number. 

Here's an example of how to use the Trace Cnt and Disp Trace 
settings to view subsets of the capture buffer: 

Assume there are 50 total traces in the SSFEMG capture buffer.  The 
Trace Cnt will default to 50 and the Disp Trace number will default to 1. 
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 Therefore all 50 traces (1 to 50) are displayed in the Trace window. 
 Now, change the Trace Cnt to 20 and leave the Disp Trace number at 
1.  You will see traces 1-20 displayed in the Trace window.  You can 
now change the Disp Trace number to 21, now you can view traces 
21-40.  Change the Disp Trace number again and it goes to 41, now 
you can view traces 41-50. 

Trace Sel / Delete - defaults to the Trace Sel mode, turn this knob to 
select a SSFEMG trace.  When selected, the trace will be displayed in 
yellow color.  Press the knob to Delete the selected trace from the capture 
buffer. 

F Keys 

 

New Pair - press to add an additional row to the results table and to 
analyze a second potential pair in the data. 

Overlay / Raster - defaults Overlay mode, in this mode the traces are 
superimposed on top of one another.  Press to activate Raster mode, in 
this mode the traces are evenly rastered down the trace window. 

Muscle List - opens the SSFEMG Muscle List window which allows you 
to select and add muscles to your Study window. 

TabData - opens the TabData summary window. 

Stimulated SFEMG Test Setup 

SSFEMG test setup options are discussed in detail in the Test Protocol Setup 
chapter of the Help system. 

 

Muscle List (F3) 

The F3 (Muscle List) function key is a convenient way to add muscles to the 
Study window after a Study List has been selected or after the SSFEMG Test 
Protocol has been loaded. 

 

To Add a Muscle to the Study Window 

1. From within the SSFEMG Test Protocol, press the F3 (Muscle List) 
function key.  The Select Muscle window will be displayed. 
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F3 - Select Muscle window. 

2. To add a single muscle, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 
the muscle.  Verify the Side parameter, use Knob #2 (Side) to 
change this if necessary.  Press the OK key on the Sierra Wave 
base unit. 

 Using the Mouse - verify the Side parameter and then double 
click on the muscle name. 

3. To add multiple muscles, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 
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the muscle.  Repeat this process until all of the muscles you want 
to add are highlighted.  Verify the Side parameter, use Knob #2 
(Side) to change this if necessary.  Press the OK key on the Sierra 
Wave base unit. 

 Using the Mouse - single click the mouse over the appropriate 
muscle names.  Once all of the muscles have been selected, verify 
the Side parameter and then click OK. 

 

 Setting the Side parameter to Left & Right will add the muscle to the Study 
window twice, once for the Left and once for the Right. 

 Adding muscles to the Study window in this manner is only temporary.  To 
add muscles to a Study List permanently, review the help topic "Changing an 
Existing Study". 

Stimulated SFEMG Trace Area 

The contents of the Trace Area will varying depending on whether the program is 
in the Acquisition or Analysis modes. 

Acquisition Mode 

Displays the Stimulated SFEMG activity.  Adjust the Gain and Sweep Speed 
by using Knob #4 (Gain / Sweep) on the Sierra Wave base unit.  Simply turn 
the knob to adjust the gain, to change the sweep speed, press the knob first 
to toggle it to the sweep mode, then turn to change the sweep speed. 

To begin data acquisition press the F2 (Stim off / Stim on) function key is set 
to the Stim On mode and increase the stimulation intensity.  Adjust other 
stimulation settings as necessary. 

Right-clicking on the trace area displays a menu of functions that can be 
used. 
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Acquisition Trace Area 

 

Right-click menu. 

Graticule Size:  The SSFEMG Trace window is divided into a grid pattern 
using vertical and horizontal divisions or graticules.  The grid pattern can 
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be changed by altering the number of these divisions.  The first number is 
for the number of vertical divisions, the second number is for the number 
of horizontal divisions. 

Capture Window:  When this feature is enabled the trace window is split 
into two sections; the top section shows the live SSFEMG trace, the 
bottom section shows a rastered display of the most recently captured 
traces. 

Capture Window Options. 

When the Capture Window is enabled, right clicking within the capture 
window trace area will display a pop-up menu of display options. 

 

 

 Hide Capture Window – turns off the capture window. 

 Number of Captured Traces - changes the number of traces 
displayed in the captured window trace area.  Select 3, 5, or 10 
from the drop down list or type in any number between 2 and 
100. 

 Amplitude Markers – enables amplitude markers in the 
captured window area. 

 Time Markers – enables time markers in the captured window 
area. 
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 Raster / Overlay – sets the position of the captured window 
traces as either rastered or overlayed (i.e., superimposed). 

 Auto Position Traces - if captured window traces have been 
moved up/down using the mouse, this option will return the 
traces to their original positions. 

 Trial Highlighting - enables the alternating white/gray coloring 
of the rastered traces. 

 Sweep Speed – the sweep speed of the Live and Capture 
Window areas can be set independently. 

o Link Sweep to SFEMG Trace Window – automatically 
sets the captured window trace area to the same sweep 
speed as the Live trace. 

o 1, 2, 5, 10 ms/Div – sets the captured window trace 
sweep speed to the selected value.  Dual sweep values 
are displayed in the Controls Toolbar or Amplifier 
Controls window when the captured window sweep 
speed is set differently than the Live trace sweep speed. 

 Copy Window - copies the contents of the SSFEMG trace 
window to the clipboard. 

Enabling the Capture Window Display as your default setting for 
SSFEMG. 

The status of the Capture Window display feature and the number of 
traces displayed within the window can be saved as part of the default 
settings for the SSFEMG test protocol.  With the feature enabled, 
simply select Save Test Parameters from the Edit menu. 

Analysis Mode 

The Analysis mode has two trace areas, the Captured Trace area on the top, 
and the Filtered Trace area on the bottom.  Right-clicking on the trace area 
displays a menu of functions that can be used. 

Captured Trace area - shows all the traces in the current capture buffer and 
an adjustable Analysis Marker. 
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Colors Used in the Capture Trace Area 

Trace Color Description 

White These traces are within the Sequential IPI Plot 
include area (shown as yellow band on the plot) and 
are added to the Filtered Trace area where they are 
used for calculating the jitter. 

Red These traces did not cross through the analysis 
marker and are therefore considered blocks.  They 
are added to the Filtered Trace area if the Jitter 
measurement is abnormal.  If the Jitter is normal, 
these traces are most likely the result of artifacts or 
mis-triggers. 

Dark Blue These traces lie outside the Sequential IPI Plot 
include area and are not added to the Filtered Trace 
area. 

Light Blue These traces have been manually rejected from the 
data set and are removed from the Filtered Trace 
area. 

Yellow Indicates the trace has been selected (using the 
mouse or Knob #4), it can be manually rejected or 
deleted from the data set. 

 

Filtered Trace area - shows only those traces that fall within the Sequential 
IPI Plots include area (yellow band).  Blocking traces (red) are also shown in 
this area when the Jitter is abnormal.  Jitter measurements are based on the 
traces in this area. 
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Right-click menu. 

Delete Selected Traces:  Deletes the yellow (i.e, selected) traces from 
the capture buffer. 
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Store:  Stores the run to disk.  This is the same function as pressing the 
Store key on the base unit. 

Reject Selected Traces:  Marks the selected trace as "manually rejected" 
which colors it light-blue and removes it from the Filtered Trace area but 
does not delete it from the capture buffer. 

Graticule Size:  The SSFEMG Trace window is divided into a grid pattern 
using vertical and horizontal divisions or graticules.  The grid pattern can 
be changed by altering the number of these divisions.  The first number is 
for the number of vertical divisions, the second number is for the number 
of horizontal divisions. 

Save Traces to ASCII:  Allows all the traces in the Capture Trace area to 
be output to a comma separated values file (*csv).  For more information 
on using the ASCII Output Utility click here. 

Copy Window - copies the contents of the SSFEMG trace window to the 
clipboard. 

 

Stimulated SFEMG Plot Descriptions 

The plot window can display up to three data plots at one time.  To view other 
plots, simply right-click over this window and select the plots you would like to 
view from the pop-up menu. 

 

Sequential IPI Plot with right click menu. 
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Sequential IPI Plot 

This is the default plot that is displayed in the Analysis Mode.  The 
Sequential IPI Plot displays the distribution of the Inter-Potential Intervals by 
plotting the difference between each individual IPI (Inter-Potential Interval) 
and the mean IPI for the whole data set.  The mean IPI is indicated as zero 
on the vertical axis.  The horizontal axis represents each sweep in the data 
set, up to a maximum of 200. 

Blocks are shown as red plus signs at the top of the plot and as red traces in 
the Captured and Filtered Trace areas.  A +/- 3 standard deviation yellow 
band is drawn about the mean value and defines an acceptance limit of IPI for 
computing jitter.  Potentials outside the yellow band are shown as dark blue 
color in the Captured Trace area and are not included in the Filtered Trace 
area.  A circle is drawn around the currently selected trace (i.e., corresponds 
to the yellow trace). 

The upper & lower boundaries of the yellow band can be adjusted by clicking 
on the boundary with the mouse and then dragging it up or down.  The 
Captured and Filtered trace areas and jitter measurements are updated 
automatically when the boundary is changed.  This is a powerful and quick 
way to analyze multiple potentials in the data set and to exclude traces that 
represent technical problems. 

 

Sequential IPI Plot 

IPI Histogram 

Displays the distribution of the IPI's in a bar graph format.  The height of each 
bar indicates the counts (N) for each value of IPI.  This graph should 
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demonstrate a Gaussian distribution; any deviation would suggest that 
spurious data may have been acquired. 

 

IPI Histogram 

 

Jitter Histogram 

This histogram provides a quick summary of the data collected for the 
muscle.  The vertical axis marks the count, while the horizontal axis indicates 
jitter (in microseconds, us).  The height of colored bar graphs indicates the 
number of runs containing that amount of jitter. Normal jitter is indicated by 
green bars, abnormal jitter as red bars, and abnormal jitter with blocking as 
red cross-hatched bars.  A dashed line marks the jitter norm for individual 
potential pairs in the muscle.  This is the default plot for the Acquisition Mode. 
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Jitter Histogram 

Table Options 

Clicking on a row in the Results Table highlights that row and allows that run's 
trace data to be reviewed.  Right-clicking within the table will display a menu of 
options. 

 

SSFEMG Results Table 

 

Right-click menu. 
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Font Size:  The font size of the table can be increased or decreased.  The 
choices are Small (default), Medium, Large, and Extra Large. 

Copy Table:  Copies the contents of the SSFEMG table to the Windows 
clipboard. 

Delete Run:  This will delete the highlighted row from the table and all the 
data for that run. 

 

Column Definitions: 

Run – indicates the run #.  If a run is analyzed more than once, it is indicated 
by .2, .3, and so on.  This would occur if more than one potential was 
analyzed in the run using the New Pair function key. 

Samples – indicates the total number of traces shown in the Filtered Trace 
area for that run. 

Blocks – indicates the number of blocks shown in the Filtered Trace area for 
that run. 

MCD – the Jitter (in microseconds) as calculated by using the Mean 
Consecutive Difference for the run. 

MCD Norm – the value on the first row of the table is the jitter norm for 
individual potential pairs.  The value in the mean row of the table is the overall 
MCD jitter norm for the muscle. 

Latency - the mean latency (in milliseconds) from the sweep onset to the 
single fiber potential. 

Stored – indicates if the run has been stored to disk. 

Block Ratio – indicates the percentage of runs with blocking potentials. 

Fiber Density - displays the fiber density value from the Fiber Density 
window. 

 

Fiber Density 

The top portion of the Fiber Density window is used to record the results of fiber 
density studies.  Count the number of time-locked potentials in the trace and then 
record that value by clicking on the corresponding button in the Fiber Density 
window.  The program computes the fiber density by taking the total count and 
dividing it by the number of entries (units).  The fiber density value is recorded in 
the results table and is included in reports. 
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Fiber Density window. 

In the above example: 

Fiber Density = (13 x 1) + (6 x 2) + (1 x 3) / (13 + 6 + 1) 

= 13 +12 + 3 / 20 

= 28 / 20 

= 1.40 

 

Stim OFF / Stim ON 

To start data acquisition and initiate repetitive electrical stimulation in the 
Stimulated Single Fiber EMG test protocol, press the F2 (Stim off / Stim on) 
function key to activate the Stim on mode.  When the test is first loaded the key 
defaults to the Stim off mode. 

Deleting a Run 

To Delete a stored SSFEMG run, follow these steps. 
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 Right click the mouse over the Run # you want to delete in the Study 
window. 

 From the pop-up menu, select Delete. 

 A confirmation message will be displayed, click OK. 

 The Run is deleted and the mean and standard deviation values in the 
Results table are automatically re-calculated. 

 

 

Re-analyzing a Run 

To review and re-analyze a Run, follow these steps. 

 Select the Run # you want to re-analyze by performing one of the 
following. 

o Turn Knob #1 (Select Run) until the desired run # is highlighted. 

o Left click the mouse over the desired run # in the Study window. 

o Left click the mouse over the desired run # within the Results 
table. 

 Adjust the Analysis Marker as needed. 

 Adjust the include area (i.e., yellow band) of the Sequential IPI Plot as 
needed. 

Saving Changes to Stimulated SFEMG Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the SSFEMG test 
protocol. 

 Select Save Test Parameters from the Edit menu. 
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Real Time SFEMG 

Performing Real Time SFEMG 

The Real Time SFEMG test protocol allows for the analysis of jitter during data 
acquisition.  Analysis is based on the peak latency rather than on a rising or 
falling edge passing through an analysis marker.  Up to 4 peaks (not including 
the triggering peak) can be analyzed simultaneously.  Real Time SFEMG 
streamlines workflow and makes data acquisition and analysis significantly faster 
than the original SFEMG protocol. 

Select the Real Time SFEMG  Test:   

 If a Study has already been selected, simply click on a Real Time 
SFEMG muscle name (i.e., Right Biceps) within the Study window or turn 
Knob #1 (Study Item) to highlight the muscle name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual Real Time SFEMG test protocol from the Study/Test 
menu, a muscle list will be displayed allowing you to pick the muscle or 
muscles that you will be testing on the patient.  Notice that when a muscle 
is selected, it is displayed within the Study window. 

 If the Real Time SFEMG test protocol is not shown in your Study/Test 
menu, click here for instructions on how to insert this protocol into your 
menu. 

Once the muscle has been selected.  Follow these steps for performing 
routine Real Time SFEMG data acquisition and analysis: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate.  Only Channel 1 can be used in the Real Time SFEMG 
test protocol. 

Typical Settings for Real Time SFEMG 

Gain = 100 uV/Div 

Hicut = 10k Hz 

Locut = 500 Hz  (1 kHz for Concentric needle) 

Sweep Speed = 0.5 ms/Div 

2.  Verify the Side 

Make sure the appropriate side, Right or Left, is selected. 
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3.  Insert the SFEMG or Concentric Needle Electrode. 

4.  Adjust the Gain and Sweep Speed as necessary. 

During Real Time SFEMG data acquisition you can easily adjust the Gain and 
Sweep Speed by using Knob #4 (Gain / Sweep) on the Sierra Wave base 
unit.  Simply turn the knob to adjust the gain, to change the sweep speed, 
press the knob first to toggle it to the sweep mode, then turn to change the 
sweep speed. 

You can also use the mouse to change these settings in the Real Time 
SFEMG Controls window. 

5.  Adjust the Volume 

Increase or decrease the Sierra Wave's internal speaker by using the Volume 
knob on the left hand side of the base unit. 

6.  Adjust Trigger Level & Delay 

Knob #3 (Trig Lev /Trig Del) defaults to the Trig Lev mode, turn this knob to 
move the position of the trigger level (horizontal portion of purple crosshair) 
up or down within the trace window.  Each time a SFEMG potential crosses 
the trigger level the sweep is added to the capture buffer and the Peak Detect 
window is updated.  Press the knob to activate Trig Del mode then turn to 
move the delay point (vertical portion of purple crosshair) left or right in tenth 
of a division increments.  Changing the delay point allows you to see more or 
less data after the triggering potential. 

 The mouse can also be used to move the Trigger Level/Delay 
indicator. 

The Peak Detect window (& trace buffer) are automatically cleared 
whenever the trigger indicator is moved a significant amount.  This feature 
can be disabled in the Real Time SFEMG Test Setup window. 

7.  Acquire SFEMG Potentials 

Once the appropriate SFEMG signal is located and the Trigger and Delay 
positions have been adjusted, acquire SFEMG potentials until the Peak 
Detect window makes one complete cycle (one cycle represents 100 
captured traces). 
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8.  Stop Data Acquisition 

Press the Run/Stop key on the Sierra Wave base unit to stop data 
acquisition.  This will change the display to the Analysis mode. 

In analysis mode, the Trigger Tag displays the mean frequency for the entire 
run and the trace area shows the captured sweeps in groups of ten. 
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9.  Manually Reject Traces (Optional) 

Traces can be manually excluded from the analysis by one of the following 
methods: 

 Rejecting traces using the mouse -  select a trace by left-clicking 
over it with the mouse.  Once selected the trace is displayed in yellow 
color.  Now, right-click and select Reject Selected Trace from the pop-
up menu, this removes the trace from the analysis and the jitter value 
 is updated.  Rejected traces are displayed in light blue color.  You can 
re-accept a rejected trace by selecting it, then right-click to remove the 
check mark next to Reject Selected Trace. 

 Use Knob #3 (Zoom Box) and Knob #4 (Trace Sel / Reject) - turn 
Knob #3 (Zoom Box) to move through the captured trace buffer in 
groups of ten.  Use Knob #4 (Trace Sel / Reject) to move the yellow 
highlight to the trace you want to reject, then press the knob to reject 
the trace.  You can re-accept a rejected trace by first selecting it then 
pressing Knob #4 again. 

10.  Verify the Keep (K) and Block (B) check boxes in the MCD Tag. 
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By default, the Keep (K) box is checked for each detected peak.  If you do not 
wish to keep the data for a particular peak then you should un-check this box. 
 When the Store key is pressed, all peaks with a check mark in the Keep (K) 
box will be added to the results table. 

If a check mark appears in the Block (B) box this indicates that the program 
has detected blocking for that peak.  You can override the program by un-
checking this box.  When the Store key is pressed, all peaks with a check 
mark in the Block (B) box will have the notation of "Yes" entered in the 
Blocks column of the results table. 

 

MCD Tag. 

If the jitter value is normal for the individual potential pair, the Block (B) 
box will not be automatically checked by the program as this is probably 
due to artifact in the data.  Blocking does not occur when the jitter is 
normal. 

If there is more than one peak detected, use the Next Tag button 

to expand the other MCD tags. 

Use the Change Trigger button when you would like to select a 
different potential as the trigger peak.  All jitter data is automatically 
recalculated when the trigger is changed. 

11.  (Optional) Manually record a Potential Pair 

Use the Norm, Incr, or Block buttons within the Fiber Density window to 
manually record a potential pair that is not detected by the automatic peak 
detection algorithm. 
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These values are automatically included in the % Normal Pairs, % Abnormal 
Pairs, and % Blocks summary calculations. 

12.  Store the Run 

Press the Store key on the Sierra Wave base unit to keep the run, the jitter 
data for each peak is entered into the results table and the jitter histogram is 
updated. 

 As each SFEMG run is stored, you will see a new "node" appear in the 
Study window below the muscle name.  The example below shows five 
runs stored for the Right Ext Dig Com muscle.   Run #5 had two peaks 
analyzed (#5.1 and #5.2). 

 

Study window. 

 If you decide not to keep any data for the run, do not press the Store 
key, simply return to the Acquisition mode by pressing the Run/Stop key 
and the run will be discarded. 

The Results Table records the analysis results for each run and calculates 
the mean and standard deviation values. 
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Results Table. 

Table Columns: 

Run – indicates the run #.  If a run contains more than one analyzed 
potential pair, it is indicated by .2, .3, .4.  If the run was acquired using 
stimulation, an 's' will be added to this value. 

Blocks – a value of "Yes" indicates blocking occurred. 

IPI – displays the mean Inter-Potential Interval in microseconds (usec). 

Jitter – displays the lowest value of either the MCD or MSCD in 
microseconds (usec).  The user can right-click on this value and select 
Swap Jitter Value, this will display the larger of the two values in this field. 

Jitter Norm – the value on the first row of the table is the jitter norm for 
individual potential pairs.  The value in the mean row of the table is the 
overall MCD jitter norm for the muscle. 

MCD – the jitter as calculated by using the Mean Consecutive Difference 
for the run. 

MSCD – the jitter as calculated by using the Mean Sorted Consecutive 
Difference for the run. 

Freq. – displays the mean firing frequency of the triggering potential in 
hertz (Hz). 
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Summary Data: 

Potential Pairs - displays the total number of potential pairs (automatic & 
manual) that have been recorded. 

Abnormal Pairs % - indicates the percentage of runs with increased jitter 
for individual potential pairs. 

Normal Pairs % - indicates the percentage of runs with normal jitter for 
individual potential pairs. 

Jitter - displays the mean jitter value for the muscle. 

Blocks %  – indicates the percentage of runs with blocking potentials. 

Fiber Density - displays the fiber density value from the Fiber Density 
window. 

13.  Acquire additional Runs. 

Press the Run/Stop key to return to Acquistion mode and repeat steps 6 
through 11 to acquire additional runs.  Typically 20 runs should be collected 
for the muscle. 

14.  Select Next Muscle (optional) 

From Acquisition mode, turn Knob #1 (Study Item) to highlight the next 
muscle in the Study window.  If the muscle you want to examine is not 
displayed within the Study window, press F3 (Muscle List) and select the 
next muscle from the list. 

Move the SFEMG or Concentric Needle Electrode to the new muscle and 
repeat the above steps as necessary. 

 It is a good idea to turn Off the preamplifier or turn down the Volume 
when moving the needle electrode to a new location. 

15.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 
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To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

16.  Next Test 

 Use Knob #1 (Study Item) to highlight another Test Protocol in the 
Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

 

Knob & Fkey Controls (Real Time SFEMG) 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in Acquisition mode or  Analyze 
mode. 

 Analyze mode is entered by pressing the Run/Stop key. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 

 

Acquisition mode  

Knobs (with Stimulation Off) 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Trig Lev / Trig Delay - this knob defaults to the Trig Lev mode, turn the 
knob to change the vertical position of the trigger level indicator.  Press 
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the knob to activate the Trig Delay mode, then turn to change the trigger 
delay position from 1 to 9 divisions in 0.1 division increments. 

Gain / Sweep - turn the knob to change the gain of the SFEMG trace. 
 Press the knob, then turn to change the sweep speed of the SFEMG 
trace. 

Knobs (with Stimulation On) 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Intensity / Pulse Width - this knob defaults to the Intensity mode and 
can be used to increase or decrease the stimulus intensity, the current 
intensity value (in milliamps) is displayed on the knob icon.  Press this 
knob to switch to the Pulse Width mode and then turn to increase or 
decrease the electrical stimulus pulse width, the current value (in 
microseconds) is displayed on the knob icon.    

Gain / Sweep - turn the knob to change the gain of the SSFEMG trace. 
 Press the knob, then turn to change the sweep speed of the SSFEMG 
trace. 

 

F Keys 

 

Stim off / Stim on - defaults to Stim off mode, press to activate Stim on 
mode and initiate data acquisition with stimulus delivery. 

Muscle List - opens the Real Time SFEMG Muscle List window which 
allows you to select and add muscles to your Study window. 

TabData - opens the TabData Summary window. 
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Analyze  mode 

Knobs 

 

Run Select - turn this knob to highlight and review stored runs in the 
Results table.  When the run is highlighted the first 10 traces for that run 
will be displayed in the trace window and the Peak Detect window will 
updated. 

Zoom Box - turn this knob to move through the capture buffer in groups of 
ten traces at a time.  The dark blue highlight in the Peak Detect window 
indicates the current position of the Zoom Box. 

Trace Sel / Reject - defaults to the Trace Sel mode, turn this knob to 
select a SFEMG trace.  When selected, the trace will be displayed in 
yellow color.  Press the knob to Reject the selected trace and remove it 
from the analysis. 

F Keys 

 

Overlay / Raster - defaults to Raster mode, in this mode the traces are 
evenly separated within the trace window.  Press to activate Overlay 
mode, in this mode the traces are superimposed on top of one another. 

Muscle List - opens the Real Time SFEMG Muscle List window which 
allows you to select and add muscles to your Study window. 

TabData - opens the TabData summary window. 
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Real Time SFEMG Test Setup 

SFEMG test setup options are discussed in detail in the Test Protocol Setup 
chapter of the Help system. 

Click here,  to go to this topic. 

 

Muscle List (F3) 

The F3 (Muscle List) function key is a convenient way to add muscles to the 
Study window after a Study List has been selected or after the Real Time 
SFEMG Test Protocol has been loaded. 

 

To Add a Muscle to the Study Window 

1. From within the Real Time SFEMG Test Protocol, press the F3 (Muscle 
List) function key.  The Select Muscle window will be displayed. 
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F3 - Select Muscle window. 

2. To add a single muscle, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 
the muscle.  Verify the Side parameter, use Knob #2 (Side) to 
change this if necessary.  Press the OK key on the Sierra Wave 
base unit. 

 Using the Mouse - verify the Side parameter and then double 
click on the muscle name. 

3. To add multiple muscles, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 
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the muscle.  Repeat this process until all of the muscles you want 
to add are highlighted.  Verify the Side parameter, use Knob #2 
(Side) to change this if necessary.  Press the OK key on the Sierra 
Wave base unit. 

 Using the Mouse - single click the mouse over the appropriate 
muscle names.  Once all of the muscles have been selected, verify 
the Side parameter and then click OK. 

 

 Setting the Side parameter to Left & Right will add the muscle to the Study 
window twice, once for the Left and once for the Right. 

 Adding muscles to the Study window in this manner is only temporary.  To 
add muscles to a Study List permanently, review the help topic "Changing an 
Existing Study". 

 

Real Time SFEMG Trace Window 

The contents of the Trace Area will varying depending on whether the program is 
in the Acquisition or Analysis modes. 

Acquisition Mode 

Displays the volitional SFEMG activity.  Adjust the Gain and Sweep Speed by 
using Knob #4 (Gain / Sweep) on the Sierra Wave base unit.  Simply turn the 
knob to adjust the gain, to change the sweep speed, press the knob first to 
toggle it to the sweep mode, then turn to change the sweep speed. 

Adjust the Trigger Level and Delay by using Knob #3 (Trig Lev /Trig Del). 
 Turn this knob to move the position of the trigger level (horizontal portion of 
purple crosshair) up or down within the trace window.  Each time a SFEMG 
potential crosses the trigger level the sweep is added to the capture buffer 
and the Peak Detect window is updated.  Press the knob to activate Trig Del 
mode then turn to move the delay point (vertical portion of purple crosshair) 
left or right in 0.1 division increments.  Changing the delay point allows you to 
see more or less data after the triggering potential. 

 The mouse can also be used to move the Trigger Level/Delay 
indicator. 
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The Peak Detect window (& trace buffer) are automatically cleared 
whenever the trigger indicator is moved a significant amount.  This feature 
can be disabled in the Real Time SFEMG Test Setup window. 

Right-clicking on the trace area displays a menu of functions that can be 
used. 

 

Trace window in Real Time SFEMG Acquisition mode. 

 

Right-click menu. 

Graticule Size:  The Real Time SFEMG Trace window is divided into a 
grid pattern using vertical and horizontal divisions or graticules.  The grid 
pattern can be changed by altering the number of these divisions.  The 
first number is for the number of vertical divisions, the second number is 
for the number of horizontal divisions. 

Copy Window:  Copies the contents of the Real Time SFEMG trace 
window to the clipboard. 

Analysis Mode 

Displays the traces in the capture buffer in groups of ten.  Right-clicking on 
the trace area displays a menu of functions that can be used. 
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Trace window in Real Time SFEMG Analysis mode. 

 

Right click menu. 

Store:  Stores the run to disk.  This is the same function as pressing the 
Store key on the base unit. 

Reject Selected Trace:  Marks the selected trace as "manually rejected" 
which colors it light-blue and removes it from the analysis. 

Graticule Size:  The Real Time SFEMG Trace window is divided into a 
grid pattern using vertical and horizontal divisions or graticules.  The grid 
pattern can be changed by altering the number of these divisions.  The 
first number is for the number of vertical divisions, the second number is 
for the number of horizontal divisions. 
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Save Traces to ASCII:  Allows all the displayed traces to be output to a 
comma separated values file (*csv).  For more information on using the 
ASCII Output Utility click here. 

Copy Window:  Copies the contents of the Real Time SFEMG trace 
window to the clipboard. 

 

Peak Detect Window 

The Peak Detect window is composed of two areas;  the Peak Tag area and the 
Peak Plot area.  Both of these areas are updated in real time during data 
acquisition.  Peak detection is based on an algorithm that uses a combination of 
amplitude, sharpness, and repeatability. 

 

Peak Tag Area: 

This area displays a firing frequency tag for the triggering potential and a 
consecutive discharge vs. frequency plot for up to four other peaks. 

 

The dividing line between the light blue and gray areas is the individual jitter 
norm that has been entered for the muscle. 

By default, the Keep (K) box is checked for each detected peak.  If you do not 
wish to keep the data for a particular peak then you should un-check this box. 
 When the Store key is pressed, all peaks with a check mark in the Keep (K) 
box will be added to the results table. 
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If a check mark appears in the Block (B) box this indicates that the program 
has detected blocking for that peak.  You can override the program by un-
checking this box.  When the Store key is pressed, all peaks with a check 
mark in the Block (B) box will have the notation of "Yes" entered in the 
Blocks column of the results table. 

 

If the jitter value is normal for the individual potential pair, the Block (B) 
box will not be automatically checked by the program as this is probably 
due to artifact in the data.  Blocking does not occur when the jitter is 
normal. 

If there is more than one peak detected, use the Next Tag button 

to expand the other MCD tags. 

Use the Change Trigger button when you would like to select a 
different potential as the trigger peak.  All jitter data is automatically 
recalculated when the trigger is changed. 

Peak Plot Area: 

For each captured trace a colored dot is drawn representing the peak of the 
triggering potential and up to four other time-locked peaks.  Each peak is 
given a unique color.  This area is updated in a waterfall fashion, one 
complete cycle through this area represents 100 captured traces. 
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Peak Plot Area, showing relationship to peaks in the Trace window. 

 

In analysis mode, this area shows a dark-blue highlight, called the Zoom Box. 
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Peak Plot Area, in analysis mode with Zoom Box. 

 

Peak Detection Criteria 

The following five criteria are used to determine a valid peak: 

1. Peak Amplitude - initial peak detection is based on amplitude.  A peak is 
detected if the 'baseline-to-peak' or 'trough-to-peak' amplitude exceeds 0.5 
 or 0.25 divisions.  So, if the amplitude criteria is set to 0.5 and the gain is 
set to 100 uV/Div, the signal must be at least 50 uV in amplitude to be 
considered as a possible peak.  This criteria is used to keep spurious 
baseline noise from being detected as peaks.  The default value is 0.5 
divisions. 

2. Peak Duration (Width) - when a peak is found its width (duration) is 
measured at the halfway point of its amplitude.  We go down from the 
peak on each side to the halfway point and then measure the duration 
across this imaginary line.  The width, or duration, must be less than or 
equal to 250, 300, or 350 us.  If it is greater than this it is not 'spikey' or 
'sharp' enough to be included in the analysis.  The default value is 250 us. 
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3. Peak Separation - a peak must be separated from other peaks by at least 
150, 100, or 50 us.  The default value is 150 us. 

4. Latency Deviation - the peak latency (or position) must be within +/-  4, 3, 
or 2 standard deviations of the mean latency for that peak.  The default 
value is 4 SD. 

5. Peak Frequency - the peak must occur in at least 30, 20, 10 or 0% of the 
trials, or it will be excluded.  The default value is 30%. 

 

 The peak detection criteria must be adjusted prior to data acquisition. 

 

Jitter Histogram Window 

This histogram provides a quick summary of the data collected for the muscle. 
 The vertical axis marks the count, while the horizontal axis indicates jitter (in 
microseconds, us).  The height of colored bar graphs indicates the number of 
runs containing that amount of jitter. Normal jitter is indicated by green bars, 
abnormal jitter as red bars, and abnormal jitter with blocking as red cross-
hatched bars.  A dashed line marks the jitter norm for individual potential pairs in 
the muscle. 
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Jitter Histogram. 

Table Options 

Clicking on a row in the Results Table highlights that row and allows that run's 
trace data to be reviewed.  Right-clicking within the table will display a menu of 
options. 

 

Real Time SFEMG Results Table 
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Right-click menu. 

Font Size:  The font size of the table can be increased or decreased.  The 
choices are Small (default), Medium, Large, and Extra Large. 

Copy Table:  Copies the contents of the Real Time SFEMG table to the 
Windows clipboard. 

Delete Run:  This will delete the highlighted row from the table and all the 
data for that run. 

Swap Jitter Value:  Selecting this option will cause the larger value between 
MCD and MSCD to be displayed in the Jitter field.  By default, the lower value 
of the two is displayed in the Jitter field. 

Table Columns: 

Run – indicates the run #.  If a run contains more than one analyzed 
potential pair, it is indicated by .2, .3, .4.  If the run was acquired using 
stimulation, an 's' will be added to this value. 

Blocks – a value of "Yes" indicates blocking occurred. 

IPI – displays the mean Inter-Potential Interval in microseconds (usec). 

Jitter – displays the lowest value of either the MCD or MSCD in 
microseconds (usec).  The user can right-click on this value and select 
Swap Jitter Value, this will display the larger of the two values in this field. 

Jitter Norm – the value on the first row of the table is the jitter norm for 
individual potential pairs.  The value in the mean row of the table is the 
overall MCD jitter norm for the muscle. 

MCD – the jitter as calculated by using the Mean Consecutive Difference 
for the run. 

MSCD – the jitter as calculated by using the Mean Sorted Consecutive 
Difference for the run. 

Freq. – displays the mean firing frequency of the triggering potential in 
hertz (Hz). 

Summary Data: 

Potential Pairs - displays the total number of potential pairs (automatic & 
manual) that have been recorded. 
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Abnormal Pairs % - indicates the percentage of runs with increased jitter 
for individual potential pairs. 

Normal Pairs % - indicates the percentage of runs with normal jitter for 
individual potential pairs. 

Jitter - displays the mean jitter value for the muscle. 

Blocks %  – indicates the percentage of runs with blocking potentials. 

Fiber Density - displays the fiber density value from the Fiber Density 
window. 

Fiber Density 

The top portion of the Fiber Density window is used to record the results of fiber 
density studies.  Count the number of time-locked potentials in the trace and then 
record that value by clicking on the corresponding button in the Fiber Density 
window.  The program computes the fiber density by taking the total count and 
dividing it by the number of entries (units).  The fiber density value is recorded in 
the results table and is included in reports. 

 

Fiber Density window. 
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In the above example: 

Fiber Density = (13 x 1) + (6 x 2) + (1 x 3) / (13 + 6 + 1) 

= 13 +12 + 3 / 20 

= 28 / 20 

= 1.40 

 

Manual Jitter 

Use the buttons in the bottom portion of the Fiber Density window to manually 
record  Normal , Increased, or Blocking potential pairs that are not detected 
by the automatic peak detection algorithm. 

 

These values are automatically included in the % Normal Pairs, % Abnormal 
Pairs, and % Blocks summary calculations. 

 

Deleting a Run 

To Delete a stored Real Time SFEMG run, perform one of the following 
procedures. 

Using the Study Window: 

 Right click the mouse over the Run # you want to delete in the Study 
window. 

 From the pop-up menu, select Delete. 

 A confirmation message will be displayed, click OK. 

 The Run is deleted and the mean and standard deviation values in the 
Results table are automatically re-calculated. 
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Using the Results Table: 

 Right click over the row in the table corresponding to the run you want 
to delete. 

 From the pop-up menu, select Delete Run. 

 

Reviewing a Run 

To review a Run, follow these steps. 

 Select the Run # you want to view by performing one of the following. 

o Turn Knob #1 (Select Run) until the desired run # is highlighted. 

o Left click the mouse over the desired run # in the Study window. 

o Left click the mouse over the desired run # within the Results 
table. 

The data for that run will be displayed in the Trace and Peak Detect windows. 

 

Saving Changes to Real Time SFEMG Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the Real Time SFEMG 
test protocol. 

 Select Save Test Parameters from the Edit menu. 
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Macro EMG 

Performing Macro EMG 

Select the Macro EMG  Test:   

 If a Study has already been selected, simply click on a Macro EMG 
muscle name (i.e., Right Biceps) within the Study window or turn Knob #1 
(Study Item) to highlight the muscle name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual Macro EMG test protocol from the Study/Test menu, 
a muscle list will be displayed allowing you to pick the muscle or muscles 
that you will be testing on the patient.  Notice that when a muscle is 
selected, it is displayed within the Study window. 

 

Once the muscle has been selected.  Follow these steps for performing 
routine Macro EMG data acquisition and analysis: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate.  Macro EMG utilizes a 2-Channel recording setup. 

Typical Settings 

 Gain 
(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep 
Speed 

(ms/Div) 

Channel 1: SFEMG signal 50 to 200 10 
kHz 

500 0.5 

Channel 2: Averaged 
Macro signal 

50 to 200 10 
kHz 

10 to 30 5.0 

 

Connect the Macro needle electrode to channel 1.  Use a reference jumper to 
connect the cannula of the Macro needle to the active input of channel 2. 
 Connect a surface reference electrode to the reference input of channel 2. 

2.  Verify the Side 

Make sure the appropriate side, Right or Left, is selected. 

3.  Insert the Macro Needle Electrode. 
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Move the needle until a stable signal with at least one sharp negative peak is 
shown on the single fiber channel. 

4.  Adjust the Gain and Sweep Speed as necessary. 

During Macro data acquisition you can easily adjust the Gain and Sweep 
Speed by using Knobs #3 and #4 on the Sierra Wave base unit.  Knob #3 
(SF Gain/SF Sweep) is used to adjust the SFEMG signal settings and Knob 
#4 (Mcr Gain/Mcr Sweep) can be used to adjust the Macro signal settings. 
 Simply turn the knob to adjust the gain, to change the sweep speed, press 
the knob first to toggle it to the sweep mode, then turn to change the sweep 
speed. 

You can also use the mouse to change these settings in the Macro EMG 
Controls toolbar. 

 

Macro EMG controls toolbar. 

5.  Adjust the Volume 

Increase or decrease the Sierra Wave's internal speaker by using the Volume 
knob on the left hand side of the base unit. 

6.  Adjust Trigger Level & Delay 

Adjust the trigger/delay cursor so that you can trigger on the sharp negative 
peak.  Knob #2 (Trig Level /Trig Delay) defaults to the Trig Level mode, 
turn this knob to move the position of the trigger level (horizontal portion of 
purple crosshair) up or down within the trace window.  Each time a SFEMG 
potential crosses the trigger level the macro signal average count is 
incremented.  Press the knob to activate Trig Delay mode then turn to move 
the delay point (vertical portion of purple crosshair) left or right in one division 
increments.  Changing the delay point allows you to see more or less data 
after the triggering potential. 

 The mouse can also be used to move the Trigger Level/Delay indicator. 

 The Macro trace average count is automatically reset whenever the 
position of the trigger & delay indicator is changed. 

7.  Acquire Data 

Once the appropriate SFEMG signal is located and the Trigger and Delay 
positions have been adjusted appropriately, allow the Macro signal to average 
until a stable baseline is achieved in the Macro trace. 
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Macro EMG acquisition mode.  The SFEMG trace and trigger/delay indicator are shown in 
the top half of the window.  The averaged Macro trace is shown in the bottom half of the 

window.  The current average count is shown in the trace label of the Macro trace. 

8.  Stop Data Acquisition 

Once the Macro signal is obtained, press the Run/Stop key on the Sierra 
Wave base unit or press the Footswitch to stop data acquisition.  This will 
change the display to the Analysis mode. 

 

Macro EMG Analysis mode. 

9.  Verify the Position of the Onset and End Cursors 

Check the position of the onset and end cursors (shown in light-blue) on the 
Macro trace.  The maximum peak amplitude and area under the curve are 
calculated between these two cursors.  Adjust the positions of these cursors 
by dragging them with the mouse. 

The run #, amplitude (uV), area (uV-ms) and average count will be 
displayed in the results table.  The data for the current run is shown in the 
Area vs. Amplitude graph as a blue circle. 

10.  Store the Run 

Press the Store key on the Sierra Wave base unit to keep the run.  In the 
Results Table the "Stored" field will change from No to Yes. 
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 As each Macro EMG run is stored, you will see a new "node" appear in 
the Study window below the muscle name.  The example below shows four 
runs stored for the Right Deltoid muscle.   

 

 If  you decide not to keep the run, do not press the Store key, simply 
return to the Acquisition mode by pressing the Run/Stop key and the run will 
be discarded. 

The Results Table records the analysis results for each run and calculates 
the mean or median values. 

 

Macro EMG Results Table 

Run – indicates the run #. 

Amp (uV) - maximum amplitude between the onset and end cursors, 
displayed in microvolts (uV). 
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Area (uV-ms) - area under the negative & positive portions of the curve 
between the onset and end cursors, displayed in microvolt/millisecond 
units. 

Average Count - displays the number of averages obtained for that run. 

Jitter - optional field for recording a qualitative indication of the jitter 
observed for the run.  Choices are Normal, Increased, and Blocking. 

Fiber Density - optional field for recording the fiber density observed for 
the run. 

Stored – indicates if the run has been stored to disk. 

Mean / Median - this setting determines how the data for all the runs is 
summarized.  If set to mean, then the summarized data for amplitude and 
area is shown as the mean values.  If set to median, then the summarized 
data for amplitude and area is shown as the median values.  The green 
diamond in the Area vs. Amplitude graph corresponds to these values. 

Fiber Density is always displayed as the mean value, regardless of this 
setting. 

11.  Acquire additional Macro EMG Runs. 

Press the Run/Stop key to return to Acquistion mode and repeat steps 6 
through 10 to acquire additional Macro EMG runs.  Typically 20 runs should 
be collected for the muscle. 

12.  Select Next Muscle (optional) 

From Acquisition mode, turn Knob #1 (Study Item) to highlight the next 
muscle in the Study window.  If the muscle you want to examine is not 
displayed within the Study window, press F3 (Muscle List) and select the 
next Macro EMG muscle from the list. 

Move the Macro EMG Needle Electrode to the new muscle and repeat the 
above steps as necessary. 

 It is a good idea to turn Off the preamplifier or turn down the Volume 
when moving the needle electrode to a new location. 

13.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 
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To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

14.  Next Test (optional) 

 Use Knob #1 (Study Item) to highlight another Test Protocol in the 
Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

 

 

Knob & Fkey Controls (Macro EMG) 

For Macro EMG, the functions assigned to the Sierra Wave base unit's Knob and 
F Key controls are the same in Acquisition and Analysis modes. 

 

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Trig Lev / Trig Delay - this knob defaults to the Trig Lev mode, turn the 
knob to change the vertical position of the trigger level indicator.  Press 
the knob to activate the Trig Delay mode, then turn to change the trigger 
delay position from 1 to 9 divisions in 0.1 division increments. 
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Mcr Gain /  Mcr Sweep - turn the knob to change the gain of the Macro 
EMG trace in channel 2.  Press the knob, then turn to change the sweep 
speed of the Macro EMG trace. 

SF Gain /  SF Sweep - turn the knob to change the gain of the Single 
Fiber EMG trace in channel 1.  Press the knob, then turn to change the 
sweep speed of the Single Fiber EMG trace. 

 

F Keys 

 

Live On / Live Off - selecting Live On will show the live Macro EMG trace 
above the averaged Macro trace. 

Audio 1 / Audio 2 - determines which channel is sent to the internal 
speaker. 

Muscle List - opens the Macro EMG Muscle List window which allows 
you to select and add muscles to your Study window. 

TabData - opens the TabData Summary window. 

 

Macro EMG Test Setup 

Macro EMG test setup options are discussed in detail in the Test Protocol 
Setup chapter of the Help system. 

Click here, to go to this topic. 

Muscle List (F3) 

The F3 (Muscle List) function key is a convenient way to add muscles to the 
Study window after a Study List has been selected or after the Macro EMG Test 
Protocol has been loaded. 

 

To Add a Muscle to the Study Window 

1. From within the Macro EMG Test Protocol, press the F3 (Muscle List) 
function key.  The Select Muscle window will be displayed. 
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F3 - Select Muscle window. 

2. To add a single muscle, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
line drawn around the muscle name.  Press the knob to highlight 
the muscle.  Verify the Side parameter, use Knob #2 (Side) to 
change this if necessary.  Press the OK key on the Sierra Wave 
base unit. 

 Using the Mouse - verify the Side parameter and then double 
click on the muscle name. 

3. To add multiple muscles, perform one of the following. 

 Using the Knobs - turn Knob #1 (Muscle Sel / Toggle) until the 
appropriate muscle name is selected, this is indicated by a dotted 
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line drawn around the muscle name.  Press the knob to highlight 
the muscle.  Repeat this process until all of the muscles you want 
to add are highlighted.  Verify the Side parameter, use Knob #2 
(Side) to change this if necessary.  Press the OK key on the Sierra 
Wave base unit. 

 Using the Mouse - single click the mouse over the appropriate 
muscle names.  Once all of the muscles have been selected, verify 
the Side parameter and then click OK. 

 

 Setting the Side parameter to Left & Right will add the muscle to the Study 
window twice, once for the Left and once for the Right. 

 Adding muscles to the Study window in this manner is only temporary.  To 
add muscles to a Study List permanently, review the help topic "Changing an 
Existing Study". 

Macro EMG Trace Area 

The contents of the Macro EMG Trace Area will varying depending on whether 
the program is in the Acquisition or Analysis mode. 

Acquisition Mode 

Displays the volitional SFEMG trace in the top half of the window and the 
averaged Macro EMG trace in the bottom half of the window.   

Adjust the Gain and Sweep Speed by using Knobs #3 and #4 on the Sierra 
Wave base unit.  Knob #3 (SF Gain/SF Sweep) is used to adjust the SFEMG 
signal settings and Knob #4 (Mcr Gain/Mcr Sweep) can be used to adjust 
the Macro signal settings.  Simply turn the knob to adjust the gain, to change 
the sweep speed, press the knob first to toggle it to the sweep mode, then 
turn to change the sweep speed. 

You can also use the mouse to change these settings in the Macro EMG 
Controls toolbar. 

 

Macro EMG controls toolbar. 

Adjust the trigger/delay cursor so that you can trigger on the sharp negative 
peak of the SFEMG trace.  Knob #2 (Trig Level /Trig Delay) defaults to the 
Trig Level mode, turn this knob to move the position of the trigger level 
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(horizontal portion of purple crosshair) up or down within the trace window. 
 Each time a SFEMG potential crosses the trigger level the macro signal 
average count is incremented.  Press the knob to activate Trig Delay mode 
then turn to move the delay point (vertical portion of purple crosshair) left or 
right in one division increments.  Changing the delay point allows you to see 
more or less data after the triggering potential. 

 The mouse can also be used to move the Trigger Level/Delay indicator. 

 The Macro trace average count is automatically reset whenever the 
position of the trigger & delay indicator is changed. 

Right-clicking on the trace area displays a menu of functions that can be 
used. 
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Macro EMG acquisition mode.  The SFEMG trace and trigger/delay indicator are shown in 
the top half of the window.  The averaged Macro trace is shown in the bottom half of the 

window.  The current average count is shown in the trace label of the Macro trace. 

 



Sierra Wave Help Manual 

790 

 

Right-click menu of SFEMG trace area. 

 

Amplitude Markers:  Enables amplitude markers within the SFEMG trace 
 area. 

Time Markers:  Enables time markers within the SFEMG trace  area. 

Graticule Size:  The Macro EMG Trace window is divided into a grid 
pattern using vertical and horizontal divisions or graticules.  The grid 
pattern can be changed by altering the number of these divisions.  The 
first number is for the number of vertical divisions, the second number is 
for the number of horizontal divisions. 

Capture Window:  When this feature is enabled the SFEMG trace area is 
split into two sections; the top section shows the live SFEMG trace and 
the trigger level indicator line, the bottom section shows a rastered display 
of the most recently captured traces. 

Capture Window Options. 

When the Capture Window is enabled, right clicking within the capture 
window trace area will display a pop-up menu of display options. 
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 Hide Capture Window – turns off the capture window. 

 Number of Captured Traces - changes the number of traces 
displayed in the captured window trace area.  Select 3, 5, or 10 
from the drop down list or type in any number between 2 and 
100. 

 Amplitude Markers – enables amplitude markers in the 
captured window area. 

 Time Markers – enables time markers in the captured window 
area. 

 Raster / Overlay – sets the position of the captured window 
traces as either rastered or overlayed (i.e., superimposed). 

 Auto Position Traces - if captured window traces have been 
moved up/down using the mouse, this option will return the 
traces to their original positions. 

 Sweep Speed – the sweep speed of the Live and Capture 
Window areas can be set independently. 

o Link Sweep to EMG Trace Window – automatically sets 
the captured window trace area to the same sweep 
speed as the Live trace. 

o 1, 2, 5, 10 ms/Div – sets the captured window trace 
sweep speed to the selected value.  Dual sweep values 
are displayed in the Controls Toolbar or Amplifier 
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Controls window when the captured window sweep 
speed is set differently than the Live trace sweep speed. 

 Copy Window - copies the contents of the entire Macro EMG 
trace window to the clipboard. 

Enabling the Capture Window Display as your default setting for 
Macro EMG. 

The status of the Capture Window display feature and the number of 
traces displayed within the window can be saved as part of the default 
settings for the Macro EMG test protocol.  With the feature enabled, 
simply select Save Test Parameters from the Edit menu. 

Analysis Mode 

The Analysis mode shows the final averaged Macro trace in the bottom half of 
the window.  Nothing is displayed in the top half of the window.  Right-clicking 
on the Macro trace area displays a menu of functions that can be used. 

 

Final averaged Macro trace and right-click menu options. 

Amplitude Markers:  Enables amplitude markers within the Macro trace 
 area. 

Time Markers:  Enables time markers within the Macro  trace  area. 



Protocols 

793 

Show All Macro EMG Traces:  When selected all the macro traces for 
every run in the results table will be displayed. 

Show Current Trace:  When selected the macro trace for the currently 
selected run in the results table will be displayed. 

Graticule Size:  The Macro EMG Trace window is divided into a grid 
pattern using vertical and horizontal divisions or graticules.  The grid 
pattern can be changed by altering the number of these divisions.  The 
first number is for the number of vertical divisions, the second number is 
for the number of horizontal divisions. 

Save Traces to ASCII:  Allows all the traces in the Macro trace area to be 
output to a comma separated values file (*csv).  For more information on 
using the ASCII Output Utility click here. 

Copy Window - copies the contents of the entire Macro EMG trace 
window to the clipboard. 

Macro EMG Graph Options 

The graph window can display an Area vs. Amplitude plot or two histogram data 
plots.  Right-click over this window to select the plot you would like to view. 

 

 

Area vs. Amplitude: 

This graph displays the Area (uV-ms) on the Y-axis and the Amplitude (uV) on 
the X-axis.  For each run, one data point is plotted.  The blue circle indicates the 
data point for the currently selected run in the Results Table.  Red circles are the 
data points for the other stored runs in the Results table.  The green diamond 
indicates the mean or median data point for the all the runs. 
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Amplitude Histogram: 

Displays the distribution of the amplitude values in a bar graph format.  The 
height of each bar indicates the counts (N) for each value of amplitude. 
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Area Histogram: 

Displays the distribution of the area values in a bar graph format.  The height of 
each bar indicates the counts (N) for each value of area. 

 

 

 

Table Options 

Clicking on a row in the Results Table highlights that row and allows that run's 
trace data to be reviewed.  Right-clicking within the table will display a menu of 
options. 
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Macro EMG results table. 

 

Right-click menu. 

Font Size:  The font size of the table can be increased or decreased.  The 
choices are Small (default), Medium, Large, and Extra Large. 

Copy Table:  Copies the contents of the Macro EMG results table to the 
Windows clipboard. 

Delete Run:  This will delete the highlighted row from the table and all the 
data for that run. 

Column Definitions: 

Run – indicates the run #. 

Amp (uV) - maximum amplitude between the onset and end cursors, 
displayed in microvolts (uV). 

Area (uV-ms) - area under the negative & positive portions of the curve 
between the onset and end cursors, displayed in microvolt/millisecond 
units. 

Average Count - displays the number of averages obtained for that run. 

Jitter - optional field for recording a qualitative indication of the jitter 
observed for the run.  Choices are Normal, Increased, and Blocking. 
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Fiber Density - optional field for recording the fiber density observed for 
the run. 

Stored – indicates if the run has been stored to disk. 

Mean / Median - this setting determines how the data for all the runs is 
summarized.  If set to mean, then the summarized data for amplitude and 
area is shown as the mean values.  If set to median, then the summarized 
data for amplitude and area is shown as the median values.  The green 
diamond in the Area vs. Amplitude graph corresponds to these values. 

 Fiber Density is always displayed as the mean value, regardless of 
this setting. 

Total:  indicates the total number of runs in the table. 

Normal – indicates the percentage of runs with normal jitter. 

Increased - indicates the percentage of runs with increased jitter. 

Blocking - indicates the percentage of runs with blocking. 

Deleting a Run 

To Delete a stored Macro EMG run, perform one of the following procedures. 

Using the Study Window: 

 Right click the mouse over the Run # you want to delete in the Study 
window. 

 From the pop-up menu, select Delete. 

 A confirmation message will be displayed, click OK. 

 The Run is deleted and the mean/median values in the Results table 
are automatically re-calculated. 
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Using the Results Table: 

 Right click over the row in the table corresponding to the run you want 
to delete. 

 From the pop-up menu, select Delete Run. 

Reviewing a Run 

To review a Run, follow these steps. 

 Select the Run # you want to re-analyze by performing one of the 
following. 

o Left click the mouse over the desired run # in the Study window. 

o Left click the mouse over the desired run # within the Results 
table. 

 

Displaying all Macro Traces 

To display all the Macro traces for every run in the results table. 

 Right-click over the Macro trace area and select Show All Macro EMG 
Traces. 
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Macro EMG trace window showing all traces. 

Saving Changes to Macro EMG Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the Macro EMG test 
protocol. 

 Select Save Test Parameters from the Edit menu. 
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EPs (SEP, AEP, VEP, P300) 

SEP Basic Steps 

This topic is a repeat of the basic SEP steps found in the Getting Started 
chapter. 

Select the SEP  Test: 

 If a Study has already been selected, simply click on the SEP test 
protocol within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the SEP test protocol from the Study/Test menu. 

 

Once the SEP test has been selected.  Follow these steps for performing 
data acquisition: 

1.  Apply electrodes to the patient and connect to amplifier 

Determine the number of channels that will be recorded and the electrodes 
that will be required for each channel.  Apply the recording electrodes and 
ground electrode to the patient and connect to the Sierra Wave amplifier. 

To view a common 3 Channel Median SEP setup, Click here. 

To view a common 3 Channel Tibial SEP setup, Click here. 

2.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the selected SEP test. 

Typical Settings 

 Display 
Gain 

(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep Speed 
(ms/Div) 

Upper Limb SEP 1 to 5 3k to 500 10 5.0 

Lower Limb SEP 1 to 5 3k to 500 10 10.0 

 

A Common Reference (CREF) input is available on the 4 Channel Amplifier. 
 The status of the CREF input, Off or On for each channel, will depend on the 
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montage chosen for the test.  If the amplifier channel should use its 
corresponding individual reference input (i.e., reference 1, 2, 3, or 4) the 
CREF setting should be set to OFF.  If the channel should not use its 
individual reference input, but should use the CREF input in its place, then the 
CREF setting should be set to ON. 

The Notch filter is typically not used during SEP recordings and should 
remain OFF. 

 

Median SEP default Amplifier Settings. 

3.  Check Impedances 

Press the Imped key on the Sierra Wave base unit.  The impedance window 
displays a picture of the front of the amplifier. 

 

Impedance window.  Channels 1, 2 and 3 have the CREF input enabled, channel 4 is turned 
Off. 
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The Active (black) and Reference (red) inputs are displayed for each 
channel as well as the CREF input (4 Channel Amplifier only).  The Ground 
input is not included in impedance measurements. 

If a Channel is turned Off, no impedance values will be calculated for either 
the active or reference inputs and the word "Off" is displayed over the inputs 
of that channel. 

When the CREF input is enabled (i.e., ON) for a channel, that channel's 
reference input will not show an impedance value and will have the word "Off" 
over the reference input.  An impedance value for the CREF input will be 
displayed. 

Impedances less than 5k Ohms (kilo-ohms) are displayed in green.  Values 
between 5.1 and 20 are displayed in yellow.  Values greater than 20 are 
displayed in red. 

To close the impedance window, press the Imped key again or click the OK 
button. 

 When performing evoked potential studies all impedances should be 
less than 5k Ohms. 

4.  Select Side of Stimulation 

Make sure the appropriate side, Right or Left, is selected.   

5.  Check Stimulator Settings and Polarity 

Apply the stimulating electrodes (bar electrode or individual electrodes) to the 
patient.  Connect the stimulating electrodes to the end of the hand-held 
electrical stimulator (remove the probe tips from the end of the stimulator). 
 The proximal stimulating electrode should be connected to the Cathode (-) 
and the distal stimulating electrode should be connected to the Anode (+). 

Intensity - start at zero milliamps and after data acquisition is started 
increase slowly until a visible muscle twitch is seen. 

Pulse Width - typically set to 100 or 200 microseconds. 

Rep Rate - typically between 2 to 5 Hz and not directly divisible into 60 (e.g., 
2.11, 2.66, 4.77). 

Polarity - set to Normal (Nml) mode. 



Protocols 

803 

  

Controls Window.                          Controls Toolbar. 

SEP Stimulator Controls 

6.  Verify Averager Settings 

Shutoff - This is the number of responses that will be averaged together to 
produce the final results.  When the shutoff count is reached stimulation will 
automatically be stopped. 

Reject On / Off - When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the percentage 
(%) of stimuli/sweeps that have been rejected from the total delivered will be 
displayed on the screen. 

Level - This is the reject sensitivity level, it is shown as a percentage of full 
amplifier scale.  Choices are 30 to 100 % in increments of 5.  100% equals 
full scale, smaller numbers will make the reject more sensitive. 

 

Example SEP Averager settings. 

 Reject is based on the Live un-averaged data and the Amp Gain 
setting.  Every channel has 5 divisions above and below its initial baseline. 
 So, if the Amp Gain is set to 10 uV/Div this means that the Live trace has an 
amplitude window of 100 microvolts (10 vertical divisions times 10 uV/Div) 
with 50 uV above the baseline and 50 uV below the baseline.  If the reject 
level is set to 100% (i.e., full scale), then the amplitude of the live data must 
be below +/- 50 uV to be included in the running average.  Should it exceed 
+/- 50 uV the trace will be rejected from the running average.  If the reject 
level is set to 50% (i.e., half of full scale), then the amplitude of the Live data 
can't exceed +/- 25 uV (2.5 divisions above or below the baseline) or it will be 
rejected from the running average.  The lower the reject level setting the more 
sensitive the program will be in rejecting large artifacts. 
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 You can check the Amp Gain setting by pressing the F1 (Avg / Live) 
function key to switch to the Live mode.  Press the function key again to 
return to the Avg mode and view the Display Gain setting. 

7.  Acquire Responses 

A.  Start Data Acquisition. 

Press the Run/Stop key to start stimulus delivery and data acquisition. 
 Slowly turn up the stimulus intensity level until a visible muscle twitch 
is observed.  The average count (AvgCnt) should start to increment and 
the traces will begin to take shape. 

Adjust the vertical size of the all traces by turning Knob #4 (Gain).  To 
adjust the gain of an individual trace, change the corresponding gain 
setting in the amplifier section of the EP Controls window. 

Press the F3 (Smooth) function key during acquisition to remove high 
frequency noise from the active (white) traces. 

B.  Store the first trial. 

When the Shutoff count is reached, stimulation will stop automatically. 
 Press the Store key to store the active (white) traces.  A copy of the 
active traces will appear on the screen and are displayed in purple. 

 The Store key can be pressed before the Shutoff count is reached. 
 This will cause the currently active traces to be stored, the average count 
will be reset to zero, and stimulation will continue automatically on a new 
set of traces. 

C.  Clear the Average Count. 

Press the Clear key to reset the average count (AvgCnt) back to zero. 
 The active (white) traces will be reset to flat lines. 

D.  Acquire a second Trial 

Press the Run/Stop key to start stimulus delivery and data acquisition 
again.  Generally, two trials should always be acquired when performing 
evoked potentials to show replication of the traces. 

E.  Store second trial and Clear. 

After the Shutoff count is reached for the second trial, press the Store key 
to store the active (white) traces.  Press the Clear key to reset the 
average count to zero. 

F.  Change Side of Stimulation. 
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To acquire traces for the opposite side, change the Side setting in the EP 
Controls window.  If you are using the Split Screen feature the active 
(white) traces will automatically move to the opposite side of the Trace 
window. 

G.  Repeat steps A - E and collect data for the opposite side. 

 

Example 3 Channel Median SEP, Left and Right. 

8.  Trace Positioning (optional) 

If the position of the traces needs to be adjusted, follow one of these 
procedures. 

 Using the Mouse - simply click on the Trial you want to move with 
the left mouse button and drag the trial to its new location.  If you 
want to move an individual Trace, not the entire Trial, first right-click 
the mouse over the Trace window and remove the check mark in 
front of "Trial Selection Mode". 

 Using the Knobs - press the F6 (Position) function key on the 
PC's keyboard.  The program's knob and function keys will change 
to reflect the position mode controls.  Use Knob #1 (Sel Trial / 
Move) to select and move trials.  To move individual traces, first 
press the F4 (Trial / Trace) function key to change the selection 
mode. 
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When positioning is completed, press the F6 (Position) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Position mode. 

 Using the Trace Position Settings - right-click the mouse over the 
Trace window and select Trace Position Settings from the pop-up 
menu.  Change the settings for Start Position, Trial Offset, and 
Channel Offset and click OK. 

9.  Place Auto Cursors 

To place Cursors on the important trace features, follow one of these 
procedures. 

 Using the Mouse - simply left-click on a trial to select it, the trial 
will be displayed in yellow.  Now, right-click the mouse and select 
Auto Place Cursors from the pop-up menu.  Cursors will be 
placed on the selected trial and the values (latency, amplitude, etc.) 
derived from the cursors will be displayed in the EP Cursor Table 
window. 

 Using the Mouse and F9 (Auto Cursors) function key - simply 
left-click on a trial to select it, the trial will be displayed in yellow. 
 Now, press the F9 key.  Cursors will be placed on the selected trial 
and the values (latency, amplitude, etc.) derived from the cursors 
will be displayed in the EP Cursor Table window. 

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trial) to select 
a trial, when selected the trial will be displayed in yellow.  Once the 
appropriate trial is selected, press the F2 (AutoPlace Cursors) 
function key and cursors will be placed on the selected trial.  The 
values (latency, amplitude, etc.) derived from the cursors will be 
displayed in the EP Cursor Table window. 

After cursors have been placed, press the F5 (Cursor) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Cursor mode. 

 For information on configuring the Auto Cursors, see the SEP Test 
Protocol setup topic. 

 



Protocols 

807 

To adjust the positions of the Cursors, follow one of these procedures. 

 Using the Mouse - simply click on the Cursor you want to move 
with the left mouse button and drag the cursor along the trace to its 
new location.  

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trial) to select 
the trial with the cursors you need to adjust, when selected the trial 
will be displayed in yellow.  Once the appropriate trial is selected, 
use Knob #1 (Sel Cursor / Move) to select and move the desired 
cursor. 

After cursor positions have been adjusted, press the F5 (Cursor) 
function key again or press the OK key on the Sierra Wave base unit 
to exit from Cursor mode. 

 

Example Median SEP Cursor Table. 

 The program will calculate the left minus right difference values for each 
defined measurement after cursors have been placed on one left and one 
right side trial. 

 Depending on your preferences in System Setup, abnormal values can 
be flagged with a red background color, as bold text, as bold text with an 
asterisk, or as bold text & background color red. 

10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 
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To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Test 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test 
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AEP Basic Steps 

This topic is a repeat of the basic AEP steps found in the Getting Started 
chapter. 

Select the AEP  Test: 

 If a Study has already been selected, simply click on the AEP test 
protocol within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the AEP test protocol from the Study/Test menu. 

 

Once the AEP test has been selected.  Follow these steps for performing 
data acquisition: 

1.  Apply electrodes to the patient and connect to amplifier 

Determine the number of channels that will be recorded and the electrodes 
that will be required for each channel.  Apply the recording electrodes and 
ground electrode to the patient and connect to the Sierra Wave amplifier. 

 

2.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the selected AEP test. 

Typical AEP Settings 

Display Gain = 0.2 to 0.5 uV/Div 

Hicut = 3k Hz 

Locut = 100 Hz 

Sweep Speed = 1.0 ms/Div 

A Common Reference (CREF) input is available on the 4 Channel Amplifier. 
 The status of the CREF input, Off or On for each channel, will depend on the 
montage chosen for the test.  If the amplifier channel should use its 
corresponding individual reference input (i.e., reference 1, 2, 3, or 4) the 
CREF setting should be set to OFF.  If the channel should not use its 
individual reference input, but should use the CREF input in its place, then the 
CREF setting should be set to ON. 

The Notch filter is typically not used during AEP recordings and should 
remain OFF. 
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2Ch. AEP Default Settings. 

3.  Check Impedances 

Press the Imped key on the Sierra Wave base unit.  The impedance window 
displays a picture of the front of the amplifier. 

 

Impedance window.  Channels 3 & 4 are turned Off.  CREF is turned OFF. 

The Active (black) and Reference (red) inputs are displayed for each 
channel as well as the CREF input (4 Channel Amplifier only).  The Ground 
input is not included in impedance measurements. 

If a Channel is turned Off, no impedance values will be calculated for either 
the active or reference inputs and the word "Off" is displayed over the inputs 
of that channel. 
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When the CREF input is enabled (i.e., ON) for a channel, that channel's 
reference input will not show an impedance value and will have the word "Off" 
over the reference input.  An impedance value for the CREF input will be 
displayed. 

Impedances less than 5k Ohms (kilo-ohms) are displayed in green.  Values 
between 5.1 and 20 are displayed in yellow.  Values greater than 20 are 
displayed in red. 

To close the impedance window, press the Imped key again or click the OK 
button. 

 When performing evoked potential studies all impedances should be 
less than 5k Ohms. 

4.  Select Side of Stimulation 

Make sure the appropriate side, Right or Left, is selected.   

5.  Check Stimulator Settings 

Apply the stimulator (headphones or inserts) to the patient, the red 
headphone/insert should be placed on the patient's right side, the left 
headphone/insert should be placed on the left.  Connect the stimulator  to the 
back of the Sierra Wave base unit. 

 

AEP Stimulator Settings - Controls Window 

 

AEP Stimulator Settings - Controls Toolbar 

Mode:  Click here to select the auditory stimulus type, choose either Click, 
Tone, Pip202, or Pip212. 

 Click - this is a 100 microsecond click stimulus. 

 Tone - this is a 10-30-10 tone burst stimulus.  It has a 10 millisecond 
rise time, a 30 millisecond plateau, and a 10 millisecond fall time.  This 
stimulus is typically used for long latency auditory evoked potentials. 
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 Pip 202 or Pip 212 - these are also tone stimuli but their rise, plateau, 
and fall times are measured in cycles rather than milliseconds.  The 2-
0-2 Pip has a 2 cycle rise, 0 cycle plateau, and 2 cycle fall.  The 2-1-2 
Pip has a 2 cycle rise, 1 cycle plateau, and a 2 cycle fall. 

 Frequency - when Tone, PiP202, or PiP212 are selected a Frequency 
setting will be displayed.  Click here to select the frequency of the 
tone/pip.  The choices are 250, 500, 750, 1000, 2000, 3000, 4000, 
6000, and 8000 Hz. 

 R/P/F - when Tone, Pip202, or Pip212 are selected the rise, plateau, 
and fall values are shown here.  Click here to change these values. 

 

Change the rise, plateau, and fall values for a Tone or Pip. 

 Envelope - when Tone, Pip202, or Pip212 are selected a stimulus 
envelope can be selected here.  Choices are None, Linear, Blackman, 
Hanning, and Gaussian. 

Type:  Click here to select the type of stimulus delivery hardware, choose 
either Phones or Inserts. 

 When Inserts are selected the program will automatically subtract 
1.0 milliseconds from all latency calculations to compensate for the delay 
produced by the plastic tubing.  This delay value can be modified by 
clicking on the Acoustic Delay value.  This value does not shift the 
displayed trace. 

Polarity:  Click here to set the stimulus polarity, the choices vary depending 
on the stimulus type. 

 For Click - choose either Rarefaction, Condensation, or Alternating 
polarity. 

 For Tone or Pip -  choose either Negative, Positive, or Alternating 
polarity. 
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Intensity L-R:  Click here to set the starting stimulus intensity value.  The first 
column is for the left side, the second column is for the right side. 

 To avoid excessive auditory stimulation, ensure that the stimulus 
intensity never exceeds 75 dB above the hearing threshold. 

Threshold L-R:  Indicates the behavioral threshold value.  The first column is 
for the left side, the second column is for the right side.  During data 
acquisition the Threshold values are added to the Intensity values to produce 
the stimulus at the headphones/inserts.  See step #6 for instructions on 
determining thresholds. 

Intensity Units:  Choose either nHL (normalized hearing level) or SPL 
(sound pressure level).  When SPL is selected the Threshold settings are 
disabled. 

dB Incr:  Click here to change the intensity value scale.  The default 
setting is 1 dB increments, choices are 1, 2, 5 and 10. 

Mask:  Click here to set the "white" noise masking as either On or Off and to 
set the level for the non-stimulated ear.  The amount selected is the number 
of dB's below the Intensity value.  This is known as differential masking and 
allows the intensity of the masking noise to decrease automatically as the 
intensity of the stimulus is decreased. 

Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz). 

6.  Determine Behavioral Threshold Levels (optional) 

There are two specially designated knobs for setting the behavioral threshold 
levels.  Knob #2 (L Thresh/Off) and Knob #3 (R Thresh/Off).  To determine 
the threshold levels follow these steps. 

I. Turn Knob #2.  Stimuli will be automatically delivered to the left ear 
and the threshold value for the left ear will turn "yellow". 

II. Continue to turn Knob #2 until the patient can definitely hear the 
stimulus. 

III. Slowly turn Knob #2 in the reverse direction to decrease the 
threshold level.  Keep decreasing the level until the patient signals 
that they can no longer hear, or can just barely hear, the stimulus. 

IV. Press Knob #2 to stop stimulus delivery and set the threshold 
value for the left ear. 

V. Repeat the above steps for the right ear using Knob #3. 
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 The threshold value is automatically added to the intensity value to 
obtain the output level for the stimulator.  For example, if the left intensity was 
set to 70 dB and the left threshold was determined to be 12 dB, the actual 
output intensity from the stimulator would be 82 (70 + 12). 

7.  Verify Averager Settings 

Shutoff - This is the number of responses that will be averaged together to 
produce the final results.  When the shutoff count is reached stimulation will 
automatically be stopped. 

Reject On / Off - When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the percentage 
(%) of stimuli/sweeps that have been rejected from the total delivered will be 
displayed on the screen. 

Level - This is the reject sensitivity level, it is shown as a percentage of full 
amplifier scale.  Choices are 30 to 100 % in increments of 5.  100% equals 
full scale, smaller numbers will make the reject more sensitive. 

 

AEP Default Averager Settings. 

 Reject is based on the Live un-averaged data and the Amp Gain 
setting.  Every channel has 5 divisions above and below its initial baseline. 
 So, if the Amp Gain is set to 10 uV/Div this means that the Live trace has an 
amplitude window of 100 microvolts (10 vertical divisions times 10 uV/Div) 
with 50 uV above the baseline and 50 uV below the baseline.  If the reject 
level is set to 100% (i.e., full scale), then the amplitude of the live data must 
be below +/- 50 uV to be included in the running average.  Should it exceed 
+/- 50 uV the trace will be rejected from the running average.  If the reject 
level is set to 50% (i.e., half of full scale), then the amplitude of the Live data 
can't exceed +/- 25 uV (2.5 divisions above or below the baseline) or it will be 
rejected from the running average.  The lower the reject level setting the more 
sensitive the program will be in rejecting large artifacts. 

 You can check the Amp Gain setting by pressing the F1 (Avg / Live) 
function key to switch to the Live mode.  Press the function key again to 
return to the Avg mode and view the Display Gain setting. 

8.  Acquire Responses 

A.  Start Data Acquisition. 
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Press the Run/Stop key to start stimulus delivery and data acquisition. 
 The average count (AvgCnt) should start to increment and the traces will 
begin to take shape. 

Adjust the vertical size of the all traces by turning Knob #4 (Gain).  To 
adjust the gain of an individual trace, change the corresponding gain 
setting in the amplifier section of the EP Controls window. 

Press the F3 (Smooth) function key during acquisition to remove high 
frequency noise from the active (white) traces. 

B.  Store the first trial. 

When the Shutoff count is reached, stimulation will stop automatically. 
 Press the Store key to store the active (white) traces.  A copy of the 
active traces will appear on the screen and are displayed in purple. 

 The Store key can be pressed before the Shutoff count is reached. 
 This will cause the currently active traces to be stored, the average count 
will be reset to zero, and stimulation will continue automatically on a new 
set of traces. 

C.  Clear the Average Count. 

Press the Clear key to reset the average count (AvgCnt) back to zero. 
 The active (white) traces will be reset to flat lines. 

D.  Acquire a second Trial 

Press the Run/Stop key to start stimulus delivery and data acquisition 
again.  Generally, two trials should always be acquired when performing 
evoked potentials to show replication of the traces. 

E.  Store second trial and Clear. 

After the Shutoff count is reached for the second trial, press the Store key 
to store the active (white) traces.  Press the Clear key to reset the 
average count to zero. 

F.  Change Side of Stimulation. 

To acquire traces for the opposite side, change the Side setting in the EP 
Controls window.  If you are using the Split Screen feature the active 
(white) traces will automatically move to the opposite side of the Trace 
window. 

G.  Repeat steps A - E and collect data for the opposite side. 
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Example 2 Channel AEP, Left and Right. 

9.  Trace Positioning (optional) 

If the position of the traces needs to be adjusted, follow one of these 
procedures. 

 Using the Mouse - simply click on the Trace you want to move 
with the left mouse button and drag the trace to its new location. 

 Using the Knobs - press the F6 (Position) function key on the 
PC's keyboard.  The program's knob and function keys will change 
to reflect the position mode controls.  Use Knob #1 (Sel Trace / 
Move) to select and move traces. 

When positioning is completed, press the F6 (Position) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Position mode. 

 Using the Trace Position Settings - right-click the mouse over the 
Trace window and select Trace Position Settings from the pop-up 
menu.  Change the settings for Start Position, Trial Offset, and 
Channel Offset and click OK. 

10.  Place Auto Cursors 

To place Cursors on the important trace features, follow one of these 
procedures. 
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 Using the Mouse - simply left-click on a trace to select it, the 
trace will be displayed in yellow.  Now, right-click the mouse and 
select Auto Place Cursors from the pop-up menu.  Cursors will be 
placed on the selected trace and the values (latency, amplitude, 
etc.) derived from the cursors will be displayed in the EP Cursor 
Table window. 

 Using the Mouse and F9 (Auto Cursors) function key - simply 
left-click on a trace to select it, the trace will be displayed in 
yellow.  Now, press the F9 key.  Cursors will be placed on the 
selected trace and the values (latency, amplitude, etc.) derived 
from the cursors will be displayed in the EP Cursor Table window. 

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select a trace, when selected the trace will be displayed in yellow. 
 Once the appropriate trace is selected, press the F2 (AutoPlace 
Cursors) function key and cursors will be placed on the selected 
trace.  The values (latency, amplitude, etc.) derived from the 
cursors will be displayed in the EP Cursor Table window. 

After cursors have been placed, press the F5 (Cursor) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Cursor mode. 

 For information on configuring the Auto Cursors, see the AEP Test 
Setup topic. 

To adjust the positions of the Cursors, follow one of these procedures. 

 Using the Mouse - simply click on the Cursor you want to move 
with the left mouse button and drag the cursor along the trace to its 
new location.  

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select the trace with the cursors you need to adjust, when selected 
the trace will be displayed in yellow.  Once the appropriate trace is 
selected, use Knob #1 (Sel Cursor / Move) to select and move the 
desired cursor. 

After cursor positions have been adjusted, press the F5 (Cursor) 
function key again or press the OK key on the Sierra Wave base unit 
to exit from Cursor mode. 
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AEP cursor table example. 

 The program will calculate the left minus right difference values for each 
defined measurement after cursors have been placed on one left and one 
right side trace. 

 Depending on your preferences in System Setup, abnormal values can 
be flagged with a red background color, as bold text, as bold text with an 
asterisk, or as bold text & background color red. 

11.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 
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12.  Next Test 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

VEP Basic Steps 

This topic is a repeat of the basic VEP steps found in the Getting Started 
chapter. 

Select the VEP  Test: 

 If a Study has already been selected, simply click on the VEP test 
protocol within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the VEP test protocol from the Study/Test menu. 

 

Once the VEP test has been selected.  Follow these steps for performing 
data acquisition: 

1.  Apply electrodes to the patient and connect to amplifier 

Determine the number of channels that will be recorded and the electrodes 
that will be required for each channel.  Apply the recording electrodes and 
ground electrode to the patient and connect to the Sierra Wave amplifier. 

 

2.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the selected VEP test. 

Typical VEP Settings 

Display Gain = 5 uV/Div 

Hicut = 200 Hz 

Locut = 1 Hz 

Sweep Speed = 25 ms/Div 
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A Common Reference (CREF) input is available on the 4 Channel Amplifier. 
 The status of the CREF input, Off or On for each channel, will depend on the 
montage chosen for the test.  If the amplifier channel should use its 
corresponding individual reference input (i.e., reference 1, 2, 3, or 4) the 
CREF setting should be set to OFF.  If the channel should not use its 
individual reference input, but should use the CREF input in its place, then the 
CREF setting should be set to ON. 

The Notch filter is typically not used during VEP recordings and should 
remain OFF. 

 

Default VEP Amplifier Settings. 

3.  Check Impedances 

Press the Imped key on the Sierra Wave base unit.  The impedance window 
displays a picture of the front of the amplifier. 
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Impedance window.  Channels 2, 3, & 4 are turned Off.  CREF is turned Off for Channel 1. 

The Active (black) and Reference (red) inputs are displayed for each 
channel as well as the CREF input (4 Channel Amplifier only).  The Ground 
input is not included in impedance measurements. 

If a Channel is turned Off, no impedance values will be calculated for either 
the active or reference inputs and the word "Off" is displayed over the inputs 
of that channel. 

When the CREF input is enabled (i.e., ON) for a channel, that channel's 
reference input will not show an impedance value and will have the word "Off" 
over the reference input.  An impedance value for the CREF input will be 
displayed. 

Impedances less than 5k Ohms (kilo-ohms) are displayed in green.  Values 
between 5.1 and 20 are displayed in yellow.  Values greater than 20 are 
displayed in red. 

To close the impedance window, press the Imped key again or click the OK 
button. 

 When performing evoked potential studies all impedances should be 
less than 5k Ohms. 

4.  Select Side of Stimulation 

Make sure the appropriate side, Right or Left, is selected.   
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5.  Check Stimulator Settings 

Connect the VEP stimulator to the appropriate connector on the back of the 
Sierra Wave base unit.  Position the stimulator at the required distance from 
the patient.  Cover the non-stimulated eye. 

 

VEP Default Stimulator Settings - Controls Window 

 

VEP Stimulator Settings - Controls Toolbar 

Mode:  Click here to select the type of visual stimulus.  Choices are Checks, 
Goggles, LED, and Flash. 

 Checks - selects a reversing black & white checkerboard pattern. 
 When checks are selected as the stimulus type the following 
additional parameters are available. 

o Target - select either On or Off.  When turned On a small target 
is positioned in the center of the black & white monitor, the 
patient should focus on this target during data acquisition. 

o Checks - click here to select the number of checks displayed 
across a horizontal row.  The choices are 1, 2, 4, 8, 16, 32, 64, 
and 128 (default is 32 checks with monitor positioned about 1 
meter from patient). 

o Field - click in this area to select the field of stimulation.  The 
choices are Full Field, Upper Half,  Right Half, Lower Half, Left 
Half, Left Upper Quarter, Right Upper Quarter, Right Lower 
Quarter, and Left Lower Quarter (default is Full Field). 

 Goggles - selects the LEG Goggles. 

 LED - selects the 3 inch hand held LED checkerboard stimulator. 

 Flash - selects the strobe flash stimulator. 
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Rep Rate:  Click here to set the repetitive stimulus rate, in pulses per second 
(Hz). 

If you are using a LCD Television Monitor, rather than a CRT Monitor, 
please refer to the document "291218-933 - Setup Instructions for LCD 
Checkerboard Monitor.pdf".  LCD monitors have different screen drawing 
characteristics than CRT monitors, and as such a compensatory delay (or 
offset) has to be determined and entered into the Sierra Wave program 
before an LCD monitor can be used.  Without this delay value entered into the 
program the latency of the visual evoked potentials will be greatly prolonged. 

6.  Verify Averager Settings 

Shutoff - This is the number of responses that will be averaged together to 
produce the final results.  When the shutoff count is reached stimulation will 
automatically be stopped. 

Reject On / Off - When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the percentage 
(%) of stimuli/sweeps that have been rejected from the total delivered will be 
displayed on the screen. 

Level - This is the reject sensitivity level, it is shown as a percentage of full 
amplifier scale.  Choices are 30 to 100 % in increments of 5.  100% equals 
full scale, smaller numbers will make the reject more sensitive. 

 

VEP Default Averager Settings. 

 Reject is based on the Live un-averaged data and the Amp Gain 
setting.  Every channel has 5 divisions above and below its initial baseline. 
 So, if the Amp Gain is set to 10 uV/Div this means that the Live trace has an 
amplitude window of 100 microvolts (10 vertical divisions times 10 uV/Div) 
with 50 uV above the baseline and 50 uV below the baseline.  If the reject 
level is set to 100% (i.e., full scale), then the amplitude of the live data must 
be below +/- 50 uV to be included in the running average.  Should it exceed 
+/- 50 uV the trace will be rejected from the running average.  If the reject 
level is set to 50% (i.e., half of full scale), then the amplitude of the Live data 
can't exceed +/- 25 uV (2.5 divisions above or below the baseline) or it will be 
rejected from the running average.  The lower the reject level setting the more 
sensitive the program will be in rejecting large artifacts. 
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 You can check the Amp Gain setting by pressing the F1 (Avg / Live) 
function key to switch to the Live mode.  Press the function key again to 
return to the Avg mode and view the Display Gain setting. 

7.  Acquire Responses 

A.  Start Data Acquisition. 

Press the Run/Stop key to start stimulus delivery and data acquisition. 
 The average count (AvgCnt) should start to increment and the traces will 
begin to take shape. 

Adjust the vertical size of the all traces by turning Knob #4 (Gain).  To 
adjust the gain of an individual trace, change the corresponding gain 
setting in the amplifier section of the EP Controls window. 

Press the F3 (Smooth) function key during acquisition to remove high 
frequency noise from the active (white) traces. 

B.  Store the first trial. 

When the Shutoff count is reached, stimulation will stop automatically. 
 Press the Store key to store the active (white) traces.  A copy of the 
active traces will appear on the screen and are displayed in purple. 

 The Store key can be pressed before the Shutoff count is reached. 
 This will cause the currently active traces to be stored, the average count 
will be reset to zero, and stimulation will continue automatically on a new 
set of traces. 

C.  Clear the Average Count. 

Press the Clear key to reset the average count (AvgCnt) back to zero. 
 The active (white) traces will be reset to flat lines. 

D.  Acquire a second Trial 

Press the Run/Stop key to start stimulus delivery and data acquisition 
again.  Generally, two trials should always be acquired when performing 
evoked potentials to show replication of the traces. 

E.  Store second trial and Clear. 

After the Shutoff count is reached for the second trial, press the Store key 
to store the active (white) traces.  Press the Clear key to reset the 
average count to zero. 

F.  Change Side of Stimulation. 
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To acquire traces for the opposite side, change the Side setting in the EP 
Controls window.  If you are using the Split Screen feature the active 
(white) traces will automatically move to the opposite side of the Trace 
window. 

G.  Repeat steps A - E and collect data for the opposite side. 

 

Example VEP, single channel recording, Left & Right. 

8.  Trace Positioning (optional) 

If the position of the traces needs to be adjusted, follow one of these 
procedures. 

 Using the Mouse - simply click on the Trace you want to move 
with the left mouse button and drag the trace to its new location. 

 Using the Knobs - press the F6 (Position) function key on the 
PC's keyboard.  The program's knob and function keys will change 
to reflect the position mode controls.  Use Knob #1 (Sel Trace / 
Move) to select and move traces. 

When positioning is completed, press the F6 (Position) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Position mode. 

 Using the Trace Position Settings - right-click the mouse over the 
Trace window and select Trace Position Settings from the pop-up 
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menu.  Change the settings for Start Position, Trial Offset, and 
Channel Offset and click OK. 

9.  Place Auto Cursors 

To place Cursors on the important trace features, follow one of these 
procedures. 

 Using the Mouse - simply left-click on a trace to select it, the 
trace will be displayed in yellow.  Now, right-click the mouse and 
select Auto Place Cursors from the pop-up menu.  Cursors will be 
placed on the selected trace and the values (latency, amplitude, 
etc.) derived from the cursors will be displayed in the EP Cursor 
Table window. 

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select a trace, when selected the trace will be displayed in yellow. 
 Once the appropriate trace is selected, press the F2 (AutoPlace 
Cursors) function key and cursors will be placed on the selected 
trace.  The values (latency, amplitude, etc.) derived from the 
cursors will be displayed in the EP Cursor Table window. 

After cursors have been placed, press the F5 (Cursor) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Cursor mode. 

 For information on configuring the Auto Cursors, see the VEP Test 
Setup topic. 

To Adjust the positions of the Cursors, follow one of these procedures. 

 Using the Mouse - simply click on the Cursor you want to move 
with the left mouse button and drag the cursor along the trace to its 
new location.  

 Using the Mouse and F9 (Auto Cursors) function key - simply 
left-click on a trace to select it, the trace will be displayed in 
yellow.  Now, press the F9 key.  Cursors will be placed on the 
selected trace and the values (latency, amplitude, etc.) derived 
from the cursors will be displayed in the EP Cursor Table window. 

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select the trace with the cursors you need to adjust, when selected 
the trace will be displayed in yellow.  Once the appropriate trace is 
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selected, use Knob #1 (Sel Cursor / Move) to select and move the 
desired cursor. 

After cursor positions have been adjusted, press the F5 (Cursor) 
function key again or press the OK key on the Sierra Wave base unit 
to exit from Cursor mode. 

 

VEP cursor table example. 

 The program will calculate the left minus right difference values for each 
defined measurement after cursors have been placed on one left and one 
right side trace. 

 Depending on your preferences in System Setup, abnormal values can 
be flagged with a red background color, as bold text, as bold text with an 
asterisk, or as bold text & background color red. 

10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 
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To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Test 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

P300 Basic Steps 

This topic is a repeat of the basic P300 steps found in the Getting Started 
chapter. 

Select the P300  Test: 

 If a Study has already been selected, simply click on the P300 test 
protocol within the Study window or turn Knob #1 (Study Item / Site) to 
highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the P300 test protocol from the Study/Test menu. 

 

Once the P300 test has been selected.  Follow these steps for performing 
data acquisition: 

1.  Apply electrodes to the patient and connect to amplifier 

Determine the number of channels that will be recorded and the electrodes 
that will be required for each channel.  Apply the recording electrodes and 
ground electrode to the patient and connect to the Sierra Wave amplifier. 

 

2.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the selected P300 test. 

Typical P300 Settings 

Display Gain = 2.0 uV/Div 
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Hicut = 30-100 Hz 

Locut = 1 Hz 

Sweep Speed = 75 - 100 ms/Div 

A Common Reference (CREF) input is available on the 4 Channel Amplifier. 
 The status of the CREF input, Off or On for each channel, will depend on the 
montage chosen for the test.  If the amplifier channel should use its 
corresponding individual reference input (i.e., reference 1, 2, 3, or 4) the 
CREF setting should be set to OFF.  If the channel should not use its 
individual reference input, but should use the CREF input in its place, then the 
CREF setting should be set to ON. 

The Notch filter is typically not used during P300 recordings and should 
remain OFF. 

 

3 Ch. P300 Settings. 

3.  Check Impedances 

Press the Imped key on the Sierra Wave base unit.  The impedance window 
displays a picture of the front of the amplifier. 
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Impedance window.  Channel 4 is turned Off.  CREF is turned ON for Channels 1 & 2 & 3. 

The Active (black) and Reference (red) inputs are displayed for each 
channel as well as the CREF input (4 Channel Amplifier only).  The Ground 
input is not included in impedance measurements. 

If a Channel is turned Off, no impedance values will be calculated for either 
the active or reference inputs and the word "Off" is displayed over the inputs 
of that channel. 

When the CREF input is enabled (i.e., ON) for a channel, that channel's 
reference input will not show an impedance value and will have the word "Off" 
over the reference input.  An impedance value for the CREF input will be 
displayed. 

Impedances less than 5k Ohms (kilo-ohms) are displayed in green.  Values 
between 5.1 and 20 are displayed in yellow.  Values greater than 20 are 
displayed in red. 

To close the impedance window, press the Imped key again or click the OK 
button. 

 When performing evoked potential studies all impedances should be 
less than 5k Ohms. 

4.  Check Stimulator Settings 
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Clinical recordings of the P300 are generally performed using a binaural 
auditory tone stimulus, commonly referred to as the auditory odd-ball 
paradigm.  Typically, two easily discriminable tones of different pitches are 
presented in random order.  One of the two tones occurs more often than the 
other and is designated the Common tone.  The other tone is designated the 
Rare tone.  This outline will assume that an auditory stimulus will be used for 
both the Common and Rare stimuli. 

Apply the stimulator (headphones or inserts) to the patient, the red 
headphone/insert should be placed on the patient's right side, the blue 
headphone/insert should be placed on the left.  Connect the stimulator  to the 
back of the Sierra Wave base unit. 

 

P300 Stimulator Controls Toolbar 

Common Stim:  These settings are used to configure the Common 
stimulus. 

 Type - can be set to Audio, Visual, Electrical, or '.Wav' file.  Audio 
is the default setting. 

 Mode - can be set to Click, Pip 202, Pip 212, or Tone.  Tone is the 
default setting and it is a 10-30-10 tone burst.  It has a 10 
millisecond rise time, a 30 millisecond plateau, and a 10 millisecond 
fall time.  

 Int - sets the intensity of the common stimulus in nHL values.  65 
dB is the default setting. 

 Frequency - click here to select the frequency of the tone.  The 
default setting is 1000 Hz. 

 Side - can be set to Right, Left, or Bilateral.  The default setting is 
Bilateral. 

 Env. - when Tone, Pip202, or Pip212 are selected a stimulus 
envelope can be selected here.  Choices are None, Linear, 
Blackman, Hanning, and Gaussian. 

 R/P/F - when Tone, Pip202, or Pip212 are selected the rise, 
plateau, and fall values are shown here.  Click here to change 
these values. 
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Change the rise, plateau, and fall values for a Tone or Pip. 

Rare Stim:  These settings are used to configure the Rare stimulus. 

 Type - can be set to Audio, Visual, Electrical, or '.Wav' file.  Audio 
is the default setting. 

 Mode - can be set to Click, Pip 202, Pip 212, or Tone.  Tone is the 
default setting and it is a 10-30-10 tone burst.  It has a 10 
millisecond rise time, a 30 millisecond plateau, and a 10 millisecond 
fall time.  

 Int - sets the intensity of the common stimulus in nHL values.  65 
dB is the default setting. 

 Frequency - click here to select the frequency of the tone.  The 
default setting is 3000 Hz. 

 Side - can be set to Right, Left, or Bilateral.  The default setting is 
Bilateral. 

 Env. - when Tone, Pip202, or Pip212 are selected a stimulus 
envelope can be selected here.  Choices are None, Linear, 
Blackman, Hanning, and Gaussian. 

 R/P/F - when Tone, Pip202, or Pip212 are selected the rise, 
plateau, and fall values are shown here.  Click here to change 
these values. 

RepRate:  Click here to set the repetitive stimulus rate, in pulses per 
second (Hz).  The default setting is 0.97. 

Rare %:  Click here to set the percentage of Rare stimuli that will be 
delivered.  The default setting is 20 %. 
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 To avoid excessive auditory stimulation, ensure that the stimulus 
intensity never exceeds 75 dB above the hearing threshold. 

5.  Verify Averager Settings 

AvgCnt - The second number displayed here is the total number of stimuli 
(Common + Rare) that will be delivered.  When this number is reached 
stimulation will automatically be stopped.  The default is 200 (160 Common, 
40 Rare). 

Reject On / Off - When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the number of 
stimuli/sweeps that have been rejected for both the Common and Rare stimuli 
will be displayed on the screen. 

Level - This is the reject sensitivity level, it is shown as a percentage of full 
amplifier scale.  Choices are 30 to 100 % in increments of 5.  100% equals 
full scale, smaller numbers will make the reject more sensitive. 

 

P300 Default Averager Settings. 

 Reject is based on the Live un-averaged data and the Amp Gain 
setting.  Every channel has 5 divisions above and below its initial baseline. 
 So, if the Amp Gain is set to 10 uV/Div this means that the Live trace has an 
amplitude window of 100 microvolts (10 vertical divisions times 10 uV/Div) 
with 50 uV above the baseline and 50 uV below the baseline.  If the reject 
level is set to 100% (i.e., full scale), then the amplitude of the live data must 
be below +/- 50 uV to be included in the running average.  Should it exceed 
+/- 50 uV the trace will be rejected from the running average.  If the reject 
level is set to 50% (i.e., half of full scale), then the amplitude of the Live data 
can't exceed +/- 25 uV (2.5 divisions above or below the baseline) or it will be 
rejected from the running average.  The lower the reject level setting the more 
sensitive the program will be in rejecting large artifacts. 

 You can check the Amp Gain setting by pressing the F1 (Avg / Live) 
function key to switch to the Live mode.  Press the function key again to 
return to the Avg mode and view the Display Gain setting. 

6.  Acquire Responses 

A.  Start Data Acquisition. 
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It is important that the patient attend to the stimuli.  This is facilitated by 
having the patient keep a mental record of the number of Rare tones (i.e., 
higher pitched tones) that are presented during the test.  Drowsiness 
should be avoided, as well as distracting noises. 

Press the Run/Stop key to start stimulus delivery and data acquisition. 
 The average count (AvgCnt) should start to increment and the traces will 
begin to take shape. 

The P300 program has dual averager banks.  The Common stimuli are 
averaged in the first averager bank and the corresponding traces are 
displayed in the left half of the trace window.  The Rare stimuli are 
averaged in the second averager bank and the corresponding traces are 
displayed in the right half of the trace window. 

Adjust the vertical size of the all traces by turning Knob #4 (Gain).  To 
adjust the gain of an individual trace, change the corresponding gain 
setting in the amplifier section of the EP Controls window. 

Press the F3 (Smooth) function key during acquisition to remove high 
frequency noise from the active (white) traces. 

B.  Store the first trial. 

When the Shutoff count is reached, stimulation will stop automatically. 
 Press the Store key to store the active (white) traces.  A copy of the 
active traces will appear on the screen and are displayed in a purple color. 

 The Store key can be pressed before the Shutoff count is reached. 
 This will cause the currently active traces to be stored, the average count 
will be reset to zero, and stimulation will continue automatically on a new 
set of traces. 

Ask the patient how many Rare stimuli they counted.  Compare this with 
the number shown in the AvgCnt column. 

C.  Clear the Average Count. 

Press the Clear key to reset the average count (AvgCnt) back to zero. 
 The active (white) traces will be reset to flat lines. 

D.  Acquire a second Trial 

Press the Run/Stop key to start stimulus delivery and data acquisition 
again.  Generally, two trials should always be acquired when performing 
evoked potentials to show replication of the traces.  Again, ask the patient 
to count the Rare stimuli. 

E.  Store second trial and Clear. 
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After the Shutoff count is reached for the second trial, press the Store key 
to store the active (white) traces.  Press the Clear key to reset the 
average count to zero. 

F.  Perform a Grand Average (Optional) 

Press the F7 (Grand Avg) function key.  Performing a Grand Average can 
enhance the principle peaks.  A 'blue' trace, representing the grand 
average of all traces acquired from that channel, will be shown for each 
channel in the montage. 

 

 

Example 3 Channel P300.  Cursors have been placed on the Grand Average trace for the 
Cz-A1A2 channel. 

7.  Trace Positioning (optional) 

If the position of the traces needs to be adjusted, follow one of these 
procedures. 

 Using the Mouse - simply click on the Trace you want to move 
with the left mouse button and drag the trace to its new location. 
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 Using the Knobs - press the F6 (Position) function key on the 
PC's keyboard.  The program's knob and function keys will change 
to reflect the position mode controls.  Use Knob #1 (Sel Trace / 
Move) to select and move traces. 

When positioning is completed, press the F6 (Position) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Position mode. 

 Using the Trace Position Settings - right-click the mouse over the 
Trace window and select Trace Position Settings from the pop-up 
menu.  Change the settings for Start Position, Trial Offset, and 
Channel Offset and click OK. 

8.  Place Auto Cursors 

To place Cursors on the important trace features, follow one of these 
procedures. 

 Using the Mouse - simply left-click on a trace to select it, the 
trace will be displayed in yellow.  Now, right-click the mouse and 
select Auto Place Cursors from the pop-up menu.  Cursors will be 
placed on the selected trace and the values (latency, amplitude, 
etc.) derived from the cursors will be displayed in the EP Cursor 
Table window. 

 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select a trace, when selected the trace will be displayed in yellow. 
 Once the appropriate trace is selected, press the F2 (AutoPlace 
Cursors) function key and cursors will be placed on the selected 
trace.  The values (latency, amplitude, etc.) derived from the 
cursors will be displayed in the EP Cursor Table window. 

After cursors have been placed, press the F5 (Cursor) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Cursor mode. 

 For information on configuring the Auto Cursors, see the P300 Test 
Setup topic. 

To Adjust the positions of the Cursors, follow one of these procedures. 

 Using the Mouse - simply click on the Cursor you want to move 
with the left mouse button and drag the cursor along the trace to its 
new location.  
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 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to 
reflect the cursor mode controls.  Use Knob #3 (Sel Trace) to 
select the trace with the cursors you need to adjust, when selected 
the trace will be displayed in yellow.  Once the appropriate trace is 
selected, use Knob #1 (Sel Cursor / Move) to select and move the 
desired cursor. 

After cursor positions have been adjusted, press the F5 (Cursor) 
function key again or press the OK key on the Sierra Wave base unit 
to exit from Cursor mode. 

 

P300 cursor table example. 

 Depending on your preferences in System Setup, abnormal values can 
be flagged with a red background color, as bold text, as bold text with an 
asterisk, or as bold text & background color red. 

9.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 
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To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

10.  Next Test 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

SEP Knobs and Fkeys 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in normal Acquisition mode or has 
been switched to either Cursor or Position mode. 

 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 
 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 

 

Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Intensity / Pulse Width - this knob defaults to the Intensity mode and 
can be used to increase or decrease the stimulus intensity, the current 
intensity value (in milliamps) is displayed on the knob icon.  Press this 
knob to switch to the Pulse Width mode and  turn to change the value of 
the electrical stimulus pulse width, the current pulse width value (in 
microseconds) will be displayed on the knob icon. 
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Gain - this knob can be used to increase or decrease the gain (uV/Div) of 
the Trace window. 

F Keys 

 

Avg / Live - defaults to Avg mode, in this mode the Trace window 
displays the results of the current running average.  Press to activate Live 
mode, in Live mode the Trace window displays the un-averaged incoming 
data.  Live mode is useful when troubleshooting artifact problems. 

Stim Avg / Stim On - defaults to Stim Avg mode, in this mode the 
averager is synchronized with stimulus delivery and the Run/Stop key is 
used to start and stop both simultaneously.  Press to activate Stim On 
mode, in this mode the stimulator is automatically turned ON and the 
averager can be turned On or Off independently of the stimulator using the 
Run/Stop key. 

Smooth - each time this key is pressed the selected (yellow) traces will be 
passed through a digital smoothing algorithm.  If no traces are selected, 
then the active (white) traces will be smoothed.  Smoothing can be 
reversed by right-clicking the mouse on the Trace window and selecting 
Unsmooth All from the pop-up menu.   

TabData - opens the TabData Summary window. 

 

Cursor mode 

Knobs 

 

Select Cur / Move Cur - this knob defaults to the Select Cursor mode 
and can be used to move the focus (yellow triangle) to any cursor on the 
selected trial.  Press this knob to switch to Move Cursor mode which will 
allow you to move the selected (green triangle) cursor. 

Select Cur / On-Off - this knob defaults to the Select Cursor mode and 
can be used to move the focus (yellow triangle) to any cursor on the 
selected trial.  Press the knob to hide the selected cursor (turn the cursor 
Off) or bring it back to view (turn the cursor On). 

Sel. Trial - turn this knob to select an SEP trial.  When selected, the trial 
will be displayed in yellow. 
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Gain - turn this knob to change the gain of the selected SEP trial.  The 
current gain setting for the trial is displayed on the knob icon. 

F Keys 

 

AutoPlace Cursors - press this function key to re-apply the auto-cursor 
algorithm to the selected (yellow) trial. 

Clear Cursors - press this function key to clear all cursors from the 
selected (yellow) trial. 

All On / All Off - defaults to All On mode.  Press to hide all cursors on all 
trials. 

 

Position mode 

Knobs 

 

Sel. Trial / Move - defaults to Select Trial mode, turn this knob to select a 
stored SEP trial.  When selected, the trial will be displayed in yellow color. 
 Press the knob to switch to Move mode, then turn to move the selected 
trial up or down within the Trace window. 

Move Active - turn this knob to move the active (white colored) trial up or 
down within the Trace window. 

Sel. Trial / Delete - turn this knob to select a stored SEP trial.  When 
selected, the trial will be displayed in yellow color.  Press the knob to 
permanently delete the selected trial. 

Gain - turn this knob to change the Gain of the selected SEP trial.  The 
current gain setting for the trial is displayed on the knob icon. 

F Keys 

 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
from each channel are separated according to the Trace Position Settings. 
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 Pressing this key switches to Overlay mode which will superimpose all 
traces from each channel on top of one another. 

Smooth All - each time this key is pressed all the traces within the Trace 
window will be passed through a digital smoothing algorithm.  Smoothing 
can be reversed by right-clicking the mouse on the Trace window and 
selecting Unsmooth All from the pop-up menu. 

Smooth - each time this key is pressed the selected (yellow) traces will be 
passed through a digital smoothing algorithm.  If no traces are selected, 
then the active (white) traces will be smoothed.  Smoothing can be 
reversed by right-clicking the mouse on the Trace window and selecting 
Unsmooth All from the pop-up menu.   

Trace / Trial - defaults to Trial mode, in Trial mode the select knobs 
(Knobs #1 and #3) will function to select a complete trial.  Press to activate 
Trace mode, in Trace mode the select knobs will function to select 
individual traces rather than complete trials. 

AEP Knobs and Fkeys 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in normal Acquisition mode or has 
been switched to either Cursor or Position mode. 

 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 
 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 

 

Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

L. Thresh / Off - used to determine and set the behavioral threshold for 
the Left ear.  Turning the knob begins stimulus deliver in the left ear. 
 Continue to turn to increase the intensity of the stimulus.  Once the 
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behavioral threshold for the patient is determined, press the knob to turn 
off stimulus delivery and set the threshold value. 

R. Thresh / Off - used to determine and set the behavioral threshold for 
the Right ear.  Turning the knob begins stimulus deliver in the left ear. 
 Continue to turn to increase the intensity of the stimulus.  Once the 
behavioral threshold for the patient is determined, press the knob to turn 
off stimulus delivery and set the threshold value. 

Gain - this knob can be used to increase or decrease the gain (uV/Div) of 
the Trace window. 

F Keys 

 

Avg / Live - defaults to Avg mode, in this mode the Trace window 
displays the results of the current running average.  Press to activate Live 
mode, in Live mode the Trace window displays the un-averaged incoming 
data.  Live mode is useful when troubleshooting artifact problems. 

Stim Avg / Stim On - defaults to Stim Avg mode, in this mode the 
averager is synchronized with stimulus delivery and the Run/Stop key is 
used to start and stop both simultaneously.  Press to activate Stim On 
mode, in this mode the stimulator is automatically turned ON and the 
averager can be turned On or Off independently of the stimulator using the 
Run/Stop key. 

Smooth - each time this key is pressed the selected (yellow) traces will be 
passed through a digital smoothing algorithm.  If no traces are selected, 
then the active (white) traces will be smoothed.  Smoothing can be 
reversed by right-clicking the mouse on the Trace window and selecting 
Unsmooth All from the pop-up menu.   

TabData - opens the TabData Summary window. 

 

Cursor mode 

Knobs 

 

Select Cur / Move Cur - this knob defaults to the Select Cursor mode 
and can be used to move the focus (yellow triangle) to any cursor on the 
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selected trace.  Press this knob to switch to Move Cursor mode which will 
allow you to move the selected (green triangle) cursor. 

Select Cur / On-Off - this knob defaults to the Select Cursor mode and 
can be used to move the focus (yellow triangle) to any cursor on the 
selected trace.  Press the knob to hide the selected cursor (turn the cursor 
Off) or bring it back to view (turn the cursor On). 

Sel. Trace - turn this knob to select an AEP trace.  When selected, the 
trace will be displayed in yellow. 

Gain - turn this knob to change the gain of the selected AEP trace.  The 
current gain setting for the trace is displayed on the knob icon. 

F Keys 

 

AutoPlace Cursors - press this function key to re-apply the auto-cursor 
algorithm to the selected (yellow) trace. 

Clear Cursors - press this function key to clear all cursors from the 
selected (yellow) trace. 

All On / All Off - defaults to All On mode.  Press to hide all cursors on all 
traces. 

 

Position mode 

Knobs 

 

Sel. Trace / Move - defaults to Select Trace mode, turn this knob to 
select a stored AEP trace.  When selected, the trace will be displayed in 
yellow color.  Press the knob to switch to Move mode, then turn to move 
the selected trace up or down within the Trace window. 

Move Active - turn this knob to move both of the active (white colored) 
traces up or down within the Trace window. 

Sel. Trace / Delete - turn this knob to select a stored AEP trace.  When 
selected, the trace will be displayed in yellow color.  Press the knob to 
permanently delete the selected trace. 
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Gain - turn this knob to change the Gain of the selected AEP trace.  The 
current gain setting for the trace is displayed on the knob icon. 

F Keys 

 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
from each channel are separated according to the Trace Position Settings. 
 Pressing this key switches to Overlay mode which will superimpose all 
traces from each channel on top of one another. 

Smooth All - each time this key is pressed all the traces within the Trace 
window will be passed through a digital smoothing algorithm.  Smoothing 
can be reversed by right-clicking the mouse on the Trace window and 
selecting Unsmooth All from the pop-up menu. 

Smooth - each time this key is pressed the selected (yellow) traces will be 
passed through a digital smoothing algorithm.  If no traces are selected, 
then the active (white) traces will be smoothed.  Smoothing can be 
reversed by right-clicking the mouse on the Trace window and selecting 
Unsmooth All from the pop-up menu.   

Trace / Trial - defaults to Trace mode, in Trace mode the select knobs 
(Knobs #1 and #3) will function to select individual traces.  Press the knob 
to activate Trial mode, in Trial mode the select knobs will function to 
select a complete trial. 

 

VEP Knob and Fkey Controls 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in normal Acquisition mode or has 
been switched to either Cursor or Position mode. 

 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 
 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 
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Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Gain - this knob can be used to increase or decrease the gain (uV/Div) of 
the Trace window. 

F Keys 

 

Avg / Live - defaults to Avg mode, in this mode the Trace window 
displays the results of the current running average.  Press to activate Live 
mode, in Live mode the Trace window displays the un-averaged incoming 
data.  Live mode is useful when troubleshooting artifact problems. 

Stim Avg / Stim On - defaults to Stim Avg mode, in this mode the 
averager is synchronized with stimulus delivery and the Run/Stop key is 
used to start and stop both simultaneously.  Press to activate Stim On 
mode, in this mode the stimulator is automatically turned ON and the 
averager can be turned On or Off independently of the stimulator using the 
Run/Stop key. 

Smooth - each time this key is pressed the selected (yellow) traces will be 
passed through a digital smoothing algorithm.  If no traces are selected, 
then the active (white) traces will be smoothed.  Smoothing can be 
reversed by right-clicking the mouse on the Trace window and selecting 
Unsmooth All from the pop-up menu.   

TabData - opens the TabData Summary window. 

 

Cursor mode 

Knobs 
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Select Cur / Move Cur - this knob defaults to the Select Cursor mode 
and can be used to move the focus (yellow triangle) to any cursor on the 
selected trace.  Press this knob to switch to Move Cursor mode which will 
allow you to move the selected (green triangle) cursor. 

Select Cur / On-Off - this knob defaults to the Select Cursor mode and 
can be used to move the focus (yellow triangle) to any cursor on the 
selected trace.  Press the knob to hide the selected cursor (turn the cursor 
Off) or bring it back to view (turn the cursor On). 

Sel. Trace - turn this knob to select an VEP trace.  When selected, the 
trace will be displayed in yellow. 

Gain - turn this knob to change the gain of the selected VEP trace.  The 
current gain setting for the trace is displayed on the knob icon. 

F Keys 

 

AutoPlace Cursors - press this function key to re-apply the auto-cursor 
algorithm to the selected (yellow) trace. 

Clear Cursors - press this function key to clear all cursors from the 
selected (yellow) trace. 

All On / All Off - defaults to All On mode.  Press to hide all cursors on all 
traces. 

 

Position mode 

Knobs 

 

Sel. Trace / Move - defaults to Select Trace mode, turn this knob to 
select a stored VEP trace.  When selected, the trace will be displayed in 
yellow color.  Press the knob to switch to Move mode, then turn to move 
the selected trace up or down within the Trace window. 

Move Active - turn this knob to move both of the active (white colored) 
traces up or down within the Trace window. 
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Sel. Trace / Delete - turn this knob to select a stored VEP trace.  When 
selected, the trace will be displayed in yellow color.  Press the knob to 
permanently delete the selected trace. 

Gain - turn this knob to change the Gain of the selected VEP trace.  The 
current gain setting for the trace is displayed on the knob icon. 

F Keys 

 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
from each channel are separated according to the Trace Position Settings. 
 Pressing this key switches to Overlay mode which will superimpose all 
traces from each channel on top of one another. 

Smooth All - each time this key is pressed all the traces within the Trace 
window will be passed through a digital smoothing algorithm.  Smoothing 
can be reversed by right-clicking the mouse on the Trace window and 
selecting Unsmooth All from the pop-up menu. 

Smooth - each time this key is pressed the selected (yellow) traces will be 
passed through a digital smoothing algorithm.  If no traces are selected, 
then the active (white) traces will be smoothed.  Smoothing can be 
reversed by right-clicking the mouse on the Trace window and selecting 
Unsmooth All from the pop-up menu.   

Trace / Trial - defaults to Trace mode, in Trace mode the select knobs 
(Knobs #1 and #3) will function to select individual traces.  Press the knob 
to activate Trial mode, in Trial mode the select knobs will function to 
select a complete trial. 

 

P300 Knobs and Fkeys 

The functions assigned to the Sierra Wave base unit's Knob and F Key controls 
will vary depending on whether the system is in normal Acquisition mode or has 
been switched to either Cursor or Position mode. 

 Cursor mode is entered by pressing the F5 key on the PC's keyboard. 
 Position mode is entered by pressing F6 on the PC's keyboard. 

 Several Knobs and F Keys have dual functions.  The currently selected 
function is displayed in Bold text. 
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Acquisition mode  

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Gain - this knob can be used to increase or decrease the gain (uV/Div) of 
the Trace window. 

F Keys 

 

Avg / Live - defaults to Avg mode, in this mode the Trace window 
displays the results of the current running average.  Press to activate Live 
mode, in Live mode the Trace window displays the un-averaged incoming 
data.  Live mode is useful when troubleshooting artifact problems. 

Smooth - each time this key is pressed the selected (yellow) traces will be 
passed through a digital smoothing algorithm.  If no traces are selected, 
then the active (white) traces will be smoothed.  Smoothing can be 
reversed by right-clicking the mouse on the Trace window and selecting 
Unsmooth All from the pop-up menu.   

TabData - opens the TabData Summary window. 

 

Cursor mode 

Knobs 

 

Select Cur / Move Cur - this knob defaults to the Select Cursor mode 
and can be used to move the focus (yellow triangle) to any cursor on the 
selected trace.  Press this knob to switch to Move Cursor mode which will 
allow you to move the selected (green triangle) cursor. 

Select Cur / On-Off - this knob defaults to the Select Cursor mode and 
can be used to move the focus (yellow triangle) to any cursor on the 
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selected trace.  Press the knob to hide the selected cursor (turn the cursor 
Off) or bring it back to view (turn the cursor On). 

Sel. Trace - turn this knob to select an P300 trace.  When selected, the 
trace will be displayed in yellow. 

Gain - turn this knob to change the gain of the selected P300 trace.  The 
current gain setting for the trace is displayed on the knob icon. 

F Keys 

 

AutoPlace Cursors - press this function key to re-apply the auto-cursor 
algorithm to the selected (yellow) trace. 

Clear Cursors - press this function key to clear all cursors from the 
selected (yellow) trace. 

All On / All Off - defaults to All On mode.  Press to hide all cursors on all 
traces. 

 

Position mode 

Knobs 

 

Sel. Trace / Move - defaults to Select Trace mode, turn this knob to 
select a stored P300 trace.  When selected, the trace will be displayed in 
yellow color.  Press the knob to switch to Move mode, then turn to move 
the selected trace up or down within the Trace window. 

Move Active - turn this knob to move both of the active (white colored) 
traces up or down within the Trace window. 

Sel. Trace / Delete - turn this knob to select a stored P300 trace.  When 
selected, the trace will be displayed in yellow color.  Press the knob to 
permanently delete the selected trace. 

Gain - turn this knob to change the Gain of the selected P300 trace.  The 
current gain setting for the trace is displayed on the knob icon. 

F Keys 
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Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
from each channel are separated according to the Trace Position Settings. 
 Pressing this key switches to Overlay mode which will superimpose all 
traces from each channel on top of one another. 

Smooth All - each time this key is pressed all the traces within the Trace 
window will be passed through a digital smoothing algorithm.  Smoothing 
can be reversed by right-clicking the mouse on the Trace window and 
selecting Unsmooth All from the pop-up menu. 

Smooth - each time this key is pressed the selected (yellow) traces will be 
passed through a digital smoothing algorithm.  If no traces are selected, 
then the active (white) traces will be smoothed.  Smoothing can be 
reversed by right-clicking the mouse on the Trace window and selecting 
Unsmooth All from the pop-up menu.   

Trace / Trial - defaults to Trace mode, in Trace mode the select knobs 
(Knobs #1 and #3) will function to select individual traces.  Press the knob 
to activate Trial mode, in Trial mode the select knobs will function to 
select a complete trial. 

EP Test Setup 

Evoked Potential test setup options are discussed in detail in the Test Protocol 
Setup chapter of the Help system. 

Using Auto Cursors 

To place Cursors on the important trace features, follow one of these 
procedures. 

 Using the Mouse - simply left-click on a trial / trace to select it, the 
trial will be displayed in yellow.  Now, right-click the mouse and select 
Auto Place Cursors from the pop-up menu.  Cursors will be placed 
on the selected trial and the values (latency, amplitude, etc.) derived 
from the cursors will be displayed in the EP Cursor Table window. 

 Using the Mouse and F9 (Auto Cursors) function key - simply left-
click on a trace/trial to select it, the trace/trial will be displayed in 
yellow.  Now, press the F9 key.  Cursors will be placed on the selected 
trace/trial and the values (latency, amplitude, etc.) derived from the 
cursors will be displayed in the EP Cursor Table window. 
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 Using the Knobs - press the F5 (Cursor) function key of the PC's 
keyboard.  The program's knob and function keys will change to reflect 
the cursor mode controls.  Use Knob #3 (Sel Trial / Trace) to select a 
trial, when selected the trial will be displayed in yellow.  Once the 
appropriate trial is selected, press the F2 (AutoPlace Cursors) 
function key and cursors will be placed on the selected trial.  The 
values (latency, amplitude, etc.) derived from the cursors will be 
displayed in the EP Cursor Table window. 

After cursors have been placed, press the F5 (Cursor) function key 
again or press the OK key on the Sierra Wave base unit to exit from 
Cursor mode. 

 In SEP test protocols you select Trials for cursor placement.  In AEP, 
VEP, and P300 test protocols you select individual Traces for cursor 
placement. 

 For information on configuring the default parameters for the Auto 
Cursors, see the individual test setup topics.  SEP Test Setup, AEP Test 
Setup, VEP Test Setup. P300 Test Setup. 

 

To adjust the positions of the Cursors, follow one of these procedures. 

 Using the Mouse - simply click on the Cursor you want to move with 
the left mouse button and drag the cursor along the trace to its new 
location.  

 Using the Knobs - press the F5 (Cursor) function key on the PC's 
keyboard.  The program's knob and function keys will change to reflect 
the cursor mode controls.  Use Knob #3 (Sel Trial / Trace) to select 
the trial with the cursors you need to adjust, when selected the trial will 
be displayed in yellow.  Once the appropriate trial is selected, use 
Knob #1 (Sel Cursor / Move) to select and move the desired cursor. 

After cursor positions have been adjusted, press the F5 (Cursor) 
function key again or press the OK key on the Sierra Wave base unit 
to exit from Cursor mode. 

 

Cursor Display Format 

There are three options for how the cursors will appear on the traces.  The 
options are Show Labels, Labels & Values, and Show Values.   This 
setting can be changed at any time by right-clicking over the Trace 
window and selecting Cursor Display from the pop-up window.  The 
factory default selection is Show Labels.  
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 Show Labels - shows the label names as entered in the auto-cursor 
table. 

 

 Labels and Values - shows the label names mentioned above as 
well as the latency value for the cursor and the amplitude value 
between two cursors in brackets. 

 

 Show Values - shows the latency value for the cursor and the 
amplitude values between two cursors in brackets. 
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Example EP Cursor Tables 

 

Example Median SEP Cursor Table. 

 

 

AEP cursor table example. 
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VEP cursor table example. 

 The program will calculate the left minus right difference values for each 
defined measurement after cursors have been placed on one left and one 
right side trial. 

 Depending on your preferences in System Setup, abnormal values can 
be flagged with a red background color, as bold text, as bold text with an 
asterisk, or as bold text & background color red. 

Table Font Size 

In all test protocols the font size of the Table window can be increased or 
decreased.  Simply right click on the table and select Font Size from the pop-up 
menu.  The choices are Small (default), Medium, Large, and Extra Large. 

 

Changing the font size of the Muscle Scoring Table. 
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Changing the font size of the NCV Tables. 

 

To save your selection as part of the test protocol's default settings, select Save 
Test Parameters from the Edit menu. 

 The selected font size is also applied to that table in the TabData window. 

Reject 

In all evoked potential test protocols a rejection feature can be used to keep large 
amplitude artifacts from being included in the running average.  The controls for 
the reject feature are found in the EP Controls window. 

Reject On / Off - When this feature is turned On the program will monitor the 
Live un-averaged data and will not include (i.e., will reject)  high amplitude 
artifacts from the running average.  During data acquisition the percentage 
(%) of stimuli/sweeps that have been rejected from the total delivered will be 
displayed on the screen. 

Level - This is the reject sensitivity level, it is shown as a percentage of full 
amplifier scale.  Choices are 30 to 100 % in increments of 5.  100% equals 
full scale, smaller numbers will make the reject more sensitive. 
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Example SEP Averager settings. 

 

How is Reject Determined? 

Reject is based on the Live un-averaged data and the Amp Gain setting. 
 Every channel has 5 divisions above and below its initial baseline.  So, if the 
Amp Gain is set to 10 uV/Div this means that the Live trace has an amplitude 
window of 100 microvolts (10 vertical divisions times 10 uV/Div) with 50 uV 
above the baseline and 50 uV below the baseline. 

If the reject level is set to 100% (i.e., full scale), then the amplitude of the live 
data must be below +/- 50 uV to be included in the running average.  Should it 
exceed +/- 50 uV the trace will be rejected from the running average. 

If the reject level is set to 50% (i.e., half of full scale), then the amplitude of 
the Live data can't exceed +/- 25 uV (2.5 divisions above or below the 
baseline) or it will be rejected from the running average.  The lower the reject 
level setting the more sensitive the program will be in rejecting large artifacts. 

What is my Amplifier Gain? 

You can check the Amp Gain setting by pressing the F1 (Avg / Live) function 
key to switch to the Live mode.  Press the function key again to return to the 
Avg mode and view the Display Gain setting. 

Using Time & Amplitude Markers 

To quickly measure the latency or amplitude of a response, use the Time & 
Amplitude Markers. 

Using the Time Markers 

 Right click over the EP Trace window and select Add Time Marker from 
the pop-up menu.  One vertical time marker will be displayed. 

 Move the marker by clicking on it with the mouse and dragging it across 
the window. 

 Repeat this process until the desired number of time markers are 
displayed. 

 The latency, in milliseconds (from the left edge of the Trace window), is 
displayed for each Time Marker in the upper left hand corner of the Trace 
window.  The difference between the two time markers is also indicated. 
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 To remove the Time Markers from the window, drag each time marker off 
the left-hand edge of the trace window. 

 

SEP Trace window with Time Markers on the N13 and N20 peaks. 

 

Using the Amplitude Markers 

 Right click over the EP Trace window and select Amplitude Markers 
from the pop-up menu.  Two horizontal amplitude markers will be 
displayed. 

 Move the markers by clicking on them with the mouse and dragging 
them up or down in the window. 

 The amplitude, in microvolts, between the two amplitude markers is 
shown in the upper left hand corner. 

 To remove the Amplitude Markers from the window, right click over the 
EP Trace window and de-select Amplitude Markers from the pop-up 
menu. 
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SEP Trace window with Amplitude Markers measuring the N20-P22 response. 

 

View Avg - View Live 

In evoked potential test protocols you can toggle the Trace window between 
displaying the running average traces or the live un-averaged traces using the F1 
(Avg / Live) function key. 

F1 (Avg / Live) - defaults to Avg mode, in this mode the Trace window 
displays the results of the current running average.  Press to activate Live 
mode, in Live mode the Trace window displays the un-averaged incoming 
data.  Live mode is useful when troubleshooting artifact problems. 

In Avg mode, the traces are displayed using the Display Gain setting.  In 
Live mode, the traces are displayed using the Amplifier Gain setting. 

Trace Positioning 

Trace Positioning 

There are several methods of changing the vertical positions of the evoked 
potential traces within the Trace window. 
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Using the Mouse: 

Left click on the SEP trial or AEP/VEP/P300 trace you want to move 
and drag the trial or trace to it's new location. 

 In the SEP protocol, to select and move an individual trace, rather 
than the entire trial, first right click the mouse and disable the "Trial 
Selection Mode" setting in the pop-up menu by clicking on it to remove 
the checkmark. 

Using the Knobs: 

1. Enter the Position mode by pressing the F6 function key on the 
PC's keyboard. 

2. Turn Knob #1 (Sel Trial or Trace / Move) until the trial or trace you 
want to move is selected.  A selected trial/trace is displayed in 
yellow rather than purple. 

3. Press the knob to activate the Move mode, now turn the knob to 
move the selected trial/trace up or down. 

4. Press the knob a second time to return to the Sel Trial or Trace 
mode. 

 In the SEP protocol, to select and move an individual trace, rather 
than the entire trial, first press the F4 (Trace / Trial) function key to 
toggle the function to Trace mode. 

Using the Trace Position Settings: 

1. Right click over the EP Trace window. 

2. From the pop-up menu, select Trace Position Settings.  The 
Trace Position Settings window will be displayed. 

 

Trace Position Settings window. 
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3. Change the listed parameters, then click OK. 

Start Position: This is the default trace position for the first trace in 
the window.  It is the number of vertical divisions below the top of 
the trace window.  In this example, the first trace will be positioned 
4 divisions below the top of the window. 

Trial Offset:  This setting determines how much space will 
separate each stored evoked potential trace acquired from each 
channel.  In this example the setting is 2.5 divisions, therefore the 
second evoked potential trace will be displayed 2.5 divisions below 
the first trace.  If a third evoked potential trace is acquired it will be 
displayed 2.5 divisions below the second evoked potential trace 
and so on. 

Channel Offset:  This setting only applies when more than one 
channel is turned ON.  It is the amount of space, in vertical 
divisions, that separates the two active channels. 

Trace Smoothing 

High frequency noise can be removed from the evoked potential traces by 
applying a digital smoothing filter. 

To Smooth All Traces: 

 Using the Mouse - right click over the EP Trace window and select 
Smooth All from the pop-up menu. 

 Using the Knobs - enter Position mode by pressing the F6 function key 
on the PC's keyboard.  Now press the F2 (Smooth All) function key. 

 

To Smooth a Selected Trace: 

 Using the Mouse - select the trial or trace you want to smooth by left 
clicking the mouse over it.  When selected, the trial/trace will be 
displayed in yellow.  Now, right click the mouse and select Smooth from 
the pop-up menu. 

 In the SEP protocol, to select an individual trace, rather than the entire 
trial, first right click the mouse and disable the "Trial Selection Mode" setting 
in the pop-up menu by clicking on it to remove the checkmark. 

 Using the Knobs - enter Position mode by pressing the F6 function key 
on the PC's keyboard.  Turn Knob #1 (Sel Trial or Trace) until the 
desired trial/trace is selected, when selected the trial/trace will be 
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displayed in yellow.  Now press the F3 (Smooth) function key to smooth 
the selected trial/trace. 

 In the SEP protocol, to select an individual trace, rather than the entire 
trial, first press the F4 (Trace / Trial) function key to toggle the function to 
Trace mode. 

 

To Remove Smoothing: 

Right click the mouse over the EP Trace window.  Select Unsmooth All 
from the pop-up menu. 

Deleting Traces 

To delete evoked potential traces use one of the following methods. 

 Using the Mouse - select the trial or trace you want to delete by 
clicking on it with the left mouse button.  When selected, the trial/trace 
color will change from purple to yellow.  Now you can either press the 
Clear key on the Sierra Wave base unit or you can right click the mouse 
and select Delete Selected Traces from the pop-up menu.  A 
confirmation message will be displayed, click OK and the selected 
trial/trace will be deleted. 

 In the SEP protocol, to select an individual trace, rather than the entire 
trial, first right click the mouse and disable the "Trial Selection Mode" setting 
in the pop-up menu by clicking on it to remove the checkmark. 

 Using the Knobs - enter the Position mode by pressing the F6 function 
key.  Now turn Knob #3 (Sel Trial or Trace / Delete) until the trial/trace 
you want to delete is selected, a selected trial/trace is displayed in yellow. 
 Press the knob to delete the selected trial/trace.  Exit Position mode by 
pressing the F6 function key a second time or by pressing the OK key on 
the Sierra Wave base unit. 

 In the SEP protocol, to select and delete an individual trace, rather than 
the entire trial, first press the F4 (Trace / Trial) function key to toggle the 
function to Trace mode. 

Change Gain of a Stored Trace 

To change the gain of a stored EP trial or trace, perform the following. 

1. Select the Trial or Trace you want to change. 
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 Using the Mouse - simply left click the mouse over the trial or trace, 
when selected the trial/trace will be displayed in yellow rather than 
purple. 

 In the SEP protocol, to select an individual trace, rather than the 
entire trial, first right click the mouse and disable the "Trial Selection 
Mode" setting in the pop-up menu by clicking on it to remove the 
checkmark. 

 Using the Knobs - enter Position mode by pressing the F6 function 
key on the PC's keyboard.  Turn Knob #1 (Sel Trial or Trace / Move) 
until the desired trial/trace is selected. 

 In the SEP protocol, to select an individual trace, rather than the 
entire trial, first press the F4 (Trace / Trial) function key to toggle the 
function to Trace mode. 

2. Now, turn Knob #4 (Gain), the selected trial/trace will be changed and it's 
current gain value will be displayed on the knob's icon. 

Trace Labels 

The labels that appear at the right end of each trace are programmed in the 
evoked potential's Test Setup window. 

To open the Test Setup window: 

 Select Test Setup from the File menu.  Now click on the individual test 
protocol name in the Test Lists column.  The default trace label settings 
are displayed in the Trace Labels section. 

Trace Labels 

This section is used to configure how the trace labels are displayed and allows 
you to choose the type of  information that is included in the trace labels.  The 
trace label can consist of up to five parameters.  The parameters can be 
separated by a colon ( ), a hyphen ( ), or a line return ( ). 

 

Example SEP test protocol trace label setup. 
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Display Mode:  Click here to specify how the trace labels will be displayed 
during data acquisition.  The choices are; 

 All Trials - trace labels are shown on all traces. 

 No Trials - trace labels are not shown on any traces. 

 First Trial - only the first trace/trial acquired on each side has a trace 
label. 

 Active Trial - only the active (white traces) have trace labels. 

Trace Label Selections: (up to 5 can be selected) 

 Trial - shows the trial number or the display mode of active traces (Avg or 
Live). 

 Channel - shows the amplifier channel number. 

 Side - shows the side being tested. 

 Gain - shows the display gain setting. 

 Sweep - shows the sweep speed setting. 

 Intensity - shows the stimulus intensity setting. 

 Rep Rate - shows the stimulus repetition rate. 

 Time - shows the time of day. 

 Custom Ch - allows you to include notations that only appear for a 
specific channel or side (i.e., C4'-Fz or A1-Cz montage designations). 

Left / Right Custom Labels: 

When Custom Ch is selected for one of the five parameters the Left/Right 
Channel area becomes activated.  This allows you to enter a text label of your 
choice for each channel on a left/right basis.  This is most commonly used to 
display the amplifier montage on the channel's trace label. 

Separators: 

The parameters can be separated by a colon ( ), a hyphen ( ), or a line 
return ( ).  Simply click the mouse on the separator and select the type that 
you want from the pop-up list.  The line return can be used to put parameters 
that follow it on a second line. 

 

To change the Trace Labels after data acquisition: 

 Select Edit Current Test from the Edit menu.  Make the necessary 
changes to the Trace Label setup and click OK. 
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EP Analysis 

The Sierra Wave program contains an evoked potential analysis module that can 
be used to Add, Average, Subtract, or Invert selected traces. 

To open the Analyze module: 

 Right click the mouse over the EP Trace window. 

 From the pop-up menu, select Analyze. 

 The EP Analysis Expression Builder window is displayed. 

 

Example analyze window using AEP test data. 

 

To perform EP analysis, follow these steps. 

1. Open the Analyze window as described above. 

2. Select the type of operation that will be performed.  Choices are Add, 
Subtract, Average, or Invert. 

3. Build the analysis expression by selecting traces and adding them to 
the expression.  Simply left click the mouse on the traces you want to 
include in the operation.  Each trace's label will be added to the 
expression.  In the above example, the trial #1 (A2-Cz) trace from channel 
2 is being averaged with the trial #2 (A2-Cz) trace also from channel 2. 

 Use the Clear button to erase the expression and start a new one. 

4. Once the analysis expression has been built, click the Compute button. 
 The results of the analysis are displayed within the Trace window in a 
blue color.  In addition, the resulting trace label will contain the text "Avg", 
"Sub", or "Add".  The result of the Invert operation does not result in 
additional traces, the original traces are simply inverted. 
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5. Click the Close button when all EP Analysis operations are complete. 

Grand Average 

To perform a grand average on an evoked potential, follow these steps. 

1. Right click the mouse over the EP Trace window. 

2. Select Grand Average from the pop-up menu. 

3. The grand averages are computed and the resulting traces are displayed 
within the Trace window in blue color and have the text "GAvg" as part of 
their trace label. 

 

 Grand Averages are computed separately for each channel and for each 
side of stimulation.   

Stim History window 

Press the F11-Stim Hist. function key to open a window listing the stimulation 
parameters for each trial that has been run. 

 

 

 

Start New Run 

If you decide to repeat an evoked potential you have a choice of clearing the 
previously acquired data for the evoked potential or of keeping the previously 
acquired data. 

To Clear the Previous Data & Repeat: 
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1. Right click the mouse in the EP Trace window over the previously 
acquired traces.  From the pop-up menu select Delete All Stored Trials. 

2. A confirmation message will be displayed.  Click OK and all previous data 
for the evoked potential is cleared. 

3. Acquire new data  in the normal fashion. 

 

To Keep the Previous Data & Repeat: 

1. Right click the mouse over the evoked potential's name in the Study 
window.  From the pop-up menu select Start New Run. 

2. A second run node will be displayed under the evoked potential test's 
name. 

3. Acquire new data in the normal fashion. 

4. To view the first run select Run #1 from the Study window.  To view the 
second run select Run #2. 

 

Two separate runs have been acquired for the Median SEP. 

5. If you want to delete one of the runs for the evoked potential test, simply 
right click over the run you want to delete and select Delete from the 
pop-up menu.  A confirmation message will be displayed, click OK to 
delete the run. 

Split Screen Controls 

To Change the Split Screen Controls during data acquisition: 

 Right click the mouse over the EP Trace window.  From the pop-up 
menu select either Full Screen, Vertical Split, or Horizontal Split. 

 

 The default layout of the EP Trace window is programmed in the evoked 
potential's Test Setup window. 

To open the Test Setup window and change the default layout: 
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 Select Test Setup from the File menu.  Now click on the individual test 
protocol name in the Test Lists column.  The default layout for the Trace 
window is specified in the Display Settings section. 

 Make the appropriate changes and click OK. 

Display Settings 

 

Side:  Click here to set the default setting for the side of stimulation.  The 
choices are Left, Right, and Bilateral.  For example, selecting Right will 
always set the initial side of stimulation to "Right" when the test protocol is 
selected.  This setting can be changed on the acquisition screen if you want 
to begin stimulation on the opposite side. 

Split Screen:  Click here to set the default setting for how the trace window is 
displayed.  The choices are Full, Vertical and Horizontal. 

 Full - sets the trace area to full, all data from all sides are displayed in 
the same trace area. 

 Vertical - splits the trace area into two equal halves with a vertical 
divider.  Left sided traces are displayed on the left half of the trace 
window.  Right sided traces are displayed on the right half of the trace 
window. 

 Horizontal - splits the trace area into two equal halves with a 
horizontal divider.  Left sided traces are displayed in the top half of the 
trace window.  Right sided traces are displayed in the lower half of the 
trace window. 

Stim Avg - Stim On 

In some circumstances you may want to run the averager independent of the 
stimulator.  This is useful during AEP testing on infants when starting and 
stopping the stimulator could awaken the sleeping infant. 

The F2 function key can be used for this purpose. 

F2 (Stim Avg / Stim On) - defaults to Stim Avg mode, in this mode the averager 
is synchronized with stimulus delivery and the Run/Stop key is used to start and 
stop both simultaneously.  Press to activate Stim On mode, in this mode the 
stimulator is automatically turned ON and the averager can be turned On or Off 
independently of the stimulator using the Run/Stop key. 
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Saving Changes to EP Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the EP test protocol. 

 Select Save Test Parameters from the Edit menu. 

RR Interval 

RR Interval Basic Steps 

Select the RR Interval  Test: 

 If a Study has already been selected, simply click on the RR Interval 
test protocol within the Study window or turn Knob #1 (Study Item / Site) 
to highlight the test. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the RR Interval test protocol from the Study/Test menu. 

 

Follow these steps for performing the RR Interval test: 

1.  Apply electrodes to the patient and connect to amplifier 

Surface electrodes are used to record the ECG signal.  Connect the 
electrodes to Act1-Ref1 inputs so that the ECG peak is shown as an upward 
deflection in the trace window.  The Live ECG signal is displayed as soon as 
the test protocol is loaded. 

2.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate.  You want to visualize 3 or more ECG peaks across the 
sweep. 

Typical Settings 

 Gain 
(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep 
Speed 

(ms/Div) 

RR Interval 200-500 50 1 200 

 

3.  Adjust the Peak Detection Threshold 
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The peak detection threshold line should be positioned about halfway up the 
ECG peak.  Use Knob #3 (Trigger Level) to move the detection line up or 
down.  The RR Interval (ms) or Heart Rate (bmp) will be shown in blue text 
next to the ECG peak. 

 

RR Interval Trace window. 

4.  Select a Run in the RR Interval Table 

The RR Interval test protocol supports up to 5 preprogrammed data 
acquisition runs.  This table labels the run and controls the amount of time 
(duration) that the Sierra Wave will acquire data.  Click on a row in the table 
to select it and give instructions to the patient that are appropriate for the run 
selected (e.g., begin deep breathing). 

 

RR Interval Run Table. 

5.  Begin Data Acquisition 

Press the Run/Stop key on the Sierra Wave base unit to begin data 
acquisition.  The text Recording Run #n will be displayed in the trace window 
to indicate that the Sierra Wave is acquiring RR Interval data for the selected 
run.   RR Datapoints will begin to be plotted within the RR Datapoint Graph. 

6. Enter Events (optional) 
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Events can be entered during data collection by pressing the F1 (Events) 
function key. 

 

Type in the text for the event or select a preprogrammed event from the drop-
down list and then click the OK button.  A dashed vertical line will appear in 
the RR Datapoint Graph to indicate the event. 

7. Stop Data Acquisition 

The program will automatically stop data acquisition when the Duration 
setting specified for the run has been reached.  You can also manually stop 
data acquisition at any time by pressing the Run/Stop key.  As soon as data 
acquisition is stopped the program will calculate and display the results for the 
run in the RR Interval Table. 

The Live ECG trace will continue to be displayed even though data 
collection has stopped. 
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Completed RR Interval Table and corresponding Datapoint Graph for Run #4. 

The program displays the following measurements for each run: 

 Min RR - minimum RR interval recorded during the run. 

 Max RR - maximum RR interval recorded during the run. 

 Mean RR - the mean RR interval for the run. 

 Min/Max Ratio - the ratio of the minimum to maximum RR interval for 
the run. 

 SD - the standard deviation of the RR interval for the run. 

 Variance % - the percentage of variance for the run.  (Max – Min) / 
Mean x 100 

The program can be configured to display the results in Heart Rate 
(bpm) values rather than RR Intervals (ms).  Please refer to the RR 
Interval Setup topic for details. 

8.  Make Adjustments to RR Datapoint Graph (optional) 

The following functions can be performed within the RR Datapoint Graph. 

 Change Y-Axis - click on the upper or lower limit of the Y-axis and 
then enter the desired value.  The graph will automatically be re-drawn. 
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 Calculate Ratio - the program automatically calculates the Min/Max 
Ratio for the lowest and highest values recorded within the run.  You 
can also manually calculate a ratio between any two selected data 
points.  The manually calculated ratio is displayed in the upper right 
corner of the datapoint graph and in the User Ratio column of the RR 
Interval table. 

To calculate a manual ratio: 

a. Right click within the datapoint graph. 

b. Select Calculate Ratio from the pop-up menu. 

c. Click on the first data point, the data point will be displayed 
in green. 

d. Click on the second data point, the data point will be 
displayed in green. 

e. The ratio is calculated and displayed in the upper right 
corner. 

 Clear Ratio - select this option in the pop-up menu to clear a manual 
ratio. 

 Enter Event - right click on the data point corresponding to where you 
would like to enter an event, then select Enter Event from the pop-up 
menu.  Type in the text for the event, or select a preprogrammed event 
from the list, then click OK.  A dashed vertical line will be displayed in 
the graph. 

Position the mouse over the vertical dashed line to view a 
pop-up box of the event text. 

 Clear Event - to remove an event, right click over the vertical dashed 
line and select Clear Event from the pop-up menu. 

 Reject Data Point - to remove a data point, right click over the point 
and select Reject Data Point from the pop-up menu.  The deleted 
point will be shown in gray color. 
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RR Datapoint Graph and right-click menu. 

9.  Repeat Steps 4-9 for other Runs 

To record additional runs, repeat steps 4 through 9. 

10.  TabData (optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's 
traces and cursor information will be displayed on the right hand side of the 
window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

11.  Next Test (optional) 
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To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

 

Knob & Fkey Controls (RR Interval) 

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Trigger Lvl - turn this knob to change the vertical position of the ECG 
trigger level indicator. 

Gain / Sweep - turn the knob to change the gain of the ECG trace.  Press 
the knob, then turn to change the sweep speed of the ECG trace. 

 

Function Keys 

 

Event - opens the Add Event window which allows you enter an event 
during a recording. 

TabData - opens the TabData Summary window. 
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RR Datapoint Graph 

The following functions can be performed within the RR Datapoint Graph. 

 

RR Datapoint Graph and right-click menu. 

 Change Y-Axis - simply click on the upper or lower limit of the Y-axis 
and then enter the desired value.  The graph will automatically be re-
drawn. 

 Calculate Ratio - the program automatically calculates the Min/Max 
Ratio for the lowest and highest values recorded within the run.  You 
can also manually calculate a ratio between any two selected data 
points.  The manually calculated ratio is displayed in the upper right 
corner of the datapoint graph and in the User Ratio column of the run 
table. 

To calculate a manual ratio: 

a. Right click within the datapoint graph. 

b. Select Calculate Ratio from the pop-up menu. 

c. Click on the first data point, the data point will be displayed 
in green. 

d. Click on the second data point, the data point will be 
displayed in green. 

e. The ratio is calculated and displayed in the upper right 
corner. 

 Clear Ratio - select this option in the pop-up menu to clear a manual 
ratio. 

 Enter Event - right click on the data point corresponding to where you 
would like to enter an event, then select Enter Event from the pop-up 
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menu.  Type in the text for the event, or select a preprogrammed event 
from the list, then click OK.  A dashed vertical line will be displayed in 
the graph. 

Position the mouse over the vertical dashed line to view a 
pop-up box of the event text. 

 Clear Event - to remove an event, right click over the vertical dashed 
line and select Clear Event from the pop-up menu. 

 Reject Data Point - to remove a data point, right click over the point 
and select Reject Data Point from the pop-up menu.  The deleted 
point will be shown in gray color. 

 Ascii Output - allows the RR interval data points to be output to an 
ASCII file.  The ASCII file is saved as a „comma separated values‟ file; 
this means it can be opened easily with a spreadsheet or analysis 
program. 

 

 

Reviewing a Run 

To review the Datapoint Graph for a Run, perform one of the following: 

 Click on Run # in Study window. 

 Click on the Run's corresponding row in the RR Interval Table 

In both cases, the Datapoint Graph for the selected run will be displayed. 

If no data was acquired for the selected run, the Datapoint Graph will be 
empty. 

Deleting/Clearing a Run 

To Delete or Clear the data for a Run, perform one of the following: 

 Right click on the Run # in the Study window, select Delete from the 
pop-up menu. 

 Right click over the Run's corresponding row in the RR Interval Table, 
select Clear Row from the pop-up menu. 

In both cases, the tabulated results for the run will be erased and the 
Datapoint Graph will be cleared. 
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Normative Data 

Deep Breathing: 

6 breaths per minute for 1 or 2 minutes (5 seconds inhale, 5 seconds 
exhale). 

AGE (yrs) Norm Max/Min Ratio 

16-20 >1.23 

21-25 >1.20 

26-30 >1.18 

31-35 >1.16 

36-40 >1.14 

41-45 >1.12 

46-50 >1.11 

51-55 >1.09 

56-60 >1.08 

61-65 >1.07 

66-70 >1.06 

71-75 >1.06 

75-80 >1.05 

 

 

Example Deep Breathing (42 year old) 
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Valsalva Maneuver: 

Patient inhales deeply and then forcibly exhales into a leaky mouthpiece and 
maintains a constant pressure for 15-20 seconds before releasing and 
completely exhaling. 

Ratio is calculated using the Max RR after cessation of forced exhale divided 
by the Min RR during the 15-20 seconds of forced exhale. 

AGE (yrs) Norm Max/Min Ratio 

10-40 >1.5 

41-50 >1.45 

51-60 >1.45 

61-70 >1.35 

 

 

Example Valsalva Maneuver (42 year old) 
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Sitting To Standing: 

Patient goes from sitting position to standing up.  The 30:15 ratio is typically 
calculated, this is the RR interval at beat 30 after standing divided by the RR 
Interval at beat 15 after standing. 

AGE (yrs) Norm 30:15 Ratio 

10-29 >1.17 

30-49 >1.09 

50-65 >1.03 

 

 

Example Sitting-To-Standing (42 year old) 

 

Reference: 

AAEM Minimonograph #48 

Autonomic Nervous System Testing 

John M. Ravits, MD 

Muscle & Nerve, August 1997 

 

Table Font Size 

In all test protocols the font size of the Table window can be increased or 
decreased.  Simply right click on the table and select Font Size from the pop-up 
menu.  The choices are Small (default), Medium, Large, and Extra Large. 
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Changing the font size of the Muscle Scoring Table. 

 

 

Changing the font size of the NCV Tables. 

 

To save your selection as part of the test protocol's default settings, select Save 
Test Parameters from the Edit menu. 

 The selected font size is also applied to that table in the TabData window. 
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Saving Changes to RR Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the RR Interval test 
protocol. 

 Select Save Test Parameters from the Edit menu. 

MUNE - Incremental 

MUNE-Incremental Basics 

What is MUNE? 

Motor unit number estimation (MUNE) refers to a group of electrophysiologic 
techniques that estimate the number of lower motor neurons (i.e. motor units) 
innervating a muscle.  The motor unit number must be estimated, because there 
is no method to count the actual number of functioning lower motor neurons 
innervating a given muscle. 

MUNE is obtained by dividing the size of the maximal CMAP by the size of the 
mean surface-recorded single motor unit potential (SMUP).   

MUNE =  Max CMAP (Area or Amplitude) / Mean SMUP (Area or Amplitude) 

MUNE techniques differ in the ways in which they obtain samples of SMUPs from 
which the mean SMUP size is determined.  All methods are quite reproducible, 
and the reliability improves as the number of motor units reduces. 

 

Overview of Incremental MUNE 

This protocol has two features that assist the user in determining if an increment 
is valid and is not due to alternation (see description below).  First, the program 
performs on-line subtraction of successive incremental responses and displays 
the resulting difference traces, thereby showing the contribution of each recruited 
single motor unit potential.  Second, a post data collection alternation detection 
function can be run which analyzes the incremental responses and notifies the 
user when cases of alternation exist in the data set.     

Alternation refers to the problems that occur when two 
or more motor units are capable of being activated at the 
same stimulus intensity.  One or the other (or both) motor 
units may be recruited at any given time.  Alternation results 
in a larger number of perceived increments, which in turn 
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results in a smaller mean SMUP value, and hence a larger 
or overestimated MUNE value.  The alternation detection 
function sorts the incremental responses by increasing 
negative peak amplitude and then subtracts each 
incremental response from all subsequent ones; any 
identical solutions are considered to be examples of 
alternation. 

The area/amplitude of each difference trace is tabulated and the mean SMUP 
value is calculated.  The mean SMUP value is then divided into the Max CMAP 
value to provide the motor unit estimate. 

The ability to record and store a sub-threshold response and automatically 
subtract this from each incremental response is also available. This can help to 
reduce stimulus artifact and improve the detection of the negative peak onset. 

 

Select the MUNE-Incr  Test:   

 If a Study has already been selected, simply click on a MUNE-Incr 
muscle name (i.e., Right Deltoid) within the Study window or turn Knob #1 
(Study Item) to highlight the muscle name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual MUNE-Incr test protocol from the Study/Test menu, 
a muscle list will be displayed allowing you to pick the muscle or muscles 
that you will be testing on the patient.  Notice that as soon as any muscle 
is selected, it is displayed within the Study window. 

 The MUNE-Incr protocol defaults to the Max CMAP acquisition mode, 
note that the F1 function key defaults to this setting. 

 

Once the muscle has been selected.  Follow these steps for performing 
MUNE-Incr data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the muscle being tested. 
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Typical Settings 

Max 
Gain 

(uV/Div) 

Incr 
Gain 

(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep 
Speed 

(ms/Div) 

5k 100 10k 10 3.0 

 

2.  Verify Side Setting 

Make sure the appropriate side, Right or Left, is selected. 

3.  Electrode Placement 

Attach the electrodes to the patient. 

4.  Check Stimulator Polarity 

For MUNE Studies, the Cathode (-) should be oriented closest to the 
recording electrodes. 

The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  

Clicking on the Polarity field in the Controls Toolbar can also reverse the 
stimulator polarity.  The default (i.e., normal) mode has the right-side probe as 
the Cathode (if holding the stimulator with the Stim button facing you and the 
probes up); the reversed state will make the left-side probe the Cathode. 

In the Normal mode, the polarity field on the screen will indicate Nml. 

 

Normal Polarity 

In the Reversed mode, the polarity field on the screen will indicate Rev. 

    

Reversed Polarity 

5.  Acquire the Max CMAP Response 

Begin by acquiring the supra-maximal CMAP response in the upper left trace 
window.  This window is labeled Max CMAP.  Cursors are automatically 
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placed on the response and the area/amplitude of the response is shown in 
the MUNE Tables window. 

 

Max CMAP 

6.  Enable Increments Acquisition Mode 

Once the supra-maximal CMAP response has been acquired press the F1 
(Max CMAP/Increments) function key to enable the Increments mode.  This 
activates the trace window in the lower left section of the screen labeled 
Increments and automatically stores the Max CMAP response. 

7.  Acquire Sub-Threshold Response (Optional) 

Press the F8 (Sub Thr.) function key to enable the sub-threshold feature. 
Turn down the stimulus intensity and acquire a sub-threshold response (i.e., 
the response prior to the first all-or-nothing single motor unit).  Press the 
Store key to save the response.  The sub-threshold response is colored 
light-blue on the screen and is labeled sThr.  This response will be 
automatically subtracted from all subsequent incremental responses to help 
reduce stimulus artifact and improve the detection of the negative peak onset. 

8.  Acquire first All-or-Nothing Response 

Slowly increase the stimulus intensity and acquire the first all-or-nothing 
response.  The response should not fractionate or show changes in shape or 
size when stimulated repetitively at this intensity.  Press the Store key to save 
the response.  This trace is automatically copied to the Difference trace area 
as it is assumed to be the lowest threshold single motor unit potential 
(SMUP). 

9.  Acquire Response for Second Unit 

Continue stimulation and slowly increase the stimulus intensity until a larger 
response appears, likely due to activation of a second motor unit. As soon as 
this response is acquired the program will compute the difference between 
this trace and the previously stored trace.  The result is shown in the 
Differences trace area and the trace is labeled 2-1..  The difference trace 
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shows the contribution of the newly recruited motor unit.  Press the Store key 
to save the increment and difference traces. 

As increments are acquired and stored the area/amplitude of each difference 
trace is recorded in the MUNE Tables window.  The mean SMUP 
area/amplitude is calculated and the MUNE value for the muscle is updated. 

10. Acquire additional Incremental Responses 

Continue to acquire and store additional increments.  Typically 11 increments 
(10 difference traces) need to be acquired for an accurate estimate.  The 
Gain can be adjusted in both the Increments and Difference trace areas.  Use 
the Gain knob or Gain setting in the amplifier toolbar to change the gain of the 
incremental traces.  Right-click over the Differences trace area to change the 
gain of the difference traces. 

The trace area located above the difference traces will default to show the 
incremental traces in an overlayed fashion.  You can right-click over this area 
and choose to display the difference traces in overlayed fashion. 

 

MUNE Incr - Trace window showing Max CMAP, Increments, and Differences 
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MUNE Table for traces shown above. 

 

11.  Check for Alternation (Optional) 

After acquiring an appropriate number of increments, press the F7 (Auto 
ALT) function key to automatically detect for possible instances of alternation 
in the data set.  The incremental responses are first sorted by increasing 
negative peak amplitude and then each incremental response is subtracted 
from all subsequent ones; any identical solutions (determined by cross-
correlation) are considered to be examples of alternation.  Cases of 
alternation are indicated by coloring the incremental trace dark blue and 
these traces are automatically removed from the estimate.  The difference 
traces are updated to reflect the new order of the incremental traces and the 
motor unit estimate is re-calculated. 
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Increment traces 6 and 8 have been marked as alternation (blue color) and as a result the 
Difference traces have been updated.  The MUNE value for the muscle went from 190 down 

to 150. 

Because the first step in the alternation detection is to sort the 
incremental traces by increasing peak amplitude it is a good idea to check the 
Onset and Peak cursor positions on the incremental traces prior to running 
the detection.  If the cursors are not displayed on the incremental traces, 
right-click over the increments trace area and select Show Cursors. 

To Undo Alternation detection: 

Alternation detection can be over-ruled in two ways: 

 You can left click on a blue alternation trace to select it, the trace 
will be displayed in yellow when selected, then right-click to remove 
the alternation status in the pop-up menu. 

 You can undo the alternation detection completely by pressing the 
F7 (Undo Alt) function key. 
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12.  Verify Cursor Positions on the Difference Traces (Very Important) 

Right-click within the Difference trace area and select Show Cursors. 
 Verify the positions of the Onset, Peak, and Trough cursors on each trace 
as these positions will effect the SMUP area/amplitude measurements and 
therefore the calculated MUNE value for the muscle.  You can return the 
setting to Show Onset Cursors or Hide Cursors after verifying the positions. 

 

Difference traces with cursors positioned correctly. 

13.  TabData (Optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 
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To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's traces 
and cursor information will be displayed on the right hand side of the window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

14.  Next Muscle or Test 

To advance to the Next Muscle: 

 Use Knob #1 (Study Item / Site) to highlight another muscle in the 
Study window. 

 Click on another muscle in the Study window using the mouse. 

 Press the F3 (Muscle List) function key on the Sierra Wave base 
unit and select another muscle from the muscle list. 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 

Knob & Fkey Controls (MUNE-Incr) 

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Intensity / Pulse Width - this knob defaults to the Intensity mode and 
can be used to increase or decrease the stimulus intensity, the current 
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intensity value (in milliamps) is displayed on the knob icon.  Press this 
knob to switch to the Pulse Width mode and  turn to change the value of 
the electrical stimulus pulse width, the current pulse width value (in 
microseconds) will be displayed on the knob icon. 

Gain / Sweep - turn the knob to change the gain of the Max CMAP or 
Increments trace area.  Press the knob, then turn to change the sweep 
speed of all traces. 

 

Function Keys 

 

Max CMAP / Increments - defaults to Max CMAP mode which allows 
the recording of the supra-maximal response.  Pressing this key 
switches to Increments mode which automatically stores the Max 
CMAP and configures the program for recording of incremental single 
motor unit potentials. 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this 
key switches to Overlay mode which will superimpose all traces on top 
of one another. 

Muscle List - opens the MUNE-Incr Muscle List window which allows 
you to select and add muscles to your Study window. 

TabData - opens the TabData summary window. 

MUNE Incremental Test Setup 

MUNE Incremental test setup options are discussed in detail in the Test 
Protocol Setup chapter of the Help system. 

 

Alternation Detection (MUNE-Incr) 

Alternation refers to the problems that occur when two or more motor units are 
capable of being activated at the same stimulus intensity.  One or the other (or 
both) motor units may be recruited at any given time.  Alternation results in a 
larger number of perceived increments, which in turn results in a smaller mean 
SMUP value, and hence a larger or overestimated MUNE value. 
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In the MUNE-Incr test protocol incremental traces can be manually marked as 
instances of alternation or an automatic alternation detection function can be 
utilized. 

 

Manual Marking of Alternation 

To manually mark an incremental trace as alternation: 

1. Left-click on the trace to select it, the trace will be displayed in yellow. 

2. Now, right-click and select Mark Selected Traces for Alternation 
from the pop-up menu. 

3. The trace will be displayed in dark blue, indicating it has been marked 
as alternation.  The difference traces will automatically be updated to 
reflect the new order of the incremental traces and the motor unit 
estimate will be re-calculated 

 

Automatic Alternation Detection 

To run the automatic alternation function: 

1. Verify the positions of the Onset and Peak cursors on the incremental 
traces.  This is important because the alternation detection function 
first sorts the incremental traces by increasing negative peak 
amplitude. 

2. Press the F7 (Auto Alt) function key.  Each incremental trace is 
subtracted from all subsequent ones; any identical solutions are 
considered to be examples of alternation.  Cases of alternation are 
indicated by coloring the incremental trace dark blue and these traces 
are automatically removed from the estimate.  The difference traces 
are updated to reflect the new order of the incremental traces and the 
motor unit estimate is re-calculated. 
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Increment traces 6 and 8 have been marked as alternation (blue color) and as a result the 
Difference traces have been updated. 

 

Reversing Alternation 

Alternation detection can be over-ruled in two ways: 

 You can left click on a blue alternation trace to select it, the trace will 
be displayed in yellow when selected, then right-click to remove the 
alternation status in the pop-up menu. 

 You can undo the alternation detection completely by pressing the F7 
(Undo Alt) function key. 

 

Adjusting Automatic Alternation Detection Threshold 

The automatic alternation detection function subtracts each incremental trace 
from all subsequent incremental traces and compares all the resulting 
solutions using cross-correlation.  The cross-correlation is normalized to the 
largest amplitude incremental trace.  Solutions that are found to be matches 
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indicate alternation in the incremental traces, and those traces are displayed 
in dark blue. 

The cross-correlation threshold defaults to 0.9850 but can be changed in the 
test setup window. 

1. From the Edit menu, select Current Test. 

2. Change the value shown in the Auto Alternation Threshold field. 

 

3. Click OK. 

4. Press the F7 (Auto Alt) function key to run the alternation detection 
function using the new threshold value. 

 

Adjusting Cursors 

Max CMAP, Increment, and Difference Traces 

Right-click over the trace area and select Show Cursors from the pop-up 
menu.  Now, simply click and drag the cursors to position them on the traces. 

Trace Positions 

There are two ways to change the vertical positions of the Incremental traces. 

Using the Mouse: 

Left click on the trace you want to move and drag the trace to it's new 
location. 

 

Using the Trace Position Settings: 

1. Right click over the Incremental Trace window. 

2. From the pop-up menu, select Trace Position Settings.  The 
Trace Position Settings window will be displayed. 
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Trace Position Settings window. 

3. Change the listed parameters, then click OK. 

Start Position:  This is the default trace within the incremental 
SMUP trace window.  It specifies the number of vertical divisions 
below the top of the trace window.  In this example, the first 
incremental trace will be positioned 2 divisions below the top of 
the window. 

Trial Offset:  This setting determines how much space will 
separate each stored incremental trace.  In this example the 
setting is 1.0 divisions, therefore the second incremental trace will 
be displayed 1.0 divisions below the first trace.  The third 
incremental trace will be displayed 1.0 divisions below the second 
trace and so on. 

Auto Adjust Traces:  When checked, this parameter will 
automatically adjust the Start Position and Trial Offset to keep all 
acquired traces displayed within the incremental trace window. 

 

Deleting Traces 

To Delete an Incremental Trace 

Left-click on the incremental trace to select it, the trace will be displayed 
in yellow.  Now, right-click and select Delete Selected Traces from the 
pop-up menu. 

 

The Difference traces are automatically updated to reflect the new 
order of the Incremental traces. 
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Start New Run 

If you decide to repeat a muscle you have a choice of clearing the previously 
acquired data for the muscle or of keeping the previously acquired data. 

To Clear the Previous Data & Repeat: 

1. Right click the mouse in the Increments trace area.  From the pop-up 
menu select Delete All Stored Trials. 

2. A confirmation message will be displayed.  Click OK and all the 
incremental traces are cleared. 

3. Acquire new data for the muscle in the normal fashion. 

 

To Keep the Previous Data & Repeat: 

1. Right click the mouse over the muscle's name in the Study window. 
 From the pop-up menu select Start New Run. 

2. A second run node will be displayed under the muscle's name. 

3. Acquire new data for the muscle in the normal fashion. 

4. To view the first run done on the muscle select Run #1 from the Study 
window.  To view the second run done on the muscle select Run #2. 

 

Two separate runs have been acquired for the Left Abd Poll Brev muscle. 

5. If you want to delete one of the runs for the muscle, simply right click 
over the run you want to delete and select Delete from the pop-up menu. 
 A confirmation message will be displayed, click OK to delete the run. 
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Saving Changes to MUNE-Incr Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the MUNE-Incr test 
protocol. 

 Select Save Test Parameters from the Edit menu. 
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Motor Unit Estimation:  Anxieties and Achievements 

Alan J. McComas, MD 

Muscle & Nerve, April 1995 

 

Electrodiagnosis in Clinical Neurology 

Fifth Edition, Michael Aminoff, M.D. 

Chapter 12: Quantitative Electromyography 

Elsevier - Churchill Livingstone, 2005 

 

Motor Unit Number Estimation (MUNE) 

Proceedings of the First International Symposium on MUNE 

Snowbird, Utah, USA 

Edited by Mark B. Bromberg, M.D. 

Supplements to Clinical Neurophysiology 

Volume 55 

Elsevier, 2003 

 

Estimating the Number of Motor Units in a Muscle 

Jasper R. Daube 

Journal of Clinical Neurophysiology 

12(6):585-594, 1995 

 

Methods for Estimating the Numbers of Motor Units in Human Muscles 

Timothy Doherty, et al. 



Protocols 

897 

Journal of Clinical Neurophysiology 

12(6):565-584, 1995 

 

Clinical Electromyography - Nerve Conduction Studies 

Third Edition 

Shin J. Oh 

Lippincott Williams & Wilkins, 2003 

Pages 465-472, 491-496 

 

Motor unit number estimation in human neurological diseases and animal models 

Jeremy M. Shefner 

Clinical Neurophysiology, 2001 

112:955-964 

 

Advances in Clinical Neurophysiology 

(Supplements to Clinical Neurophysiology, Vol. 57) 

Chapter 14 - Motor unit number estimation: new techniques and new uses 

Mark B. Bromberg 

Elsevier, 2004 

 

Methods for Estimating the Numbers of Motor Units in Human Muscles 

An AAEM Workshop 

William F. Brown, M.D. 

American Association of Electrodiagnostic Medicine 

October 1992 

 

Changes in Motor Unit Estimates with Aging 

V. Galea 

Journal of Clinical Neurophysiology 

13(3):253-260, 1996 

 



Sierra Wave Help Manual 

898 

The Numbers and Relative Sizes of Motor Units Estimated by Computer 

Victoria Galea, MSc., et al. 

Muscle & Nerve 

14:1123-1130, 1991 

 

Number and Relative Size of Thenar Motor Units Estimated by an 

Adapted Multiple Point Stimulation Method 

Francois-Charles Wang, MD, and Paul J. Delwaide, MD, PhD 

Muscle & Nerve 

18:969-979, 1995 

 

Number of EDB Motor Units Estimated Using an Adapted Multiple Point 

Stimulation Method:  Normal Values and Longitudinal Studies in ALS and 

Peripheral Neuropathies 

Eric Albrecht, Thierry Kuntzer 

Clinical Neurophysiology 

115:557-563, 2004 

 

Thenar Motor Unit Number Estimates Using the Multiple Point Stimulation 

Technique:  Reproducibility Studies in ALS Patients and Normal Subjects 

Kevin J. Felice, DO 

Muscle & Nerve 

18:1412-1416, 1995 

 



Protocols 

899 

MUNE - MPS 

MUNE-MPS Basics 

What is MUNE? 

Motor unit number estimation (MUNE) refers to a group of electrophysiologic 
techniques that estimate the number of lower motor neurons (i.e. motor units) 
innervating a muscle.  The motor unit number must be estimated, because there 
is no method to count the actual number of functioning lower motor neurons 
innervating a given muscle. 

MUNE is obtained by dividing the size of the maximal CMAP by the size of the 
mean surface-recorded single motor unit potential (SMUP).   

MUNE =  Max CMAP (Area or Amplitude) / Mean SMUP (Area or Amplitude) 

MUNE techniques differ in the ways in which they obtain samples of SMUPs from 
which the mean SMUP size is determined.  All methods are quite reproducible, 
and the reliability improves as the number of motor units reduces. 

 

Overview of Multiple Point Stimulation (MPS) MUNE 

This protocol supports both the Standard and Adapted methods of multiple point 
stimulation. 

For both methods the program automatically aligns the onset latencies of the 
individual SMUP responses from different stimulus sites and then averages these 
responses „data-point-by-data point‟ and displays the resulting averaged SMUP 
response (upper right section of trace window).  The area/amplitude of the 
averaged SMUP response is then used to calculate the motor unit estimate. 

The Standard method records and stores only the first all-or-nothing SMUP 
from each stimulus site along the nerve. 

The Adapted method supports the recording of multiple SMUPs from each 
stimulus site along the nerve.  When more than one incremental response is 
acquired for a stimulus site, the program automatically computes the difference 
trace between the newest and previous response and places the resulting 
difference trace in the onset aligned window. 

The ability to record and store a sub-threshold response for each stimulus site 
and automatically subtract this from each incremental response is also available. 
 This can help to reduce stimulus artifact and improve the detection of the 
negative peak onset. 
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Select the MUNE-MPS  Test:   

 If a Study has already been selected, simply click on a MUNE-MPS 
muscle name (i.e., Right Deltoid) within the Study window or turn Knob #1 
(Study Item) to highlight the muscle name. 

 If a Study has not been selected, or you don't want to use a Study. 
 Select the individual MUNE-MPS test protocol from the Study/Test 
menu, a muscle list will be displayed allowing you to pick the muscle or 
muscles that you will be testing on the patient.  Notice that as soon as any 
muscle is selected, it is displayed within the Study window. 

 The MUNE-MPS protocol defaults to the Max CMAP acquisition mode, 
note that the F1 function key defaults to this setting. 

 

Once the muscle has been selected.  Follow these steps for performing 
MUNE-MPS data acquisition: 

1.  Verify Amplifier Settings 

Check the Gain, Hicut, Locut, and Sweep Speed settings and make sure 
they are appropriate for the muscle being tested. 

Typical Settings 

Max 
CMAP 
Gain 

(uV/Div) 

SMUP 
Gain 

(uV/Div) 

Hicut 
(Hz) 

Locut 
(Hz) 

Sweep 
Speed 

(ms/Div) 

5k 100 10k 10 3.0 

 

2.  Verify Side Setting 

Make sure the appropriate side, Right or Left, is selected. 

3.  Electrode Placement 

Attach the electrodes to the patient. 

4.  Check Stimulator Polarity 

For MUNE Studies, the Cathode (-) should be oriented closest to the 
recording electrodes. 
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The Cathode (i.e., the negative stimulus probe) can be selected by pressing 
the Reverse Polarity (+/-) button on the electrical stimulator handle.  A green 
LED indicates the probe that is the Cathode.  

Clicking on the Polarity field in the Controls Toolbar can also reverse the 
stimulator polarity.  The default (i.e., normal) mode has the right-side probe as 
the Cathode (if holding the stimulator with the Stim button facing you and the 
probes up); the reversed state will make the left-side probe the Cathode. 

In the Normal mode, the polarity field on the screen will indicate Nml. 

 

Normal Polarity 

In the Reversed mode, the polarity field on the screen will indicate Rev. 

    

Reversed Polarity 

5.  Acquire the Max CMAP Response 

Begin by acquiring the supra-maximal CMAP response in the upper left trace 
window.  This window is labeled Max CMAP.  Cursors are automatically 
placed on the response and the area/amplitude of the response is shown in 
the MUNE Tables window. 

 

Max CMAP 

6.  Enable SMUPs Acquisition Mode 

Once the supra-maximal CMAP response has been acquired press the F1 
(Max CMAP/SMUPs) function key to enable the SMUPs mode.  This 
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activates the trace window in the lower left section of the screen labeled 
SMUPs and automatically stores the Max CMAP response. 

7.  Acquire Sub-Threshold Response (Optional) 

Press the F8 (Sub Thr.) function key to enable the sub-threshold feature. 
Turn down the stimulus intensity and acquire a sub-threshold response (i.e., 
the response prior to the first all-or-nothing single motor unit) from the first 
stimulus site.  Press the Store key to save the response.  The sub-threshold 
response is colored light-blue on the screen and is labeled S1:sThr.  This 
response will be automatically subtracted from all subsequent incremental 
responses recorded from this stimulus site, this will help reduce stimulus 
artifact and improve the detection of the negative peak onset. 

8.  Acquire first All-or-Nothing Response 

Slowly increase the stimulus intensity and acquire the first all-or-nothing 
response.  The response should not fractionate or show changes in shape or 
size when stimulated repetitively at this intensity.  Press the Store key to save 
the response.  This trace is automatically copied to the Difference-Onset 
Aligned trace area (labeled S1:1) as it is assumed to be the lowest threshold 
single motor unit potential (SMUP) from this stimulus site. 

9.  Acquire another response from the same stimulus site (Optional - 
Adapted Method) 

Continue stimulation at the first stimulus site and slowly increase the stimulus 
intensity until a larger response appears, likely due to activation of a second 
motor unit. As soon as this response is acquired the program will compute the 
difference between this trace and the previous trace.  The result is labeled 
S1:2-1 and is shown in the Differences-Onset Aligned trace area.  The 
difference trace shows the contribution of the newly recruited motor unit. 
 Press the Store key to save the incremental trace (labeled S1:2).  This step 
can be repeated to acquire additional incremental traces from this stimulus 
site, but typically only 2 or 3 are easily obtained. 

10.  Advance to the Next Stimulus Site 

Press the F9 (Next Site) function key and then move the stimulator to a new 
stimulus site along the nerve.  Repeat steps 7-9 above.  Typically 10 SMUPs 
need to be acquired for an accurate estimate. 

The Gain can be adjusted in both the Increments and Difference-Onset 
Aligned trace areas.  Use the Gain knob or Gain setting in the amplifier 
toolbar to change the gain of the SMUP traces, right-click over the 
Differences-Onset Aligned area to change the gain of these traces. 

The Avg SMUP trace area (upper right) shows the averaged SMUP trace and 
is automatically updated as new traces are added to the Difference-Onset 
Aligned area. 
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MUNE MPS - Trace window showing Max CMAP, SMUPs, Difference-Onset Aligned, and 
Avg SMUP traces. 

 

MUNE-MPS Table for traces shown above. 

 

11.  Verify Onset Cursor Positions (Very Important) 



Sierra Wave Help Manual 

904 

Right-click within the Difference-Onset Aligned trace area and select Show 
Cursors.  Verify that the placement of the Onset cursor is correct on all the 
Difference-Onset Aligned traces and that the Onset, Peak, & Trough cursors 
are appropriately placed on the Avg SMUP trace. 

These cursor positions will effect the computation of the average SMUP trace 
and therefore the calculated MUNE value for the muscle.  You can return the 
setting to Show Onset Cursors or Hide Cursors after verifying the positions. 

When the Onset cursor is moved on a Difference-Onset Aligned trace: 

 The program automatically moves the trace horizontally to align the 
onset position with the other traces in this area. 

 Recomputes the Avg SMUP and updates the MUNE calculation. 
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Onset cursors in correct positions. 

12.  TabData (Optional) 

To view a Summary window of all the tests done on the patient, press the F4 
(TabData) function key on the Sierra Wave base unit. 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for Summary Tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the test with the mouse.  The selected test's traces 
and cursor information will be displayed on the right hand side of the window. 

To view a Summary Table: 

Highlight the table by turning Knob #1 (Select / Open) on the Sierra Wave 
base unit or by clicking on the Summary Table with the mouse.  The selected 
table will be displayed on the right hand side of the window. 

To print a Report: 

Click on one of the report buttons at the bottom of the TabData window, or 
press the corresponding function key on the Sierra Wave base unit. 

13.  Next Muscle or Test 

To advance to the Next Muscle: 

 Use Knob #1 (Study Item / Site) to highlight another muscle in the 
Study window. 

 Click on another muscle in the Study window using the mouse. 

 Press the F3 (Muscle List) function key on the Sierra Wave base 
unit and select another muscle from the muscle list. 

To change Test Protocols: 

 Use Knob #1 (Study Item / Site) to highlight another Test Protocol in 
the Study window. 

 Click on another Test Protocol in the Study window using the mouse. 

 Press the Select key on the Sierra Wave base unit and select a Test 
Protocol from the Study/Test menu. 
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Knob & Fkey Controls (MUNE-MPS) 

Knobs 

 

Study Item - turn this knob to highlight and load a different Test Protocol 
in the Study window. 

Intensity / Pulse Width - this knob defaults to the Intensity mode and 
can be used to increase or decrease the stimulus intensity, the current 
intensity value (in milliamps) is displayed on the knob icon.  Press this 
knob to switch to the Pulse Width mode and  turn to change the value of 
the electrical stimulus pulse width, the current pulse width value (in 
microseconds) will be displayed on the knob icon. 

Gain / Sweep - turn the knob to change the gain of the Max CMAP or 
Increments trace area.  Press the knob, then turn to change the sweep 
speed of all traces. 

 

Function Keys 

 

Max CMAP / SMUPs - defaults to Max CMAP mode which allows the 
recording of the supra-maximal response.  Pressing this key switches 
to SMUPs mode which automatically stores the Max CMAP and 
configures the program for recording of single motor unit potentials. 

Raster / Overlay - defaults to Raster mode, in Raster mode the traces 
are separated according to the Trace Position Settings.  Pressing this 
key switches to Overlay mode which will superimpose all traces on top 
of one another. 

Muscle List - opens the MUNE-MPS Muscle List window which allows 
you to select and add muscles to your Study window. 

TabData - opens the TabData summary window. 

MUNE MPS Test Setup 

MUNE-MPS test setup options are discussed in detail in the Test Protocol 
Setup chapter of the Help system. 
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Click here to go to this topic. 

Alternation Detection (MUNE-MPS) 

Alternation refers to the problems that occur when two or more motor units are 
capable of being activated at the same stimulus intensity.  One or the other (or 
both) motor units may be recruited at any given time.  Alternation results in a 
larger number of perceived increments, which in turn results in a smaller mean 
SMUP value, and hence a larger or overestimated MUNE value. 

In the MUNE-MPS test protocol SMUP traces can be manually marked as 
instances of alternation. 

 

Manual Marking of Alternation 

To manually mark an SMUP trace as alternation: 

1. Left-click on the trace to select it, the trace will be displayed in yellow. 

2. Now, right-click and select Mark Selected Traces for Alternation 
from the pop-up menu. 

3. The trace will be displayed in dark blue, indicating it has been marked 
as alternation.  The Difference-Onset Aligned traces for that stimulus 
site will automatically be updated to reflect the new order of the SMUP 
traces and the Avg SMUP trace and motor unit estimate will be re-
calculated. 

Reversing Alternation 

Left click on a blue alternation trace to select it, the trace will be displayed 
in yellow when selected, then right-click to remove the alternation status in 
the pop-up menu. 

Adjusting Cursors 

Max CMAP, SMUP, Difference-Onset Aligned, and Avg SMUP Traces 

Right-click over the trace area and select Show Cursors from the pop-up 
menu.  Now, simply click and drag the cursors to position them on the traces. 

When the Onset cursor is moved on a Difference-Onset Aligned trace: 

 The program automatically moves the trace horizontally to align the 
onset position with the other traces in this area. 

 Recomputes the Avg SMUP and updates the MUNE calculation. 
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Trace Positions 

There are two ways to change the vertical positions of the SMUP traces. 

Using the Mouse: 

Left click on the trace you want to move and drag the trace to it's new 
location. 

 

Using the Trace Position Settings: 

1. Right click over the SMUP Trace window. 

2. From the pop-up menu, select Trace Position Settings.  The 
Trace Position Settings window will be displayed. 

 

Trace Position Settings window. 

3. Change the listed parameters, then click OK. 

Start Position:  This is the default trace within the SMUP trace 
window.  It specifies the number of vertical divisions below the top 
of the trace window.  In this example, the first SMUP trace will be 
positioned 2 divisions below the top of the window. 

Trial Offset:  This setting determines how much space will 
separate each stored SMUP trace acquired from the same 
stimulus site.  In this example the setting is 0.5 divisions, therefore 
the second SMUP trace will be displayed 0.5 divisions below the 
first trace.  The third SMUP trace will be displayed 0.5 divisions 
below the second trace and so on. 

Site Offset:  This setting determines how much space will 
separate the SMUP traces from different stimulus sites.   
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Auto Adjust Traces:  When checked, this parameter will 
automatically adjust the Start Position and Trial Offset to keep all 
acquired traces displayed within the SMUP trace window. 

 

Deleting Traces 

To Delete an SMUP Trace 

Left-click on the SMUP trace to select it, the trace will be displayed in 
yellow.  Now, right-click and select Delete Selected Traces from the pop-
up menu. 

The Difference-Onset Aligned traces are automatically updated to 
reflect the new order of the SMUP traces. 

Start New Run 

If you decide to repeat a muscle you have a choice of clearing the previously 
acquired data for the muscle or of keeping the previously acquired data. 

To Clear the Previous Data & Repeat: 

1. Right click the mouse in the SMUP trace area.  From the pop-up menu 
select Delete All Stored Trials. 

2. A confirmation message will be displayed.  Click OK and all the SMUP 
traces are cleared. 

3. Acquire new data for the muscle in the normal fashion. 

 

To Keep the Previous Data & Repeat: 

1. Right click the mouse over the muscle's name in the Study window. 
 From the pop-up menu select Start New Run. 

2. A second run node will be displayed under the muscle's name. 

3. Acquire new data for the muscle in the normal fashion. 

4. To view the first run done on the muscle select Run #1 from the Study 
window.  To view the second run done on the muscle select Run #2. 
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Two separate runs have been acquired for the Left Abd Poll Brev muscle. 

5. If you want to delete one of the runs for the muscle, simply right click 
over the run you want to delete and select Delete from the pop-up menu. 
 A confirmation message will be displayed, click OK to delete the run. 

 

Saving Changes to MUNE-MPS Settings 

During an exam you may make changes to various parameters or window 
layouts. 

To save these changes as the new default settings for the MUNE-MPS test 
protocol. 

 Select Save Test Parameters from the Edit menu. 

MUNE References 
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Protocols 

911 

Proceedings of the First International Symposium on MUNE 

Snowbird, Utah, USA 

Edited by Mark B. Bromberg, M.D. 

Supplements to Clinical Neurophysiology 

Volume 55 

Elsevier, 2003 

 

Estimating the Number of Motor Units in a Muscle 

Jasper R. Daube 

Journal of Clinical Neurophysiology 

12(6):585-594, 1995 

 

Methods for Estimating the Numbers of Motor Units in Human Muscles 

Timothy Doherty, et al. 

Journal of Clinical Neurophysiology 

12(6):565-584, 1995 

 

Clinical Electromyography - Nerve Conduction Studies 

Third Edition 

Shin J. Oh 

Lippincott Williams & Wilkins, 2003 

Pages 465-472, 491-496 

 

Motor unit number estimation in human neurological diseases and animal models 

Jeremy M. Shefner 

Clinical Neurophysiology, 2001 

112:955-964 

 

Advances in Clinical Neurophysiology 

(Supplements to Clinical Neurophysiology, Vol. 57) 

Chapter 14 - Motor unit number estimation: new techniques and new uses 

Mark B. Bromberg 



Sierra Wave Help Manual 

912 

Elsevier, 2004 

 

Methods for Estimating the Numbers of Motor Units in Human Muscles 

An AAEM Workshop 

William F. Brown, M.D. 

American Association of Electrodiagnostic Medicine 

October 1992 

 

Changes in Motor Unit Estimates with Aging 

V. Galea 

Journal of Clinical Neurophysiology 

13(3):253-260, 1996 

 

The Numbers and Relative Sizes of Motor Units Estimated by Computer 

Victoria Galea, MSc., et al. 

Muscle & Nerve 

14:1123-1130, 1991 

 

Number and Relative Size of Thenar Motor Units Estimated by an 

Adapted Multiple Point Stimulation Method 

Francois-Charles Wang, MD, and Paul J. Delwaide, MD, PhD 

Muscle & Nerve 

18:969-979, 1995 

 

Number of EDB Motor Units Estimated Using an Adapted Multiple Point 

Stimulation Method:  Normal Values and Longitudinal Studies in ALS and 

Peripheral Neuropathies 

Eric Albrecht, Thierry Kuntzer 

Clinical Neurophysiology 

115:557-563, 2004 

 



Protocols 

913 

Thenar Motor Unit Number Estimates Using the Multiple Point Stimulation 

Technique:  Reproducibility Studies in ALS Patients and Normal Subjects 

Kevin J. Felice, DO 

Muscle & Nerve 

18:1412-1416, 1995 

 





 

915 

Study Window 

Study Window Overview 

The Study window has several functions: 

 Lists the test protocols that have been pre-selected and grouped into 
the selected Study List (e.g., lists the tests for the Right Carpal Tunnel 
Study). 

 Automatically adds to the list other test protocols, not originally part of 
the Study list, as they are selected from the Study/Test menu or nerve 
and muscle lists. 

 Provides an easy way to change from one test protocol to another or go 
back and review a previous test. 

 Shows which test protocols have been completed by placing a 
checkmark on the test protocol's icon. 

 

To Select a Test Protocol in the Study window 

Use Knob #1 (Study Item), on the Sierra Wave base unit, to move the highlight 
up and down through the Study window.  If you stop the highlight on a test 
protocol for more than 1.5 seconds, that protocol will be loaded. 

Alternatively, click on a test protocol with the left mouse button to load it. 
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Study window. 

 

 

Context Menu Options 

Study Window Context Menu 

The Study window has a Context menu, also known as the right click menu. 
 It is accessed by right clicking the mouse over a blank area, or over a test 
protocol name, within the Study window.  The functions that are available in 
the context menu will vary depending on where you right clicked. 

When right clicking over a blank area in the Study window: 

The following context menu appears.  The Delete & Start New Run 
functions are disabled. 
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Insert - this function opens the Insert window.  The Insert window shows 
all the available test protocols on the system and allows you to easily add 
test protocols to those already listed in your Study window. 

 

Insert window. 

To Insert a Test Protocol: 

 Using the mouse. 

o Highlight a test protocol by clicking on it.  Expand nodes by 
clicking on the (+) sign. 

o Choose the appropriate Side (Left, Right, or Left & Right) by 
clicking on the drop down arrow.  The Side Setting does not 
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apply to SEP, AEP, VEP, P300, RR Interval, or Blink test 
protocols. 

o Click the Insert button.  The test protocol is inserted into the 
Study window below the currently selected test. 

o Repeat these steps until you have inserted all the test 
protocols that you need, then click the Done/OK button. 

o Using the Knobs. 

o Turn Knob #1 (Select / Insert) to move the highlight 
up/down within the Insert window and highlight the test 
protocol you want to insert.  You can press the knob to 
expand any nodes that have a (+) sign, like NCV. 

o Turn Knob #2 (Side) to change the Side (Left, Right, Left & 
Right).  The Side Setting does not apply to SEP, AEP, VEP, 
P300, RR Interval, or Blink test protocols. 

o Press Knob #1 (Select / Insert).  The highlighted test is 
inserted into the Study window below the currently selected 
test. 

o Repeat these steps until you have inserted all the test 
protocols that you need, then press the OK key on the Sierra 
Wave base unit. 

 

When right clicking on an NCV, F, H, RNS, Blink, SFEMG, or Evoked 
Potential test protocol name in the Study window: 

The following context menu appears. 

     

Insert - this function opens the Insert window.  This is the same window 
as described above. 

Delete - this function will delete the selected test protocol from the Study 
window and all data associated with the test. 
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Start New Run - use this function to repeat a test protocol while keeping 
the results of the first test.  For example, you may want to run the Right 
Sural Anti Sensory nerve twice on the same patient.  After selecting this 
function you will see Run Nodes appear underneath the test protocol's 
name in the Study window.  The first run node, Run #1, contains the 
original test results, Run #2 is for the second set of results.  Selecting 
Start New Run again would place additional run nodes in the Study 
window (e.g., Run #3, Run #4). 

 

Study window showing Run Nodes for Right Sural Anti Sensory nerve. 

Swap Sides - selecting this function will switch the Side Setting, from 
Right to Left or Left to Right, for the selected test protocol.  If the test 
protocol that results from the swap does not already exist in the Study 
window, it will be created automatically.  If the test protocol that results 
from the swap does already exist in the Study window, then the data is 
simply moved from the selected test to the resulting test. 

Move To - this feature allows the NCV, F Wave, H Reflex, or RNS  traces 
to be moved to a different nerve.  For example, motor nerve traces can be 
moved to any other motor nerve of the same 'nerve type'  in your nerve 
list. 

Font Size - use this function to change the font size displayed within the 
Study window.  Choices are Small (default), Medium, Large, and Extra 
Large. 

When right clicking on an EMG muscle name in the Study window: 

The following context menu appears.  The Start New Run function is 
disabled. 
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Insert - this function opens the Insert window.  This is the same window 
as described above. 

Delete - this function will delete the selected test protocol from the Study 
window and all data associated with the test. 

Score Muscle Normal - this function will add the selected muscle to the 
scoring table with all choices set to normal. 

Delete Muscle Score - this function will remove the selected muscle from 
the scoring table.  It also removes the check mark next to the muscle 
name, this indicates the muscle is no longer scored. 

Swap Sides, Left/Right - changes the side label of the muscle to the 
opposite setting. 

Change to Bilateral - changes the side label of the muscle to "Bilateral". 

Score Unscored Muscles Normal - this function will add all unscored 
muscles within the EMG test protocol to the scoring table with all choices 
set to normal. 

Score All Muscles Normal - this function will add all the muscles within 
the EMG test protocol to the scoring table with all choices set to normal. 

Delete All Muscle Scoring - this function will remove all the muscles 
within the EMG test protocol from the scoring table.  It also remove the 
check marks next to the muscle names, indicating that these muscle are 
no longer scored. 

Font Size - use this function to change the font size displayed within the 
Study window.  Choices are Small (default), Medium, Large, and Extra 
Large. 
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TabData Window 

TabData Window Overview 

The TabData window provides an overview of all tests completed on the patient 
as well as summary tables for test protocols such as NCV, F/H, and EMG.  An 
optional Sentence Generator is available to create sentences describing the 
results. 

To open the TabData window press the F4 (TabData) function key from within 
any test protocol or select TabData from the View menu. 

Completed test protocols are listed down the left-hand side of the window. 
  To select a test protocol or summary table perform one of the following 
actions. 

 Turn Knob #1 (Select / Open) to move the blue highlight to the 
desired test protocol or table. 

 Click the left mouse button on the test protocol or table. 

The highlighted entry's results are displayed on the right-hand side of the 
TabData window. 
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TabData window with All NCV summary tables selected. 

 

Integrated Sentence Generator for Findings: 

The TabData window features an optional Sentence Generator which can 
build findings sentences to describe NCV, F Wave, H-Reflex, EMG, and EP 
data. 

To Enable the Sentence Generator: 

 Start the Sierra Wave program. 

 Select System Setup from the Edit menu. 

 Place a check mark in the box labeled "Show Sentence Generator in 
TabData". 

 Click OK. 
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When an NCV, F Wave, or H-Reflex table node is highlighted in the TabData 
window, the findings sentences for those test protocols will be displayed 
below the summary tables. 

 

NCV, F, H findings sentences. 

When the EMG Scoring Table is highlighted in the TabData window, the 
findings sentences for the muscle scoring will be displayed below the scoring 
table. 

 

EMG findings sentences. 

When an EP table is highlighted in the TabData window, the findings 
sentences for the EP test will be displayed below the table. 
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Editing the Findings Sentences: 

Below each sentence is a Reset, Edit, and Save button.  Click the Edit 
button if you want to make changes or additions to the generated sentences. 
 The background of the sentence area will change to white color, signifying 
that you are in the Edit mode.  The formatting controls above the sentence 
area will also be activated. 

 

Edit mode. 

Click within the sentence area and make your changes/additions. 

 

Edit mode with changes. 

To save your changes, click the Save button.  The background will turn 
green, this signifies that editing has been performed and those 
changes/additions have been saved. 
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Changes to the sentences have been saved. 

To cancel your changes or additions, click the Reset button.  The sentence 
is returned to its default state and the background color changes back to the 
non-edit mode color. 

 

Sentence has been reset to default state. 

View the Custom Fields from the Patient Information window 

Clicking on the Patient Info / Report node will display the custom fields from 
the patient information window as well as the findings sentences (if enabled). 
 If a QuickReport Item has been assigned to a custom field, it can be 
processed in this view.  For more information on using custom fields, click 
here. 
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TabData window with Patient Info/Report node selected. 

 

Changing NCV Column Setup 

NCV Column Setup 

When a NCV Summary table or individual nerve test protocol is selected the 
Change Columns button is available. 

Clicking on Change Columns allows you to specify how the NCV results will 
be shown in your reports.  This does not change how the results are 
displayed during data acquisition. 

Selections can be made for both the NCV Tables and the Left/Right 
Comparison Tables. 

Click on the nerve type you want to change.  To include information in 
reports, click at the bottom of the displayed column, or within the column, and 
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then select Insert from the pop-up menu.  Select the value you want to 
include in the report from the displayed list of choices.  To remove information 
in reports, click on the value displayed in the column, then select Delete from 
the pop-up menu. 

 

NCV - Change Columns window. 

 

Amplitude Units:  Click here to select the amplitude measurement units, 
either millivolts (mV) or microvolts (uV).  Motor nerves are generally 
displayed in millivolts, sensory nerves in microvolts. 

Amplitude Type:  Click here to select how the normal amplitude value is 
displayed, either Onset to Peak or Peak to Trough. 

                  

Delta Type:  Click here to select how the nerve conduction velocity 
calculations are determined. 

 Delta-O, velocity is calculated based on the difference between the 
onset latencies of the two responses, and when distal onset latency 
is used for the terminal conduction velocity. 
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 Delta-P, velocity is calculated based on the difference between the 
peak latencies of the two responses, and when distal peak latency 
is used for the terminal conduction velocity. 

First Velocity:  Click here to select whether the first velocity segment 
should have it's velocity displayed or hidden.  Generally this setting is 
always set to Show, but in some instances users like to put in a distal 
segment for motor nerves, such as Wrist to APB.  This allows them to 
record the distal distance but hide the conduction velocity. 

L-R Amp Units:  Click here to specify whether the left minus right side 
amplitude differences are displayed as percentages (%) or absolute 
amplitude values (uV or mV). 

 

Site Table Columns: Select the site measurement columns that you would 
like to display in the report (Report/TabData).  To include a measurement, 
click at the bottom of the displayed column list, or within the column list, and 
then select Insert from the pop-up menu.  Select the measurement you want 
to include from displayed list of choices.  To remove a measurement, click on 
the measurement column in the column list, then select Delete from the pop-
up menu. 
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Site Table measurement choices. 

 Site - this column displays the stimulus site names, (e.g., Wrist, 
Elbow, Axilla). 

 NR - this column is used to indicate a "no response". 

 Onset (ms) - this column reports the onset latency of the response 
in milliseconds. 

 Norm Onset (ms) - this column displays the normal value for the 
site if one has been entered for the nerve being tested. 

 Peak (ms) - this column displays the peak latency of the response 
in milliseconds. 

 Norm Peak (ms) - this column displays the normal value for the 
site if one has been entered for the nerve being tested. 
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 O-P or P-T Amp - this column displays the amplitude of the 
response as either onset to peak or peak to trough.  The type of 
measurement, mV or uV,  is determined by selecting the 
Amplitude Units. 

 Norm Amp - this column displays the normal amplitude for the site 
if one has been entered for the nerve being tested. 

 Neg Dur (ms) - this column displays the negative duration of the 
response in milliseconds. 

 Full Dur (ms) - this column displays the full duration of the 
response in milliseconds. 

            

 Neg Area - this column displays the negative area of the response 
in either mV-ms or uV-ms depending on the setting of the 
Amplitude Units. 

 Full Area - this column displays the full area of the response in 
either mV-ms or uV-ms depending on the setting of the Amplitude 
Units. 
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 Amp% (1st) - this column shows a site‟s percent change in 
amplitude compared to the amplitude of site #1.  (Site #1 compared 
to itself is always 100%) 

 Amp% (Prev) - this column shows a site's percent change in 
amplitude compared to the amplitude of the previous site.  (e.g., 
Site 2 compared to Site 1, Site 3 compared to Site 2) 

 Neg Area% (1st) - this column shows a site's percent change in 
negative area compared to the negative area of site #1.  (Site#1 
compared to itself is always 100%). 

 Neg Area% (Prev) - this column shows a site's percent change in 
negative area compared to the negative area of the previous site. 
 (e.g., Site 2 compared to Site 1, Site 3 compared to Site 2) 

 Full Area% (1st) - this column shows a site's percent change in full 
area compared to the full area of site #1.  (Site#1 compared to itself 
is always 100%). 

 Full Area% (Prev) - this column shows a site's percent change in 
full area compared to the full area of the previous site.  (e.g., Site 2 
compared to Site 1, Site 3 compared to Site 2) 

 Contra Lat (ms) - this column shows the corresponding latency 
values (if Delta-O they are onset latencies, if Delta-P they are peak 
latencies) for the contralateral side. 

 L Lat (ms) - this column shows the corresponding latency values (if 
Delta-O they are onset latencies, if Delta-P they are peak latencies) 
for the left side of the nerve. 

 R Lat (ms) - this column shows the corresponding latency values (if 
Delta-O they are onset latencies, if Delta-P they are peak latencies) 
for the right side of the nerve. 

 L-R Lat (ms) - this column shows the Left minus Right side 
difference in the latency values. 

 Norm L-R Lat (ms) - this column displays the L-R normal latency 
difference value for the site if one has been entered for the nerve 
being tested. 

 Contra Amp (uV or mV) - this column displays the corresponding 
amplitude values (as either onset to peak or peak to trough) for the 
contralateral side.  The type of measurement, mV or uV,  is 
determined by selecting the Amplitude Units. 

 L Amp (uV or mV) - this column shows the correspond amplitude 
values (as either onset to peak or peak to trough) for the left side. 
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 The type of measurement, mV or uV,  is determined by selecting 
the Amplitude Units. 

 R Amp (uV or mV) - this column shows the correspond amplitude 
values (as either onset to peak or peak to trough) for the right side. 
 The type of measurement, mV or uV,  is determined by selecting 
the Amplitude Units. 

 L-R Amp (%, uV, or mV) - this column displays the Left minus 
Right side difference in amplitude values.  The values can be 
shown as a percentage or as an absolute value. 

 Norm L-R Amp - this column displays the L-R normal amplitude 
difference value for the site if one has been entered for the nerve 
being tested. 

 

Segment Table Columns:  Select the segment measurement columns that 
you would like to display in the report (Report/TabData).  To include a 
measurement, click at the bottom of the displayed column list, or within the 
column list, and then select Insert from the pop-up menu.  Select the 
measurement you want to include from the displayed list of choices.  To 
remove a measurement, click on the measurement column in the column list, 
then select Delete from the pop-up menu. 

 

Segment Table measurement choices. 

 Site 1 and Site 2 - this column shows the names of the stimulus 
sites that make up the segment. 
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 Delta-O or Delta-P - this column shows the difference (in 
milliseconds) between the response latencies of the two sites 
composing the segment.  The type of measurement is determined 
by selecting the Delta Type (onset or peak). 

 Norm Delta (ms) - this column displays the segment's normal 
value for the Delta measurement if one has been entered for the 
nerve being tested. 

 Distance (cm) - this column provides a place to enter the distance 
(in centimeters) between the two stimulus sites, or in some cases 
the distance between the distal stimulation site and the recording 
site. 

 Vel (m/s) - this column displays the calculated conduction velocity 
in meters per second. 

 Norm Vel (m/s) - this column displays the normal velocity for the 
segment if one has been entered for the nerve being tested. 

 Contra Dist (cm) - the column displays the corresponding distance 
values for the contralateral side. 

 L Dist (cm) - this column displays the distance values for segments 
on the left side. 

 R Dist (cm) - this column displays the distance values for 
segments on the right side 

 Contra Vel (m/s) - this column displays the corresponding velocity 
values for the contralateral side. 

 L Vel (m/s) - this column displays the velocity values for segments 
on the left side. 

 R Vel (m/s) - this column displays the velocity values for segments 
on the right side. 

 L-R Vel (m/s) - this column displays the Left minus Right side 
difference in velocity values. 

 Norm L-R Vel (m/s) - this column displays the L-R normal velocity 
difference value for the segment if one has been entered for the 
nerve being tested. 

 DVel (m/s 1st) - this column shows a segment's change in velocity 
compared to the velocity of the 1st segment.  (e.g., Segment 2 
compared to Segment 1, Segment 3 compared to Segment 1). 

 DVel (m/s prev) - this column shows a segment's change in 
velocity compared to the velocity of the previous segment.  (e.g., 
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Segment 2 compared to Segment 1, Segment 3 compared to 
Segment 2). 

Sort Options 

When a NCV Summary table or individual nerve test protocol is selected the Sort 
Options button is available. 

Clicking on this button allows you to specify how the NCV, F Wave, and H Reflex 
 results will be sorted  within the summary tables. 

 

NCV/F/H Sorting Options 

 Alphbetical by Nerve Name (Left then Right) - when this option is selected the 
nerves are sorted alphabetically by nerve name, Left side first and then Right side. 

 Alphbetical by Nerve Name (Right then Left) - when this option is selected the 
nerves are sorted alphabetically by nerve name, Right side first and then Left side. 

 By Side (Right then Left) - when this option is selected the nerves are sorted with 
Right side before Left side (all right-sided nerves and then all left-sided nerves). 

 By Side (Left then Right) - when this option is selected the nerves are sorted with 
Left side before Right side (all left-sided nerves and then all right-sided nerves). 

 

EMG/NCV Sentence Generator 

The Sentence Generator feature, which is used to automatically create findings 
sentences, is integrated into the Sierra Wave‟s TabData window.  This gives the 
user the ability to simultaneously view the patient‟s tabulated test results and the 
findings sentences.  This is an optional feature which can be turned On or Off in 
the System Setup window. 
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The findings sentences also include Left vs. Right side comparison data for NCV, 
F Wave, and H-Reflex test protocols. 

When an NCV, F Wave, or H-Reflex table node is highlighted in the TabData 
window, the findings sentences for those test protocols will be displayed at the 
bottom of the window.  When an EMG table node is highlighted, the EMG 
findings sentences will be displayed. 

 

NCV node highlighted and the NCV, F Wave, and H-Reflex sentences shown at the bottom of the 
TabData window. 
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Muscle Scoring Table node highlighted and EMG sentences shown below the scoring table. 

 

How to enable the Sentence Generator feature: 

The integrated sentence generator is enabled in the System Setup window 
(shown below).  From the Edit menu, select System Setup.  Check the 
Sentence Generator box and then click OK. 
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How to include the Sentence Generator findings in a Report: 

In order to include the Sentence Generator findings in your report, your 
QuickReport template must contain the sentence generator items.  The factory 
default template, named “Full Report with Sentence Gen”, already includes these 
items. 
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Item list for the template named “Full Report with Sentence Gen”. 

Note the arrow pointing to the NCV and EMG Sentence Gen items. 

 

Sentence Generator Setup for NCV, F Wave, and H-Reflex 

When the NCV, F, H findings sentences are displayed a Sentence Setup button 
will be shown in the lower right hand corner of the TabData window.  Click on this 
button to make changes to the wording used by the NCV/F/H sentence 
generator. 
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NCV, F Wave, and H-Reflex sentence generator setup window. 

Sentence Phrasing for NCV/F/H: 

Click on the tab at the top of the window corresponding to the part of the 
sentence you want to modify.  You can simply type into the First Sentence, 
Abnormal Single & Plural, Normal Single & Plural, and Summary Sentences 
boxes. 

First Sentence – the words used to begin the findings paragraph. 

Abnormal and Complete Description Phrasing – the words used to begin a 
sentence when a result is abnormal. 

Normal Phrasing – the words used to begin a sentence when a result is 
normal. 

Summary Sentences – the sentence that is used to describe any remaining 
normal nerves (after the abnormal nerves have been individually described 
first), or when all nerves tested are found to be normal. 
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Sentence Meanings for Complete Descriptions: 

Value Name, Meaning 1 & Meaning 2 

Click on the underlined words in the Complete Descriptions table to change 
the words used to describe the abbreviated measurement name and value 
meaning (normal or abnormal meaning) for that measurement.  The defined 
meaning is used in front of the value name in the sentence.  For example, 
“The median motor nerve showed normal distal onset latency”. 

Severity Meanings 1-3 (Optional) 

These fields allow you to specify additional wording to use in the findings 
sentence when a value is abnormal.  For example, "the distal latency was 
mildly prolonged" rather then simply "the distal latency was prolonged". 
 These additional words can be manually selected for each abnormal value or 
the program can apply them automatically if the normal values for a nerve are 
configured appropriately.  For more information on using the Abnormal 
Severity feature, click here. 

Organization Options: 

Include Values – when enabled the sentence will contain the latency, 
amplitude, and/or velocity value of the nerve in brackets.  Evaluation of the 
Right Median Motor nerve showed prolonged distal onset latency (4.3 ms). 

Group – combines multiple nerves into one sentence when they have the 
same abnormality. Evaluation of the Left Median Motor and the Right Median 
Motor nerves showed prolonged distal onset latency. 

Show All if Abnormal – when a nerve has an abnormal value the sentence 
will also comment on the nerve‟s normal values.  Evaluation of the Right 
Median Motor nerve showed prolonged distal onset latency (4.3 ms), normal 
amplitude (14.9 mV), and normal conduction velocity (Elbow-Wrist, 51.8 m/s). 

Abnormal First – use in combination with the Use Normal Phrasing 
parameter to force abnormal nerves to be described before normal nerves. 

Sort by Nerve Name - sorts the sentences alphabetically by nerve name. 
 For example, all the sentences regarding the median nerve, then the 
sentences regarding radial nerve, and finally all the sentences pertaining to 
the ulnar nerve. 

Normals Options: 

These settings determine how normal nerves are described in the findings 
sentences. 

Skip Normals – does not include any sentences for normal nerves. 
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Use Summary Sentences – when there is at least one abnormal nerve, or 
when all nerves are normal, the sentence will include the summary sentence 
text.  All remaining nerves (as indicated in the following tables) were within 
normal limits. 

Use Normal Phrasing – when a nerve is normal, the normal phrasing will be 
used to describe it.  The Right Ulnar Motor nerve was unremarkable. 

Use Complete Description – uses the value name and meanings from the 
Complete Description table to describe normal nerves.  The Right Ulnar Motor 
nerve showed normal distal onset latency (3.0 ms), normal amplitude (5.9 
mV), normal conduction velocity (B Elbow-Wrist, 54.0 m/s), and normal 
conduction velocity (A Elbow-B Elbow, 56.0 m/s). 

Formatting Options: 

These settings determine how the sentences are formatted in the report. 

Single Paragraph - the findings sentences will be grouped into a single 
paragraph. 

 

Unformatted List - the findings sentences will appear in list format but 
without bullets or numbers. 
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Bulleted List - the findings sentences will be formatted into a bulleted list. 
 Microsoft Word's default bullets will be used. 

 

Numbered List - the findings sentences will be formatted into a numbered 
list.  Microsoft Word's default numbering format will be used. 

 

Capitalize Side [Left/Right] 

Check this box to have the side (Left or Right) automatically capitalized within 
the generated sentences. 

Bold Side & Nerve Names 

Check this box to have the side and nerve name displayed in bold text within 
the generated sentences. 

Include L-R Sentences 

Check this box to include the Left vs. Right side differences within the 
generated sentences. 

 

Customize Muscle/Nerve Names 

Clicking on this button opens a window where you can specify alternate 
wording that can used for each EMG muscle, NCV Nerve Type, and NCV 
Nerve.  This feature allows for complete names to be used within the 
sentences while keeping the abbreviated names for use in results tables. 
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The columns on the left (Sierra Name) are the abbreviated names from the 
user's setup file.  Enter the complete names for each muscle or nerve in the 
right hand column (Sentence Generator Name), these names will be used in 
the sentence generator.  If a Sentence Generator Name is left blank, then the 
system will continue to use the name from the Sierra Name column. 

Clicking OK saves this information to a file in the user's setup folder.  This file 
is named "SentenceGenMap.xml" and is automatically included in the 
Preserve & Restore functions. 

 

Sentence Generator Setup for EMG 

When the EMG findings sentences are displayed, a Sentence Setup button will 
be displayed in the lower right hand corner of the TabData window.  Click on this 
button to make changes to the wording used by the EMG sentence generator. 
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EMG sentence generator setup window. 

Synchronize Button: 

If you have modified the original factory default muscle scoring options you 
will need to click this button the first time you enter the EMG Sentence Setup. 
 This will import the new or modified scoring options from your EMG test 
protocol so that you can assign categories and meanings to those options. 

Sentence Phrasing for EMG: 

First Sentence – the words used to begin the EMG findings paragraph. 

Abnormal and Complete Description Phrasing – the words used to begin a 
sentence when a muscle is abnormal. 

Normal Phrasing – the words used to begin a sentence when a muscle is 
normal. 

Summary Sentences – the sentence that is used to describe any remaining 
normal muscles (after the abnormal muscles have been individually described 
first), or when all muscles tested are found to be normal. 

Sentence Meanings for Complete Descriptions: 

Click on the underlined words in the Complete Descriptions table to change 
the words used to describe the abbreviated value name, category name, and 
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value meaning for the muscle scoring column.  The defined meaning is used 
in combination with the category name in the sentence.  For example, if the 
APB muscle had 2+ Fibs the sentence would be, “The Right Abd Poll Brev 
showed moderately increased spontaneous activity.   Fibs has been assigned 
to a category called “spontaneous activity” and the value of 2+ has been 
assigned a meaning of “moderately increased”. 

Include Values – when enabled the sentence will contain the actual scoring 
values in brackets.  Needle evaluation of the Right Abd Poll Brev showed 
increased insertional activity (Incr Ins Act) and moderately increased 
spontaneous activity (2+ Fibs, 1+ PSW's). 

Organization Options: 

Group – combines multiple muscles into one sentence when they have the 
same abnormality.   Needle evaluation of the Right Abd Poll Brev and the 
Right ABD Dig Min showed moderately increased spontaneous activity. 

Show All if Abnormal – when a muscle has an abnormal value the sentence 
will also comment on the muscle‟s normal values.  Needle evaluation of the 
Right Abd Poll Brev showed increased insertional activity, moderately 
increased spontaneous activity, normal motor unit amplitude, normal motor 
unit duration, no polyphasic potentials, normal recruitment, and normal 
interference pattern. 

Abnormal First – use in combination with the Use Normal Phrasing 
parameter to force abnormal muscles to be described before normal muscles. 

Normals Options: 

These settings determine how normal muscles are described in the findings 
sentences. 

Skip Normals – does not include any sentences for normal muscles. 

Use Summary Sentences – when there is at least one abnormal muscle, or 
when all muscles are normal, the sentence will include the summary sentence 
text.  All remaining muscles (as indicated in the following table) showed no 
evidence of electrical instability. 

Use Normal Phrasing – when a muscle is normal, the normal phrasing will 
be used to describe it.  The Right Deltoid was unremarkable. 

Use Complete Description – uses the category name and meanings from 
the Complete Description table to describe normal muscles. The Right Deltoid 
showed normal insertional activity, normal spontaneous activity, normal motor 
unit amplitude, normal motor unit duration, no polyphasic potentials, normal 
recruitment, and normal interference pattern. 
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Formatting Options: 

These settings determine how the sentences are formatted in the report. 
 See examples shown above for the NCV sentences. 

Single Paragraph - the findings sentences will be grouped into a single 
paragraph. 

Unformatted List - the findings sentences will appear in list format but 
without bullets or numbers. 

Bulleted List - the findings sentences will be formatted into a bulleted list. 
 Microsoft Word's default bullets will be used. 

Numbered List - the findings sentences will be formatted into a numbered 
list.  Microsoft Word's default numbering format will be used. 

Capitalize Side [Left/Right] 

Check this box to have the side (Left or Right) automatically capitalized within 
the generated sentences. 

Customize Muscle/Nerve Names 

Clicking on this button opens a window where you can specify alternate 
wording that can used for each EMG muscle, NCV Nerve Type, and NCV 
Nerve.  This feature allows for complete names to be used within the 
sentences while keeping the abbreviated names for use in results tables. 
 See the complete description above in the Setup for NCV Sentences. 

Making Changes to Test Results 

While viewing the TabData window, the Sentence Generator will 
automatically update the findings sentences as soon as changes are made to 
the EMG muscle scoring or to the cursor positions on NCV, F Wave, or H-
Reflex traces. 

Using Abnormal Severity Meanings 

This feature gives a user the ability to specify an abnormal value‟s degree of 
abnormality (e.g., mildly increased, moderately increased, or severely increased) 
for a latency value rather than simply having the findings sentence indicate that a 
latency is only „increased‟. 

You can define the wording used for up to 3 severity ranges in the NCV 
Sentence Setup window and this feature can be automated by using a range of 
values for the normal value of a nerve. 

Abnormal Severity Setup 
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In the NCV Sentence Setup window there are three columns for specifying 
the degree of abnormality.  The columns are titled Severity Meaning 1, 
Severity Meaning 2, and Severity Meaning 3. 

These columns allow you to specify the additional wording that can be used in 
the findings sentence when a value is found to be abnormal.  You can fill-in 
some, all, or none of rows in these columns. 

 To open the NCV Sentence Setup window, go to the TabData window 
and select the top level NCV node in the left hand column.  Click on the 
Sentence Setup button shown in the lower right hand corner. 

 

NCV Sentence Setup window. 

 

How to use the Abnormal Severity Meanings 

In either the NCV Acquisition screen or from within the TabData window (if 
the individual nerve‟s node is highlighted in the left hand column) right click 
over the abnormal value to display a list of possible meanings.  The following 
example shows the result of right clicking over an abnormal Onset Latency. 
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An asterisk (*) indicates the sentence generator‟s currently assigned default 
meaning.  You can override the default meaning by selecting one of the 
additional abnormal meanings from the list.  You can also override the 
program and set the meaning  for the value to Normal. 

When an abnormal meaning other than the default is selected, a check mark 
appears next to that meaning.  To remove a selection, simply click on that 
meaning again and the check mark will be deleted. 

 

Meaning changed to "moderately". 

Right clicking over an abnormal Amplitude or Velocity value will list 
appropriate selections for those values. 
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Right click over Amplitude value. 

 

 

Right click over Velocity value. 

 

In the following example, the default meaning for both the distal peak latency 
and conduction velocity of the Right Median Anti-Sensory nerve were 
changed to “moderately”. 

 

 

Automating this feature using Normal Value Ranges 

The selection for the sentence‟s abnormal meaning can be automated by 
specifying a range of values in the norm field of a nerve.  Up to three ranges 
can be specified that correspond to Severity Meaning 1, Severity Meaning 2, 
and Severity Meaning 3.   

After the initial normal value is specified (e.g. <4.2) commas can be used to 
setup the additional abnormal ranges for the sentence generator. 

The following example shows how this can be done for the Onset, Amplitude, 
and Velocity measurements of the Median Motor nerve. 
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 Using <4.2,5,6 for the Onset normal value sets up the following 
ranges. 

<4.2 sets the normal limit.  (Anything greater than this value is 
flagged as abnormal). 

4.3 – 5.0 represents the #1 severity range (i.e., mildly increased). 

5.1 – 6.0 represents the #2 severity range (i.e., moderately 
increased). 

6.1 and above represents the #3 severity range (i.e., severely 
increased). 

 To determine what the three Latency ranges will be, use 
the following formula. 

Severity Range #1 = 1st value (plus 0.1) to 2nd 
value. 

Severity Range #2 = 2nd value (plus 0.1) to 3rd 
value. 

Severity Range #3 = 3rd value (plus 0.1) and above. 

 

 Using >5,4,2.5 for the distal Amplitude normal value sets up the 
following ranges. 
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>5 sets the normal limit.  (Anything less than this value is flagged 
as abnormal). 

4.9 – 4.0 represents the #1 severity range (i.e., mildly decreased). 

3.9 – 2.5 represents the #2 severity range (i.e., moderately 
decreased). 

2.4 or less represents the #3 severity range (i.e., severely 
decreased). 

 To determine what the three Amplitude ranges will be, 
use the following formula. 

Severity Range #1 = 1st value (minus 0.1) to 2nd 
value. 

Severity Range #2 = 2nd value (minus 0.1) to 3rd 
value. 

Severity Range #3 = 3rd value (minus 0.1) or less. 

 

 Using >50,45,40 for the distal Velocity normal value sets up the 
following ranges. 

>50 sets the normal limit.  (Anything less than this value is flagged 
as abnormal.) 

49 – 45 represents the #1 severity range (i.e., mildly decreased). 

44 – 40 represents the #2 severity range (i.e., moderately 
decreased). 

39 or less represents the #3 severity range (i.e., severely 
decreased). 

 To determine what the three Velocity ranges will be, use 
the following formula. 

Severity Range #1 = 1st value (minus 1) to 2nd 
value. 

Severity Range #2 = 2nd value (minus 1) to 3rd 
value. 

Severity Range #3 = 3rd value (minus 1) or less. 
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 If only two values are used for a norm, such as <4.2,6.5 for 
latency. 

<4.2 sets the normal limit. 

4.3 – 6.5 represents the #1 severity range (i.e., mildly prolonged). 

6.6 and above represents the #2 severity range (i.e., moderately 
prolonged). 

Severity #3 is not used. 

 

 If only one value is used for a norm, such as <4.0 for latency. 

For a latency value of 4.1 or higher the findings sentence will use 
the default meaning, “prolonged onset latency”. 

 

 Normal value ranges are hidden in the acquisition view unless the 
norm field is selected with the mouse for editing purposes.  The ranges 
are also hidden in the TabData window and in final reports. 
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EP Sentence Generator 

The Sentence Generator feature, which is used to automatically create findings 
sentences, is integrated into the Sierra Wave‟s TabData window.  This gives the 
user the ability to simultaneously view the patient‟s tabulated test results and the 
findings sentences.  This is an optional feature which can be turned On or Off in 
the System Setup window. 

When an Evoked Potential (SEP, AEP, or VEP) node is highlighted in the 
TabData window, the findings sentences for that test protocol will be displayed at 
the bottom of the window. 

 

Median SEP node highlighted and the findings sentences shown at the bottom of the TabData 
window. 



Sierra Wave Help Manual 

954 

 

How to enable the Sentence Generator feature: 

The integrated sentence generator is enabled in the System Setup window 
(shown below).  From the Edit menu, select System Setup.  Check the 
Sentence Generator box and then click OK. 

 

 

How to include the Sentence Generator findings in a Report: 

In order to include the EP Sentence Generator findings in your report, your 
QuickReport template must contain the EP sentence generator items. 
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Item list for the template named “Full Report with Sentence Gen”. 

Note the arrows pointing to the EP Sentence Gen items. 

If you don't have the EP Sentence Gen items in your report item list - 
they can be imported from the software installation CD.  Please contact 
the Applications Support Department for instructions on how to do this. 

 

Sentence Generator Setup for Evoked Potentials 

When the Evoked Potential findings sentences are displayed a Sentence Setup 
button will be shown in the lower right hand corner of the TabData window.  Click 
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on this button to make changes to the wording used by the EP Sentence 
Generator. 

 

Evoked Potential sentence generator setup window. 

Normals - these settings determine how normal values are described in the 
findings sentences. 

Use Normal Phrasing & Summaries – when there is at least one abnormal 
value or one abnormal L-R difference, the sentence will include the summary 
sentence text.  Measurements for the right side showed increased N20-N13 
interpeak latency. All remaining measurements for the right side were within 
normal limits.  All measurements for the left side were within normal limits.  All 
L-R differences were within normal limits. 

Normal Phrasing – the words used to end a sentence when a single 
value or all values are normal (the Use Normal Phrasing & Summaries 
option must be selected). 

Normal Summary Sentences 

 Single Side - summary sentence used to describe the 
remaining normal values for one side. 

 Some L-R Differences - summary sentence used to 
describe the remaining L-R side difference normal values. 
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 All L-R Differences - summary sentence used when all L-R 
side difference values are normal. 

Use Complete Description – uses the value name and meanings from the 
Complete Description table to describe the normal values.   Measurements 
for the right side showed normal N20 latency, normal N13 latency, normal 
N10 latency, increased N20-N13 interpeak latency, normal N13-N10 
interpeak latency, and normal N20-N10 interpeak latency. 

Abnormals - these values always use the Complete Descriptions. 

Formatting Options: 

These settings determine how the sentences are formatted in the report. 

Single Paragraph - the findings sentences will be grouped into a single 
paragraph. 

 

Unformatted List - the findings sentences will appear in list format but 
without bullets or numbers. 

 

Bulleted List - the findings sentences will be formatted into a bulleted list. 
 Microsoft Word's default bullets will be used. 

 

Numbered List - the findings sentences will be formatted into a numbered 
list.  Microsoft Word's default numbering format will be used. 
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Sentence Meanings for Complete Descriptions: 

Value Name (Single), Value Name (Plural), Meaning 1 & Meaning 2 

Click on the underlined words in the Complete Descriptions table to change 
the words used to describe the abbreviated measurement name and value 
meaning (normal or abnormal meaning) for that measurement.  The defined 
meaning is used in front of the value name in the sentence.  For example, 
"Measurements for the right side showed normal N20 latency." or 
"Measurements for the right side showed increased N20 latency." 

 

Organization Options: 

Include Values – when enabled the sentence will contain the actual latency, 
amplitude, interpeak latency, and L-R difference numbers in the sentence. 
 See example above in the TabData window. 

Group Sides – combines values from each side into one sentence when they 
have the same abnormality.  The right and left N20 latencies (R19.8, L19.4 
ms) were normal. 

Group L-R Differences – adds the L-R difference sentences to the same 
paragraph that is describing the individual side values.  The right and left N20 
latencies (R19.8, L19.4 ms) and right vs. left latency difference (0.4 ms) were 
normal. 

 

 

Editing the Sentences 

Below each sentence is a Reset, Edit, and Save button.  Click the Edit 
button if you want to make changes or additions to the generated sentences. 
 The background of the sentence area will change to white color, signifying 
that you are in the Edit mode.  The formatting controls above the sentence 
area will also be activated. 
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Edit mode. 

Click within the sentence area and make your changes/additions. 

 

Edit mode with changes shown in red text. 

To save your changes, click the Save button.  The background will turn 
green, this signifies that editing has been performed and those 
changes/additions have been saved. 

 

Changes to the sentences have been saved. 

To cancel your changes or additions, click the Reset button.  The sentence 
is returned to its default state and the background color changes back to the 
non-edit mode color. 
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Sentence has been reset to default state. 

Adjusting Cursors 

Adjusting Auto Cursor Positions 

Begin by highlighting an individual test protocol, such as Right Median Motor. 
 The test's traces and cursor table will be displayed on the right-hand side of 
the window. 

Click on a cursor using the left mouse button and drag it along the trace to its 
new location.  The information in the cursor table will be updated to reflect the 
new position. 

Trace Context Menu 

Trace Context (pop-up) Menu 

Whenever traces are displayed in the right-hand side of the TabData window 
you can right-click the mouse over the trace area to display the same context 
menu that is available during data acquisition. 

Use this context menu to delete traces, smooth traces, etc. 

Changing Muscle Scoring 

Change Muscle Scoring 

If an EMG Muscle Scoring Table is selected you can change the muscle 
scoring selections for a muscle simply by clicking with the left mouse button 
within the table. 
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Sorting Muscle Scoring Table 

Sorting Muscle Scoring Table 

If an EMG Muscle Scoring Table is selected you can click the mouse at the 
top of any of the table's columns to sort the table according to that column's 
information.  To reverse the sorting, right-click the mouse over the muscle 
scoring table and select "Original Sort Order" from the pop-up menu. 

Override an Abnormal Value 

You can override the abnormal value flag when you believe that a value is 
actually within acceptable limits.  This function can be performed from the main 
acquisition screen for the nerve, or from within the TabData window if the 
individual nerve‟s node is highlighted in the left hand column. 

Simply right-click the mouse over the abnormal value, then select Set as 
Normal from the pop-up menu.  The abnormal flag (red color or bold text) will be 
removed. 

 

Median motor cursor table. 

If you make a mistake, right click over the value again, and then remove the 
check mark next to Set as Normal.  The abnormal flag will return. 

This feature is also available in EP cursor tables. 

 

Tibial SEP cursor table. 
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Swap Sides in TabData 

Swap Sides 

When an individual NCV, F Wave, H Reflex, or RNS test protocol is selected 
the Swap Side button can be used to swap the side parameter of the selected 
test. 

 If the side you are swapping to doesn't already exist within the Study 
window, then that nerve will automatically be added. 

 If the side you are swapping to already has stored traces, then a second 
run will be automatically added to that existing nerve. 

Playback EMG Buffer 

When a stored EMG Buffer is selected, the compressed buffer trace will be 
shown in the right hand portion of the TabData window.  Use the playback 
controls to replay the buffer without having to open the EMG test protocol. 
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TabData window with stored EMG Buffer selected. 

 

EMG Buffer Playback Controls. 

 

Buffer Playback Controls. 

Go back one page. 

Go forward one page. 

Go back one division. 

Go forward one division. 

Start EMG playback. 

Stop EMG playback. 
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Report Options 

This button allows you to remove some elements from generated reports without 
removing them from the data acquisition screen or the TabData Summary view. 

Clicking on the Report Options button displays the following window: 

 

 Flag Abnormals in Reports - when this box is checked abnormal values 
will be indicated in reports, usually as red colored boxes or bolded 
numbers. 

 Show Comments (NCV, F, H) - when this box is checked comments 
entered during NCV, F Wave, or H Reflex data acquisition will be 
displayed in the data tables of generated reports. 

 Show Norm Columns (NCV, F, H) - when this box is checked the normal 
value columns for NCV, F Wave, and H Reflex tests will be included in the 
data tables of generated reports. 

 Show Column Header Shading - when this box is checked the column 
headings at the top of each table are shaded gray. 

 Show Outside Table Lines - when this box is checked a line is drawn 
between each nerve and a box is drawn around the entire table.  If this 
box is unchecked, only the column heading row will remain underlined. 

 Show All Vertical Table Lines - when this box is checked a vertical line 
is drawn between each table column. 
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 Show All Horizontal Table Lines - when this box is checked a horizontal 
line is drawn between each table row. 

 Convert Red Background to Grey (Best for Fax) - when this box is 
checked the abnormal values, that are usually shown as red colored 
boxes in reports, will be changed to grey colored boxes.  This is more 
suitable for reports that are being faxed to the referring physician. 

 

 The Report Options button can also be accessed in the System Setup 
window. 

Print A Report 

Print a Report 

Two buttons, representing the Print and Report keys on the Sierra Wave base 
unit, are displayed at the bottom of the TabData window.  The name of the 
report template that is currently assigned to these buttons is displayed as the 
button's label. 

To initiate a report. 

 Click on one of these two buttons with the mouse. 

 Press either the F2 or F3 function key on the PC's keyboard. 

 Press the Print or Report keys on the Sierra Wave base unit. 

Opening a Test 

Open a Test Protocol 

To open a test protocol and display the acquisition screen (this would be 
necessary to re-stimulate or collect additional traces), perform one of the 
following. 

 Highlight the test protocol by turning Knob #1 (Select / Open) and 
then press to open. 

 Highlight the test protocol and then click the Open Test button. 

 Double click on the test protocol with the mouse. 
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Closing TabData 

Close the TabData window 

To close the TabData window and return to the previous test protocol screen, 
perform one of the following. 

 Click on the F4 (Close) button. 

 Press the F4 (Close) function key on the Sierra Wave base unit. 

 Click on the TabData window's red X  . 
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AnatomyVIEW 

AnatomyVIEW Window Overview 

The AnatomyVIEW feature allows the EMG muscle scoring data and Nerve 
Conduction results to be displayed on a 3D color-coded anatomical model.   

To open the AnatomyVIEW window, perform one of the following: 

 Click on the AnatomyVIEW button in the test controls toolbar. 

 

 Select AnatomyVIEW from the View menu. 

 

It takes about 8-10 seconds for the AnatomyVIEW window to open the 
first time it is selected.  The window will open much faster after this, as long 
as the Sierra Wave program is not closed.  The reason for this is that the 3D 
modeling data has to be decrypted each time it is used, this is per the 
licensing agreement with the supplier of the 3D models. 
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AnatomyVIEW window. 

 

Scenes: 

Muscle Data: 

The AnatomyVIEW window is composed of 3 scenes; Anterior, Posterior, 
and Cervical / Lumbo-Sacral.  The Cervical / Lumbo-Sacral scene is 
intended to show the paraspinal muscles. 

Nerve Data: 

The AnatomyVIEW window is composed of 2 scenes; Anterior and 
Posterior. 

 

Size and Position: 

The size and position of the AnatomyVIEW window is stored by the Sierra Wave 
program.  So, if you resize or move the window, it will return to this state the next 
time it is opened. 
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Window Controls: 

Various controls and buttons for configuring the setup of the window are shown 
across the top of the display, the bottom left hand corner contains a color key for 
the muscle scoring data.  

 

Controls 

 

Muscle Data Color Key 

 

Nerve Data Color Key 

Closing the Window: 

 Click on the Close button. 

 Click on the red X in the upper right corner. 

The AnatomyVIEW window must remain open (or minimized) in order to 
make the graphic available for QuickReport.  Simply minimize AnatomyVIEW 
before launching the report generator. 

 

What happens if a muscle is not available in viewer? 

If you score a muscle that is not available in the AnatomyVIEW window, or 
the muscle has not had any viewer muscles mapped to it, the following 
message box will be displayed upon opening the AnatomyVIEW window. 

 

Message box indicating that the Left Soleus cannot be displayed in the AnatomyVIEW. 
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AnatomyVIEW Controls 

Various controls and buttons for configuring the setup of the AnatomyVIEW 
window are shown across the top of the display. 

 

Muscle Data Controls 

 

Nerve Data Controls 

Changing Views: 

To change the view shown in the window, click on the View drop-down list and 
then select a different view from the list. 

 

 

Using the Mouse Tools: 

The mouse tools can be used to move, rotate, and zoom in & out on each model 
in a scene.  A reset tool allows you to quickly return the models in all scenes to 
their default positions. 

Move Tool - this is the default tool.  Left click and drag within a scene to 
move the model within that scene up or down. 

Free Rotate Tool - use this tool to rotate the model in the X or Y plane. 
 After selecting this tool, left click and drag within a scene to rotate the model 
within that scene in the X or Y plane. 

Reset Tool - click on this button to return all 3 scenes to their default 
positions. 
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Expand Tool - use this tool to expand the selected scene to fit the 
entire width of the AnatomyVIEW window.  Click on this tool a second 
time to return the scene to its original size. 

Zoom Tool - the mouse wheel is used for this tool.  Turn the mouse wheel to 
zoom in or out on a model in the selected scene. 

When a scene is selected its background color will be shown in a slightly 
lighter color than the other scenes. 

The Whole Body view only contains two scenes, Anterior and Posterior. 

 

Animate Abnormals: 

When checked abnormal nerve segments will flash on & off on the nerve data 
tab. 

 

Tool Tips: 

Position the mouse over a muscle to view a Tool Tip containing the muscle name 
and any associated muscle scoring abnormalities. 

 

Mouse over biceps muscle with resulting tool tip. 

Position the mouse over an abnormal nerve segment to view a Tool Tip 
containing the segment name and any associated abnormalities. 
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Mouse over median wrist segment with resulting tool tip. 

Display Options: 

Clicking on the Display Options button will open a new window that contains 
several options for changing the appearance of the AnatomyVIEW and also 
allows for configuration of the muscle scoring data (i.e., how the color coding is 
setup). 
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Display Options window. 

Show Options 

 Nerves - when selected the nerve layer will be shown within each 
scene. 

 Bones - when selected the bone layer will be shown within each 
scene. 

 Study Muscles - when selected the muscles that have been scored in 
the EMG test protocol will be shown within each scene. 

 Study Nerve Segments - when selected the nerve segment results 
will be shown within each scene. 

 Tool Tips or All Muscles - these options are mutually exclusive, only 
one can be enabled at a time. 

o Tool Tips - when selected the tool tip will be displayed when 
the mouse hovers over a scored muscle. 

o All Muscles - when selected all the muscles supported by the 
viewer will be displayed. 
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 Transparency Slider - move left or right to adjust the 
opacity of the muscles.  Moving the slider all the way to 
the right will make the muscles completely opaque (i.e., 
solid). 

 

Background Color 

Click on the drop down list to change the background color of the view. 
 Choices are Black, Dark Blue, and White.  This selection is remembered by 
the program and will default to whatever you choose. 

Use the check box to set the background color in reports to white, allowing 
the background color on-screen to remain set to black or dark blue. 

 

Muscle Scoring Configuration 

Clicking on the Muscle Scoring Configuration  button opens a new window 
that contains the weighting factors that are used to determine how muscle 
scoring abnormalities are color coded. 

A weighting factor is assigned to each muscle scoring column and are used to 
compute a composite score for each muscle, the higher the composite score 
the higher the color coding on the abnormal scale.   
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Muscle Scoring Configuration window. 

 Column Name - shows the muscle scoring columns from the 
current user's EMG test protocol. 

 Weighting - click on the drop-down arrow to assign a weighting 
factor to each muscle scoring column.  The weighting factors are 
used to compute a composite score for each muscle.  The higher 
the composite score, the higher color coding on the abnormal 
scale. 

o Linear (0-4) - use this factor for columns that use a linear 
scoring scale.  For example, the Fibs column has choices of 
Normal, 1+, 2+, 3+, 4+.  This is a linear scale with the most 
abnormal value being 4+. 

o Equal (1), Equal (2), Equal (3), Equal (4) - use these factors 
for columns that do not use a linear scoring scale.  For 
example, the Ins Act column has choices of Normal, 
Increased, or Decreased.  Choosing either Increased or 
Decreased are equally an abnormal sign, this would be a 
good example for using the Equal (2) weighting factor. 
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 Choosing either one is about the same as a 2+ on a linear 
scale. 

o None - use this setting for columns that should be ignored 
when computing the composite score for a muscle. 

o Ongoing or Chronic Process - these check boxes are used in 
combination with the Abnormality button described below.  You 
can categorize each scoring column as either Ongoing (acute) or 
Chronic.  Typically, fibrillation potentials are evidence of an ongoing 
process while changes in amplitude are evidence of a chronic 
process. 

Clicking OK saves this information to a file in the user's setup folder.  This 
file is named "AnatomyScoreMap.xml" and is automatically included in the 
Preserve & Restore functions. 

 

Viewing by type of Abnormality (Muscle Data only): 

Click on the All Abnormalities button to toggle the view to show only Ongoing 
(acute) or Chronic Processes.  Only those muscles showing abnormalities 
matching the current button setting will be displayed within the view. 

 

AnatomyVIEW Setup - Muscle Data 

The AnatomyVIEW feature allows the EMG muscle scoring data to be displayed 
on a 3D color-coded anatomical model. 

The Sierra Wave is very flexible in that each user can create and name their own 
muscles and change the name of factory default muscles.  Therefore, the 
program must be able to match each users name for a muscle to the muscle ID 
that is recognized by the AnatomyVIEW window.  This is done using the Muscle 
Map Editor. 

To open the Muscle Map Editor: 

1. From the Edit menu select Test Menu.  When the Test Menu Setup 
window is displayed click on the EMG test protocol in the test list.  The 
EMG test protocol settings will be displayed on the right hand side of 
the screen. 

2. Click on the AnatomyVIEW Muscle Map button.  The Muscle Map 
Editor window will be displayed. 
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Muscle Map Editor window. 

Column Descriptions: 

 Sierra Muscle - this column shows the user's muscle list, as read 
from the EMG test protocol setup window. 

 Right Mapped IDs - this column shows the muscle ID's from the 
Viewer that have been assigned to this muscle for the right side. 

 Left Mapped IDs - this column shows the muscle ID's from the 
Viewer that have been assigned to this muscle for the Left side.  

 Muscles Available in AnatomyVIEW - this column lists all the 
muscle IDs that the Viewer is able to display. 

 

To  Map a Viewer Muscle ID to a Muscle: 

1. Find the appropriate muscle ID in the Viewer List. 

2. Left click on the muscle ID and drag it over to the appropriate 
Right or Left Mapped ID cell. 

3. Release the mouse button to drop the muscle ID into the cell. 
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Click and Drag muscle available in Viewer and drop into appropriate user muscle. 

 

To Map Multiple Viewer Muscle IDs to a Muscle: 

You may want to map more than one Viewer muscle to a muscle in 
your muscle list.  For example, when you score the Biceps muscle, you 
may want both the Lateral Biceps and the Medial Biceps to be 
highlighted in the AnatomyVIEW window.  This can be done by 
mapping multiple viewer muscles to the muscle in your list. 

Simply click and drag multiple muscle IDs from the viewer list and drop 
them onto the muscle.  You can click on the drop-down arrow to view 
all the muscles that have been mapped to your muscle. 
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The Viewer's Lateral & Medial Biceps have both been mapped to the user's Biceps 
muscle. 

 

To Clear an Assignment: 

1. Highlight the appropriate cell by clicking on it with the mouse. 

2. Click on the Clear button. 

 

To Clear All Assignments: 

1. Click on the Clear All button. 

 

To Save the Assignments: 

1. Click on the OK button. 

 The muscle mapping data is saved to a file in the user's setup 
folder.  This file is named "MuscleMap.xml" and it is automatically 
included in the Preserve & Restore functions. 

 

What happens if a muscle is not available in viewer? 

If you score a muscle that is not available in the AnatomyVIEW window, or 
the muscle has not had any viewer muscles mapped to it, the following 
message box will be displayed upon opening the AnatomyVIEW window. 

 

Message box indicating that the Left Soleus cannot be displayed in the AnatomyVIEW. 

 

Click the OK button, the AnatomyVIEW will display those muscles that are 
available. 
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Nerve Data Setup 

The AnatomyVIEW feature allows the NCV nerve segment data to be displayed 
on a 3D color-coded anatomical model. 

The Sierra Wave is very flexible in that each user can create and name their own 
nerves, sites, and segments; and change the name of factory default nerves. 
 Therefore, the program must be able to match each users name for a nerve 
segment to the nerve segment ID that is recognized by the AnatomyVIEW 
window.  This is done using the Nerve Map Editor. 

To open the Nerve Map Editor: 

1. From the Edit menu select Test Menu.  When the Test Menu Setup 
window is displayed click on the NCV test protocol in the test list.  The 
NCV test protocol settings will be displayed on the right hand side of 
the screen. 

2. Click on the General Settings tab. 

3. Click on the AnatomyVIEW Nerve Map button.  The Nerve Map 
Editor window will be displayed. 

 

Nerve Map Editor window. 
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Column Descriptions: 

 Sierra Nerve List - this column shows the user's nerve list, as read 
from the NCV test protocol setup window.  Only those sites and 
segments with corresponding normal values (latency, amplitude, or 
velocity) are shown in the list. 

 Right Mapped IDs - this column shows the nerve segment ID's 
from the Viewer that have been assigned to this site/segment for 
the Right side. 

 Left Mapped IDs - this column shows the nerve segment ID's from 
the Viewer that have been assigned to this site/segment for the Left 
side.  

 Nerve Segments Available in AnatomyVIEW - this column lists 
all the nerve segment IDs that the Viewer is able to display. 

 

To  Map a Viewer Nerve Segment ID to a Site/Segment: 

1. Find the appropriate nerve segment ID in the Viewer List. 

2. Left click on the nerve segment ID and drag it over to the 
appropriate Right or Left Mapped ID cell. 

3. Release the mouse button to drop the nerve segment ID into the 
cell. 

 

Click and Drag nerve segment available in Viewer and drop into appropriate user site/segment 

 

To Clear an Assignment: 

1. Highlight the appropriate cell by clicking on it with the mouse. 

2. Click on the Clear button. 
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To Clear All Assignments: 

1. Click on the Clear All button. 

 

To Save the Assignments: 

1. Click on the OK button. 

 The nerve mapping data is saved to a file in the user's setup 
folder.  This file is named "NerveMap.xml" and it is automatically 
included in the Preserve & Restore functions. 

 

 

Including in Reports 

The AnatomyVIEW graphic can be included in reports.  Simply launch 
QuickReport and select a template that contains the report items needed in order 
to include the AnatomyVIEW graphic and color code.  The factory default 
template "Full Report with SG and AV" is one example. 

 

The AnatomyVIEW window must remain open (or minimized) in order to 
make the graphic available for QuickReport.  Simply minimize AnatomyVIEW 
before launching the report generator. 

 Four report items are typically needed in the report template, they are 
the Sierra item "Anatomy Graphic (Muscles)", the Sierra item "Anatomy 
Graphic (Nerves)", the Paragraph  item "AnatomyVIEW Label", and the Insert 
item "AnatomyVIEW Key (ALL)". 

 

Report Items for AnatomyVIEW. 
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Please refer to the help topics within the QuickReport program for instructions 
on how to add these items to an existing report template. 

 

Example report with AnatomyVIEW included. 

 

Set the Default View 

To Assign the default AnatomyVIEW for a Study: 

1.  From the Edit menu, select Study Menu to display the Study Menu 
Setup window. 
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2.  Right click over the name of the Study and select AnatomyVIEW Setup 
from the pop-up menu.  The AnatomyVIEW Setup window will be 
displayed. 

 

 

3.  Select the default view and then click the OK button. 
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DataLAB 

DataLAB Overview 

The DataLAB window is a new feature introduced in the version 8 software 
upgrade.  This window allows for the calculation and display of user-defined 
formulas that are not built-in to the Sierra Wave program. 

Some example formulas that could be used with DataLAB are: 

 Robinson Index (also known as the Combined Sensory Index or CSI) 

 Amplitude ratios between nerves, such as the Median Sensory / Radial 
Sensory ratio 

 Calculation of proximal F Wave velocity 

 Temperature correction of nerve conduction velocity 

Formulas can use any measurement (latency, amplitude, velocity, etc.) that the 
Sierra Wave displays in the NCV, F Wave, and H Reflex test protocols. 
 Formulas can also use temperature, patient height, patient weight, patient age, 
and leg length. 

The DataLAB window uses two ".xml" setup files, these files are stored in the 
user's setup folder.  One file is used to map the Sierra data needed for the 
formulas, the other is used to actually define the formulas.  

Shown below is an example NCV screen with a DataLAB window that has been 
setup to calculate the Robinson Index. 
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Please contact the Cadwell Applications Support department for more 
information and assistance with the setup of the DataLAB feature. 

DataLAB Setup 

The Sierra Wave is very flexible in that each user can create and name their own 
nerves and change the name of factory default nerves.  Users can also create 
their own nerve types and stimulation site names.  Therefore, we need a method 
to identify the Sierra's name for a value (i.e., latency, amplitude, velocity) and 
map it to a format that can be included in a user defined formula. 

This is done by using two ".xml" files that are stored in the user's setup folder. 
 One file, called "ValueBindings.xml",  is used to map the Sierra data needed for 
the formulas, the other file, called "FormulaList.xml", is used to actually put the 
defined values into mathematical formulas.   Both of these files are automatically 
included in the Preserve & Restore functions. 
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Defining the Sierra Data needed for a Formula: 

Go to the user's setup folder and use the Notepad application to open the file 
"ValueBindings.xml".  Add the values that will be needed by your formula to 
this file, follow the format that is shown in the file.  Save your changes. 

 

Example ValueBindings.xml, showing values needed for the Robinson Index. 
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Explanation of syntax used to define a Sierra value. 

Please contact the Cadwell Applications Support department for 
more information and assistance with the setup of the DataLAB 
feature. 

 

Defining the Formulas: 

Go to the user's setup folder and use the Notepad application to open the file 
"FormulaList.xml".  Add your formula to this file, follow the format that is 
shown in the file.  Save your changes. 
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Example FormulaList.xml, showing formulas for Left and Right Robinson Index. 

 

 

Explanation of formula syntax. 

Please contact the Cadwell Applications Support department for 
more information and assistance with the setup of the DataLAB 
feature. 

 

Displaying the DataLAB Window 

To open the DataLAB window: 

1. Start the Sierra Wave program and select an NCV, F Wave, or H Reflex 
test. 

2. From the View menu, select DataLAB Window.  The DataLAB window 
will be displayed. 
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DataLAB window. 

3. Set the position and size of the DataLAB window and then save the layout 
by selecting Save Test Parameters from the Edit menu. 

 

To change the Formulas shown in the DataLAB window: 

1. Right click inside the DataLAB window, click on DataLAB Setup. 

 

2. In the DataLAB Setup window, place a check mark next the formulas you 
want to be displayed. 
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DataLAB Setup. 

3. Click OK 

Including in Reports 

The DataLAB tables can be included in reports.  Simply launch QuickReport and 
select a template that contains the report item needed in order to include the 
DataLAB table.  The factory default template "Full Report with DataLAB" is one 
example. 

 One additional report item is needed in the report template, the Sierra 
item "DataLAB Table". 

 

Please refer to the help topics within the QuickReport program for instructions on 
how to add this item to an existing report template. 
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Set the Default Formulas 

To Assign a DataLAB Formula to a Study: 

1.  From the Edit menu, select Study Menu to display the Study Menu 
Setup window. 

2.  Right click over the name of the Study and select DataLAB Setup from 
the pop-up menu.  The DataLAB Setup window will be displayed. 
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3.  Place a check mark next to the formulas you want to appear in the 
DataLAB window when using this Study. 

 

DatLAB Setup window. 

4.  Click OK. 

 

To Display the contents of a Formula: 

1.  Click on the formula to highlight it. 

2.  Click on the Display Formula button. 

3.  The actual formula specified in the FormulaList.xml file will be displayed. 
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Display Formula window. 

 

 

Report Generation 

QuickReport Overview 

The Sierra Wave uses a separate program for report generation, this program is 
called QuickReport. 

To initiate a report you must select a template from within the Sierra Wave 
program.  Once a template is selected the QuickReport program will start 
automatically. 

 QuickReport is a Microsoft WordTM based application and includes such 
Word features as spell check, grammar check, table formatting, and graphics 
support. 

 QuickReport can be run by stand-alone to edit and create the report 
templates used by the program. 

 

To Select a Report Template 

From within the TabData window: 

 Click on one of the two report buttons shown within the TabData 
window.  The buttons are labeled with the name of the template 
currently assigned to them. 

 Press either the Print or Report key on the Sierra Wave base unit. 

From within a Test Protocol screen: 

 Press either the Print or Report key on the Sierra Wave base unit. 

 Use the program's File Menu to select one of the following. 
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Launch QuickReport & Select Template - this will start the 
QuickReport program and allow you to select any report template 
available on the system. 

Print "Template Name" for Print key - the template name currently 
assigned to the Print key on the Sierra Wave base unit is displayed 
here.  Clicking this entry will select this template and start QuickReport. 

Print "Template Name" for Report key - the template name currently 
assigned to the Report key on the Sierra Wave base unit is displayed 
here.  Clicking this entry will select this template and start QuickReport. 

 

Description of the Factory Default Report Templates 

Current Test - use this template to print the results for the individual Test 
Protocol that is currently displayed on the screen.  For example, use this to 
print the results for a single NCV nerve test or a single Evoked Potential test. 
 It also includes the Chief Complaints, Medications, Physical Exam / History, 
and Impression custom fields from the Patient Information window. 

Full Report (manual Findings) - this template includes all the test protocols 
within the TabData window (tables & traces).  It also includes the Chief 
Complaints, Medications, Physical Exam / History, Impression, and 
Recommendation custom fields from the Patient Information window as well 
as an interactive Findings item for manual creation of findings sentences. 

Full Report with DataLAB - this template includes all the test protocols 
within the TabData window (tables & traces).   It also includes the Chief 
Complaints, Medications, Physical Exam / History, Impression, and 
Recommendation custom fields from the Patient Information window.  A 
Findings section automatically imports the text from the Sentence Generator 
feature of the TabData window.  The results of the DataLAB feature are also 
included in this report. 

Full Report with Sentence Gen - this template includes all the test protocols 
within the TabData window (tables & traces).   It also includes the Chief 
Complaints, Medications, Physical Exam / History, Impression, and 
Recommendation custom fields from the Patient Information window.  A 
Findings section automatically imports the text from the Sentence Generator 
feature of the TabData window. 

Full Report with SG and AV - this template includes all the test protocols 
within the TabData window (tables & traces).   It also includes the Chief 
Complaints, Medications, Physical Exam / History, Impression, and 
Recommendation custom fields from the Patient Information window.  A 
Findings section automatically imports the text from the Sentence Generator 
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feature of the TabData window.  The AnatomyVIEW graphic is also included 
in this report. 

Injection Report - this template to print the injection log table from the EMG 
Guidance protocol.  It also includes an injection diagnosis and procedure 
code table. 

MMUA Report -  this template includes the summary tables and MUP 
waveforms from Multi-Motor Unit Analysis.  It also includes the Chief 
Complaints, Medications, Physical Exam / History, Impression, and 
Recommendation custom fields from the Patient Information window. 

TabData w/ Traces - this template includes all the test protocols within the 
TabData window (tables & traces).  It also includes the Chief Complaints, 
Medications, Physical Exam / History, Impression, and Recommendation 
custom fields from the Patient Information window. 

TabData w/o Traces - this template includes all the test protocols within the 
TabData window (tables only).  It also includes the Chief Complaints, 
Medications, Physical Exam / History, Impression, and Recommendation 
custom fields from the Patient Information window. 

 

QuickReport Views 

QuickReport has three main views. 

Select Report - the program will go to this view if you select "Launch 
QuickReport & Select Template" from the Sierra Wave's file menu.  This 
view allows you to choose any template on the system.  This view is 
initially displayed if you start QuickReport outside of the Sierra Wave 
program.  To select a template, either double click on it or single click on it 
and then click the Next button. 

Fill In Report - the program will go to this view if you select a report 
template that requires user input.  For example, the "Full Report (manual 
Findings)" template will go directly to this view so that the user can make 
manual selections for the Findings section of the report. 

Document - this view shows the generated report in Word format.  The 
program will automatically go to this view if you select a report template 
that does not require any user input, the "Current Test", "TabData w/ 
Traces", and "TabData w/o Traces" templates are examples.  The 
program will also switch to this view when all selections are complete on 
the Fill In Report view. 

 To get a printout of the current test screen, select Print Screen from the 
Sierra Wave File menu. 
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 For more detailed information on QuickReport and report templates, see the 
Help Topics within the QuickReport program. 

Select Report View 

The QuickReport program will go to this view if you select "Launch QuickReport 
& Select Template" from the Sierra Wave's file menu.  This view is also displayed 
if you have pressed a report key with the "Menu" option assigned to it.   

This view allows you to choose any Sierra report template on the system. 

 

Select Report view with TabData w/Traces template selected. 

To Select a Report Template 

 Single click on the report template to select it, then click the Next button. 

 Double click on the report template. 
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Fill In Report View 

The QuickReport program will go to this view if you select a report template that 
requires user input.  For example, the "Full Report (manual Findings)" template 
will go directly to this view so that the user can make manual selections for the 
Findings section of the report. 

 

Fill In Report view - processing Abnormal Motor Nerve findings. 

Some selections are made by simply clicking on the word or words you would 
like. 

Other selections require that you click on the green arrow  .  When the 
selection is made the arrow is shown in red.  The example shown below 
illustrates this. 
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Impressions Item - click on green arrows to make selections. 

 

Select Done and/or OK when all selections have been made for an item. 

After the last item is completed the program automatically goes to the Document 
view. 

 

Making Changes to Previous Selections 

You can go back to the Fill In Report view from the Document view.  This allows 
you to make changes to any of the selections that were made the first time 
through the template.  From the Document view, simply click on the Back button 
at the bottom right of the screen.  To make changes to any of the selections, click 
on the green arrow  or click on the item's label in the box shown on the left 
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hand side of the screen.  After making your changes, click the Next button to 
generate a new report with your changes. 

 

Fill In Report view - after returning from Document view. 
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Document View 

This QuickReport view shows the generated report in Microsoft WordTM format. 
 The QuickReport program will automatically go to this view if you select a report 
template that does not require any user input, the "Current Test", "TabData w/ 
Traces", and "TabData w/o Traces" are examples of this kind of template.  The 
program will also switch to this view when all selections have been completed on 
the Fill In Report view. 

 

Document view. 

The finished report document contains all the information specified in the report 
template.  Usually, the document will start with a Header that contains the 
address for the clinic or hospital.  Next, the patient information is typically 
displayed followed by the test results and traces. 

Anything within the document can be edited.  Simply click the mouse where you 
want to make a change, the blinking cursor will appear.  Use the backspace key 
to delete the text then re-type the text the way you want it.  To add to the report, 
click on a blank line, then type the text you want. 

If you want to delete an entire row from a table, like the EMG Muscle Score table, 
click the mouse anywhere in the row you want to delete.  The blinking cursor will 
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appear.  Now, select “Delete-Row” from the Table menu at the top of the screen. 
 If you make a mistake, select “Undo” from the Edit menu. 

To insert a page-break, click the mouse above the line where you want the new 
page-break to start.  Then, select “Break, Page Break, OK” from the Insert menu. 

Use the formatting toolbar to make changes to the text size, add bolding, or 
italics, or change the font style. 

 

Printing and Saving Reports 

To Print the Report 

From the Document view, 

 Click on the Printer icon at the top of the screen.  The report will 
be sent to your default printer. 

 Select Print from the File menu. 

To Save the Report 

From the Document view,  

 click the Finish button, you will be prompted to save the report. 

 click on the Diskette icon . 

 select Save from the File menu. 

The report is saved to the user's Data directory with the filename of 
"lastname, firstname, date, time.doc". 

To Close QuickReport 

From the Document view, 

 Select Exit from the File menu. 

 Click the Finish button at the bottom right of the screen. 

 Click the Red X in the top right-hand corner. 

 Click the Cancel button at the bottom right of the screen. 

If the report has not been saved the program will ask you if you would like 
to save the report before exiting. 
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Configuring Report Keys 

From the Edit menu, select System Setup. 

The Report Key Assignments section allows you to assign specific report 
templates to the Print and Report keys on the Sierra Wave base unit.  Click on 
the Select button; click the plus (+) sign in front of the report category; highlight 
the report template and click OK to change the Report Key Assignment.  You 
can also assign “Use Menu” to bring up the complete report template list when 
the appropriate key is pushed. 

 

Editing Report Templates 

This topic is covered in greater detail within the Help Topics of the QuickReport 
program. 

To Edit an Existing Template 

Start the QuickReport program by double clicking on its icon on the Windows 
desktop. 

From the Select Report view: 

 Right click the mouse over the template that you want to edit, from the 
pop-up menu select Edit "template name". 

From the Fill In Report view: 

 Select Edit Template from the View menu. 

The Edit Template mode will be displayed. 
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Edit Template Mode. 

In Edit mode, the individual Items that make up the template are listed down 
the center of the screen.  A check mark in front of an item indicates that no 
user input is required for that item during report generation.  If an item 
doesn't have a check mark in front of it, then it will require the user to make 
selections on the Fill In Report view when the report is generated. 

Items with a check mark are also known as Auto-Selected Items.  These 
items are hidden from view unless the Edit mode is activated. 

 

To Edit Report Items 

Report templates are composed of Items.  There are several item types and 
they each have a specific function.  To edit an existing item perform one of 
the following steps. 

From the Fill In Report view: 

 Enter the Edit Template mode by selecting Edit Template from the 
View menu. 

 Right click over an Item, then select Edit from the pop-up menu. 
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 Make your changes, then click the Update button.  All templates that 
use this Item will be updated to reflect the new changes. 

From the Select Report view: 

 Select Edit Items from the File menu. 

 The Report Item Editor will be displayed. 

 Select the Item you want to change, then click on the Edit Item button. 

 Make your changes, then click the Update button.  All templates that 
use this item will be updated to reflect the new changes. 
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Report Item Editor 

 For more detailed information on creating and editing report templates and 
report items, see the Help Topics within the QuickReport program. 

Reviewing a Stored Report 

By default, reports are saved as Microsoft WordTM documents.  They can be 
easily opened for review by following one of the steps shown below. 

 

From within the Sierra Wave program 

 Start the Sierra Wave program 

 From the File menu, select Review Report, or press the F2-Review 
Report function key.  The Open Report window will be displayed. 
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 This window defaults to the data directory path that is specified in the 
System Setup window and lists all the stored reports found in this 
location. 

 

Open Report window. 

 Select a report by turning Knob #1 on the Wave base unit until the 
desired report is highlighted, press the same Knob to Open the file. 
 You can also select the report by clicking on the file with the mouse 
and then clicking the Open button. 

 The stored report is opened in the Microsoft WordTM program. 

The version 11 software upgrade adds the template name to the 
filename of the report.  Example reports saved with version 11 are 
shown below. 
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Report filenames after version 11 software upgrade. 

 

From Outside the Sierra Wave program 

 Go to the appropriate Sierra Wave Data folder. 

o Doulble click My Computer 

o Double click the Local Disk (C:) 

o Double click the Cadwell folder 

o Double click the Sierra Wave folder 

o Double click on the appropriate user's Data folder 

 Double click on the stored report document to open it. 
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Reviewing an Exam 

Reviewing an Exam 

To Review a patient's exam: 

1. Start the Sierra Wave program. 

2. Press the F4-Review Exam key or select Review Exam from the File 
menu. 

    

3. The Open Exam for Review  window will be displayed.  This window 
defaults to the data directory path that is specified in the System Setup 
window and lists all the patient files found in this location. 
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4. Select a patient by turning Knob #1 on the Wave base unit until the 
desired patient is highlighted, press the same Knob to Open the file. 
 You can also select the patient by clicking on the patient file with the 
mouse and then clicking the OK button. 

5. The patient's file will be opened and the TabData window will be 
displayed. 

 

TabData window, NCV Summary Tables selected. 

 

The left hand side of the TabData window shows all the tests that were 
performed on the patient.  It also has entries for summary tables (i.e., Motor 
Summary table, Anti Sensory table, Muscle Scoring table). 

To view the results for an individual test: 

Highlight the test by turning Knob #1 on the Sierra Wave base unit or by 
clicking on the test with the mouse.  The selected test's traces and cursor 
information will be displayed on the right hand side of the window. 
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To view a summary table: 

Highlight the table by turning Knob #1 on the Sierra Wave base unit or by 
clicking on the summary table with the mouse.  The selected table will be 
displayed on the right hand side of the window. 

 

For more information on the TabData window, see the topic TabData Window 
Overview. 
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Resuming an Exam 

Resuming an Exam (Append To) 

This feature is used to open an existing patient exam and add more test data to 
the file. 

To Resume a patient's exam: 

1. Start the Sierra Wave program. 

2. Press the F3 - Resume Exam key or select Resume Exam from the File 
menu. 

    

3. The Open Exam for Resume window will be displayed.  This window 
defaults to the data directory path that is specified in the System Setup 
window and lists all the patient files found in this location. 
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4. Select a patient by turning Knob #1 on the Wave base unit until the 
desired patient is highlighted, press the same Knob to Open the file. 
 You can also select the patient by clicking on the patient file with the 
mouse and then clicking the OK button. 

5. The patient's file will be opened and the Study window will be displayed. 

6. Select an existing test within the Study window or select a new test from 
the Study/Test menu. 

7. Continue testing on the patient.  When your finished, close the exam in the 
normal fashion (i.e., File - Close Exam). 
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Working with Patient Information 

Editing Patient Information during an Exam 

From the Edit menu, select Patient Information.  The patient information 
window will be displayed. 

 

Patient Information window 
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Make the appropriate entries or changes and click the F3 - OK button when 
finished. 

To close the window without saving your changes, click the F4- Cancel button. 

To load patient information from a file, click the F1- Load Patient Info button. 
 See the topic "Loading Patient Information" for more details. 

The Report Header can be selected from the drop-down list or by clicking on the 
Browse button.  The report header can also be selected from within the System 
Setup window. 

Pre-entering and Saving Patient Information 

Patient information can be entered and saved to a file before the patient arrives 
for testing.  After testing begins this information can be quickly retrieved. 

To pre-enter patient information: 

1. Start the Sierra Wave program. 

2. Press the F1- New Exam button on the Sierra Wave base unit, or select 
Enter Patient Info from the File menu. 

3. The patient information window is displayed. 
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4. At a minimum, enter the Lastname and Firstname for the patient. 

5. Click the F2 - Close & Save button. 

6. A standard Save As window will be displayed with the Save In location 
defaulting to the user's Data folder.  The filename is automatically created 
using the patient's lastname & firstname.  To save the patient information 
in this location, click the Save button. 
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Save As window for Patient Information 

 Patient Information files have the file extension, cpi. 

 The Report Header can be selected from the drop-down list or by 
clicking on the Browse button.  The report header can also be selected from 
within the System Setup window. 

Loading Patient Information 

To load patient information from a patient information or patient data file, follow 
the steps shown below. 

1. Start the Sierra Wave program. 

2. Press the F1- New Exam button on the Sierra Wave base unit, or select 
Enter Patient Info from the File menu. 

3. The patient information window is displayed. 
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4. Click the F1 - Load Patient Info button 

5. A standard Open window is displayed with the Look In location defaulting 
to the user's Data folder. 
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Open window for pre-entered patient information. 

6. Highlight either a patient information file (*.cpi) or a previous patient 
data file (*.sd), then click the Open button. 

7. The information contained in the file will be loaded into the Patient 
Information window. 

8. Select F3 - Start Exam to begin testing. 

Custom Fields 

The Patient Information window can be customized by adding up to 20 user-
defined fields.  These fields are displayed at the bottom of the patient information 
window and can be of varying lengths. 

To setup the custom patient information fields, select System Setup from the 
Edit menu. 

The Custom Patient Info section lists the custom fields that are currently 
defined for the system. 

Up to 20 fields can be created and there are 5 types (length) to choose from. 
 The information entered in these fields can be transferred to your report. 
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Name: 

Enter the name of the Custom Field.  To change an existing field name, 
click on it with the mouse.  To enter a new field, click on the blank blue line 
at the bottom of the list. 

Type: 

Click here to specify the length of each Custom Field.  Choices are Short 
(15 characters max), Medium (40 characters max), Long (110 characters 
max), Paragraph (unlimited characters), and Report Item.  A selection of 
Short, Medium, Long, or Paragraph for a custom field will setup a simple 
text box in the patient information window. 

If  Report Item is selected an additional column will be displayed.  This 
additional column, titled Report Item, allows you to assign a QuickReport 
Item to this custom field.  Simply click within the Report Item column and 
the Select Item window will be displayed.  This window displays all the 
available Narrative, Paragraph, and Select items that are stored within 
QuickReport's database.  Only one report item can be assigned to each 
custom field. 
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Select Item window. 

 

Using a Report Item with a Custom Field 

When a report item has been assigned to a custom field, the label of that 
report item and a small document icon will be displayed above and to the left 
of the custom field in the patient information window.  The user still has the 
option of simply typing into the custom field, or they can click on the report 
item's name and process that item.  This gives the user the ability to 'pre-
process' the report item before starting the report generator. 
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Patient Information window. 

Clicking on the Complaints item , in the above example, will pop-
up the typical QuickReport window for that item which is shown below. 



Sierra Wave Help Manual  

1024 

 

Chief Complaints report item. 

You can complete the report item in the normal fashion and when the OK 
button is clicked the output of the report item (i.e., the data in the blue preview 
box) is inserted into the custom field in the patient information window. 
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Patient Information window with the Patient Complaints, Medications, and Patient 
History/Exam custom fields completed. 

 If you click on a report item a second time, it will simply add the results to 
the end of the text already inside the field. 
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Utilities & Converters 

Preserve Settings 

The Preserve feature creates a single backup file with the current user's test 
protocol settings (including nerve lists, and muscle lists), the user's report 
headers, and all of the system's report templates. 

If you have made changes to the default factory settings, it is recommended that 
you make a preserve file. 

In the unlikely event that a user's settings become corrupted, the preserve file 
can be used to restore the settings. 

To make a Preserve File: 

1. Start the Sierra Wave program. 

2. From the File menu, select Preserve. 

3. A standard Save As window will be displayed with the location of the 
"Save In" field defaulting to the current user's Setup folder (e.g., 
Setup.username).  The filename for the preserve file is automatically 
created but can be changed to something more descriptive, like the user's 
name. 
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Save As window for Preserve Settings. 

4. To create the preserve file in this location, click the Save button.  If you 
want to create the file in a different location, use the drop-down arrow of 
the "Save In" field to change the location prior to clicking the Save button. 

 Preserve files have the file extension, prs. 

 Preserve files can be written directly to a writable CD.  The built-in Windows 
XP CD Writing Wizard will automatically be displayed. 

 If there are multiple users of the Sierra Wave machine, with each using a 
different setup directory, then each user should create their own preserve file. 

Restore Settings 

The Restore feature is used to restore test settings and report templates from a 
Preserve file.  There are two types of restore methods, All or Selected. 

 

To Restore All Settings: 

1. Start the Sierra Wave program. 
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2. From the File menu, select Restore All. 

3. A standard Open window will be displayed with the location of the "Look 
In" field defaulting to the current user's Setup folder (e.g., 
Setup.username).  All preserve files in this location will be listed. 

 

Open window for selecting a preserve file. 

4. Select the preserve file and click the Open button.  All the test settings 
and report templates within the preserve file will be loaded and will 
replace the current settings.  If the preserve file is in a different location, 
use the drop-down arrow for the "Look In" field and change the location 
prior to selecting the preserve file. 

 

To Restore Selected Test Protocols or Study Lists: 

1. Start the Sierra Wave program. 

2. From the File menu, select Restore, then click on Selected. 

3. A standard Open window will be displayed with the location of the "Look 
In" field defaulting to the current user's Setup folder (e.g., 
Setup.username).  See example above.  All preserve files in this location 
will be listed. 
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4. Select the preserve file and click the Open button.   The Sierra Wave 
Restore Utility window will be displayed.  This window will default to the 
Sierra Wave view.  Study Lists contained in the preserve file are listed in 
the left hand column, Test Protocols contained in the preserve file are 
listed in the right hand column.  You can expand a study by clicking on the 
(+) sign in front of the study name, this will show you the individual test 
protocols composing the study. 

 

Restore Selected Sierra Wave Studies and/or Test Protocols. 
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5. To restore a Study List 

 Select the Study by clicking on the box in front of the study name, 
a green check mark will appear to indicate the study has been 
selected. 

 Select a restore option at the bottom of the Study List, the options 
are "Do not overwrite existing tests", "Overwrite existing tests", and 
"Ask before overwriting".  When you restore a Study from a 
preserve file you have the option of not only restoring the study 
name, and the names of the test protocols within the study, but also 
of restoring the test settings for those test protocols. 

o Do not overwrite existing tests - the name of the study 
and test protocols within the study will be restored but the 
program will not restore any of the test protocol settings. 
 The existing test settings will continue to be used. 

o Overwrite existing tests - the name of the study and test 
protocols within the study will be restored, in addition, the 
test settings for the test protocols used in the study will be 
copied over the existing settings. 

o Ask before overwriting - the program will prompt the user 
when it needs to overwrite existing test settings at which 
time the user can answer "Yes" or "No". 

 Click the OK button. 

6. To restore a Test Protocol 

 Select the Test Protocol by clicking on the box in front of the test 
protocol name, a green check mark will appear to indicate the test 
protocol has been selected. 

 Click the OK button. 

 

To Restore Selected Report Templates: 

1. Start the Sierra Wave program. 

2. From the File menu, select Restore, then click on Selected. 

3. A standard Open window will be displayed with the location of the "Look 
In" field defaulting to the current user's Setup folder (e.g., 
Setup.username).  See example above.  All preserve files in this location 
will be listed. 
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4. Select the preserve file and click the Open button.   The Sierra Wave 
Restore Utility window will be displayed.  This window will default to the 
Sierra Wave view. 

5. Click on the QuickReport tab.  The Select Report(s) section will display 
the report templates and report items that are available in the preserve 
file.  You can expand a category by clicking on the plus (+) sign in front of 
the category name, this will show you the individual report templates or 
report items contained within the category. 

 

Restore Selected QuickReport Templates and/or Items. 
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6. To restore All Templates and Items. 

 Click on the Restore All button. 

7. To restore Selected Templates and Items. 

 Expand the appropriate categories by clicking on the (+) sign in front 
of the category name. 

 Click on the box in front of the template or item name to select it, a 
green check mark will appear to indicate it has been selected. 

 Click on the Restored Checked button. 

8.  Click the OK button to close the Restore window. 

 

Archiving Overview 

Archive Utility Overview 

The Sierra Wave's Archiving feature can be used to archive (i.e., copy) patient 
files and stored report documents to a CD-R / CD-RW drive, to another location 
on the computer's hard disk drive, or to a location on a networked computer.  It 
can also be used in the opposite direction, to restore patient files or reports from 
an archive media back to the Sierra Wave's data directory. 

From the File menu, select Archiving.  The Archive Utility  window will be 
displayed. 
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Archive Utility window. 

Local Patient Files 

The top of the Archive Utility window lists the patient files that are currently 
present in the local data folder.  The default location of this folder is set in the 
System Setup window.  The browse button can be used to change this location. 

Archived Patient Files 

The bottom of the Archive Utility window lists the patient files currently located on 
the archive media.  The default location for this media is set in the System Setup 
window.  The browse button can be used to change this location. 

File Types 

Three options are available for selecting the types of files that are displayed. 

 Data Files and Reports - both Sierra Wave patient data files and stored 
report documents are listed. 

 Data Files only - only Sierra Wave patient data files are listed. 
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 Reports only - only stored report documents are listed. 

Sorting Files 

The listed files can be sorted by clicking on the top of the displayed columns.  For 
example, to sort by patient name simply click at the very top of the Patient Name 
column.  To sort by Study Date, click at the top of the Study Date column. 

Selecting Files 

 Select All - click the Select All button to highlight all of the files listed in 
the Local Patient Files area. 

 Select a single file - point at the file and click the left mouse button. 

 Select multiple files - hold down the Control key on the PC's keyboard 
while you click on the files. 

Deleting Files 

The Delete button can be used to delete files from the local data folder.  Typically 
this would be done after the patient files have been successfully archived. 

Printing a Directory 

The Print button can be used to print a listing of the files on the currently 
selected archive media. 

 

 

Archiving in Windows XP 

Archiving to CD-R/DVD in Windows XP: 

3 possible archiving options are described. 

 OPTION 1 - Archiving to CD within the Sierra Wave program (using built-in 
Windows XP burner). 

 OPTION 2 - Archiving to CD outside of the Sierra Wave program (using 
built-in Windows XP burner). 

 OPTION 3 - Archiving to another folder on the local hard disk drive or to a 
network drive. 
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Third party software such as Easy CD Creator, Direct CD, and Drag-N-Drop 
are not supported within the Sierra Wave Archive Utility window.  These 
programs can be used outside of the Sierra Wave program, please refer to 
each program's instructions for proper use. 

 

Option 1:  Archiving to a CD within the Sierra Wave program (using built-in 

Windows XP burner). 

1. Start the Sierra Wave program. 

2. Insert a CD-R disc into the drive. 

 If a window is displayed, asking you what you would 
like to do with the CD, click the Cancel button. 

 If a window is displayed showing you the contents of 
the CD drive, close or minimize the window. 

3. From the File menu, select Archiving 

4. Select the patient files you want to archive in the Local Patient Files 
area. 

 Select All - click the Select All button to highlight all of the files 
listed in the Local Patient Files area. 

 Select a single file - point at the file and click the left mouse 
button. 

 Select multiple files - hold down the Control key on the PC's 
keyboard while you click on the files. 

5. Click the Archive button. 

6. The CD Writing Wizard window will be displayed. 
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CD Writing Wizard window 

5.   

7. Type the Name you want to give to the CD, or use the name that is 
already entered.  Click the Next button.  The selected files will be 
copied to the CD.  After the files are copied, the CD is ejected and the 
following window is displayed. 
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CD Writing Wizard window - after writing is complete. 

7.   

8. Click on the Finish button, the above window closes and you are 
returned to the Archive Utility window. 

9. Close the Archive Utility window by clicking the Done button. 

10. The archive process is complete.  It is a good idea to put the CD back 
into its protective case until the next archiving session. 

 

Option 2:  Archiving to CD outside the Sierra Wave program (using 

Windows XP's built-in CD burner). 

1. Close the Sierra Wave program. 

2. Insert a CD-R disc into the drive. 

 If a window is displayed, asking you what you would like to do with 
the CD, click the Cancel button. 

 If a window is displayed showing you the contents of the CD drive, 
close or minimize the window. 
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3. Open the Data folder (here is one possible way of doing this). 

 Double click on My Computer. 

 Double click on Local Drive (C:). 

 Double click on the Cadwell folder. 

 Double click on the Sierra Wave folder. 

 Double click on the appropriate Data.username folder. 

4. Select the files to be archived. 

 Select a single file - point at the file and click the left mouse 
button. 

 Select multiple files - hold down the Control key on the PC's 
keyboard while you click on the files. 

5. Right click the mouse over one of the selected files and select 
Send To - CD Drive (D:) from the pop-up menu.  Do not select "Send 
To Drag N Drop" if it is listed in the menu. 

6. A message will appear in the lower right corner of the screen.  This 
message tells you that there are files waiting to be written to the CD. 
 Click on the balloon message. 

 

Balloon Message 

7. The CD Drive Window will be displayed.  Click on the task, Write 
these Files to CD. 
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CD Drive window. 

8. The CD Writing Wizard window will be displayed. 
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CD Writing Wizard window 

9. Type the Name you want to give to the CD, or use the name that is 
already entered.  Click the Next button.  The selected files will be 
copied to the CD.  After files are copied, the CD is ejected and the 
following window is displayed. 
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CD Writing Wizard window - after writing is complete. 

10. Click on the Finish button, the above window closes and you are back 
to the CD Drive Window.   

11. Click on the X in the upper right hand corner to close this window. 

12. The archive process is complete.  It is a good idea to put the CD back 
into its protective case until the next archiving session. 

 

Option 3:  Archiving to another folder on the local hard disk drive or to a 

network drive. 

1. Start the Sierra Wave program. 

2. From the File menu, select Archiving. 

3. Verify the Archive destination.  If necessary, use the Browse button 
to display the Browse For Folder window and change this location. 
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Browse For Folder window. 

4. Select the patient files you want to archive in the Local Patient Files 
area. 

 Select All - click the Select All button to highlight all of the files 
listed in the local data folder. 

 Select a single file - point at the file and click the left mouse 
button. 

 Select multiple files - hold down the Control key on the PC's 
keyboard while you click on the files. 

5. Click the Archive button.  The selected files will be copied to the 
archive destination and will be listed in the Archived Patient Files 
area. 

6. Click the Done button to close the Archive Utility. 
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Archiving in Windows 7 

Archiving to CD-R/DVD in Windows 7 

With a Blank Disc:  (go to the next section if using a non-blank disc) 

1. Insert the CD or DVD.  Close any windows that might come up, like the 
Autoplay window, by clicking on the X. 

  

2. Start the Sierra Wave program. 

3. From the File menu, select Archiving. 

4. Select the patient files you want to archive in the Local Patient Files area 
(at the top). 

5. Click the Archive button. 

6. A dialog called “Burn to Disc” will be displayed. 
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7. Enter a title for the disc. 

8. Click the Next button. 

9. The files will now be written to the disc.  The disc will automatically eject 
when the process is complete. 

10. Click the Finish button. 
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11. Click the Done button to close the Archiving window. 

 

With a Non-Blank Disc: 

You can burn additional patient files directly to a non-blank CD/DVD, but you will 
receive an error message during the process.  Follow the steps below to archive 
patient files to a non-blank CD/DVD and answer the error message correctly. 

1. Insert the CD or DVD.  Close any windows that might come up, like the 
Autoplay window, by clicking on the X. 
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2. Start the Sierra Wave program. 

3. From the File menu, select Archiving. 

4. Select the patient files you want to archive in the Local Patient Files area 
(at the top). 

5. Click the Archive button. 

6. A dialog called “Burn to Disc” will be displayed. 
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7. Enter a title for the disc. 

8. Click the Next button. 

9. The following error message is displayed. 

 

10. Click the YES button.  The new files have not actually been written to 
the disc at this point. 

11. After clicking on Yes, the new patient files will now be written to the disc. 
 The disc will automatically eject when the process is complete. 

12. Click the Finish button. 
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13. Click the Done button to close the Archiving window. 

 

Deleting Patient Files 

Typically this would be done after the patient files have been successfully 
archived. 

Option 1:  Use the Archive Utility 

1. Start the Sierra Wave program. 

2. From the File menu, select Archiving.  The Archive Utility  window will 
be displayed. 

3. Select the patient files you want to delete from the Local Patient Files 
area. 

 Select All - click the Select All button to highlight all of the files listed 
in the local patient files area. 

 Select a single file - point at the file and click the left mouse button. 
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 Select multiple files - hold down the Control key on the PC's 
keyboard while you click on the files. 

4. Click the Delete button. 

 

Option 2:  Delete directly from the Data folder outside the Sierra Wave 

program. 

1. Close the Sierra Wave program. 

2. Open the Data folder (here is one possible way of doing this). 

 Double click on My Computer. 

 Double click on Local Drive (C:). 

 Double click on the Cadwell folder. 

 Double click on the Sierra Wave folder. 

 Double click on the appropriate Data.username folder. 

3. Select the files to be deleted. 

 Select a single file - point at the file and click the left mouse button. 

 Select multiple files - hold down the Control key on the PC's 
keyboard while you click on the files. 

4. Right click the mouse over one of the selected files and select Delete 
from the pop-up menu.  

 

 

Calibration Signal 

In all test protocols an internal calibration signal can be displayed, recorded, and 
printed.  The calibration signal is a 50 uV, 20 Hz square wave. 

 In order to use the calibration signal a minor modification has to be made to 
the Sierra Wave Amplifier.  Please contact the Application Support or Service 
Department to verify that your amplifier has the modification and to enable the 
calibration feature.  If your amplifier doesn't have the necessary modification, 
arrangements can be made to have this modification performed. 
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 If the Calibration Signal is enabled without the necessary 
amplifier modification the peak-to-peak voltage of the calibration 
signal will not be accurate and will fluctuate between 45 and 50 
uV. 

 

To view the Calibration Signal: 

1. Start the Sierra Wave program. 

2. Select a test protocol from the Study/Test menu.  A sensory nerve 
conduction test protocol works well for recording and measuring the 
calibration signal. 

3. From the View menu, select Calibration Signal. 

4. The Calibration Signal window will be displayed. 

 

5. To optimize the signal for measurement purposes, do the following: 

 Disconnect all electrodes from the amplifier. 

 Set the Gain to 20 uV per division. 

 Set the Sweep Speed to 20 ms per division. 

 Set the Hicut filter to 2 kHz. 

 Set the Locut filter to 0.32 Hz. 

6. Press the Single button on the Sierra Wave base unit to record the 
calibration signal.  The amplitude of the square wave should be 50 uV (+/- 
1.0 uV) peak-to-peak.  The interval from the onset of one square wave to 
the next should be 50 ms, which is equivalent to 20 Hz. 
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Calibration Signal displayed in the sensory NCV test protocol. 

7. Print the results by selecting Print Screen from the File menu. 

8. Turn off the calibration signal by clicking the Done button in the 
Calibration Signal window. 

 The Time & Amplitude Markers can be used to measure the 
calibration signal.  Right click on the trace area to enable them. 

 The Calibration Signal can be enabled in all test protocols. 

 

Ascii Output 

In all test protocols, the trace data can be output to an ASCII file by selecting 
“Save Traces to ASCII” from the right-click menu of the Trace window.  The 
program allows you to specify the location where the ASCII file will be saved. 
 The ASCII file is saved as a „comma separated values‟ file; this means it can be 
opened easily with a spreadsheet or analysis program. 
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To perform Ascii output of the trace data: 

1. Right click over the Trace window. 

2. Select the option Save Traces to ASCII from the pop-up menu. 

 

3. A standard Save As window will be displayed.  If necessary, you can 
change the Save In location and the Filename. 
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4. Click the Save button. 

 

Formatting of the Ascii Output File 

The following example shows the Ascii file opened using Microsoft Excel. 
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 Test Name - shows the name of the test protocol. 

 Test Item - shows the name of the nerve or muscle being tested. 

 Patient Name - shows the name of the patient. 

 Patient ID - shows the patient's ID number. 

 Test Date - shows the test date. 

 Trace Label - shows the label, if any, for each trace that was present 
in the Trace window. 

 Sensitivity - shows the sensitivity of each trace in microvolts per 
division (uV/Div). 

 Hicut - shows the hicut filter setting for each trace in hertz (Hz). 

 Locut - shows the locut filter setting for each trace in hertz (Hz). 

 ms/Sample - shows the horizontal time resolution of each data point. 
 All tests, except EMG, have 640 data points for each trace.  The EMG 
protocol has variable data points depending on the sweep speed of the 
EMG test. 
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 Samples - shows the number of data points for the trace. 

 Trace Data (uV) - shows a column of data points for each trace.  The 
data is scaled in microvolts (uV).  Negative values reflect upward 
deviations from the baseline, positive numbers reflect downward 
deflections from the baseline. 

 If you graph the data points in a spreadsheet, in order to get the 
correct polarity you will need to invert the Y-axis so that negative values 
are above the baseline (or zero point), and positive values are below the 
baseline. 

 

Example of Ascii Data converted to a graph using Microsoft Excel 

The following picture is an example of a Median Motor (Wrist trace) graphed in 
Microsoft Excel. 
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EMG to AVI Converter 

This utility allows an EMG buffer to be converted to an AVI file. 

An AVI file is a sound and motion picture file that conforms to the Microsoft 
Windows Resource Interchange File Format (RIFF) specification.  AVI files 
(which end with an „avi‟ extension) can be played using the Windows Media 
Player or Apple Quick Time Player. 

Some of the potential uses for the EMG to AVI Converter Utility are; 1) you can 
send an EMG recording to someone who doesn‟t have Sierra Wave software and 
they can view and hear the recording, 2) you can include EMG recordings in 
presentations made with Microsoft PowerPoint, and 3) you can build a library of 
EMG examples for use as teaching cases. 

To Create an AVI file: 

1. Record a new buffer of EMG or select a previously stored EMG Buffer 
from the Study window. 

2. Right-click over the Trace window and select Convert EMG to AVI 
from the pop-up menu. 

3. The 'Reel Time' EMG window is displayed. 
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4. Select the amount of the buffer to be converted by positioning the start 
and end markers. 
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5. Enter a Label (optional).  The label will appear above the EMG trace 
when the AVI file is played. 

6. Select Graticule, Calibration, and Repeat options. 

  Check this box to display the graticule dots during 
playback. 

  Check this box to display the horizontal & vertical 
calibration scale. 

  Check this box if you want the AVI to repeat the 
selected buffer with a 5 second delay in between. 

7. Select the desired Resolution of the AVI file.  Choices are 320x240, 
640x480, 800x600, 1024x768, 1280x1024, and 1600x1200. 

8. Select the Sweep Speed for the AVI file.  The sweep speed can be set 
slower or faster than the original EMG Buffer. 

9. Select the appropriate EMG Display Mode options. 

 

 Free Run - during playback the AVI will show a free-run 
EMG trace. 
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Free-run EMG playback. 

 Trigger - during playback the AVI will show a triggered 
EMG trace.  When this option is selected a trigger line is 
displayed in the buffer area, this trigger line can be moved 
up/down to set the appropriate trigger level. 

 

Triggered EMG playback (trigger marker enabled, raster is disabled). 

o Show Trigger Marker - causes a trigger level 
marker to be displayed during AVI playback (see 
above picture). 
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 Raster - the AVI will show rastered EMG traces when this 
box is checked.  Choose to raster 3 or 6 traces. 

 Smooth Traces - for large resolution outputs, this setting 
helps to smooth the appearance of the traces. 

10. Verify that the Output path and filename are correct.  The program 
defaults to the user‟s data folder.  Use the Browse button to change 
the file storage location.  The default AVI filename is „EMG.avi‟. 

11. Select an optional Logo or Signature, this  must be a bitmap (.bmp) 
file.  This will appear at the bottom-center of the AVI when it is played 
back.  This option is only available when the output resolution is 640 x 
480 or higher. 

12. Click the Save button.  A green progress bar indicates the progress of 
the conversion and an animation occurs in the EMG area. 

 It takes about 15 seconds to convert a 30 second EMG Buffer to 
AVI. 

 A 30 second (320x240) buffer is about 14 Mb in size. 

 

12. Click the Done button when finished. 
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To Play an AVI file: 

Use Windows Explorer to go to the folder where the AVI file is stored.  Double 
click on the AVI file.  It should open in your default media player and the file 
should start playing automatically. 

 

Windows Media Player 
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Quick Time Player 

 

EMG to WAV Converter 

This utility allows an EMG buffer to be converted to a type of audio file called a 
WAV. 

A Wave file is an audio file format, created by Microsoft, that has become a 
standard PC audio file format for everything from system and game sounds to 
CD-quality audio. A Wave file is identified by a file name extension of WAV 
(.wav). Used primarily in PCs, the Wave file format has been accepted as a 
viable interchange medium for other computer platforms, such as Macintosh. 
This allows content developers to freely move audio files between platforms for 
processing, for example. 

To Create an WAV file: 

1. Record a new buffer of EMG or select a previously stored EMG Buffer 
from the Study window. 

2. Right-click over the Trace window and select Save Live Buffer To 
File from the pop-up menu. 

3. A standard Save As window will be displayed with the file type set to 
*.wav. 
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4. Enter a File Name for the audio file. 

5. If necessary, change the Save In location to the folder where you 
would like the audio file to be placed. 

6. Click the Save button. 

 

To Play a WAV file: 

Use Windows Explorer to go to the folder where the WAV file is stored. 
 Double click on the WAV file.  It should open in your default media player, 
which in most cases is Windows Media Player.  The file should start playing 
automatically. 

Reader Station Configuration 

On systems that are only used for data review, you can disable the 
“communication error” message that is displayed when launching the Sierra 
Wave program. 

To disable the communication error message: 

1. Open My Computer. 
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2. Go to the C:\Cadwell\Sierra Wave folder. 

3. Locate the file “ReaderStationOn.reg” and double-click on it. 

4. Answer Yes and OK to the displayed messages. 

 

HL7 Interface 

The Cadwell HL7 interface can be used with the Sierra Wave EMG/EP 
instrument.  The interface allows the Sierra Wave program to be launched using 
the patient information (i.e., demographics) provided by an order message from 
the hospital/office EMR system.  The interface also supports the sending of 
results messages back to the hospital/office EMR at the conclusion of testing; 
this 'results' message tells the EMR where the patient‟s report document (.doc, 
.rtf, or .pdf) is located on the network.  The hospital/office EMR is responsible to 
obtain the report document and to incorporate or link it into the patient's 
electronic medical record (by whatever means are supported by the EMR 
software). 

The Cadwell HL7 interface is comprised of the following two components: 

 HL7 Link - this is a data exchange module that can be run on the hospital 
server or on any Windows XP computer that is always 'on-line' with the 
hospital/office network.  HL7 order messages (ORM^O01) from the 
hospital/office EMR are routed to this program's IP/Port address for 
queuing of service requests.  This program also manages the sending of 
results messages (ORU^R01) back to the hospital/office EMR. 

 HL7 Launch - this is a program that resides on the desktop of the Cadwell 
Sierra Wave computer.  When launched it picks up service requests from 
the HL7 Link module and displays a list of patients for selection.  On 
selection, the Sierra Wave program is launched and the patient 
information window is automatically populated with the pertinent patient 
demographics.  At the completion of testing a report is generated and 
saved, this triggers a results message to be generated and queued; this 
results message is then picked up by the HL7 Link module and sent to the 
hospital/office EMR. 

HL7 Link and HL7 Launch use a common set of shared network folders for 
queuing of order and results messages. 

Setup information is used by both HL7 Link and HL7 Launch to configure IP 
addresses and Port numbers, to specify HL7 field usage, and to specify preferred 
operating modes.  Editing this setup information allows for customization at 
different installation sites. 
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Shown below is a conceptual diagram of the interface: 

 

Please contact Cadwell Laboratories for more information on the HL7 
Interface Module. 
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Data Interface Toolkit 

Sierra Wave now supports real-time data output to third-party applications. 
 A data interface toolkit is available for researchers interested in this capability. 
 The data interface toolkit consists of C# (C-sharp) code and an example client 
program that demonstrates the functions and methods supported by the 
interface.  Trace data, instrument status, patient demographics, and minimal 
control functions are supported by the interface. 

 

The first application to utilize this new interface is a program called DQEMG. 

What is DQEMG? 

Decomposition based Quantitative ElectroMyoGraphy (DQEMG) is a program 
designed to provide quantitative information on motor-unit potential (MUP) train 
analysis. 

This program has been developed by Dr. Daniel W. Stashuk over a period of 
several years, including recent versions with collaboration with Dr. Andrew 
Hamilton-Wright. 

The program and acquisition support software is available at the following 
website; http://www.qemg.org/Sierra 

 

For additional information on the Data Interface Toolkit, please contact the 
Application Support Department. 





 

1069 

Reference Guides 

Brachial Plexus 
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Brachial Plexus Root Distribution 

 

 

 

 



Reference Guides 

1071 

Brachial Plexus Studies 

Brachial Plexus Protocol 

General Approach when Diffuse Plexus Involvement Suspected 

 Common Studies Additional Considerations 

Motor Nerve 
Studies 

Median (APB) 
Ulnar (ADM) 
Radial (EDC) 
Musculocutaneous 
(Biceps) 
Spinal Accessory 
(Trapezius) 

Perform conduction studies in all 
nerves that have a clinical deficit 
(any weakness or sensory loss). 

Sensory 
Nerve 
Studies 

Median (2nd Digit) 
Ulnar (5th Digit) 
Radial (Thumb) 
Lateral Antebrachial 
Cutaneous 

Consider performing sensory and/or 
motor studies on opposite side for 
comparison if the findings are 
borderline. 

Needle EMG 
Studies 

Cervical Paraspinal (two 
levels) 
Biceps (MC, C5-6, both 
heads) 
Triceps (R, C5-6, both 
lateral and medial heads) 
First Dorsal Interosseous 
(U, C8-T1) 

If weakness in Upper Trunk, test 
additional C5-6 muscles: 
Rhomboid (DSc) 
Infraspinatus (SScap) 
Deltoid (Ax) 
Brachioradialis (R) 
 
If weakness in Middle Trunk, test 
additional C7 muscles: 
Pronator Teres (M) 
Extensor Carpi Radialis (R) 
Extensor Dig Communis (R) 
 
If there is weakness in Lower Trunk, 
test additional C8 muscles: 
Extensor Carpi Ulnaris (R) 
Extensor Indicis Proprius (R) 
Flexor Pollicis Longus (M) 
Flexor Carpi Ulnaris (U) 
Flexor Pollicis Longus (M) 

MC = musculocutaneous n., R = radial n., M = median n., U = ulnar n., DSc = dorsal scapular n., 
SScap – suprascapular n., Ax = axillary n. 
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Segments of the Brachial Plexus tested by specific nerve conduction 
studies 

 Upper Trunk (C5-6) Middle Trunk (C6-7-
8) 

Lower Trunk (C8-
T1) 

 Suprascapular 
(Supraspinatus) 
 

  

Lateral 
Cord 

Lateral Antebrachial 
Cutaneous 
Median sensory to 
Thumb 
Median sensory to 
2nd Digit 
Musculocutaneous 
motor (Biceps) 
 

Median sensory to 
2nd Digit 
Median sensory to 
3rd Digit 

 

Posterior 
Cord 

Radial sensory 
Axillary motor 
(Deltoid) 
 

Radial sensory 
Radial motor (EDC) 

 

Medial 
Cord 

  Ulnar sensory to 5th 
Digit 
Dorsal Ulnar 
Cutaneous 
Medial Antebrachial 
Cutaneous 
Median motor 
(APB) 
Ulnar motor (ADM, 
FDI) 
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Brachial Plexus Muscle Innervation 

 Upper Trunk (C5-6) Middle Trunk (C6-7-
8) 

Lower Trunk (C8-
T1) 

 Supraspinatus 
(SScap) 
Infraspinatus (SScap) 

  

Lateral 
Cord 

Biceps (MC) 
Brachialis (MC) 
Coracobrachialis (MC) 

Pronator Teres (M) 
Flexor Carpi Radialis 
(M) 

 

Posterior 
Cord 

Brachioradialis (R) 
Supinator (R) 
Deltoid (Ax) 
Teres Minor (Ax) 
Triceps (R) 

Triceps (R) 
Anconenus (R) 
Extensor Carpi 
Radialis (R) 
Extensor Dig 
Communis (R) 
Extensor Carpi 
Ulnaris (R) 

Extensor Indicis 
Proprius (R) 
Extensor Carpi 
Ulnaris (R) 

Medial 
Cord 

  Abductor Pollicis 
Brevis (M) 
First Dorsal 
Interosseous (U) 
Abductor Digiti 
Minimi (U) 
Flexor Carpi Ulnaris 
(U) 
Flexor Digitorum 
Profundus (U) 
Flexor Pollicis 
Longus (M) 

SScap= Suprascapular nerve  
MC = Musculocutaneous nerve 
Ax = Axillary nerve 
R = Radial nerve 
M = Median nerve 
U = Ulnar nerve 
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Upper Trunk Assessment 
(C5-6) 

Nerve Conduction Studies Needle EMG 

Abnormal 
Sensory 

Normal Sensory Abnormal Normal 

Median to 2nd Digit 
Median to Thumb 
Radial to Dorsum & 
Thumb 
Lateral 
Antebrachial 
Cutaneous 
 

Ulnar to 5th Digit Supraspinatus 
Infraspinatus 
Deltoid 
Teres Minor 
Biceps 
Brachioradialis 
Brachialis 
Supinator 
Pronator Teres 
Extensor Carpi 
Radialis 
Flexor Carpi 
Radialis 

Rhomboid Major 
Serratus Anterior 
Triceps 
First Dorsal 
Interosseous 
Upper Cervical 
Paraspinals 

Abnormal Motor Normal Motor 

Axillary (Deltoid) 
Musculocutaneous 
(Biceps) 
Suprascapular 
(Infraspinatus) 

Median (APB) 
Ulnar (ADM) 

Clinical Presentation: 
Weakness in nearly all C5-6 innervated muscles; most affected are Supraspinatus, 
Infraspinatus, Deltoid, and Brachioradialis. 
 
Sensory loss in lateral arm, lateral forearm, lateral hand and thumb. 
 
Reflexes: Biceps and Brachioradialis are depressed or absent.  Triceps reflex is normal. 

 



Reference Guides 

1075 

 

Middle Trunk Assessment 
(C7) 

Nerve Conduction Studies Needle EMG 

Abnormal 
Sensory 

Normal Sensory Abnormal Normal 

Median to 2nd Digit 
Median to 3rd Digit 
Radial to Thumb 
 

Median to Thumb 
Ulnar to 5th Digit 

Pronator Teres 
Flexor Carpi 
Radialis 
Triceps 
Anconeus 
Extensor Digitorum 
Com 

Deltoid 
Biceps 
Brachioradialis 
First Doral 
Interosseous 
Mid Cervical 
Paraspinals 

Abnormal Motor Normal Motor 

Radial (EIP or 
EDC) 

Median (APB) 
Ulnar (ADM) 

Clinical Presentation: 
Middle Trunk injuries are very rare, they mimic C7 radiculopathy. 
 
Weakness is seen primarily in the Pronator Teres, Flexor Carpi Radialis, and Triceps. 
 
Sensory loss in middle finger and posterior forearm. 
 
Reflexes: Only Triceps is abnormal. 
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Lower Trunk Assessment 
(C8, T1) 

Nerve Conduction Studies Needle EMG 

Abnormal 
Sensory 

Normal Sensory Abnormal Normal 

Ulnar to 5th Digit 
Medial Antebrachial 
Cutaneous 
Dorsal Ulnar 
Cutaneous 
 

Median to 2nd Digit 
Radial to Thumb 

Abductor Digiti 
Minimi 
First Dorsal 
Interrosseous 
APB 
Flexor Pollicis 
Longus 
Extensor Indicis 
Proprius 
Flexor Carpi 
Ulnaris 
Flexor Digitorum 
Profundus 
 
*Basically all Ulnar 
innervated 
muscles, and C8-
T1 Median 
innervated muscles 
(APB, FPL, PQ), 
and C8 Radial 
innervated muscles 
(EIP, EPB) 

Deltoid 
Biceps 
Brachioradialis 
First Doral 
Interosseous 
Mid Cervical 
Paraspinals Abnormal Motor Normal Motor 

Median (APB) 
Ulnar (ADM) 

 
 

Clinical Presentation: 
Middle Trunk injuries are very rare, they mimic C7 radiculopathy. 
 
Weakness is seen primarily in the Pronator Teres, Flexor Carpi Radialis, and Triceps. 
 
Sensory loss in middle finger and posterior forearm. 
 
Reflexes: Only Triceps is abnormal. 
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Posterior Cord Assessment 
(Radial, Axillary, Thoracodorsal) 

Nerve Conduction Studies Needle EMG 

Abnormal 
Sensory 

Normal Sensory Abnormal Normal 

Radial to Thumb Median to 2nd Digit 
Ulnar to 5th Digit 
 

Deltoid 
Teres Minor 
Brachioradialis 
Supinator 
Triceps 
Extensor Carpi 
Radialis 
Extensor Digitorum 
Com 
Extensor Indicis 
Proprius 

Biceps 
Pronator Teres 
First Dorsal 
Interosseous 
Mid Cervical 
Paraspinals 

Abnormal Motor Normal Motor 

Radial (EIP and 
EDC) 
Axillary (Deltoid) 

Median (APB) 
Ulnar (ADM) 

Clinical Presentation: 
Radial palsies (wrist drop and finger drop), weakness of arm extension, weakness of 
shoulder abduction, and adduction. 
 
Sensory loss involves lateral arm, posterior arm and forearm, and radial innervated 
dorsal portion of hand. 
 
Reflexes: Triceps and Brachioradialis reflexes are abnormal.  Biceps is normal. 
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Lateral Cord Assessment 
(Musculocutaneous, C6-7 portion of Median) 

Nerve Conduction Studies Needle EMG 

Abnormal 
Sensory 

Normal Sensory Abnormal Normal 

Median to Thumb 
Median to 2nd Digit 
Median to 3rd Digit 
Lateral 
Antebrachial 
Cutaneous 
 

Radial to Dorsum 
Ulnar to 5th Digit 

Biceps 
Brachialis 
Pronator Teres 
Flexor Carpi 
Radialis 

Infraspinatus 
Supraspinatus 
Brachioradialis 
Supinator 
Deltoid 
Teres Minor 
Rhomboid Major 
Triceps 
First Dorsal 
Interosseous 
Upper Cervical 
Paraspinals 

Abnormal Motor Normal Motor 

Musculocutaneous 
(Biceps) 

Median (APB) 
Ulnar (ADM) 

Clinical Presentation: 
Weakness of arm pronation and wrist flexion (median nerve - PT, FCR).  Weakness of 
elbow flexion (radial nerve - biceps). 
 
Sensory loss to the lateral forearm, lateral hand, and first 3 fingers. 
 
Reflexes: Biceps reflex is abnormal. 
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Medial Cord Assessment 
(C8-T1 Median, Ulnar) 

- Nearly identical to Lower Trunk plexopathy, except for intact C8 Radial fibers 

Nerve Conduction Studies Needle EMG 

Abnormal 
Sensory 

Normal Sensory Abnormal Normal 

Ulnar to 5th Digit 
Medial Antebrachial 
Cutaneous 
 

Radial to Dorsum 
Median to 2nd Digit 

First Dorsal 
Interosseous 
Abductor Pollicis 
Brevis 
Flexor Pollicis 
Longus 
Flexor Carpi 
Ulnaris 
Flexor Digitorum 
Profundus 

Deltoid 
Biceps 
Pronator Teres 
Triceps 
Extensor Carpi 
Ulnaris 
Extensor Indicis 
Proprius 
Mid Cervical 
Paraspinals 

Abnormal Motor Normal Motor 

Median (APB) 
Ulnar (ADM) 

 

Clinical Presentation: 
Weakness of all ulnar innervated muscles and C8-T1 median innervated muscles (APB, 
FPL, FDP).  The finger extensors (radial) are spared. 
 
Sensory loss in medial arm, medial forearm, medial hand, and 4th and 5th fingers. 
 
Reflexes: All normal. 
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Median Nerve Diagram 

 

 



Reference Guides 

1081 

Ulnar Nerve Diagram 
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Radial Nerve Diagram 
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Musculocutaneous Nerve Diagram 
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Suprascapular Nerve Diagram 
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Axillary Nerve Diagram 
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Lumbar Plexus 
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Sacral Plexus 
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Femoral and Peroneal Nerve Diagram 
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Sciatic and Tibial Nerve Diagram 
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NCV Setups 

NCV Index 

Upper Limb Motor Nerves 

Median 

Ulnar 

Ulnar Inching Across Elbow 

Radial 

Musculocutaneous 

Axillary 

Suprascapular 

Lower Limb Motor Nerves 

Femoral 

Peroneal (to Extensor Digitorum Brevis) 

Peroneal (to Tibialis Anterior) 

Tibial 

Medial Plantar 

Lateral Plantar 

Upper Limb Sensory Nerves 

Median Antidromic 

Median Orthodromic 

Median Across Palm 

Median/Ulnar Comparison to 4th Digit 

Median/Radial Comparison to 1st Digit 

Median/Ulnar Palm Comparison to Wrist 

Ulnar Orthodromic 

Median Inching (across the wrist) 

Dorsal Cutaneous 

Medial Antebrachial Cutaneous 

Lateral Antebrachial Cutaneous 

Ulnar Antidromic 
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Radial Antidromic 

Lower Limb Sensory Nerves 

Sural Antidromic 

Superficial Peroneal Antidromic 

Saphenous Antidromic 

Medial Plantar 

Lateral Plantar 

Medial Plantar Mixed 

Lateral Plantar Mixed 
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Upper Limb Motor Nerves 

Median Motor 
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MEDIAN MOTOR - Example Traces 
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Ulnar Motor 
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ULNAR MOTOR - Example Traces 
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Ulnar Motor Inching Across Elbow 
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Radial Motor 
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Example Trace (First Stimulation Site): 
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Musculocutaneous Motor 
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Axillary Motor 
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Suprascapular Motor 
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Lower Limb Motor Nerves 

Femoral Motor 
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Peroneal Motor 

 



Reference Guides 

1107 
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Example Traces: 
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Peroneal Motor (Tibialis Anterior) 
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Tibial Motor 
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Example Traces: 
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Medial Plantar Motor 
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Lateral Plantar Motor 
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Upper Limb Sensory Nerves 

Median Antidromic Sensory 
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MEDIAN ANTI SENSORY - Example Trace 
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Median Orthodromic Sensory 
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Example Traces: 
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Median Across Palm Sensory 
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Example Traces: 
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Median/Ulnar Sensory Comparison to 4th Digit 
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Example Traces: 
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Median/Radial Sensory Comparison to 1st Digit 
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Example Traces: 
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Median/Ulnar Palm Sensory Comparison to Wrist 
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Example Traces: 
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Ulnar Antidromic Sensory 
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ULNAR ANTI SENSORY - Example Trace 
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Ulnar Orthodromic Sensory 
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Example Trace: 
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Radial Antidromic Sensory 
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Example Trace: 
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Median Inching (across the wrist) 
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Example Traces: 
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Dorsal Cutaneous 
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Example Trace: 
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Medial Antebrachial Cutaneous 
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Example Trace: 

 



Sierra Wave Help Manual  

1140 

Lateral Antebrachial Cutaneous 
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Example Trace: 
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Lower Limb Sensory Nerves 

Sural Antidromic Sensory 
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Example Trace: 
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Superficial Peroneal Antidromic Sensory 
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Example Trace: 
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Saphenous Antidromic Sensory 
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Medial Plantar Sensory 
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Lateral Plantar Sensory 
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Medial Plantar Mixed 
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Lateral Plantar Mixed 
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F Wave / H Reflex Setups 

F Wave / H Reflex Index 

Click on a nerve to display that topic. 

Median F Wave 

Ulnar F Wave 

Peroneal F Wave 

Tibial F Wave 

H Reflex (Tibial) 
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Median F Wave 
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Example Traces: 
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Ulnar F Wave 
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Example Traces: 
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Peroneal F Wave 
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Example Traces: 
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Tibial F Wave 
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Example Traces: 
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H Reflex 
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Example Traces: 
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EMG Muscles 

Muscle Index 

Hand Muscles 

Abductor Pollicis Brevis 

Adbductor Digiti Minimi 

First Dorsal Interosseous 

Forearm Muscles 

Flexor Pollicis Longus 

Flexor Digitorum Superficialis 

Flexor Carpi Radialis 

Extensor Indicis 

Extensor Carpi Ulnaris 

Extensor Carpi Radialis 

Extensor Digitorum Communis 

Extensor Pollicis Longus 

Abductor Pollicis Longus 

Pronator Teres 

Brachioradialis 

Anconeus 

Supinator 

Pronator Quadratus 

Arm Muscles 

Biceps Brachii 

Triceps 

Brachialis 

Shoulder Muscles 

Pectoralis Major 

Supraspinatus 

Infraspinatus 

Latissimus Dorsi 
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Teres Major 

Deltoid 

Serratus Anterior 

Rhomboid Major 

Levator Scapula 

Trapezius 

Foot Muscles 

Extensor Digitorum Brevis 

Abductor Digiti Quinti 

Abductor Hallucis 

Leg Muscles 

Posterior Tibialis 

Peroneus Longus 

Gastrocnemius - Lateral 

Gastrocnemius - Medial 

Anterior Tibialis 

Soleus 

Extensor Hallucis Longus 

Extensor Digitorum Longus 

Thigh Muscles 

Biceps Femoris - Long Head 

Biceps Femoris - Short Head 

Adductor Longus 

Vastus Medialis 

Vastus Lateralis 

Rectus Femoris 

Adductor Magnus 

Gracilis 

Hip Muscles 

Gluteus Maximus 

Gluteus Medius 
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Iliopsoas 

Non-Limb Muscles 

Orbicularis Oris 

Orbicularis Oculi 

Sternocleidomastoid 

Cervical Paraspinals 

Lumbosacral Paraspinals 

 

Innervation and Action 

Common Arm Muscles 
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Common Leg Muscles 

 



Reference Guides 

1167 

Hand 

Abductor Pollicis Brevis 
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Abductor Digiti Minimi 
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First Dorsal Interosseous 
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Forearm 

Flexor Pollicis Longus 
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Flexor Digitorum Superficialis 
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Flexor Carpi Radialis 
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Extensor Indicis 
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Extensor Carpi Ulnaris 

 



Reference Guides 

1175 

Extensor Carpi Radialis 
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Extensor Digitorum Communis 
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Extensor Pollicis Longus 
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Abductor Pollicis Longus 
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Pronator Teres 
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Brachioradialis 
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Anconeus 

 



Sierra Wave Help Manual  

1182 

Supinator 
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Pronator Quadratus 
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Arm 

Biceps Brachii 
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Triceps 
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Brachialis 
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Shoulder 

Pectoralis Major 
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Supraspinatus 
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Infraspinatus 
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Latissimus Dorsi 
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Teres Major 
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Deltoid 
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Serratus Anterior 
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Rhomboid Major 
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Levator Scapula 
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Trapezius 
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Foot 

Extensor Digitorum Brevis 
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Abductor Digiti Quinti 
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Abductor Hallucis 
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Leg 

Posterior Tibialis 
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Peroneus Longus 
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Gastrocnemius - Lateral Head 
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Gastrocnemius - Medial Head 
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Anterior Tibialis 
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Soleus 
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Extensor Hallucis Longus 
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Extensor Digitorum Longus 
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Thigh 

Biceps Femoris - Long Head 
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Biceps Femoris - Short Head 
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Adductor Longus 
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Vastus Medialis 
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Vastus Lateralis 
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Rectus Femoris 
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Adductor Magnus 
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Gracilis 
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Hip 

Gluteus Maximus 
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Gluteus Medius 
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IIiopsoas 
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Non-Limb 

Orbicularis Oris 
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Orbicularis Oculi 
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Sternocleidomastoid 
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Cervical Paraspinals 
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Lumbosacral Paraspinals 
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EP Setups 

Median SEP Setup 

 



Reference Guides 

1225 

Example Traces: 
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Upper SEP Dermatomes 
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Tibial SEP Setup 
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Example Traces: 
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Lower SEP Dermatomes 
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AEP Setup 
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Example Traces: 
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VEP Setup 
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Example Traces: 
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P300 Setup 
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Example Traces: 
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Blink Setup 

Blink Reflex Setup 
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Example Traces: 
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Brainstem Lesions and Blink Reflex Responses 
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Service & Maintenance 

Grounding the Cart 

If you use a cart with your Sierra Wave and do not use the isolation transformer, 
you will need to ground the cart to the Sierra Wave.. 

 

1. Remove the screw connecting black ground wire (grounds base unit to 
laptop) from the rear panel of Sierra base unit.  

2. Insert screw through eye of black ground wire and the eye of the 
green/yellow ground wire. 

3. Reinsert screw with both ground wires attached into the Sierra base unit. 
 Tighten screw to secure the connection. 

4. Attach crocodile clip on black ground wire to back of laptop with screw 
provided. 

5. Attach green/yellow ground wire to the cart with screw provided. 

Replacing the System Fuse 

A blown fuse usually results from an overload condition, excessive vibration, or a 
failure in the main module.  If a fuse is blown, the Sierra Wave will not power up. 

To replace the fuse 

1. Turn off and disconnect all equipment. 

2. Locate the fuse holders on the bottom right rear of the base unit. 

3. Insert a flathead screwdriver into the  fuse holder cap and unscrew cap. 

4. Remove old fuse and replace with a new 2A fuse.  Replacement fuses 
must have appropriate safety approvals (e.g., UL, CSA, VDE, BSI, etc..). 

5. Reinsert fuse holder cap into base unit and tighten. 

Removing the Laptop from the Sierra Wave 

To remove the laptop 

1. Turn off Sierra Wave base unit. 

2. Shut down laptop following standard windows procedures. 
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3. Close the laptop. 

4. Disconnect all cables from the back of the laptop. 

5. Gently lift the laptop off the instrument base (laptop is secured with 
velcro). 

Preventive Maintenance & Calibration 

To ensure that your instrument provides optimum performance, Cadwell 
recommends that you schedule annual preventive maintenance and system 
calibration. 

For general cleaning and sterilization recommendations, see the topic 
Recommendations. 

Servicing the Sierra Wave 

If the Cadwell Service department determines that the problem lies at the 
component level or is in the custom keyboard or computer, you may be asked to 
ship the base unit of your Sierra Wave or the laptop computer to Cadwell 
Laboratories for service or repair. 

See Shipping Instructions for further details. 

Shipping Instructions 

To send equipment for repair  

1. Place the item to be shipped in the original shipping box or other 
appropriate shipping container (you can purchase a shipping box and 
foam from the Cadwell Service Dept). 

2. Obtain a Service Return Order (SRO) number from Cadwell and put it on 
the left corner of the box. 

3. Send item to:  

Cadwell Laboratories, Inc. 

Attn: Service Department 

909 North  Kellogg Street 

Kennewick, WA  99336 

 

If sending an item in for exchange follow "Exchanging Parts instructions. 
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Exchanging Parts 

To send an item in on exchange. 

1. Call Cadwell Laboratories to order a replacement item. 

2. After receiving the replacement item, use the packing material (box and 
packing material) along with the enclosed airbill to return the defective 
item to Cadwell Laboratories. 
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Warranty Information 

Warranty and Service Contracts 

Your Cadwell Sierra System is covered by a one-year limited warranty at the time 
of purchase. Additional one-year service contracts may be purchased from 
Cadwell Laboratories before the warranty period or previous service contract 
expires. All warranties are non-transferable.   

Cadwell has a variety of service contracts to suit any need.  Contact us for 
detailed information or to request a proposal.  Service contracts are non-
transferable and non-refundable. 

 

Toll-Free within the United States: 800-245-3001 

Phone: 509-735-6481 

Fax: 509-783-6503 

Email: contracts@cadwell.com 

Monday-Friday 

8 a.m. - 5 p.m. PT  

Limited Warranty 

Cadwell warrants for a period of one year from the date of purchase, the 
system listed against defects in material and workmanship. Notice of a 
defect and an explanation of circumstances concerning any claim that the 
system has proven defective in material or workmanship shall be given to 
Cadwell Laboratories, Inc. within two (2) working days of the discovery of 
the defect in the system. Upon such notice, Cadwell will follow the company 
service procedures outlined on page 1 (of the warranty). 

Cadwell agrees to retrofit equipment. If the company makes standard 
improvements to components of the equipment covered under this 
agreement during the term of the warranty and if such improvements are 
compatible with the equipment located on the customer‟s premises, then 
Cadwell will retrofit such physical equipment at no additional charge. 
Cadwell reserves the right to make changes in specifications, construction 
or design of its products at any time in such a manner as it may consider 
necessary or advisable. 
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Preventative Maintenance 

When equipment is delivered at customer‟s expense during the term of the 
warranty to Cadwell Laboratories, Cadwell will take the action necessary to 
insure performance to specifications, including cleaning as necessary, 
checking, calibrating, and verifying operation. Preventative maintenance 
must be scheduled with Cadwell. 

Warranty Exclusion 

 Except as expressly set forth herein, there is no warranty, expressed 
or implied as to fitness for any particular purpose, nor to anything 
else unless contained on the face of this Agreement. All other 
warranties, expressed or implied, including, but not limited to, any 
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR 
ANY PARTICULAR USE, ARE HEREBY DISCLAIMED. 

 Cadwell Laboratories shall be under no obligation to furnish, repair 
or replace any part which has been damaged, abused or misused 
through no fault of Cadwell Laboratories, or if unauthorized attempts 
to modify, repair or service equipment have impaired the 
performance of the equipment. 

Oral Statements Do Not Constitute Warranties 

Representatives of Cadwell are not authorized to make warranties about 
the merchandise described in this Agreement. These representatives‟ 
ORAL STATEMENTS DO NOT CONSTITUTE WARRANTIES, shall not be 
relied upon by the customer and are not part of the contract. The entire 
contract is embodied in this writing and NO OTHER WARRANTIES are 
given beyond those set forth in this contract. This writing constitutes the 
final expression of the parties‟ agreement, and it is a complete and 
exclusive statement of the terms of that agreement. 

Sole Purpose 

The sole purpose of the exclusive remedy shall be to provide the customer 
with free repair and/or replacement of defective parts in the manner 
provided herein. This exclusive remedy shall not be deemed to have failed 
of its essential purpose so long as the company is willing to repair or 
replace defective parts in the prescribed manner. 

Indemnification 

Customer agrees to indemnify Cadwell and hold it harmless from any and 
all demands or claims of any nature whatsoever arising out of the use of 
the equipment, including product liability or physical injuries to person or 
property, loss of life, or other claims or damages. 
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Business Use 

Except as expressly provided by Cadwell in writing, all goods sold 
hereunder are intended for the ultimate use by a commercial user and for 
operation by persons trained and experienced in the use and maintenance 
of such equipment. Cadwell‟s warranty does not extend to any consumer. 
Customer acknowledges that it is purchasing the equipment for a business 
use and for no other. 

Exclusive Remedy and Limitations of Damages 

The parties agree that the customer‟s SOLE AND EXCLUSIVE REMEDY 
against Cadwell shall be for repair and/or replacement of defective parts as 
provided herein. Customer agrees that NO OTHER REMEDY SHALL BE 
AVAILABLE to them and that the company shall not, in any event, be liable 
for incidental damages or consequential damages, including loss of 
income, loss of time, lost sales, injury to person or personal property, 
liability customer had with respect to any other person, or for any other type 
of formal consequential damage or economic loss. 

Severability 

If any provision or clause of this Contract or the application thereof to any 
person or circumstance is held invalid or unconscionable, such invalidity or 
unconscionability shall not affect other provisions or applications of the 
Contract which can be given without the invalid or unconscionable provision 
or application, and to this end the provisions of this Contract are declared to 
be severable. 

Cost of Legal Action 

In the event any action shall be instituted for the failure to perform the terms 
and conditions of this Agreement, the prevailing party shall be entitled to 
recover costs, including attorney‟s fees. 

Time Limit on Customer Commencing Legal Actions 

An action by the customer for breach of this Agreement or any other action 
by customer otherwise arising out of this transaction must be commenced 
within one year from the date the right, claim, demand or cause of action 
shall first accrue, or be barred forever. 

No Waiver 

If Cadwell at its option agrees to a waiver of any of the terms and 
conditions recited herein, such waiver shall not for any purpose be 
construed as a waiver of any succeeding breach of the same or any other 
terms or conditions of this Agreement; nor shall such a waiver be viewed as 
a course of performance. 
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CUSTOMER AGREES TO BE BOUND BY ALL OF THE ABOVE TERMS 
AND FURTHER AGREES THAT THEY CONSTITUTE THE COMPLETE 
AND EXCLUSIVE STATEMENT OF THE AGREEMENT BETWEEN THEM 
WHICH SUPERSEDES ALL PROPOSALS, ORAL OR WRITTEN AND ALL 
OTHER COMMUNICATIONS BETWEEN THEM RELATING TO THE 
SYSTEM AND WARRANTY THEREON. 

THIS AGREEMENT WILL BE GOVERNED BY THE STATE OF 
WASHINGTON AND SHALL NOT BE MODIFIED, AMENDED OR 
OTHERWISE AFFECTED EXCEPT BY A WRITING SIGNED BY BOTH 
PARTIES.  
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Customer Support 

Application Support 

Contact numbers 

In the U.S.  

Voice: 1-800-245-3001 

Fax: 1-509-783-6503 

Outside the U.S. : 

Local Distributor or 1-509-735-6481 

 

Email:  applications@cadwell.com 

 

Support hours 

Application support 6:30 am to 5 pm PST (Pacific Standard Time) 

 

To contact Cadwell for a problem 

1. Have the person who normally operates the equipment in front of the 
Sierra Wave prepared to speak to a support person. This person should 
be able to provide an accurate description of the situation. 

2. Call the customer support number and ask for application support. 
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Service Department 

Contact numbers 

In the U.S. : 

Voice: 1-800-245-3001 

Fax: 1-509-783-6503 

Outside the U.S. : 

Local Distributor or 1-509-735-6481 

 

Email: service@cadwell.com 

 

Support hours 

Service Department support 7 am to 5 pm PST 

 

To contact Cadwell for a problem 

1. Have the person who normally operates the equipment in front of the 
Sierra Wave prepared to speak to a Service Technician. This person 
should be able to provide an accurate description of the situation. 

2. Call the customer support number and ask for the Service Department.  

The Cadwell Service Technician will determine if an exchange or repair of parts 
is necessary and instruct you on appropriate shipping arrangements. 
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Cleaning and Disinfecting 

Recommendations 

Perform cleaning and disinfection procedures on a periodic basis to ensure the 
safe operation of your Sierra Wave system. As you clean, visually inspect the 
instrument and its components for damage or wear. Contact Cadwell if you 
notice damage to the exterior of the instrument.    

While the Sierra Wave EMG/EP system has been carefully designed and 
manufactured to be as reliable and durable as possible, regular cleaning and 
inspection of the system components can help the long term trouble free 
operation of the system.  Try to avoid extremes of physical stress such as 
dropping the unit or exposing it to extreme temperatures.  If you suspect a 
problem, contact the Cadwell Service Department at 800-245-3001. 

Cadwell recommends that you refer to the AAMI Standards and Recommended 
Practices for Sterilization in Health Care Facilities, or equivalent standard text for 
detailed disinfection instructions.  

These standards may be ordered by calling the Association for Advancement of 
Medical Instrumentation at 1-800-332-2264, ext. 250. 

 

   Turn off and disconnect all Sierra components before cleaning. 
Do not attempt to service or repair damaged or inoperable equipment. 

Wave Base Unit 

Use a soft cloth to wipe away any dust that has collected on the instrument 
casing. You can dampen the cloth slightly in a mild soap-and-water solution or 
ammonium based surface disinfectant such as Envirocide® (active ingredients - 
Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium chloride 0.28%, 
Isopropanol 17.20%).   Isopropyl Alcohol may also be used to clean the exterior 
of the unit. 

A soft brush or pressurized air duster can also be used to remove dust from 
hard-to-access areas such as the custom keyboard, alphanumeric keyboard, and 
between connectors on the side and rear panels. To clean dust from monitor‟s 
screen, wipe it with a soft cloth or cloth dampened with a non-ammoniated glass 
cleaner. 

  Turn off the base unit and disconnect the AC power before 
cleaning. Disconnect all peripheral components before cleaning.  Keep 
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all cleaning fluids away from electrical connectors. Do not let 
solutions seep inside the base unit. Do not use abrasive cleansers. 

Gloves should be worn when using environmental disinfectants. 

   Do not use acetone to clean the surface of the Sierra Base Unit. 

   Avoid letting liquid seep into any of the internal electronics. 

Amplifier 

Use a soft cloth to wipe away any dust that has collected on the amplifier casing. 
You can dampen the cloth slightly in a mild soap-and-water solution or 
ammonium based surface disinfectant such as Envirocide® (active ingredients - 
Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium chloride 0.28%, 
Isopropanol 17.20%).  Isopropyl Alcohol may also be used to clean the exterior of 
the amplifier. 

Do not use acetone to clean the surface of the Amplifier. 

Gloves should be worn when using environmental disinfectants. 

Avoid letting liquid seep into any of the internal electronics. 

Stimulators 

Visually inspect the stimulator for unusual wear or damage prior to each use. If 
you notice damage, disconnect the stimulator immediately and contact Cadwell.  

Use a soft cloth to clean stimulator parts that come in contact with the patient 
after each use (e.g., electrical stimulator probes, earphones, and LED goggles). 
Properly dispose of the foam tips used with the insert earphones after each use. 
You can dampen the cloth slightly in a mild soap-and-water solution or 
ammonium based surface disinfectant such as Envirocide® (active ingredients - 
Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium chloride 0.28%, 
Isopropanol 17.20%).  Isopropyl Alcohol may also be used to clean the exterior of 
the stimulators. 

In cases requiring the full sterilization regimen, the electrical stimulator probes 
(removed from the stimulator) can be steam autoclaved at 250 °F (121 °C) and 
15 psi for 15 minutes, or the standard recommended temperature, pressure, and 
time for rubber products.  
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 Turn off and disconnect stimulators before cleaning. Keep all 
cleaning fluids away from electrical connectors. Do not let solutions 
seep inside the stimulators. Do not use abrasive cleansers. 

Gloves should be worn when using environmental disinfectants. 

 

Interface Cables and Power Cords 

Visually inspect the interface cables and power cords that are used with 
components, stimulators, and accessories. If you notice unusual wear or 
breakage, disconnect the cable or cord immediately and contact Cadwell. 

Use a soft cloth to clean interface cables and power cords. You can dampen the 
cloth slightly in a mild soap-and-water solution or ammonium based surface 
disinfectant such as Envirocide® (active ingredients - 
Diisobutylphenoxyethoxyethyl dimethyl benzyl ammonium chloride 0.28%, 
Isopropanol 17.20%).  Isopropyl Alcohol may also be used to clean cables. 

Gloves should be worn when using environmental disinfectants. 

 

Recording Electrodes 

The quality of signal acquisition is affected by the condition of your recording 
electrodes. Routine inspection, careful handling, frequent cleaning, and proper 
storage are essential practices for properly maintaining them.  

The following maintenance procedures apply to nonspecialized electrodes: 

 Inspect electrode leads for breaks, rust, corrosion, and debris prior to use. 

 Handle electrodes carefully, and do not pull on the leads. 

 Clean electrodes in warm water, using a toothbrush to scrub the surface of 
the electrode. If necessary, soak electrodes to loosen debris. (Using a file 
or steel wool to scrub electrodes may lead to contamination of electrode 
metal. This can result in signal artifact.) 

 For proper sterilization techniques refer to the electrode manufacturer's 
instructions. 

 If necessary, dry electrodes thoroughly to prevent corrosion from hard 
water deposits. 

 Store electrodes in a clean, dry place. 
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 Do not tangle or kink electrode leads. 

 Properly discard disposable electrodes after each use (e.g., disposable 
needle electrodes and disposable surface electrodes). 

   Specialized electrodes are often more complex and require special care. 
Anyone using them should consult the manufacturer for proper maintenance and 
handling techniques. 



 

1255 

Patient Safety 

Operating Limits 

Operational Limits (ambient conditions) 

 

Rating:    100-240VAC 50-60 Hz 2A max 

Temperature:   +10º C (+50º F) to +40º C (+104º F) 

Relative Humidity:  30% - 75%  

Atmospheric Pressure:  700 hPa to 1060 hPa 

Hazardous Operating Conditions 

 If needle electrodes are used for stimulation, the current at the tip may be 
high enough to cause arcing and possible local tissue damage. 

 Patients who are unresponsive or cannot communicate, lack sensation, or 
are anesthetized may be injured by prolonged high-intensity stimulation. 

 Injury may occur if the stimulating electrode is directly applied to muscle, 
nerve, brain, spinal cord, or other exposed tissue. 

 

Warnings and Precautions 

 Avoid trans-thoracic stimulation.  

 If discrete wire electrodes are used, place the stimulus and return 
electrodes in close proximity or on the same limb.  

 Use a low-current stimulator with needle electrodes and in surgery to 
avoid injury 

 Permanently applied surface electrodes should be at least 0.5 cm in 
diameter. 

 Current densities for any electrode exceeding 2 mA r.m.s./cm2 may 
require the special attention of the operator. 

 Avoid prolonged, high-current, high-repetition-rate stimulation. 

 Avoid stimulation near implanted electronic devices (e.g., pacemakers). 
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 Do not stimulate a patient with an implanted electronic device unless a 
specialist medical opinion has first been obtained. 

 Electrodes should be considered a possible return path for electro-cautery 
under certain fault conditions, and should be positioned to avoid burns or 
damage to the equipment. 

 This equipment should not be used within 5 meters of therapeutic 
microwave or shortwave equipment. 

 A video VEP monitor which does not meet IEC 60601-1-1 should have a 
protective earth connection.  

 Avoid accidental electrical contact between stimulators, amplifiers, 
sensors and other isolated components and the computer, cart, and other 
grounded or non-isolated components. 

 Disconnect isolated components for storage or when contact with non-
isolated components is possible. 

 Do not wrap amplifiers in blankets or other insulators that impede cooling. 

 Do not place amplifiers or stimulators against the patient for prolonged 
periods. 

 To avoid excessive auditory stimulation, ensure that the stimulus intensity 
never exceeds 75 dB above the hearing threshold. 

 Portable and Mobile RF communications equipment can affect medical 
electrical equipment. 

 Sierra Wave should not be used adjacent to or stacked with any other 
equipment. If adjacent or stacked use is necessary, performance of the 
Sierra Wave should be observed to verify normal operation in the 
configuration in which it will be used. 

 Do not immerse system components in liquid. 

 No user serviceable parts inside. Service by Cadwell Laboratories, Inc. 
and other authorized bodies only. 

 Use extreme caution when electro-cautery or similar equipment is used as 
burns may appear under electrodes as current seeks an alternate return 
path. 

 The operator must be trained to be able to recognize the difference 
between signal artifacts and valid bio-signals caused by movements, 
interference, or misplacement of sensors or electrodes. 

 The proper use of this device for its intended purpose can only be assured 
once all instructions have been read and understood.  If there are any 
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questions regarding the operation of the Sierra Wave EMG/EP system, 
contact Cadwell Laboratories. 

 The system is not defibrillator proof. 

 Do not use the system in an MRI environment. 

 Cleaning instructions in this manual need to be strictly adhered to.  Always 
disconnect equipment from power source and patient before cleaning. 

 The system is not designed to operate in an explosive environment. 

 The system is designed to be used with one patient at a time.  Do not 
connect multiple patients to one amplifier. 

 The Help Topics provide an operational summary for the Sierra Wave 
system.  It does not provide clinical training.  It is assumed that the user 
has adequate clinical training to perform procedures.   

 Sierra Wave system patient connections are type B Floating. 

Auditory Stimulation: 

The auditory stimulator (headphones of both the cup and insert type) output a 
100µS square wave (pulse) which is heard as a click.  The output level is user 
adjustable from -10 to 95 dB nHL. Contralateral masking is also available and is 
user is adjustable from 0 to 80 dB below stimulus level.  Extended exposure to 
high sound pressure levels can result in permanent hearing loss.  While the 
effect of high sound pressure levels differ greatly between individuals it is 
possible that exposure to levels of 75dB nHL for several hours can cause 
permanent hearing loss. As the sound pressure levels go up the acceptable 
exposure time goes down. Where possible avoid stimulating at high levels for 
extended periods of time. 

Photic (Flash) Stimulation: 

The photic stimulator using flash tube technology outputs a pulse of white light 
with a pulse width of approximately 10uS.  The flash can be manually triggered 
or set to flash repeatedly at a rate between 1 and 25 Hz.  The flash energy is 1.5 
million candle or less.  UV energy is blocked by a protective filter incorporated 
into the lens.  While there are no industry or other standards established for EEG 
flash stimulators these parameters are all within the range used by the major 
EEG manufactures.  They have been proven to be safe when used at distances 
of 18 inches or more on a patient with eyes closed. If used on an anesthetized 
patient a means should be provided to ensure that the eye lids remain closed. 

The photic stimulator using LED technology outputs a pulse of white light with a 
pulse width of several milliseconds.  The flash can be manually triggered or set to 
flash repeatedly at a rate between 1 and 60 Hz.  The LED produces no UV 
energy.  The flash energy is much less that output by a flash tube stimulator and 
the pulse width is adjusted to give the same perceived brightness. While there 
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are no industry or other standards established for EEG flash stimulators these 
parameters are all within the range used by the major EEG manufactures.  They 
have been proven to be safe when used at distances of 18 inches or more on a 
patient with eyes closed. If used on an anesthetized patient a means should be 
provided to ensure that the eye lids remain closed. 

The photic stimulator goggles use LED technology and output a pulse of red light 
(650nm nominal wavelength) with a pulse width of 10 milliseconds.  The flash 
can be manually triggered or set to flash repeatedly at a rate up to 10 Hz.  The 
LED produces no UV energy.  The flash energy is in accordance with EN 60825-
1 which covers the safety of laser and LED products. While there are no industry 
or other standards established for EEG flash stimulators these parameters are all 
within the range used by the major EEG manufactures.  The goggles have been 
proven to be safe when used on a patient with eyes closed.  If used on an 
anesthetized patient a means should be provided to ensure that the eye lids 
remain closed. 

Avoid prolonged use of high sound pressure levels or light output 
which may cause permanent hearing or visual impairment. 

Electrical Stimulator Characteristics 

The Sierra Wave contains one constant-current electrical stimulator. The output 
generates a monopolar output. The  maximum outputs (which cannot occur 
simultaneously) are: 

380 volts 
100 mA 
1000 microseconds pulse width 
90 pulses per second 
0.3 Watts r.m.s. 
1.6 mA r.m.s.    

 
Continuous, fast repetition rates and high currents will cause the output voltage 
to droop as a safety measure, stabilizing at the smaller of the rated r.m.s. 
wattage or r.m.s. current.   

The stimulator contains fault detectors that monitor for current delivered when no 
stimulus is requested, for current that is higher than requested, and for other 
conditions. The fault detector will disable the high voltage, and/or clamp the 
outputs until reset.  



Patient Safety 

1259 

The maximum deliverable current for a single stimulus is a function of electrode 
impedance, and is calculated as: 

I (ma) = 380 volts / R (kOhms), or R = 380 / I 

Current 

10 mA 

20 mA 

50 mA 

100 mA 

Maximum 
Resistance 

38 kOhm 

19 kOhm 

7.6 kOhm 

3.8 kOhm 

 

Electrode gel and/or abrasive skin preparation should be applied as needed. 

If the specified current cannot be delivered, a “Z” symbol appears on the screen 
for approximately 1 second each time the stimulator is fired. 

Transport and Storage Limits 

Transport and Storage Limits (ambient conditions) 

The Sierra Wave system should be stored in a clean, dry place.  Handle the 
system with care. 

 

Temperature:    Do not expose to temperatures below -20º C (-4º F) or above 
65º C (149º F) 

Relative Humidity:  Do not expose to relative humidity below 10% or above 90% 
non-condensing 

Atmospheric Pressure:  500 hPa to 1060 hPa 

Electromagnetic Compatibility 

6.8.2.201 a1) This medical electrical equipment needs special precautions 
regarding Electromagnetic Compatibility (EMC) and needs to be installed and put 
into service according to the EMC information provided below. 

6.8.2.201 a2) Portable and Mobile RF communications equipment can affect 
medical electrical equipment. 
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6.8.3.201 a1) List of cables and accessories.   

 

Sierra Wave 2 channel base – 
100813-200 

Sierra Wave 4 channel base – 
100814-200 

Sierra Wave 4 channel amplifier – 
190216-200 

Sierra Wave 2 channel amplifier – 
190215-200 

Sierra Wave software – 369030-
200 

 

 

TDH-39 adult headphones – 199219-
200 

TDH-39 lightweight headphones – 
199220-200 

Insert earphones – 291151-000 

Foot switch – 190218-200 

Sierra Wave electrical stimulator – 
190217-200   

VEP LED module – 199217-200 

LED goggles – 199218-200 

Power com module – 197145-200 

Flash stimulator – 190182-200 

Skin temp probe – 199210-200 

External speaker – 190200-200 

Isolation transformer – 197205-200 

 

 

6.8.3.201 a2) Use of accessories and cabling other than those specified in 
6.8.3.201 a1 above, with the exception of those sold by Cadwell as replacement 
parts, may result in increased emissions or decreased immunity of Sierra Wave 
systems. 

 



Patient Safety 

1261 

6.8.3.201 a3) Table 201- electromagnetic emissions 

 

Guidance and manufacturer’s declaration – electromagnetic emissions 

Sierra Wave EMG/EP systems are intended for use in the electromagnetic environment specified 
below. The customer or the user of the Sierra Wave should assure that it is used in such an 
environment. 

Emissions test Compliance Electromagnetic environment – 
guidance 

RF Emissions 

CISPR 11 

Group 1 

 

Sierra Wave uses RF energy only for its 
internal function. Therefore, its RF 
emissions are very low and are not likely to 
cause any interference in nearby electronic 
equipment 

RF Emissions 

CISPR 11 

Class B Sierra Wave is suitable for use in all 
establishments, including domestic 
establishments and those directly 
connected to the public low-voltage power 
supply network that supplies buildings used 
for domestic purposes. 

Harmonic Emissions 

IEC 61000-3-2 

Voltage fluctuations/ flicker 
emissions 

IEC 61000-3-3 

Complies 

 

6.8.3.201 a4) Sierra Wave should not be used adjacent to or stacked with any 
other equipment. If adjacent or stacked use is necessary, performance of the 
Sierra Wave should be observed to verify normal operation in the configuration in 
which it will be used. 

6.8.3.201 a5) Immunity justification 

Refer to EN60601-1-2 test report summaries above. 
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6.8.3.201 a6) Table 202 –electromagnetic immunity. 

Guidance and manufacturer’s declaration – electromagnetic immunity 

Sierra Wave EMG/EP systems are intended for use in the electromagnetic environment specified below. The customer 
or the user of the Sierra Wave should assure that it is used in such an environment. 

Immunity 
test 

IEC 60601 test 
level 

Compliance level Electromagnetic environment - 
guidance 

Electrostatic 
discharge 
(ESD) 

IEC 61000-4-
2 

±6 kV contact 

±8 kV air 

±6 kV contact 

±8 kV air 

Electrostatic discharge at ANY 
level will produce noise glitches 
on the Sierra II display screen 
and may temporarily saturate 
amplifier inputs. These noise 
glitches and saturation are 
easily differentiated from 
biopotential input signals. ESD 
noise is unavoidable in high 
static environments due to the 
high input sensitivity of the 
equipment.  

To minimize electrostatic 
effects, floors should be wood, 
concrete or ceramic tile. If 
floors are covered with 
synthetic material, the relative 
humidity should be at least 
30%. 

Electrical fast 
transient/burst 

IEC 61000-4-
4 

±2 kV for power 
supply lines 

±1 kV for 
input/output lines 

±1 kV for power 
supply lines 

±1 kV for 
input/output lines 

EFT‟s above 1 kV cause 
events in the display 
waveforms. This is an 
unavoidable phenomenon due 
to the high input sensitivity of 
the equipment. These 
waveform disturbances can be 
differentiated from 
physiological events.  

To minimize these effects, 
mains power quality should be 
that of a typical commercial or 
hospital environment. 

Surge 

IEC 61000-4-
5 

±1 kV differential 
mode 

±2 kV common 
mode 

±1 kV differential 
mode 

±1 kV common 
mode 

Mains power quality should be 
that of a typical commercial or 
hospital environment. 
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Voltage dips, 
short 
interruptions 
and voltage 
variations on 
power supply 
input lines 

IEC 61000-4-
11 

<5 % UT (>95 % 
dip in UT ) for 0.5 
cycle 

40 % UT (60 % 
dip in UT) for 5 
cycles 

70 % UT (30 % 
dip in UT) for 25 
cycles 

<5  % UT (>95 % 
dip in UT) for 5 
sec 

Complies at all line 
input voltages 

Complies at 240 V 
50 Hz. Turns off at 
120 V 60 Hz. 

Complies at all line 
input voltages 

Sierra II turns off. 
Restart of software 
required. 

Mains power quality should be 
that of a typical commercial or 
hospital environment. If the 
user of the Sierra Wave 
requires continued operation 
during power mains 
interruptions, it is 
recommended that the Sierra 
Wave be powered from an 
uninterruptible power supply. 

 

Power 
frequency 
(50/60 Hz) 
magnetic field 

3A/m  Power frequency magnetic 
fields should be at levels 
characteristic of a typical 
location in a typical commercial 
or hospital environment. 

NOTE   UT is the a.c. mains voltage prior to application of the test level. 
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6.8.3.201 b) Table 204 –electromagnetic immunity  

Guidance and manufacturer’s declaration – electromagnetic immunity 

Sierra Wave EMG/EP systems are intended for use in the electromagnetic environment specified below. The 
customer or the user of the Sierra Wave should assure that it is used in such an environment. 

Immunity 
test 

IEC 60601 test level Compliance 
level 

Electromagnetic environment - 
guidance 

 

 

 

 

 

Conducted 
RF 

IEC 61000-4-
6 

 

Radiated RF 

IEC 61000-4-
3 

 

 

 

 

 

3 Vrms 

150 kHz to 80 MHz 

 

 

3 V/m 

80 MHz to 2.5 GHz 

 

 

 

 

 

V 1 = 3 V 

 

 

 

E 1 = 3 V/m 

Portable and mobile RF 
communications equipment should 
be used no closer to any part of the 
Sierra Wave, including cables, than 
the recommended separation 
distance calculated from the 
equation applicable to the frequency 
of the transmitter. 

Recommended separation distance 

 

Where P is the maximum output 
power rating of the transmitter in 
watts (W) according to the 
transmitter manufacturer and d is 
the recommended separation 
distance in meters (m). 

Field strengths from fixed RF 
transmitters, as determined by an 
electromagnetic site survey, 

a
 

should be less than the compliance 
level in each frequency range. 

b
 

Interference may occur in the 
vicinity of equipment marked with 
the following symbol  

  

Note 1  At 80 MHz and 800 MHz, the higher frequency applies. 

Note 2  These guidelines may not apply in all situations. Electromagnetic propagation is 
affected by absorption and reflection from structures, objects and people. 
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a
  Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile 

radios, amateur radio, AM and FM radio broadcast cannot be predicted theoretically with accuracy. To assess the 
electromagnetic environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the 
measured field strength in the location in which the Sierra Wave is used exceeds the applicable RF compliance level 
above, the Sierra Wave should be observed to verify normal operation. If abnormal performance is observed, additional 
measures may be necessary, such as reorienting or relocating the Sierra Wave. 

b
Over the frequency range 150 kHz to 80 MHz, field strengths should be less than [v1] V/m. 

 

 

6.8.3.201 b) Table 204 –electromagnetic immunity  

Recommended separation distances between portable and mobile RF 
communications equipment and the Cadwell Sierra Wave 

Sierra Wave EMG/EP systems are intended for use in an electromagnetic environment in 
which radiated RF disturbances are controlled. The customer or the user of the Sierra Wave 
can help prevent electromagnetic interference by maintaining a minimum distance between 
portable and mobile RF communications equipment (transmitters) and the Sierra Wave as 
recommended below, according to the maximum output power of the communications 
equipment. 

Rated maximum output 
power of transmitter 

W 

Separation distance according to frequency of transmitter 

m 

150 kHz to 80 MHz 

 

80 MHz to 800 MHz 

 

800 MHz to 2.5 GHz 

 

0.01 d = 0.12 m d = 0.12 m d = 0.23 m 

0.1 d = 0.38 m d = 0.38 m d = 0.73 m 

1.0 d = 1.2 m d = 1.2 m d = 2.3 m 

10 d = 3.8 m d = 3.8 m d = 7.3 m 

100 d = 12 m d = 12 m d = 23 m 

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in meters 
(m) can be estimated using the equation applicable to the frequency of the transmitter, where P is the maximum 
output power rating of the transmitter in watts (W) according to the transmitter manufacturer. 

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies. 

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and 
reflection from structures, objects and people. 

NOTE 3 Stated separation distances will assure safe operation of the Sierra Wave. However, some noise may present 
on displayed waveforms. 
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Isolation Transformer Configurations 

ELECTRICAL SAFETY REQUIREMENTS & ALLOWABLE IEC 60601-1-1 
SYSTEM CONFIGURATIONS 

GENERAL DISCUSSION 

The application of modern electronic technologies in medical 
practice has led to systems of medical and non medical electrical 
equipment being used together for the diagnosis and monitoring of 
patients. 

MEDICAL ELECTRICAL EQUIPMENT complying with IEC 60601-
1 such as Cadwell equipment and accessories are often connected 
to other, non medical electrical equipment such as computers and 
printers. Non-medical electrical equipment may fully meet the 
requirements applicable in their specific field, but may not comply 
with isolation or leakage requirements for medical electrical 
equipment and thereby impact the safety of the entire MEDICAL 
ELECTRICAL SYSTEM. 

The following configurations ensure that combinations of Cadwell 
devices and non-medical electrical equipment comply with the 
electrical safety requirements for MEDICAL ELECTRICAL 
SYSTEMS. 

ALLOWABLE CADWELL SYSTEM CONFIGURATIONS 

1. All Cadwell equipment and accessories are permissible in the 
PATIENT ENVIRONMENT without incorporating a 
SEPARATING TRANSFORMER.  

2. A double insulated Laptop Computer powered from Cadwell 
equipment is permissible in the PATIENT ENVIRONMENT 
without incorporating a SEPARATING TRANSFORMER.  

3. Other computing devices (i.e. desktop computer, monitor, 
printer, camera, IR illuminator etc.) are NOT allowed in the 
PATIENT ENVIRONMENT unless a SEPARATING 
TRANSFORMER is used to power those devices. 

4. Non medical devices (examples in #3 above) may be used 
outside the PATIENT ENVIRONMENT within the MEDICALLY 
USED ROOM without incorporating a SEPARATING 
TRANSFORMER, provided each individual device is plugged 
into a FIXED MAINS SOCKET OUTLET. Otherwise a 
SEPARATING TRANSFORMER must be incorporated. 
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5. MULTIPLE PORTABLE SOCKET OUTLETS (power strips) are 
not permitted in a MEDICALLY USED ROOM unless connected 
to the output of a SEPARATING TRANSFORMER. 

6. Connection to hospital networks is allowed without 
incorporating a SEPARATING DEVICE as long as the network 
server and the MEDICAL ELECTRICAL SYSTEM are 
connected to circuits powered from and grounded to the same 
electrical service entrance. 

SYSTEM REQUIREMENTS 

1. Non medical electrical equipment used in MEDICAL 
ELECTRICAL SYSTEMS must meet their respective IEC 
electrical safety requirements, i.e. IEC 950 for computing 
devices. 

2. ENCLOSURE LEAKAGE must not exceed 500uA in any 
SINGLE FAULT condition within the PATIENT 
ENVIRONMENT. 

3. ENCLOSURE LEAKAGE must not exceed 100uA in normal 
condition. 

4. EARTH LEAKAGE must not exceed 500uA in any single fault 
condition within the PATIENT ENVIRONMENT. 

5. The MEDICAL ELECTRICAL SYSTEM must provide a 
minimum of 1500 volts isolation between patient and earth. 

6. The MEDICAL ELECTRICAL SYSTEM must provide a 
minimum of 4000 volts isolation between patient applied parts 
and mains voltage. 

7. The MEDICAL ELECTRICAL SYSTEM must provide a 
minimum of 1500 volts isolation between non-patient contact 
parts of the SYSTEM and mains voltage. 

GENERAL WARNINGS AND PRECAUTIONS 

1. DO NOT place ISOLATION TRANSFORMERS or MULTIPLE 
PORTABLE SOCKET OUTLETS on the ground. 

2. DO NOT connect MULTIPLE PORTABLE SOCKET OUTLETS 
(power strips) to the system, unless connected downstream of 
an isolation transformer. 

3. DO NOT connect items which are not specified as part of or for 
use with the SYSTEM. 
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4. DO NOT exceed the medical isolation transformer placarded 
maximum load. 

5. DO NOT use medical isolation transformer provided with the 
system to power non-system components as this can overload 
the transformer, or defeat the separation by providing additional 
leakage sources. 

6. DO NOT plug non medical electrical equipment intended for 
use in the PATIENT ENVIRONMENT directly into a wall outlet 
as this can potentially result in excessive leakage current 
present in the patient environment. 

DEFINITIONS 

1. MEDICAL ELECTRICAL EQUIPMENT:  Electrical equipment, provided 
with not more than one connection to a particular supply mains and 
intended to diagnose, treat, or monitor the patient under medical 
supervision and which makes physical or electrical contact with the 
patient and/or transfers energy to or from the patient and/or detects 
such energy transfer to or from the patient. 

2. MEDICAL ELECTRICAL SYSTEM (SYSTEM):  combination of items of 
equipment, at least one of which must be MEDICAL ELECTRICAL 
EQUIPMENT and interconnected by functional connection or an 
ISOLATION TRANSFORMER. 

3. PATIENT ENVIRONMENT:  any volume of space (area) in which 
intentional or unintentional contact can occur between PATIENT and 
parts of the SYSTEM or between PATIENT and other persons 
touching parts of the system. For practical purposes this is an area 1.5 
meters or 5 feet beyond reach of the patient. 

4. MEDICALLY USED ROOM:  the room in which the PATIENT 
ENVIRONMENT is located. 

5. SEPARATING TRANSFORMER:  medical ISOLATION 
TRANSFORMER designed to limit transfer of unwanted leakage 
current and allow non-IEC 60601-1 devices to be located in the 
PATIENT ENVIRONMENT. 

6. SEPARATING DEVICE:  a component or arrangement of components 
with input parts and output parts that, for safety reasons, prevent a 
transfer of unwanted voltage or current between parts of the MEDICAL 
ELECTRICAL SYSTEM. 

7. FIXED MAINS OUTLET:  permanently installed (hard wired) grounded 
outlet in a facility. 
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8. MULTIPLE PORTABLE SOCKET OUTLET (power strips):  a 
combination of two or more socket-outlets intended to be connected to, 
or integral with, flexible cables or extension cords. 

9. SINGLE FAULT:  Condition in which a single means for protection 
against a safety hazard in the SYSTEM is defective or a single external 
abnormal condition is present. 

Contact Cadwell Quality/Regulatory department at 509-735-6481 with any 
questions regarding these requirements. 





 

1271 

Wave File Extensions and Locations 

Installation Folders and File Extensions 

The default installation folder is C:\Cadwell\Sierra Wave.  The program's 
application files are located here. 

Two sub-folders are created within the Sierra Wave folder; Data and Setup.  The 
Window‟s username is added to the end of the Data and Setup folder names. 

 Computers purchased through Cadwell Laboratories will typically be pre-
configured with a Windows XP username of "Cadwell".  Therefore, the Data and 
Setup folders will default to Data.Cadwell and Setup.Cadwell respectively. 

The Data folder is typically where patient data files and stored reports are 
located.  The Setup folder is where settings and preserve files are located. 

The following extensions are located in the user's Data folder. C:\Cadwell\Sierra 
Wave\Data.username 

.sd – Patient data file, format is (Lastname, Firstname, date, and time) 

.doc  - Stored report document (Word 2002 & 2003) 

.docx - Stored report document (Word 2007 & 2010) 

.pdf - Stored report in Adobe format (Word 2007 &2010) 

.cpi - Stored patient information file, created using the Close & Save button in the 
Patient Information window. 

.db – Directory file, used by the Review and Resume windows. 

The following extensions are located in the Users Setup folder. 
 C:\Cadwell\Sierra Wave\Setup.username 

.prs – Preserve File, contains all of a user's test protocol settings and all report 
templates. 

.wsm – Study Menu file, contains current study lists. 

.stm – Test Protocol menu, contains current parameters, nerve, and muscle lists 
for all test protocols. 

.stp – Saved Test Protocol, created using the Save Test button in the Test Menu 
Setup window. 

.xml - Configuration files used by the AnatomyVIEW, DataLAB, and Sentence 
Generator. 
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Sierra Wave Specifications 

Amplifier 

Channels: 2 or 4. 

Sensitivity: 2, 5, 10, 20, 50, 100, 200, 500 µV/div; 1, 2, 5, 10, 20 mV/div. 

(Additional sensitivity values of 0.05, 0.5, 0.2, 0.1 in NCV protocol) 

Highcut filters: All modes.  

2-pole (12 dB/octave) filter.  

Selectable at 30, 50, 100, 200, 300, 500 Hz; 1, 1.5, 2, 3, 5, 10, kHz. 

Lowcut filters: 1-pole filter. 

Selectable at 0.04, 0.32, 1, 10, 20, 30, 100, 500 Hz; 1, 2 kHz. 

Notch filter, 50 or 60 Hz. 

Connection types: 1.5-mm, touchproof connector or 5-pin DIN connector. 

Input impedance: > 1000 M (common mode). 

Noise:  Channels 1,2: <2 uV rms 

Common recording reference input (4 channel only). 

Temperature probe input. 21° to 44°C ± 5°C. 

Impedance of active and reference inputs. 

A/D Converter 

16-bit, analog-to-digital conversion. 

76.8-kHz sampling rate per channel (2-channel mode). 

38.4-kHz sampling rate per channel (4-channel mode). 

Averager 

Number of averages per channel: 1 to 10,000. 

Artifact reject: Rejects signals that exceed 95% of full scale. On or off for all channels. 

Sweep speeds: 0.5 to 1000 ms/div in 19 steps. 

Isolation Transformer 

Refer to Cadwell document 309002-000 to determine if an isolation transformer is required. 

Mechanical 

Base dimensions: 1.8 H x 12 W x 13 D in. Weight: 6 lbs. (2.7 kg) 
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Electrical 

100-240 vac, 50-60 Hz, 2A max. 

Auditory Output 

Built-in 2-way speaker. 

Stimulators 

Repetition rates: 0.5 to 90 pps depending on stimulus type, sweep speed, and protocol. 

Electrical Stimulator 

Type: Hand-held, constant-current electrical stimulator with stimulus intensity dial, stim and 
store buttons on handle. 

Pulse duration: 50 to 1000 µs width, adjustable in 50-µs increments. 

Electrical range: 0 to 100 mA, 380 V maximum voltage. 

Resolution: 0.1 mA. 

Safety features: Over current fault detection. 

Auditory Stimulators 

Headphones: TDH-39, 10-ohm. Available in acoustically shielded and non-shielded models. 

Ear inserts: TDH-39, 10-ohm compatible transducers. 

Presentation: Left, right, both, or neither ear. 

Intensity units: nHL/SPL. 

Stimulus types: Click, Tone Burst, Tone Pip. 

Clicks: 100-µs square wave clicks.  Rarefaction, condensation, or alternating polarity. 

Tone Burst:  10-30-10 ms. (250, 500, 750, 1k, 2k, 3k, 4k, 6k, 8k Hz) 

Tone Pip:  2-0-2 and 2-1-2 cycles.  (250, 500, 750, 1k, 2k, 3k, 4k, 6k, 8k Hz) 

Decibel range: -10 to 95 dB nHL. 

White noise masking: Contralateral masking from 0 to 80 dB below stimulus level. 

Visual Stimulators 

VEP Video CRT Monitor: NTSC or PAL (Discontinued October 2010) 

Monochrome VEP video for black and white, pattern-reversal checkerboard stimulation. 
 Features center fixation target, independent quadrant and half-field stimulation. Square 
sizes: 1, 2, 4, 8, 16, 32, 64 or 128 checks across the horizontal axis. Combination of Sierra 
Wave and monitor must meet requirements of EN60601-1-1. 
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VEP Video LCD Television Monitor: 

15.6 inch monochrome VEP video for black and white, pattern-reversal checkerboard 
stimulation.  Features center fixation target, independent quadrant and half-field 
stimulation. Square sizes: 1, 2, 4, 8, 16, 32, 64 or 128 checks across the horizontal axis. 
 Combination of Sierra Wave and monitor must meet requirements of EN60601-1-1. 

3-in (8-cm) LED Stimulator: Pattern-reversal checkerboard stimulator with 0.25-in (6.4-mm) 
red and black square. 

LED goggles: Flash pattern stimulus selectable for right, left, or both eyes. 

Flash Stimulator: Flash rates from 1-25 Hz. 0.72 J/flash. 
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External Speaker Specifications 

Units purchased before November 2003: 

Connecting Non-Cadwell Devices to the External Speaker Jack 

Introduction 

The Sierra Wave provides a jack for connection to an external speaker. 
 Cadwell sells a high quality magnetically shielded speaker with cable for use 
as an external speaker. Connecting other devices to this external speaker 
jack is possible but standard audio equipment cannot be plugged directly into 
the jack.  This technical note describes the speaker output and how to 
interface non-Cadwell equipment to it. 

Background 

When an external speaker is used with the Sierra Wave it is connected in 
parallel with the existing dual speaker system contained in the base unit. 
 Standard audio equipment cannot be directly connected to this external 
speaker jack due to its unique pin out configuration.  The Sierra Wave uses 
an audiophile quality class D audio amplifier.  This same amplifier is used in 
high-end televisions and audio equipment.  The class D amplifier allows good 
volume levels with a simple power supply and minimum power usage.  This 
makes it ideal for use in lightweight portable medical devices such as the 
Sierra Wave.  However, in order to obtain this improved performance the 
amplifier drives both speaker wires in a push pull configuration.  Most older 
single ended audio systems have one wire driven and the other wire 
connected to ground and most auxiliary audio equipment such as 
headphones and recorders are built to handle this type of connection.   

External Speaker Jack Connections 

The Sierra Wave external speaker jack is a standard 3.5mm (about 1/8 inch) 
three-conductor phone jack.  This is the same jack used by portable / 
personal stereo equipment for the headphone connector.  A typical plug that 
is used with such a jack is shown below. 
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The Sierra Wave connects the two driven speaker outputs to tip and ring. 
 The sleeve is connected to earth ground.  The two speaker outputs are 180 
degrees out of phase and centered at 6 VDC.  Full volume swing is 0 to 12 
VDC.   

Connecting Stereo Headphones to the External Speaker Jack 

The 6 VDC bias prevents the direct connection of a 3.5mm stereo headphone 
to the external speaker jack. This 6-volt bias would overdrive and possibly 
destroy the headphone speaker elements.  Placing a capacitor in line with 
each of the speaker outputs would eliminate the bias but would result in the 
left and right sides being out of phase The out of phase signals result in an 
unnatural presentation of sound that most people find unpleasant. 

Because the sound from the Sierra Wave is monaural an adapter will provide 
the same signal to each side of the stereo headphone.  Connecting the right 
and left headphone speakers in parallel as shown in the following figure does 
this. 

 

Headphone Adapter Circuit 

Connecting the External Speaker Jack to the Auxiliary Input of Audio 
Equipment 

Audio equipment auxiliary inputs such as amplifiers or recorders are most 
commonly designed for a single ended 1-volt peak to peak audio signal 
centered on ground.  The Sierra Wave outputs a maximum signal level of 
almost 12 volts peak to peak centered at 6 volts DC.  Therefore, both the 
signal amplitude and DC level must be modified before the Sierra Wave 
external speaker jack can be connected to audio equipment.  

The following circuit reduces the amplitude of the speaker signal and shifts 
the DC level for use with audio equipment auxiliary inputs.  Several 
assumptions have been made to keep the circuit as simple as possible: First, 
the Sierra Wave volume will seldom if ever be set to deliver more than a 6 
volts peak to peak signal.  Second, the auxiliary input will have impedance of 
at least 10K ohms.  Third, the auxiliary input will not place any DC bias on the 
input signal.  With these three conditions met the circuit is very simple.  A 
schematic representation is as follows: 
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Circuit for connecting an external amplifier or recorder to the Sierra Wave external speaker 
output. 

An additional challenge is presented by the volume control.  The signals used 
by conventional auxiliary inputs do not normally change in level intensity with 
the volume control.  The output of the Sierra Wave is affected by the volume 
control.  So an auxiliary recording device must have an automatic gain control 
or the recording level of the device will need to be adjusted whenever the 
volume on the Sierra Wave is adjusted. 

 

Units purchased after November 2003: 

The external speaker circuit was changed on November 26, 2003.  This 
change now allows the Cadwell speaker (mentioned above) and standard PC 
speakers to be connected to the circuit. 

Recommendations for use of “PC” Speakers. 

 Purchase a high quality magnetically shielded speaker. 

 If you desire the remote speaker to have a volume level at or above 
that of the base unit purchase an amplified speaker and leave the 
volume of the base unit low (but not off) and adjust the volume on the 
remote speaker as desired. 

 Purchase a pair of speakers where the slave speaker (the one without 
the computer connection) can be disconnected.  Disconnect and do 
not use the slave speaker.  (It does not matter if the slave is the left or 
the right speaker.)  A single speaker will not have "out of phase" 
problems and will therefore sound better than the pair. 
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Labels and Symbols 

Symbol Title/Meaning Reference 

 

Attention, consult accompanying 
documents.  

Attention, consulter les documents 
d‟accompagnement. 

IEC  

UL  

 

Caution.  To reduce the risk of electric 
shock, do not remove cover or back.  

UL  

 

Danger.  Explosion risk if used with 
flammable anesthetics.  

UL 

 

Dangerous voltage 

Tension dangereuse   

IEC  

 

Power ON 

Marche (mise sous tension)  

IEC 

UL 

 

Power OFF 

Arrêt (mise hors tension)  

IEC  

UL 

 

Equipotentiality  

Equipotentiálite  

IEC 

UL 

 

Warning.  Replace fuse as marked.  UL 

 

Type B equipment.  Ordinary, non-
isolated patient connection. 

Appareil de type B.  

IEC 

UL 

 

Type BF equipment.  Isolated patient 
connection.  

Appareil de type BF.  

IEC 

UL 



Sierra Wave Help Manual  

1280 

 

Alternating current 

Courant alternatif   

IEC 

UL 

 

Output   

Sortie 

IEC 

 

Input   

Entrée 

IEC 

 

Variability in steps 

Variabilité par échelons  

IEC 

 

Reverse Polarity 

reverse polarite 

Cadwell 
Convention 
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Copyright & Trademarks 

 Cadwell Laboratories, Inc. 2003, 2004, 2005, 2006, 2008, 2009, 2010 All rights 
reserved 

Cadwell is a registered trademark and Sierra Wave is a trademark of Cadwell 
Laboratories, Inc. Other brand and product names are trademarks or registered 
trademarks of their respective holders. 

Cadwell Laboratories reserves the right to modify, delete, extend, or improve 
features described herein without notice. 

 

DJN 

 



Sierra Wave Help Manual  

1282 



 

1283 

Index 

A 

About Sierra ............................................. 381 

Add EP Traces ......................................... 864 

AEP Example Setup .............................. 1230 

AEP Test Protocol 

AEP - Basic Operation .......................... 88 

AEP Example Setup .......................... 1230 

AEP Knobs and FKeys ........................ 841 

AEP Setup ........................................... 325 

Auto Cursors ....................................... 850 

Change Gain of a Stored Trace .......... 861 

Cursor Table Setup ............................. 325 

Deleting Traces ................................... 861 

Reject .................................................. 855 

Saving Changes to EP Settings .......... 868 

Split Screen Controls........................... 866 

Start New Run ..................................... 865 

Stim Avg - Stim On .............................. 867 

Time & Amplitude Markers .................. 856 

Trace Labels ........................................ 862 

Trace Positioning ................................. 858 

Trace Smoothing ................................. 860 

View Avg - View Live ........................... 858 

AEP Test Protocol ..................................... 88 

Amp/Stim Switch Box .............................. 490 

Amplifier Cleaning.................................. 1252 

AnatomyVIEW Window 

Controls ............................................... 970 

Including in Reports............................. 982 

Muscle Data Setup ............................. 976 

Nerve Data Setup ............................... 980 

Overview ............................................. 967 

Set the Default View ........................... 983 

AnatomyVIEW Window ........................... 967 

Archiving Overview ........... 1033, 1035, 1044 

Ascii output ........................................... 1052 

Auditory Stimulators .................................. 15 

Auto F Wave Latency ............................. 590 

Auto H-Reflex Latency ............................ 645 

Auto Score Muscles ................................ 162 

Auto Seq ................................................. 658 

Automatic Muscle Scoring ........................ 49 

Average EP Traces ................................. 864 

AVI ........................................................ 1057 

B 

Back Panel Connections 

10 Base T ............................................. 10 

Amplifier ................................................ 10 

Auxilliary ............................................... 10 

BAEP / VEP .......................................... 10 

EStim .................................................... 10 

External Speaker .................................. 10 

Footswitch ............................................ 10 

Laptop Power ....................................... 10 

Temp..................................................... 10 

Back Panel Connections ........................... 10 

Base Unit Cleaning ............................... 1251 

Blink Reflex Example Setup ................. 1236 



Sierra Wave Help Manual  

1284 

Blink Test Protocol 

Basic Operation ..................................... 73 

Blink Setup .......................................... 237 

Knob & Fkey Controls (Blink) .............. 681 

Markers ............................................... 684 

Saving Changes to Blink Settings ....... 689 

Trace Positioning & Delete .................. 687 

Blink Test Protocol ..................................... 73 

Botox Switch Box ..................................... 490 

C 

Calibration .............................................. 1050 

Calibration Signal................................... 1050 
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Changing the Test Layout ....................... 360 

Cleaning and Sterilization . 1251, 1252, 1253 

Close Exam ............................................. 131 
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Closing the Sierra Wave Program ........... 132 

Collision Study ......................................... 555 

Color Editor .............................................. 137 

Communication Error ................................. 22 
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Connections ................................................. 4 

Contact Numbers ................................... 1249 

Controls Toolbar ........................................ 27 

Copyright & Trademarks ........................ 1281 
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Cursor Display Format ............................. 850 
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Including in Reports ............................ 991 

Set the Default Formulas .................... 992 

Setup .................................................. 986 

DataLAB .................................................. 985 
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E 

Edit Menu ................................................ 376 

Editing Patient Information .................... 1015 
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Intensity Wheel ..................................... 13 
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Store Button .......................................... 13 
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EMG Test Protocol 
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Capture Mode ..................................... 398 
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Deleting a Snapshot ............................ 424 
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Live Mode ............................................ 398 
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MUP Tool ............................................ 413 

Muscle List (F3) ................................... 436 

Muscle List Setup ................................ 162 
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Notch Filter .......................................... 435 
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Scoring Muscles .................................. 427 

Storing a Live Buffer ............................ 412 

Storing a Live Snapshot ...................... 410 

Storing Captured Traces ..................... 423 

Swap Sides ......................................... 434 

Time & Amplitude Markers .................. 438 

Trace Position Settings ....................... 162 

EMG Test Protocol .................................... 49 

EMG to AVI Converter ........................... 1057 

EMG to WAV Converter ........................ 1063 

Enable the repetitive stimulation.............. 140 
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EP Stim History ....................................... 865 

External Speaker .................................. 1275 

F 
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Auto Cursors ....................................... 618 
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Deleting Traces ........................... 592, 620 

Distance & Velocity ..................... 591, 619 

F Wave Setup ...................................... 204 

Knob & Fkey Controls (F Wave Markers)
 ........................................................ 572 

Latency Markers .................................. 590 

Manual / Auto Store.............589, 617, 644 

Move To .............................................. 581 

Nerve List (F3) ............................. 586, 614 

Nerve List Setup .................................. 204 

No Response ....................................... 582 

Normal Value Setup .................... 576, 603 
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Swap Sides ................................. 580, 607 

Test Setup ........................................... 204 
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Fibs / Recrt .............................................. 162 
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Change Sides ..................................... 636 

Comment ............................................ 638 
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H Reflex Setup ................................... 215 
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Clear All Traces ................................... 561 

Comment ............................................. 552 
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